ANSYS Workbench Products Release Notes

ANSYS Workbench Release 10.0

ANSYS, Inc.
Southpointe
275 Technology Drive
Canonsburg, PA 15317
ansysinfo@ansys.com
http://www.ansys.com
(T) 724-746-3304
(F) 724-514-9494
Copyright and Trademark Information

© 2005 SAS IP, Inc. All rights reserved. Unauthorized use, distribution or duplication is prohibited.

ANSYS, ANSYS Workbench, CFX, AUTODYN, and any and all ANSYS, Inc. product and service names are registered trademarks or trademarks of ANSYS, Inc. or its subsidiaries located in the United States or other countries. ICEM CFD is a trademark licensed by ANSYS, Inc. All other trademarks or registered trademarks are the property of their respective owners.

Disclaimer Notice

THIS ANSYS SOFTWARE PRODUCT AND PROGRAM DOCUMENTATION INCLUDE TRADE SECRETS AND ARE CONFIDENTIAL AND PROPRIETARY PRODUCTS OF ANSYS, INC., ITS SUBSIDIARIES, OR LICENSORS. The software products and documentation are furnished by ANSYS, Inc., its subsidiaries, or affiliates under a software license agreement that contains provisions concerning non-disclosure, copying, length and nature of use, compliance with exporting laws, warranties, disclaimers, limitations of liability, and remedies, and other provisions. The software products and documentation may be used, disclosed, transferred, or copied only in accordance with the terms and conditions of that software license agreement.

ANSYS, Inc. and ANSYS Europe, Ltd. are UL registered ISO 9001:2000 Companies.

U.S. GOVERNMENT RIGHTS

For U.S. Government users, except as specifically granted by the ANSYS, Inc. software license agreement, the use, duplication, or disclosure by the United States Government is subject to restrictions stated in the ANSYS, Inc. software license agreement and FAR 12.212 (for non-DOD licenses).

Third-Party Software

See the online documentation in the product help files for the complete Legal Notice for ANSYS proprietary software and third-party software. The ANSYS third-party software information is also available via download from the Customer Portal on the ANSYS web page. If you are unable to access the third-party legal notices, please contact ANSYS, Inc.

Published in the U.S.A.
Solution Status Monitor Available for Simulation and DesignXplorer DOE Solutions

A Solution Status Monitor, located in the Windows system tray, allows users to monitor the progress of local and remote solutions from Simulation and DesignXplorer DOE.

Help Menus Include Access to Installation, Licensing, and Customization Guides

Choosing Help from the main menu on the Project Page or from within any of the Workbench modules now includes a menu item for directly accessing online versions of the Installation and Licensing documentation. In addition, choosing Help from the main menu on the Project Page includes a menu item for directly accessing the Customization Guide for ANSYS Workbench.

ANSYS Workbench Products Network Configuration (AWPNC) Updates

The network configuration utility now supports client licensing configuration for single server and three server (Triad) configurations. In addition, it is no longer necessary to pre-configure the ProENGINEER or Unigraphics CAD applications. The configuration utility can read-in the necessary data and perform the configuration steps independently.

Graphics Viewing Enhancements

New enhancements to Workbench graphics at release 10.0 allow you to:

- Define a custom Isometric viewpoint, as well as define the "up" direction for orientation on screen.
- Flip through Previous and Next graphics viewpoints like history in a web browser.
- Control animation graphically in the new Animation tab.
- View interactive Capped Isosurfaces using a new toolbar.
- Customize the new Legend using a specialized dialog box.

Configuring Panes inside the Workbench Window

On Microsoft Windows only, Workbench now offers control over the individual panes inside the application window: moving, resizing, tab docking and autohiding.

DesignModeler Release Notes for 10.0

Bidirectional Refresh for Attach

The Refresh Property of the Attach to Active CAD Geometry feature now allows you to refresh the geometry using parameter values from either the source CAD package or from the CAD parameters in DesignModeler's Details View.
Mid-Surface Feature

The Mid-Surface feature allows you to create surface bodies that are mid-way between pairs of solid body faces of uniform thickness. The body’s thickness is automatically propagated to the resultant surface bodies. The faces can be manually selected, or an automatic mode allows you to set a thickness range and then automatically detect matching face pairs.

Modeler License Preference

DesignModeler can run under two different license keys. When using DesignModeler in conjunction with BladeGen, it is recommended that the modeler license preference be set to ANSYS BladeModeler. This will allow both DesignModeler and BladeGen to run under a single BladeModeler license key. If the modeler licensing preference is set to ANSYS DesignModeler, then running both applets will cause two licenses to be checked out, one for ANSYS BladeModeler and one for ANSYS DesignModeler.

Monte Carlo N-Particle Import & Export Support

You can now import and export models in the Monte Carlo N-Particle (.mcnp) format, provided the model contains analytic surfaces. Additionally, DesignModeler will color bodies imported from an MCNP file according to its material.

OneSpace Designer Modeling

DesignModeler now supports the Reader/Plug-In for OneSpace Designer Modeling 2005, revision 13.20 on the Windows platform. OneSpace Designer Modeling supports the import of solid and surface components.

Parasolid Binary Import/Export

DesignModeler now supports the import of neutral binary Parasolid files with the extension .x_b and .xmt_bin. Use the Import External Geometry File feature, in the File menu, to import Parasolid files.

Primitive Library

DesignModeler allows you to create models quickly by defining primitive shapes that do not require sketches. All the primitive features (sphere, box, parallelepiped, cylinder, cone, prism, pyramid, torus, and bend) require several point and/or direction inputs. These inputs may be defined by either specifically typing in the coordinates or components, or by selecting geometry onscreen. Also, each primitive contains a base plane that identifies the coordinate system in which the primitive is defined.

Scripting API

The Scripting Application Program Interface (API), accessible via the Run Script button in the File menu, has been expanded to include support for Plane features.

Show Problematic Geometry

The Show Problematic Geometry feature, accessible via the context menu of the feature in the Tree Outline, is available when faulty geometry associated with the error or undesired state can be determined for a feature. The feature will point out the faulty topology by selecting it and displaying an annotation containing a description of the error.
STEP Import

DesignModeler now supports the Reader for STEP (Standard for the Exchange of Product model data) on both the Windows and UNIX platforms. Geometry options for STEP within DesignModeler include Simplify Topology, Tolerance, and Replace Missing Geometry.

Symmetry Feature

The new Symmetry feature takes either all the bodies or selected bodies of the model as input and accepts up to three symmetry planes. You can choose either full or partial models to work with. If a full model is used, the selected symmetry planes will slice the model and only a portion of the model will be retained. The feature will operate on solid and surface bodies. It is recommended that you do not change the symmetry plane selection after a model has been transferred to Simulation.

To Next Option of Surface Extension

The Extent property of the Surface Extension feature has been expanded to include a fourth option-To Next. To Next extends the selected surfaces up to the first encountered faces that fully bound the extension. This operation is similar to the To Faces option except you are not required to select the target faces.

New Winding Editor Alignment Option

The Winding Table in the Winding Tool feature has been enhanced to include Rotate Ends as a data line column. Rotate Ends is an optional column with values of Yes/No (1/0 are also accepted). If Yes (or 1), this will rotate the alignment of the connections between slots by 90° to point up/down, parallel to the central axis of the winding. This can be useful for coils that connect slots on opposite sides of the winding (near 180° apart).

CFX-Mesh Release Notes

Edge Spacing

You can now create edge spacing controls on geometrical edges. Edge spacing controls possess the same options that are available for face spacing controls.

Inflation Layer-by-Layer Smoothing

The orthogonality of inflated, prismatic mesh near to inflated surfaces can now be achieved by using the layer-by-layer smoothing option available as part of the Inflation details.

Display Overview

You can now display an overview of features by selecting the appropriate object in the Tree View. For example, all point, line and triangular mesh controls can be displayed simultaneously if you highlight the Controls entry in the Tree View. A similar overview is available for Regions, Virtual Topology, Spacings, Periodicity and Inflation.

Mesh Generation Interrupt

The mesh generation process can now be interrupted using a button on the CFX-Mesh user interface. This is useful if the mesh generation process was started accidentally or the you realize that the mesh settings are unsuitable part way through the mesh generation process.
Hide Option
Composite 2D Regions and Solid Bodies can now be hidden from view as an option when you right-mouse-click on an object in the Tree View. This not only removes the objects from view, but also means that they cannot be selected. For example, if the outer surfaces of a geometry are grouped into a Composite 2D Region and then hidden, the internal surfaces can still be seen and appropriate selections made, avoiding the need to use the selection rectangles.

Virtual Topology Extensions
This release provides full support for Virtual Faces and Virtual Edges. It also allows a wider range of objects to be selected and grouped into Virtual Faces.

Distributed Parallel Meshing
As a beta feature, CFX-Mesh now allows you to use multiple processors on distributed machines to generate the volume mesh. This speeds up mesh generation for large meshes, and also allows the creation of larger meshes than could be generated on a single processor or single machine.

Support For Named Selections
Named Selections created in DesignModeler can be imported into CFX-Mesh as Composite 2D Regions, avoiding the necessity to regenerate the regions.

Simulation Release Notes for 10.0
Thermal Transient Simulations
Users can now perform thermal transient simulations using the following new features that have been added to support this simulation type:

- Initial Condition Object
- Timeline Controller and Tabular Data Window
- Load Histories
- Transient Settings Worksheet
- Transient Settings Object
- Thermal Condition Load
- Heat Convergence Added to Solution Information Output
- Thermal Results (RTH) File Handling
- Output Controls
- Recovering Unconverged Results
- Results Animation Enhancements
- Probe Results
Sequenced Simulation Results Enhancements

Changes have been made at release 10.0 for handling results in a sequenced simulation that were designed to enhance the user experience. Following is a brief description of the results related features that have changed.

- **Animation.** For sequenced results at release 9.0, animation was only done at the currently selected load step. True multi-step animation was therefore not possible. This has been greatly enhanced at release 10.0 to support true multi-step animation across all steps or just a subset.

- **Result Minimum and Maximum over Time.** At release 9.0, only results at the current sequence number were displayed. If a user wanted to find the minimum or maximum over all the time steps, he would be forced to look at each step individually. At release 10.0, the minimum and maximum values across the loads steps are computed and displayed in the Timeline window, greatly facilitating the identification of critical load steps and the review of results at that step.

- **Reviewing Results at Different Sequenced Steps.** At release 9.0, if the database was solved and the user choose a different step in the sequence controller, the program would automatically recalculate the result. This behavior has been changed at release 10.0. After selecting a different sequence number, to calculate the result, the user simply needs to choose Retrieve Results in a context menu available by clicking the right mouse button in either the Timeline window or Tabular Data window. This was done to be consistent with transient results and also to avoid potentially unexpected long delays from the auto calculation that was present in release 9.0 on large models.

- **Resuming Solved Sequenced Databases From Release 9.0 into Release 10.0.** Since the minimum and maximum values over time were not calculated at release 9.0, the Timeline window will be empty. In order to calculate the histories, users need to simply change the sequence number on the result and choose either Evaluate Results or Solve from the Result object context menu. Users wishing to calculate the histories for all results can simply select all the results, perform a Clean operation (on the results only, not on the solution), and choose Solve.

Geometry Enhancements

The following geometry enhancements have been made at release 10.0:

- **Generalized Plane Strain Behavior Added as 2-D Option.** Generalized Plane Strain is now available as a 2-D option for structural and shape simulations. Generalized plane strain assumes a finite deformation domain length in the z direction, as opposed to the infinite value assumed for standard plane strain.

- **ANSYS Element Control.** A new Element Control setting has been added to the Details View of a Geometry object that allows users to manually control the underlying ANSYS element options (KEYOPTS) for the geometry, or have the options program controlled (using the equivalent of the ETCON,SET ANSYS command).

- **OneSpace Designer Modeling 2005.** The reader/plug-in for OneSpace Designer Modeling 2005, revision 13.20 on the Windows platform is now supported.

- **STEP Reader Support.** The reader for STEP (STandard for the Exchange of Product model data) on both the Windows and UNIX platform is now supported.

- **Suppress All Other Bodies.** A Suppress All Other Bodies option has been added that allows users to unsuppress only selected bodies.

Meshing Enhancements

The following meshing enhancements have been made at release 10.0:
- **Gap Tool Expands Gap Sizing Capability.** All gap sizing controls, used in electromagnetic simulations, are now included within a **Gap Tool** object. The gap sizing capability, introduced at the previous release, is more robust because of an improved algorithm. It has been expanded to include a control for identifying face/edge or face/face pairs, and controls for defining multiple gaps within a range specified by the user. The range can be specified as numerical values or as CAD parameters.

- **Contact Sizing Support for Face/Edge Contact.** The **Contact Sizing** tool now has the capability for creating elements from face/edge as well as face/face contact regions.

- **Automatic Virtual Topology.** The creation of virtual cells can now be accomplished automatically for surface bodies in Simulation. Upon inserting a **Virtual Topology** object in the tree, users can specify criterion in the Details View for creating virtual cells. After choosing the **Generate Virtual Cells** context menu option, **Virtual Cell** objects that match the criterion are automatically inserted in the tree.

- **Hard Divisions.** An **Edge Behavior** option has been added to the **Sizing** control that allows users to define hard divisions or element size on a body face or edge. Using hard divisions ignores any **Curv/Proximity** or **Element Size** global settings.

- **Method Options for Uniform Meshing.** Options have been added to the **Method** mesh control tool that creates a uniform mesh of all quad elements or a combination of quad and triangular elements, over the entire part of a selected surface body. The methods are governed by a **Defeaturing Tolerance** and an **Element Size** specification value that is a user input.

- **Renaming Mesh Control Tools.** Any of the mesh control tools can be renamed to include the name of the part or body by using a new **Rename Based on Definition** right mouse button context menu option. For example, a **Refinement** tool scoped to a body named **Tube** can be renamed to **Refinement on Tube** using this new option.

## Loads/Supports Enhancements

The following loads/supports enhancements have been made at release 10.0:

- **Radiation Thermal Load.** A new **Radiation load** has been added for thermal analyses, applicable to 3-D model faces and 2-D model edges. Adjustable settings in the Details View include **Emissivity** and **Ambient Temperature**.

- **ANSYS CFX Load Transfer.** A one way transfer of fluid-structure boundary pressure loads from an ANSYS CFX solution on to the corresponding Simulation model faces is now possible. These surfaces forces are imported as pressure loads in Simulation.

- **Bolt Load Scoping Expanded.** Bolts can now be applied directly to bodies by leveraging a coordinate system to determine the cutting plane.

## Solution Enhancements

The following solution enhancements have been made at release 10.0:

- **Remote Unix Settings Included in WB Cluster** The remote **Solver Process Settings** included in the Details View of the **Solution object** have been streamlined to include all Unix settings under the **WB Cluster**.

- **Weak Spring Stiffness Value Control.** Users now can control the amount of weak spring stiffness for a solution. Prior releases relied strictly on a value supplied by the program. Now, users can add higher stiffness values to compensate for values that may be too weak to enable a solution or cause rigid body motion, or they can merely experiment with different stiffness values to study the impact on their simulation.
• **ANSYS Memory Options.** An option has been added in the Details View under **Process Settings** for changing the workspace and database memory for a solution.

**Results Enhancements**

The following results enhancements have been made at release 10.0:

• **Manual Modal Frequency Sweep Range Added to Harmonic Tool.** A control has been added to the **Harmonic Tool** that allows users specifying **Mode Superposition**, the option of manually inputting the modal frequency sweep range for a harmonic simulation.

• **Strain-Life Fatigue.** Strain-life low-cycle fatigue studies that assume local plastic stress/strain are now included in the fatigue capabilities of Simulation. A new **Hysteresis** result has been added to support this capability.

**Ease of Use Enhancements**

The following ease of use enhancements have been made at release 10.0:

• **Hide All Other Bodies.** An ease of use feature has been added that allows display of only those bodies that belong to a specific contact region. Choosing **Hide All Other Bodies** from a right mouse button click on a **Contact Region** object enables this feature.

• **Collapse Viewing Controls.** Controls have been added under **View** in the main menu that facilitates managing objects in the Simulation tree. When **Collapse to Model** is chosen, all objects collapse under their parent **Model** object. When **Collapse to Environment** is chosen, all objects collapse under their parent **Environment** object.

• **Objects Reference Help Pages.** The Simulation Help includes a reference specification page that represents each object that can display in the Simulation tree view.

**FE Modeler Release Notes for 10.0**

**Unit Selection Available for NASTRAN or ABAQUS Files**

When importing NASTRAN or ABAQUS files into FE Modeler, users can now select one of the five supported unit systems from the Project Page or from a Start Page pop-up window. A custom unit option is also available for scaling base units of length, time, or mass.

**ABAQUS Support**

FE Modeler now allows the user to link to ABAQUS input data and provides support for certain ABAQUS keywords and element types.

**Import and Export Capabilities**

FE Modeler now allows you to import and export ANSYS, ABAQUS, and NASTRAN data files. A Template facility is also available to customize exported data. In addition, the import capability allows material data to be shared between FE Modeler and Simulation via Engineering Data.

**NASTRAN Bulk Data Card Support**

FE Modeler now supports the Loads/Boundary Conditions Card PLOAD4. And for the General Card, GRID, rotated nodes are grouped into a component during import.
DesignXplorer Release Notes for 10.0

Distributed Solving for DesignXplorer DOE

DesignXplorer Design of Experiment (DOE) solutions now have the capability for distributed solving and assume the same settings included in Simulation for specifying remote servers and queues. This feature is available on the Windows, UNIX, and Linux platforms.

Extended DOE

Via the Options control panel in DesignXplorer, you can now select an enhanced template of points for performing a Design of Experiment (DOE) study instead of the default template. Designed for problems with continuous parameters amenable to be fitted by response surfaces, the extended DOE allows you to select either of the optimal designs—Rotatable, Face-Centered, G-Optimal, VIF-Optimal, User-Defined, and Auto. If there is only one input parameter, the enhanced and the original templates are the same.

Linear Thermal Analysis

Linear (constant with respect to temperature, material properties, loads, and boundary conditions) thermal analysis, both 2D and 3D, for all DesignXplorer Variational Technology (VT) approximation types is now available. Supported parameters include geometry, material conductivity, surface heat flux, film coefficient of a surface convection, ambient temperature of a surface convection, temperature, and heat flux.

Load Parameters, SXSFE

Pressure and Surface Force parameterization is now possible in DesignXplorer Variational Technology (VT) for 2D and 3D models via the new SXSFE command in ANSYS. SXSFE defines the surface load of a single element or a set of elements as an input variable of the DesignXplorer VT. DesignXplorer VT will evaluate the derivatives of the result parameter(s) with respect to the surface load. This procedure can be used for parameterization of static models with surface loads or pressure parameters. Edge Force and Vertex Force are not supported.

New Options for DesignXplorer VT

The following settings have been added to the Options dialog box that are applicable to DesignXplorer VT:

* Mesh Morphing Type: Sets the method of mesh morphing in DesignXplorer VT to either the classic or central composite design matrix method.

PCG Solver Supported with ROMS

The Preconditioned Conjugate Gradient (PCG) Solver is now available for use with the Reduced Order Model Sweep (ROMS) approximation method in DesignXplorer Variational Technology (VT). The PCG solver starts with element matrix formulation. Instead of factoring the global matrix, the PCG solver assembles the full global stiffness matrix and calculates the degree of freedom (DOF) solution by iterating to convergence (starting with an initial guess solution for all DOFs). The PCG solver uses a proprietary preconditioner that is material property and element-dependent.

ROMS Method

The Reduced Order Model Sweep (ROMS) is a new variational technology approximation method in the ANSYS Workbench for 2D and 3D models. ROMS provides more accurate parametric results, throughout the hypercube
results space, with larger variation ranges for the input variables and less limitation for the input variables and solution options.

While the default approximation type is still Auto, which automatically picks Taylor or Pade, the ROMS method introduces two new choices: Solver Type and Out-of-core processing. All methods can be set via the Options control panel. Note that modal analysis is not supported by the ROMS method. ROMS is intended for use with parameterization of linear static analysis. As a result, all optimization (Six Sigma Analysis, Robust Design, Goal Driven Optimization, GA, NLPQL, and Monte-Carlo sampling) in DesignXplorer is compatible.

**Third Party Plug-Ins**

The Third Party Plug-In feature is a mechanism by which DesignXplorer interacts with executables and codes that are not native to the ANSYS Workbench environment. Any executable that supports a command line to specify a text based input and output file, can be used by DesignXplorer in a Design of Experiment (DOE) optimization or a Six Sigma Analysis. Alternatively, all scriptable (ActiveX) objects are accessible by wrapping a simple script file around the object.

In order to accomplish generic interaction between process level components, an XML instruction language for DesignXplorer has been developed. Using this language, it is possible to chain a sequence of actions (each may occur in a separate executable or code component) together to define a full process. This process defines a single DOE point, which is treated as a standard Simulation design point in a traditional DesignXplorer DOE study. As a result, all optimization (Six Sigma Analysis, Robust Design, Goal Driven Optimization, GA, NLPQL, and Monte-Carlo sampling) in DesignXplorer is compatible with a user-defined process.

**What-if Parameter Studies**

You can now examine how input parameters affect the output parameters by creating designs in a tabular view. To examine, begin by highlighting the Simulation link in the Project Page hierarchy, add the design points to the tabular view, and click Run in the toolbar. What-If Parameter Studies are also functional with Simulation in Distributed/Asynch mode.

**Engineering Data for 10.0**

**Load History Data**

Engineering Data now allows you to create and manage tabular Load History data. These load histories are used as loads in thermal transient simulations.

**Hyperelastic Material Models and Material Curve Fitting**

Engineering Data now supports Hyperelastic Material Models for use in analysis of rubber-like materials. In addition, a new curve fitting module allows you to compute hyperelastic material coefficients from test data. You can also graphically view the expected behavior for a given set of coefficients.

**Temperature Dependent Properties**

Engineering Data now supports additional Temperature Dependent Properties for Structural and Thermal analyses.

**Strain-Life Parameters for Structural Steel**

Engineering Data now supports strain-life parameters as a material property that can be used in low-cycle fatigue calculations.
Customization and the Workbench SDK for 10.0

For the Windows Operating systems, you may now use Microsoft Visual Studio .NET 2003 when creating applications with the **SDK Applet Generator**. Please see the **ANSYS Workbench Customization Guide** within the **Help** menu bar.
Getting Started with ANSYS Workbench
Getting Started with ANSYS Workbench
Table of Contents

Welcome to the ANSYS Workbench ................................................................. 1–1
Using Help ........................................................................................................ 1–2
Workbench Projects and Databases .............................................................. 1–3
Start Page Navigation .................................................................................... 1–4
  Software Licensing .................................................................................... 1–6
Project Page Navigation ................................................................................ 1–6
  Headlines and Messages ......................................................................... 1–9
Workbench Tabs ........................................................................................... 1–10
Workbench Interface ..................................................................................... 1–10
  Workbench Graphics Controls .............................................................. 1–10
  Rotate ........................................................................................................ 1–10
  Pan ............................................................................................................ 1–10
  Zoom ........................................................................................................ 1–10
  Box Zoom ................................................................................................. 1–11
  Zoom to Fit .............................................................................................. 1–11
  Magnifier Window .................................................................................... 1–11
  Previous View ........................................................................................ 1–11
  Next View ............................................................................................... 1–11
  Isometric View ....................................................................................... 1–11
  Image Capture ......................................................................................... 1–12
  Capped Isosurfaces ................................................................................ 1–12
  Results Animation .................................................................................. 1–13
  Customizing Result Legend ................................................................. 1–14
  Workbench Windows Manager .............................................................. 1–16
  Restore Original Window Layout .......................................................... 1–16
  Window Manager Features .................................................................... 1–16
Workbench Behavior ..................................................................................... 1–17
  Solution Status Monitor ....................................................................... 1–18
  Menu Bar ................................................................................................. 1–20
  Tree View ............................................................................................... 1–21
  List View ................................................................................................ 1–23
  Progress Pane ......................................................................................... 1–23
  Tray Context Menu ................................................................................ 1–24
Workbench Options ....................................................................................... 1–24
Workbench Limitations ................................................................................ 1–28
Technical Support ......................................................................................... 1–28
Welcome to the ANSYS Workbench

The ANSYS Workbench, together with the Workbench projects and tabs, provides a unified working environment for developing and managing a variety of CAE information and makes it easier for you to set up and work with data at a high level.

If you have experience with previous standalone versions of ANSYS DesignSpace, ANSYS AGP (Analysis Geometric Processor), or ANSYS DesignXplorer, you will discover that these applications work in the same way as before. Within the Workbench environment however, they are referred to more as task modules. ANSYS DesignSpace is referred to as Simulation, ANSYS AGP is referred to as DesignModeler, and ANSYS DesignXplorer is referred to as DesignXplorer. Workbench provides enhanced interoperability and control over the flow of information between these task modules.

Typical tasks you can perform in Workbench are:

- Importing models from a variety of CAD systems.
- Conditioning models for design simulations using the DesignModeler.
- Performing FEA simulations using Simulation.
- Optimizing designs using DesignXplorer or DesignXplorer VT.
- Implementing a chosen design back into the original model.

The following is an animated GIF. Please view online if you are reading the PDF version of the help.

Additionally, Workbench includes the following modules:

- Engineering Data: A repository of material data for use by other Workbench applications.
- FE Modeler: Uses input from NASTRAN, ABAQUS, or Simulation, and allows navigating and visualizing of the finite element model for downstream analysis in ANSYS.
- CFX-Mesh: Generates meshes that are ready for Computational Fluid Dynamics (CFD) simulations in the CFX-5 software product.
Using Help

To start, click Help on the toolbar.

- If you are on the Project Page, help topics are available through the following menu options:

  ![Help Menu Example](image)

- If you are working in any of the Workbench modules, that module’s help topics are directly available, along with the Installation and Licensing Help. The following example shows the Help menu available from within the Simulation module:

  ![Help Menu Example](image)

The product online help system describes the features and uses of the ANSYS Workbench. If you are a Windows user, the help system for all ANSYS products is Windows HTML Help. If you are a UNIX user, all ANSYS products use Oracle Help, a Java-based intuitive online help system.

- Each help system is organized into sections, which are listed on the Contents tab. Click the document icon or topic title next to each section to display its content in the right windowpane.

- The Index tab allows you to view topics that are based on predetermined index terms that appear alphabetically in a list. Primary index terms are left-justified in the list while secondary index terms are indented. As you type in a keyword or phrase in the field above the list, matching characters jump to the top of the list and are highlighted. For the Workbench help system, the particular module’s help is displayed in brackets following all primary index terms. To go to the topic represented by a primary or secondary index term, double-click the index term. To find out where you are in the help system, click the Contents tab and the table of contents will display, showing you where the topic is.

- The Search tab allows you to view topics that contain certain words or phrases you specify. When you execute a search, all topics containing the search text display. To go to that topic, double-click the topic. To find out where you are in the help system, click the Contents tab and the table of contents will display, showing you where the topic is.

The Search tab in the Windows Help includes several capabilities to assist you in narrowing down information returned in your searches. Some of these capabilities are:

- Using quotes to search for literal phrases.
- Using Boolean operators (AND, OR, NOT, NEAR) to precisely define search expressions.
- Using wildcard characters (*, ?) to search for expressions with identical characters.
– Using parentheses to nest search expressions.

As an example, if you wanted to search for all sections in the Simulation Help that included both the words “probe” and “timeline”, a suggested term to enter in the Search tab would be “(probe and timel*) near simulation”.

The Search tab in the Windows Help also includes checkboxes located at the bottom of the panel that allow you to search previous results, match similar words, or search titles only.

• The Favorites tab in the Windows Help allows you to save topics that you frequently reference.

Context sensitive help for tree objects is available for some of the Workbench modules, and can be accessed by highlighting the object and pressing the [F1] key.

Core ANSYS Help

A printable English version of the core ANSYS Help is available in PDF format from the ANSYS Customer Portal:


Workbench operation is heavily based on core ANSYS technology. The core ANSYS Help includes descriptions of the underlying commands and elements that interact “behind the scenes” in Workbench. Also included is a theory manual and several guides that detail the background and operation of several types of analyses.

Additional Documentation

In addition to the online Workbench help, the following documentation is available:

• A printable English version of the Workbench Help is available in PDF format at:
  
  <install directory>:\Program Files\ANSYS Inc\v100\CommonFiles\Help\en-us\Workbench.pdf for Windows, and <install directory>:/v100/commonfiles/help/en-us/Workbench.pdf for UNIX.

• ANSYS Workbench Release Notes - print copy of the online version. The printed copy is included in the product box.

• ANSYS Workbench Errata - print version only, included in the product box.

• ANSYS, Inc. Licensing Guide - print copy of the online version. The printed copy is included in the product box.

• ANSYS Workbench Products Installation and Configuration Guide - print copy of the online version. The printed copy is included in the product box.

1 - To view and print the contents of the PDF file, you must have Adobe Reader installed. A free reader download is available at:

http://www.adobe.com/products/acrobat/readstep2.html

Workbench Projects and Databases

ANSYS Workbench uses projects to manage your workflow through the various task modules (DesignModeler, Simulation, FE Modeler, DesignXplorer). A project helps you to manage the various sources of data needed to complete an end-to-end CAE process. For example, if you insert a link to a CAD assembly into a project, an item corresponding to the geometry source appears in a list on the Project Page. You may rename the item or re-link
the item to a different geometry source. You may delete the item from the project list, or delete any associated files along with the project item.

When a project is created, a Workbench project database file is also created. Likewise, when you perform a task within any of the task modules, a database file is also created that is associated with the module. The Workbench project database file contains the project definition and links to the associated module database files. The following filename extensions are associated with each of the database files:

- Workbench project database file = .wbdb
- DesignModeler database file = .agdb
- CFX-Mesh database file = .cmdb
- Simulation database file = .dsdb
- Engineering Data database file = .eddb
- FE Modeler database file = .fedb
- DesignXplorer database file = .dxdb

Note — You should only use database files created in this release or in the previous two releases. The success of using database files created in any older releases cannot be guaranteed.

**Start Page Navigation**

The Start Page is your entry point to the ANSYS Workbench and streamlines the process of creating and accessing data.

You access the Start Page either through your **Start** menu, or from a CAD system’s **ANSYS 10.0** menu. The Start Page appears when Workbench starts and no project is open.

You can perform the following tasks from the Start Page:
· **Select a template to create a new database or project.** Template availability depends on licenses available to your system.

  - Click the **Geometry** template to create DesignModeler data.
  - Click the **Simulation** template to create new Simulation data.
  - Click the **Finite Element Model** template to create new FE Modeler data. You will be prompted to open a NASTRAN bulk data file (*.bdf, *.dat, or *.nas). You can also choose to open an ABAQUS file (*.inp or *.dat). \(^a\)
  - Click the **CFX-Mesh** template to create new CFX-Mesh data.
  - Click the **Empty Project** template to proceed directly to the Workbench Project Page where you can build a project that includes database files from various Workbench sessions.

  Note — Advanced users can build customized templates. Refer to the ANSYS Workbench Software Development Kit (SDK) in the Customization Guide for additional details.

· **Open an Existing Database File.** The **Open** area includes a drop down list of the most recently used database files. Click on a file name to open the database file directly in the associated Workbench module. Not all database types support a recent file list. You can click the **Browse...** button to open a database file whose name is not in the file list, or you can access additional file types. For example, you can run a startup macro by choosing a script file.

  The list is filtered according to your choice in the drop down list.

  - Choose **Workbench Projects** to display only Workbench database files (*.wbdb).
  - Choose **Simulations** to display only Simulation database files (*.dsdb).
  - Choose **DesignModeler Geometry** to display only DesignModeler database files (*.agdb).
  - Choose **DesignXplorer Studies** to display only DesignXplorer database files (*.dxdb).
  - Choose **Finite Element Models** to display only FE Modeler database files (*.fedb). \(^a\)
  - Choose **CFX Meshes** to display only CFX-Mesh database files (*.cmdb).

· **The Tools** section of the Start Page provides two selections:

  - **Options** - Displays a dialog box that allows you to define Workbench options or preferences that modify Workbench's behavior.
  - **Addins** - This option launches the Addins manager dialog. This dialog allows you to load/unload third-party add-ins that are specifically designed for integration within the Workbench environment.

You can enlarge the page by clicking the icon in the upper right corner of the Start Page. This will display more information and minimize scrolling. You can toggle the Start Page back to the smaller size by clicking the icon in the upper right corner again.

\(^a\) If you choose to link to a NASTRAN or ABAQUS file, the **Select Unit System** dialog box appears on the **Project Page** and allows you to select one of the five supported unit systems. A **Custom** choice is also available that allows you to scale base units of length, time, and mass.
Software Licensing

You can choose which simulation license to use for the Workbench session by specifying it under Tools> Options> Licensing> License Management using the Current setting. When choosing this option for the first time only, there may be a time lag until the license list appears. This delay happens the first time within each Workbench session. An analysis license is required for Simulation, ANSYS, and FE Modeler. (DesignModeler and DesignXplorer have license requirements that are separate from the analysis license.)

The license will not be checked out until it is actually needed. For example, if you start a Workbench session, specify an analysis license using this option setting, open DesignModeler, then exit the Workbench session, the license is never checked out.

If you chose a license upon installation, that license will be the default. You can change the default under Tools> Options> Licensing> License Management using the Default setting. Also, you will not be able to exchange one simulation license for another during a Workbench session. To change a license, you must exit the Workbench session and start a new session.

Project Page Navigation

Once you have created or opened an existing Workbench project from the Start Page, a Project Page replaces the Start Page as your project management tool, providing useful options as you move through the various Workbench modules.

A project Name list is displayed on the right that indicates the database files associated with a particular project. When you click on an item name in the Name list, the left panel changes to display options specifically related to the item. These options provide control of the item and its relationships with other items in the Project. For example, CAD geometry files display the following tasks: New geometry, New simulation, and Generate CFX-Mesh. Simulation items display a group of tasks used to update geometry from its source by either pushing or pulling any parameter values. Simulation items also display tasks to create new parametric design studies if a version of DesignXplorer is available. Displayed items are controlled by your current simulation license and the set of other product licenses that are available on the license server. Not all options are controlled by the simulation license selection. For example, the Open CFX-Mesh option is displayed only if you have the appropriate CFX license on the server. New geometry is displayed only if you have a DesignModeler license on the server.
Options Based on Selected Name

The following are summaries of the various options available based on your selection in the Name list:

- Options when you select Project name:
  - Link to an ANSYS APDL input file.
  - Link to a DesignXplorer VT Results file.
  - Link to a NASTRAN bulk data file.\(^a\)
  - Link to an ABAQUS input file.\(^a\)
  - Transfer to DesignModeler to create new geometry, including assigning a name and specifying the length unit to be used.
  - Link to geometry from an open CAD system.
  - Link to geometry from a file.

\[^a\] If you choose to link to a NASTRAN or ABAQUS file, a Unit Selection section appears on the Project Page that allows you to select one of the five supported unit systems. A Custom choice is also available that allows you to scale base units of length, time, and mass.

- Options when you select CAD geometry name:
  - Transfer to DesignModeler and open the selected geometry. This requires that you select a length unit. Then choose Generate from within DesignModeler to display and use the geometry.
  - Transfer to Simulation and open the selected geometry file.
  - Transfer to CFX-Mesh and open the selected geometry file.
  - Set Geometry Preferences. If you choose to import geometry from a CAD system, you can specify preferences on how you would like the geometry to be transferred into Workbench. You can find a description of these preferences included under Geometry Preferences. This section also includes descriptions of geometry preferences you can specify in the Geometry Details View within Simulation.
  - Re-link to geometry from an open CAD system.
  - Re-link to geometry from a file.

  \textit{Note} — This option relocates a file that may have moved. The geometry itself does not update until you select either of the Update options in Simulation.

  - Various editing tasks.\(^1\)

- Options when you select DesignModeler name:
  - Transfer to DesignModeler and open the selected .agdb file.
  - Create and open a copy of the selected .agdb file to add new geometry into the Project Page. This will modify the project to have one more DesignModeler model in the hierarchy. It will also create a file for the new copy.
  - Transfer to Simulation based on the geometry in the selected .agdb file.
  - Set Geometry Preferences.
  - \textbf{Delete...} \(^1\)
• Options when you select Simulation name:
  - Transfer to Simulation and open the selected .dsdb file.
  - Start a new DesignXplorer “What If” study, DesignXplorer study, or DesignXplorer VT study based on the analysis from the selected simulation.
  - Update the selected simulation with parameters and geometry that were specified in the DesignModeler file and in all associative geometry sources.
  - Update the DesignModeler or geometry file using parameters from the selected simulation, then update the selected simulation with the latest geometry.
  - Switch to ANSYS (if you have ANSYS installed) or FE Modeler from the selected Simulation environment(s). (List environments... appears if environment(s) were not yet viewed in Simulation. In this case, click on List environments... to display the list, then click on the environment(s) that you want to transfer.
  - Various editing tasks.¹

• Options when you select FE Modeler name:
  - Transfer to FE Modeler and open the FE model from the selected .fedb file.
  - Transfer to ANSYS (if you have ANSYS installed) and open or continue the analysis from the selected environment.
  - Various editing tasks.¹

• Options when you select DesignXplorer name:
  - Transfer to DesignXplorer and open the selected .dxdb file.
  - Update the selected DesignXplorer study with the latest parameters and values from the input files.
  - Various editing tasks.¹

• Options when you select CFX-Mesh name:
  - Various editing tasks.¹

[1] If you choose Delete..., a dialog box prompts you to choose one of the following options:
  - Delete only the selected item and any dependent items from the project (not any underlying files).
  - Delete the project items and underlying files from the system. The underlying files are listed in the dialog box. This option does not delete CAD files, NASTRAN files, or ANSYS input files.

You can also view Headlines and Messages on the Project Page regardless of which name is highlighted.

Name Dependencies

The indentation level of an item in the Name list implies dependency and data flow. In the examples mentioned above, a design study depends on a simulation, which in turn depends on geometry. For parametric updates, the system pushes parameter values upwards through the dependencies and then updates items top-down. If
the listed file timestamp for a geometry item is newer than the timestamp for a dependent simulation, you may need to update the simulation to incorporate edits made to the geometry.

Each item in the Name list provides a corresponding full path or file name in the list. If only a file name appears, the file exists in the same folder as the location of the project database. A full pathname implies no relationship between the location of the file and the project. Select an item to view its full path in the bar at the bottom of the window.

The icon indicates the state of the item: saved, not saved, or not found. If not found, the item appears in red with an "X". The Project Page toolbar allows you to save individual items or all unsaved items at once. You may also save an item from inside its associated task module. If you close a project with unsaved items, Workbench highlights the items in the Project Page and prompts you to save all, save none, or return to the project.

The Size column is filled in for every Project Page item that has been saved to disk. The Size column shows the size of the file currently on disk, not the expected size of the current data set in memory. For example, suppose you save a Simulation session to a DSDB file of size 200 KB, then continue to work in Simulation, adding branches and generating meshes. Though the memory usage has increased, the Size column will not change its value until you execute another save operation.

**The RTH File Listing (Thermal Simulation)**

For a thermal simulation, an RTH file (.rth) is the thermal results file generated by the ANSYS executable file and referenced by Simulation. The RTH file may be listed with the DSDB under Name. When you select an RTH file, a bullet is displayed in the left panel that describes the purpose of the item. Basic file management is the only task option available when an RTH file is selected, including the option to delete the file from disk.

*Note* — If the item is deleted from the Project Page, the Result File setting for the Solution object in Simulation is not updated. The file name selection is still valid although the file is now currently missing. A new solve will regenerate the file.

**Headlines and Messages**

Current Workbench-related headlines from ANSYS Inc. appear at the bottom of the task panel in the Project page. Click a headline title to view the article in a new web browser window. Headlines download from the internet automatically when you create or open a Project. You can completely turn off this feature by setting Load Headlines at Startup to No in the Options dialog box under User Interface. For dialup Internet connections, the operating system may display an autodial prompt when starting Workbench. To avoid this prompt, you can either disable the headlines feature or deactivate automatic (on demand) dialing.

*Headlines and Messages* will not slow or interrupt your use of Workbench. If anything goes wrong (for example, if your computer cannot connect to the Internet) the *Headlines and Messages* simply won’t appear in the task panel.

**Customizing Headlines and Messages**

Workbench includes a simple news reader that works with RSS, a standard for publishing news article abstracts and links. The mechanism involves Workbench downloading a small XML text file from a specific Internet address. You can view up to three extra headlines from a custom source by typing the address to an RSS feed in the Options dialog box under Custom RSS Feed Address. For example, your ANSYS distributor may provide a feed to regularly updated articles on using Workbench. Or, you may choose a feed from a source such as Yahoo! News to view the day’s top stories. For more information, perform a search on "RSS" on the Internet. Some news feeds may not be compatible with Workbench.
Workbench Tabs

The Start/Project Page, and each of the Workbench modules have a tab that appears at the top of the Workbench window. The tabs appear as each page or module is used in a particular Workbench session. You can click on any tab to immediately access the page or module represented by the tab.

You may work with multiple tabs simultaneously (e.g. the project, a DesignModeler item, a Simulation item, and so on), but you cannot open two tabs associated with the same module. To close an item, click the X button inside its tab. This action only removes the tab, but the data associated with the tab is still in memory, and is accessible from the Project Page.

Workbench Interface

Most of the Workbench modules share a common interface.

Workbench Graphics Controls

The following graphics controls are common to most of the Workbench modules. In some cases their behavior may vary from module-to-module and therefore are more precisely explained in their respective module's Help. Each control listed below is represented by their Tool Tip designation in the Graphical User Interface.

- Rotate
- Pan
- Zoom
- Box Zoom
- Zoom to Fit
- Magnifier Window
- Previous View
- Next View
- Isometric View
- Image Capture
- Capped Isosurfaces
- Results Animation

Rotate

Rotate is one of the four cursor modes accessible via the right mouse button. Module-specific details are available for DesignModeler and Simulation and FE Modeler. Rotate in DesignXplorer exhibits behavior comparable to that in Simulation.

Pan

Pan is one of the four cursor modes accessible via the right mouse button. Module-specific details are available for DesignModeler and Simulation and FE Modeler. Pan in DesignXplorer exhibits behavior comparable to that in Simulation.

Zoom

Pan is one of the four cursor modes accessible via the right mouse button. Module-specific details are available for DesignModeler and Simulation and FE Modeler. Zoom in DesignXplorer exhibits behavior comparable to that in Simulation.
Box Zoom

Box Zoom is one of the four cursor modes accessible via the right mouse button or the toolbar. Module-specific details are available for DesignModeler and Simulation and FE Modeler. Box Zoom in DesignXplorer exhibits behavior comparable to that in Simulation.

Zoom to Fit

Zoom to Fit accessible via the right mouse button or the toolbar. Module-specific details are available for DesignModeler and Simulation and FE Modeler. Zoom to Fit in DesignXplorer exhibits behavior comparable to that in Simulation.

Magnifier Window

The Magnifier Window can be toggled on and off via the toolbar button. It is not accessible via the right mouse button. Module-specific details are available for DesignModeler and Simulation and FE Modeler. Magnifier Window in DesignXplorer exhibits behavior comparable to that in Simulation.

Previous View

To return to the last view displayed in the graphics window, click the Previous View button on the toolbar. By continuously clicking you can see the previous views in consecutive order.

Next View

After displaying previous views in the graphics window, click the Next View button on the toolbar to scroll forward to the original view.

Isometric View

Isometric View Button

The Isometric View button allows you to view your model in the custom isometric state.

Set Button

The ISO icon button allows you to set the isometric view. You can define a custom isometric viewpoint based on the current viewpoint (arbitrary rotation), or define the “up” direction so that geometry appears upright.

Restore Default Button

The Restore Default icon button resets the isometric view to its default state.

Keyboard Support

The same functionality is available via your keyboard. The numbers correlate to the following functionality:

0 = View Isometric
1 = +Z Front
2 = -Y Bottom
3 = +X Right
4 = Previous View
5 = Default Isometric
Image Capture

The Image Capture icon button allows you to save the contents of the Graphics window in a standard image file format. The following file formats are supported:

- Windows Bitmap (.bmp)
- Joint Photographic Experts Group (.jpg)
- Encapsulated PostScript (.eps)
- Tagged Image File (.tif)
- Portable Network Graphics (.png)

Capped Isosurfaces

Capped Isosurface mode displays surfaces through the geometry that correspond to a given value within the calculated range for a selected result. To view a capped isosurface, display the Capped Isosurface toolbar from Simulation or from DesignXplorer.

The value for the isosurface is set by the slider or textbox in the toolbar. The slider represents the range from min to max for the selected result.
The three radio buttons control if any solid geometry remains visible on either side of the isosurface. The leftmost button displays the isosurface only, the center button displays the surface and geometry with values below the surface, the right button displays the surface and values above.

**Results Animation**

An **Animation** toolbar is available to view results from Simulation or from DesignXplorer. Access the toolbar from Simulation or from DesignXplorer. The toolbar is presented below along with descriptions of each animation control.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Play</strong></td>
<td>Initiates a new animation.</td>
</tr>
<tr>
<td><strong>Pause</strong></td>
<td>Pauses an existing animation. Choosing <strong>Play</strong> after <strong>Pause</strong> does not generate new animation frames. When the animation is paused, as you move the cursor across the <strong>Timeline</strong> controller, the cursor’s appearance changes to a double horizontal arrow when you hover over the current frame indicator. With the cursor in this state, you can drag the frame indicator to define a new current frame. The result graphic will update accordingly.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>Halts a result animation. Choosing <strong>Play</strong> after <strong>Stop</strong> generates new animation frames.</td>
</tr>
<tr>
<td><strong>Distributed</strong></td>
<td>For static simulations, frames display linearly interpolated results. Frame 1 represents the initial state of the model and the final frame represents the final results calculated by the solver. For sequenced and transient simulations, the frames in <strong>Distributed</strong> mode are distributed over a time range selected in the <strong>Timeline</strong> controller.¹</td>
</tr>
<tr>
<td><strong>Result Sets</strong></td>
<td>(available only for sequenced and transient simulations) Frames represent the actual result sets that were generated by the solver.¹</td>
</tr>
<tr>
<td>10 Frames</td>
<td>Chooses the number of frames in the animation.</td>
</tr>
<tr>
<td>2 Sec (Auto)</td>
<td>Chooses the desired amount of time for the entire animation.</td>
</tr>
<tr>
<td>8.9 FPS</td>
<td>Read-only indication of the predicted frames per second.</td>
</tr>
<tr>
<td><strong>Export Video File</strong></td>
<td>Saves animation as an AVI file.</td>
</tr>
</tbody>
</table>

*Note* — When exporting an AVI file, make sure that you keep the Workbench module window in front of other windows until the exporting is complete. Opening other windows in front of the module window before the exporting is complete may cause those windows to be included in the AVI file capture.
1 - For sequenced and transient simulations, as you move the cursor across the **Timeline** controller, the cursor’s appearance changes to a scope icon for solved solution points.

**Animation Behavior**

Depending upon the type of simulation that you perform, the behavior of the resulting animation varies.

For a static simulation, the progression of an animation occurs in a linear forward/backward manner. The color contours begin with the initial condition, advance to the solution state, and then “rewinds” to the initial conditions.

For thermal transient and sequenced simulations that have an associated time or step range, the animation begins at the initial time or step value, progresses to the final set, and then stops and starts at zero again. It does not traverse backward as it does for static simulations.

In addition, you may also select a specific time period to animate that is a subset of the total time. To do so, drag the mouse through the time period in the Timeline window pane. The selected time period turns blue. Press the **Play** button (or right-click the mouse and select a **Play** option) to animate only through that period. An animated example of this function is shown below.

*The following is an animated GIF. Please view online if you are reading the PDF version of the help.*

![Timeline Control](image)

**Customizing Result Legend**

You can customize the legend that appears when viewing contour results from Simulation and DesignXplorer using the **Legend** dialog box shown below.
A preview of the contour bar appears on the left and includes the minimum and maximum values of the current legend. After accessing the dialog box from Simulation or from DesignXplorer, you can perform the following tasks with the legend:

- **Set maximum value**: You can enter a custom value in the field at the top of the contour or you can click the adjacent button to accept the default result **Maximum** value calculated by the program. The custom value that you enter must be greater than the default value calculated by the program.

- **Set alarm color for the maximum range**: Click on a red, magenta, or tan button beneath the maximum value field to set the alarm color representing values in the maximum contour range. The default color is red.

- **Set lower value for the maximum range**: You can enter a custom value in the second field from the top of the contour or you can click the adjacent button to accept the default **Automatic** value calculated by the program.

- **Set number of bands between the bottom and top of the contour**: You can set this value using the + or - buttons, or by entering a value in the adjacent field. The number of bands can range from 1 to 14.

- **Set upper value for the minimum range**: You can enter a custom value in the second field from the bottom of the contour or you can click the adjacent button to accept the default **Automatic** value calculated by the program.

- **Set alarm color for the minimum range**: Click on a red, magenta, or tan button toward the bottom of the contour to set the alarm color representing values in the minimum contour range. The default color is blue.

  **Note** — The same alarm color cannot be selected for both maximum and minimum ranges.

- **Set minimum value**: You can enter a custom value in the field at the bottom of the contour or you can click the adjacent button to accept the default result **Minimum** value calculated by the program. The custom value that you enter must be less than the default value calculated by the program.

- **Change the color spectrum**: Choose one of the four buttons in the **Color** area to set the contour color spectrum from red to blue, blue to red, white to black, or black to white.
Change the position of the legend: Choose one of the four buttons in the **Position** area to set the position of the legend to one of the following locations in the **Geometry** window: left/vertical, right/vertical, top/horizontal, or bottom/horizontal.

Adjust the size of the legend: Choose a radio button in the **Size** area to determine the amount of space that the legend can occupy in the **Geometry** window.

Save and restore legend settings to and from an XML file: Choose the Export or Import button to perform either of these tasks. After choosing the Export button, you are prompted to save the legend settings in an XML file to the file path location of your choice.

Reset settings to factory default values: Choose the **Reset** to perform this task.

**Note** — Be aware of the following regarding customized legend settings:

- If you insert a **Figure** object that includes customized legend settings, these settings are stored with the **Figure** object. Legend settings are **not** saved in the database file for results however.
- You can change the **Position** setting for all result items. The remaining settings may not be available for certain result items (such as results under the **Shape Tool** or **Fatigue Tool**).

### Workbench Windows Manager

The Workbench window contains a number of panes that house graphics, outlines, details and other views and controls. The window manager allows you to move, resize, tab dock and autohide panes.

Tab dock means that two or more panes reside in the tabs in the same space on screen.

Autohide means that a pane (or tab docked group of panes) automatically collapses when not in use to free screen space.

**Note** — The management of these windows differs on Windows platforms vs. UNIX platforms.

### Restore Original Window Layout

Choose “Restore Original Window Layout” from the View menu to return to the default original pane configuration.

### Window Manager Features

#### AutoHiding

Panes are either pinned or unpinned. Toggle this state by clicking the icon in the pane title bar.

A pinned pane occupies space in the Workbench window. An unpinned pane collapses to a tab on the periphery of the window when inactive.

To work with an unpinned pane, move the mouse pointer into the tab; the pane will fly out on top of other panes in the Workbench window. The pane will remain visible as long as it is active or contains the mouse pointer. Pin the pane to restore its previous configuration.

#### Moving and Docking

Drag the title bar to move a pane, or drag a tab to undock panes. Once the drag starts a number of dock targets appear overtop the Workbench window:
Move the mouse pointer over a target to preview the resulting location for the pane. Arrow targets indicate adjacent locations; a circular target allows tab-docking of two or more panes (to share screen space). Release the button on the target to move the pane.

Abort the drag operation by pressing the [ESC] key.

Resize panes by dragging the borders.

**Workbench Behavior**

When transitioning between the ANSYS Workbench modules, expect to encounter unique behavioral scenarios as described below.

**Open an Existing Database**

From the Start Page when you choose to open an existing database, either Simulation (.dsdb), DesignModeler (.agdb), or DesignXplorer (.dxdb), you are prompted to select a project name and location under the heading entitled “Choose a default project name and location”. The project name is the default name for any .dsdb, .agdb, or .dxdb. If you have an existing file with the same name in your project folder, you will be prompted for permission to overwrite that file. If you want to preserve the existing file, choose a different project folder on the Start Page.

*Note* — In order to maintain data link integrity, ANSYS Workbench must create these files for you upon project startup. Failure to do so may cause the following error message to appear:
Deleting Files From A Project

When you delete a file from a project, you are given options of deleting only the selected item and any dependent items from the system (not any underlying files), or deleting the selected item, dependent items, and all underlying files from the system (not including CAD, NASTRAN, or ANSYS input files). If you choose the first option, removing a file from a project does not remove it from the disk. If you choose the second option, selected items and their associated files listed in the dialog box will be deleted from the disk. If you don’t remove the file from a project and attempt to create a new project item, a new name is generated, generally with a number appended to the original name. If you remove the file, then the original name could be reused.

File Dependencies

When attempting to open a project that includes database files from more than one of the ANSYS Workbench modules, you must be sure the files are in their original location, or in the same folder, for the project to construct properly. For example if the DesignXplorer database (.dxdb) cannot find the Simulation database (.dsdb) or DesignModeler database (.agdb) that it is dependent upon, the project will be constructed with only the .dxdb and DesignXplorer can only be used to view the saved results.

CAD Plug-Ins

In a third-party CAD program, when you select the ANSYS 10.0 option, the drop-down menu allows you to select either Simulation or Workbench. When you choose the Simulation option, you are directed into the Simulation module of ANSYS Workbench and the CAD geometry is automatically transferred. A default Simulation database (dsdb) name and location is created. If you save the data, the file name and location default to match your CAD file and location. If the .dsdb already exists a warning message allows you to overwrite the file.

When you choose the Workbench option, you are redirected to the Start Page.

Solution Status Monitor

The Solution Status Monitor allows you to view and manage local and remote asynchronous solutions. Using its features, you can filter jobs (display your choice of completed, running, pending, and failed jobs), manage local queues and servers, view and delete jobs, and monitor the progress of a job. The monitor also provides a New Job Desktop Alert that informs you when a new job has been submitted. It is a single instance application that, by default, loads in the Windows system tray, but you can also choose to run it in full-window mode.

Solution Status Monitor User Interface

This section examines the functional elements of the Solution Status Monitor user interface. A screen capture of the application is shown below.
The functional elements of the interface include the following.

<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Bar</td>
<td>Provides selectable menu options.</td>
</tr>
<tr>
<td>Tree View</td>
<td>Allows you to filter jobs.</td>
</tr>
<tr>
<td>List View</td>
<td>Displays current jobs. You may delete jobs from this area.</td>
</tr>
<tr>
<td>Progress Pane</td>
<td>Displays the solution activity as well as solution log messages.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Displays the <strong>Delete</strong> button. This button deletes a currently selected job or jobs. It is the same as using the <strong>Remove</strong> option of the <strong>List View</strong> context menu or the delete key.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Located at the bottom of the interface window, it contains two panes:</td>
</tr>
<tr>
<td></td>
<td>• Information pane – shows the status of the application and displays informative tips when you hover your mouse above a menu item.</td>
</tr>
<tr>
<td></td>
<td>• Job count pane – displays the number of jobs displayed in the list view.</td>
</tr>
<tr>
<td>Tray</td>
<td>The tray context menu is a duplication of options available via the main menu.</td>
</tr>
</tbody>
</table>

In addition, to the options described above, the **Solution Status Monitor** interface provides two other interactive elements that include:

- **Solution Status Tray** - Double clicking the tray icon displays the solution status monitor main window. The tray icon changes based on the status of jobs (no jobs running, at least one job is running; at least one job has failed). A tool tip is available on the tray icon to display the current status of jobs.

- **New Job Desktop Alert** - The New Job Desktop Alert automatically displays when a new job is submitted. It displays the running, and finished jobs. The number of pending jobs (in addition to running and finished jobs) is also displayed in the window title. Tool tips are available on the individual jobs. If all jobs are finished, the desktop alert will disappear automatically. If you wish to hide the desktop alert, use the menu options or tray context (right-click) menu to turn it off. Closing the desktop alert will not cause it to hide itself, it will pop-up again as long as jobs are available. Finished jobs can be hidden by using the **Tools>Options** menu or the tray context menu. A screen capture of this window is shown below.
### Menu Bar

The menu bar provides the following functions.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selections</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>Close</td>
<td>Hides the main form - the tray icon continues running.</td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td><strong>Always On Top</strong></td>
<td>Solution status monitor remains in front of all other windows unless minimized.</td>
</tr>
<tr>
<td></td>
<td><strong>Hide When Minimized</strong></td>
<td>Hides the solution status monitor when it is minimized.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td><strong>Local Jobs</strong></td>
<td>Shows or hides locally running jobs.</td>
</tr>
<tr>
<td></td>
<td><strong>WB Cluster</strong></td>
<td>Displays or hides jobs running on the specified RSM web server.</td>
</tr>
<tr>
<td></td>
<td><strong>LSF Cluster</strong></td>
<td>Displays or hides jobs running on LSF.</td>
</tr>
<tr>
<td></td>
<td><strong>All owner jobs</strong></td>
<td>Displays or hides jobs that belong to owners other than yourself (if checked, shows your jobs and other owners, otherwise displays only jobs which you own).</td>
</tr>
<tr>
<td></td>
<td><strong>Progress Pane</strong></td>
<td>Displays or hides the progress pane.</td>
</tr>
<tr>
<td></td>
<td><strong>Refresh Now</strong></td>
<td>Forces the solution status monitor to update now, regardless of the update speed setting.</td>
</tr>
<tr>
<td><strong>Update Speed</strong></td>
<td></td>
<td>Provides the following submenu selections:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• High - updates the display automatically every 2 seconds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Normal - updates the display automatically every 4 seconds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Low - updates the display automatically every 8 seconds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Paused - the display will not automatically update.</td>
</tr>
<tr>
<td><strong>Tools</strong></td>
<td><strong>Desktop alert</strong></td>
<td>Shows or hides the new job desktop alert window.</td>
</tr>
<tr>
<td></td>
<td><strong>Remove</strong></td>
<td>Deletes the selected job or jobs.</td>
</tr>
<tr>
<td></td>
<td><strong>Options</strong></td>
<td>Displays the Solution Status Monitor options window.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td><strong>ANSYS Solution Status Help</strong></td>
<td>Displays the Help system in another browser window.</td>
</tr>
<tr>
<td></td>
<td><strong>About ANSYS Solution Status</strong></td>
<td>Provides information about the program.</td>
</tr>
</tbody>
</table>
Tree View

Based on the clusters you have selected to view (Local Jobs, WB Cluster, or LSF Cluster) and which owners you have selected to view (All Owner Jobs or not) All Jobs displays all currently running jobs with respect to the filters you have selected.

Beneath All Jobs there are several filtering options available for customizing what is displayed in the list view. You may filter your choice of completed, running, pending and failed jobs in the list view. The tree view also contains a list of servers and queues setup on your local machine that can be configured via the context (right-click) menu.

Tree View Context Menu

The Tree View provides the following options through context (right-click) menus:

<table>
<thead>
<tr>
<th>Context (right-click) Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queues</td>
<td>Add - Displays the queue properties dialog box and allows you to configure a queue to be added.</td>
</tr>
<tr>
<td>Servers</td>
<td>Add - brings up the server properties dialog and allows you to configure a server to be added</td>
</tr>
</tbody>
</table>
| Queue (Local)              | • Properties - displays the queue properties dialog to edit a queue.  
                              • Delete - deletes the selected queue from the queues. |
| Server (LocalHost)         | • Properties - displays the server properties dialog to edit a server.  
                              • Delete - deletes the selected server from the servers. |
| Add (Server)               | Displays a Server Properties dialog to configure the new server to be added. Pressing OK commits your configured server and adds it to the servers collection. Pressing Cancel discards the server and it is not be added to the servers collection. |
| Add (Queue)                | Displays a Queue Properties dialog box that allows you to configure the new queue to be added. Pressing OK commits your configured queue and adds it to the queues collection. Pressing Cancel discards the queue, and does not add it to the queues collection. |
Context (right-click) Menu

**Server Properties**

**General field contents:**
- Name - the name of the server (should be different from other servers).
- MachineName - server machine name.
- Enabled - is the server available for use.
- Working Directory - the directory used to hold job files.

**User Authentication field contents:**
- User - the user name or account on which jobs run.
- **Password** - a user's password. Place your cursor in the field and then press the button to edit the user's password on the **Change Server Password** dialog box.
- Domain - the user's domain.
- Press the **OK** to accept your changes or press **Cancel** to discard changes.
- Press the **Test Server** button to test the server's connectivity.

**Test Server Button**

This dialog box displays the status of the server test (succeeded or failed) and a viewer to display the server's log to help diagnose why the server connectivity test may have failed.
Context (right-click) Menu

Queue Properties Dialog Box

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General field:</strong></td>
</tr>
<tr>
<td>- <strong>Name</strong> - the name of the queue (should be different from other queues).</td>
</tr>
<tr>
<td>- <strong>Enabled</strong> - indicates whether or not the queue is available for use.</td>
</tr>
<tr>
<td>- <strong>Assigned Servers</strong> - lists all of the available servers by this queue. Selecting the checkbox next to a server assigns that server to the queue and deselecting it unassigns the server.</td>
</tr>
<tr>
<td>- Press the <strong>OK</strong> button to accept changes or <strong>Cancel</strong> to discard changes.</td>
</tr>
</tbody>
</table>

Change Server Password

| Enter your password into both boxes and press **OK** to commit your password. If the password entries do not match, you are alerted. Press **Cancel** to discard a password change. |

List View

You can customize which fields are displayed in the list view using the context (right-click) menu. You may also sort the displayed fields by selecting the appropriate column you wish to sort. You may delete jobs that belong to you by clicking the delete button in the toolbar, or clicking **Remove** in the context menu, or pressing the delete key. The List View supports the deletion of multiple jobs by highlighting the jobs you wish to remove and following the above steps to delete them. If you delete a job, the job may not be removed from the list view immediately. It will disappear the next time the List View is refreshed.

List View Context Menu Options

The List View context menu provides the following options:

- **Remove** - same as main menu.
- **Job** - always available.
- **Status** - display or hide the status column.
- **Submitted** - display or hide the submitted column.
- **Owner** - display or hide the owner column.
- **Server** - display or hide the server column.
- **Queue** - display or hide the queue column.

Progress Pane

This pane provides the following fields:
- The **Progress** bar is not real progress at version 10.0. It indicates that the job is active. Actual progress will be implemented in a future release.

- The **Phase Progress** field is not real progress. It indicates that the job is active.

- The **Log Messages** field displays messages about the job. You can copy the log messages using the context menu or the Copy (`Ctrl+C`) key combination.

### Tray Context Menu

By right-clicking the **Tray** icon, you receive the following options:

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options</strong></td>
<td>Displays the <strong>Options</strong> dialog box, which includes:</td>
</tr>
<tr>
<td></td>
<td>- <strong>RSM Web Server</strong> field – the remote RSM server on which to view running jobs.</td>
</tr>
<tr>
<td></td>
<td>- <strong>New Job Desktop Alert Settings</strong> fields, which includes the following:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Show Running Jobs</strong> - always available.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Show Pending Jobs</strong> – always available.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Show Completed Jobs</strong> - completed jobs can be optionally shown in the New Job Desktop Alert window.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Same as Menu Bar option.</td>
</tr>
<tr>
<td><strong>About</strong></td>
<td>Same as Menu Bar option.</td>
</tr>
<tr>
<td><strong>Local Jobs</strong></td>
<td>Same as Menu Bar option.</td>
</tr>
<tr>
<td><strong>WB Cluster</strong></td>
<td>Same as Menu Bar option.</td>
</tr>
<tr>
<td><strong>LSF Cluster</strong></td>
<td>Same as Menu Bar option.</td>
</tr>
<tr>
<td><strong>All Owner Jobs</strong></td>
<td>Same as Menu Bar option.</td>
</tr>
<tr>
<td><strong>Desktop Alert</strong></td>
<td>Same as Menu Bar option.</td>
</tr>
<tr>
<td><strong>Open Job Status</strong></td>
<td>Displays the main solution status monitor window.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Exits the <strong>Solution Status Monitor</strong>.</td>
</tr>
</tbody>
</table>

### Workbench Options

You can set several options or preferences that govern Workbench behavior from the Start Page or by performing the following procedure from within any of the Workbench tabs.

1. From the main menu, choose **Tools > Options**. An **Options** dialog box appears and is identical regardless of where you accessed the menu item.

2. Expand any of the major options listed on the left then click on a specific option within that category.

3. Change any of the option settings by clicking directly in the option field on the right. You will first see a visual indication for the kind of interaction required in the field (examples are drop down menus, secondary dialog boxes, direct text entries).

4. Click **OK**. Whenever an option is changed, the change is reflected in all of the applications or task modules running inside Workbench. The options that you set are persistent from run to run.
**Common Settings**

The **Common Settings** options include general options governing graphics and interfacing.

**Common Settings: Graphics Style**

The **Graphics Style** category includes:

- **Background Style**: sets a solid graphic background or a gradient background that varies from top to bottom, left to right, or diagonally. The default is the top to bottom gradient.

- **Background Color**: sets a graphic background color from the built-in color palette. The default color is blue.

- **Background Color2**: sets a second graphic background color from the built-in color palette. The second color is used for gradient background displays. For example, if you want a top-bottom gradient that starts out white and ends up black, **Background Color** should be set to white and **Background Color2** should be set to black. The default color is white.

- **Edge Color**: sets the color of all edges from the built-in color palette. The default color is black.

- **Unshared Edge Color**: sets the color of all edges that are not touching. This is useful for finding modeling errors in sheet parts. For example, if you see a red line running through the middle of a sheet part, you'll know that the surfaces on either side of the line do not share an edge, even though it appears that they do. Colors from the built-in color palette are available. The default color is red.

- **Mesh Edge Color**: sets the color of all meshed edges from the built-in color palette. The default color is gray.

- **Text Color**: sets the color of all text from the built-in color palette. The default color is black.

**Common Settings: Graphics Interaction**

The **Mouse Buttons** category includes options for setting the various button controls on the mouse as well as button combinations with the [Shift] and [Ctrl] keys.

The **Rotation** category has the following setting:

- **Dynamic Viewing**: If set to *Yes* and you are making a standard view change (such as front, back, left, right, bottom, top, isometric, and Look At Face/Plane/Sketch) a short animation is drawn showing the model moving/twisting toward its final pose. When set to *No*, there is no animation shown and the view is immediately changed to the model's final pose. The default setting is *Yes*. Choose *No* if you are using an older graphics card.

The **Spaceball** category has the following setting:

- **Use Spaceball**: enables the use of the Spaceball 3D import device (not supported in UNIX). The default setting is *Yes*.

The **Selection** category has the following setting:

- **Extend Selection Angle Limit (degrees)**: Sets a limit in degrees for what kind of face and edge angles the system considers “smooth”. This affects the Extend to Adjacent and Extend to Limits Extend Selection toolbar buttons in DesignModeler. Extend Selection buttons are also present in Simulation. The default value is 20° and the range is from 0° to 90°.
Common Settings: User Interface

The Startup category includes:

- **Custom Start Screen Configuration URL**: Address of an XML configuration file that defines custom content for the Start Page screen.

You can also develop and maintain several XML configuration files that each define various additional applications to appear on the Start Page screen. Further details on this advanced task and on the overall customization of Workbench are included in the ANSYS Workbench Software Development Kit (SDK) section of the Customization Guide.

- **Load Headlines at Startup**: Indicates if the Headlines and Messages section should appear on the Project Page when Workbench is started. The default is *Yes*.

- **Custom RSS Feed Address**: URL to a custom RSS to allow the Headlines and Messages section to list headlines from that RSS.

The Value Display category includes:

- **Number of Significant Digits**: Sets the number of digits that appear for numbers throughout Workbench. The default is *5* and the range is from *3* to *8*. This setting affects only the numbers that are displayed. It does not imply any numerical round off of internal calculations.

The Menus/Toolbars category includes:

- **Show Beta Options**: Allows testing of unreleased Workbench features. The default is *No*. Beta features remain untested in this release and therefore are neither documented nor supported.

- **Omit Text on Toolbars**: Indicates if text tips are to be omitted from toolbar buttons. The default is *No*.

The File Management category includes:

- **"Save As" Preferred Default**: Determines the default settings when you choose File > Save As.... The following choices are available:
  - Name and location of most recent link (e.g., CAD file) [default]
  - Location of most recently saved database

Under certain conditions such as creating a new simulation from CAD, the default file name and location are based on the geometry file. If you prefer to organize databases in a separate location, adjusting this option may provide a more convenient default.

The CAD Licensing Management category includes:

- **CAD Licensing**: Determines whether the CAD license will be released when not in use. During DesignXplorer studies and Simulation parameter manager runs, when the CAD license is accessed repeatedly, the license may not always be available if the Release option is used. The following choices are available:
  - Release (default)
  - Hold

The Solution Status Startup Management category includes:
• **Start**: Controls the startup of the *Solution Status Monitor* available on Windows platforms only. The following choices are available:

  - **When ANSYS Workbench starts** (default): Starts the *Solution Status Monitor* whenever Workbench starts. If you choose this option and if you had closed the *Solution Status Monitor*, the *Solution Status Monitor* will start when an asynchronous solution is performed.
  
  - **I will start it myself**: Allows you to start the *Solution Status Monitor* manually from the *Start* menu using ANSYS10.0> Workbench Utilities> ANSYS Solution Status Monitor.
  
  - **Use old Solution Status**: Allows you to use the *Job Status* tab in Simulation. This option will not be available in future releases.

**Common Settings: Geometry Import**

Refer to the Geometry Preferences section located in the Simulation help.

**DesignModeler**

Refer to the DesignModeler Options section located in the DesignModeler help.

**CFX-Mesh**

Refer to the CFX-Mesh Options section located in the CFX-Mesh help.

**Simulation**

Refer to the Simulation Options section located in the Simulation help.

**DesignXplorer**

Refer to the DesignXplorer Options section located in the DesignXplorer help.

**FE Modeler**

Refer to the FE Modeler Options section located in the FE Modeler help.

**Licensing: License Management**

When you choose this folder for the first time in a Workbench session, there may be a time lag until the options appear.

The **Solver** category includes:

• **Current**: Specifies the license to use for the Workbench session. You choose a license from a drop down list of license names. If you choose **Use Default** (one of the options in the list), the license reverts to the **Default** setting described below.

• **Default**: When you start a Workbench session, the license stated here will be used. You can change the default license by choosing it from a drop down list that is similar to the one used for the **Current** setting.
Note — The Current license selection overrides the Default selection for the current Workbench session only. The next time you run Workbench the Current selection will be restored to Use Default. Conversely, the Default license selection is persistent from run to run.

Workbench Limitations

The following limitation applies to the Workbench environment and is not limited to a particular module.

Startup Limitation

You should avoid using a configxx.ans file when using Workbench. Specifically, issuing the ANSYS command /CONFIG,NOELDBW,1 causes solving problems in Workbench. Also, Workbench ignores any startxx.ans and stopxx.ans files.

Technical Support

We are dedicated to producing the world’s finest mechanical design software tools. Please contact your ANSYS support provider for any questions you may have on this product.
DesignModeler Help
# Table of Contents

**Welcome to the DesignModeler 10.0 Help** ................................................................. 1–1
  Overview .......................................................................................................................... 1–1
  Introduction to DesignModeler ....................................................................................... 1–2
  Introduction to the Modeling Environment ..................................................................... 1–2
    Introduction to Parametric Sketching and Modeling ...................................................... 1–2
  Process for Creating A Model ......................................................................................... 1–3

**Typical Usage** .................................................................................................................. 2–1
**Menus** ............................................................................................................................. 3–1

  **File Menu** .................................................................................................................... 3–1
    New ................................................................................................................................. 3–2
    Start Over ...................................................................................................................... 3–3
    Open ............................................................................................................................... 3–3
    Close DesignModeler .................................................................................................... 3–3
    Save ............................................................................................................................... 3–3
    Save As .......................................................................................................................... 3–4
    Export ............................................................................................................................ 3–4
    Attach to Active CAD Geometry .................................................................................... 3–4
    Import External Geometry File ...................................................................................... 3–9
    Import and Attach Options ............................................................................................ 3–12
    Run Script ...................................................................................................................... 3–13
    Print ............................................................................................................................... 3–14
    Auto-save Now ............................................................................................................... 3–14
    Image Capture ............................................................................................................... 3–14
    Restore Auto-save File ................................................................................................. 3–14
    Recent AGDB Files ........................................................................................................ 3–15
    Recent Imports ............................................................................................................... 3–15
    Recent Scripts .............................................................................................................. 3–15
    Exit Workbench ............................................................................................................ 3–15

  **Create Menu** .............................................................................................................. 3–16

  **Concept Menu** ............................................................................................................ 3–17

  **Tools Menu** ................................................................................................................ 3–18

  **View Menu** ............................................................................................................... 3–19

  **Help Menu** ............................................................................................................... 3–20

  **Context Menus** ......................................................................................................... 3–20
    Suppress/Hide Part and Body ....................................................................................... 3–20
    Suppress/Hide Parts from Tree Outline ........................................................................ 3–21
    Named Selection from Model View Window ............................................................... 3–22
    Form New Part ............................................................................................................. 3–22
    Explode Part ................................................................................................................. 3–24
    Edit Selections .............................................................................................................. 3–25
    Feature Insert ............................................................................................................... 3–25
    Feature Suppression ..................................................................................................... 3–25
    Show Problematic Geometry ....................................................................................... 3–26
    Show Dependencies ...................................................................................................... 3–27
    Sketch/plane right mouse button options .................................................................... 3–28
    Delete right mouse button option in Model and Details View ...................................... 3–28
    Delete right mouse button option in Tree Outline ...................................................... 3–28
    Sketch Instances ......................................................................................................... 3–28
    Quick Cut Copy Paste .................................................................................................. 3–30
    Measure Selection ........................................................................................................ 3–30
<table>
<thead>
<tr>
<th>Section</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Model</td>
<td>4-1</td>
</tr>
<tr>
<td>Model Appearance Controls</td>
<td>4-1</td>
</tr>
<tr>
<td>Shaded Display</td>
<td>4-1</td>
</tr>
<tr>
<td>Shaded Display with 3D Edges</td>
<td>4-1</td>
</tr>
<tr>
<td>Wireframe Display</td>
<td>4-2</td>
</tr>
<tr>
<td>Show Frozen Bodies in Transparent Mode</td>
<td>4-2</td>
</tr>
<tr>
<td>Show Edge Joints</td>
<td>4-2</td>
</tr>
<tr>
<td>Show Cross Section Alignments</td>
<td>4-3</td>
</tr>
<tr>
<td>Show Cross Section Solids</td>
<td>4-3</td>
</tr>
<tr>
<td>Triad</td>
<td>4-4</td>
</tr>
<tr>
<td>Ruler</td>
<td>4-4</td>
</tr>
<tr>
<td>Context Menu Viewing Options</td>
<td>4-5</td>
</tr>
<tr>
<td>Display Toolbar</td>
<td>4-6</td>
</tr>
<tr>
<td>Display Plane</td>
<td>4-6</td>
</tr>
<tr>
<td>Display Model</td>
<td>4-6</td>
</tr>
<tr>
<td>Look at Face/Plane/Sketch</td>
<td>4-6</td>
</tr>
<tr>
<td>Rotation Modes</td>
<td>4-7</td>
</tr>
<tr>
<td>Rotate</td>
<td>4-7</td>
</tr>
<tr>
<td>Pan</td>
<td>4-7</td>
</tr>
<tr>
<td>Zoom</td>
<td>4-7</td>
</tr>
<tr>
<td>Box Zoom</td>
<td>4-7</td>
</tr>
<tr>
<td>Zoom to Fit</td>
<td>4-7</td>
</tr>
<tr>
<td>Magnifier Window</td>
<td>4-7</td>
</tr>
<tr>
<td>Previous View</td>
<td>4-8</td>
</tr>
<tr>
<td>Next View</td>
<td>4-8</td>
</tr>
<tr>
<td>Isometric View</td>
<td>4-8</td>
</tr>
<tr>
<td>Print Preview</td>
<td>4-9</td>
</tr>
<tr>
<td>Window Layout</td>
<td>4-10</td>
</tr>
<tr>
<td>Restore Original Window Layout</td>
<td>4-10</td>
</tr>
<tr>
<td>2D Sketching</td>
<td>5-1</td>
</tr>
<tr>
<td>Sketches and Planes</td>
<td>5-1</td>
</tr>
<tr>
<td>Construction Sketches</td>
<td>5-2</td>
</tr>
<tr>
<td>Color Scheme</td>
<td>5-3</td>
</tr>
<tr>
<td>Auto Constraints</td>
<td>5-3</td>
</tr>
<tr>
<td>Details View in Sketching Mode</td>
<td>5-4</td>
</tr>
<tr>
<td>Sketch Details</td>
<td>5-4</td>
</tr>
<tr>
<td>Edge Details</td>
<td>5-6</td>
</tr>
<tr>
<td>Dimension Details</td>
<td>5-7</td>
</tr>
<tr>
<td>Right mouse button option items with (icon) check marks</td>
<td>5-7</td>
</tr>
<tr>
<td>Draw Toolbox</td>
<td>5-8</td>
</tr>
<tr>
<td>Line</td>
<td>5-9</td>
</tr>
<tr>
<td>Tangent Line</td>
<td>5-10</td>
</tr>
<tr>
<td>Line by 2 Tangents</td>
<td>5-10</td>
</tr>
<tr>
<td>Polyline</td>
<td>5-10</td>
</tr>
<tr>
<td>Polygon</td>
<td>5-10</td>
</tr>
<tr>
<td>Rectangle</td>
<td>5-11</td>
</tr>
<tr>
<td>Rectangle by 3 Points</td>
<td>5-11</td>
</tr>
<tr>
<td>Oval</td>
<td>5-12</td>
</tr>
</tbody>
</table>
Grid ................................................................................................................................. 5–31
Major Grid Spacing ........................................................................................................... 5–31
Minor-Steps per Major ........................................................................................................ 5–32
Snaps per Minor ............................................................................................................... 5–32
Selection .............................................................................................................................. 6–1
Selection Toolbar .............................................................................................................. 6–3
New Selection ..................................................................................................................... 6–3
Select Mode ......................................................................................................................... 6–3
Selection Filter: Points ....................................................................................................... 6–5
Selection Filter: Sketch Points (2D) .................................................................................. 6–5
Selection Filter: Model Vertices (3D) ................................................................................ 6–5
Selection Filter: PF Points (Point Feature Points, 3D) ..................................................... 6–5
Selection Filter: Edges ....................................................................................................... 6–5
Selection Filter: Sketch Edges (2D) .................................................................................. 6–5
Selection Filter: Model Edges (3D) ................................................................................... 6–5
Selection Filter: Line Edges (3D) ....................................................................................... 6–5
Selection Filter: Faces ....................................................................................................... 6–5
Selection Filter: Bodies ...................................................................................................... 6–6
Selection Filter: Solid Bodies (3D) ................................................................................... 6–6
Selection Filter: Line Bodies (3D) .................................................................................... 6–6
Selection Filter: Surface Bodies (3D) ................................................................................ 6–6
Extend Selection ................................................................................................................ 6–6
Extend to Adjacent .............................................................................................................. 6–6
Extend to Limits .................................................................................................................. 6–7
Flood Blends ....................................................................................................................... 6–7
Flood Area .......................................................................................................................... 6–8
Graphical Selection ............................................................................................................. 6–9
Highlighting ........................................................................................................................ 6–9
Picking ................................................................................................................................ 6–9
Painting ............................................................................................................................... 6–10
Depth Picking ...................................................................................................................... 6–10
Planes and Sketches ........................................................................................................... 7–1
Active Plane/Sketch Toolbar ............................................................................................... 7–1
Active Plane Drop Down .................................................................................................... 7–1
New Plane .......................................................................................................................... 7–1
Terminology ........................................................................................................................ 7–2
Reference Geometry ........................................................................................................... 7–2
Point Reference ................................................................................................................... 7–2
Direction Reference ............................................................................................................ 7–2
Plane Properties .................................................................................................................. 7–3
Plane Transforms ............................................................................................................... 7–3
Tangent Plane ..................................................................................................................... 7–6
Plane Preview ...................................................................................................................... 7–6
Rotation Axis Rules ............................................................................................................ 7–8
From-Face Plane, Planar vs. Curved-Surfaces Faces Behavior ............................................ 7–8
Offset Before Rotate Property ............................................................................................ 7–9
Apply/Cancel in Plane ......................................................................................................... 7–10
Active Sketch Drop Down .................................................................................................. 7–10
New Sketch ........................................................................................................................ 7–10
3D Modeling ....................................................................................................................... 8–1
Bodies and Parts .................................................................................................................. 8–1
Bodies ................................................................................................................................. 8–1
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symmetry</td>
<td>8–57</td>
</tr>
<tr>
<td>Fill</td>
<td>8–60</td>
</tr>
<tr>
<td>Surface Extension</td>
<td>8–62</td>
</tr>
<tr>
<td>Winding Tool</td>
<td>8–68</td>
</tr>
<tr>
<td>Pattern</td>
<td>8–73</td>
</tr>
<tr>
<td>Body Operation</td>
<td>8–76</td>
</tr>
<tr>
<td>Slice</td>
<td>8–81</td>
</tr>
<tr>
<td>Face Delete</td>
<td>8–84</td>
</tr>
<tr>
<td>Parameters</td>
<td>9–1</td>
</tr>
<tr>
<td>Parameters Windows</td>
<td>9–1</td>
</tr>
<tr>
<td>Creating Parameters</td>
<td>9–3</td>
</tr>
<tr>
<td>Parametric Expressions</td>
<td>9–5</td>
</tr>
<tr>
<td>Parametric Functions</td>
<td>9–6</td>
</tr>
<tr>
<td>Sending Parameters to Simulation</td>
<td>9–6</td>
</tr>
<tr>
<td>Scripting API</td>
<td>10–1</td>
</tr>
<tr>
<td>Script Constants</td>
<td>10–2</td>
</tr>
<tr>
<td>Script Features</td>
<td>10–2</td>
</tr>
</tbody>
</table>
Selection Functions ............................................................................................................... 10–2
Plane Access Functions ......................................................................................................... 10–3
Plane Features ...................................................................................................................... 10–3
Point Access Functions ........................................................................................................ 10–4
Point Feature ....................................................................................................................... 10–5
Line from Points Feature .................................................................................................... 10–5
Surface from Line Edges Feature ....................................................................................... 10–7
Cross Section Feature ........................................................................................................... 10–8
Form New Part (from All Bodies & Selected Bodies) ............................................................... 10–8

DesignModeler Options ........................................................................................................ 11–1
Geometry ................................................................................................................................... 11–1
Graphics ..................................................................................................................................... 11–2
Miscellaneous ............................................................................................................................ 11–3
Toolbars ..................................................................................................................................... 11–4
Units ........................................................................................................................................... 11–5
Grid Defaults ............................................................................................................................. 11–5

List of Tables

1. Point Definition Options ....................................................................................................... 8–24
Welcome to the DesignModeler 10.0 Help

Sections in this Help include the following:

- Section : Overview
- Typical Usage
- Menus
- Viewing
- 2D Sketching
- Selection
- Planes and Sketches
- 3D Modeling
- Parameters
- Scripting API
- DesignModeler Options

To access the ANSYS Workbench Help, see Section : Using Help.

Overview

DesignModeler is designed to be used as a geometry editor of existing CAD models. DesignModeler is a parametric feature-based solid modeler designed so that you can intuitively and quickly begin drawing 2D sketches, modeling 3D parts, or uploading 3D CAD models for engineering analysis preprocessing.

If you have never used a parametric solid modeler, you will find DesignModeler easy to learn and use. If you are an experienced user in parametric modeling, DesignModeler offers you the functionality and power you need to convert 2D sketches of lines, arcs, and splines into 3D models.

The DesignModeler interface is similar to that of most other feature-based modelers. The program displays menu bars along the top of the screen.
Introduction to DesignModeler

DesignModeler features two basic modes of operation: 2D Sketching and 3D Modeling.

Sketching Mode

In the Sketching mode, you have five toolboxes to create 2D sketches by adding and removing 2D edges. From the 2D sketches you can generate 3D solid models as described in 3D Modeling.

1. **Section : Draw Toolbox**: drawing lines, rectangles, and splines
2. **Section : Modify Toolbox**: modifying by trimming, cutting, and pasting
3. **Section : Dimensions Toolbox**: defining dimensions in length/distance, diameter, and angle
4. **Section : Constraints Toolbox**: applying tangent, symmetry, and concentricity constraints.
5. **Section : Settings Toolbox**: plane settings such as grid and grid spacing

Modeling Mode

The Modeling mode allows you to create models, for example, by extruding or revolving profiles from your sketches.

As you become acquainted with the tools and controls, you will quickly feel comfortable using DesignModeler for sketching and modeling tasks.

Introduction to the Modeling Environment

DesignModeler is a parametric feature-based modeler. Its modeling paradigm is to sketch 2D profiles and use them to generate features. In CAD systems, features are collections of geometric shapes with which you add or cut material from a model. In DesignModeler, you can also use features to slice a model into separate bodies for improved mesh generation or to imprint faces for patch loading. More generally, in DesignModeler you can apply features to the task of enhancing your models for the purpose of engineering simulation.

Because DesignModeler is a feature-based modeler, the features shown in the Tree Outline list all of the operations used to create the model. This feature list represents the model’s history. Features may be modified and the model rebuilt to reflect your changes. Features may also be suppressed, deleted, or even inserted into the middle of the feature list.

A sketch is always required at the start of creating a new model. However not all features, such as Section : Blend and Section : Chamfer, require you to create sketches. Some features, such as Section : Extrude or Section : Sweep, require you to create sketches prior to their definition.

Introduction to Parametric Sketching and Modeling

Before starting a new model in DesignModeler, you are presented with three mutually perpendicular planes, corresponding to the three mutually perpendicular planes in the Cartesian coordinate system (the XYPlane, the YZPlane and the ZXPlane).

You can use the sketching toolbox to draw edges on the planes. The edges form the sketches used for feature creation. The last sketch/plane that you worked on is the “active” sketch/plane. If any of the feature construction tools are selected, the active sketch is the default input for that feature creation. You can select a different sketch from the Tree Outline to change this input. Similarly, for features like Section : Skin/Loft and Section : Sweep that require more than one sketch as input, the Tree Outline is used for sketch selections.
Before a sketch can be used to create a feature, you must define it on a plane. All sketches are attached to unique planes. Only a single sketch can be worked on at a time. This sketch is the “active sketch.” To make an existing sketch the active sketch, select the sketch object in the Tree Outline or in the Section : Active Sketch Drop Down menu in the Section : Active Plane/Sketch Toolbar. You can then select the sketching tab to enter the sketching mode and edit the sketch. Even though you can only add edges to the active sketch, you can add dimensions or constraints between edges of different sketches in the active plane.

New planes can be inserted in the model by clicking the Section : New Plane icon in the Section : Active Plane/Sketch Toolbar. You will then be prompted for input to clearly define the plane using the different options available.

A plane can have any number of sketches attached to it. This is required in many instances because different features created on a plane may use different profiles. DesignModeler does not allow you to select certain portions of a sketch, ignoring others, for use in feature creation. Features can only be defined using entire sketches.

Note — DesignModeler distinguishes dimensions as:

- Feature Dimensions
- Plane Dimensions
- Design Parameters

**Feature Dimensions:**

The features themselves have defining dimensions. For example, Fixed Blends have a blend radius, Extrusions have a depth, and Revolves have an angle of revolution.

**Plane Dimensions:**

You can dimension the edges in the planes/sketches. You can add these dimensions at any time, and change them to generate different model configurations.

**Design Parameters:**

You can promote both feature dimensions and plane dimensions to “design parameters” using the Parameters tool, or by checking the “driven” check mark (if available) next to the feature or plane dimensions, and then pass them into Simulation for parametric studies.

The Section : Generate icon updates the model after a dimension or parameter change is made. You are free to specify any number of such changes before using the Section : Generate icon to update the model.

**Process for Creating A Model**

To create a new model from scratch, you have to start with a base sketch to create your initial feature. Select the plane on which you want to draw a sketch. Select Sketching mode by clicking the Sketching tab at the bottom of the Tree Outline. The five sketching toolboxes are displayed.

Pictured below is the model you can create by following the instructions in this section.
To start the process of creating a model, open DesignModeler from the Start Page by selecting Geometry. To begin sketching, choose one of the sketch tools from the Section : Draw Toolbox. For this example, click on the Section : Rectangle tool. You can simply sketch the rectangle by left clicking the top left corner location and dragging the mouse to the lower right corner location and clicking.

Show me.¹

[http://www.ansys.com/techmedia/1-create_rectangle.html]

Additional edges can be added by choosing the appropriate sketch tool. Exact locations and dimensions are not critical at this point. For example, click on the Section : Circle tool to add two circles representing the desired holes in the finished model. Simply sketch the rough locations. You can finalize the hole placement when editing the model.

Show me.¹

[http://www.ansys.com/techmedia/2-add_hole_circles.html]
After completing the rough sketch, select the Dimensions toolbox and add dimensions by picking the appropriate tool in the Section : Dimensions Toolbox. DesignModeler provides a number of dimensioning tools similar to those found in advanced CAD systems. Select the Section : Diameter dimension tool, and then select the two circles to be dimensioned. Unlike drafting systems, DesignModeler does not automatically position dimension labels, but you can do so manually, via mouse drags.

Show me.¹

[http://www.ansys.com/techmedia/3-dimension_hole_circles.html]

You may choose to use the Section : Display Name/Value tool in the Section : Dimensions Toolbox to choose the Name and/or Value display (only Names shown here).

Show me.¹
After defining the 2D sketch, you can generate a 3D solid model using one of the feature creation operations in DesignModeler. For example, you can revolve or sweep a profile to create a solid. DesignModeler also has Section: Skin/Loft capabilities that allow you to join multiple sketch profiles to form a solid. After the dimensions have been resolved, you can generate the 3D model by clicking Extrude, Revolve, etc. from the Section: 3D Features Toolbar. For this example, the sketch is extruded to a depth of 30 millimeters (mm). Click on Extrude, then specify the extrusion depth in the “Feature Details” window. Here the sketch is shown in the Isometric View, which you can see by right-clicking in the Model View and selecting Section: Isometric View from the context menu.

Once the depth of the extrusion is determined and entered, you must click on the Generate button. In this example, the 2D pattern of the sketch is extruded into a 3D solid.

Show me.¹

¹[http://www.ansys.com/techmedia/5-generate_3_d.html]
At this point, you can return to Sketching mode by clicking the Sketching tab under the Tree Outline to finalize the dimensions. Using the Section : Edit tool in the Section : Dimensions Toolbox, simply pick the dimension value and modify it in the details window. Alternatively, you can edit a dimension through the Details Window of the Sketch. In this example, we change the value of D1 in Sketch1 to 20 mm.

Show me.¹

[http://www.ansys.com/techmedia/6-change_dimension.html]

After modifying the dimensions, click on the Generate button from the Section : 3D Features Toolbar to update the changes.
In addition to the 2D sketch creation tools and the 3D solid features, DesignModeler is capable of creating 3D surface features. Click on the Modeling tab so you can add 3D features using the appropriate tools, such as features from the 3D Features Toolbar. Here the model is shown in the Isometric View. For the example, click the Section : Blend button, then select the Fixed Radius feature from the drop down menu.

The Geometry listing in the Feature Details window will say “Not selected.” This is where you will apply your selection for the Section : Blend feature.
Select the front face of the model, click “Not selected” and then click the Apply button next to the Geometry property to complete the geometry assignment.

Change the Blend Radius to 5 mm by editing the text field of the Radius property,
and click Generate to complete the feature.

If you have not yet done so, use Section : Save in the File menu to save your model. The name you select will appear at the top branch of the **Tree Outline** and in the DesignModeler tab of the Section : Project Page Navigation.
Show me.¹

[http://www.ansys.com/techmedia/7-add_3d_blend.html]

Now would be a good time to add Design Parameters to the model. One way to do this is to use the “driven” check marks next to the feature/plane dimensions in the Feature Details window.

For example, click the checkbox of the radius dimension of FBlend1. A pop-up dialog will appear, asking whether you want to create a new Design Parameter.
The dialog also allows you to specify the parameter name. DesignModeler uses an internal dimension “reference” as a unique default name; it is advisable to change this name to something more meaningful with respect to your problem at hand. The Design Parameter name you choose is important. The Parameter Key shown on the Project Page is used to filter DesignModeler’s Design Parameters.

For example, change the name to “BlendRadius”. Once you close the dialog by clicking “OK”, you will see a blue “D” in the checkbox next to the dimension. This indicates that the dimension can no longer be set directly, but is instead “driven” by a Design Parameter.

To complete the example, select Sketch1 (under XYPlane) from the tree. After doing so, the information for Sketch1 appears in the Feature Details window.
Instruct DesignModeler to “drive” the two dimensions XYPlane.D1 and XYPlane.D2 by design parameters “Diameter1” and “Diameter2”, respectively. As shown below, when you click on D1’s checkbox, a pop-up window prompts you to personalize the Design Parameter name.

In this example, change XYPlane.D1 to “Diameter1” and XYPlane.D2 to “Diameter2”.

[Diagram showing the process of driving dimensions by design parameters]

[Pop-up window for personalizing Design Parameter name]
If done correctly, the two diameters will have the blue letter D before them in the Feature Details window.

At this point, the three dimensions in the example can no longer be changed using the value fields in the detail view directly. You must use the Parameters tool in the toolbar instead. This tool will bring up the Design Parameters and Parameter/Dimension Assignments tabs below the display window, where parameter assignments can be managed.

For example, go to the Design Parameters tab, and change the parameter “Diameter1” to 25,
and click Generate to update the model.

Show me.

[http://www.ansys.com/techmedia/8-generate_parameters.html]

The model is now complete and ready for simulation. With the ANSYS Workbench you have the option to apply this model to a new Simulation scenario with the click of a tab. For this example, click the ANSYS Workbench Project tab. You will see details of your DesignModeler database listed and buttons to access the functionality of Simulation.
Make the Parameter Key blank, otherwise only design parameters with the Parameter Key string will transfer. For example, if left with the entry “DS”, as shown here, only those parameters listed with a “DS” in DesignModeler’s Parameter Manager will transfer.

By clicking on “New Simulation” under DesignModeler Tasks on the left, your geometry will be inserted into the Simulation mode, not as a separate application, but rather in the same window with its own tab.

In the Simulation tree, entitled Outline, if you select the Geometry branch,
you will see the Design Parameters you named (e.g. BlendRadius, Diameter1, and Diameter2) defined in DesignModeler listed under the “CAD Parameters” branch in the Details View.

You can now use the Simulation Geometry detail to change any of the parameters in your DesignModeler geometry. If you do so, you should update the geometry in DesignModeler to reflect your latest parameter assignment. To do this, click the Geometry button in Simulation's toolbar and select Update: Use Simulation Parameter Values from the drop down menu.

Notice the interoperability between DesignModeler and Simulation. They are both accessible by clicking their corresponding tab in the ANSYS Workbench. For example, you can conveniently return to the DesignModeler session and verify your parameter assignments by clicking the DesignModeler tab.
To return to the Section : Project Page Navigation, click the Project tab. Now both your original DesignModeler geometry project and your current Simulation session are listed. For more information about the Section : Project Page Navigation, click on the Help button (signified by a white question mark in a blue circle) in the Toolbar or the Help menu.

Show me.¹

[http://www.ansys.com/techmedia/9-run_in_ds.html]

1 - Video demonstrations require internet access.

- **PC Users**: videos play directly in the help system.
- **UNIX Users**: videos do not play directly in the help system. However, you can view them by copying the published URL to an internet browser capable of playing back Flash video files.
Typical Usage

Located here are walkthrough examples of some 3D modeling tasks using DesignModeler. Instructions are included on how to adjust your screen’s area for optimal viewing of the procedures while running DesignModeler concurrently on your screen. Database files that are required to run the examples are also included for downloading from the site.

Click here to interactively learn how to use some of DesignModeler’s basic features (requires internet access).
Menus

All features and tools available in DesignModeler are accessible via drop down menus in the Menus toolbar. The toolbar includes the following menus:

- Section : File Menu
- Section : Create Menu
- Section : Concept Menu
- Section : Tools Menu
- Section : View Menu
- Help Menu
- Section : Context Menus

**File Menu**

![File Menu screenshot](image-url)
Units can only be set when creating a new DesignModeler model from the Start Page. When running DesignModeler in stand-alone mode, the Units preferences can be changed through the Options dialog box.

The toolbar also reflects differences in file-management functionality. When DesignModeler operates in the ANSYS Workbench, the Start Over and Close DesignModeler options are available.

- Section : New
- Section : Start Over
- Section : Open
- Section : Close DesignModeler
- Section : Save
- Section : Save As
- Section : Export
- Section : Attach to Active CAD Geometry
- Section : Import External Geometry File
- Section : Import and Attach Options
- Section : Run Script
- Section : Print
- Section : Auto-save Now
- Section : Restore Auto-save File
- Section : Recent AGDB Files
- Section : Recent Imports
- Section : Recent Scripts
- Section : Exit Workbench

A description of each file-management option follows:

**New**

**Hotkey: [Ctrl]-N**

Use the New option to begin a new model. Before the new model is started, you will be prompted to save your current model, if necessary. Choose the unit setting in the Units pop-up window:
You may choose a unit setting for the new session, or by checking the box you can always use the default value for future models without being prompted. The Units pop-up window can always be reactivated through the Options dialog box. The new model will be unnamed.

**Start Over**

[Image: Start Over icon]

Available only in the ANSYS Workbench mode, use the **Start Over** option to begin a new model. Note that your model name is retained.

**Open**

[Image: Open icon]

**Hotkey:** [Ctrl]-O

Use the **Open** option to open a saved DesignModeler model (extension: .agdb).

**Close DesignModeler**

[Image: Close DesignModeler icon]

Available only in the ANSYS Workbench mode, this option will close the DesignModeler tab in the Section: Project Page Navigation. If the model requires saving, you will be prompted to save it.

**Save**

[Image: Save icon]

**Hotkey:** [Ctrl]-S

The **Save** option stores a model with the .agdb extension at the specified file location.
Save As

Use the **Save As** option to store a model to a named file location (extension: `.agdb`). Note that the model name in the session is determined by this operation.

You can use the **Save As** option for an initial save and to store a model by a different file location. Changing a model's name and/or location using the **Save As** command from the **File Menu** creates a new copy of the sketch/model, so two versions of the file exist: one with the old name and/or location and one with the new. The versions are completely separate, and the work you do on one file has no effect on the other.

Export

The **Export** option is used to export a model to DesignModeler (`.agdb`), Parasolid (`.x_t`, `.xmt_txt` or `.x_b`, `.xmt_bin`), ANSYS Neutral File (`.anf`), Monte Carlo N-Particle (`.mcnp`), IGES (`.igs`), or STEP AP203 (`.stp`) format.

The original model name still presides over your DesignModeler session. Note that bodies that are grouped in multiple body parts do not share topology when exported to formats other than DesignModeler's AGDB. In those cases, all bodies are treated as if they are single body parts.

When exporting to IGES, non-manifold line bodies may not be exported properly, or may not be exported at all.

When exporting to Parasolid, MCNP, and IGES formats, those exported files may appear in the Recent Imports list.

Attach to Active CAD Geometry

You can import a model into DesignModeler that is currently open in a CAD session on your computer. Use the **Attach to Active CAD Geometry** option to import the model into DesignModeler, where it will appear as an attached feature in the feature Tree Outline. You do not need to begin a new model to use the **Attach to Active CAD Geometry** option and it can be used at any time (and multiple times) during any DesignModeler session.

*Note* — The **Attach to Active CAD Geometry** option is not supported for UNIX.

From the CAD program Unigraphics you can attach surface thicknesses. Surface thicknesses are automatically transferred to bodies in DesignModeler and are updated whenever the CAD geometry is refreshed. You are still allowed to modify the thickness of a surface body, though if you do, then that surface's thickness will no longer update when the CAD geometry is refreshed.

Source Property

DesignModeler will automatically detect active CAD programs on your computer. You can choose which one DesignModeler will attach to by changing the CAD Source property in the Details View.
Parameter Key Property

Also in the Details View is the property Parameter Key. It is a string that helps you filter the CAD parameter names to attach. The default is “DS,” meaning that only names prefixed or appended with “DS” are selected. If blank, all independent parameters regardless of name are selected.

CAD parameters should be uniquely named. If duplicate parameter names exist, the Import/Attach feature will generate a warning. It is not recommended to create design parameters from CAD parameters whose names are non-unique.

Import Material Properties

DesignModeler can process material properties for imported bodies by setting the Import Material Properties option to “yes.”. If the imported geometry contains material information, then it will be attached to the bodies. The material properties can be seen when viewing the body's details. See Section : Additional Properties for more information on body properties.

Note that the corresponding CAD system must support material properties and have materials assigned to the bodies in order for the material properties to be processed in DesignModeler. Material property transfer is supported for Autodesk Inventor, Pro/ENGINEER, and Unigraphics. The default setting is off for all new Import and Attach features. For .agdb files created prior to Release 8.0, the default is no.

Refresh Property

Once a model is attached, you can continue to edit it in your CAD program. To reflect changes made with the CAD program in DesignModeler or to reflect changes in the original active CAD source, change the Refresh property to Yes. These are the three choices for the Refresh property:

- **No**: The feature will not refresh the CAD geometry.
- **Yes (Use Geometry Parameter Values)**: The feature will refresh the CAD geometry using the parameters of the original CAD source. Parameters of the Attach feature will be updated to reflect the current values from the CAD system.
- **Yes (Use DesignModeler Parameter Values)**: The feature will refresh the CAD geometry using the parameter values displayed in the Details View.

The refresh will be completed to reflect any changes once the **Generate** button is clicked.

*Note* — Autodesk Mechanical Desktop models will not maintain associativity upon refresh.

Base Plane Property

Attach has a property called Base Plane. This allows you to specify the coordinate system in which the attached model is brought in. When creating a new Attach feature, the active plane is chosen as the Base Plane by default. You can change the Base Plane by selecting planes from the **Tree Outline**.

Operation Property

Attach also has an Operation property. This allows you to do things other than add bodies to your model.
Note — The Add Material option does not always apply. DesignModeler will not add material when the Attach consists of multiple bodies AND active bodies already exist in the current model. In this case, DesignModeler will automatically apply the “Add Frozen” material type instead and mark the feature with a warning.

Note — When body suppression operations are needed in your model, it is best to perform them with DesignModeler than with attached CAD programs. If the suppression of a body using the CAD program results in a DesignModeler part being added or deleted, you may lose associativity on the part in your Simulation.

**Process Property**

The Process property describes what bodies will get attached to DesignModeler. The options are Solids Only, Surfaces Only, and All Bodies. The default setting is All Bodies. Modifying this setting after the Attach feature has generated may lead to loss in associativity.

**Geometry Interface Support for Windows**

<table>
<thead>
<tr>
<th>Reader/Plug-In</th>
<th>Version of CAD Package</th>
<th>Windows 2000 (Service Pack 2, Version 5.00, Build 2195)</th>
<th>Windows XP Professional</th>
<th>Windows XP Professional x64</th>
<th>Windows XP Home</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reader for ACIS (SAT)</td>
<td>ACIS 15</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader for CFX BladeGen</td>
<td>CFX BladeGen 4.1</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader for Monte Carlo N-Particle</td>
<td>Parasolid 16.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Reader for Parasolid</td>
<td>Parasolid 16.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Reader for CATIA</td>
<td>CATIA V5 (R2–R15)</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Reader for IGES</td>
<td>IGES 4.0, 5.2, 5.3</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader for STEP*****</td>
<td>AP203,AP214</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Reader/Plug-In for Solid Edge</td>
<td>Solid Edge Version 16.0</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for SolidWorks</td>
<td>SolidWorks 2004</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for Autodesk</td>
<td>Inventor R9</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inventor R10</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In</td>
<td>Version of CAD Package</td>
<td>Windows 2000 (Service Pack 2, Version 5.00, Build 2195)</td>
<td>Windows XP Professional</td>
<td>Windows XP Professional x64</td>
<td>Windows XP Home</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------------------------------</td>
<td>-------------------------------------------------------</td>
<td>-------------------------</td>
<td>----------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intel IA32 Windows</td>
<td>Intel IA32 Windows</td>
<td>EM64T, AMD64</td>
<td>Intel IA32 Windows</td>
</tr>
<tr>
<td>Reader/Plug-In for Pro/ENGINEER</td>
<td>Pro/ENGINEER Wildfire 1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pro/ENGINEER Wildfire 2</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for Unigraphics</td>
<td>Unigraphics NX 2.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unigraphics NX 3.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for Mechanical Desktop**</td>
<td>Mechanical Desktop 2005</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mechanical Desktop 2006</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for OneSpace Designer</td>
<td>OneSpace Designer Modeling 2005 (Rev. 13.20)</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Plug-In for TeamCenter Engineering</td>
<td>TcEng 9.1.2 with UGNX3, TcEng 9.0.0 with UGNX2</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>

x = supported

** Associativity not maintained upon refresh.

****STEP export from DesignModeler only supports AP203 format.

### Geometry Interface Support for UNIX and Linux

<table>
<thead>
<tr>
<th>Reader/Plug-In</th>
<th>Version of CAD Package</th>
<th>Solaris 8 64-bit</th>
<th>Solaris 8 ULTRA III* 64-bit</th>
<th>HP-UX 11.0 (64-bit)</th>
<th>HP PA 8000 64-bit</th>
<th>Intel IA-32 Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reader for ACIS (SAT)</td>
<td>ACIS 15</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Reader for CFX BladeGen</td>
<td>CFX BladeGen 4.1</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader for Monte Carlo N-Particle</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader for Parasolid</td>
<td>Parasolid 16.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In</td>
<td>Version of CAD Package</td>
<td>Solaris 8 ULTRA III*</td>
<td>Solaris 8 ULTRA III*</td>
<td>HP-UX 11.0 (64–bit)</td>
<td>Intel IA-32 Linear Linux</td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------</td>
<td>----------------------</td>
<td>----------------------</td>
<td>---------------------</td>
<td>-------------------------</td>
<td></td>
</tr>
<tr>
<td>Reader for CATIA</td>
<td>CATIA V5 (R2–R14)</td>
<td>Sun UltraSPARC 64–bit</td>
<td>Sun UltraSPARC 64–bit</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader for IGES</td>
<td>IGES 4.0, 5.2, 5.3</td>
<td>x</td>
<td>x</td>
<td>x****</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader for STEP****</td>
<td>AP203, AP214</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for Solid Edge</td>
<td>Solid Edge Version 16.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for Solid Edge</td>
<td>Solid Edge Version 17.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for SolidWorks</td>
<td>SolidWorks 2004</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for SolidWorks</td>
<td>SolidWorks 2005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for Autodesk</td>
<td>Inventor R9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for Autodesk</td>
<td>Inventor R10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for Pro/ENGINEER</td>
<td>Pro/ENGINEER Wildfire 1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for Pro/ENGINEER</td>
<td>Pro/ENGINEER Wildfire 2</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for Unigraphics</td>
<td>Unigraphics NX 2.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for Unigraphics</td>
<td>Unigraphics NX 3.0</td>
<td>x***</td>
<td>x***</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for Mechanical Desktop**</td>
<td>Mechanical Desktop 2005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for Mechanical Desktop**</td>
<td>Mechanical Desktop 2006</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for OneSpace Designer</td>
<td>OneSpace Designer Modeling 2005 (Rev. 13.20)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plug-In for TeamCenter Engineering</td>
<td>TcEng 9.1.2 with UG NX3, TcEng 9.0.0 with UG NX2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

x = supported

* This version processor may run on the Sun UltraSPARC 64–bit platform, but with limited performance.

*** UGNX3.0.1.3 MP1 is supported on these systems.

****IGES import and export on the HP platform may behave differently than other operating systems.

*****STEP export from DesignModeler only supports AP203 format.
Import External Geometry File

The Import External Geometry File option is used exclusively to import foreign models such as:

- **ACIS** (extension .sat)
- **BladeGen** (extension .bgd)
- **Monte Carlo N-Particle** (extension .mcnp)
- **CATIA5** (extension .CATPart)
- **IGES** (extension .igs or .iges)
- **Parasolid**
  - Extension .x_t and .xmt_txt for text files
  - Extension .x_b and .xmt_bin for neutral binary files
- **STEP** (extension .step and .stp)

Imports can be applied at any time during your DesignModeler session. You do not need to begin a new model to use the feature.

From the CAD program Unigraphics you can attach surface thicknesses. Surface thicknesses are automatically transferred to bodies in DesignModeler and are updated whenever the CAD geometry is refreshed. You are still allowed to modify the thickness of a surface body, though if you do, then that surface's thickness will no longer update when the CAD geometry is refreshed.

Material property transfer is supported for Autodesk Inventor, Pro/ENGINEER, and Unigraphics. Material properties transfer is controlled by the Import Material Properties option through the Details View. The default setting is “yes.” for all new import and attach features. For .agdb files created prior to Release 8.0, the default is no.

**Model Units Property**

Some import types allow you to specify the units of the imported model. Before clicking Generate, you may be able to change the model units from the Details View, depending on the type of import. Note that some model types store their units, so no Model Units property will appear when importing them.

**Base Plane Property**

Import has a property called Base Plane. This allows you to specify the coordinate system into which the model is brought. When creating a new Import feature, the active plane is chosen as the Base Plane by default. You can change the Base Plane by selecting planes from the Tree Outline.

**Operation Property**

Import also has an Operation property. This allows you to do things other than add bodies to your model.

*Note* — The Add Material option does not always apply. DesignModeler will not add material when the Import consists of multiple bodies AND active bodies already exist in the current model. In this case, DesignModeler will automatically apply the “Add Frozen” material type instead and mark the feature with a warning. For Import features in all .agdb files prior to this upgrade, the default operation is Add Material.
Process Property

The Process property describes what bodies will get imported to DesignModeler. The options are **Solids Only**, **Surfaces Only**, and **All Bodies**. The default setting is All Bodies.

When importing a file with an extension of “.mcnp”, the Process property will be changed to **Solids Only** and become disabled. Only solid bodies may be defined in MCNP files.

Blade Sets Property

This property appears only when importing BladeGen models. With this property, you can specify how many blade sets to import. If the value is zero, or if the number entered is greater than the number of blade sets in the model, then all blade sets are imported. The default value is 1.

Refresh Property

Sometimes an imported CAD file may have changed since it was first imported into DesignModeler. To reflect changes made to the CAD file in DesignModeler, change the Refresh property to “yes.”. This will cause DesignModeler to refresh the imported geometry the next time you click Section : Generate.

*Note* — When you modify the Process property or change the CAD source, the Refresh is automatically set to “yes.”.

Geometry Interface Recommendations

*Note* — Successful importation of CAD models into DesignModeler requires that the geometry’s mathematical representation be as complete and exact as possible. If a model imports into Simulation but does not import into DesignModeler, you should implement one or more of the Section : Import and Attach Options. Under certain system limitation circumstances, models that import into Simulation may not necessarily import into DesignModeler.

Parasolid

- DesignModeler imports/exports Parasolid files (x_t, xmt_txt, x_b, xmt_bin).
- DesignModeler allows neutral binary Parasolid files (x_b and xmt_bin) and text Parasolid files (x_t and xmt_txt) to be imported and exported.
- Both text and neutral binary Parasolid files are platform independent.
- Binary neutral Parasolid files (xmt_bin, x_b) are compressed but are not human readable.
- Text Parasolid files are human readable but take up more space than their respective neutral binary versions.
- The default Parasolid file setting for DesignModeler is text.

BladeGen

- DesignModeler imports CFX BladeGen on Windows systems only. The BladeGen import produces a flow path, which is the air or fluid surrounding the blade. The import procedure is a three-step process:
  1. Read the blade data from the BladeGen database,
  2. Convert the data to Parasolid format, and
  3. Read the Parasolid data into DesignModeler.
It is important to note the scaling factor when importing BladeGen models. If an incorrect Model Unit setting is chosen, it is possible that the BladeGen model will fail to import into DesignModeler. In some cases, tolerance issues will prevent the Parasolid conversion from succeeding, or it may produce a distorted flow path. In these cases, it is recommended to try using a larger Model Unit setting.

**CATIA**

- Version 5 surface bodies consisting of closed surfaces are transferred as solid bodies.

**IGES**

- IGES imports of sets of surfaces that enclose a region will create a solid body.

**STEP reader**

- The STEP (STandard for the Exchange of Product model data) reader will both read and write model data to and from the STEP format. It is important to note that the STEP format does not store model data in the same way as DesignModeler. STEP format stores surface data, which upon import into DesignModeler is stitched together to form bodies. In some rare cases, a DesignModeler model exported to STEP format may not produce the exact same geometry when imported again into DesignModeler.

**Autodesk Inventor**

- At present, all Autodesk Inventor weldments get grouped as a single part with a single body. This may cause problems for the mesher determining an appropriate mesh element size (making them too large) and a failure when meshing using default values. If this occurs, it would be recommended that mesh sizing be defined and scoped to the weldment part and a mesh retried.

**Autodesk Mechanical Desktop**

- Associativity not maintained upon refresh.

**OneSpace Designer Modeling**

- The plug-in will import all parts in the model based on body type import filters. Active CAD session models imported from OneSpace Designer Modeling can only be updated from an active session unless the model is relinked to a specified file. A model imported based on its file can only be updated from the file unless relinked to an active session.

- OneSpace Designer Modeling supports the import of solid and surface components.

- Supported extension types include (*.pkg;*.bdl;*.ses;*.sda;*.sdp;*.sdac;*.sdpc).

Note — SES files are not portable between different versions of OneSpace Designer Modeling. They should be limited to use on a single machine.

**Pro/ENGINEER**

- When importing Pro/ENGINEER parts, the parts must reside on a local or mapped drive. This is due to an error in Pro/ENGINEER that causes issues when attempting to use parts from network paths.

- File versions of Pro/ENGINEER are accessible through the Workbench Start Page.

- To improve our associativity with Pro/ENGINEER models, a modification was made to vertex processing that will yield a “break” in associativity for most vertex loads and boundary conditions upon update. You
will be required to reattach/redefine those loads that are lost, but should expect associativity to be maintained from that point forward.

- Surface bodies imported into DesignModeler include numerical references to the parent part or assembly and Pro/ENGINEER quilt ID. For example, a part named H103 with three Pro/ENGINEER quilts 1, 2, and 3 will be identified as H103[1], H103[2] and H103[3].

**Solid Edge**

- When importing a Solid Edge assembly, make sure that no two components use the same component name. This will result in the second component being displayed on top of the first.
- A closed surface body will be imported into DesignModeler as a solid body since Solid Edge considers this body as a solid.
- Solid Edge recommends that part documents contain only one body, otherwise a duplicate set of parameters and variables may be imported.

**SolidWorks**

- A limitation imposed by SolidWorks in relation to geometry and the API processing exists if a sketch is revolved 180 degrees. As a result, the faces generated on either portion of the revolution are identified as the same. However if the revolution angle is changed, they now become different faces; one retains the original identification and the second a new one. This creates an associativity break if the angle of revolution is modified to or from 180 degrees.

**Unigraphics**

- Closed surface models from Unigraphics can only be imported to ANSYS Workbench Products through UG NX 1.0.1.2 and up. Persistence may not be maintained when a Unigraphics import is first refreshed in old databases prior to Release 8.0.
- If you refresh Unigraphics geometry in DesignModeler, the Unigraphics interface uses Unigraphics User Defined Objects (UDO) to store persistent IDs. To maintain the associativity of the geometry between Unigraphics and DesignModeler, you need to Import/Attach the Unigraphics geometry file in DesignModeler and save the part file at the end of a Unigraphics session (plug-in), or save the part file from within DesignModeler (reader). At update/refresh time, you will need to set the **Reader Save Part File** property to **Yes**. The part file will be saved at the end of an attach process using the same file name in the same directory. The current part file will be backed up by changing the extension of the file to *bak* before saving the part. Make sure that the file is not set to read-only.

  *Note* — You should avoid setting **Reader Save Part File** to **Yes** on UNIX platforms if a CAD file is open.

**Import and Attach Options**

**Geometry Options**

Several options are available for the various types of geometry imported or attached to DesignModeler. Some options are available only for specific CAD packages, while others apply to some, but not all CAD packages. Below is a description of the geometry options, followed by a chart showing which options are available for each CAD package or file type.

- **Simplify Geometry** - If yes, DesignModeler will simplify the surfaces and curves of the model into analytical geometry where possible. Default is no.
• **Simplify Topology** - If yes, DesignModeler will remove redundant faces, edges, and vertices from the model where possible. Default is no. Property appears in the Details View only when you select an IGES or STEP file for import.

• **Heal Bodies** - Attempts to heal geometry before performing import or attach operation. Default is no.

• **Clean Bodies** - Attempts to heal geometry for solid and surface bodies after performing import or attach operation. Default is “yes.” The Clean Bodies option is not available on Linux platforms. Additionally, imported line bodies are ignored by the Clean Bodies option.

• **Tolerance** - Choose either Normal or Loose stitching tolerance. Default is Normal. Property appears in the Details View only when you select an IGES or STEP file for import.

• **Replace Missing Geometry** - If yes, missing geometry will be replaced. Default is no. Property appears in the Details View only when you select an IGES or STEP file for import.

• **Reader Save Part File** - If set to yes, then Unigraphics® User Defined Objects (UDO) will be saved.

• **Do Smart Update** - If on, when you modify preferences such as the parameter key, attributes, import type, etc. will not be respected if the component can be smart updated. Further details available in Simulation help.

• **Stitch Surfaces** - If on, the modeler will attempt to stitch together all surface bodies resulting from import. Property appears in the Details View only when you select an IGES or STEP file for import.

---

<table>
<thead>
<tr>
<th></th>
<th>Simplify Geometry</th>
<th>Simplify Topology</th>
<th>Heal Bodies</th>
<th>Clean Bodies*</th>
<th>Tolerance</th>
<th>Replace Missing Geometry</th>
<th>Reader Save File</th>
<th>Smart Update</th>
<th>Stitch Surfaces</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acis</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BladeGen</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Catia V5</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventor</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IGES</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Mechanical Desktop</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OneSpace Designer Modeling</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parasolid</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pro/ENGINEER</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Solid Edge</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SolidWorks</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STEP</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unigraphics</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>

*Clean Bodies* option is not supported on Linux.

---

**Run Script**
Use the **Run Script** option to start a script created with the instructions in Scripting API. Such scripts are intended to assist in creating many similar parts by making simple changes to the script file.

**Print**

Use the **Print** option to print your model. The option is only available when you are in Section: Print Preview mode.

*Note* — The **Print** option is not supported for UNIX.

**Auto-save Now**

DesignModeler will now automatically save backup files of the model after a specified number of Generates. **Auto-save Now** forces an automatic save immediately. A list of these backup files will then be available for you to resume from the File->Restore File Menu.

Auto-save files are saved to a folder named Auto-save, which resides in DesignModeler’s temporary directory. In the **Options** dialog box, under the DesignModeler **Miscellaneous** options, you can set the path where the temporary directory will be created. Whenever you change this path, a new temporary directory and Auto-save folder will be created and the old folder and Auto-save files will be deleted.

Auto-save files have the following special naming convention: ModelName.agdb-##, where ModelName is the name of the file and ## starts at 00 (the most recent Auto-save file) and increases until the specified Auto-save File Limit has been reached (the highest ## is the oldest Auto-save file).

*Note* — Since the Auto-save filename depends on the name of the original .agdb file, it is not advisable to have multiple models with the same filename, as their Auto-save files will interfere and overwrite each other. Additionally, it is not recommended to have multiple DesignModeler sessions of the same model open, as their Auto-save files will interfere.

**Image Capture**

The **Image Capture** tool allows you to save the contents of the graphics view in a standard image file format. The following file formats are supported:

- Windows Bitmap (.bmp)
- Joint Photographic Experts Group (.jpg)
- Encapsulated PostScript (.eps)
- Tagged Image File (.tiff)
- Portable Network Graphics (.png)

**Restore Auto-save File**

Restore Auto-save File
You can restore an Auto-save file by selecting a file using Restore Auto-save in the **File Menu**. A list of all the Auto-save files for the model that is currently open is displayed as well as Browse option. The Browse option will open to the Auto-save folder and display all the Auto-save files, where you may choose a specific Auto-save file.

*Note* — The -00 Auto-save file will not be displayed in the list unless the Auto-save Frequency is greater than Every Generate and the model has not just been Auto-saved.

**Recent AGDB Files**

From this menu you may choose to open a recent DesignModeler database. You will be prompted to save your current model if necessary.

**Recent Imports**

From this menu you may choose a recent CAD file to Import. A new Import feature will be added to the bottom of the feature list, with the CAD file automatically chosen as the source. Note that previously exported files may also appear in this list.

**Recent Scripts**

From this menu you may choose to run a script that was recently used.

**Exit Workbench**

The **Exit Workbench** option closes the ANSYS Workbench. You are prompted to save your file first if you have not already done so.
The following feature options are available under the **Create Menu**. The Section : 3D Features include:

- Section : New Plane
- Section : Extrude
- Section : Revolve
- Section : Sweep
- Section : Skin/Loft
- Section : Thin/Surface
- Section : Fixed Radius
- Section : Variable Radius
- Section : Chamfer
- Pattern Feature
- Section : Body Operation
- Section : Slice
- Section : Face Delete
- Section : Point
- Primitives
The following feature options are available under the **Concept Menu**:

- Section : Lines From Points
- Section : Lines From Sketches
- Section : Lines From Edges
- 3D Curve
- Section : Split Line Body
- Section : Surfaces From Lines
- Section : Surfaces From Sketches
- Section : Cross Section
The following feature options are available under the **Tools Menu**:

- **Section : Freeze**
- **Section : Unfreeze**
- **Section : Named Selection**
- **Section : Mid-Surface**
- **Section : Joint**
- **Section : Enclosure**
- **Section : Symmetry**
- **Section : Fill**
- **Section : Surface Extension**
- **Section : Winding Tool**
- **Section : Form New Part**
- **Parameters**
- **Addins** - Launches the **Addins** manager dialog that allows you to load/unload third-party add-ins that are specifically designed for integration within the ANSYS Workbench environment.
- **Options**
The **View Menu** consists of four groups of display controls that affect the appearance of your model in DesignModeler and one group that restores the original window layout. The settings in the **View Menu** are saved in the .agdb files themselves, though the Triad and Ruler are always on by default.

The first and second groups apply only to solids and surface bodies.

- Section : Shaded Display
- Section : Shaded Display with 3D Edges
- Section : Wireframe Display
- Section : Show Frozen Bodies in Transparent Mode
- Section : Show Edge Joints

The third group applies only to line bodies.

- Section : Show Cross Section Alignments
- Section : Show Cross Section Solids

The fourth group always effects display.

- Section : Triad
- Section : Ruler

The fifth group contains one window display option.

- Section : Restore Original Window Layout
Help Menu

This online documentation for DesignModeler is provided as a set of HTML files in standard Microsoft HTML Help for Windows. See Using Help for detailed usage instructions.

- **ANSYS DesignModeler Help**: Click this button to access the ANSYS Workbench Help. By default you are taken to the DesignModeler section, where you can search by keywords.

  *Note* — You can also access the online documentation by pressing the [F1] hotkey.

- **Installation and Licensing Help**: Click this button to access the ANSYS Workbench Installation and Licensing Help.

- **About ANSYS DesignModeler**: Click this button to access copyright, software build date and version, and service pack version information.

Context Menus

Context menus are only accessible using the right mouse button.

Suppress/Hide Part and Body

The functionality to Suppress and Hide parts and bodies behaves exactly as in Simulation.

- Suppress implies Hide.
- Suppress/Hide is possible from both the **Tree Outline** and the **Model View** window.
- In the **Model View** window, suppression issued on a body (edge, face) applies to the body as a whole.
- Hide means the body is not visible.
- Suppress means it is not visible and it is also not exported to Simulation.
- Select All Bodies will select all visible bodies in the model.

Right mouse button Options:

**Hide Body**

Right clicking on a body in the **Tree Outline** and clicking **Hide Body** may hide the body. A light check mark icon will appear in the **Tree Outline** when a body is hidden.

**Hide All Other Bodies**

Right clicking on **Hide All Other Bodies** functions as the name implies.
Show Body

A body can be made visible by right clicking on the body in the Tree Outline and clicking Show Body. A solid green check mark icon will appear in the Tree Outline when a body is visible.

Show All Bodies

Right clicking on Show All Other Bodies functions as the name implies.

Suppress Body

A body may be suppressed by right clicking on the body in the Tree Outline and clicking Suppress Body. An “X” icon will appear in the Tree Outline when a body is suppressed.

Unsuppress

A body can be unsuppressed by right clicking on the body in the Tree Outline and clicking Unsupress Body. A solid green check mark icon will appear in the Tree Outline when a body is not suppressed.

Unsuppress All Bodies

Right clicking on Unsupress All Bodies functions as the name implies.

Invert Suppressed Body Set

Right clicking on Invert Suppressed Body Set functions as the name implies.

Note — For more information about body visibility and suppression, please see the Section : Body Status section.

Suppress/Hide Parts from Tree Outline

Suppress Part

A part may be suppressed by right clicking on the Part branch in the Tree Outline and clicking Suppress Part. The Suppress Part command suppresses all bodies that belong to the part. An “X” icon will appear in the Tree Outline when a part is suppressed (all bodies are suppressed). If some bodies in the part are already suppressed
when the suppress command is clicked, they will remain suppressed and the unsuppressed bodies will become suppressed.

**Unsuppress Part**

A part can be unsuppressed by right clicking on the Part branch in the **Tree Outline** and clicking **Unsuppress Part**. If some bodies in the part are not suppressed when the **Unsuppress Part** command is clicked, they will remain unsuppressed and the suppressed bodies will become unsuppressed. A solid green check mark icon will appear in the **Tree Outline** when a part is not suppressed (not all bodies are suppressed).

**Hide Part**

Right clicking on the Part branch in the **Tree Outline** and clicking **Hide Part** may hide a part. The **Hide Part** command hides all bodies that belong to the part. A light check mark icon will appear in the **Tree Outline** when a part is hidden (all bodies are hidden). If some bodies in the part are already hidden when the **Hide Part** command is clicked, they will remain hidden and the visible bodies will become hidden.

**Show Part**

A part can be made visible by right clicking on the Part branch in the **Tree Outline** and clicking **Show Part**. If some bodies in the part are visible when the **Show Part** command is clicked, they will remain visible and the hidden bodies will become visible. A solid green check mark icon will appear in the **Tree Outline** when a part is visible (not all bodies are hidden). Bodies that are suppressed when **Show Part** is clicked will not be affected.

**Named Selection from Model View Window**

When you have model entities selected, you will be able to start a **Named Selection** feature through the context menu. The **Named Selection** option is not available in the Sketching mode, feature creation, or edit selection.

**Form New Part**

The **Form New Part** feature is available only if bodies are selected and all of those bodies do not belong to the same part, and you are not in the middle of an operation that creates or edits model features.

By default, DesignModeler places every newly created body by itself, into a new part. However, you can group multiple bodies into a single part. Solid bodies, grouped as such, will have shared topology in Simulation and, when meshed, will form distinct but contiguous regions within the part mesh.

Surface Bodies grouped in the same part may share the topology if they are used in creating a Joint, depending on the choice/settings in the details of Joint.
To create a new part, select one or more bodies from the Model View window and use the Form New Part option in the context menu (right mouse button).

A new part can also be formed by selecting multiple bodies in the Tree Outline and using the Form New Part option in the context menu (right mouse button). Before a new part is formed, the selected bodies are removed from any existing parts. The new part is appended to the bottom of the body list in the Tree Outline and any parts that become empty are removed. For parts that contain multiple bodies, a part branch, containing multiple bodies, will be denoted in the tree. Part branches will not be shown explicitly for single-body parts.

The Details View for a part contains the part name, which can be changed, and the number of bodies, volume, surface area, and number of edges and faces associated with it.

To illustrate how grouping bodies into parts works, consider the following model with six bodies, named 1 through 6. Initially each body belongs to its own body group and no part branches are visible.

Now the odd numbered bodies are selected to form a body group. The result is that there are four parts; the first three use the defaults, consisting of one body each; the last one is the newly formatted group of bodies named “Part,” which can be expanded to show the three bodies within it. The part can then be renamed to “Odd Numbers.”

Suppose you now wish to group the prime numbers together. Bodies 2, 3, and 5 are selected and a body group is formed. It can then be renamed to “Prime Numbers.” Note that the group named “Odd Numbers” now contains only one body, so only body 1 is shown. Bodies 2, 3, and 5 are now grouped under the new part, “Prime Numbers.”
Explode Part

The **Explode Part** operation will separate the bodies contained within a part, changing them into single body parts. To perform the operation, right click the part you want to eliminate in the **Tree Outline** and choose **Explode Part**.

Result:
The operation may also be performed by selecting all the bodies that belong to a part in the Model View window, then choosing **Explode Part** in the context menu.

**Edit Selections**

DesignModeler allows you to perform Section : Edit Selections for Features and Apply/Cancel via the feature's context menu.

**Feature Insert**

DesignModeler allows you to insert a feature before a selected feature (branch in the feature **Tree Outline**) via the right mouse button.

A feature menu item is only shown in the right mouse button submenu if the system supports inserting the corresponding feature at the selected position in the tree. Note that Insert Feature will roll back the model to its status before the selected feature (branch in the tree). Just as in Edit Selections, this is necessary so that you can properly select model entities for the creation of the new feature (see example illustration below). When inserting a feature or performing edit selections on a feature, the features that appear after the selected one will become temporarily inactive until the model is regenerated. Inactive features appear gray in the **Tree Outline**.

**Feature Suppression**

Through the feature **Tree Outline**, you can suppress and unsuppress features. When a feature is suppressed, that means it is ignored when the model is generated. There are four suppression options, though only two of the four are available at a time.

- **Suppress**: Suppresses the selected feature and features that depend on it.
- **Unsuppress**: Unsuppresses the selected feature and all features that it depends on.
- **Suppress & All Below**: Suppresses the selected feature and all features below it in the feature **Tree Outline**.
Unsuppress & All Below: Unsuppresses the selected feature, all features below it in the feature Tree Outline, and all features that they depend on.

**Show Problematic Geometry**

The **Show Problematic Geometry** feature is available when faulty geometry associated with the error or undesired state can be determined for a feature. Furthermore, it is only selectable for one feature at a time. The **Show Problematic Geometry** feature will point out the faulty topology by selecting it and displaying an annotation containing a description of the error. It is important to note that this option is not available for all errors or all features. Only features in which additional error information is available can identify problematic geometry. Also note that the availability of problematic geometry may depend on the state of the model. If a feature fails and contains problematic geometry, that geometry must exist in the final model in order to be identifiable (e.g. if a blend feature identifies an edge as problematic and a subsequent Extrude feature cuts material such that the edge disappears from the model, then the problematic edge will not be available for viewing).

The **Show Problematic Geometry** option can only be accessed from the context menu of features in the Tree Outline.

![Show Problematic Geometry](image)

If selected, the **Show Problematic Geometry** option will point out the offensive geometry and highlight it.
If there are multiple faulty topologies available, then all of them will be highlighted and annotated. The maximum number of problematic geometry that is shown on the screen at one time can be set in the Options control panel.

**Show Dependencies**

The **Show Dependencies** option will display the parents and children of the selected feature. A parent is a feature that the selected feature depends on. A child is a feature that depends on the selected feature. The **Show Dependencies** option will not appear for features that have no parents or children.
Sketch/plane right mouse button options

Several options specific to sketches and planes appear in the context menu when right clicking on them in the feature Tree Outline.

- **Keep Visible**: Makes the selected sketch always visible, even when viewing another plane. Applies only to sketches.
- **Don’t keep visible**: Returns the sketch to its normal viewing mode. The sketch will be visible if the plane it belongs to is visible. Applies only to sketches.
- **Look At**: Orient the display so that it is centered on the selected sketch or plane.

Delete right mouse button option in Model and Details View

The Delete function is provided as a context menu option (right mouse button) whenever applicable within the Model View window and Details View. For example, you can select a constraint or edge from the Details View, click the right mouse button, and choose Delete.

Delete right mouse button option in Tree Outline

The Delete function is also available in context menus (right mouse button) accessed in the feature Tree Outline. A feature or sketch may be deleted if it is not used to define any other feature. Cross sections may be deleted if they are not assigned to any line bodies. The Delete function can also be used to “Cancel” the creation of a new feature.

*Note — While a new feature is being created, no other feature in the model can be deleted.*

Sketch Instances

Sketch Instances allow you to place copies of existing sketches in other planes. The edges in a sketch instance are fixed just like a plane boundary and cannot be moved, edited, or deleted by normal sketch operations. When changes are made in a base sketch, its instances will be automatically updated to match it when a Generate is done. A sketch instance can be used just like normal sketches for creating other features. However, it cannot be used as base sketches for Instances, and since it is designed to be a copy of the base sketch, you cannot go into Sketching mode to edit/modify a Sketch Instance. Because you are not allowed to make a sketch instance 'active' while in Sketching mode, they are not included in the drop down menu of sketches on the toolbar.

The basic steps to create a sketch instance are to first right click on the plane in the tree where you want to insert the Sketch Instance.
Since a Sketch Instance must lie in a plane later in the tree than the base sketch (unless the base sketch is a plane boundary), the XYPlane does not have an option for creating a Sketch Instance. The other two fixed planes have the option Insert Sketch Instance, and for other planes, Sketch Instance is an option in the Insert portion accessible via the right mouse button. Select the base sketch property in the Details View and then select the base sketch, either from the tree, or in the graphics area if it has been made visible. Just selecting a single edge of the desired sketch is sufficient. When you click on Apply, you will see the new Sketch Instance in the active plane. Note that the selected sketch must be from a plane that is earlier in the tree than the active plane. Another option for the base sketch is to select a plane in the tree that has boundary edges. These are planes made from planar faces. The boundary edges will be treated just like a base sketch.

You can also modify the following properties to control the location, angle, and scale of the sketch instance:

- **FD1, Base X:** This, along with Base Y, sets a reference location in the Base Sketch.
- **FD2, Base Y:** See Base X above.
- **FD3, Instance X:** This, along with Instance Y, sets the location in the active plane where the Base X and Y of the Base Sketch will be positioned. The Instance X and Y locations are also used as the central point for rotation and scale.
- **FD4, Instance Y:** See Instance X above.
• **FD5, Rotate Angle:** This allows rotation about the Instance X and Instance Y location.

• **FD6, Scale:** This allows scaling in relation to the Instance X and Instance Y location. Scaling is limited to a range of 0.01 to 100.0.

A Base Sketch can be used for multiple Sketch Instances. However, once you have used a sketch as a Base Sketch, you cannot delete it until you have deleted all of its Sketch Instances.

Note that a base sketch must be in a plane prior to the current plane in the tree. This is because the location and definition of the instance depends on the base sketch. If they were in the same plane, the location and definition of the base sketch could be affected by constraints and dimensions to the fixed sketch instance. This would mean that B depends on A, but A also depends on B, a circular definition that must be avoided. However, when the base sketch is really a plane boundary (a plane is selected as the base sketch), this circular definition cannot occur since the plane boundary is fixed. Because of this, an instance of a plane boundary is allowed to be in the same plane as its base.

*Note* — Generate is required to complete the sketch instances.

Once you create a sketch instance in a plane, that will prevent you from deleting the base sketch or the plane containing it as long as the Sketch Instance exists. In fact, just deleting the instance is not enough to allow the base sketch or its plane to be deleted. This is because you could still do an “Undo” to restore the instance. If you delete the plane that contains the instance, that will free up the dependence between the base and instance because the Undo and Redo stacks for that plane are cleared. Another way to clear the dependence is to Save via the File menu since that clears the Undo and Redo stacks for all planes.

**Quick Cut Copy Paste**

When in Sketching Mode, and in the general selection state, once you have selected any edges, Cut and Copy appear in the context menu. If you choose one of these, it is just as though you changed to the Modify group (if necessary), and selected either Cut or Copy in the toolbox, with the preselected edges. At that point you are asked to indicate the Paste Handle, and then automatically taken to the Paste function to place the edges, at as many locations as you want. When you are finished with Paste, along with the End option in the context menu, Cut and Copy now appear here also providing shortcuts back to those functions. Also, in the Cut and Copy functions themselves, any of the End right mouse button options will take you automatically to the Paste function.

**Measure Selection**

A setting in the **Options** dialog box defines a limit at which DesignModeler will stop automatically measuring a selection. This is intended to avoid doing CPU-intensive operations when the selection becomes complex. For properties that appear in the Details View, such as volumes and surface areas, you will see three dots "..." instead of the calculated value when the object exceeds the automatic calculation limit defined in the **Options** dialog box.
You can always force the selection to be measured by right clicking on the property and choosing **Measure Selection**. The **Measure Selection** option, if applicable, will appear in the Details View context menu and in the **Tree Outline** context menu if a body or part is selected.

### Edit Dimension Name/Value

You can quickly edit a dimension's name and value by selecting the dimension, then clicking the right mouse button and choosing the **Edit Name/Value** option as shown below.

A pop-up window will appear where you may modify the dimension's name and value. Note that for reference dimensions, you may only modify the name.
Move Dimensions

To change a cross section dimension's location, use the right mouse button option, as explained in the Section: Editing Cross Sections.

Go To Feature

When you have a model entity selected in the Model View window, the Go To Feature function is accessible via the right mouse button.
The function allows you to find which feature generated the selected entity. The supported entities are faces, edges, vertices, point feature points (PF points), and bodies. When a body is selected, this function will only show the first feature used to generate the body. The corresponding feature will be selected in the Tree Outline.

**Example 1 Selecting an edge**

Here the **Go To Feature** is used to select an edge from a model.
Note — This operation may fail to identify the appropriate feature due to the extension of surfaces during feature generation. It includes Body Operation and Surface Extension. Also the search may fail for Slice when it is performed on surface or line bodies.

Select All

The Select All option will select all visible entities in the model, for the active selection filter you have chosen.
Viewing

This chapter includes:

- Section : Model Appearance Controls
- Section : Context Menu Viewing Options
- Section : Display Toolbar
- Section : Rotation Modes
- Section : Print Preview

Model Appearance Controls

The following controls are accessible from the View menu:

- Section : Shaded Display
- Section : Shaded Display with 3D Edges
- Section : Wireframe Display
- Section : Show Frozen Bodies in Transparent Mode
- Section : Show Edge Joints
- Section : Show Cross Section Alignments
- Section : Show Cross Section Solids
- Section : Triad
- Section : Ruler

Shaded Display

Model faces are drawn, in normal “shaded” mode, but not model edges.

Shaded Display with 3D Edges

Model faces and model edges are drawn.
Wireframe Display

Model edges are drawn, but not model faces. The edges are drawn in two colors, one for shared edges, the other for unshared edges. The edge colors are determined by the DesignModeler Options dialog.

Show Frozen Bodies in Transparent Mode

If checked, frozen bodies will appear transparent, otherwise they will appear opaque. This option is checked by default.

Show Edge Joints

If checked, then the model's edge joints will be displayed. Edge joints are shown as thick lines in one of two colors. Blue edges indicate joints which are correctly grouped into the same part. These edges will be transferred to Simulation with their topology shared. Red edges indicate joints that have improper grouping. To change the color of the joint from red to blue, the bodies that created the joint must be grouped into the same part. Red edge joints will not share topology upon transfer to Simulation. In this example picture, the lower shelf is not grouped into the same part as the other bodies.
Show Cross Section Alignments

Each line body edge shows its alignment triad.

Show Cross Section Solids

Line bodies are drawn using their cross section attribute, if one exists. Shear Center and Centroid offsets are displayed the same. If the display line bodies with alignment option is on, both alignment triad and solid facet representation will be shown together. In this case, the solid facet representation will be drawn in a transparent color so that the alignment triads can be seen underneath it.
Note — The solid display for line body edges is done by sweeping the cross section along the edge. The sweep may fail to be displayed properly if the cross section dimensions are so large that the sweep becomes self-intersecting. In this case, the edge is drawn without a solid facet representation.

**Triad**

To toggle the triad orientation symbol in the display screen at all times, single-click the left mouse button on the **Triad** button in the View menu. The triad symbol is on by default.

The interactive Triad in the bottom right corner of the window contains viewing and informational controls.

- Red represents the x-axis
- Green represents the y-axis
- Blue represents the z-axis
- Clicking any of the triad arrows orients the view normal to that arrow.
- Clicking the Cyan "Iso" ball orients the model to isometric view.
- Mousing over any arrow identifies the axis (X, Y, Z) and direction (+/-) of the arrow.

**Ruler**
To toggle the ruler in the display screen, single-click the left mouse button on the **Ruler** button in the View menu. You can use the ruler, shown at the bottom of the Graphics Window, to obtain a good estimate of the scale of the displayed geometry. The ruler is on by default.

**Context Menu Viewing Options**

You can access most of the viewing options and selection filters described below by clicking on the right mouse button while in the sketching or modeling mode.

The following is displayed when you use the right mouse button in both the Sketching and Modeling modes.

The Cursor Mode options include:

- Section : Rotate
- Section : Pan
- Section : Zoom
- Section : Box Zoom

The View options include:

- **Front View**: To view your part from the front, click on the Front View button.
- **Back View**: To view your part from the back, click on the Back View button.
- **Right View**: To view your part from the right, click on the Right View button.
- **Left View**: To view your part from the left, click on the Left View button.
- **Top View**: To view your part from the top, click on the Top View button.
- **Bottom View**: To view your part from the bottom, click on the Bottom View button.
- **Isometric View**: The Isometric View allows you to view in 3D any time.
Display Toolbar

Use the display buttons to manipulate how triads, models, faces, planes and sketches are displayed in the graphics Window.

Display Plane

The Display Plane button allows you to toggle between displaying the axis vectors and origin point (if there is not a 3D model), and to toggle between displaying the axis vectors, origin point, and boundary edges (if there is a 3D model). If you turn off the axis vectors, origin point, and boundary edges, the 3D model is turned on automatically.

Display Model

The Display Model button allows you to toggle between displaying the 3D model or not. If you turn off the 3D model, the plane is turned on automatically.

Look at Face/Plane/Sketch

The Look at Face/Plane/Sketch button centers the display on the currently selected Face, the currently active Plane, or the currently active Sketch.
Rotation Modes

Use the rotation modes to manipulate the position of items displayed in the Sketch/Model Window.

Rotate

The Rotate tool allows you to rotate any sketch, model, or part. The cursor location and shape determine the rotation behavior.

Pan

The Pan tool allows you to move the entire part about the display screen.

Zoom

The Zoom tool allows you to scale the part on the display screen.

Box Zoom

The Box Zoom tool allows you to use the cursor to indicate opposite corners of the zoom window.

Zoom to Fit

The Zoom to Fit tool allows you to show the part at full size in the display screen.

Magnifier Window

The Magnifier Window tool allows you to zoom in to portions of the model. With the model in any state, you can display the Magnifier Window by clicking the button in order to:

- Pan the Magnifier Window across the model by holding down the left mouse button and dragging the mouse.
- Increase the zoom of the Magnifier Window by adjusting the mouse wheel, or by holding down the middle mouse button and dragging the mouse upward.
- Recenter or resize the Magnifier Window using a right mouse button click and choosing an option from the context menu. Recenter the window by choosing Reset Magnifier. Resizing options include Small...
Magnifier, Medium Magnifier, and Large Magnifier for preset sizes, and Dynamic Magnifier Size On/Off for gradual size control accomplished by adjusting the mouse wheel.

Standard model zooming, rotating, and picking are disabled when you use the Magnifier Window.

**Previous View**

To return to the last view displayed in the graphics window, click the Previous View button on the toolbar. By continuously clicking you can see the previous views in consecutive order.

**Next View**

After displaying previous views in the graphics window, click the Next View button on the toolbar to scroll forward to the original view.

**Isometric View**

**Isometric View Button**

The Isometric View button allows you to view your model in an isometric state.

**Set Button**

The ISO icon button allows you to set the isometric view. You can define a custom isometric viewpoint based on the current viewpoint (arbitrary rotation), or define the “up” direction so that geometry appears normally oriented.

**Restore Default Button**

The Restore Default icon button resets the isometric view to its default state.

**Keyboard Support**

The same functionality is available via your keyboard. The numbers correlate to the following functionality:

- 0 = View Isometric
- 1 = +Z Front
- 2 = -Y Bottom
- 3 = +X Right
- 4 = Previous View
- 5 = Default Isometric
- 6 = Next View
7 = -X Left
8 = +Y Top
9 = -Z Back
. (dot) = Set Isometric

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>8</td>
<td>9</td>
</tr>
<tr>
<td>-X</td>
<td>+Y</td>
<td>-Z</td>
</tr>
<tr>
<td>Left</td>
<td>Top</td>
<td>Back</td>
</tr>
</tbody>
</table>

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>← Previous</td>
<td>Default Isometric</td>
<td>Next →</td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>+Z</td>
<td>-Y</td>
</tr>
<tr>
<td>Front</td>
<td>Bottom</td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>+X</td>
</tr>
<tr>
<td></td>
<td>Right</td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
</tr>
<tr>
<td>View</td>
<td></td>
</tr>
<tr>
<td>Isometric</td>
<td></td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>.</td>
<td></td>
</tr>
<tr>
<td>Set</td>
<td></td>
</tr>
<tr>
<td>Isometric</td>
<td></td>
</tr>
</tbody>
</table>

**Print Preview**

A tab at the lower left corner of the sketch window shows that by default, the system is in the Model View. To the right is the Print Preview tab. Clicking it allows you to print the current view of your model or save a screen shot.
The lines at the top of the Print Preview page contain several fields describing the model. The text for some of the fields is determined by the properties in the model branch, which is the first branch in the Tree Outline.

To print the model, use the Section : Print option in the File menu.

**Window Layout**

The window layout in the ANSYS Workbench environment implements a docking pane configuration that allows you to shift and size the individual panes to your liking.

**Restore Original Window Layout**

To restore the same window layout used as when you started DesignModeler, select the Restore Original Window Layout option from the View menu.
2D Sketching

Important

In order to use the sketcher efficiently, it is important to note that, in the context of constraints and dimensions, the system treats 2D edges as if they extend beyond their endpoints.

To create a solid body from your sketch, all connected chains of edges must be closed.

Most multiple-task operations are done by one of two input sequences:

- Click (press and release), move, click sequence
- Press (hold), drag, release sequence

Many sketching operations make heavy use of the right mouse button context menu for optional input. Some also have optional input via toolbox check/edit box options. In the following, these options are listed after the operation's icon:

**Toolbox check/edit box:** Option 1, Option 2, …

**Right Mouse Button context menu:** Option 1, Option 2, …

The right mouse button `Back` option is very much like a “micro” undo during the sketching operation.

The sketching operations support Undo/Redo functionality, but note that each plane stores its own Undo/Redo stacks.

Also note that while in Sketching mode, you can always exit whatever function you are in and go to the general Select mode, by pressing the [ESC] key. Note that if you have accessed a window external to the DesignModeler, you will need to click somewhere back in the DesignModeler window before the [ESC] key will be usable.

**Undo**

Use the Undo command to rescind the last sketching action performed.

**Redo**

Use the Redo command to “redo” a sketching action previously undone.

**Sketches and Planes**

A sketch is a collection of 2D edges. A plane can hold any number of sketches. Whenever you create a 2D edge using one of the tools in the Section: Draw Toolbox, it is added to the currently “active” sketch. You can click the Section: New Sketch button to create a new sketch in the currently “active” plane, or you can select an already existing sketch to make it the new active sketch.
Note — Sketch Instances (accessible via the Context menus) allow you to place copies of existing sketches in other planes.

Planes Without Sketches

If you begin drawing on a plane that has no sketches, a new sketch will be automatically created for you. Once created, sketches can be used for feature creation, and they can be modified at any time using the various sketching tools.

Points are created automatically at the ends of 2D edges. The points can then be used for dimensions and constraints. Additionally, there are options in the Section: Draw Toolbox to create a point at a screen location or at the intersection of 2D edges.

Construction Sketches

One very important use of having multiple sketches in a plane is to use one sketch just for construction geometry. You can name this sketch “Construct” or something similar to remind you that it is for construction geometry. This sketch can be used for geometry that is useful for the construction or constraints on other geometry, but is geometry that you do not wish to be included in a feature.

For example, if you want to create a circular pattern of holes, it can be difficult to constrain/dimension these so that they remain in the pattern you want, especially if you want the option of later modifying the radius of the pattern.

An easy way to deal with this is to create a construction sketch and then create a polygon in that construction sketch, with the same number of sides/vertices that you want for the pattern of holes. Then constrain/dimension the polygon so that the vertices are where you want the circle centers to be.

Finally, go back to the sketch where you want real geometry created and create the circles, with each circle center coincident with one of the polygon vertices. Now you can modify the radius of the polygon, or rotate it, and the circles will move with it. However, if you extrude the sketch with the circles, the polygon is ignored.
Another simple example is if you want a series of circle centers to be linear, you can simply create a line in a construction sketch and constrain all of the circle centers to be on that line.

**Color Scheme**

2D entities are colored to indicate their constraint status. The colors will help you to identify sketch entities that may require constraints or are in error. There are five colors used to denote the status of a 2D entity:

- **Teal**: Under-constrained
- **Blue**: Well Defined
- **Black**: Fixed
- **Red**: Over-Constrained
- **Gray**: Inconsistent or Unknown

*Note* — Fixed plane edges are drawn as dotted black lines.

**Auto Constraints**

During drawing input, if the Auto Constraints Cursor mode is on, symbols are displayed confirming snapping to either of:

- **Coincident**, depicted by the letter C
- **Coincident Point**, depicted by the letter P
- **Horizontal**, depicted by the letter H
- **Vertical**, depicted by the letter V
- **Parallel**, depicted by the parallel symbol: //
- **Tangent**, depicted by the letter T
- **Perpendicular**, depicted by the perpendicular symbol: ⊥
- **Equal Radius**, depicted by the letter R

*Note* — Cursor and Global Auto Constraint modes can add noticeable time to sketch operations on very complex sketches, so you can control whether or not you want them on (see Auto Constraints on the Constraints menu).
Details View in Sketching Mode

While in Sketching mode, the Details View can contain three types of information:

- **Section : Sketch Details**
- **Section : Edge Details**
- **Section : Dimension Details**

All the detail views are broken into groups, listed in boldface and proceeded by a [-], followed by the information that pertains to that group. Items within a group have a title on the left followed by a value on the right. The value column may be grayed-out, if the item is read-only, and cannot be edited.

**Sketch Details**

![Details of Sketch](image)

**Details of Sketch**

The first item under the Details of Sketch group, lists the sketch name in a value field that can be edited. This allows you to change the name of a sketch. All names and labels that you create must be unique, start with a letter, and contain only letters, digits and underscores. Spaces and hyphens are not recognized. If your supplied name does not end in a numeric and is not unique, a numeric will be added at the end. For example, MyPlane becomes MyPlane2, and MySketch5 becomes MySketch6.

The next item in this group is 'Show Constraints,' and its value can be Yes or No. Changing this value has a major effect on how the rest of the Sketch Detail View will look, as will be explained below.

Clicking the 'Details of' group selects the sketch and highlights all the edges in the sketch.

**Dimensions: n**

The 'Dimensions: n' group lists the dimension, where 'n' is the number of dimensions created with this active sketch. This group will not appear if there are no dimensions as part of the sketch. If there are dimensions, they
will be listed item by item. Their appearance depends on whether or not they are Reference dimensions. If it is a **Reference** dimension, its name is displayed enclosed in parenthesis in the title area, and its value is displayed in a read-only background value field. Otherwise, if the dimension is not a Reference dimension, then the title field is preceded with a check box (provided the model has been saved to a file and has a valid model name) which, once checked, will be marked with a “D” indicating that the dimension is driven by a Design Parameter. Once a dimension is driven by a Design Parameter, its value field becomes read-only.

If a dimension's value field is not read-only, then you can select it and change the value. The sketch(es) on this plane will then be updated to reflect this change. You can then click Generate to have this change reflected in your 3D model.

In general, you can select any dimension by selecting it in the Model View area, or by selecting it in the details view. If you select the “Dimensions: n” group, all the dimensions in the sketch are selected and highlighted.

**Edges: n**

The “Edges: n” group, lists the edges contained in the sketch, where 'n' is the number of edges in the sketch. The format of this group is strongly affected by the setting of the “Show Constraints” switch above. If the switch is set to “No”, then each of the edges is listed as an element of this group, with its type as the title, and its value the name of the edge. If the switch is set to “Yes”, then each of the edges is listed as its own group, 'Edge Type Name,' containing a list with constraints that are applied to that edge.

If you select the “Edges: n” group, all of the edges are selected.

**Edge Type Name**

If the Show Constraints switch is set to “Yes,” you will get one of these groups for each edge and construction point that has been created in this sketch. Edge types can be Line, Circle, Circular Arc, Ellipse, Elliptical Arc, Open Spline, Closed Spline, or Point. The items in this group (if any) are the constraints on the edge itself, and then any constraints on its start, end, or center point if they exist and have constraints. The constraint will be named and in the value field will be shown the other edge that is named in the constraint.

Selecting the group will select the edge.

Selecting one of the constraints actually selects the constraint, though these cannot be seen, and highlights the edges involved in the constraint. If you select one of the constraints, and then hit Delete, the constraint is deleted, not the highlighted edges.

**Points: n**

If the “Show Constraints” switch above is set to “No,” and you have created construction points while this sketch was active, these construction points are listed in the 'Points: n' group, where 'n' denotes their number. If the constraint switch is set to “Yes,” then they are created as “Point Name” groups and appear identical to the “Edge Type Name” groups above.

**References: n**

The ‘References: n’ group lists points and edges in other sketches that are directly connected to points or edges in this sketch via constraints or dimensions. The origin point and axis lines for the plane are not listed here, but if you have more than one sketch in your plane and put a dimension between an edge in one sketch and an edge in another sketch, you will see this group show up.

You can select items in this group and they will be highlighted and selected. However, selecting the group itself has no effect.
Edge Details

When you select an edge in the Model View area, the Edge Details appears. The first group is the Details of Edge Type Name group. As the first item it lists, again, the edge type, and its name, in the value field, which can be edited. Note that edge names must be unique, and if the name you supply ends with a numeric, it will be modified to find a unique name. If your supplied name does not end in a numeric, and is not unique, a numeric will be added at the end. The next few items in this group provide specific information about the edge you have selected.

Next, there will be an item with the title “Constraint Status”, and a value such as Fixed, Under-Constrained, Over-Constrained, Inconsistent, Well Defined, or Unknown. An example of Inconsistent would be if you created a triangle and dimensioned the lengths of the sides, then changed their values such that they were 10, 20, and 50. This is not possible and would lead to an Inconsistent constraint status on one or more of the edges. When you have one or more edges with an Inconsistent or Over-Constrained status, the status of other edges sometimes cannot be determined. When this happens, you may see the Unknown status appear. If an edge has a status of Under-Constrained, an additional item will appear with the title “Constraints Needed” and a value of Position, Angle, Radius, or a combination of these depending how the item can still change based on its current constraints.

After the constraint status item, each constraint on the edge is listed, with the related edge in the value field.
Following this there are Point Name groups for each of the edge's base, end, and center points, when appropriate. These will show the X and Y position of the point, its constraint status, and the constraints on the point.

You can select items in the Edge Details similar to selecting from the Sketch Details. When you create something new, you are returned to the Sketch Details. You can also return there by clicking the New Selection icon.

**Dimension Details**

<table>
<thead>
<tr>
<th>Details of NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Length/Distance</strong></td>
</tr>
<tr>
<td><strong>Value</strong></td>
</tr>
<tr>
<td><strong>Line9.Base</strong></td>
</tr>
<tr>
<td><strong>Reference Only?</strong></td>
</tr>
<tr>
<td><strong>Update position with geometry?</strong></td>
</tr>
</tbody>
</table>

**Details of NAME**

When you select a dimension in the Model View area, the Dimension Details appear. The first group in the Dimension Details is always 'Details of NAME,' where NAME is the name of the selected dimension. The first item in this group identifies the dimension type, and lists the dimension's name in the value field, which can be edited. Note that dimension names must be unique, and if the name you supply ends with a numeric, it will be modified to find a unique name. If your supplied name does not end in a numeric and is not unique, then a numeric will be added at the end. The next item lists the Value. If the value field is not read-only, then you can modify it. Clicking Generate will then propagate that change through the 3D model.

The following items identify the points or edges associated with this dimension. Then, the next item allows you to state whether or not this is a Reference Only dimension. If it is, you will not be able to change its value and its name will be shown enclosed in parentheses, and its value can change as the sketch is changed. Finally, there is a switch that allows you to prevent the position of this dimension from automatically being updated when its associated geometry moves.

To go back to the Sketch Details, you can select the Active Sketch Drop Down menu on the toolbar, or [ESC] can be used to clear the selections and go back to the Sketch Details. Note that if you have accessed a window external to DesignModeler, you will need to click somewhere back in DesignModeler window before the [ESC] key will be usable.

**Right mouse button option items with (icon) check marks**

When using the Fillet, Chamfer, Split, Equal Distance constraint, or general Dimension features, you can click the right mouse button to display by check mark (depressed icon) the current mode for the option shown. Shown here are the Fillet trim mode options.

*Note* — Full circle here implies no trimming.
**Draw Toolbox**

The Draw toolbox is displayed by default when you enter the Sketching mode. Use the tools to draw 2D edges and apply dimensions and constraints.
Note — Sometimes not all of the toolbox items can be displayed at once. Use the up and down arrow buttons to the right of the toolbox categories to scroll up and down though the available toolbox items.

**Line**

Right Mouse Button Context Menu: *Back*

Use the cursor to indicate a start and end for the line.
Tangent Line

**Right Mouse Button Context Menu:** *Back*

To maintain tangency between a line and an edge, use the Tangent Line tool. Click on an existing edge or endpoint to start the line. It will rubber band as tangent to the selected edge and you can then indicate the length of the line. The rubber band line will not stay under the cursor, but instead, its length will be based on the cursor location, while its start and direction are controlled by the selected edge. To ensure that you are tangent to the end of an edge, select its endpoint, not the actual edge.

Line by 2 Tangents

**Right Mouse Button Context Menu:** *Back*

To create a line tangent to two edges (or points), use the Line by 2 Tangents tool. Select two edges or points near the desired tangent location on each edge. The defined line will start and end at the tangency location on each selection.

Polyline

**Right Mouse Button Context Menu:** *Open End, Closed End, Back*

To draw a closed or open polygon, use the Polyline tool. The Polyline tool allows you to draw a series of connected lines. You need to use one of the right mouse button options, *Open End* or *Closed End*, to finish your input and actually define the lines.

Polygon

**Toolbox check/edit box:** \( n = \)

**Right Mouse Button Context Menu:** *Back*

The Polygon tool allows you to draw regular polygons with \( n = 3-36 \) sides. You set the number of sides via an edit box on the toolbox item. Then you enter a center location and the location of one of the vertices. The polygon is then created, along with a center point. This center point is important to the polygon, as a special type of internal constraint is created to maintain the polygon's shape, even when you rotate or resize the polygon. If you delete the central point, the internal constraint is deleted and the polygon may no longer maintain its shape when changes are made to it. The edges of the Polygon are lines, just like those you could create with the basic Line function, or Polyline. The main difference is that this internal constraint makes sure the polygon retains its shape. If you select a center point of a polygon, you will see in its detail view that it lists 'Polygon Center', with the number of sides for the full polygon show to the right. If you select one of the edges, it lists 'Polygon Edge' as one of its constraints and shows the center point of the polygon to the right.

You can delete lines from the polygon and it will still maintain its shape, as long as the center point and at least three edge lines remain. However, when a polygon line is deleted, the adjacent lines remain in the correct location and angle, but the neighboring endpoints can be either trimmed back or extended without violating the polygon
shape. When making copies of a polygon with Cut/Copy/Paste/Move/Replicate, you need to either select all of the lines of the polygon, or the center point (in which case all lines will be processed as though they were selected). If you do not select all the lines, or the center point, copies will not have the internal constraint that maintains the polygon shape. The screen shot below shows some sample polygons. The one at the lower left has had three lines deleted from it. Also shown are some Line and Point entries in the Sketch detail view, with constraints shown.

**Rectangle**

Toolbox check/edit box: Auto-Fillet

Right Mouse Button Context Menu: Back

To proportionately draw a rectangle with a horizontal/vertical orientation, use the Rectangle tool. It allows you to draw a horizontal and vertical oriented rectangle (defined by four edges), by indicating opposite corners.

The **Auto-Fillet** option, if checked, allows you to indicate one more location to provide the radius for corner arcs. If your radius is too large for all four of the corners, the narrow ends of the rectangle will be replaced with 180° arcs.

**Rectangle by 3 Points**

Toolbox check/edit box: Auto-Fillet

Right Mouse Button Context Menu: Back
To draw a rectangle at an angle by specifying three of the four corners, use the Rectangle by 3 Points. It allows you to draw a rectangle (defined by four edges) at any angle. Your first two-cursor indications define the length and direction of one side of the rectangle. Your third indication determines the length of the sides perpendicular to the initial side.

The Auto-Fillet option, if checked, allows you to indicate one more location to provide the radius for corner arcs. If your radius indication is too large for all four corners, the narrow ends of the rectangle will be replaced with 180° arcs.

**Oval**

**Right Mouse Button Context Menu: Back**

To draw an oval, use the Oval (four edges) tool. Indicate the center of the two circular end caps, and then indicate their radius.

**Circle**

**Right Mouse Button Context Menu: Back**

To draw a circle, use the Circle tool. Indicate the center and then the radius.

**Circle by 3 Tangents**

**Right Mouse Button Context Menu: Back**

To draw a circle using three tangents, use the Circle by 3 Tangents tool. Select three points or edges near where you want a tangent circle created. A circle will be created that is tangent to the selected edges, or passing through the selected points.

**Arc by Tangent**

**Right Mouse Button Context Menu: Reverse, Back**

To draw an arc by tangent, use the Arc by Tangent tool. Select an edge or endpoint to start a tangent arc. An arc is then rubber banded. You control the radius and angular extent of the arc with the cursor. Which way the arc curves from your initial selection depends on your cursor position. If you imagine a tangent line extending out from this first location, which side of that line your cursor is on effects the direction the arc curves. Also, if you want the second end of the arc to be tangent to another curve, watch for the 'T' to be displayed, if you have the Section : Auto Constraints Cursor turned on, when selecting the second curve. You can use the right mouse button Reverse option to reverse the initial direction of the arc. If you want it to be tangent to the end of an edge, be sure to select its endpoint instead of the edge itself. If you select a center point, Section : Construction Point, or nothing at all, a 180° arc will be created.
Note — If you are selecting a point where there is more than one possible endpoint, and not getting the direction you want, then instead select the edge as close as possible to its end. That way, Auto-Constraints should still snap the arc to the edge endpoint.

**Arc by 3 Points**

*Right Mouse Button Context Menu: Back*

To draw an arc using three points, use the Arc by 3 Points tool. Indicate the start and end of an arc, then the final indication controls the side and radius of the arc.

**Arc by Center**

*Right Mouse Button Context Menu: Back*

To draw an arc from a center point, use the Arc by Center tool. Indicate a center and then drag the cursor to indicate the radius, just as though you were creating a full circle. After that, however, use the radius indication as the start angle of the arc, and a third indication gives the end angle. When moving the cursor for the third location, the Arc can be created in either direction from your second location. However, once the Arc being rubberbanded exceeds 90°, that locks in the direction from the second location, allowing you to continue moving the cursor to create Arcs greater than 180° if desired.

**Ellipse**

*Right Mouse Button Context Menu: Back*

To draw an ellipse from a center point, use the Ellipse tool. Indicate the center and then the end of one axis of the ellipse to determine the angle of the ellipse. Use the third indication to determine the length of the other axis of the ellipse.

Ellipses and elliptical arcs (trimmed/partial ellipses) can be difficult to properly constrain and dimension. One very important thing to remember regarding this is that you can use the Section : Parallel constraint with them. This will set the major axis parallel to a line or another ellipse. If you don't want the line in your sketch, you can put it in a separate 'construction' sketch. Also, dimensioning or constraining the center point and using the min and max radius dimensions are useful techniques for ellipses.

Finally, tangent constraints are also useful. You can even create a rectangle (by 3 points so it can be at an angle) in a 'construction' sketch; make the ellipse parallel to a long side of the rectangle; and then make the ellipse tangent to each of the sides.

**Spline**

*Right Mouse Button Context Menu: Open End, Open End with Points, Closed End, Closed End with Points, Back*
To draw a closed or open spline, use the Spline tool. Create the spline by indicating a series of control points and then use the right mouse button to finish the spline either **Open End** or **Closed End, with Points** or **without Points**. The with Points options will create points at the locations used to create the spline that are associated with the spline, like the center points of circles. These points have a special form of coincident constraint to the spline that prevents them from sliding along the spline.

**Flexible Splines**

To create a flexible spline, click on the toolbox check/edit box beside the Spline feature.

![Spline Flexible](image)

The 'Flexible' check box can be used to decide whether you want the spline you create to be rigid (default), or flexible (if you check the box). A rigid spline can be moved or rotated, but its actual shape will not change (unless you later change it to flexible). You can change the shape of a flexible spline by assigning constraints (e.g. tangent lines at its endpoints), dimensions, or by using the Drag function to move defining points, tangent curves, or other edges that are related to the spline via constraints or dimensions. Note that if you create a spline 'with Points', those points remain at fixed locations along the curve. These are very useful for dragging to modify the shape of the spline. The Section : Edge Details for a spline contains a line that allows you to change whether or not you want a spline to be flexible or not. Note that currently, if you create a Closed spline, it will be set to non-flexible, no matter what the setting of the Flexible option is and cannot be changed in the Section : Edge Details.

A flexible spline exhibits the characteristics similar to a “flexible ruler” as illustrated.

![Flexible Spline](image)

Before dragging the endpoint of a flexible Spline.
After dragging the endpoint of a flexible Spline.

**Construction Point**

Points are automatically constructed during edge creation at edge end points and/or center. This option allows the cursor input of additional points, which, may or may not lie on edges.

**Construction Point at Intersection**

This option will place a point at the intersection of two selected edges. If the edges do not intersect, but their extensions would, this extended intersection will be found.

*Note* — If the curves intersect at more than one location, your selection locations will determine which is created.

**Modify Toolbox**

Use the Modify toolbox to edit your sketches.
You can draw a fillet for intersecting and non-intersecting edges. Select an endpoint connecting two edges, or two edges or points to place a tangent arc of the specified radius between them. The selection locations are used to determine both where to place the tangent arc, and which end of the selected edges to trim (or extend) to the tangency location. You can use the right mouse button options to control the trimming of the selected edges, or to optionally create a full circle with no trimming.
Chamfer

Toolbox check/edit box: Length
Right Mouse Button Context Menu: Trim Both, Trim 1st, Trim 2nd, Trim None

You can draw a chamfer for intersecting and non-intersecting edges. Select an endpoint connecting two edges, or edges to create a chamfer line “breaking” the corner between them. The length specified is the distance from the intersection location of the edges to each of the endpoints of the chamfer line.

Corner

Select two edges to trim or extend as needed to their intersection location. Where you select the edges determines which end of the edge is modified.

Trim

Select an edge in an area where you want it to be trimmed. The portion of the edge up to its intersection with other edge, axis line, or point will be removed. If the edge does not intersect anything, it will be deleted. If the Ignore Axis box is checked, then axis lines will be ignored when determining the trim extent.

   Note — Preselected edges are ignored.

Extend

Select an edge near the end of the edge that you want extended to its intersection with another edge, axis line, or point. If you have previously trimmed a spline, Extend can be used on it. However, it cannot extend a spline beyond the ends of its original definition. If the Ignore Axis box is checked, then axis lines will be ignored when determining extensions.

   Note — Preselected edges are ignored.

Split

Toolbox check/edit box: \( n \)
Right Mouse Button Context Menu: Split Edge at Selection, Split Edges at Point, Split Edge at All Points, Split Edge into \( n \) Equal Segments

There are several distinct right mouse button options to this function, so be sure to choose which you want before selecting an edge.

Split Edge at Selection: Set as the default option, it splits an edge into two pieces at the selection location, unless the selected edge is a full circle or ellipse. If it is a full circle or ellipse, both start and end endpoints are created at the selection location.
2D Sketching

**Split Edges at Point:** Select a point, and all edges, which pass through the selected point, are split there.

**Split Edge at All Points:** Select an edge and it is split at all points that it passes through and that have a coincident constraint to it.

**Split Edge into n Equal Segments:** Set the value \( n \) in the edit box and then select the edge which you want to Split.

**Variable Text**

The Split toolbox has variable text, depending on which Split right mouse button option you select. Moreover, the \( n= \) number edit box only appears when the Split Edge into n Equal Segments option has been selected.

*Note —* A value up to 100 is allowed for \( n \). If you attempt to set the value to more than 100 the previously-set value is retained.

**Drag**

Select a point or an edge to “drag” using the cursor. How the model will change depends on both what you select, and existing constraints and dimensions on the model. You can drag a group of edges by preselecting them before choosing this tool.

**Cut**

This lets you select a set of items to copy to an internal clipboard, and then deletes the originals from the sketch.

See: Section : Copy, Section : Paste

**Copy**

**Right Mouse Button Context Menu:** Clear Selection, End / Set Paste Handle, End / Use Plane Origin as Handle, End / Use Default Paste Handle

**Right Mouse Button Context Menu:** Clear Selection, Use Plane Origin as Handle

Cut/Copy requires the selection of a *paste handle* relative to which the Paste will be performed. The paste handle is the location to which the cursor is attached while you are moving the image into position to paste. The basic sequence is:

1. Select the edges (and/or points) to be cut/copied.
2. Choose the one of the following right mouse button options.
   a. End / Set Paste Handle, and specify the paste handle.
   b. End / Use Plane Origin as Handle, the 0.0, 0.0 location of the plane will be used as the paste handle.
   c. End / Use Default Paste Handle, the start of the first curve selected will be used as the handle.

This lets you select a set of items to copy to an internal clipboard, and leaves the originals in the sketch.
If Cut/Copy are used with preselection, the right mouse button is the same as after **End / Select Paste Handle** is chosen: (Clear Selection, Use Plane Origin as Paste Handle)

If Cut or Copy is exited without selecting a paste handle, a default will be used.

Dimensions to axis lines, origin point, or unselected items will NOT be processed. An attempt will also be made to preserve as many constraints on the selected items as possible. Note that Horizontal/Vertical dimensions and constraints are converted to the opposite in a 90° rotation at Paste time. At any other rotation angle, these dimensions and constraints will not be pasted.

**Paste**

**Toolbox check/edit box:** r, f

**Right Mouse Button Context Menu:** Rotate by r Degrees, Rotate by -r Degrees, Flip Horizontally, Flip Vertically, Scale by Factor f, Scale by Factor 1/f, Paste at Plane Origin, Change Paste Handle, End

This lets you take items placed on the clipboard by Cut or Copy and place them into the current (on new) sketch, even if it is on a different plane.

Whatever you place on an internal clipboard by Cut or Copy, you can place either in the same plane or on another plane. The edges are dragged, relative to the previously selected paste handle. By changing r and f, and then using the right mouse button options, the edges to be pasted can be rotated or scaled. The Change Paste Handle option displays symbols at each of the selected curves endpoints and/or center plus a symbol that represents the plane origin relative to where the curves were when they were Cut or Copied. The symbol nearest the cursor is displayed different than the others. Once you click to select the nearest symbol, that location will now be used as the paste handle (location that is attached to the cursor). You can paste multiple times.

**Move**

**Toolbox check/edit box:** r, f

**Right Mouse Button Context Menu:** Clear Selection, End / Set Paste Handle, End / Use Plane Origin as Handle, End / Use Default Paste Handle

The Move command functions the same as the Replicate command with the exception that your original selection is moved to a new location instead of being copied.

Dimensions to axis lines, origin point, or unselected items will NOT be processed. An attempt will also be made to preserve as many constraints on the selected items as possible. Note that Horizontal/Vertical dimensions and constraints are converted to the opposite in a 90° rotation at Paste time. At any other rotation angle, these dimensions and constraints will not be pasted.

**Replicate**

**Toolbox check/edit box:** r, f
Right Mouse Button Context Menu: Clear Selection, End / Set Paste Handle, End / Use Plane Origin as Handle, End / Use Default Paste Handle

Right Mouse Button Context Menu: Clear Selection, Use Plane Origin as Handle

Right Mouse Button Context Menu: Rotate by r Degrees, Rotate by -r Degrees, Flip Horizontally, Flip Vertically, Scale by Factor f, Scale by Factor 1/f, Paste at Plane Origin, Change Paste Handle, End

The Replicate command is equivalent to the Copy command, followed by a Paste.

After one of the **End / options** is selected, the right mouse button changes to the Paste right mouse button.

If Move/Replicate are used with preselection, the right mouse button is the same as after **End / Select Paste Handle** is chosen: (Clear Selection, Use Plane Origin as Paste Handle)

If Move/replicate is exited without selecting a paste origin, a default will be used.

Dimensions to axis lines, origin point, or unselected items will NOT be processed. An attempt will also be made to preserve as many constraints on the selected items as possible. Note that Horizontal/Vertical dimensions and constraints are converted to the opposite in a 90° rotation at Paste time. At any other rotation angle, these dimensions and constraints will not be pasted.

### Offset

Right Mouse Button Context Menu: Clear Selection, End Selection / Place offset

The Offset function allows you to create a set of lines and arcs that are offset by an equal distance from an existing set of lines and arcs. The original set of lines and arcs must be connected in a simple end-to-end fashion and can form either an open or closed profile. You can either preselect the edges, or select them within the function and then choose the right mouse button option “End selection / Place offset” when finished with the selection process.

Now, as you move the cursor around, its location is used to determine three things:

- Offset distance
- Offset side
- Offset area

The first two are fairly clear, but the third is also very important. If portions of your selected curves would collapse out or cross over one another given the current offset side and distance, the cursor location determines which area of offset curves is kept. With large offset distances and collapsed areas, some unique results will occur if the cursor is placed in areas that should be removed. However, by placing the cursor in desired areas, you should find that this method of allowing you to select the desired offset area allows for the offset of many very complex shapes.

Also, remember that if the offset does not give you exactly what you want, you can easily use the Trim and Extend functions to make minor changes later.

To create the new curves, click the mouse when you are satisfied with what is displayed. You can then create additional offsets, or use the right mouse button to clear the selection or exit the function. Once you have created a set of offset curves, a single distance dimension between an original curve and its offset will control the spacing of all curves in the offset.
At this point, you cannot change the offset distance via a dimension to any value that would cause more curves to collapse out (e.g. a radius that becomes zero or negative).

If you show the constraints in the Sketch detail view, you will see that multiple Equal Distance constraints have been created between the curves. This is what maintains the spacing.

**Offset Examples**

The first image below contains a simple rectangle with a circular cutout on the top. For this illustration, these edges have a fixed constraint and appear as black. It has been offset three times to the outside and three times to the inside. Sketching pencil symbols are shown where the cursor was placed for each offset.

On the first inside offset, closest to the profile, you will see that all the curves have been offset and trimmed appropriately. On the next inside offset, you will notice that the line on the upper left of the original profile has been eliminated as it has collapsed out. Finally, on the third inside offset, you will see a single triangular shape (with an arc for one side) as at this distance, offsetting the bottom line and the top arc intersect, splitting the result into two possible areas. The cursor location determines that this is the result.

Now, looking at the first outside offset, you will see that the arc has been extended to its intersections with the top line offsets. In the second outside offset, the lines would no longer intersect the arc, so the arc is 'extended' with tangent lines from its ends. Finally, on the third outside offset, the radius of the arc has collapsed to zero or less, so it is eliminated.

The second image below shows a line with a simple rectangular notch, repeated three times, and again in each case the original curves are fixed so they show up as black. Also again, sketching pencil symbols are shown where
the cursor was placed for each offset. In the upper part of the image, it has been offset such that the notch has been collapsed out. In the center part of the image, the cursor was placed in the area being collapsed out. This is to illustrate the importance of where you place the cursor! In the lower area, you can see how a single dimension makes the entire offset profile fully constrained.

**Dimensions Toolbox**

Use the Dimensions toolbox to define your sketch.

*Note* — Because the numbers for dimension names begin at 1 for each plane, there can be, for example, H1 and V2 in many different planes. They remain unique as the name is associated with the plane to which they belong. When creating dimensions, while placing the dimension on the plane, you can click the right mouse button to Cancel (delete the current dimension), change whether or not a dimension automatically changes position when its associated geometry changes, or select Edit Name/Value. This will pop up a dialog box that allows you to change the name and/or value before indicating the location for the dimension. For Reference dimensions, or dimensions being created with Section : Semi-Automatic, you can only modify the name, not the value. You can also access the pop-up dialog via the right mouse button when you select a dimension from the general select mode.
**General**

**Right Mouse Button Context Menu:** Horizontal, Vertical, Length/Distance, Radius, Diameter, Angle

Allows creation of any of the dimension types, depending on what edge(s) and right mouse button options are selected. When you use a single edge for Horizontal, Vertical, or Length/Distance dimensions, the dimension is actually to its endpoints.

The right mouse button changes after the first selection:

- After **Horizontal, Vertical, Length/Distance**, selected: (Horizontal, Vertical, Length/Distance, Angle, Select Pair, Cancel)
- After **Sketch** (straight) line selected: (Horizontal, Vertical, Length/Distance, Angle, Select Pair, Cancel)
- After **Radius, Diameter**, or a sketch circle or ellipse selected: (Radius, Diameter, Select Pair, Cancel)
- After **Angle**, or a sketch point selected: (Horizontal, Vertical, Length/Distance, Cancel)
**Horizontal**

**Right Mouse Button Context Menu:** Cancel

Select two points or edges to create a horizontal dimension between them, then choose a position for the dimension text. You can choose lines for the dimension, but they are not actually used. Instead, the endpoint nearest your selection is used. The selection location determines which side of a circle or ellipse (or its arc) is used. Splines are not selectable for this function, but their endpoints can be used.

*Note* — The Dimension measures only the distance in the horizontal (x-axis) direction. Any vertical distance is ignored.

**Vertical**

**Right Mouse Button Context Menu:** Cancel

Select two points or edges to create a vertical dimension between them, then choose a position for the dimension text. You can choose lines for the dimension, but they are not actually used. Instead, the endpoint nearest to your selection is used. The selection location determines which side of a circle or ellipse (or its arc) is used. Splines are not selectable for this function, but their endpoints can be used.

*Note* — The Dimension measures only the distance in the vertical (y-axis) direction. Any horizontal distance is ignored.

**Length/Distance**

**Right Mouse Button Context Menu:** Cancel

The Length/Distance dimension measures the true distance between two selected points or edges. The selection location determines which side of a circle or ellipse (or its arc) is used. Splines are not selectable for this function, but their endpoints can be used.

**Radius**

**Right Mouse Button Context Menu:** Cancel

Select a circle or ellipse, or their arcs for this tool. If you select an ellipse or elliptical arc, either its major or minor radius will be dimensioned, depending on the selection location, and whether another dimension already exists.

**Diameter**

**Right Mouse Button Context Menu:** Cancel
You can select a circle or circular arc, though this is usually used on full circles.

**Angle**

*Right Mouse Button Context Menu: Cancel, Alternate Angle*

Select two lines to create an angle dimension between them. By varying the selection order and location, you can control whether you are dimensioning the acute, obtuse, or 360° minus the acute or obtuse angle. The selection process gives you the flexibility to create any kind of angle dimension you may want. Imagine the intersection of the two lines as the center of a clock. Then the end of the lines that you select nearest will be the direction of the hands on the clock. Finally, the dimension will measure the angle counter clockwise from the first selected line to the second. You may then position the text of the dimension where you want it.

The Alternate Angle right mouse button option allows you to switch to any of the four possible angles by repeatedly selecting this option.

**Semi-Automatic**

*Right Mouse Button Context Menu: Skip, Exit, Continue*

The Semi-Automatic tool will present a series of dimensions for you to place to help fully dimension your model. For each dimension presented, you have the option of placing it where you want it, or using the right mouse button options:

- **Skip**: Delete this dimension and do not place it on the sketch. Go on to the next possible dimension.
- **Exit**: Delete this dimension and exit the tool without offering any more dimensions to place.
- **Continue**: Ignore the right mouse button and continue to allow this dimension to be dragged into position.

**Edit**

Allows you to edit the name and value of a dimension, or change its Reference dimension flag. If you set it to be a Reference dimension, you cannot change its value to change the model. Instead changes to the model will change the value of a Reference or driven dimension. Note that Reference dimensions are displayed inside parentheses.

*Note* — The dimension value can also be edited in the Section : Sketch Details.

See Section : Dimension Details.

**Move**

The Move tool allows you to reposition an existing dimension. Simply select a dimension to move, then click again to define its new location.
Animate

**Toolbox check/edit box:** Cycles
**Right Mouse Button Context Menu:** Fastest, Very Fast, Fast, Normal, Slow, Very Slow, Slowest

The Animate tool allows you to see the effect that changing a dimension through a range of values would have on the sketch. You can set a minimum and maximum scale in the **Options** dialog box to apply to the dimension. The system will run through several cycles (set in toolbox edit box) of modifying the selected dimension between its value times the minimum factor and its value times the maximum factor. The right mouse button speed selections determine how many intermediate steps are calculated and displayed, thus effecting the speed of the animation. The speed will also be effected by the complexity of the sketches in the current plane. The sketch will return to its original state when finished.

Display Name/Value

The Display Name/Value command allows you to decide whether to display dimension names, values, or both.
Constraints Toolbox

Use the Constraints toolbox to define relationships between sketch elements and reference planes.

**Fixed**

Select a 2D edge or point to prevent it from moving. For an edge, this does not fix the locations of its endpoints unless “Fix Endpoints” is checked. They can still move along the curve. Endpoints may also be selected to apply a Fixed constraint to them after which they can no longer move. When a point is selected to make it Fixed, all points coincident to it are also made Fixed.

**Horizontal**

Select a straight line. The Horizontal constraint forces a selected line to a position parallel to the X-axis. If an ellipse, or elliptical arc is selected, its major axis will be forced parallel to the X-axis.
**Vertical**

Select a straight line. The Vertical constraint forces a selected line to a position parallel to the Y-axis. If you select an ellipse, or elliptical arc, its major axis will be forced parallel to the Y-axis.

**Perpendicular**

Select two edges as close as possible to the location where they, or their extensions, would cross. The Perpendicular constraint ensures that, where the two edges cross, they (or if curves, their tangents) are at 90° to each other. Using preselect, you can select an edge and a series of other edges to be perpendicular to the first edge before selecting this function.

**Tangent**

Select two edges as close as possible to the location where they are to be tangent. The selection location controls which side of a circle the Tangent constraint applies. Also, the tangency can occur outside of the displayed portion of a curve. For example, a line can be made tangent to a circle that is far from it. Using preselect, you can select an edge and a series of other edges to be tangent to the first edge before selecting this function.

**Coincident**

Select two points, two edges, or a point and an edge as near as possible to the location you want them to be coincident. The coincident location can be outside the displayed portion of either edge. For example, you can make a point coincident with a line even though the point does not lie on the displayed line segment. Using preselect, you can select an edge and a series of other edges to be coincident to the first edge before selecting this function. The selected edges must be of the same type, or one of them must be a point. You cannot make two splines coincident.

If you have two or more points that are at, or near the same location and you want to assign them as all coincident, a good way to do it is to preselect using box selection with only points allowed for selection. Then go to **Coincident** and constraints will be created to make them all coincident.

**Midpoint**

Select a point and a line. The Midpoint constraint forces the point to be on the line an equal distance from the line endpoints. You can preselect a series of point-line pairs before selecting this function.

*Note* — If you split, trim, or extend a line that has a midpoint constraint, the constraint will be removed.

**Symmetry**
**Right Mouse Button Context Menu:** Select new symmetry axis

First select a line to be the symmetry axis, then a pair of points or edges (of the same type) to be symmetric about the axis. If you want the endpoints of the curves to also be symmetric, you need to add symmetry constraints to them as well.

You may continue to select pairs of points or edges (of the same type) to be symmetric about the axis you already have selected. Use the right mouse button option. Select new symmetry axis when you want to select a new axis. Axis and pairs of points or edges (of the same type) may also be preselected before entering the function.

**Parallel**

![Parallel symbol]

**Right Mouse Button Context Menu:** Select pairs, Select multiple, New multiple select

The default right mouse button option, Select pairs, allows you to select a pair of 2D straight edges, such as lines. The Parallel constraint forces the selected lines or major axes for ellipses and elliptical arcs to be parallel. The right mouse button option, Select multiple, allows you to select a continuing series of lines or ellipses. In the series, after you have selected two edges, a constraint is created and then the second edge you selected is used as the first edge for the next pair. This continues until you either use the right mouse button to start a new series or return to standard pairs selection. A series of these may be preselected before selecting the function and they are treated like a series selected in 'Select multiple' mode.

**Concentric**

![Concentric symbol]

**Right Mouse Button Context Menu:** Select pairs, Select multiple, New multiple select

The default right mouse button option, Select pairs, allows you to select two points, circles, circular arcs, ellipses, or elliptical arcs. The Concentric constraint will force selected points, or centers to be at the same location. For circles, circular arcs, ellipses, or elliptical arcs, they do not need to have an actual center point. The right mouse button option, Select multiple, allows you to select a continuing series of points, circles, circular arcs, ellipses, or elliptical arcs. In the series, after you have selected two edges, a constraint is created and then the second edge you selected is used as the first edge for the next pair. This continues until you either use the right mouse button to start a new series or return to standard pairs selection. A series of these may be preselected before selecting the function and they are treated like a series selected in 'Select multiple' mode.

**Equal Radius**

![Equal Radius symbol]

**Right Mouse Button Context Menu:** Select pairs, Select multiple, New multiple select

The default right mouse button option, Select pairs, allows you to select two circles or circular arcs. The Equal Radius constraint will ensure that circles or circular arcs have the same radius. Then, by placing a radius or diameter dimension on one of the arcs or circles, you can control the radius of all of them. The right mouse button option, Select multiple, allows you to select a continuing series of circles, and circular arcs. In the series, after you have selected two edges, a constraint is created and then the second edge you selected is used as the first edge for the next pair. This continues until you either use the right mouse button to start a new series or return to standard pairs selection. You can preselect a series of circles and circular arcs before selecting the function and they are treated like a series selected in 'Select multiple' mode.
Equal Length

**Right Mouse Button Context Menu:** Select pairs, Select multiple, New multiple select

The default right mouse button option, Select pairs, allows you to select a pair of lines. The Equal Length constraint ensures that the selected lines are the same in length. The right mouse button option, Select multiple, allows you to select a continuing series of lines. In the series, after you have selected two lines, a constraint is created and then the second line you selected is used as the first line for the next pair. This continues until you either use the right mouse button to start a new series or return to standard pairs selection. You can preselect a series of lines before selecting the tool and they are treated like a series selected in 'Select multiple' mode.

Equal Distance

**Right Mouse Button Context Menu:** Select 2 pairs, Select multiple, New multiple select

Use the Equal Distance constraint to select two pairs of edges. Each pair can be points, lines, or a point and a line. The two pairs do not have to be the same. Note that the constraint requires four edges (points or lines), one of which may be shared. If two lines are selected as a pair, they must be, and will be forced to be parallel if they are not already. The constraint ensures that the distance between the edges in the first pair is the same as the distance between the edges in the second pair. You can preselect a series of edges before selecting the function, and they will all become equally spaced. While in the function, you can use the right mouse button options to use the second selection “twice.” This allows you to select three edges and make them all equally spaced. While in the function, you can also use the right mouse button option, Select multiple, and then select a series of points and/or lines. Just as preselected edges, they will all become equally spaced. For example, if you select five lines—A, B, C, D, and E—three constraints are created. The first ensures that the distance A-B is the same as B-C. The next ensures B-C is the same as C-D. The last ensures that C-D is the same as D-E. The result is a series of five equally-spaced lines.

Auto Constraints

While drawing, DesignModeler will attempt to detect constraints. These constraints include point coincidence, curve tangency, horizontal and vertical lines, etc. However, in some models, this setting of automatic constraints is detrimental to the drawing process. In very complex sketches, either or both of these constraint modes can add noticeable time to the input or modification of sketches. This option allows you to control the automatic constraint detection.

**Cursor** on/off decides whether local constraint snapping is performed or not. Auto Constraint **Cursor** only looks for coincident, tangent, and perpendicular constraints between the edge you are creating and other edges that are under the cursor (or a short extension would put them under the cursor).

**Global** on/off determines the automatic constraint detection with respect to all the entities in the active plane. Auto Constraint **Global** is not processed until you actually create an edge, and then it is examined in its relation to all other edges and points in the plane.
Settings Toolbox

- Section : Grid
- Section : Major Grid Spacing
- Section : Minor-Steps per Major
- Section : Snaps per Minor

Grid

This gives access to the grid options: grid visibility, Show in 2D on/off, as well as snap behavior, Snap on/off. The grid guides you as you create your sketch. The grid is optional and you may sketch without it. The grid is not required to enable snapping.

At start-up a grid appears (depending on defaults in the Options dialog box). The grid appears fixed as a rectangular XY pattern in the current plane. Any input for 2D-edge creation using the Section : Draw Toolbox will snap to this rectangular grid if the Grid Snap option is checked. The minimum range of the grid is determined by the Minimum Axes Length setting in the Grid Defaults section of the Options dialog box. It will expand as needed if items are drawn outside the current grid area. It can also shrink back to its minimum range if items are deleted.

Major Grid Spacing

This option specifies the spacing for the grid. You can set the spacing in terms of the Major Grid Line Distance, i.e., the distance between two major grid lines.
Minor-Steps per Major

You can set the spacing for display and/or snapping in terms of the **Major Grid Line Distance**, i.e., the distance between two major grid lines. The spacing for minor grid line display and/or snapping is equal to the **Major Grid Spacing** divided by the value you set for the **Minor-Steps per Major**.

Snaps per Minor

**Grid Snaps per Minor** allows you to specify intermediate snap locations between minor grid lines (1-1000). You can use this to reduce the density of the grid display, while still snapping to a tighter grid. For example, in millimeters if the **Major Grid Spacing** is set to 10, you can set the **Minor-Steps per Major** to 5, and the **Grid Snaps per Minor** to 2. This way, minor grid lines are displayed every 2 mm, but snapping is still to every mm.

Another way to use this function is to set this to a value like 100 or 1000. This way, sketching does not appear to be snapping to a grid, but it actually is and the coordinates of your sketching are being snapped to 1/100th or 1/1000th of your minor grid line spacing. For example, if the minor grid lines are every inch and the **Grid Snaps per Minor** are set to 100, when sketching a point its coordinates will end up as numbers such as 8.36 or 5.27 instead of 8.357895846483938474 or 5.27123934933421 with no grid snapping at all.
Selection

Sketching Mode

The following is displayed when you use the right mouse button in the Sketching mode. The context menu lists Select Loops/Chains when you are selecting, not when you are drawing. This works for 2D and 3D edges. Instead of selecting a single edge, it will select the entire loop of edges or, if the edge does not belong to a loop, the entire edge chain.

The Selection Filter options include:

- Section : Selection Filter: Points
- Section : Selection Filter: Edges

Modeling Mode

The following is displayed when you use the right mouse button in the Modeling mode.
In the Modeling mode you may use two unique features:

- **Select Loops/Chains**: This works for 2D and 3D edges. Instead of selecting a single edge, it will select the entire loop of edges or, if the edge does not belong to a loop, the entire edge chain.

- **Select Smooth Chains**: This works only for 3D edges and works the same as Select Loops/Chains except that the chain is defined by edges that are tangent to each other at their endpoints (that is, no jagged intersections allowed).

The following image depicts (left to right) a loop, chain, and smooth chain.

Because the selection filter buttons on the toolbar can represent more than one type of filter, the status of the detailed filters can be checked through the right mouse button context menu. For example when you are in the modeling mode, the following image shows that both Vertex and PF Point filters are on.
The Selection Filter options include:

- Section: Selection Filter: Points
- Section: Selection Filter: Edges
- Section: Selection Filter: Faces
- Section: Selection Filter: Bodies

**Selection Toolbar**

Use the **Select** tool to perform these tasks:

- Preselect entities for sketching and modeling functions.
- Select sketch entities (curves, points, and dimensions).
- Select model vertices, edges, faces, or bodies.
- Extend the current selection.

To select multiple entities, hold the [Ctrl] key down while selecting additional entities when in the modeling mode.

**New Selection**

Use the **New Selection** button to clear the current selection, if any, and start a new selection. This also ends the current sketching state.

**Select Mode**

The Select Mode toolbar button allows you to select items designated by the Selection Filters through the Single Select or Box Select drop down menu options.
Selection

- **Single Select** (default): Click on an item to select it.
- **Box Select**: Selects all filtered items by dragging a selection box. There are two types of selections based on the dragging direction. When the dragging is from left to right, items completely enclosed in the box are selected. When the dragging is from the right to the left, items completely and partially enclosed in the box are selected. Note the difference in the hash marks along the edges of the box to help you determine which box selection type will be performed.

You can use the [Ctrl] key for multiple selections in both modes. Switching the select mode from Single Select to Box Select or vice versa does not affect the current selection.
Selection Filter: Points

The Points filter can be divided into 2D Point, Vertex, and Point Feature Point. If one or more types of point filters are on, the point filter button is latched. Use the Select Points button to turn the current point selection on/off. Use the right mouse button to select a specific point filter.

Selection Filter: Sketch Points (2D)

Use the Select Sketch Points (2D) button to turn the selection of 2D points on/off in sketching mode.

Selection Filter: Model Vertices (3D)

Use the Select Model Vertices (3D) button to turn the selection of 3D model vertices on/off.

Selection Filter: PF Points (Point Feature Points, 3D)

Use the Select PF Points button to turn the selection of 3D point feature points on/off. See the Point feature for more information about PF Points.

Selection Filter: Edges

The Edges filter can be divided into 2D Edge, 3D Edge, and Line Edge. If one or more types of edge filters are on, the edge filter button is latched. Use the Select Edges button to turn the current edge selection on/off. Use the right mouse button to select a specific edge filter.

Selection Filter: Sketch Edges (2D)

Use the Select Sketch Edges (2D) button to turn the selection of 2D edges on/off in sketching mode.

Selection Filter: Model Edges (3D)

Use the Select Model Edges (3D) button to turn the selection of 3D model edges on/off.

Selection Filter: Line Edges (3D)

Use the Select Line Edges button to turn the selection of 3D model line edges on/off.

Selection Filter: Faces
Use the Select Faces button to turn the selection of 3D model faces on/off.

**Selection Filter: Bodies**

The Bodies filter can be divided into Solid Body, Surface Body, and Line Body. If one or more types of body filters are on, the body filter button is latched. Use the Select Bodies button to turn the current body selection on/off. Use the right mouse button to select a specific body filter.

**Selection Filter: Solid Bodies (3D)**

Use the **Select Bodies** button to turn the selection of solid bodies on/off.

**Selection Filter: Line Bodies (3D)**

Use the **Select Line Bodies** button to turn the selection of 3D model line bodies on/off.

**Selection Filter: Surface Bodies (3D)**

Use the **Select Surface Bodies** button to turn the selection of 3D model surface bodies on/off.

**Extend Selection**

Use the **Extend Selection** button to access the following options:

- **Section:** Extend to Adjacent
- **Section:** Extend to Limits
- **Section:** Flood Blends
- **Section:** Flood Area

**Extend to Adjacent**

Use the **Extend to Adjacent** button to expand the selected 3D edges and 3D faces to include any adjacent edges/faces that form a “smooth” angle with the original selection set. Each click of Extend to Adjacent expands the selection by one adjacent (and smooth) edge/face. The current face selection is extended with its adjacent
faces. Here, “adjacent” means, adjacent and separated by a seam edge -- i.e., corner (non-smooth) adjacencies do not count.

Faces are considered smooth if the angle between them is less than the limit defined in the Section : Geometry DesignModeler option in the DesignModeler Options dialog box.

Before **Extend to Adjacent**, one face is selected:

![Before Extend to Adjacent](image)

After **Extend to Adjacent**, faces that are adjacent and smooth to the selected one have been added to the selection set:

![After Extend to Adjacent](image)

**Extend to Limits**

Use the **Extend to Limits** button to gain the same result as clicking the **Extend to Limits** button multiple times, until the selection can no longer grow.

After **Extend to Limits**, the selection set is expanded until all tangent faces have been added:

![After Extend to Limits](image)

**Flood Blends**

![Flood Blends](image)
Use the **Flood Blends** button to expand your currently selected blend faces to include all of its adjacent blend faces.

*Note* — This is not a fool proof method. For some cases, variable-blend faces cannot be identified. “**Flood Chamfer**” is not supported.

Before **Flood Blends**, these six blend faces are selected:

After **Flood Blends**, the selection set has expanded to include all the blend faces:

**Flood Area**

Use the **Flood Area** button to expand the face selection to include all faces within the area contained by the selected edges.

Given a seed face selection and a selection of boundary edges (the current face selection is interpreted as the seed selection; the current edge selection is interpreted as the “boundary” selection), **Flood Area** extends the face selection by flooding the bounded area. Multiple, disconnected seed and respective boundary conditions are supported. The face flood covers the case of flooding multiple (disconnected) areas. Then each such area would be defined by one seed face and its respective boundary. If the selection of the boundary edges is incomplete or not closed, then the flood will extend to the whole of the respective body.

Before **Flood Area**, two regions have been bounded by edges, with one face selected in each region:
After Flood Area, the two regions are flooded up to the bounding edges:

**Graphical Selection**

**Tips for working with graphics**

- You can rotate the view while selecting geometry by dragging your middle mouse button.
- You can zoom in or out by holding the Shift key and dragging with the middle mouse button.
- You can pan the view by using the arrow keys or holding the [Ctrl] key and dragging with the middle mouse button.
- Click the interactive triad to quickly change the Model View window.
- You can zoom in or out by scrolling the mouse wheel.
- To rotate about a specific point in the model, switch to Rotate mode and click the model to select a rotation point.
- To roll the model, click the Rotate button, then hold down the left mouse button outside of the model as shown.
- To select more than one surface, hold the [Ctrl] key and click the surfaces you wish to select.
- You may customize the mouse operations in the Section : Workbench Options.

**Highlighting**

Highlighting provides visual feedback about the current pointer behavior (e.g. select surfaces) and location of the pointer (e.g. over a particular surface). The surface edges are highlighted in colored dots.

**Picking**

A pick means a click on visible geometry. A pick becomes the current selection, replacing previous selections. A pick in empty space clears the current selection in the modeling mode.
By holding the [Ctrl] key down, you can add unselected items to the selection and selected items can be removed from the selection.

**Painting**

Painting means dragging the mouse on visible geometry to select more than one entity. A pick is a trivial case of painting. By holding the [Ctrl] key down, painting will append all appropriate geometry touched by the pointer to the current selection.

**Depth Picking**

Depth Picking allows you to pick obscured entities through the Z-order. Whenever more than one entity lies under the pointer, the graphics window displays a stack of rectangles in the lower left corner. The rectangles are stacked in appearance, with the topmost rectangle representing the visible (selected) geometry and subsequent rectangles representing geometry hit by a ray normal to the screen passing through the pointer, front to back. The stack of rectangles is an alternative graphical display for the selectable geometry.

Highlighting and picking behaviors are identical and synchronized for geometry and its associated rectangle. Moving the pointer over a rectangle highlights both the rectangle and its geometry. [Ctrl] key and painting behaviors are also identical for the stack. Holding the [Ctrl] key while clicking rectangles picks or unpicks associated geometry, while preserving the rest of the current selection. Dragging the mouse (painting) along the rectangles picks geometry front-to-back or back-to-front.
Planes and Sketches

- Active Plane/Sketch Toolbar
- Terminology
- Reference Geometry
- Plane Properties
- Tangent Plane
- Plane Preview
- From-Face Plane, Planar vs. Curved-Surfaces Faces Behavior
- Offset Before Rotate Property
- Apply/Cancel in Plane
- Active Sketch Drop Down
- New Sketch

Active Plane/Sketch Toolbar

Use the Active Plane/Sketch Toolbar to create a new plane or a new sketch. You can also use it to switch the active plane or active sketch while in the sketching mode. (While in the modeling mode, this is usually done via selection in the Feature Tree.)

Note — A very useful shortcut exists that allows you to create a new plane and new sketch in a single operation. To do this, while in the modeling mode, select a face. By selecting the sketching tab, the plane and sketch will be created automatically.

Active Plane Drop Down

Use the Active Plane Drop Down to select the plane in which you want to work. This lists all the planes present in the model. You can select a plane to make it the active plane. XYPlane is the default.

New Plane

Use the New Plane tool to create a new plane. Click on Type in the Details View to display the drop down menu that lists the six different types of plane construction:

- From Plane: new plane is based on another existing plane.
- From Face: new plane is based on a face.
From Point and Edge: new plane is defined by a point and a 2D line or 3D edge. The plane goes through the point and the two ends of the selected edge. These three locations cannot be collinear.

From Point and Normal: new plane is defined by a point and a normal direction. Alternatively, there is the option to create a parameterized and persistent tangent plane, via a Point Feature (construction) point and the base face normal.

From Three Points: new plane is defined by three points.

Note — Three-point planes defined in Release 8.0 and forward place the plane origin at the first point, and the X-Axis by default is in the direction from the first point to the second point. When you edit three-point planes created prior to Release 8.0, they still function as they always did.

From Coordinates: new plane is defined by typing in the coordinates of the origin and normal. You can also select a point to use its coordinates for the origin. If you select a point, its coordinates are used as the initial origin coordinates. If the point later moves, or you change any of the coordinates, then the point and plane origin will not be at the same location. Also, if you have “Driven” a coordinate by promoting it to a Design Parameter, then that coordinate will not be changed by the selected point. If you have all three coordinates “Driven” then the option to select a point will not be displayed.

Terminology

In DesignModeler, the plane terminology considers a “plane” to be a 2D object (X- and Y-Axis) with an orientation (determined by the plane normal vector). In contrast, Simulation uses a coordinate system terminology. There, the “normal” is referred to as the Z-Axis.

Reference Geometry

Several features in DesignModeler, including Plane, accept point and direction reference inputs.

Point Reference

Generally speaking, DesignModeler accepts three forms of “point” input:

- 2D (Sketch) Points
- 3D (Model) Vertices
- Point Feature Points (Construction Points, Point Loads, Spot Welds)

Direction Reference

Normal direction, X-Axis line, and Reference edge for Rotation can be defined by selecting a face (its normal is used), a 2D line, a 3D edge, two points, or three points. The direction reference for the Plane feature and other DesignModeler features accepts the following “directional” input:

- Plane (its normal is used)
- 3D (Model) Face (its normal is used)
- 2D (Sketch) Line
- 3D (Model) edge
- two points (any of the above “point” input is accepted)
- three points (the normal of plane spanning the three points is used)
Plane Properties

When constructing a plane, some plane types allow you to use the Details View to add an offset to the plane. Also, some types allow you to use the Details View to reverse the plane normal direction. When adding from another plane or a planar face, you can specify a rotation axis and angle. In this case, rotation takes precedence to offset.

Overall, there are eight plane properties:

1. **Subtype**: This property is only available if the plane type is From-Face. Then if the selected face is, at creation time, a planar face, the options for the Subtype are either:
   - **Outline**: The plane’s origin is placed at one of the selected face’s vertices. This option is only available for planar faces.
   - **Tangent Plane**: The plane's origin is placed at the location where you clicked. This is the only option allowed for curved faces.

2. **X-Axis Line**: This allows you to select a direction (see above) with which you want the plane’s X-Axis to be aligned. If not specified, the system will align the plane’s axes with the axes of the global coordinate system. Applies to Release 7.1 and earlier.

3. **Z-Axis Rotation**: This allows you to specify the degrees in which the X-axis can be rotated around the normal vector. 0° means no rotation; take X-axis as is. Applies to Release 7.1 and earlier.

4. **Offset Before Rotate**: This property is only available for From-Plane planes, if the rotation axis is selected, and the rotation axis lies in the base plane. By default Offset Before Rotate is set to No, which means that the rotation (around the selected rotation axis) is applied before the offset. On the other hand, if the property is set to “yes.”, then the offset is applied first. Applies to Release 7.1 and earlier.

5. **Reverse Normal/Z-Axis**: Reverses/flips/inverts the plane normal (or Z-Axis; Blue triad arrow).

6. **Flip XY-Axis**: Reverses/flips/inverts both the X- and Y-axis of the plane.

7. **Use Arc Centers for Origin**: This property is only available for From Face planes. If “yes.”, then when a planar face is selected and an arc or elliptical arc edge is nearest to the selection, then the center of the circle/ellipse will be used for the origin. When this is set to No, then arc and elliptical arc edges are treated just like other edges and the nearest end point is used for the origin. The default is “yes.” for all new Plane features and No for planes created prior to Release 8.1.

8. **Export Coordinate System**: Exports the plane as a coordinate system into Simulation. The default is No.

   *Note* — ANSYS Workbench Products 7.1 is only processing exported coordinate systems at the time of the initial attach of the active CAD model. This means, in particular, the Updates are not supported for exported coordinate systems.

Plane Transforms

Planes defined prior to Release 8.0 will maintain their current definition form, and editing them will remain as it was in the past. For Release 8.0, definitions of Planes have been made more general and much more flexible. While each plane type has its own set of required information, the transform logic and prompts are now identical for all plane types. Now after the detail information for the specific plane type, the following lines are always displayed:

- **Transform 1 (RMB)**: None
Reverse Normal/Z-Axis? No
Flip XY-Axes? No
Export Coordinate System? No

After the Transform 1 line, a 'Transform 1 Axis' appears for transform types that require an axis selection. Also, an 'FD1, Value 1' line will appear for any transform that requires a value. Likewise for additional transforms if they are used.

Clicking on the down arrow in the right column of Transform 1 generates a drop down menu of choices for the type of transform you want. Clicking on Transform 1 in the left column, produces the same categorized list.

A detailed explanation of each choice follows:

- **None:** No change
- **Reverse Normal/Z-Axis:** Reverses the Normal/Z-Axis, as well as the X-Axis
- **Flip XY-Axes:** Reverse the X-Axis and Y-Axis
- **Offset X:** Offsets the plane's origin in its X direction by the amount in its matching "value."
- **Offset Y:** Offsets the plane's origin in its Y direction by the amount in its matching "value."
- **Offset Z:** Offsets the plane's origin in its Z direction by the amount in its matching "value."
- **Rotate about X:** Rotates the plane about its X-Axis by the degrees in its matching "value."
- **Rotate about Y:** Rotates the plane about its Y-Axis by the degrees in its matching "value."
- **Rotate about Z:** Rotates the plane about its Z-Axis by the degrees in its matching "value."
- **Rotate about Edge:** For this option, an additional line appears, "Transform n Axis," where "n" is the current transform number, and allows selection of an Edge. The plane is then rotated about this Edge by the degrees in its matching "value."
- **Align X-Axis with Base:** Certain plane types inherit a base direction from what is used in their definition. This is true for Plane From Plane, Plane from Planar Face, and Three Point Plane. This option will attempt to align the X-Axis with the base data. Note, that by default the X-Axis is aligned with this data prior to any transforms. For all other plane types, this option acts the same as 'Align X-Axis with Global'.
- **Align X-Axis with Global:** Aligns the X-Axis of the plane with the Global X-Axis, unless it is normal to it.
- **Align X-Axis with Edge:** For this option, an additional line appears, 'Transform n Axis', where 'n' is the current transform number, and allows selection of an Edge. The X-Axis is then aligned with this Edge.
- **Offset Global X**: Offsets the plane’s origin in the global X direction by the amount in its matching “value.”
- **Offset Global Y**: Offsets the plane’s origin in the global Y direction by the amount in its matching “value.”
- **Offset Global Z**: Offsets the plane’s origin in the global Z direction by the amount in its matching “value.”
- **Rotate about Global X**: Rotates the plane about the global X-Axis by the degrees in its matching “value.”
- **Rotate about Global Y**: Rotates the plane about the global Y-Axis by the degrees in its matching “value.”
- **Rotate about Global Z**: Rotates the plane about the global Z-Axis by the degrees in its matching “value.”
- **Move Transform Up**: This exchanges the position of this transform and the one previous to it in the list and thereby the order of processing it. If this is the first transform in the list, it becomes the last. Note that this changes the ‘FDn’ parameters that refer to the transforms that change position in the list. If there is only one transform, this does nothing.
- **Move Transform Down**: This exchanges the position of this transform and the one after it in the list and thereby the order of processing it. If this is the last transform in the list, it becomes the first. Note that this changes the ‘FDn’ parameters that refer to the transforms that change position in the list. If there is only one transform, this does nothing.
- **Remove Transform**: This deletes the current transform, and those following it are moved down one. Note that this changes the ‘FDn’ parameters that refer to the transforms that change position in the list.

The ‘FD1, Value 1’ is the value that is associated with this transform, if needed, giving you the ability to place and orient the new plane just the way you want. In addition to the up to 9 user-specified transforms, which are processed in the order you specify, you can also specify a final ‘Reverse Normal/Z-Axis’, which is the same as a 180° rotation about the plane’s Y-Axis, and a ‘Flip XY-Axes’, which is the same as a 180° rotation about the plane’s Z-Axis.

*Note* — For plane types (Align X-axis with Base) that do not have an X-axis direction inherited from their base data, an **Align X-Axis with Global** is automatically performed before any of the specified transforms.
An alternative way to assign the transform type is through the right mouse button context menu. Right click on **Transform 1 (RMB)** to bring up the menu, where you can choose the transform list manually. The right mouse button context menu is available for all 9 of the user-defined plane transforms.

**Tangent Plane**

If you create a From-Face plane from a curved-surface face, then the preview will give you the “tangent plane” with regards to the point selected—the subtype will conveniently default to *Tangent Plane*. This plane is specially marked as “dead” and will never be regenerated after creation. This is AGP Release 6.1 behavior and is maintained in DesignModeler Release 8.1 for backward compatibility. However, the correct way to create a tangent plane at a given point is to:

1. Place a controlled/persistent/parameterized Construction Point onto the face, via the Point Feature; and
2. Use this point feature points (PF points) for the tangent plane creation with the From-Point-and-Normal plane type.

**Plane Preview**

The plane preview shows all three axes. When creating a new plane, you will see the X (red), Y (green), and Z (blue) direction arrows for the new plane.
When creating a From-Face plane, there are two cases:

- curved-surface base face (like the above picture)
- and planar base face (i.e. a flat surface—see below).

For a curved-surface base face, the plane's subtype is set to *Tangent Plane* and remains as such (no other option for curved-surface base faces). In this case, the origin is determined by the location where you click on the face. Once generated, such created tangent planes remain fixed - i.e., they are “dead” and will not be regenerated.

For planar base faces, you also have the option to set the subtype to *Tangent Plane*. However, since it is probably more useful, it will default to *Outline*. In this case the origin is determined like this:

- DesignModeler finds the edge on the face closest to where you clicked.
- From that edge, DesignModeler chooses the vertex closest to where you clicked. If the face contains only a ring edge (such as a circle, ellipse, or spline), then it places the origin at the center.
For the case where the origin is placed at a vertex, the X-Axis (red arrow) is aligned such that it is tangent to the closest edge. For ring edges, the X-Axis is determined by the type of ring. For example, the ellipse above aligned the X-Axis with its major axis.

Also for planar faces (whether ring or not), you have the option to reverse the direction of the axes.

**Rotation Axis Rules**

When you are rotating about an edge, Fleming’s Rule (right-hand rule) dictates which direction the plane should rotate. Positive rotations are counterclockwise. As example, open your right hand and stick out your thumb. Your thumb represents the rotation axis from start to end. Curl your fingers around the axis to illustrate the direction that the plane will rotate. The curl direction is a positive rotation.

**From-Face Plane, Planar vs. Curved-Surfaces Faces Behavior**

**From-Face Plane, planar (6.1 Behavior)**

In AGP 6.1 you may have noticed that From-Face Planes behave differently whether the Base Object is a planar or curved-surface face.

- If the base face is **planar**, the plane loses its axes and becomes a “face-boundary Outline plane,” where face-boundary edges will be inserted as fixed lines into the plane object. In this case it is far more useful to have access to the boundary edges of the base face (for sketching constraints and dimensioning) than to the axes.

  *Note* — These planes and their boundary regenerate/refresh properly after the model changes.

- If the face is **curved-surface**, then the plane is treated as a “*(dead)* Tangent Plane,” with axes, and the origin fixed as it was given at plane creation time.

  *Note* — These planes do *not* regenerate; rather, they are frozen “dead” in the state of creation (or their last regeneration with a planar base face - observe that it is possible, but probably atypical, that faces change from planar to curved-surface, or vice versa, during model regeneration).
Curved-Surface Faces (Current Behavior)

If the plane has been created with AGP 6.1 (i.e., it has been read from a 6.1 agdb), then the behavior is as in the above for backward compatibility.

Otherwise:

- If the plane has been created with a curved-surface base face, then the plane defaults to and remains as a “(dead) Tangent Plane” for the life of the feature, independently of whether the base face changes geometry or not (this is in contrast to 6.1 behavior). Refer to the subtype property which, in this case, becomes read-only.

- If the plane has been created with a planar base face, and with the Subtype property specifically set to that of "(dead) Tangent Plane" then, as above, the plane will remain so for the life of the feature.

- If the plane has been created with a planar base face, and with subtype Outline (which happens to be the default in this case), then the plane will be created as a face-boundary (instead of axes) and the origin snapped to the closest vertex. The plane subtype will remain “Outline” for the life of the feature—however, it will properly regenerate whenever the face outline changes.

- If the plane has been created with a planar base face, but there is no vertex suitable for snapping (in case of a ring edge), then the plane will be created as with a face boundary, and the origin will be set at the center of the face.

In addition:

- If a plane cannot be regenerated, because it has been created as a “face-boundary outline plane” and the base face somehow changed from planar to curved-surface (unlikely, but possible), then the plane will not regenerate (i.e., fall back to the last successful generation, the appropriate boundary edges) and a warning will be issued (yellow check mark).

Offset Before Rotate Property

This property is only available for “From Plane” planes, if the rotation axis is selected, and the rotation axis lies in the base plane. By default, Offset Before Rotate is set to No, which means that the rotation (around the selected rotation axis) is applied before the offset. On the other hand, if the property is set to “yes.”, then the offset is applied first. This property appears only for planes created with DesignModeler Release 7.1 or earlier.

The following property shows an example plane with Offset Before Rotate = No.

And now the same with Offset Before Rotate = Yes.
Apply/Cancel in Plane

Because of the many options available in Plane, changes to properties that require selections are immediately shown in the preview of the plane. Until you hit Apply for a property, or Generate for the plane itself, you have the option of using Cancel in that property to backup to the previous selection (if any). Once you hit Generate, all current selections are considered “applied.”

Active Sketch Drop Down

Use the Active Sketch Drop Down to select in which sketch of the active plane you want to work.

New Sketch

Click the New Sketch icon to create a new empty sketch in the active plane.

To attach a new sketch to a plane, select the plane that the sketch is to be attached to, and then click on the New Sketch icon in the Section : Active Plane/Sketch Toolbar.

Note — New sketches cannot be added to planes that are suppressed or in error.
3D Modeling

- Section : Bodies and Parts
- Section : Boolean Operations
- Section : Profiles
- Section : Edit Selections for Features and Apply/Cancel
- Section : 3D Features
- Section : Primitives
- Section : Advanced Features and Tools
- Section : Concept Menu

Bodies and Parts

The last branch of the Tree Outline contains the bodies and parts of the model. A body is a single component in the model, either a solid, surface, or line body. A part is a collection of bodies grouped together. In the Details View for each body or part are statistics:

<table>
<thead>
<tr>
<th>Details of Part</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part</td>
</tr>
<tr>
<td>Volume</td>
</tr>
<tr>
<td>Surface Area</td>
</tr>
<tr>
<td>Bodies</td>
</tr>
<tr>
<td>Faces</td>
</tr>
<tr>
<td>Edges</td>
</tr>
<tr>
<td>Vertices</td>
</tr>
</tbody>
</table>

The statistics list the number of entities contained in the body or part as well as the volume and surface area of the body. For parts, the sums of the volumes and surface areas of bodies contained within the part are displayed. Volumes and surface areas are measured automatically up to the limit specified by the Measure Selection Limit setting in the Options Dialog. If you see three dots “...” instead of a numerical value, that means the geometry is too complex to be automatically measured. You may use the Measure Selection context menu option to force the volume and surface area calculation at any time. In some rare cases, DesignModeler may not be able to complete the measurement. When this occurs, the volume and surface area of the entity will be reported as “Unknown.”

For more information on bodies and parts, please visit these sections:

- Section : Bodies
- Section : Parts

Bodies

- Section : Body States
- Section : Body Types
Body States

There are two states for bodies in DesignModeler:

- **Active**: The body can be modified by normal modeling operations. Active bodies cannot be sliced. To move all active bodies to the **Frozen** state, use the Section : Freeze feature. Active bodies are displayed in blue in the **Tree Outline**. The body's icon in the **Tree Outline** is dependent on its type: solid, surface, or line.

- **Frozen**: The body is immune to all modeling operations except slicing. To move a body from the **Frozen** state to the **Active** state, select the body and use the Section : Unfreeze feature. Frozen bodies are displayed in white in the **Tree Outline**. The body's icon in the **Tree Outline** is dependent on its type: solid, surface, or line.

Body Types

There are five types of bodies that DesignModeler supports:

- **Solid**: The body has both a surface area and volume.

- **Surface**: The body has a surface area, but no volume.

- **Line**: The body, consisting entirely of edges, does not have a surface area or volume.

Line body edges are shown in one of three colors. On the graphics screen, line body edges are shown in violet for line bodies that have no Section : Cross Section assigned to them. Line bodies that have cross sections draw their edges as either red or black. Red means the edge has an invalid cross section alignment, whereas black denotes a valid cross section alignment. If line bodies are drawn in Section : Show Cross Section Solids mode, then all black edges are instead drawn as solids using their cross section attributes.

- **Planar**: A special case of surface body is the 2D planar body. A 2D planar body is defined as a flat surface body that lies entirely in the XYPlane. These bodies are available to use for 2D analysis, meaning they will be sent to Simulation when you have chosen 2D analysis from the simulation options in the Project Page. In DesignModeler, the only difference between 2D planar bodies and other surface bodies is the icon that appears in the **Tree Outline**. A 2D planar body behaves in exactly the same way as any other surface body regarding feature operations and selection.

The easiest way to create planar bodies in DesignModeler is to create sketches on the XYPlane, then use the Section : Surfaces From Sketches feature to create the surface bodies. Since they are flat and they lie in the XYPlane, they will be identified as planar bodies.

- **Winding**: The body, consisting entirely of edges, does not have a surface area or volume.

Winding bodies are special forms of Line bodies that are intended to model coils of wire. In fact, a normal Line body can be converted to a Winding body or back if desired. The other way Winding bodies can be created is via the Section : Winding Tool. Winding bodies created by the Section : Winding Tool, cannot be converted to normal Line bodies. Instead of having a standard Cross Section assigned to them, Winding
bodies currently only allow a rectangular cross section, and its values are determined by the Winding Table for Winding bodies from the Section : Winding Tool.

In order to create a valid Winding body from a Line body, it must be based on only line and arc edges and form a closed loop. If the Alignment direction is not consistent when it is converted, the conversion process will reverse alignments on edges as necessary to assure a consistent orientation. You may right click on a converted Winding body in the tree and reverse the alignments of all edges in that converted Winding body.

For Winding bodies that are converted from Line bodies, any previous cross section assignments to them are cleared, and you can manually enter length and width values for the cross section. These converted Winding bodies still allow you to control the alignment whereas those created by the Section : Winding Tool do not. Likewise you can modify the Number of Turns property for a converted Winding body. Turns comes from the Winding Table for those created by the Section : Winding Tool.

When Winding bodies are passed to Simulation and the ANSYS environment, a special element type (SOURC36) is used to mesh winding body edges with a single element. Converting Line Bodies that contain edge types other than Line or Arc/Circle to Winding bodies will cause errors in Simulation, and therefore should be avoided.

**Body Status**

The status of a body is indicated by the small check mark or x next to the body icon in the Tree Outline. The status of a body can be one of the following types:

- **Visible:** The body is visible on screen. It is denoted by a green check mark.

- **Hidden:** The body is not visible on screen. It is denoted by a light green check mark.

- **Suppressed:** Suppressed bodies do not get sent to Simulation for analysis, nor are they included in the model when exporting to a format other than AGDB. In the Tree Outline, a blue x is shown next to suppressed bodies. Unlike the behavior in Simulation, suppressed bodies are included in the statistics of its owning part and/or overall model statistics. **Hint:** To suppress bodies when attaching to a plug-in, it is best to leave all bodies unsuppressed in the CAD program, then suppress them in DesignModeler.

  *Note* — Suppressing bodies in such a way that it results in adding or deleting parts to or from DesignModeler, while the model is attached as an active CAD model in Simulation, may result in lost associativities on the part level.

- **Warning:** This alerts you when a line body either has no cross section assigned, or contains edges that have not been aligned.

  *Note* — This will not be displayed if the cross section type is Section : Circular or Section : Circular Tube, where default alignment is considered acceptable.

- **Error:** This error appears when a line body contains edges that have invalid alignment. This means that a cross section cannot be oriented on an edge because the edge’s alignment vector is parallel to the edge’s direction. See Section : Cross Section Alignment for more information about line edge alignment.

- **Error:** This error can occur for a number of reasons as shown below.
1. Invalid alignment (as above for Line Body).

2. Winding body contains edges other than Line or Arc/Circle. If this body gets transferred to Simulation, it cannot be properly meshed.

3. The body’s edge directions are invalid. Because the edge directions define the current flow, the directions must be consistent throughout the winding body. You can see edge alignments using View: Show Cross Section Alignments. You can select the edges (Selection Filter: Line Edge) and choose Reverse Orientation to reverse the direction on an edge.

4. Three or more edges meet at one vertex. The winding body must form a simple loop, so each vertex must connect to exactly two edges.

5. Winding body is not a closed path.

*Note* — Similar to features, when a warning or error is indicated on a body, you can now right click on it in the Tree Outline and choose Show Errors to get more information. Also, bodies showing an error icon will NOT be transferred to Simulation.

**Additional Properties**

From the CAD program Unigraphics, you can attach surface thicknesses using either the Section : Attach to Active CAD Geometry or Section : Import External Geometry File features. Material property transfer is supported for Autodesk Inventor, Pro/ENGINEER, and Unigraphics.

**Thickness:** This value is entered as the thickness of the body in Simulation. The property only appears for surface bodies.

**Material:** This read-only property appears for bodies that have a material attribute assigned to them. Material properties can only be created by utilizing the Section : Attach to Active CAD Geometry or Section : Import External Geometry File features.

Body thickness and material may propagate as a result of boolean operations. For example, suppose a surface body has both a thickness and material defined. If that body is cut into two or more pieces, then each piece will also possess the same thickness and material.

**Body Naming**

Names of bodies imported or attached to DesignModeler using the Section : Import External Geometry File and Section : Attach to Active CAD Geometry features can be renamed. After renaming a body you must refresh for the name to be kept. Otherwise the body name supplied by the CAD source will appear.

By default, body names are assigned from the CAD source if one is provided. The body name will also be refreshed if the CAD source is refreshed. However, once you manually modify a body’s name, that name will remain regardless of whether the body originated from another CAD system.

Winding Bodies that are created by a Section : Winding Tool are automatically named using the Phase name and coil number (from the Winding Table), e.g. "A.1" for Phase "A", coil number 1. Again, this is just a default name and if you change it, then your name will remain.

**Parts**

- Section : Form New Part
- Section : Explode Part
- Section : Part Status
Form New Part

You can group bodies into parts using the Section : Form New Part tool. These parts will be transferred to Simulation as parts consisting of multiple bodies, with shared topology. By default, DesignModeler places each body into one part by itself. To form a new part, select one or more bodies from the graphics screen and use the right mouse button option Section : Form New Part. The Section : Form New Part option is available only when bodies are selected and you are not in a feature creation or feature edit state. Parts can also be created by selecting one or more bodies from the Tree Outline and clicking Form New Part in the Tools menu.

Explode Part

Parts can be deconstructed. Select a part in the Tree Outline, then use the right mouse button option Explode Part to break the part into individual bodies. See Section : Explode Part in the Section : Context Menus section of the Menus chapter.

Part Status

The status of a part is indicated by one of the following three types:

- **Visible**: Some bodies in the part are visible on screen. It is denoted by a green check mark.
- **Hidden**: All bodies in the part are hidden. It is denoted by a light green check mark.
- **Suppressed**: All bodies in the part are suppressed. It is denoted by a blue x.

Boolean Operations

- Section : Material Types
- Section : Model Size Box
- Section : Manifold Geometry

Material Types

Typically, the generation of a 3D feature (e.g. Extrude or Sweep, Section : Sweep) consists of two steps:

(a) Generate the feature bodies, and
(b) Merge the feature bodies with the model via Boolean operations.

You can apply five different Boolean operations to the 3D features:

- **Add Material**: Use to create material and merge it with the active bodies. It is always available.
- **Cut Material**: Use to remove material from the active bodies. It is available whenever active bodies are present.
• **Slice Material**: Use to slice frozen bodies into pieces. It is available only when ALL bodies in the model are frozen.

• **Imprint Faces**: Similar to Slice, except that only the faces of the bodies are split, and edges are imprinted if necessary, but no new bodies are created. Its availability is the same as Cut in that it operates on active bodies.

• **Add Frozen**: Similar to Add Material, except that the feature bodies are not merged with the existing model but rather added as frozen bodies. This allows you, for example, to automatically import a model as an assembly of frozen bodies, without the need to manually apply the Freeze feature.

*Note* — Line bodies are immune to Cut, Imprint, and Slice operations.

## Model Size Box

DesignModeler’s geometry engine has a one cubic kilometer size box limit, centered about the world origin. This means that all geometry must be reside within 500 meters of the world origin, regardless of the units setting. Any geometry created that extends beyond this size box may generate an error.

## Manifold Geometry

All solid and surface geometry created in DesignModeler must be manifold. This means that for solid bodies, each edge connects to exactly two faces.

For surface bodies, each interior edge connects to two faces, and each boundary edge connects to exactly one face. Most often, non-manifold solids can occur during Section : Enclosure operations, where bodies touch at an edge or vertex.

For surface bodies, any type of 'T' intersection is considered non-manifold and is not permitted in Boolean operations. Bodies that are oriented in this manner should be kept separate by leaving one or both bodies frozen. If you wish to share topology between bodies that form a 'T' intersection, consider using the Section : Joint feature.

Line bodies do not have any such restrictions.

Below are some examples of valid (manifold) and invalid (non-manifold) geometry:
Example 1

This solid is invalid because the top edge connects to four faces instead of two.

When split into two bodies, this geometry becomes manifold.

Example 2

This surface body is invalid because it contains a "T" intersection. The middle edge is connected to three faces.

When kept separate, two bodies remain manifold.
Profiles

Important

The 3D features that create bodies support the following base objects:

- **Sketches:** In the more common case of sketches as base objects.
- **From-Face Planes:** In the case of From-Face planes as base objects, the feature interprets the (face) boundary edges of such planes as quasi “sketches” and uses the boundary loops for feature creation.
- **Named Selections:** Faces, Surface Bodies (their faces are used), 3D Edges, Line Bodies (their edges are used), and for Skin/Loft, an individual Point (Vertex or point feature points—PF points) stored in Named Selections can be used as the Base Object, Profile, or Path.

Sketches, faces, and Named Selections consist of one or more profiles. Each profile is a chain of non-intersecting sketch edges that are used in the four basic modeling features:

- **Section : Extrude**
- **Section : Revolve**
- **Section : Sweep**
- **Section : Skin/Loft**

Profiles are either open or closed. A closed profile is one in which the edges in the chain form a loop. An open profile is a sketch chain that is open at both ends. If a profile intersects itself, then it is invalid. Below, from left to right, are three examples of profiles: a closed profile, an open profile, and an invalid self-intersecting profile.

By default, closed profiles take precedence over open profiles. If a sketch contains both closed and open profiles, then the closed profiles will be used and the open profiles will be ignored. In this example, one closed profile takes precedence over the other open profiles in this Revolve feature.
The As Thin/Surface property allows you to define a thickness to create thin solids or set it to zero to create surfaces. When using open profiles, As Thin/Surface must be set to Yes, otherwise a warning will be issued. In this example, two open profiles are extruded to create two surface bodies.

Both open and closed profiles are not allowed to intersect each other except when As Thin/Surface is set to Yes. Additionally, when using intersecting profiles, the thickness must be non-zero. The following two examples show the cases when profiles are permitted to intersect each other.

For the Revolve feature, if the base sketch contains only open profiles and one of its edges is used as the axis of revolution, then the profile to which the edge belongs will be ignored (it is already used as an “axis”). An example is shown below, where the middle profile contains an edge chosen as the rotation axis.
Edit Selections for Features and Apply/Cancel

A feature’s definition consists of:

- Feature Dimensions (e.g., the depth of an Extrude Feature)
- Feature Options (e.g., the operation or type of an Extrude Feature)
- Feature Selections (i.e., selections referencing entities of the construction history, 2D sketches, or 3D model - e.g., the base object, sketch or plane, of an Extrude feature, the rotation axis, 2D or 3D edge, of a Revolve feature, but also, say, the edges and faces to be blended in the Fixed-Radius Blend feature)

You can change certain Feature Selections where applicable. This functionality is provided by the means of the Apply/Cancel buttons in the Details View. By default, Feature Selections are read-only; however, editing Feature Selections is possible under two circumstances:

1. At feature creation (before initial generation)
2. Choosing Edit Selections from the right mouse button context menu for the appropriate feature will effectively roll the model back to its state prior to the feature being generated, enabling you to edit the Feature Selections.

Once editing of Feature Selections is enabled, you can “activate” the Apply/Cancel buttons by either double-clicking the corresponding property names (left column of Details View) or by single-clicking the corresponding property value fields (right column).

The Plane feature and the Revolve feature use a rotation axis selection. By selecting the axis row in the Details View, you can define the rotation axis, which must be a straight 2D or 3D edge. For the Revolve feature, you can also preselect the axis line before clicking the Revolve button.

The Section : Sweep feature takes a profile sketch, the sweep profile, and sweeps it along a path sketch, the sweep path. You define the sweep profile by selecting the Sweep Profile row in the Details View and then selecting the desired sketch or plane in the Tree Outline, and finally clicking Apply to lock in your selection. Similarly, you define the sweep path by selecting the Sweep Path row in the Details View and then selecting the desired sketch or plane in the Tree Outline, and again click Apply to lock in your selection.

In the Section : Body Operation feature, the planes are chosen by following the status bar instructions or by highlighting the source or destination plane property, then choosing a plane from the Tree Outline and clicking Apply.

Feature Selections Behavior

- Pre-select (Note: this applies for feature creation only!)
Select geometry
Click feature button
RESULT: Selection is loaded into the object

- **Post-select** (Note: this is the most typical usage!)
  
  Click feature button (at feature creation) or use the **Edit Selections** right mouse button option
  Bring up the Apply/Cancel buttons for the desired property
  Select geometry
  Click Apply/Cancel
  RESULT: Selection is loaded into the object (in case of Apply)

**Example**

Illustrated here is an example of using post-select to create a fixed-radius blend. Use the **Blend** drop down menu from the toolbar, and select **Fixed-Radius** Blend.

Specify the blend radius as desired, and start edge selection by double-clicking the Geometry property, thus bringing up the Apply/Cancel buttons, and perform your edge selection:
Click Apply, to accept your selection, and then Section : Generate to create the **Blend** feature. Now, assume more modeling has been done, and after some other features have been created, you want to go back and edit the above edge selection. Use the right mouse button context menu over the **Blend** feature:

...and select the **Edit Selections** option. This will “roll back” the model to the state before the **Blend** feature.

Upon selecting the **Edit Selections** option, the model will roll back to the state it was in when the feature was created. During selection editing, features that are inactive are shown in gray. If a feature was suppressed when **Edit Selections** is selected, the feature and any of its parent features will become unsuppressed.

At this point, you may edit, say, the **Blend** feature’s edge selection by double-clicking the Geometry property, thus, again, bringing up the Apply/Cancel buttons, and perform your edge selection:

The current geometry selection of the feature is selected on screen. Now, say, add another edge to the selection by holding down the [Ctrl] key:
Click Apply to accept your changes, and click Section : Generate to update the model.

The Edit Selections option is available for all features except Freeze. Additionally, Edit Selections may not be performed on any of the three absolute planes, nor is it allowed during feature creation.

### 3D Features

Use the 3D Features Toolbar to create a model and to make changes to it. The 3D features are also accessible via the Section : Create Menu. Next to each features icon in the Tree Outline is a graphic showing the state of the feature. There are five states a feature can have:

- 🟢 Feature succeeded. Denoted by a green check mark.
- 🌟 Feature has been updated since the last generate. Denoted by a yellow lightning bolt.
- 🟡 Feature has generated, but some warnings exist. Denoted by a yellow check mark.
- 🔴 Feature failed to generate. Denoted by a red exclamation symbol.
- ✗ Feature is suppressed and has no effect on the model. Denoted by a blue x.

Additionally, if the feature appears in gray, it means the feature is inactive. This can occur whenever you are performing a Section : Feature Insert or Section : Edit Selections for Features and Apply/Cancel.
**Generate**

**Hotkey:** [F5]

Click the **Generate** button to update the model after any number of changes in the model's feature or sketch/plane dimensions, or changes in design parameters.

**Extrude**

Use the **Extrude** button to create an extruded feature. Solids, surfaces, and thin-walled features can be created from a sketch (to create surfaces, set the inner and outer thicknesses to zero). The active sketch is the default input but can be changed by selecting the desired sketch or a plane from face (boundary used) in the **Tree Outline**.

A Section : Named Selection can also be selected as the base object. If a Section : Named Selection is used, then a Direction Vector must be defined, and will be used for extruding all legitimate items in the Section : Named Selection. Extrude can use faces (its edges are actually used) and edges from the Section : Named Selection as well as Surface Bodies (treated like faces) and Line Bodies (treated like edges) from Named Selections. Open sets of edges will only be used if there are no faces or closed sets of edges in the Section : Named Selection.

The Details View is used to set the Extrude depth, direction vector, direction, direction type and modeling operation (Add, Cut, Slice, Imprint, or Add Frozen). Clicking Section : Generate completes the feature creation and updates the model.

**Direction Vector for Extrude**

The default Direction Vector is normal to the plane the sketch lies in. However, you can define a custom Direction Vector by selecting a Section : Direction Reference. The direction you choose must not be parallel to the base object or the **Extrude** may fail to generate.

*Note* — The Direction Vector is required if the base object is a Section : Named Selection.

**Direction Property for Extrude**

You can access two directions via a combination box with four options:

- **Normal**: Extrudes in positive Z direction of base object.
- **Reversed**: Extrudes in negative Z direction of base object.
- **Both - Symmetric**: Applies feature in both directions. One set of extents and depths will apply to both directions.
- **Both - Asymmetric**: Applies feature in both directions. Each direction has its own extent and depth properties.

**Extent Types**:

There are five Extent Types that you use to define the extrusion:

- Section : Fixed Type
- Section : Through All Type
- Section : To Next Type
Fixed Type

Fixed extents will extrude the profiles the exact distance specified by the Depth property. The feature preview shows an exact representation of how the feature will be created:

Through All Type

Through All will extend the profile through the entire model. When adding material with this option, the extended profile must fully intersect the model. Although the preview will show the direction in which the profile gets extruded, the actual extent will not be determined until the feature is generated.

To Next Type

To Next will extend the profile up to the first surface it encounters when adding material. When performing Cut and Slice operations, the extent will go up to and through the first surface or volume it encounters. Although the preview will show the direction in which the profile gets extruded, the actual extent will not be determined until the feature is generated.
If Target Bodies are selected, then DesignModeler will only consider those bodies when determining the To Next extent.

**To Faces Type**

The **To Faces** is an advanced option which allows you to extend the Section : Extrude feature up to a boundary formed by one or more faces. Select the face or faces to which you want to extend the Section : Extrude feature. This is easiest when you have only one profile in the base sketch. If you have multiple profiles in your Base Object, you have to make sure that each profile has at least one face intersecting its extent. Otherwise, an extent error will result.

The extent calculation is the same for all material types. Although the preview will show the direction in which the profile gets extruded, the actual extent will not be calculated until the feature is generated.

*Note* — To Faces option is quite different from To Next. You can say that To Next does not mean “to the next face,” but rather “through the next chunk of the body (solid or surface).”

Another noteworthy aspect of the To Faces option is that it can also be used with respect to faces of frozen bodies.

---

**To Surface Type**

The **To Surface** extent is an advanced option which allows you to define the extent through a surface. In this case a single target face is selected and its underlying (and possibly unbounded) surface is used as the extent. The underlying surface must fully intersect the extruded profile or an error will result.

Also, please note that some Non-Uniform Rational B-Splines (NURBS) target faces cannot be extended. In those cases, the **Surface Extension** feature may fail if the extension is not fully bounded by the selected target face’s surface.

The extent calculation is the same for all material types. The preview will show the direction of the extrusion, but the actual extent calculation is not performed until the feature is generated.
Revolve

Use the Revolve button to create a revolved feature. The active sketch is the default but can be changed using the Tree Outline. If there is a disjoint line in the sketch, it is chosen as the default axis of revolution. A Section : Named Selection can also be selected as the base object. Revolve can use faces (its edges are actually used) and edges from the Section : Named Selection as well as Surface Bodies (treated like faces) and Line Bodies (treated like edges) from Named Selections. Open sets of edges will only be used if there are no faces or closed sets of edges in the Section : Named Selection. The axis of revolution may be any straight 2D sketch edge, 3D model edge, or plane axis line.

Further, the Details View can be used to change the angle of revolution, the feature direction, and modeling operation: Add, Cut, Slice, Imprint, or Add Frozen. Solids, surfaces, and thin-walled features can be created by using this feature. For creating a surface body, the inner and outer thickness values should be kept equal to zero. Clicking Section : Generate completes the feature creation and updates the model.

Direction Property for Revolve

You can access two directions via a combination box with four options:

- **Normal**: Revolves in positive Z direction of base object.
- **Reversed**: Revolves in negative Z direction of base object.
- **Both - Symmetric**: Applies feature in both directions. One set of angles will apply to both directions.
- **Both - Asymmetric**: Applies feature in both directions. Each direction has its own angle property.

Sweep

The Details View can be used to change the modeling operations (Add, Cut, Slice, Imprint, or Add Frozen) and the alignment of the sweep. Solids, surfaces, and thin-walled features can be created by using this feature. For creating a surface body, the inner and outer thickness values should be kept equal to zero. Clicking Section : Generate completes the feature creation and updates the model.

The Sweep profile may consist of a single or multiple chains, and they may be either open or closed. The sweep path may be either an open or a closed chain, but there may only be one path. If the sweep path is an open chain, then the endpoint of the path that lies closest to the profile(s) is chosen as the start vertex for the Sweep operation.

For either the Sweep profile or the Sweep path, or both, you may use Named Selections. Also note that if neither end of an open Sweep path or if no vertex of a closed Sweep path lies in the plane of the Sweep profile, then the resulting Sweep may appear strange. This is especially true if Path Tangent is being used for Alignment.

Alignment

There are two options for the alignment property:

- **Path Tangent**: Reorients the profile as it is swept along the path to keep the profile’s orientation with respect to the path consistent.
Example 3  Path Tangent alignment

Global Axes: The profile’s orientation remains constant as it is swept along the path, regardless of the path’s shape. As an example, consider these two sweeps that use identical path and profile sketches. The picture on the left uses Path Tangent alignment, while the picture on the right uses Global Axes alignment.

Example 4  Global Axes alignment

Path Tangent alignment  Global Axes alignment

Scaling and Twisting

Use the Scale and Turns properties of the Sweep feature to create helical sweeps, as illustrated.
Use **Scale** to taper or expand the profile along the path of the sweep. The value for **Scale** determines the size of the end of the sweep relative to the original profile. Use **Turns** to twist the profile as it is swept along the path. The value of **Turns** is the number of rotations about the path. A negative value for **Turns** will make the profile rotate about the path in the opposite direction.

- **+Turns:** Rotates counterclockwise.
- **-Turns:** Rotates clockwise.

These two properties are designed for creating helical sweeps, although there are some restrictions:

- **Scale:** The sweep path must be an open chain AND smooth.
- **Turns:** The sweep path must be smooth. Additionally, if the sweep path is a closed loop, then **Turns** must be an integer. If the sweep path is an open chain, then any value for **Turns** is acceptable.

The default values for **Scale** and **Turns** are 1.0 and 0.0 respectively.

**Skin/Loft**

Takes a series of profiles from different planes to (Add, Cut, Slice, Imprint, or Add Frozen, depending on the chosen "material type") a solid or surface fitting through them. The Details View can be used to change the modeling operations (Add, Cut, Slice, Imprint, or Add Frozen). Solids, surfaces, and thin-walled features can be created by using this feature. For creating a surface body, the inner and outer thickness values should be kept equal to zero. Clicking Section : Generate completes the feature creation and updates the model.

You must select two or more profiles for the **Skin/Loft** feature. A profile is a sketch with one closed or open loop or a plane from a face or a Section : Named Selection. All profiles must have the same number of edges. Additionally, open and closed profiles cannot be mixed. All profiles for the **Skin/Loft** feature must be of the same type. Sketches and planes can be selected by clicking on their edges or points in the graphics area, or by clicking on the sketch or plane branch in the **Tree Outline**. Upon selecting an adequate number of profiles, a preview will appear which shows the selected profiles and the guide line. The guide line is a gray polyline which shows how the vertices between the profiles will line up with each other.

There is a right mouse button context menu to assist in creating the **Skin/Loft** feature. Clicking the right mouse button context menu will present two options:

- **Fix Guide Line:** Allows you to click on edges in the graphics area to change the guide line alignment. For open profiles, the guide line must pass through the profiles at their endpoints.
- **Continue Sketch Selection:** Leaves the alignment state in order to continue profile selection for the **Skin/Loft** feature.

**Skin Profile Ordering**

Profiles are reordered through the Details View. The **Skin/Loft** feature's Details View will list the selected profiles in order. If you select a profile and then click the right mouse button, a context menu appears which allows you to reorder that profile's position in the list, as illustrated below.
Note — There are four reordering options plus Delete, which will remove the selected profile from the list altogether.

Point Profiles

The Skin/Loft feature can accept profiles consisting of a single point. A point profile is defined as a sketch that contains exactly one construction point and nothing else or a Section: Named Selection with a single vertex or 3D Point (from Section: Point feature). Point profiles are restricted to either the first and/or last profile in the profile list. Point profiles may not be placed in the middle of the profile list. If both the start and end profiles are point profiles, then at least three profiles are necessary for the Skin/Loft feature instead of the usual two. You can tell which profiles in the Details View are point profiles by the asterisk (*) that is placed after them. In the following picture, Sketch3 is a point profile:

You do not need to be concerned about how the guide rail lines up with a point profile, since there is only a single point for the Skin/Loft to which to converge. The other profiles in your profile list may be either open or closed, but not both. Shown here are some examples:
Profiles for a boat’s hull (closed profiles):

Profiles for a surface (open profiles):

After generating the Skin/Loft:

Thin/Surface

The Thin/Surface feature has two distinct applications:

- Create thin solids
- Simplified shelling

The three selection tools are:

- **Faces to Remove**: selected faces will be removed from their bodies.
- **Faces to Keep**: selected faces will be kept, while unselected faces are removed.
- **Bodies Only**: the operation will be performed on the selected bodies without removing any faces.

The Thin/Surface feature allows you to convert solids into thin solids or surfaces. The feature can operate on both active and frozen bodies. Typically, you will select the faces to remove, and then specify a face offset that is greater than or equal to zero (>=0). You can make a model’s thickness in one of three directions of offset:

- Inward
- Outward
- Mid-Plane
The simplified shelling application allows you to convert from thin solid models to surface models. This applies for a thickness of zero (=0). The Thin/Surface feature supports thickness > 0 if the selected faces are part of surface bodies. This allows for the “thickening” of an imported surface. Example:

When you create a surface, you can also specify a Face Offset. Face Offset only appears when the thickness is zero.

The Direction property specifies the direction in which the surface is thickened (or the solid is hollowed). The directions are Inward, Outward, and Midplane. Midplane allows for consistent thickness to approximate the midsurface. Midplane applies half of the given thickness to both sides.

*Note* — This does not mean midplane extraction. It means that the bodies will be hollowed, such that the inner and outer walls of the bodies are offset equal distances from the original faces.

For example, shown below left is a body before hollowing and to the right, the body after midplane hollowing.

*Note* — The Midplane direction can be applied to surface bodies as well, so that surfaces are thickened equally on both sides.

**Blend**

The Blend feature allows you to create blends in two forms:

- Fixed Radius
- Variable Radius

**Fixed Radius**
The **Fixed-Radius** feature allows you to create blends on model edges. You can preselect 3D edges and/or faces for blending, and select 3D edges and/or faces while in the blend creation itself. If you select a face, all the edges from that face are blended. Preselection allows additional options from a right mouse button context menu for face edge loop selection and smooth 3D edge chain selection from the model. You can edit the blend radius in the Details View. Clicking Section : Generate completes the feature creation and updates the model.

**Variable Radius**

The **Variable-Radius** feature allows you to blend features on model edges. You can preselect 3D edges for blending and/or you can select 3D edges while in the blend creation itself. Preselection allows additional options from a right mouse button context menu for face edge loop selection and smooth 3D edge chain selection from the model. Use the Details View to change the start and end blend radius for each edge. Also, the Details View can set the transition between blends to smooth or linear. Clicking Section : Generate completes the feature creation and updates the model.

**Chamfer**

The **Chamfer** feature allows you to create planar transitions (or chamfer faces) across model edges. You can preselect 3D edges and/or faces for chamfering, and/or you can select 3D edges and/or faces while in the chamfer creation itself. If a face is selected, all the edges from that face are chamfered. Preselection allows additional options from a right mouse button context menu for face edge loop selection and smooth 3D edge chain selection from the model. Every edge on a face has a direction. This direction defines a right and left side. **Chamfer** is defined either by two distances from the edge for the planar transition (chamfer face), or by a distance (left or right) and an angle. The type of chamfer is defined in the Details View along with the distances and angle. Clicking Section : Generate completes the feature creation and updates the model.

**Point**

The **Point** feature allows for controlled and fully dimensioned placement of points relative to selected model faces and edges. These points are referred to as **point feature points**, or **PF points**.

The feature can operate on both active and frozen bodies. You begin by selecting the set of base faces and guide edges. Next, select the type:

- **Spot Weld**: Used for “welding” together otherwise disjointed parts in an assembly. Only those points that successfully generate mates are passed as spot welds to Simulation. Spot welds on multiple body parts will not be transferred to Simulation.

- **Point Load**: Used for “hard points” in the analysis. All points that successfully generate are passed to Simulation as vertices. However, Simulation will ignore points that do not lie on faces. Also point loads on multiple body parts are not supported in Simulation.

- **Construction Point**: No points of this type are passed to Simulation.

Then, choose from up to four possible Point Definition options, and for each of these certain placement definitions may be specified:
Table 1 Point Definition Options

<table>
<thead>
<tr>
<th>POINT DEFINITION</th>
<th>AVAILABLE PLACEMENT DEFINITIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>Sigma and Offset</td>
</tr>
<tr>
<td>Sequence By Delta</td>
<td>Sigma, Offset, Delta</td>
</tr>
<tr>
<td>Sequence By N</td>
<td>Sigma, Offset, N, Omega</td>
</tr>
<tr>
<td>From Coordinates File</td>
<td>(See Coordinates File section below)</td>
</tr>
</tbody>
</table>

The Point placement is defined by distances on the chain of guide edges and by distances along the chain of guide edges as follows:

**Sigma:** the distance between the beginning of the chain of guide edges and the placement of the first point. Measurement is taken on the chain of the first Guide Edge selected, in arc length.

**Edge Offset:** the distance between the guide edges and the placement of the spots on the set of base faces (approximation).

**Delta:** the distance, measured on the guide edges, in arc length between two consecutive points, for the Sequence By Delta option.

**N:** the number of points to be placed, relative to the chain of guide edges, in case of the Sequence By N option.

**Omega:** the distance between the end of the chain of guide edges and the placement of the last spot, for the Sequence By N option. Measurement is taken on the chain of the Guide Edges in arc length.

Definitions

**Base Faces:** where points are to be added.

**Guiding Edges:** used as a reference to create the points.

**Mating Faces:** what DesignModeler detects as the faces on which mating points are to be created when creating the “Spot Welds.” These faces may be on either side of the Base Faces within the given range. If the edge offset is zero (i.e., if the points lie on the Guide Edges, and no Mating Faces are found on either side of the Base Face), then an attempt is made to find Mating Faces in the tangent direction of the Base Face. This can be used to approximate “Seam Welds.”

**Mating Targets:** what body is to be used for finding contact points. Used for models with multiple bodies, when contact is only desired between certain bodies.

The mating face is detected automatically, and the points are added depending on whether the mating face is above the points on the base face, or below the points on the base face. Illustrated below is an example when points will not have mating points on the Mating Face.
Point Placement

For edge offsets that are nonzero, the point is placed on a Base Face, relative to the Guiding Edge, as illustrated below.

Location on Guiding Edge.
Point (1) is offset in direction perpendicular to Surface Normal and Edge Tangent.
Point (2) is projected back onto the face at the point on the surface closest to point (2). For planar faces, no projection is needed since point (2) will already lie on the face.

Points that fall outside their base faces will not be placed, as illustrated below.

If Sigma is zero, then the sequence of the points will begin from the beginning of the first edge of the chain of guide edges. Similarly, if Omega is zero, the point at the other end will be on the edge of the base face.

For the Spot Weld analysis type, there is a “Range” property in the Details View. In this case, for each point placed on the base faces, the system will attempt to find a suitable “mate” on another face (typically on another surface body). If successful, it will then place a point at the “mate” position as well (the original point and its mate will be interpreted as a “weld” by Simulation). The Range specifies the maximum distance for each original point to probe for its mate.
**Point Mate Search Procedure**

Mates are found by searching up to three directions:

1. The Surface Normal
2. The opposite direction of the Surface Normal
3. The direction perpendicular to both the Surface Normal and Edge Tangent

Direction 1 and 2 are always searched. The closest mate found from these two directions is chosen. If no mate is found, then direction 3 is searched.

Mate placement is defined by the ray originating from the original point in one of the three directions described above. Note that each point’s ray may be different, since the ray depends on the shape of the base face, as illustrated below. The distance between the point and its mate must be less than or equal to the Range parameter. For a Spot Weld from Coordinates File, only directions 1 and 2 are searched.

**Face Offset Property**

This option allows you to place points offset from the surface of the base face. The Face Offset property is available for Point Load and Construction Point types, but not for Spot Welds. The offset direction is determined by the surface normal as shown here.

Note that the face offset may be either positive or negative, and may even result in the point being placed inside a body. An example is shown here, where the base face and guide edge are highlighted.
Note — Current versions of Simulation (up to and including 9.0) do not support isolated points, i.e., points that are placed off a surface, be it inside or outside a solid. This means that, currently, it is not recommended to use Face Offsets > 0 for any other purpose than for creating construction points, internal to the DesignModeler model.

Coordinates File

This option allows you to specify a text file from which to read coordinates. These coordinates are used exactly as specified and are not projected onto any face or edge. The file itself must be a simple text file formatted according to the following rules:

1. After a pound sign ‘#’, everything else on that line is considered a comment and is ignored.
2. Empty lines are ignored.
3. Data consists of 5 fields, all on one line, separated by spaces and/or tabs:
   a. Group number (integer): must be >0
   b. Id number (integer): must be >0
   c. X coordinate
   d. Y coordinate
   e. Z coordinate
4. A data line with the same Group and Id numbers as a previous data line is an error.
5. Number of points is limited to the value set in the Options dialog box (see the Point Feature Limit setting under the DesignModeler Miscellaneous settings in the Options dialog box).

The Refresh property for this option allows you to update your text file and have the system read it again. Since the Group number and Id number fields uniquely identify each point generated for this Section : Point feature, this allows you to modify coordinates, or delete or add points. A sample coordinates file is shown below.

```
# List of Point Coordinates
# Format is integer Group, integer ID, then X Y Z all
# delimited by spaces, with nothing after the Z value.

# Group 1
1 1 20.1234 25.4321 30.5678
1 2 25.2468 30.1357 35.1928
1 3 15.5555 16.6666 17.7777

# Group 2
2 1 50.0101 100.2021 7.1515
2 2 -22.3456 .8765 -.9876
2 3 21.1234 22.4321 23.5678
```

Special Notes for Point Load and Spot Weld from Coordinate File

For **Point Load** and **Spot Weld**, a base face is searched for at each point, and for **Spot Weld**, mate faces are also determined. Because the mate faces are automatically detected, you should not put locations of mate points in the file. Doing so may result in the creation of duplicate spot welds.

Normally, a very tight tolerance is used when checking that a point is actually on a face. For locations read from coordinate files, this tolerance is loosened to make the points easier to specify. However, they will still need to be within $5.0 \times 10^{-7}$ meters of the face. This tolerance is mapped to the unit setting you are using, so for example it is equivalent to $5.0 \times 10^{-4}$ millimeters, or about $2.0 \times 10^{-5}$ inches.
If a point lies on an edge or vertex, then any of the adjacent faces could be used for **Point Load. Spot Weld** will try each of these possible faces until it finds one for which it can also find a mate face. You have some control of this by selecting the Section : Target Bodies in the Section : Point feature.

For **Point Load** and **Spot Weld**, points are created for each coordinate in the file (up to the limit, see item five in Coordinates File). However, note that Simulation will ignore **Point Load** points that are not on a face. Also, for **Spot Welds**, if no base face is found, the point is internally marked as “expired” and does not display or transfer to Simulation.

## Advanced Feature Properties

The options described in this section apply selectively to the 3D Features. Charted below are the Advanced Properties and the 3D Features to which they apply.

<table>
<thead>
<tr>
<th>Advanced Properties</th>
<th>Target Bodies</th>
<th>Merge Topology</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic 3D Features</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extrude</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Revolve</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Sweep</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Skin/Loft</td>
<td>Yes*</td>
<td></td>
</tr>
<tr>
<td>Thin/Surface</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blend (fixed)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blend (variable)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chamfer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>Yes*</td>
<td></td>
</tr>
<tr>
<td><strong>Advanced Tools</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freeze</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unfreeze</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Named Selection</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mid-Surface</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Joint</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enclosure</td>
<td>Yes*</td>
<td></td>
</tr>
<tr>
<td>Symmetry</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Fill</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surface Extension</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Body Operation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slice</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Face Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Concept Modeler</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lines from Points</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lines from Sketches</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lines from Edges</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Split Line Body</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surfaces From Lines</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surfaces From Sketches</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
* The Target Bodies property for Enclosure and Point have a slightly different meaning. Please see the Section: Enclosure or Point feature for details.

## Target Bodies

The Target Bodies property allows you to specify which bodies are operated on during a Cut, Imprint, or Slice operation. By switching the value of the Target Bodies property from All Bodies to Selected Bodies, you can select bodies through another Apply/Cancel property called Bodies. Here, the bodies that you select will be the ones subjected to the Boolean operation.

For example, suppose you wish to cut circular holes into the blocks of this model, but for only some of the blocks.

![Target Bodies Diagram]

After changing the Material Type to Cut Material, the Target Bodies property will appear. By changing its value to Selected Bodies, the bodies you wish to be cut may be chosen. Here three bodies are chosen.
After clicking Section : Generate, three of the five bodies have holes. Only the bodies selected as targets were used in the Boolean operation.

The same functionality applies to Imprint and Slice operations as well. The following picture is the result if the operation were changed to Imprint Faces. Here the imprinted faces are highlighted for clarity.
If the blocks are initially frozen, we could perform a Slice operation using target bodies. Selecting the same three bodies would yield this result. Note here that for clarity, frozen body transparency has been turned off.

**Merge Topology**

Extrude, Revolve, Section : Sweep, and Skin each have a property called **Merge Topology**. This property is a Yes/No combination box that gives you more control over feature topology. Setting the property to Yes will optimize the topology of feature bodies, while setting it to No will leave the topology of feature bodies unaltered.

For features in previous versions, AGP 7.0 and older, **Merge Topology** is a read-only property whose value is AGP 7.0 style. This means that features created in old versions of AGP follow the previous topology merging scheme and cannot be changed. Under the old scheme, inner profile faces are merged, but outer profile faces are not.
The default setting for **Merge Topology** differs depending on the 3D feature you are using:

- **Extrude**: The default is Yes.
- **Revolve**: The default is Yes.
- **Skin/Loft**: The default is No.
- **Sweep**: The default is No.

For example, consider a rectangular profile with a circular hole in it. To illustrate the differences in the topology merging schemes, each edge is split into several pieces:

Extruding this profile in AGP 7.0 would produce the following result. The old scheme merges the cylindrical faces of the hole, but does not merge the outer faces of the block:
In DesignModeler 7.1 and later, you have control over topological optimizations. The same profile is extruded in DesignModeler 7.1:

**With Merge Topology = Yes:**

**With Merge Topology = No:**

Note how the setting the value to Yes optimizes all topology of the feature body. It is however, recommended to leave this setting as No for the Skin/Loft and Section : Sweep features to best represent the true characteristics of the profiles. Additionally, you should be cautious when changing the value of the Merge Topology property because after initial creation, once other features depend on this, faces and edges may appear or disappear and cause failures and invalid selections for subsequent features.
Primitives

DesignModeler allows you to create models quickly by defining primitive shapes that do not require sketches. All the primitive features require several point and/or direction inputs. These inputs may be defined by either specifically typing in the coordinates or components, or by selecting geometry on the screen. Also, each primitive contains a base plane which identifies the coordinate system in which the primitive is defined.

There are nine Primitive features in DesignModeler:

• Section : Sphere
• Section : Box
• Section : Parallelepiped
• Section : Cylinder
• Section : Cone
• Section : Prism
• Section : Pyramid
• Section : Torus
• Section : Bend

Sphere

The Sphere feature creates a primitive sphere from an origin and radius.

![Sphere](image)

Inputs

• **Origin**: The center of the sphere.
• **Radius**: The radius of the sphere.
**Box**

The Box feature creates a primitive box. It can be defined in two ways:

- **From One Point and Diagonal:** The box is defined by one point and a diagonal vector which defines the box's opposite corner.
- **From Two Points:** The box is defined by two points that represent opposite corners of the box.

![Box Diagram](image)

**Inputs**

- **Point 1:** The first corner of the box.
- **Point 2:** The second corner of the box.
- **Diagonal:** The vector spanning from the first point to its opposite point.

No coordinate of Point 2 may match its corresponding coordinate of Point 1. The Diagonal vector must have non-zero inputs for all three of its components.

**Parallelepiped**

The Parallelepiped feature creates a parallelepiped from an origin and three axis vectors.
Inputs

- **Origin**: The starting corner of the parallelepiped.
- **Axis 1**: The vector defining the first side of the parallelepiped.
- **Axis 2**: The vector defining the second side of the parallelepiped.
- **Axis 3**: The vector defining the third side of the parallelepiped.

Note that no two axis vectors may be parallel.

**Cylinder**

The Cylinder feature creates a primitive cylinder from an origin, axis, and radius.
Inputs

- **Origin**: The center of the cylinder at its base.
- **Axis**: The central axis of the cylinder. A vector defining the central axis of the cylinder.
- **Radius**: The radius of the cylinder.

Cone

The Cone feature creates a primitive cone from an origin, axis, and two radii.

![Cone Diagram](image)

Inputs

- **Origin**: The center of the cone at its base.
- **Axis**: The central axis of the cone. A vector defining the central axis of the cone.
- **Base Radius**: The radius of the cone at its base.
- **Top Radius**: The radius of the cone at its top.

*Note* — Either the Top Radius or the Base Radius may be zero, but not both.

Prism

The Prism feature creates a primitive prism. The prism’s size can be defined in two ways:

- **By Radius**: A radius from the origin to an outer vertex.
- **By Side Length**: The length of each side of the prism.
**Inputs**

- **Origin**: The center of the prism.
- **Axis**: The central axis of the prism. A vector defining the central axis of the prism.
- **Base**: The vector defining the direction to the first vertex of the prism.
- **Radius**: The radius of the prism.
- **Side Length**: The length of each prism side.
- **Sides**: The number of prism sides.

*Note* — The Axis and Base vectors are not required to be perpendicular. They may not however, be parallel.

**Pyramid**

The Pyramid feature creates a primitive pyramid.
**Inputs**

- **Origin:** The center of the pyramid's base.
- **Axis:** The central axis of the pyramid. A vector defining the central axis of the pyramid.
- **Base:** The vector defining the pyramid base's alignment.
- **Base Length:** The length of the pyramid base.
- **Base Width:** The width of the pyramid base.
- **Pyramid Height:** The height of the pyramid. A value of zero implies a pyramid of full height.

*Note* — The Axis and Base vectors are not required to be perpendicular. They may not however, be parallel.

**Torus**

The Torus feature creates a primitive torus.
Inputs

- **Origin**: The center of the torus.
- **Axis**: The central axis of the torus.
- **Base**: The vector defining the alignment of the torus with respect to its axis.
- **Inner Radius**: The distance from the axis to the inside of the torus.
- **Outer Radius**: The distance from the axis to the outside of the torus.
- **Angle**: The angle of rotation about the axis.

*Note* — The direction of rotation about the axis follows the right hand rule. The Axis and Base vectors are not required to be perpendicular. They may not however, be parallel.

**Bend**

The Bend feature creates a rectangular bend.
Inputs

- **Origin**: The center of the bend.
- **Axis**: The central axis of the bend.
- **Base**: The vector defining the alignment of the bend with respect to its axis.
- **Radius**: The distance from the axis to the center of the bend profile.
- **Base Length**: The length of the bend's profile.
- **Base Width**: The width of the bend's profile.
- **Angle**: The angle of rotation about the axis.

*Note* — The direction of rotation about the axis follows the right hand rule. The Axis and Base vectors are not required to be perpendicular. They may however, be parallel.

Advanced Features and Tools

The Advanced Tools toolbar can be customized through the **Options** dialog box accessible under the Section : Tools Menu. The Advanced Tools include:

- Section : Freeze
- Section : Unfreeze
- Section : Named Selection
- Section : Mid-Surface
- Section : Joint
- Section : Enclosure
- Section : Symmetry
- Section : Fill
- Section : Surface Extension
- Section : Winding Tool
Freeze

The **Freeze** feature is an advanced modeling tool available from the Tools menu. **Freeze** has two applications: it allows for an alternative method for assembly modeling with multiple body parts, and it allows you to “slice” a given part into several sub-volumes (e.g., sweepable volumes for hex meshing).

Normally, a 3D solid feature operates like this:

1. Create the bodies of the 3D feature (e.g., the body or bodies of an **Extrude** feature).
2. Merge the feature bodies with the existing model via Boolean operations:
   - Add Material
   - Cut Material
   - Imprint Faces

The **Freeze** feature allows you to control the second step. It acts as a separator in the construction history as displayed in the **Tree Outline**. Any bodies created for features before a **Freeze** will become frozen. Frozen bodies are denoted by the ice cube icon next to a body under the Bodies branch of the **Tree Outline**. All frozen bodies will be ignored when it comes to the Add, Cut, or Imprint Material operation of any features following the Freeze.

The solid features offer an additional Boolean operation:

- Slice Material

In contrast to Add and Cut, the Slice Material operation is only available when the model consists entirely of frozen bodies. Also, in the case of Slice Material, the Freeze separator does not hide bodies from the Boolean operation.

Unfreeze

The **Unfreeze** feature activates a selected body, or a group of frozen bodies, and merges them with the active bodies in the model if applicable.

DesignModeler is not an assembly modeler; rather it is an “extended” part modeler that can deal with multiple bodies. However, with the **Freeze** and the **Unfreeze** tools, certain modeling capabilities for (imported) assemblies do exist. On the one hand, this may seem a limitation, but on the other hand, this is a different approach to assembly modeling and allows actually more (or other) functionality (e.g., slicing).
By default, if you import an assembly from a CAD package, the modeling capabilities of DesignModeler are limited, because applying any form of a 3D modeling operation would simply merge any touching bodies into one. However, this can be circumvented with the Freeze and Unfreeze tools.

If you immediately Freeze the model after importing an assembly or import an assembly using the Add frozen operation, your bodies will be shielded from the merge. You can, at that point, add new bodies; however, you cannot modify any of the existing frozen bodies. For this, you can use Unfreeze to select bodies to become “active.” (Active bodies are depicted as shaded blue blocks in the Tree Outline.) DesignModeler can now operate on the newly unfrozen bodies as it would on any other active bodies.

**Freeze Others**

If set to Yes, all unselected bodies will become frozen, while selected bodies will become active. You do not have to first Freeze immediately followed by an Unfreeze.

**Named Selection**

The Named Selection feature allows you to create named selections that can be transferred to Simulation, or used in the creation of some features. You can select any combination of 3D entities, including point feature points (PF points). Selections are performed through an Apply/Cancel property called Geometry in the Details View of DesignModeler.

Named selections are transferred to Simulation by first selecting the **Named selections** option in the **Default Geometry Options** section of the ANSYS Workbench environment Project Page.
There you must provide a key string that is used to choose which named selections you wish to transfer. A **Named Selection** feature will be transferred to Simulation if the key string given in the ANSYS Workbench environment is found in the feature's name. This field can have any number of prefixes with each prefix delimited by a semicolon (for example: `NS_ForceFaces;NS_FixedSupports;NS_BoltLoaded`). By default the filter is set to **NS**. If the filter is set to an empty string all applicable entities will be imported as named selections.

To ensure your selections remain persistent in Simulation, it is recommended that you create your **Named Selection** features last.

**Multiple Selection Types**

Simulation does not support multiple selection types for its named selections. If you choose more than one entity type for a **Named Selection** feature in DesignModeler, it will get split into two or more named selections in Simulation, one for each entity type. Also, while DesignModeler allows you to place multiple selection types into a **Named Selection** feature, you should avoid this practice. If you try to use a **Named Selection** feature as a base object for a feature within DesignModeler, you will get an error if it contains more than one entity type.

It is recommended that you do not delete or rename a **Named Selection** feature after the model has been transferred to Simulation. To avoid confusion, please note that Simulation will retain the previous **Named Selection** features.

**Named Selections in Regions of Shared Topology**

Note that your named selection may become lost if you select a region in which topology is shared. When you group bodies together into a multi-body part, you still work with them in DesignModeler as if they are independent bodies. When the model is transferred from DesignModeler to another applet, they combine to form the multi-body part. When the shared topology is merged, usually one of the original entities survives and the others are discarded. If you wish to place a **Named Selection** in a region of shared topology, it is recommended that all entities in the shared region be chosen in the named selection. For example, if you want a **Named Selection** on
a face that will be shared between two bodies, place the **Named Selection** on both faces. During transfer, the two faces will be merged, and one of them will persist in the resultant model.

**Mid-Surface**

The **Mid-Surface** feature allows the creation of surface bodies that are midway between existing solid body faces. The resulting surface body(s) have a **Thickness** property which defines the “thickness” that surface body represents. The faces can be manually selected, or an automatic mode allows you to set a thickness range and then automatically detect matching face pairs. Along with the basic name property, there are six properties for defining a Mid-Surface via manual selection, and four additional properties for automatic detection.

The six basic properties that define the **Mid-Surface** feature:

- **Face Pairs:** An Apply/Cancel property that facilitates the selection of the matching faces. The selected faces must be of the same type and be defined such that one is essentially offset from the other by a fixed distance. The order of the selected faces is important, especially the first pair of a given thickness. The mid-surface will be generated attempting to have the normal such that it points from the second (lavender / hot pink) face towards the first (purple) face. You must select a face and its matching face in the order you prefer. If you try to select two or more faces on one side before selecting the other side, the feature will assume you are selecting a face and immediately its matching face, thus leading to errors. Also, if you select a pair of faces that are not exact offsets of one another, a warning message will be displayed and the pair will not be used. In general, the normals from the two faces should point away from each other. For planar faces this is explicitly tested for and if they do not point away from each other, a warning will be displayed and they will not be used. For other face types, if they are offsets, but the normals point toward each other, or in the same direction, they will get used but the results may not be correct. If they are valid, the first face will be colored purple, and the second lavender / hot pink, with the eventual normal pointing outward from the purple face.

- **Selection Method:** Here you can decide whether to manually select faces, or set up additional properties so that matching faces can be automatically detected. If you have face pairs already selected when you select Automatic mode and you have not yet set min/max threshold values, then they will be automatically computed from your current selections.

- **Thickness Tolerance:** This property provides a tolerance so that face pairs that are the same distance apart, along with those that are within tolerance of that distance, can be grouped together. The feature will attempt to combine resulting surface bodies which touch one another and have the same thickness into a single surface body.

- **Sewing Tolerance:** During the creation of the Mid-Surface, internally surfaces are created from each face pair selected. These are then trimmed to other surfaces with the same thickness and then sewn together to attempt to form as few surface bodies as possible. However, there are sometimes small gaps between these individual surfaces. This tolerance specifies the maximum gap that can be closed by the sewing process. Normally it is not necessary to change this tolerance. However, if you find there are small gaps in the resulting body, this may be increased to a point where the gap gets closed. Note that using too large a sewing tolerance can lead to slots or openings getting filled when they should not. Very large tolerances can result in strange results and should be avoided.

- **Extra Trimming:** As with the Sewing Tolerance above, there are situations that the internal trimming algorithms cannot completely handle. In these cases, it is useful to be able to trim sheets that have trimming errors to the original body, or at times to trim all sheets to the original body for cases where no error was detected even though the trimming was not correct. If trimming to the original body would result in a non-manifold sheet, then the sheet will remain untrimmed. You also have options to delete sheets with trimming errors, or to keep them with no additional trimming. Note that if you use the “Delete Untrimmed”
option and there are trimming problems, you will not be able to use “Show Problematic Geometry” as the problem geometry will have been deleted.

- **Preserve Bodies:** Here you can decide whether the bodies whose faces you are selecting are kept or not after the Mid-Surface feature is generated. Along with the “Yes” and “No” options there is also an option to **Preserve body if error.** With this option, if one or more of the selected face pairs in a body cannot be properly processed, then that body will be preserved. If some face pairs for that body are successful, then the sheet bodies created by those pairs will be inside the preserved solid body. If there are no problems then this option is the same as the “No” option.

If you choose the Automatic selection method, the following four additional properties are shown:

- **Bodies to Search:** Here you choose which bodies to search. The default is **Visible Bodies.** The other choices are **All Bodies,** and **Selected Bodies.** If you choose **Selected Bodies** an additional **Bodies** property is displayed that allows you to select the bodies to process.

- **Minimum Threshold:** This sets the minimum distance allowed between face pairs during automatic detection. If it is set larger than the Maximum Threshold, then that value is set equal to the Minimum Threshold. Also, only values greater than zero are allowed.

- **Maximum Threshold:** This sets the maximum distance allowed between face pairs during automatic detection. If it is set less than the Minimum Threshold, then that value is set equal to the Maximum Threshold. Also, only values greater than zero are allowed.

- **Find Face Pairs Now:** This property will always display a ‘No’ as its value. When you set it to ‘Yes’, detection is done at that time, using the settings you have provided for the Threshold and Bodies, as well as the Thickness Tolerance. When it is finished processing, this value is automatically set back to ‘No’. If you have previously selected face pairs, the options shown for this are ‘No’; ‘Yes - Add to Face Pairs’; and ‘Yes - Replace Face Pairs’.

### Context Menu Options

If you select the right mouse button while the cursor is in the graphics area, several Mid-Surface specific options are presented:

- **Add Face Pairs:** This is the default mode for selecting face pairs. When the Face Pairs property is active, this allows you to add additional face pairs.

- **Remove Face Pairs:** When the Face Pairs property is active, this allows you to select a single face and all face pairs that contain that face are removed.

- **Reverse Face Pairs:** When the Face Pairs property is active, this allows you to select a single face and all face pairs that contain that face are reversed. Additionally, all face pairs that are dependent on the selected face via adjacent face connections that have matching orientation are also reversed.

- **Clear Existing Face Pair Selections:** This clears all current face pairs.

- **Adjust Min/Max Thresholds:** This uses the distance between all currently selected face pairs to set the Minimum and Maximum Threshold properties.

### Usage

There are several important concepts to understand to ensure successful use of the **Mid-Surface** feature.

- Resultant surface body names come from their original bodies.

- Selected face pairs must be an equal distance apart at all locations. Close is not good enough. They must be exact offsets of each other. Also, the normals to the selected pairs should point away from each other,
with solid material between them. This is automatically checked for planar pairs. Planar faces will not be accepted if the normals do not point in the correct directions. For other face types it is up to you to choose properly. If faces are selected that do not follow this rule, the resulting mid-surface may not be correct.

- Selecting face pairs that do not make sense will likely lead to errors. For example, selecting more that a single face pair on a simple block solid leads to multiple intersecting sheets rather then a single mid-surface sheet to represent the block. These cannot be properly trimmed and lead to trimming errors.

- You can control the normal direction of automatically detected faces by selecting an initial pair manually.
- You are free to mix manual selections and automatic detections (for example with different thresholds).
- The minimum and maximum threshold ranges are actually expanded by half of the thickness tolerance. This means you can set both thresholds to the same value and then only get faces that are within the tolerance range of that thickness.
- If your model has small faces, it is better to set identical minimum and maximum threshold ranges and use a fairly tight tolerance to avoid a mismatch of faces.
- Another reason to use small threshold ranges is to avoid selection of valid, but unwanted face pairs. For example if you have a rectangular block \(2 \times 4 \times 8\) and you use a threshold range from \(1\) to \(5\), you will get the face pair that is \(2\) units apart and the face pair that is \(4\) units apart. The result would be two intersecting mid-surface sheets. A range of \(1\) to \(9\) would result in three intersecting sheets. So for this part a range of \(1\) to \(3\) would work much better, or even better would be \(2\) to \(2\) so that you get used to using just exactly what is wanted.
- Sewing Tolerance can be used to close small gaps, but using very large values can lead to invalid results.
- You may right click on the Mid-Surface feature in the tree if it has errors or warnings and look at either the error/warnings, or at the geometry causing the problem.

### Step-by-Step Example

The following example should help to demonstrate some of the functionality described above. Browse ... to one of the following:

- Windows platform: \...\Program Files\ANSYS Inc\v100\AISOL\Samples\DesignModeler\MidSurfaceBracket.agdb
- Unix platform: .../ansys_inc/v100/aisol/Samples/DesignModeler/MidSurfaceBracket.agdb

The Demo_Bracket part is imported and is actually two separate solids. The front brace, even though it touches the main bracket is a separate body, as you might have in an assembly part.
In the first figure, load the part, choose the **Mid-Surface** feature, and select two face pairs (using the stacked rectangles in the lower left to choose hidden faces). These pairs represent the two thicknesses of this model.

Now, after selecting Apply, go to the Automatic Selection mode. Since some face pairs are already selected, and the minimum and maximum thresholds have not yet been set, it automatically calculates a range based on the current selections. This can also be done via the right mouse button context menu at any time, or the thresholds can be set manually. Next, for **Find Face Pairs Now**, select **Yes, Add to Face Pairs**. This results in a total of 11 face pairs being selected. However, there is actually one face pair not wanted, and some adjustments are needed so that the normal points in the direction desired.
Here you can see where to select the pair to remove and the pair to reverse. An unwanted face pair was detected near one of the slots because its thickness is within range of the thresholds that were specified. When you have cases like this, activate the face pairs property and, with the cursor in the graphics area, use the right mouse button context menu to choose **Remove Face Pairs**. Then select the unwanted face pair as indicated above. Just the one selection will remove both faces of the pair. The next step is to reverse the normals of the surfaces for the two braces such that they point away from each other. Use the right mouse button option **Reverse Face Pairs**, select once where indicated, and the order of all connected face pairs will be reversed.

Here is how the model will appear after the removal and reversal, but before the Apply. Now you are ready to Apply, and then **Generate**.
Here is the result of the Generate. Now, instead of two solid bodies, there are four surface bodies. They cannot be combined into a single body because the "T" intersections would cause it to be non-manifold. Also, in the final figure below, you will see that the resulting surface bodies for the back brace are automatically extended/trimmed to meet the main part of the bracket, as these were all part of one solid body originally. However, the front brace was a separate body, so it is not automatically extended.

Note that the Surface Extension feature can be used to extend the front brace so it does meet the main bracket.
The **Joint** feature is a tool used to join surface bodies together so that their contact regions will be treated as shared topology when meshed in Simulation. The feature takes two or more surface bodies as input, then imprints edges on all bodies where they make contact. There is no restriction on the states of the bodies you select; both active and frozen body selections are permitted. The **Share Topology** property allows you to control the behavior of the feature:

- **Share Topology**: To treat the imprinted edges as shared topology in Simulation, set the Shared Topology option to Yes. Imprinted edges will display an edge joint where the coincident edges are to signify that their edges will be shared. That is, two coincident edges will still exist in DesignModeler as separate edges, but when the model is attached to Simulation, the edges are merged into one. If **Share Topology** is set to No, then edges will be imprinted on both surface bodies, but no shared topology information is kept. The default setting is Yes.

Two more properties list the results of the Joint operation:

- **Edge joints generated**: This tells you the number of edge joints that the **Joint** feature created. The value of this property will always be zero if **Share Topology** is set to No.
- **Expired edge joints**: This will inform you of any edge joints that have expired due to model changes. If any edges in an edge joint are modified in any way, then the edge joint will become expired and no longer appear when viewing the edge joints. For this reason, it is recommended that you apply **Joint** features after you are done building your model. This property is not displayed if there are no expired edge joints for a **Joint** feature.

For example, suppose you wish to join the following two surface bodies. DesignModeler would normally not allow these two bodies to be merged, since they created non-manifold geometry. Using the **Joint** feature, we can imprint the bodies and form shared topology between them.

![Joint feature example](image)

After generating the **Joint** feature, edges are imprinted onto all three bodies, and topology sharing information is created. Notice that the shared edges are shown as thick blue lines. Additionally, the three bodies are grouped under the same part.

![Joint feature result](image)
For more information on viewing edge joints, see Show Edge Joints.

Enclosure

The Enclosure feature is a tool used to enclose the bodies of a model so that the material enclosing the bodies can be assigned to something such as a gas or fluid in Simulation. The feature takes either all the bodies or selected bodies of the model as input, creates a frozen enclosure body around those bodies, and then cuts the bodies out of the enclosure. This operation will not delete any bodies currently in the model. All types of bodies will be enclosed but only solid bodies will be cut out of the enclosure.

The Section : Enclosure feature supports symmetry models when the shape of enclosures is a box or a cylinder. A symmetry model may contain up to three symmetry planes. You can choose either full or partial models to be included in the enclosure. If a full model is used, symmetry planes will slice off the Enclosure feature and only a portion of the enclosure will be retained.

Example 5  Full model with one symmetry plane

During the model transfer from DesignModeler to Simulation, the Enclosure feature with symmetry planes forms two types of named selections:

- **Open Domain**: All exterior enclosure surfaces that are not coincident to any symmetry planes are grouped in an Open Domain named selection.
- **Symmetry Plane**: For each symmetry plane, all faces, from both the enclosure and the model, that are coincident to the symmetry plane are grouped into a named selection.

*Note* — It is recommended that you do not change the symmetry plane selection after a model has been transferred to Simulation. Simulation will not delete the previous symmetry planes during updating. A similar note applies when using the Named Selection feature.
Example 6  Partial model with two symmetry planes

These additional properties allow you to control the behavior of the feature:

- **Shape**: This property specifies the shape of the enclosure. There are four different shapes available:
  - Box (default)
  - Sphere
  - Cylinder
  - User Defined

- **User Defined Body**: If User Defined is selected for the Shape property, then this property becomes available. It is an Apply/Cancel property that facilitates selection of the user defined enclosure body. The body selected for this property may not be included in the list of target bodies. Additionally, only one user-defined body can be selected.

- **Cylinder Alignment**: If cylinder is selected for the Shape property then this property becomes available. This specifies the cylinder axis of the bounding cylinder surrounding the target bodies. There are four different alignments the cylinder can have:
  - Automatic (default)
  - X-Axis
  - Y-Axis
  - Z-Axis

  Automatic alignment will align the cylinder axis in the largest direction (X, Y, or Z) of the bounding box surrounding the target bodies.

For the enclosure with symmetry planes, the following rules are applied for automatic alignment:

1. For one symmetry plane, the largest dimension of the bounding box for the target bodies is used.
2. For two symmetry planes, the intersection of the two symmetry planes is used.
3. For three symmetry planes, the intersection of the first two symmetry planes is used.

- **Number of Planes**: This property defines how many symmetry planes are used in the enclosure. The default value is 0.
- **Symmetry Plane1**: first symmetry plane selection
- **Symmetry Plane2**: second symmetry plane selection
- **Symmetry Plane3**: third symmetry plane selection
- **Model Type:** This property specifies either Full Model or Partial Model as input for the enclosure with symmetry planes:

  **Full Model:** DesignModeler will use the chosen symmetry planes to cut the full model, leaving only the symmetrical portion. For each symmetry plane, material on the positive side of the plane (that is, the +Z direction) is kept, while material on the negative side is cut away.  
  **Partial Model:** Since the model has already been reduced to its symmetrical portion, DesignModeler will automatically determine on which side of the symmetry planes the material lies.

- **Cushion:** The cushion property specifies the distance between the model and the outside of the enclosure body. The enclosure is initially calculated to be just big enough to fit the model, and then the cushion value is applied to make the enclosure larger. The cushion is set to a default value and must be greater than zero. This property is available for all enclosure shapes except User Defined. This property may also be set as a design parameter.

  *Note* — The bounding box calculation for the model used in the Enclosure feature is guaranteed to contain the model (or selected bodies). While the computed bounding box is usually very close to the minimum-bounding box, it is not guaranteed.

- **Target Bodies:** This property specifies whether all of the bodies or only selected bodies of the model will be enclosed. The default is all bodies.

- **Bodies:** If Target Bodies is set to Selected Bodies then this property becomes available. It is an Apply/Cancel button property that facilitates selection of the target bodies that you wish to be enclosed. None of the bodies selected for this property can also be selected as the user-defined body.

- **Merge Parts:** This property specifies whether or not the enclosure and its target bodies will be merged together to form a part. It is only available during feature creation or while performing Edit Selections. If yes, the enclosure body (or bodies) and all target bodies will be merged into a single part. Only solid bodies are considered when merging parts - line and surface bodies will not be merged. If the property is set to No, then no attempt is made to group the bodies into the same part, nor is any attempt made to undo any groupings previously performed. The Merge Parts property is set to No by default, and will automatically be set to No after each Merge Parts operation.

Shown below is the creation of each enclosure shape:
Box Enclosure of heat sink model.

Sphere Enclosure
Cylinder Enclosure with Y-Axis alignment

Shown below is the creation process of a User Defined Enclosure:

First Freeze the body or bodies that you will build your enclosure around.
Then create the User Defined Enclosure over the selected bodies.

**Symmetry**

The *Symmetry* feature is a tool used to define a symmetry model. The feature takes either all the bodies or selected bodies of the model as input and accepts up to three symmetry planes. You can choose either full or partial models to work with. If a full model is used, the selected symmetry planes will slice off the model and only a portion of the model will be retained. The valid body types for this feature are surface and solid.

During the model transfer from DesignModeler to Simulation, the faces and edges coincident to the symmetry planes are grouped into a named selection.

*Note* — It is recommended that you do not change the symmetry plane selection after a model has been transferred to Simulation. Simulation will not delete the previous symmetry planes during updating. A similar note applies when using the *Named Selection* feature.

The following properties allow you to control the behavior of the feature:

- **Number of Planes**: This property defines how many symmetry planes are used in the feature.
- **Symmetry Plane1**: first symmetry plane selection.
- **Symmetry Plane2**: second symmetry plane selection.
- **Symmetry Plane3**: third symmetry plane selection.
- **Model Type**: This property specifies either Full Model or Partial Model as input.
**Full Model:** DesignModeler will use the chosen symmetry planes to cut the full model, leaving only the symmetrical portion. For each symmetry plane, material on the positive side of the plane (that is, the +Z direction) is kept, while material on the negative side is cut away.

**Partial Model:** Since the model has already been reduced to its symmetrical portion, there is no model change after the **Symmetry** feature is generated. However when the model is transferred from DesignModeler to Simulation, the faces and edges coincident with the symmetry planes will be identified automatically and put into a named selection.

- **Target Bodies:** This property specifies whether all of the bodies or only selected bodies of the model will be enclosed. The default is **All Bodies**.
- **Bodies:** If Target Bodies is set to Selected Bodies, then this property becomes available. It is an Apply/Cancel button property that facilitates selection of the target bodies.

**Example 7 Full model with one and two symmetry planes**

A full model before creating **Symmetry** features:

![Full model before creating Symmetry features](image1.png)

A full model after creating a **Symmetry** feature with one symmetry plane:
A full model after creating a **Symmetry** feature with two symmetry planes:
The **Fill** feature is located in the Section : Tools Menu, and is available when the model consists of active and/or frozen bodies. This feature will create frozen bodies that fill selected depressions and holes in bodies that are currently in the model. Faces must be selected such that they surround each of the cavities that are to be filled. When the feature is generated, the bodies already in the model will not be modified. Frozen bodies that fill the selected cavities and holes will be added.

**Note** — The **Fill** feature may only be used in conjunction with solid bodies. A warning message is displayed if you select faces belonging to surface bodies.

The **Fill** feature is chosen from the Section : Tools Menu with a body in the model:
The faces are then selected for the area that is to be filled:

Finally, the feature is generated and the frozen body that fills the selected depressions is created:
When Filling a cavity, all faces in the cavity must be selected in order to complete the Fill operation. As shown here, to Fill a cylindrical cavity, both the base face and the circular face must be selected, otherwise the operation will fail.

In the case of a rectangular cavity, five faces must be selected: the base face, and each of the four side faces as shown here.

Surface Extension

The **Surface Extension** feature allows the extension of surface bodies. Sets of edges that belong to the boundaries of surface bodies are selected through an Apply/Cancel property. The surface is extended naturally along
the selected edge set. The extension distance can be determined by a fixed number or by a set of bounding faces. There are five properties that define the **Surface Extension** feature:

- **Edges**: An Apply/Cancel property that facilitates the selection of the edge sets. The selected edges must be on the boundary of the surface. Edges on the interior of the surface body cannot be extended.
- **Extent**: This property has four options for defining the extent of the surface extension:
  - **Fixed (default)**: Fixed means the surface will be extended an exact amount.
  - **To Faces**: To Faces means the surface will be extended up to a bounding set of faces.
  - **To Surface**: To Surface allows the surface to be extended up to a single face's unbounded surface.
  - **To Next**: To Next will extend the selected surfaces up to the first encountered faces which fully bound the extension. This operation is similar to the **To Faces** option except the user is not required to select the target faces. This is most useful when joining surface bodies in an assembly.
- **Distance**: This property defines the distance to extend the surface. Its value must be greater than zero or an error will occur. The extension is performed along the direction perpendicular to the selected edge set. It only appears if the Fixed extent is chosen. The value in this property may be promoted to a Design Parameter.
- **Faces**: An Apply/Cancel property that allows selection of faces. The extended surface must be fully bounded by the selected faces to succeed. This property only appears if the To Faces extent is chosen.
- **Target Face**: An Apply/Cancel property that allows the selection of a face to be used as the bounding surface. In this case a single target face is selected and its underlying (and possibly unbounded) surface is used as the extent. The underlying surface must fully intersect the extruded profile or an error will result. Also, note that some Non-Uniform Rational B-Splines (NURBS) target faces cannot be extended. In those cases, the **Surface Extension** feature may fail if the extension is not fully bounded by the selected target face's surface. This property only appears if the Section: To Surface Type extent is chosen.

Note that not all surfaces are extendable. Sometimes parametric surfaces twist awkwardly or become self-intersecting when extended. Since the extension distance is measured perpendicular to the edge set, one must be careful that the edges do not become twisted when extended.

Consider the ellipse in the following picture. The gray surface is extended, producing the result shown by the blue surface. After extending the surface along the elliptical edge, the resulting edge after the extension is not an ellipse, but rather a parametric curve. Had this surface been extended any further, the resulting edge would have become self-intersecting, causing the surface extension operation to fail.
Another example of the **Surface Extension** feature is shown here. Suppose you wish to extend the surface of the gray cone up to the cylindrical face and down to the planar surface. First, select the edges along the surface to extend:

Next, the extent faces for the extension are chosen:
Upon generating the feature, the gray cone is extended up to the desired faces:

A final example of the **Surface Extension** is shown here with the extent set as **To Surface**. To extend the surface to the body, first select the edges to be extended as with the other extent types:
Next, chose the face whose unbounded surface you wish to extend to:

Upon generating the feature, the surface body is extended to the desired face's surface:
An example of the **To Next** feature is shown here. Suppose you wish to extend the surface to the planar surface and the U-shape face. First, select the edges along the surface to extend:

Upon generating the feature, the surface body is extended to the desired faces:
Winding Tool

The Winding Tool is used to create Winding Bodies (a special form of line body) that represent coils of wire wound through slots of a rotor or stator of a motor. The Winding Bodies generated will automatically be named using the phase and coil from the Winding Table.

When you select a winding body, you will be shown the cross section size for the coil and the number of turns for it. Unlike standard Line Bodies, you cannot change the Cross Section or Alignment of its edges. The Winding Tool itself sets these. Like normal Line Bodies, the display of Winding Bodies is affected by the View options Section : Show Cross Section Alignments, and Section : Show Cross Section Solids.

Interface

Before selecting Winding Table from the Section : Tools Menu, you should first create a model of the rotor or stator to which it will be applied, and the center plane that will define the alignment of the Winding Bodies. Below are two diagrams showing how the winding coils are defined.
Example 8 Cross Section of Coil for an 8 Slot Rotor

Below are the properties required to define the **Winding** feature:

- **Center Plane**: A plane defined midway between the ends of the rotor or stator, with its origin and Z-axis at the center of the rotor or stator. It is recommended that you create this plane prior to creating the **Winding** feature.
- **Winding Table File**: This is where you pick the Winding Table File to use. When this is set/changed, it is read and the value in the next property, "Number of Slots" is set from it. Also if the Winding Table is dis-
played, you will be able to see what was read from the file. A Winding Table File is not required. You may enter the winding data manually.

- **Number of Slots:** This is used to compute the location of all the other slots. This value must be the same as that in the Winding Table. This value is initially 0, so the property shows as “Invalid”. A value greater than 1 must be entered. If you enter a Winding Table File, this value is set from the “SLOTS n” record in that file. If this value is changed, it resets all slot angles to be equally spaced around a full circle (see Slot Angles below).

- **Stack Length:** This is the distance between the ends of the rotor or stator. The actual length of the coil edges that go through a slot will be this length plus the clearance value added at each end.

- **Slot Angle:** This is the counterclockwise (CCW) angle from the X-axis of the Center Plane to a radius line from the origin of the Center Plane through the center of Slot 1. If there is a Skew Angle, it is important to understand that this value is measured at the central plane. (For the angle of other slots, see Slot Angles.)

- **Skew Angle:** If this is zero, the coils will go in a direction normal to the central plane as they pass through the In and Out slots. If it is not zero, the location at the top and bottom of the rotor or stator will be modified by half the Skew Angle, counterclockwise at the top and clockwise (CW) at the bottom. In fact, the top and bottom of the coil will be modified slightly more than that as the angle continues to “skew” the Clearance distance beyond the top and bottom of the rotor or stator. The skew angle must be in the range from -12.0 to 12.0 degrees.

- **View Winding Table:** The default for this is Yes, which means you want to display the Winding Table and allow it to be edited via the Winding Table Editor.

- **Refresh:** This is automatically set to Yes when you change the Winding Table File, or the Number of Slots (since that must agree with the value in the Winding Table). When this value is Yes, then the Winding Table File will be parsed for its values when the feature is generated.

- **Clash Detection:** When this is set to Yes and solid bodies are selected in the next property, then Clash Detection will be performed during Section : Generate. The SlotIn portion of each coil will be tested for clashes with the selected bodies. If the radius for the SlotOut is different than that for the SlotIn, then the SlotOut portion of the coil will also be tested for clashes. If no body is selected, or this property is set to No, then no clash detection is done for the coils. However, you will still be warned of a possible clash at the ends if the clearance for a coil is not larger than half of the width specified for that coil. Clashes between coils are not looked for.

- **Body for Clash Detection:** This property is only seen if the previous property is set to Yes. This allows the selection of bodies for the clash detection. If the previous property is set to Yes and no solid bodies are selected, this property will show as Invalid, and a warning will be issued for the feature during Section : Generate.

*Note* — As with other features, the Winding Bodies are not actually created, or the Winding Table parsed until you select Section : Generate.

Note that standard Cross Sections as created under the Section : Concept Menu are not used for Winding bodies. Instead, the cross section information for a Winding Body is provided in the Winding Table for each coil. These values are used in a similar way to standard Cross Sections.

When DesignModeler parts are transferred to Simulation, information is sent to Simulation identifying the Winding Bodies, along with the Number of Turns and the special cross section information needed.

### Winding Table

To create winding bodies, you will need a **Winding Table** to provide information needed for each coil. The **Winding Table** is a ".txt" file with the following characteristics:
1. After a pound sign '#', everything else on that line is considered a comment and is ignored.
2. Empty lines are ignored.
3. Values on a line are separated by spaces and/or tabs.
4. Keywords are not case sensitive. Version, version, VERSION, VeRsloN are all valid.
5. At the top of the file are two special lines:

```
VERSION 10.0
SLOTS 8
```

6. The primary data lines must contain the following columns, in order:

<table>
<thead>
<tr>
<th>Phase</th>
<th>Coil</th>
<th>Turns</th>
<th>SlotIn</th>
<th>SlotOut</th>
<th>Routing</th>
<th>Clearance</th>
<th>Radius- In</th>
<th>Radius- Out</th>
<th>CStype</th>
<th>Length</th>
<th>Width</th>
<th>Rotate Ends</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>1</td>
<td>50</td>
<td>6</td>
<td>1</td>
<td>Straight 0.6</td>
<td>8.0</td>
<td>8.0</td>
<td>RECT</td>
<td>2.0</td>
<td>1.0</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>2</td>
<td>50</td>
<td>7</td>
<td>2</td>
<td>Straight 0.6</td>
<td>8.0</td>
<td>8.0</td>
<td>RECT</td>
<td>2.0</td>
<td>1.0</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>3</td>
<td>50</td>
<td>8</td>
<td>3</td>
<td>Straight 0.6</td>
<td>8.0</td>
<td>9.0</td>
<td>RECT</td>
<td>2.0</td>
<td>1.0</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>50</td>
<td>5</td>
<td>2</td>
<td>Straight 0.76</td>
<td>9.0</td>
<td>9.0</td>
<td>RECT</td>
<td>2.5</td>
<td>1.5</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

7. Phase is a text string with no spaces/tabs in it. It is limited to 20 characters. The phase and coil are used to maintain persistence for the winding bodies. If you modify the phases or coils, it is possible that other features dependent on this feature may not generate successfully.
8. Coil, Turns, SlotIn, and SlotOut are integer values greater than zero
9. SlotIn and SlotOut must be different and not greater than the number of slots
10. A data line with the same Phase and Coil of a previous line is an error.
11. Routing must be STRAIGHT or ARC (or 0/1). This is how the connections between slots are made.
12. Clearance is the distance above and below the 'Stack Length' (see below) for the connections
13. RadiusIn and RadiusOut are the radius values to the center of the cross section within a slot.
14. CSType must be RECT. Currently this is the only value allowed here.
15. Length is the size of the cross section in the direction of a radius from the axis through the slot.
16. Half the Width must be smaller than the Clearance or you will get a Warning of a possible Clash between the connection and the end of the rotor/stator.
17. Rotate Ends is an optional column with values of Yes/No (1/0 are also accepted). If Yes (or 1), this will rotate the alignment of the connections between slots by 90°. This can be useful for coils that connect slots on opposite sides of the winding (near 180° apart).

Sample Winding Table File

VERSION 10.0

SLOTS 8

#Sample Winding Table with 8 slots

#Format is:
Winding Table Editor

When the View Winding Table property is set to yes (default), the Winding Table Editor panel will be displayed when creating and editing a Winding Tool feature, and whenever a Winding Tool feature in the Tree Outline is selected. It displays in a portion of the area where the graphics normally appears, similar to the panel for the Parameter Manager. There are two tabbed windows:

- Winding Data
- Slot Data

At the top will be the name of the Winding Tool, and the filename (and path) of the Winding Table File (if it has been given). At the bottom of the panel are four buttons:

- **Clear**: Gives you the option to clear the Winding Table, and the filename if it exists.
- **Save**: Allows you to save the Winding Table to a file
- **Refresh**: Gives you the option to reload the table back from an already assigned file. If no filename has been provided, this does nothing.
- **Close**: Allows you to close the Winding Table Editor. If you have made changes, you are given the option of saving first. You can then turn it back on via the View Winding Table property.

Winding Data

In between the names at the top and the buttons at the bottom, the information in the Winding Table is displayed in columns corresponding to the columns described in the section Winding Table File. You will note that comments (phase name starting with a "#") are displayed in green and invalid values are displayed in red. If the file was read from an external file and there was missing data, those positions display as three consecutive question marks (???). If you right click on a row in the table, you are given several options:

- **Add Row**: Inserts a row in front of the current row
- **Delete Row**: Deletes a row in front of the current row
- **Cut Row**: Cuts a row in front of the current row
- **Copy Row**: Copies a row in front of the current row
- **Paste Row**: Only offered if a row has been Cut or Copied, puts pasted row in front of current row.

To insert a row at the end, just click in the Phase cell of the row after the last one in the table. Once you have entered the Phase cell, the rest of the row is able to be edited, unless you entered a comment ("#" at start of the phase). You will note that when new rows are inserted, or added at the end, an attempt is made to set default values based on the values in neighboring rows.
Example 9  Winding Data Tab in DesignModeler

Slot Angles

By default, the slot angles are equally spaced in a full circle, with the spacing based on dividing 360 by the number of slots. Anytime you change the number of slots, this spacing is adjusted based on the above formula, and any custom angles you have entered are lost. If you want to change the angles, then when the Winding Table is being displayed via View Winding Table, you can click on the Slot Data tab to view the slot angles.

Here, you will see the angle of each slot, as measured from the first slot (S1). This way, if you change the Slot Angle property, all the other slots will rotate with it. All slot angles must be greater than 0.0° and less than 360.0°.

Also, to preserve the numbering order, slot angles must always be greater than the previous slot angle and less than the following slot angle. Angles entered that do not meet these requirements will not be accepted.

Finally, remember that anytime you change the number of slots, or click on the Clear button here, the values in this table will revert to equal spacing around a circle.

Example 10  Slot Data Tab in DesignModeler

Pattern
The **Pattern** feature allows you to create copies of faces and bodies in three patterns:

- **Linear**: a direction and offset distance is required.
- **Circular**: a rotation axis and angle are required.
- **Rectangular**: two sets of directions and offsets are needed.

For face selections, each connected face set is patterned independently of other face sets. For a face pattern to succeed, the copied instance of the face set must remain coincident with the body it originated from, or be able to be easily extended to it. The new faces of the pattern must touch the topological entities that were incident to the original face set, also known as the base region. Additionally, the instances for face sets may not intersect each other or the original face set. The faces may belong to either active or frozen bodies. An example of the base region is shown below.

**Example 11 Base Region**

All instances of the pattern faces selected in the picture on the left must lie in the base region highlighted in the picture on the right. Note that this means the instances may not intersect the hole where the original pattern faces reside.

There are no such restrictions for selected bodies. Solid, surface, and line bodies are all acceptable. If the selected bodies are active, then the patterned copies will be added to the model as active bodies and merged with other active bodies. For selected bodies that are frozen, their instances will be added to the model as frozen bodies.

The properties of the **Pattern** feature are:

- **Pattern Type**: Defines either a Linear, Circular, or Rectangular pattern. The default setting is Linear.
- **Geometry**: An Apply/Cancel type selection property that accepts face and body selections.
- **Direction**: The direction for a Linear pattern, or the first of two directions for a Rectangular pattern.
- **Offset**: The offset distance for a Linear pattern, or the first of two offsets for a Rectangular pattern. This is the distance between each instance of the pattern. Its value must be non-zero.
- **Axis**: The rotation axis for a Circular pattern. The axis may be any straight 2D sketch edge, 3D model edge, or plane axis.
- **Angle**: The rotation angle for a Circular pattern. This is the angle between each instance of the pattern. If the value of this property is 0°, then DesignModeler will automatically calculate the angle necessary to
evenly space the patterns about the rotation axis, and you will see “Evenly Spaced” indicated in the property instead of a numerical value. The default value for Angle is 0°.

- **Copies**: The number of copies to create for Linear and Circular patterns. For Rectangular patterns this is the number of copies to create in the first direction. Its value must be positive. The default value is 1.

- **Direction 2**: The second of two directions for a Rectangular pattern.

- **Offset 2**: The second of two offset distances for a Rectangular pattern. This is the distance between each instance of the pattern in the second direction. Its value must be non-zero.

- **Copies 2**: The number of copies to create in the second direction for Rectangular patterns. Its value must be positive. The default value is 1.

**Example 12 Linear patterns**

**Example 13 Circular patterns**
Example 14 Rectangular patterns

Body Operation

The Body Operation feature allows you to manipulate bodies. Any type of body can be used with body operations, regardless of whether it is active or frozen. However, point feature points (PF points), attached to the faces or edges of the selected bodies, are not affected by the body operation.

The Body Operation feature is available via the Create menu. It has up to eight options, although not all of them will be available at all times. For selections, bodies are selected via the Apply/Cancel property in the Details View. Planes are also selected via Apply/Cancel properties. The options are:

Mirror

You select bodies and a mirror plane. Upon clicking Section: Generate, DesignModeler will create copies of the selected bodies that are reflections of the original bodies in the mirror plane. Active bodies that are reflected will be merged with the active model, whereas frozen bodies that are reflected will not. By default, the mirror plane is initially the active plane.

Example 15 Mirroring in XYPlane

This body is selected to be mirrored in the XYPlane:
After generating:

Move

Select bodies and two planes—a source plane and a destination plane. Upon clicking Section : Generate, DesignModeler will transform the selected bodies from the source plane to the destination plane. This is especially useful for aligning imported or attached bodies. Typically, these planes will be planes created from the faces of the bodies at hand.

Example 16 Aligning Imported/Attached Bodies

Two imported bodies that do not align properly:
The cap is moved using Body Operation’s Move option:

**Copy**

The exact same as the Move option, except that copies of the bodies are moved while the original bodies remain unaltered.

**Delete**

Use to select bodies to delete from the model.

**Scale**

Use to select bodies to scale, then select a scaling origin through the Scaling Origin property. This property is a combination box with three options:

- **World Origin**: The origin of the world coordinate system is used as the scaling origin.
- **Body Centroids**: Each selected body is scaled about its own centroid.
- **Point:** You can select a specific point, either a 2D sketch point, 3D vertex, or PF points, to use as the scaling origin.

**Example 17  Scaling about centroids**

The selected bodies will undergo a scaling operation about their centroids:

The bodies after scaling them about their centroids by a scale factor of 2x:

The final three **Body Operation** types are designed to use bodies in Boolean operations, similar to the material types used in other features. You may choose whether you wish to keep or destroy the bodies you have chosen for the Boolean operation through the Preserve Bodies property. The default value for Preserve Bodies is No.

**Cut Material**

You select bodies to use in a cut operation that is performed on the active bodies in the model. Body Operation's Cut Material option works the same way as Cut Material does for any of the basic features. This option is available when active bodies exist in the model.

**Example 18  Cutting to form a mold**

A body is selected to cut into the block to form a mold:
Imprint Faces

You select bodies to use in an imprint operation that is performed on the active bodies in the model. Body Operation's Imprint Faces option works the same way as Imprint Faces does for any of the basic features. This option is available when active bodies exist in the model.

Example 19 Imprint faces of a block

In this example of an imprint operation, the selected body is used to imprint the faces of the block:
**Slice Material**

You select bodies to use in a slice operation that is performed on a completely frozen model. Body Operation’s **Slice Material** option works the same way as **Slice Material** does for any of the basic features. This option is available only when all bodies in the model are frozen.

**Example 20 Slicing a block**

An example of a slice operation where a body is selected to slice the block:

![Image of a slice operation](image)

**Slice**

The **Slice** feature improves the usability of DesignModeler as a tool to produce sweepable bodies for hex meshing. As with the **Slice Material** operation, the **Slice** feature is only available when the model consists entirely of frozen bodies.

The **Slice** feature is available via the Create Menu and has two options:

- **Slice By Plane**: Select a plane, and the model will be sliced by this plane.
- **Slice Off Faces**: Select faces on the model, presumably forming some concavity; and DesignModeler will “slice off” these faces.

*Note* — Internally the **Slice Off Faces** feature is very similar to **Face Delete**. In **Face Delete**, the selected faces are removed from the model and deleted. Afterwards, the engine will attempt to heal the remaining bodies. In **Slice Off Faces**, the selected faces are also first removed from the existing model, only then they are not deleted, but rather, DesignModeler will attempt to create new bodies out of the sliced-off faces. An important similarity between **Slice Off Faces** and **Face Delete** is that both operations involve model healing, and the engine may not be able to determine a suitable extension to cover the wound left by the removed faces. If so, then the feature will report an error stating that it cannot heal the wound.

For example, suppose you are using an .agdb file, as illustrated below. Since you want to slice it in order to make the model sweepable, immediately set the Import’s Operation Type to Add Frozen. Select the faces you want to “slice off,” then bring down the Section : Create Menu and select Section : Slice.
Hit Section : Generate, and see how the model is sliced into different bodies. Note that, in these screen shots, we show the frozen bodies in a “solid” manner. By default, DesignModeler is showing frozen bodies in a translucent manner (but you can change this behavior through an option in the Section : View Menu.)
Slice Targets Property

When using the Slice By Plane option, there is an additional property called Slice Targets. This allows you to specify the bodies that are subjected to the slice operation.

For example, you might wish to slice a body by a plane, but do not want to slice all bodies by it. Slice Targets is a combination box with two options:

- **All Bodies**: The plane slices all frozen bodies. This is the default option.
- **Selected Bodies**: Only the selected bodies are sliced by the plane. If this option is chosen, an Apply/Cancel property will appear to facilitate body selection.

As illustrated below, a Slice By Plane will operate only on the selected body.
After generating the **Slice** feature, only the selected body got sliced.

**Face Delete**

Use the **Face Delete** feature to undo features such as blends and cuts by removing faces from the model and then healing it to patch up the holes left behind by the removed faces. **Face Delete** can be used to remove unwanted features from imported models. It can be used for defeaturing and refeaturing of imported models; remove a feature, such as a hole, and recreate in DesignModeler in order to get it parameterized. Use of the feature is graphically illustrated below.

During feature creation of **Face Delete**, you may select faces and 3D edges. The 3D edge selection is only there to assist in selecting the faces with use of the Section: Flood Area selection extension. **Face Delete** works by attempting to remove groups of adjacent selected faces from the model, and heal the resulting “wound.” You should select the faces such that upon removing these groups, the surrounding geometry can extend to cover the wound(s) left by the removed faces. If a suitable extension cannot be determined, the feature will report an error stating that it cannot heal the wound.

Suppose you wanted to delete the blends and cavity from this model.
Using the **Face Delete** feature, select these four highlighted faces.

The result is no blends or cavities.
Concept Menu

Lines From Points
Lines From Sketches
Lines From Edges
3D Curve
Split Line Body
Surfaces From Lines
Surfaces From Sketches
Cross Section
Rectangular
Circular
Circular Tube
Channel Section
I Section
Z Section
L Section
T Section
Hat Section
Rectangular Tube
User Integrated
Use the features in the **Concept Menu** to create and modify beam models. To begin Concept Modeling, you can either create line bodies using the `Section : Construction Point` and `Section : Line` features in the `Section : Draw` Toolbox to design a 2D sketch and generate a 3D model, or use the `Section : Import External Geometry File` feature. Line Bodies can be created using either method.

The following feature options are available under the **Concept Menu**:

- `Section : Lines From Points`
- `Section : Lines From Sketches`
- `Section : Lines From Edges`
- `3D Curve`
- `Section : Split Line Body`
- `Section : Surfaces From Lines`
- `Section : Surfaces From Sketches`
- `Section : Cross Section`

Using the `Section : Model Appearance Controls`, you can modify your model’s cross section assignments and alignments before body grouping. Use the `Section : Form New Part` feature to group bodies.

Video demos are available on the use of the **Concept Menu**.

### Lines From Points

The **Lines From Points** feature allows the creation of Line Bodies in DesignModeler that are based on existing points. Points can be any 2D sketch points, 3D model vertices, and point feature points (PF points). The feature’s selections are defined by a collection of point segments. A point segment is a straight line connecting two selected points. The feature can produce multiple line bodies, depending on the connectivity of the chosen point segments. The formation of point segments is handled through an Apply/Cancel property.

#### Point Segments

Each Line Body edge is defined by a line connecting two points, forming a segment. The two points may be any combination of 2D sketch points, 3D model vertices, and PF points. Point Segment selection is performed in two ways:

- **Point Pairs**: Each segment is formed by selecting pairs of points. For every two points selected, one point segment is formed.

- **Point Chains**: Point Segments are formed in a continuous chain by selecting a chain of points. The first segment is defined by the first two points selected. Thereafter, each additional point selection defines another segment, using the end of the previous segment as the start of the next segment.

As you select point segments, green lines will appear on screen indicating that a segment has been formed. To remove a point segment, simply reselect the two points that define the segment and the segment will disappear. To lock in your point segment selection, click the Apply button. All point segments highlighted in green will now turn blue to indicate they’ve been locked in.

The **Lines from Points** feature starts off in Point Pairs selection mode by default. To change selection modes, use the right mouse button context menu.
Adding Line Bodies Created by Point Segments

The Operation property allows you to add the Line Bodies created by the feature to the model as either active or frozen, as illustrated below. The default setting is Add Material.

![Image](image-url)

Lines From Sketches

The **Lines From Sketches** feature allows the creation of Line Bodies in DesignModeler that are based on base objects, such as sketches and planes from faces. The feature creates Line Bodies out of all sketch edges contained in the selected base objects. Multiple line bodies can be created, depending on the connectivity of the edges within the base objects.

You can select sketches and planes from faces via the **Tree Outline** and lock in the selections through the Base Objects Apply/Cancel property.

Multiple sketches, planes, and combinations of sketches and planes can be used as the Base Object for the creation of line bodies.

Adding Line Bodies Created by Lines From Sketches

The Operation property in the Details View allows you to add the Line Bodies created by the feature to the model as either active or frozen, as illustrated below. The default setting is Add Material.
Lines From Edges

The **Lines From Edges** feature allows the creation of Line Bodies in DesignModeler that are based on existing model edges. The feature can produce multiple line bodies, depending on the connectivity of the selected edges and faces. You can select 2D sketch edges, 3D model edges, and faces through two Apply/Cancel properties:

**Edges**

Line Body edges can be created from a combination of 2D sketch edges and 3D model edges.

**Faces**

Line Body edges are created from the boundary edges of each selected face.

**Adding Line Bodies Created by Lines From Edges**

The Operation property allows you to add the Line Bodies created by the feature to the model as either active or frozen, as illustrated below. The default setting is Add Material.
Edge Joints

When the Lines From Edges feature executes, shared topology is created between the new line edges and the original model edges that created them. Edges marked as shared are called edge joints, and are viewable by turning on edge joint display (see Show Edge Joints). Two additional properties list the results of the Lines From Edges operation:

- **Edge joints generated**: This tells you the number of edge joints that the Lines From Edges feature created.
- **Expired edge joints**: This will inform you of any edge joints that have expired due to model changes. If any edges in an edge joint are modified in any way, then the edge joint will become expired and no longer appear when viewing the edge joints. This property is not displayed if there are no expired edge joints for a Line From Edges feature.

3D Curve

The 3D Curve feature allows the creation of line bodies in DesignModeler that are based on existing points or coordinates. Points can be any 2D sketch points, 3D model vertices, and point feature points (PF points). Coordinates are read from text files. The feature's selections are defined by a collection of points in a chain. The curve passes through all points in the chain. All points in the chain must be unique. The 3D Curve feature can produce multiple curves when reading the data from files.

Use the context menu to help define the 3D Curve:

- **Closed End**: connects the last point to the first point to form a closed curve.
- **Open End**: forces a closed curve to be open again.
- **Clear All Points**: removes all points from the chain.
- **Delete Point**: allows you to remove a point from the chain.

The feature is useful for creating curves that may be used as a Named Selection base object.

A coordinate file must be a simple text file in the following format:

1. After a pound sign (#), everything else on that line is considered a comment and is ignored.
2. Empty lines are ignored.
3. Data consists of five fields, all on one line, separated by spaces and/or tabs:
   a. Group number (integer)
   b. Point number (integer)
c. X coordinate
d. Y coordinate
e. Z coordinate

4. A data line with the same Group number and Sequence number as a previous data line is an error. A data line cannot contain the same Group number and Sequence number as a previous data line.

5. For a closed curve, the point number of the last line should be 0. In this case, the coordinate fields are ignored.

Example 21 Coordinate File

The number format is Group number, Sequence number, then X Y Z all delimited by spaces.

Group 1 (open curve)

1 1 10.1234 15.4321 20.5678
1 2 15.2468 20.1357 25.1928
1 3 5.5555 6.6666 7.7777

Group 2 (closed curve)

2 1 100.0101 200.2021 15.1515
2 2 -12.3456 .8765 -.9876
2 3 11.1234 12.4321 13.5678
2 0

Split Line Body

The Split Line Body feature allows you to break Line body edges into two pieces. The location of the split is controlled by the Fraction property, which determines where along the edge the split should occur. The edges selected for the operation must come from active bodies. Section: Cross Section Alignment of the edges being split will be passed to the split edges. Those edges with just default alignments will continue to have default alignments, which will normally be +Z unless that is invalid, in which case +Y is used.

The value for Fraction specifies the ratio between the distance from the start point of the edge to the split location and the overall length of the edge. For example, a Fraction value of 0.5 will split the edge into two edges of equal length, each edge being half the length of the original edge. A Fraction value of 0.75 will split the edge into two edges where the first edge is three quarters the length of the original edge and the other edge is only one quarter the length of the original edge. The default value for Fraction is 0.5.

The Split Line Body feature may be applied only to Line body edges that are not used in a Section: Surfaces From Lines operation. The reason for this is that the line splitting operation destroys the original edge to create two new edges. Once the original edge is destroyed, any associativity between it and surface body edges is lost. If you wish to both split an edge and use it to create a surface body, it is recommended that you split the edge first, then use the two resultant edges in a subsequent Section: Surfaces From Lines feature.
As an example, two edges of this line body are selected to be split:

The Split Line Body feature is generated using the default 0.5 Fraction value, then a cross piece is created between the two split locations using the Section : Lines From Points feature:

Afterwards, if the Fraction value is changed to 0.25 and the model is regenerated, it would produce this result:

Surfaces From Lines

The Surfaces From Lines feature allows the creation of Surface bodies in DesignModeler that use Line body edges as the boundary. Line body edges should be chosen such that they produce non-intersecting closed loops. Each closed loop will create a frozen surface body that contains a single face. The loops should form a shape such that a simple surface can be inserted into the model. Examples of simple surfaces are planes, cylinders, tori, cones, and spheres. Simple twisted surfaces can also be created. After a surface has been generated, you can choose to flip the normal of the surface by setting Flip Surface Normal to Yes. You can also choose to set thickness in the Section : Details View.

Illustrated below is an example of a planar surface.
Illustrated below is an example of a twisted surface.

Note that sometimes it is impossible to generate a single surface that will span the closed profile of Line Body edges. In these cases, DesignModeler may still generate a surface body consisting of multiple faces. When this happens, the faces that get generated are not guaranteed to remain persistent. By modifying the source edges used in the feature, there is no guarantee that the same number of faces will get created or stay in the same location on the Line Body. The **Surfaces From Lines** feature will be marked with a warning alerting you of this occurrence.

Illustrated below is an example of a Surface Body containing multiple, non-persistent faces.

**Edge Joints**

When the Section : Surfaces From Lines feature executes, shared topology is created between the new surface body edges and the original line edges that defined the surface. Edges marked as shared are called edge joints, and are viewable by turning on edge joint display (see Section : Show Edge Joints). Two additional properties list the results of the Section : Surfaces From Lines operation:
• **Edge joints generated**: This tells you the number of edge joints that the Section : Surfaces From Lines feature created.

• **Expired edge joints**: This will inform you of any edge joints that have expired due to model changes. If any edges in an edge joint are modified in any way, then the edge joint will become expired and no longer appear when viewing the edge joints. This property is not displayed if there are no expired edge joints for a Section : Surfaces From Lines feature.

**Surfaces From Sketches**

The **Surfaces From Sketches** feature allows the creation of surface bodies using sketches as their boundary. Both single and multiple sketches may be used as the base objects for this feature. Base sketches must include closed profiles and may not be self-intersecting. The **Surfaces From Sketches** feature is located in the **Concept Menu**, and has two operations: add material and add frozen. After a surface has been generated, you can choose to adjust the normal of the surface. By default, the normal will be aligned to the plane normal. You can change this by setting **Orient with Plane Normal** to **No** in the Details View. You can also adjust the thickness of the surface in the Details View.

An example of **Surfaces From Sketches** is shown below. Before:

![Before](image)

After:

![After](image)
Cross Section

- Lines From Points
- Lines From Sketches
- Lines From Edges
- 3D Curve
- Split Line Body
- Surfaces From Lines
- Surfaces From Sketches
- Cross Section
  - Rectangular
  - Circular
  - Circular Tube
  - Channel Section
  - I Section
  - Z Section
  - L Section
  - T Section
  - Hat Section
  - Rectangular Tube
  - User Integrated
Cross sections are attributes assigned to line bodies to define beam properties in Simulation. In DesignModeler, cross sections are represented by sketches and are controlled by a set of dimensions. You may only modify the dimension values and dimension locations of a cross section; they are not to be edited in any other way. The eleven cross section types supported in DesignModeler correspond directly to specialized beam section types used in the ANSYS environment.

**Coordinate Systems for Cross Sections**

It should be noted however, that DesignModeler uses a different coordinate system for cross sections compared to the one used in the ANSYS environment, as shown in the picture below. In DesignModeler, the cross section lies in the XY Plane and the Z direction corresponds to the edge tangent. In the ANSYS environment, the cross section lies in the YZ plane and uses the X direction as the edge tangent. This difference in orientation has no bearing on the analysis.

![Coordinate Systems](image)

**Editing Cross Sections**

Cross section dimension values and locations are editable. To edit the value of a cross section dimension, select the cross section in the Tree Outline. The Details View will display a list of dimensions as shown below. New values may be entered into the dimension properties. Cross section dimensions may not be deleted nor renamed. If you input an invalid dimension value for a cross section, an error will pop up.

To change a cross section dimension’s location, use the right mouse button option, Section : Move Dimensions, available when right clicking on the cross section in the Tree Outline or when right clicking in the graphics.
window when viewing a cross section. DesignModeler will enter a dimension moving state, identical to the tool used to move dimensions in the Section : Dimension Toolbox in Sketching Mode. When you are done moving dimensions on the cross section, the Move Dimensions state is ended by clicking on another item in the Tree Outline or by clicking the Section : New Selection button.

Note that for Section : User Integrated cross sections, the Move Dimensions option does not appear because there is no sketch representation for cross sections of this type.

**Cross Section Assignment**

To assign a cross section to a line body, first select the line body in the Tree Outline. In the Details View will appear a Cross Section property. At first, all line bodies will have no cross sections until you assign them. When a line body has no cross section assigned to it, the Cross Section property will appear in yellow as “Not Selected.” Next select the cross section to be assigned to the selected line body from the drop-down menu available in the Details View. The drop-down menu will display all the cross section nodes added to the Tree Outline.

Note that the check mark on a line body will be yellow if no Cross Section is assigned or if a default alignment is being used. The check mark will be red if the alignment is invalid.

To make cross section assignment faster, you can also assign cross sections to multiple bodies at once. By using the [Ctrl] key or by using box selection, you can select multiple line bodies. In the Details View, you will see the number of line bodies selected at the top of the property group. Though the properties shown are specific to the first line body selected, the cross section assignment will apply to all selected bodies. Below is an example of what you would see when four line bodies are selected.
Cross Section Offset

After assigning a cross section to a line body, a new property will appear where you can specify the type of offset to apply. There are three choices:

- **Centroid**: The cross section is centered on the edge according to its centroid. This is the default setting.
- **Shear Center**: The cross section is centered on the edge according to its shear center. Note that for this setting, DesignModeler draws the body's edges the same way it does for Centroid. When analyzed, the shear center is used.
- **Origin**: The cross section is not offset and is taken exactly as it appears in its sketch.

Cross Section Alignment

Once cross sections are assigned and offset, they must be aligned to ensure they have the proper orientation. Line body edges appear as one of three colors in DesignModeler:

- **Violet**: line body edge has no cross section assigned.
- **Black**: line body edge has a cross section assigned and a valid orientation.
- **Red**: line body edge has a cross section assigned, but an invalid orientation.

For black line body edges, you'll notice that each one has a small alignment triad shown with it, as shown in the picture below. The blue arrow identifies the edge's tangent direction, while the green arrow represents the alignment vector. It is this green arrow that defines the +Y direction of the cross section on the edge. The green arrow is defined by a reference direction, which is set through an Apply/Cancel property for line body edges. A line body edge's alignment becomes invalid when its reference direction is parallel to the edge's tangent direction.

![Diagram showing cross section alignment](image)

By default, initially all line body edges are aligned in either the global +Z direction, or if that would be invalid, the global +Y direction. The text for this property will indicate if +Z or +Y is being used and will be colored if a valid alignment edge has not been selected. While a default alignment results in valid edge orientation for most line body edges, it does not necessarily mean the cross section is aligned in the desired manner. You should check the alignment arrows of your edges or inspect the line bodies with their solid facet representation to ensure that your cross sections have the desired alignment on the edges. See Viewing for more information on line body display modes.
Note — The icon on a line body will be yellow if no cross section is assigned or if a default alignment is being used (unless the cross section type is Section : Circular or Section : Circular Tube, where default alignment is considered acceptable). The icon will be red if the alignment is invalid. For more information see Section : Body Status

To set the line body edge's alignment, first select the edge in the graphics window. A property called Cross Section Alignment will appear in the Details View. If there is no alignment direction defined for the edge, then the property will appear in yellow as "Not Selected". Activating the Apply/Cancel buttons of this property will place you in an alignment selection mode, where you may select entities in the Tree Outline or from the graphics on screen to define a reference direction. The reference direction may be any of the types described in Section : Direction Reference, though usually plane normal directions are most often used. When you've selected the desired direction reference, you can assign it by clicking the Apply button. To preserve the previously assigned reference direction, click Cancel. To clear the reference direction from a line body edge, you can clear the selection, then click the Apply button. The direction reference will be cleared and the default global +Z or +Y direction will again be used.

You can also change the Alignment mode to Vector, and enter an X, Y, and Z direction for the alignment vector. When not in 'Vector' mode, these fields are used to show the direction of the current alignment selection (or default), though they will be read-only.

In addition to the default or specified alignment, you can also specify a 'Rotate' angle. This rotation will be applied after the alignment is processed. There is also now an option, 'Reverse Orientation?' If you set this to 'Yes,' it treats the edge as though it has been reversed. If you are displaying the triad, you will see that it displays at the opposite end, and that the X and Z axes directions have reversed. This also effects the direction of any additional 'Rotate' angle.

### Line-Body Edge

<table>
<thead>
<tr>
<th>Alignment Mode</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross Section Alignment</td>
<td>None (+Z by default)</td>
</tr>
<tr>
<td>Alignment X</td>
<td>0</td>
</tr>
<tr>
<td>Alignment Y</td>
<td>0</td>
</tr>
<tr>
<td>Alignment Z</td>
<td>1</td>
</tr>
<tr>
<td>Rotate</td>
<td>0°</td>
</tr>
<tr>
<td>Reverse Orientation?</td>
<td>No</td>
</tr>
</tbody>
</table>

Finally, when finished editing Cross Section Alignment properties, ESC, Section : Generate, or reselection the Select icon can be used to easily clear the Details View display.

**Select Unaligned and Invalid Line Edges**

When you choose one or more Line Bodies from the Tree Outline, and nothing else at the same time, along with the Hide and Suppress options, the right mouse button may present one or two additional options, Select Unaligned Line Edges and Select Invalid Line Edges. These options look through the Line Bodies you have selected and place any unaligned or invalid edges it finds into the selection set. Then it takes you to the option to change the alignment, just as though you had manually selected these Line Edges.

Note — Line Bodies with unaligned edges (or no Cross Section assignment) will be shown with a yellow check mark in the Tree Outline. If it has any edges with invalid alignments, it will have a red indicator. See Section : Cross Section for more information.
The table below illustrates the cross section alignment of an edge that is valid.

**Step One:** Select the line body edge you wish to align the cross section on.

**Step Two:** Activate the Apply/Cancel buttons for the Cross Section Alignment property.
Step Three: Select the desired direction reference by clicking in the **Tree Outline** or graphics window.

To make cross section alignment faster, you can also assign direction references to multiple edges at once. By using the [Ctrl] key or by using box selection, you can select multiple line body edges. In the Details View, you will see the number of line body edges selected at the top of the property group. Though the properties shown...
are specific to the first line body edge selected, the cross section alignment will apply to all selected edges. Below is an example of what you would see when four line body edges are selected.

![Line-Body Edges: 4]

<table>
<thead>
<tr>
<th>Alignment Mode</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross Section Alignment</td>
<td>None (+Z by default)</td>
</tr>
<tr>
<td>Alignment X</td>
<td>0</td>
</tr>
<tr>
<td>Alignment Y</td>
<td>0</td>
</tr>
<tr>
<td>Alignment Z</td>
<td>1</td>
</tr>
<tr>
<td>Rotate</td>
<td>0 °</td>
</tr>
<tr>
<td>Reverse Orientation?</td>
<td>No</td>
</tr>
</tbody>
</table>

### Cross Section Types

The 11 cross section types, similar to those supported in the ANSYS environment, provide a template of basic shapes to assist you in defining cross sections to be used in the model.

#### Rectangular

Data to be supplied in the **Rectangular** value fields: B, H

- B = Width
- H = Height

![Rectangular Cross Section]

#### Circular

Data to be supplied in the **Circular** value fields: R

- R = Radius

![Circular Cross Section]
Circular Tube

Data to be supplied in the **Circular Tube** value fields: Ri, Ro

- Ri = Inner radius of the tube.
- Ro = Outer radius of the tube.

Channel Section

Data to be supplied in the **Channel Section** value fields: W1, W2, W3, t1, t2, t3

- W1, W2 = Lengths of the flanges.
- W3 = Overall depth.
- t1, t2 = Flange thickness.
- t3 = Web thickness.
**I Section**

Data to be supplied in the **I Section** value fields: W1, W2, W3, t1, t2, t3

- W1, W2 = Width of the top and bottom flanges.
- W3 = Overall depth.
- t1, t2 = Flange thickness.
- t3 = Web thickness.

**Z Section**

Data to be supplied in the **Z Section** value fields: W1, W2, W3, t1, t2, t3

- W1, W2 = Flange lengths.
- W3 = Overall depth.
- t1, t2 = Flange thicknesses.
• \( t_3 \) = Stem thickness.

**L Section**

Data to be supplied in the **L Section** value fields: \( W_1, W_2, t_1, t_2 \)

• \( W_1, W_2 \) = Leg lengths.
• \( t_1, t_2 \) = Leg thicknesses.

**T Section**

Data to be supplied in the **T Section** value fields: \( W_1, W_2, t_1, t_2 \)

• \( W_1 \) = Flange width.
• \( W_2 \) = Overall depth.
• \( t_1 \) = Flange thickness.
• \( t_2 \) = Stem thickness.
Hat Section

Data to be supplied in the **Hat Section** value fields: $W_1, W_2, W_3, W_4, t_1, t_2, t_3, t_4, t_5$

- $W_1, W_2 = $ Width of the brim.
- $W_3 = $ Width of the top of the hat.
- $W_4 = $ Overall depth.
- $t_1, t_2 = $ Thicknesses of the brim.
- $t_3 = $ Thickness of the top of the hat.
- $t_4, t_5 = $ Web thicknesses.

Rectangular Tube

Data to be supplied in the **Rectangular Tube** value fields: $W_1, W_2, t_1, t_2, t_3, t_4$

- $W_1 = $ Outer width of the box.
• \( W_2 \) = Outer height of the box.
• \( t_1, t_2, t_3, t_4 \) = Wall thicknesses.

### User Integrated

Arbitrary: User-supplied integrated section properties instead of basic geometry data. Data to be supplied in the User Integrated value fields: \( A, I_{xx}, I_{xy}, I_{yy}, Iw, J, CGx, CGyz, SHx, SHy \)

- \( A \) = Area of section, must be greater than zero.
- \( I_{xx} \) = Moment of inertia about the x axis, must be greater than zero.
- \( I_{xy} \) = Product of inertia.
- \( I_{yy} \) = Moment of inertia about the y axis, must be greater than zero.
- \( Iw \) = Warping constant.
- \( J \) = Torsional constant, must be greater than zero.
- \( CGx \) = X coordinate of centroid.
- \( CGy \) = Y coordinate of centroid.
- \( SHx \) = X coordinate of shear center.
- \( SHy \) = Y coordinate of shear center.

**Note** — For User Integrated cross sections, there is no sketch representation. When displaying line bodies with their cross sections as solids, line bodies that use the User Integrated cross sections will have no solid representation.

### Deleting Cross Sections

Cross sections are deleted just like any other sketch, by selecting the item in the Tree Outline and pressing the Delete key, or by right-clicking the item in the Tree Outline and choosing the Delete option.

In order to delete a cross section, it must first be unused. That means the cross section cannot be assigned to any line body in the model.
Within ANSYS Workbench, parameters can be passed from application to application (e.g. Pro/ENGINEER to DesignModeler) and updated from ANSYS Workbench applet to applet (e.g. DesignModeler to Simulation). Once a parameter is created and uniquely named, it can be accessed through related applications/applets.

Information pertaining to parameters in DesignModeler can be categorized in five ways:

- Section : Parameters Windows
- Section : Creating Parameters
- Section : Parametric Expressions
- Section : Parametric Functions
- Section : Sending Parameters to Simulation

**Parameters Windows**

DesignModeler distinguishes between plane/sketch or feature dimensions and design parameters. A model easily contains hundreds of dimensions. It is not useful to consider all of them for parametric studies. Thus, DesignModeler allows you to “promote” a selected set of these to Design Parameters. The Parameters tool includes four tabbed windows:

- Design Parameters Tab
- Parameter/Dimension Assignments Tab
- Check Tab
- Close Tab

To display the Parameters windows, click on the Parameters feature in the toolbar or choose the Parameters menu item from the Section : Tools Menu. You can edit the text that appears in each window.

**Design Parameters Tab**

The text in the Design Parameters window lists the specified parameters and their values. The syntax is line-oriented, values can be specified using scientific notation (e or E) if needed, and comments can be added with the “#” sign.

![Design Parameters window](image)

Note that these Design Parameters will be filtered according to the Parameter Key that you specify on the Project Page.
See Sending Parameters to Simulation for information specific to the Project Page.

**Parameter/Dimension Assignments Tab**

The text in the **Parameter/Dimension Assignments** window lists a sequence of “left-hand-side = right-hand-side” assignments which are used to drive the model dimensions by the given **Design Parameters**.

The left-hand side is a reference to one of the plane/sketch or feature dimensions, or, optionally, a reference to an auxiliary “variable”.

The right-hand side is an arbitrary expression in +, -, e+, e-, *, and /, including parentheses, referencing **Design Parameters** (here, the syntax uses the “@” prefix) and feature dimensions, but also numeric constants or references to auxiliary variables and parametric functions. DesignModeler will evaluate the right-hand side of each expression, and use the resulting value to drive the dimension referenced in the left-hand side.

Plane/sketch dimensions are referenced by the plane’s name, followed by a period (“.”), followed by the dimensions name. The syntax for feature dimensions is as follows: feature name, followed by a period (“.”), followed by 'FD1,' 'FD2,' ... (“Feature Dimension 1,” “Feature Dimension 2,” ...) according to the Section : Details View of the corresponding dimensions property of the feature in question.

These expressions can also be used to make a dimension in one plane or feature drive the dimension of another plane or feature.
Check Tab

The Check tab triggers an execution of the Parameter/Dimension Assignments without updating the model. This can serve as a “syntax check” in case you are using nontrivial assignments.

The contents of the Check tab is a log output; it serves no other purpose -- editing it has no effect. The first column is the corresponding line number in the Parameter/Dimension Assignments text. The second column classifies the line into one of four types:

- **Comment**: for an empty or comment line
- **Plane Dim**: for a plane dimension assignment
- **Feature Dim**: for a feature dimension assignment
- **Variable**: for an auxiliary variable assignment

The next column is the assigned value; i.e., the result of the right-hand-side expression of the corresponding Parameter/Dimension Assignments. This is followed by a printout of the right-hand-side expression itself.

The log output will be interrupted in case of a “syntax” error. This includes errors where Design Parameters are references (“@” prefix) which do not exist.

Close Tab

The Close tab closes the Parameters text window, and returns to the model-only view.

Creating Parameters

You can also promote feature and sketch dimensions directly through the Section : Details View.
Feature and sketch dimensions contain check boxes next to their properties in the Section : Details View. When the check box is clicked, a popup dialog will appear which allows you to give the design parameter a name. **Design Parameter** names cannot contain spaces, nor special characters, nor can they begin with a numeric character. After clicking OK, DesignModeler creates the design parameter in the **Design Parameters** text window and then assigns the feature or sketch dimension to that design parameter in the **Parameter/Dimension Assignments** text window.

*Note* — Even though the pop-up dialog provides you with an unique default parameter name, it is recommended to rename the **Design Parameter** to something more fitting to your analysis.

Afterwards, the Section : Details View shows the letter “D” next to feature and sketch dimensions that are “driven” by design parameters. A driven feature or sketch dimension becomes read-only in the Section : Details View, since its value is now determined by the Parameter Manager. Parameter assignments can be cancelled by clicking the “D” check box again. This will comment out the assignment line in the **Parameter/Dimension Assignments** text window and clear the “D” that was in the check box. Clicking the check box will toggle the parameter assignment on and off. Once created, the design parameters themselves always remain unless deleted or commented out manually in the **Design Parameters** text window.

**Example 1  Toggling Parameter Assignment**

<table>
<thead>
<tr>
<th>D FD1, Depth (&gt;0) 30 mm</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“D” Checked</td>
<td>“D” Unchecked</td>
</tr>
</tbody>
</table>

*Note* — If you choose to promote the parameters of an Attach feature to DesignModeler Design Parameters, you will instead see a “P”. You cannot undo the operation, i.e., you cannot uncheck the “P” in this case. A CAD parameter cannot contain spaces, otherwise it will not be parsed correctly in the Parameter Manager.

By clicking the check boxes in the Section : Details View, **Design Parameters** can be easily enabled or disabled. However, if you choose to manually modify the contents of the **Design Parameters** or **Parameter/Dimension Assignments** text windows, you must ensure your changes are consistent among both windows. For example, if you wish to manually delete an entry in the **Design Parameters** text window, you must also delete all references to that entry in the **Parameter/Dimension Assignments** window. Use the **Check** tab to inspect your changes and help pinpoint errors, if any.
Once you have created **Design Parameters** to define your model, varying them is easy. Just change the **Design Parameter** values in the first text window, then click the **Check** window tab to verify your changes. Note that any features that are affected by the **Design Parameter** change will be marked as updated. Click Generate to update the model.

**Parameters Tutorial**

The basic steps used in adding **Design Parameters** to a model in DesignModeler are illustrated in Section : Process for Creating A Model.

**Parametric Expressions**

Parametric expressions involve operations among parameters and numbers such as addition, subtraction, multiplication, and division. The available parametric expressions for DesignModeler are listed in the table below.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
</tr>
<tr>
<td>—</td>
<td>Subtraction</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
</tr>
<tr>
<td>^</td>
<td>Exponentiation</td>
</tr>
<tr>
<td>%</td>
<td>Modulus; returns the remainder of x/y.</td>
</tr>
<tr>
<td>E+, E-, e+, e-</td>
<td>Scientific notation</td>
</tr>
</tbody>
</table>

Parentheses can also be used for clarity and for nesting operations. The order in which DesignModeler evaluates an expression is as follows:

1. Operations in parentheses (innermost first)
2. Scientific Notation (in order from left to right)
3. Exponentiation (in order from right to left)
4. Multiplication, Division, and Modulus (in order from left to right)
5. Unary association (such as +A or -A)
6. Addition and Subtraction (in order from left to right)
7. Logical Evaluation (in order from left to right)

*Note* — + or - must follow e/E in Parameter/Dimension Assignments tab but + need not follow e/E in Design Parameters tab as it is implied.

**Example 2 Parametric Expressions**

\[
X = A+B
\]

\[
P = (R1+R2)/2
\]

\[
D = B+E^2-4*A*C \text{ [Evaluates to } B + E^2 - 4AC]\]

\[
XYZ = A+B^2/C\%R \text{ [Evaluates to } A + ((B^2/C) \% R)]
\]
Ae+2 [Evaluates to A00.00] or AE-2 [Evaluates to 0.0A]

**Parametric Functions**

A parametric function is a sequence of operations that return a single value, such as SQRT(x), LN(x), or SIN(x). The available functions for DesignModeler are listed in the table below.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABS(x)</td>
<td>Absolute value of x.</td>
</tr>
<tr>
<td>EXP(x)</td>
<td>Exponential of x (e^x).</td>
</tr>
<tr>
<td>LN(x)</td>
<td>Natural log of x.</td>
</tr>
<tr>
<td>SQRT(x)</td>
<td>Square root of x.</td>
</tr>
<tr>
<td>SIN(x)</td>
<td>Sine, Cosine, and Tangent of x in degrees by default.</td>
</tr>
<tr>
<td>COS(x)</td>
<td></td>
</tr>
<tr>
<td>TAN(x)</td>
<td></td>
</tr>
<tr>
<td>ASIN(x)</td>
<td>Arcsine, Arccosine, and Arctangent of x. x must be between -1.0 and +1.0 for ASIN and ACOS. Output is in degrees by default. Range of output is -90 to +90 for ASIN and ATAN, and 0 to 180 for ACOS.</td>
</tr>
<tr>
<td>ACOS(x)</td>
<td></td>
</tr>
<tr>
<td>ATAN(x)</td>
<td></td>
</tr>
</tbody>
</table>

**Example 3  Parametric Functions**

- A = acos (-1) # Evaluates to -90
- B = abs (x) # Evaluates to |x|
- C = asin (sqrt (2) / 2)) # Evaluates to 45
- D = exp(ln(x)) # Evaluates to x

**Sending Parameters to Simulation**

When using .agdb files in Simulation, the entries in the Design Parameters text window appear as the CAD parameters in Simulation if their names contain the Parameter Key defined before starting the simulation. Most often, the Parameter Key is DS (default).

To send all Design Parameters to Simulation, make the Parameter Key blank before starting the simulation. Note that this should not be confused with the Parameter Key property used in Section : Import External Geometry File and Section : Attach to Active CAD Geometry features accessible via the Section : File Menu.

Note that when importing CAD models into DesignModeler, you can promote those CAD parameters to be Design Parameters in DesignModeler. However, if a CAD system contains multiple parameters with the same name, then only one of them can be promoted in DesignModeler.
Scripting API

The Scripting Application Program Interface (API) is beneficial for converting large files to geometry, or to create many similar parts by making simple changes to the script file.

This feature provides the option of running JScript files (extension .js) to create basic geometry in DesignModeler. Access to DesignModeler functions is accessible via the prefix 'agb.', as in the command:

```
var LF1 = agb.LinePt();
```

To execute one of these files, click Run Script in the File Menu. This opens a file browser window where you can select the file to run.

Note — Although JScript is case sensitive, an error message is not generated when an inaccurate variable is entered. JScript allows mixed-case variables by the same name to coexist.

Creation Limits

Bound by the definitions in script, some items can be created via a single command, while others take multiple commands for the full definition. In the multiple command cases, the first command creates the basic item or feature, then additional commands provide the additional required information. This additional information can be in the form of functions or properties of the base object, as noted in:

- Script Constants
- Script Features

For most of the multiple commands, an 'agb.Regen();' command is required to complete them. In these cases, the feature in not completely created until the Regen command is executed. If you are creating multiple features, you cannot simply put a single Regen() command after all of them. The Regen command must follow each feature definition as it completes the definition of that feature.

Special Constants

Some commands will require special constants as input arguments. These constants are accessed as 'agc.Name'. For example, when creating a Point feature, you need to provide the Point type and Definition type. Because there is only one form of the Point feature available in script, the following example script can be used to create a Point feature from a coordinate file.

```
var PF1 = agb.FPoint(agc.FpointConstruction, agc.FPointCoordinateFile);
PF1.CoordinateFile = "D:\Samples\SampleCoordFile.txt";
agb.Regen();
```

In this simple script, the basic Point feature (PF1) is created first, using constants to designate the type of Point feature to create. Next the “Coordinate File” property of the feature is set, giving the full path and name of the coordinate file to read. When the '\' is included in a text string, it is given twice, even though this represents just one '\' in the actual path. Finally the Regen() command completes the operation.

In general most features have a “Name” property. This allows you to set the name that will appear in the tree for this feature. For example, in the above sample, an additional line could be added to set the name that would appear in the tree:

```
PF1.Name = "BoxPoints";
```
Script Constants

Note — The codes using back slash paths listed below apply to the Windows operating system. UNIX
users must use forward slashes instead.

These must be prefixed with agc to be usable.

    // General
    agc.Yes
    agc.No

    // Material Mode
    agc.Add // Add Material
    agc.Frozen // Add Frozen

    // General Item Types
    agc.TypeBody // Body
    agc.TypeEdge3d // 3d Edge
    agc.TypeFPoint // Point from Point Feature

    // Point Feature Type
    agc.FPointConstruction // Construction Point

    // Point Feature Definition Type
    agc.FPointCoordinateFile // From Coordinate File

Script Features

Script features include two basic functions and five DesignModeler features. Complete descriptions of the features
are accessible by clicking on the feature name from the list below.

Functions

• Selection
• Point Access

Features

• Point
• Lines from Points
• Surfaces From Lines
• Cross Section
• Form New Part

Selection Functions

The selection functions are restricted to use with Surfaces From Lines and Form New Part from selected bodies.

• ClearSelections (): This clears all current selections.
• AddSelect(type, item): This adds the item, of the specified type to the current selections.
• GetNumIDEdges(ID): This returns the number of edges that match a given user ID.
• AddSelectEdgeID(ID, n): This adds the edge(s) that match the given ID to the current selections. The
  second argument 'n' is optional and is in the range 1-num, where num is the value returned by GetNum-
  mIDEdges. If supplied, it is used to specify that the 'n'th match of the ID is the only edge added. If there
is not an 'n'th match, then nothing is added. If the second argument is not provided, multiple edges can be added to the current selection. The ID is set in the AddSegment command for the Line From Points feature below. If it is not set, then its value is 0.

**Plane Access Functions**

- **GetXYPlane ()**: Returns pointer to the Fixed XY Plane.
- **GetZXPlane ()**: Returns pointer to the Fixed ZX or XZ Plane (see control panel).
- **GetYZPlane ()**: Returns pointer to the Fixed YZ Plane.
- **GetActivePlane ()**: Returns pointer to the currently active Plane.
- **SetActivePlane (plane)**: Sets the currently active Plane.

**Plane Features**

- **PlaneFromPlane(basePlane)**
- **PlaneFromPointEdge(point, edge)**
- **PlaneFromPointNormal(point, item1, item2, item3)**: For this call, item2 and item3 are optional depending on how you define the Normal. It can be with an edge, two points, or three points (a cross product is used).
- **PlaneFrom3Points(point1, point2, point3)**
- **PlaneFromCoord(x, y, z, i, j, k)**

**Properties**

- **Name**: Allows the feature to be named, e.g. "CenterPlane".
- **ReverseNormal**: Reverses/flips/inverts both the plane normal and X-axis.
- **ReverseAxes**: Reverses/flips/inverts both the X- and Y-axis of the plane.
- **ExportCS**: Exports the plane as a coordinate system into Simulation.

**Functions**

- **AddTransform(type, value, edge)**: Adds a transform to the plane. The value and edge arguments are optional, but may be needed by the transform type you select. Note that for transform types XformEdgeRotate and XformXAlignEdge you should include both the value and edge arguments.
- **GetOrigin()**: Returns the origin point of the plane.
- **GetXAxis()**: Returns the X-axis line of the plane.
- **GetYAxis()**: Returns the Y-axis line of the plane.

**Example**

```javascript
var PF1 = agb.FPoint(agc.FPointConstruction, agc.FPointCoordinateFile);
PF1.CoordinateFile = "E:\Onyx90\box8pt.txt";
agb.Regen(); //To insure model validity
var LF1 = agb.LinePt();
LF1.AddSegment(PF1.GetPoint(1, 1), PF1.GetPoint(1, 2), 1);
LF1.AddSegment(PF1.GetPoint(1, 2), PF1.GetPoint(1, 3), 2);
agb.regen();
var Yes = agc.Yes;
var No = agc.No;
```
var plxy = agb.GetXYPlane();
var pl4 = agb.PlaneFromPlane(plxy);
if(pl4)
{
    pl4.Name = "Batch_Plane";
    pl4.ReverseNormal = Yes;
    pl4.ReverseAxes = Yes;
    pl4.ExportCS = Yes;
    pl4.AddTransform(agc.XformZOffset, 9);
    pl4.AddTransform(agc.XformEdgeRotate, 30, LF1.GetEdge(1));
}
agb.regen();

var spt1 = PF1.GetPoint(1, 3);
var x,y,z;
x = agb.GetPointX(spt1);
y = agb.GetPointY(spt1);
z = agb.GetPointZ(spt1);

var pl5 = agb.PlaneFromCoord(x,y,z,1,2,3);
if(pl5)
{
    pl5.Name = "Batch_Coords";
    pl5.ReverseNormal = No;
    pl5.ReverseAxes = No;
    pl5.ExportCS = Yes;
}
agb.regen();

spt0 = pl4.GetOrigin();
var spt2 = PF1.GetPoint(2, 2);
var spt3 = PF1.GetPoint(2, 4);
var pl6 = agb.PlaneFrom3Points(spt0, spt2, spt3);
if(pl6)
    pl6.Name = "Batch_3_Pts";
agb.regen();

var pl7 = agb.PlaneFromPointEdge(spt2, LF1.GetEdge(1));
if(pl7)
    pl7.Name = "Batch_PT_Edge";
agb.regen();

var pl8 = agb.PlaneFromPointNormal(spt2, LF1.GetEdge(1));
if(pl8)
    pl8.Name = "Batch_PT_NORMAL_Edge";
agb.regen();

var pl9 = agb.PlaneFromPointNormal(spt2, PF1.GetPoint(1, 2), PF1.GetPoint(1, 3));
if(pl9)
    pl9.Name = "Batch_PT_Normal_2Pts";
agb.regen();

var pl10 = agb.PlaneFromPointNormal(spt2, PF1.GetPoint(1, 2), PF1.GetPoint(1, 3),
PF1.GetPoint(1, 4));
if(pl10)
    pl10.Name = "Batch_PT_Normal_3Pts";
agb.regen();

Point Access Functions

You can access points themselves via the Point Feature function PF.GetPoint. Then you can get the global coordinates of that point using these functions.

- **GetPointX (point)**: Returns the global X value of the point.
- **GetPointY (point)**: Returns the global Y value of the point.
- \texttt{GetPointZ (point)}: Returns the global Z value of the point.

**Point Feature**

- \texttt{FPoint(\text{Type, Definition})}

**Type Options**

- \texttt{agc.FPointConstruction}: Construction Point

**Definition Options**

- \texttt{agc.FPointCoordinateFile}: From Coordinate File

**Properties**

- **Name**: Allows the feature to be named, e.g. "BoxPoints"
- **CoordinateFile**: Allows the Coordinate File to be set, e.g. "D:\Samples\Box.txt"

**Functions**

- \texttt{GetPoint(\text{Group, Id})}: Allows access to a point defined by the Point feature. (See the Line from Points feature for an example of its use)

Note — Only a single Type and Definition are supported in script. This allows creation of a Point feature from a Coordinate File. The format of the coordinate file is described in the standard documentation for this feature. The required sequence is to define the feature, set its coordinate file, and then do a Regen(). Naming it is optional.

**Example**

```javascript
var PF1 = agb.FPoint(agc.FPointConstruction, agc.FPointCoordinateFile);
PF1.Name = "BoxPoints";  //This is not required
PF1.CoordinateFile = "D:\Samples\Box.txt";
agb.Regen();
//Here is how to get the coordinates of one of the points
var pt1 = GetPoint(1,1);
var x = agb.GetPointX(pt1);
var y = agb.GetPointY(pt1);
var z = agb.GetPointZ(pt1);
```

**Line from Points Feature**

- \texttt{LinePt()}

**Properties**

- **Name**: Allows the feature to be named, e.g. "TableTopLines"
- **Material**: \texttt{agc.Add} for 'Add Material' (default if not specified) and \texttt{agc.Frozen} for 'Add Frozen'

**Functions**

- \texttt{AddSegment(Pt, Pt, ID, x, y, z)}: Adds a segment to the Line feature, and optionally sets its ID and alignment. The ID and alignment are optional arguments. In order to supply the alignment, an ID
must be supplied. However, if the ID is zero, it will not be used. If during the creation of this feature this segment is split into multiple edges, each will get the specified ID and/or alignment, if specified.

- **GetNumBodies()**: This can only be used after a Line feature is created and Regen called. Gets the number of Line bodies created from the feature. This may not be the same as the number of segments added. It depends on how many segments are connected, or intersect, and if segments connect with segments from other Line features. Because of this the number can range from 0 to the number of segments added.

- **GetBody(index)**: This can only be used after a Line feature is created and Regen called. This is called with a value of 1 to the number returned by GetNumBodies.

- **GetNumEdges()**: This can only be used after a Line feature is created and Regen called. Gets the number of Line edges created from the feature. This may not be the same as the number of segments added. It depends on how many segments intersect other edges (this can create additional edges), and if segments overlap existing edges. A segment that totally overlaps an existing edge will not create any edge. Because of this the number can range from 0 to more than number of segments added.

- **GetEdge(index)**: This can only be used after a Line feature is created and Regen called. This is called with a value of 1 to the number returned by GetNumEdges.

### Line Body Function

- **SetCrossSection(cs)**: Assigns the Cross Section (cs) to the Line Body

The Line from Points feature can be created from existing points. These must be points defined by the Point feature. Naming it is optional. This feature can be created by either using AddSegment calls after creation function, LinePt(), or by putting the points in the selection list before calling LinePt(). If you put the points in the selection list first, via agb.AddSelect(agc.TypeFPoint, point), where GetPoint is used to get the point, there are two restrictions.

First, this method does not allow you to set the alignment vector. Second, a point can only be in the select list once, so this cannot be used if you need to use a point more than once. With either method, the feature is not complete until you issue the Regen() command.

#### Example

```javascript
var PF1 = agb.FPoint(agc.FPointConstruction, agc.FPointCoordinateFile); //Creates basic feature
PF1.Name = "TablePoints"; //This is not required
PF1.CoordinateFile = "D:\Samples\Table.txt";
agb.Regen(); //Feature not complete until this is done

var LF1 = agb.LinePt(); //Creates basic feature
LF1.Name = "TableTop";
LF1.AddSegment(PF1.GetPoint(1, 1), PF1.GetPoint(1, 2));
LF1.AddSegment(PF1.GetPoint(1, 2), PF1.GetPoint(1, 3));
LF1.AddSegment(PF1.GetPoint(1, 3), PF1.GetPoint(1, 4));
LF1.AddSegment(PF1.GetPoint(1, 4), PF1.GetPoint(1, 1));
agb.Regen(); //Feature not complete until this is done

var LF2 = agb.LinePt();
LF2.Name = "TableLegs";
LF2.Material = agc.Frozen; //Sets the Material property to Add Frozen
//The following commands also set the alignment for the created edges
//The zero value for the ID is because it is not used here
LF1.AddSegment(PF1.GetPoint(1, 1), PF1.GetPoint(2, 1), 0, 1.0, 0.0, 0.0);
LF1.AddSegment(PF1.GetPoint(1, 2), PF1.GetPoint(2, 2), 0, 0.0, 1.0, 0.0);
LF1.AddSegment(PF1.GetPoint(1, 3), PF1.GetPoint(2, 3), 0, -1.0, 0.0, 0.0);
LF1.AddSegment(PF1.GetPoint(1, 4), PF1.GetPoint(2, 4), 0, 0.0, -1.0, 0.0);
agb.Regen(); //Feature not complete until this is done

//Create Cross Section
var CS1 = agb.CSRect(6.0, 4.5); //Creates rectangular Cross Section 6 units wide by 4.5 units high
var CS2 = agb.CSLSect(4.0, 4.0, 0.5, 0.5); //Creates L section Cross Section
```
//Assign Cross Section to Line Bodies created
var num = LF1.GetNumBodies();
var i;
var body;
for(i=1; i<= num; i++)
{
    body = LF1.GetBody(i);
    if(body)
        body.SetCrossSection(CS1);
}
num = LF2.GetNumBodies();
for(i=1; i<= num; i++)
{
    body = LF2.GetBody(i);
    if(body)
        body.SetCrossSection(CS2);
}

Surface from Line Edges Feature

· SurfFromLines()

Properties

· Name: Allows the feature to be named, e.g. "Hood"

Note that for this feature, you must first use AddSelect(agg.TypeEdge3d, edge) to add the Line Edges you want to use to the selection set prior to invoking the SurfFromLines() function. The required sequence is to preselect the lines, define the feature, and then do a Regen(). Naming it is optional.

Example

//Points
var PF1 = agg.FPoint(agg.FPointConstruction, agg.FPointCoordinateFile);
PF1.CoordinateFile = "E:\Onyx81\box8pt.txt";
agg.Regen(); //To insure model validity

//Bottom
var LF1 = agg.LinePt();
LF1.AddSegment(PF1.GetPoint(1, 1), PF1.GetPoint(1, 2));
LF1.AddSegment(PF1.GetPoint(1, 2), PF1.GetPoint(1, 3));
LF1.AddSegment(PF1.GetPoint(1, 3), PF1.GetPoint(1, 4), 1); //Note setting ID=1
LF1.AddSegment(PF1.GetPoint(1, 4), PF1.GetPoint(1, 1));
agg.Regen();

var LF2 = agg.LinePt();
//Note these also set IDs
LF2.AddSegment(PF1.GetPoint(1, 3), PF1.GetPoint(2, 1), 2);
LF2.AddSegment(PF1.GetPoint(2, 1), PF1.GetPoint(2, 2), 3);
LF2.AddSegment(PF1.GetPoint(2, 2), PF1.GetPoint(1, 4), 4);

var i;
var edge;
var numb1 = LF1.GetNumEdges();
if(numb1 == 4)
{
    agg.ClearSelections();
    for(i=1; i<5; i++)
    {
        edge = LF1.GetEdge(i);
        agg.AddSelect(agg.TypeEdge3d, edge);
    }
    var surf1 = agg.SurfFromLines();
    agg.Regen();
}
//Now select using IDs
Cross Section Feature

The following commands are used to create Cross Sections in script. Complete descriptions of the features are accessible by clicking on the feature name from the list below

- **CSRect** \((B, H)\); Rectangular
- **CSCirc** \((R)\); Circular
- **CSCircTube** \((R_i, R_o)\); Circular (Hollow) Tube
- **CSSection** \((W_1, W_2, W_3, t_1, t_2, t_3)\); C Section
- **CSISection** \((W_1, W_2, W_3, t_1, t_2, t_3)\); I Section
- **CSZSection** \((W_1, W_2, W_3, t_1, t_2, t_3)\); Z Section
- **CSLSection** \((W_1, W_2, t_1, t_2)\); L Section
- **CSTSection** \((W_1, W_2, t_1, t_2)\); T Section
- **CSHatSection** \((W_1, W_2, W_3, W_4, t_1, t_2, t_3, t_4, t_5)\); Hat Section
- **CSRectTube** \((W_1, W_2, t_1, t_2, t_3, t_4)\); Rectangular (Hollow) Tube
- **CSUserInt** \((A, I_{xx}, I_{xy}, I_{yy}, I_w, J, CG_x, CG_y, SH_x, SH_y)\); User Integrated

**Properties**

- **Name**: Allows the feature to be named, e.g. "tube4x6"

**Example**

```javascript
var CS1 = agb.CSRect(6.0, 4.5);  //Creates rectangular Cross Section 6 units wide by 4.5 units high
CS1.Name = "Top";
```

**Form New Part (from All Bodies & Selected Bodies)**

- **FormNewPartFromAllBodies ()**;
- **FormNewPartFromSelectedBodies ()**;

**Properties**

- **Name**: Allows the part to be named, e.g. "Bracket"

These functions allow you to combine all bodies created by feature functions, or only those you added to the selection set, into a single part.
**DesignModeler Options**

To access the DesignModeler Options via the Tools menu:

1. From the main menu, choose **Tools > Options**. An **Options** dialog box appears and the DesignModeler options are displayed on the left.
2. Click on a specific option.
3. Change any of the option settings by clicking directly in the option field on the right. You will first see a visual indication for the kind of interaction required in the field (examples are drop down menus, secondary dialog boxes, direct text entries).
4. Click **OK**.

The following **DesignModeler** options appear in the **Options** dialog box:

- **Section : Geometry**
- **Section : Graphics**
- **Section : Miscellaneous**
- **Section : Toolbars**
- **Section : Units**
- **Section : Grid Defaults**

Other help descriptions available that describe the **Options** dialog box:

- Common Settings
- CFX-Mesh
- Simulation
- DesignXplorer
- Licensing

**Geometry**

The **Parasolid** category includes:

- **Transmit Version:** DesignModeler writes your model in Parasolid format when you Export using the *.x_t or *.x_b extension. The Geometry preference displays the Transmit version (16.0, 15.0, 14.0, 13.0, or 12.0) which is useful when you want to transfer your model into a third-party CAD program that uses a different Parasolid version. DesignModeler defaults to Transmit Version 15.0.

- **Body Validation:** The Body Validation allows you to select one of three values:
  1. **Always:** All bodies created by features are validated.
  2. **Import/Attach Only:** Only bodies created from Import and Attach features are validated (default).
  3. **Never:** No bodies are validated. Note that when this option is chosen, all Import and Attach features will produce a warning that informs you bodies have not been validated.

- **Problematic Geometry Limit:** This defines the maximum number of problematic geometries collected for a feature. The selectable range of the Problematic Geometry Limit is from 1 to 20, with 10 being the default.
The **CAD Options** category includes:

- **IGES Export Type**: Allows you to export solids or trimmed surfaces when exporting a model to an IGES file. The default is Solids.
- **Enable MCNP Options?**: Enables several features specific to MCNP operations:
  - Bodies will be renamed in DesignModeler when exporting to an MCNP file.
  - During MCNP export, Named Selections will be created for geometries that are invalid with respect to the MCNP format.
  - Material properties will be available for bodies created by a Primitive feature.
  - A warning will be generated for errors during MCNP export.

The **Selection** category includes:

- **Measure Selection Automatically**: allows you to select one of three settings:
  1. **Always**
  2. **Never**
  3. **Up to Limit**, in which case the limit is given in the next preference (default).

- **Measure Selection Limit (#faces/edges)**: specifying the maximum number of 3D (model) edges or faces to trigger automatic selection measurements.

The default setting for the **Section : Measure Selection** preferences is **Up to Limit**, and **Limit = 25**. They occur in two instances:

1. The Surface Area and Volume properties under the Detail View of a body
2. The (current) Selection Information area at the lower-right side of the screen (i.e., towards the right, on the status bar).

Selection measurements may be a CPU-intensive endeavor; especially (1) when selecting complex bodies (i.e., solids or surfaces) in the Tree View, and/or (2) when accumulating large and complex (model) face/edge selection sets, most probably via the Extend Selection toolbar buttons. The mentioned option settings allow you to influence DesignModeler’s behavior.

If automatic selection measurements are disabled - either due to the option setting Never or because of going “over” the specified Limit, then DesignModeler will skip the measurements. However, there will be a right mouse button Context Menu option **Measure Selection**, which will allow the user to compute the measurements on demand.

**Graphics**

The **Graphics** category includes:

- **Facet Quality**: You can control the quality of DesignModeler’s model facets. The Facet Quality setting is a number between 1 (lowest quality) and 10 (highest quality). The default setting is 5. Shown here, left to right, is an example of Facet Quality 10 and Facet Quality 1.
Setting the facet quality higher will improve the look of the model, but DesignModeler will take longer to generate model facets. Setting the facet quality lower will speed up facet generation, but reduce the visual quality of the model. Note that the Facet Quality setting does not affect the actual geometry of the model; it only affects how the geometry is displayed.

Note — It is strongly recommended that you use the default Facet Quality setting or lower with very large models. Model faceting is a memory intensive operation. With a high Facet Quality setting, the system may fail to generate facets due to insufficient memory.

The **Dimension Animation** category includes:

- **Minimum and Maximum Scale**: the amount that dimensions will animate relative to the original dimension. For example, values of 0.5 and 1.5 will cause the dimension to animate between 50% and 150% of its original size.

**Miscellaneous**

The **Display** category includes:

- **Startup Mode**: Modeling (Modeling/Sketching). You can choose which mode you would like DesignModeler to start in. The default is Modeling.

The **Files** category includes:

- **Folder for temporary files**: DesignModeler occasionally uses temporary files. Here you can specify a folder to put these files. The default is operating system dependent.
- **Auto-save Frequency**: This property defines how often DesignModeler performs an auto-save of the model. The choices are:
  - Every Generate
  - Every 2nd Generate
  - Every 5th Generate
  - Never Auto-save

  Note — Choosing the Never Auto-save option will disable Auto-save. The default frequency is Every 5th Generate.

- **Auto-save File Limit (per model)**: This is the number of Auto-save files stored for each model. You may choose a number between 5 and 20. The default is 10.
- **Delete auto-save files after... (days)**: This is the number of days that DesignModeler will keep auto-save files before automatically deleting them. The default is 60.
• **Max Recent File Entries:** This is the number of entries (1–10) that will show in the Recent AGDBs, Recent Imports, and Recent Scripts menus. The default is 5.

The **Features** category includes:

• **XZ-ZX Plane Direction for new parts:** Allows you to choose whether the second standard plane (along with XYPlane and YZPlane) is to be an **XZPlane**, with its normal being (0,-1,0), or a **ZXPlane** with its normal being (0,1,0). The default is **ZXPlane**.

• **Point Feature Limit:** This represents the maximum number of PF points allowed per Point feature. The default is 500.

The **Print Preview** category includes:

• **Image Resolution:** The quality of the screenshot image. Choices are Normal (default), Enhanced, and High (Memory Intensive).

• **Image Type:** The type of graphics image used for screenshots. Choices are PNG (default), JPEG, and BMP.

The **Input Devices** category includes:

• **Use Spaceball:** Set to No if you wish to disable support for the Spaceball device. The default is Yes. (Not supported in UNIX)

**Toolbars**

The Feature Toolbar is now customizable. You can specify which features will be available as icons in the Feature Toolbar. The **Show icon in Feature Toolbar...** categories control which icons will appear in the toolbar. Any feature that appears in any of the menus described above can be added to the toolbar by selecting Yes next to its name.

*Note* — The first icon in the Feature Toolbar is always the Generate button. This is hard-coded, and cannot be changed. Because the Feature Toolbar has limited screen real-estate, if you add too many icons in your customization, using Show Toolbar Texts = Yes, then the toolbar may be cutoff, and the last icons will “fall off” the screen.

The **Features: Show icon in Feature Toolbar...** category includes:

• **Section : Extrude:** The default is Yes.
• **Section : Revolve:** The default is Yes.
• **Section : Sweep:** The default is Yes.
• **Section : Skin/Loft:** The default is Yes.
• **Section : Thin/Surface:** The default is Yes.
• **Section : Blend:** The default is Yes.
• **Section : Chamfer:** The default is Yes.
• **Section : Pattern:** The default is No.
• **Section : Body Operation:** The default is No.
• **Section : Slice:** The default is No.
• **Section : Face Delete:** The default is No.
• **Section : Point:** The default is Yes.
• Concept Modeling: The default is No.
• Concept Modeling, Section: Cross Section: The default is No.

The **Tools: Show icon in Feature Toolbar...** category includes:

• Freeze: The default is No.
• Unfreeze: The default is No.
• Section: Named Selection: The default is No.
• Section: Joint: The default is No.
• Section: Enclosure: The default is No.
• Fill: The default is No.
• Surface Extension: The default is No.
• Winding Tool: The default is No.
• Parameters: The default is Yes.

**Units**

The **Units** category includes:

• **Length Unit**: reflects the current units selection. Millimeter is displayed by default but can be changed to your default unit of preference (Centimeter, Meter, Inch, Foot).

• **Display Units Pop-Up Window**: sets whether the Units pop-up window is displayed. The Units pop-up window appears when moving to DesignModeler from the Start Page and allows you to select a length unit at that point. The Units pop-up window includes an **Always use default** checkbox, which when checked, causes the Units pop-up window to not display upon subsequent moves to DesignModeler from the Start Page. By setting **Display Units Pop-Up Window to Yes** (the default), you can reset the Units pop-up window to appear upon subsequent moves to DesignModeler from the Start Page. The window is only viewable in the Workbench Mode.

**Grid Defaults**

The unit length reflects the current selection.

In the **Grid Defaults** category, note that each plane has its own grid settings, so you can set each plane's grids differently. The grid settings in the **Options** dialog box define what the default grid settings are for each new plane created. The **Grid Defaults** category includes:

• **Minimum Axes Length**: This allows you to set the default length of the axes for newly-created planes. The default size of the grid, if any, will always be twice this length. Note that this is just the minimum size. As items are created outside this range, the axes and grid will expand as needed. If these items are later deleted, the axes and grid can shrink back down to the Minimum Axes Length. The default varies depending on the units you choose.

• **Major Grid Spacing**: The setting for the number of units in between consecutive thick grid lines. The default varies depending on the units you choose.

• **Minor-Steps per Major**: This determines the number of thin grid lines per major line. The default varies depending on the units you choose.
- **Grid Snaps per Minor**: This allows you to specify intermediate snap locations between minor grid lines. The default is 1.

- **Show Grid (in 2D Display Mode)**: This allows you to show the grid in 2D by default. The default is No.

- **Snap to Grid (while in Sketching)**: This allows you to turn on Snap in 2D by default. The default is No.

- **Apply Grid Defaults to Active Plane**: By changing it to Yes, the grid defaults in the Options dialog box will be applied to the active plane. Note that this setting is always No when the Options dialog box is opened.

### Usage Examples

**Grid Snaps per Minor** in the Settings group allows you to specify intermediate snap locations between minor grid lines (1-1000). You can use this to reduce the density of the grid display, while still snapping to a tighter grid. For example, in millimeters if the **Major Grid Spacing** is set to 10, you can set the **Minor-Steps per Major** to 5, and the **Grid Snaps per Minor** to 2. This way, minor grid lines are displayed every 2 mm, but snapping is still to every mm.

Another way to use this function is to set this to a value such as 100 or 1000. This way, sketching does not appear to be snapping to a grid, but it actually is and the coordinates of your sketching are being snapped to 1/100th or 1/1000th of your minor grid line spacing. For example, if the minor grid lines are every inch and the **Grid Snaps per Minor** are set to 100, when sketching a point its coordinates will end up as numbers such as 8.36 or 5.27 instead of 8.35789584683938474 or 5.2713934933421 with no grid snapping at all.
CFX-Mesh Help
CFX-Mesh Help
# Table of Contents

## Overview of the Meshing Process .......................................................... 1–1
- Create the Geometry ................................................................. 1–1
- Define Regions ................................................................. 1–1
- Define the Mesh Attributes ....................................................... 1–2
- Create the Surface Mesh ......................................................... 1–2
- Create the Volume Mesh ......................................................... 1–2
- Mesh Adaption ............................................................................ 1–2

## Tutorials ....................................................................................... 2–1

## Graphical User Interface ................................................................. 3–1
- Tree View ................................................................................. 3–1
  - Suppressing Objects ........................................................... 3–3
  - Hiding Objects ....................................................................... 3–4
- Details View .............................................................................. 3–4
- Graphics Window ................................................................. 3–5

## Toolbars and Icons .................................................................... 3–5
- File Toolbar .............................................................................. 3–6
- Display Control, Mouse Actions, and the Rotation Modes Toolbar .................................................. 3–6
- Rotate Mode ............................................................................. 3–7
- Selection .................................................................................... 3–8
- Selection Filters ........................................................................ 3–9
- Point Selection ........................................................................... 3–10
- Selection Mode Toolbar, Box Select and Flood Select ................................................................. 3–11
- Display Toolbar ........................................................................ 3–11
- Triad ......................................................................................... 3–11
- Ruler ......................................................................................... 3–12
- Geometry Toolbar ...................................................................... 3–12
- Meshing Toolbar ......................................................................... 3–12
- Interrupt ....................................................................................... 3–12

## Menus .......................................................................................... 4–1
- File Menu ................................................................................. 4–1
  - Mesh Settings as CCL .......................................................... 4–1
- Tools Menu .............................................................................. 4–1
- View Menu .............................................................................. 4–2
- Go Menu ................................................................................. 4–2

## Geometry .................................................................................. 5–1
- Geometry Creation and Import .................................................. 5–1
  - External CAD formats .......................................................... 5–2
- Geometry Update ....................................................................... 5–4
- Geometry Requirements ........................................................... 5–5
  - General Geometry Requirements ........................................... 5–5
  - Multiple Bodies, Parts and Assemblies ................................ 5–6
  - Geometry and Topology for Solid Bodies .............................. 5–6
  - Bodies Joined by a Common Face .......................................... 5–6
  - Bodies Touching at a Face ....................................................... 5–7
  - Body with a Hole ..................................................................... 5–8
  - Body with an Enclosed Body .................................................. 5–8
  - Bodies with an Enclosed Body and a Hole .............................. 5–10
  - Body with an Enclosed Body Touching the Face .................... 5–11
  - Geometry and Topology for the Faces of Solid Bodies ............ 5–12
  - Non-Manifold Geometry ........................................................ 5–12
Overview of the Meshing Process

CFX-Mesh is a mesh generator aimed at producing high quality meshes for use in computational fluid dynamics (CFD) simulations. CFD requires the use of meshes which can resolve boundary layer phenomena and which satisfy more stringent quality criteria than structural analyses.

CFX-Mesh produces meshes containing tetrahedra, prisms and pyramids in standard 3D meshing mode, and additionally can include hexahedra in the Extrude 2D meshing mode. It produces output in the form of a CFX Section : CFX-Pre Mesh File, suitable for importing directly into CFX-Pre, the CFX-5 pre-processor. Extensive advanced surface and volume mesh generation controls are available, including:

- Section : Inflation
- Section : Controls
- Edge and Surface Proximity detection
- Parallel volume meshing

The steps to create a mesh are as follows:

1. Section : Create the Geometry
2. Section : Define Regions
3. Section : Define the Mesh Attributes
4. Section : Create the Surface Mesh
5. Section : Create the Volume Mesh

To access the ANSYS Workbench Help, see Section : Using Help.

Create the Geometry

You can create geometry for CFX-Mesh from scratch in DesignModeler within ANSYS Workbench, or import it from an external CAD file. CFX-Mesh requires you to construct Solid Bodies (not Surface Bodies) to define the region for the mesh. A separate Solid Body must be created for each region of interest in the CFD simulation: for example, a region in which you want the CFD solver to solve for heat transfer only must be created as a separate Solid Body. Multiple Solid Bodies are created in DesignModeler by use of the Freeze command; see Section : Freeze in the DesignModeler Help for more details.

There are some restrictions on the topology of your geometry. These are described in Geometry.

Define Regions

When you come to set up your CFD simulation, you will need to define boundary conditions on which to apply specific physics. For example, you may need to define where the fluid enters the geometry or where it leaves. Although it would be possible to select the faces which correspond to a particular boundary condition in CFX-Pre, it is rather easier to make this selection in CFX-Mesh. In addition, it is much better to define the location of periodic boundaries before the mesh is generated to allow the nodes of the surface mesh to match on the two sides of the periodic boundary, which in turn allows a more accurate CFD solution. You can define the locations of boundaries by creating Composite 2D Regions in the appropriate locations from within CFX-Mesh.
Define the Mesh Attributes

The mesh generation process in CFX-Mesh is fully automatic. However, you have considerable control over how the mesh elements are distributed, in order to ensure that you get the best CFD solution possible with your available computing resources. You can dictate the background length scale, and where and how it should be refined. In general, the process of setting up the length scale field for your mesh can be thought of as a three step process:

1. Assign a suitable background length scale (Section : Body Spacing).
2. Override the background length scale locally on faces and the regions close to them (Section : Face Spacing and Section : Proximity).
3. Override (1) and (2) locally where necessary using mesh Section : Controls.

In many simple cases, the need for mesh controls is removed by the setting of appropriate local face mesh spacings, Edge Proximity and Surface Proximity. These controls can be used in isolation, or in combination. Inflation is used to control the near-wall internal mesh distribution.

CFX-Mesh uses all the current Mesh Control settings to determine the appropriate size of the mesh in a particular region. In general, the element size is determined by the minimum length scale from all Mesh Controls, the local length scale from surface mesh parameters and global length scale.

Create the Surface Mesh

The surface mesh will always be generated prior to the volume mesh generation. However, it is often helpful to explicitly generate at least part of the surface mesh before volume meshing, to view it and ensure that the chosen length scales and controls will have the desired effect. Included in the surface mesh generation process is a mechanism called Section : Inflation for generating prism elements (and a small number of pyramids as required) near the walls. Inflation is used for resolving the mesh in the near wall regions to capture flow effects for viscous problems.

The surface mesh can be previewed before generating the volume mesh by using the Preview function. Preview Groups can be used to view the surface mesh on selected faces or the whole surface mesh can be generated in one go.

Two surface meshers, the Section : Delaunay Surface Mesher and the Section : Advancing Front (AF) Surface Mesher, are available for use.

Create the Volume Mesh

The standard volume mesher in CFX-Mesh is the Section : Advancing Front Volume Mesher. It allows automatic tetrahedral mesh generation using efficient mesh generation techniques.

An alternative volume mesher, the Section : Extruded 2D Meshing, is available for two-dimensional or simple extruded meshes.

The volume mesh is written to a CFX-5 Section : CFX-Pre Mesh File ready for import into CFX-Pre. It cannot be viewed in CFX-Mesh.

Mesh Adaption

The CFX-5 software allows you to refine your mesh automatically as the solution to your CFD calculation is obtained. This helps to ensure that a fine mesh is used where the solution is changing most rapidly. The set-up for
Mesh Adaption takes place in the CFX-Pre software, not in CFX-Mesh. Mesh Adaption can be used to improve a reasonable solution; it cannot be used to produce good solutions from a initial poor quality mesh, so you must still generate a reasonable mesh to begin with.
Tutorials

Click here to work through one or more step-by-step tutorials. Several tutorials are available to demonstrate the geometry and meshing steps for a number of computational fluid dynamics models. Each tutorial provides full instructions and leads directly into one of the CFX-5 Tutorial Examples provided in the CFX-5 User Documentation.

Note that the link above is an internet link to up-to-date tutorials, not to material stored on your computer. If internet access is not available from the machine you want to use, or if the speed of your connection is too slow for this to be convenient, then you can instead download the tutorial files as a package, put them on your local machine and view them locally. You may have to update this package when the tutorials are updated, particularly upon the release of a new version of CFX-5. An up-to-date package should be readily available from the CFX Community Website: go to http://www.ansys.com/cfx and follow the Community link. This site is available to all registered users. If you have not already got a username and password, go to http://www-waterloo.ansys.com/cfx/community/apply.htm to apply.

If you want to print out the tutorials, then we recommend that you follow the instructions above to download a package which is suitable for printing, and use this for printing from.

Please contact your local support representative if you have any difficulty in obtaining the tutorial package.
Graphical User Interface

The graphical user interface of CFX-Mesh is designed to be consistent with the user interface of DesignModeler. A snapshot is shown below. Click inside the yellow highlighted areas for links to a section containing more information about the item.

Also note that while using the software, pressing the F1 key over the Details View in CFX-Mesh will open up the CFX-Mesh online help at a relevant page (“context-sensitive help”).

Tree View

The Tree View, located towards the top left of the CFX-Mesh window, shows the current state of the mesh settings. The symbols to the left of each item's name are called Status Symbols and show the state of that particular item; their meanings are listed in the table below.
Graphical User Interface

- To delete an item from the tree, right-click on its name and select **Delete** from the context menu that appears.

- To rename an item, right-click on its name and select **Rename** from the context menu that appears. Any name must start with an alphabetic character, can be any length and can contain alphabetic characters, numbers and single spaces.

- To change the settings of an object, left-click on its name and then edit the information in the Section : Details View below.

- A plus symbol to the left of an item's icon indicates that it contains associated sub-items. Click on the plus symbol to expand the item and display its contents.

- To collapse an item, so that none of its sub-items are visible in the tree, click on the minus symbol to the left of the item's icon. To collapse all expanded items at once, double-click the Model name at the top of the tree.

- To insert a new sub-item, right-click on the item and select **Insert ...** from the context menu that appears. Some items are only allowed to appear once (e.g. Inflation, Stretch).

- To view all the items of a particular type, select the entry in the Tree View which contains them. The items will then be highlighted in the Graphics windows. For example, to view all Virtual Topology, click on the **Virtual Topology** heading in the Tree View. All Virtual Topology entities (Virtual Faces and Virtual Edges) will then be highlighted.

For Regions and Spacings, there is a slight exception to this general rule. If you click on the **Regions** heading in the Tree View, all Composite 2D Regions are highlighted except for the Default 2D Region. If you click on the **Spacing** heading in the Tree View, all Face and Edge Spacings are highlighted except for the Default Face Spacing. The Default 2D Region and Default Face Spacing are excluded as these contain all the faces which are not otherwise assigned explicitly to a user-defined Composite 2D Region or a user-defined Face Spacing; if they were included then the whole model would be highlighted when either of these headings were selected.

- Several items are in the tree by default when the meshing database is created, and these cannot be deleted or renamed. They include Region (with the Default 2D Region), Preview, Spacing (with the two default spacing objects), Controls, Periodicity, Inflation, Stretch, Proximity and Options.

### Status Symbols

Next to each item in the Tree View is a small symbol, known as a “Status Symbol”, that gives you information about the status of that item. The meanings of these are given in the table below.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Everything is valid.</td>
</tr>
<tr>
<td>✔</td>
<td>Everything is valid but the item has been automatically changed and you may wish to double-check the settings. This may occur, for example, if you have performed a geometry update which has resulted in a face no longer existing: if that face appeared in the location list for any mesh feature, then it will have been removed automatically as part of the update and so the mesh feature will be marked with this status symbol.</td>
</tr>
<tr>
<td>⚠</td>
<td>This means that there is something invalid about the definition of the item or one of its sub-items (which will also be marked with the same symbol). Often this will be because no required selection has been made.</td>
</tr>
<tr>
<td>✗</td>
<td>The item is suppressed (inactive).</td>
</tr>
<tr>
<td>☹</td>
<td>The item is suppressed and will be invalid when it is unsuppressed.</td>
</tr>
</tbody>
</table>
### Symbols and Meanings

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="✓" /></td>
<td>This status symbol only applies to Regions and Solid Bodies. Everything is valid but the item has been hidden in the Graphics window. When this status symbol is displayed, the item cannot be selected in the Graphics window; however, the item is not suppressed and will still be meshed (although the mesh can be displayed on the item only when the item is visible in the viewer).</td>
</tr>
<tr>
<td><img src="image" alt="⚡️" /></td>
<td>These status symbols only apply to Preview Groups. If the symbol underneath the yellow flash is a green tick, then the Preview Group is valid but either the mesh has not been generated or the generated mesh is out-of-date i.e. it does not reflect the current mesh settings. To generate an up-to-date mesh for the Preview Group, right-click over its name and choose Generate This Surface Mesh. To generate an up-to-date mesh on all Preview Groups, right-click over Preview in the Tree View and choose to Generate All Surface Meshes. If the symbol shows the yellow lightning bolt but the symbol underneath it is a yellow tick, then the Preview Group is both out-of-date (see above) and automatically changed. Refer to the table entry for a yellow tick symbol for details of what might cause an automatic change to a Preview Group. If the symbol shows the yellow lightning bolt but the symbol underneath it is a red exclamation mark, then the Preview Group is both out-of-date (see above) and invalid. You must make the Preview Group valid (by making a valid selection for its Location) before you can generate or regenerate it.</td>
</tr>
<tr>
<td><img src="image" alt="➕" /></td>
<td>This indicates that an item contains associated sub-items. Left-click on the symbol to expand the item and display its contents.</td>
</tr>
<tr>
<td><img src="image" alt="➖" /></td>
<td>Left-click on the symbol to close the item so that its contents are not visible in the tree.</td>
</tr>
</tbody>
</table>

### Supressing Objects

Items in the Tree View can be **suppressed**. This means that they become inactive. For instance, if you had set up an Inflated Boundary, but wanted to try generating the mesh without it, then you could suppress the Inflated Boundary, generate the mesh, and then, if required, simply unsuppress it to make it active again with the same settings as before.

Most items can be suppressed, including Inflated Boundaries, Face Spacings and Controls. You can also suppress higher-level objects. For example, you could suppress the entire Inflation entry to turn off Inflation, or suppress the entire Controls entry to suppress all of the Controls.

Note that if you suppress geometry (Parts or Bodies) then this hides them from the Graphics window and stops them from being included in the mesh. More details on how this affects the resulting mesh is given in Section: Suppression of Bodies and Parts.

A suppressed object still shows in the Tree View, but its Status Symbol will become gray to indicate its status. You must unsuppress an object before you can edit or delete it.

Items are suppressed by right-clicking on their names in the Tree View, and selecting **Suppress**. To unsuppress, right-click again and select **Unsuppress**.

In addition to **Suppress** and **Unsuppress**, users can also **Suppress All** (when multiple entities exist), **Unsuppress All** (when multiple entites exist), as well as **Invert Suppression** which inverts the state of the suppression for each entity at the same level in the Tree View.
**Hiding Objects**

Items in the Region section and Bodies in the Geometry section of the Tree View can be hidden. This means that they are not displayed in the Graphics window.

A face or edge that is part of Composite 2D Region or Body that is hidden cannot be selected; however, hiding an item does not exclude it from the meshing process and if, after meshing, the status of an item is changed from hidden to shown, the mesh can be displayed.

Note that if you suppress geometry (Parts or Bodies) rather than hiding it, then this hides the geometry from the Model View and stops it from being included in the mesh. More details on how this affects the resulting mesh is given in Section : Suppression of Bodies and Parts.

A hidden object still shows in the Tree View, but its Status Symbol will become a pale color to indicate its status.

Items are hidden by right-clicking on their names in the Tree View, and selecting **Hide**. To show again, right-click again and select **Show**.

In addition to **Hide** and **Show**, users can also **Hide All** (when multiple entities exist), **Show All** (when multiple entities exist), as well as **Invert Visibility** which inverts the state of the visibility for each entity at the same level in the Tree View.

### Details View

<table>
<thead>
<tr>
<th><strong>Inflation</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Inflated Layers</td>
</tr>
<tr>
<td>Expansion Factor</td>
</tr>
<tr>
<td>Number of Spreading Iterations</td>
</tr>
<tr>
<td>Minimum Internal Angle [Degrees]</td>
</tr>
<tr>
<td>Minimum External Angle [Degrees]</td>
</tr>
<tr>
<td>Inflation Option</td>
</tr>
<tr>
<td>Define First Layer By</td>
</tr>
<tr>
<td>First Prism Height [m]</td>
</tr>
<tr>
<td>Extended Layer Growth</td>
</tr>
<tr>
<td>Layer by Layer Smoothing</td>
</tr>
</tbody>
</table>

The Details View is found to the bottom left of the CFX-Mesh window. It contains all of the available information for any item in the Section : Tree View. You can access it by clicking with the left mouse button on the item’s name in the Tree View.

Details which are grayed out cannot be edited, but most can be edited by simply clicking in the relevant box and typing. Press Enter on the keyboard after typing in a box to make the change take effect, or simply move the cursor out of the box.

You can change the name of an item by right-clicking on its name in the Tree View. This is not available through the Details View.

Where a box requires you to make a selection, you can do this either by picking items from the Graphics window (where appropriate) or through the Tree View directly. Selection is explained in Section : Selection.
Most of the parameters and settings that require you to enter a number will only take numbers within a certain range. See Section : Valid and Invalid Values for more details on valid ranges.

Selections of locations must satisfy the rules for the objects that you are trying to create. If you try to make a selection which is invalid, then the selection will not be accepted. Some notes on valid selections are given under the section which describes the feature which you are creating, and some notes for the case where you have multiple Bodies in your geometry are in Section : 2D Regions and Faces.

To minimize the number of mouse clicks required to select a Location for any CFX-Mesh Model feature, the Location selection is now made active when you first create that feature (e.g. Inflated Boundary, Preview Group, Composite 2D Region). For example, this means that you can create a new Inflated Boundary and then immediately click in Graphics window to select the faces for it, without having to first activate the Location selection by clicking in the Details View.

In general, if you select an object in the Tree View, the Location selection for the first item which does not already contain a valid selection is activated.

If you prefer not to have the Location selection being automatically activated, then you can set the CFX-Mesh option Auto Activate to No, under Properties View Options. The CFX-Mesh options and how to set them are described in CFX-Mesh Options.

Graphics Window

The Graphics window forms the largest section of the CFX-Mesh window, and is the place where the model is displayed. It also shows the Section : Ruler and the Section : Triad, the axes in the bottom right corner. How to move the model around and put it into selected views is described in Section : Display Control, Mouse Actions, and the Rotation Modes Toolbar.

Toolbars and Icons

The following toolbars are available in CFX-Mesh:
- Menus Toolbar
- Section : File Toolbar
- Rotation Modes Toolbar
- Selection Filters
- Selection Mode Toolbar
- Section : Display Toolbar
- Section : Geometry Toolbar
- Section : Meshing Toolbar
- Section : Interrupt

**File Toolbar**

The File Toolbar reproduces some of the functionality from the File menu.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Settings</td>
<td>Clear all the user-defined settings from the CFX-Mesh database (reinitialize the database). This is equivalent to starting a new CFX-Mesh database with the same geometry, but is quicker since the geometry does not need to be re-imported.</td>
</tr>
<tr>
<td>Revert Settings to Saved</td>
<td>Reverts the settings to how they were when you last saved the CFX-Mesh database.</td>
</tr>
<tr>
<td>Save File</td>
<td>Save the current setup as a .cmdb file. The name and location is dictated by the settings on the Project Page.</td>
</tr>
</tbody>
</table>

**Display Control, Mouse Actions, and the Rotation Modes Toolbar**

By default, the mouse buttons and keyboard presses over the Graphics window have the following functions in CFX-Mesh. In some cases, holding down the Shift or Ctrl key whilst using the mouse changes its behavior. A description of the functions themselves can be found in the following table.

<table>
<thead>
<tr>
<th>Action</th>
<th>No Keypress</th>
<th>Shift</th>
<th>Ctrl</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left Mouse Button Click only</td>
<td>Single Select (when selecting) or Set Rotation Center (when in a Rotation Mode)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Left Mouse Button Click and Drag</td>
<td>Flood Select or Box Select (when selecting) or see below for behavior when in a Rotation Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Middle Mouse Button</td>
<td>Rotates</td>
<td>Zoom</td>
<td>Pan</td>
</tr>
</tbody>
</table>
Right Mouse Button Click and Drag
Mouse Wheel (if available) | Box Zoom
| Zoom

You can change which function is assigned to which mouse button by using **Common Settings>Graphics Interactions** in the Workbench Options. These can be accessed using **Tools>Options**.

You can also use the Section: Triad at the bottom right corner of the Graphics window to quickly put the model into a specified viewing position.

The left mouse button is used both for selection and for model manipulation. Its behaviour is determined by whether a selection filter (Face Selection Mode) or rotation mode (Rotate) is selected from the two toolbars. For example, see the pictures below.

![Selection filter Face Selection Mode is selected.](image)

![Rotation mode Rotate is selected.](image)

Selection is described in Selection Filters, and the rotation modes are described below.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate</td>
<td>This is described in Section: Rotate Mode.</td>
</tr>
<tr>
<td>Pan</td>
<td>This function allows you to move (translate) the model about the display screen as you move the cursor.</td>
</tr>
<tr>
<td>Zoom</td>
<td>This function allows you to zoom in on the model by dragging the mouse cursor vertically toward the top of the graphics window, or zoom out by dragging the mouse cursor vertically toward the bottom of the graphics window. The center for the Zoom is the same as the center of rotation, which can be set while in a Rotation Mode.</td>
</tr>
<tr>
<td>Box Zoom</td>
<td>This function allows you to drag a box over the model in order to zoom in to that area, which is expanded to fill the window.</td>
</tr>
<tr>
<td>Zoom to Fit</td>
<td>This function zooms in or out from the model to fit the entire model in the graphics window.</td>
</tr>
</tbody>
</table>

**Rotate Mode**

By default, dragging the mouse with its middle button held down rotates the model in Rotate Mode, which is described in the table below. In addition, the left mouse button can operate in Rotate Mode when the appropriate rotation mode is selected from the Rotation Modes Toolbar.

When in Rotate Mode, the type of cursor which is shown determines which type of rotation occurs.

<table>
<thead>
<tr>
<th>Cursor</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Free rotation." /></td>
<td>Free rotation.</td>
</tr>
<tr>
<td><img src="image" alt="Rotation around an axis which points out of the screen (roll)." /></td>
<td>Rotation around an axis which points out of the screen (roll).</td>
</tr>
</tbody>
</table>
Rotation around a vertical axis relative to the screen ("yaw" axis).

Rotation around a horizontal axis relative to the screen ("pitch" axis).

The type of cursor which is shown (and hence the type of rotation) depends on the starting location of the cursor. In general, if the cursor is near the center of the graphics window, the familiar 3D free rotation occurs. If the cursor is near a corner or edge, a constrained rotation occurs: pitch, yaw or roll.

Specifically, the circular free rotation area fits the window. Narrow strips along the edges support pitch and yaw. Corner areas support roll. The following figure illustrates these regions.

The crosshairs in the Graphics window indicate the center of rotation. If you are using the left mouse button in Rotate Mode then you can click over the model with the left mouse button to change the position of the crosshairs relative to the model. Click outside the model to restore the default center of rotation.

**Selection**

Many objects in the meshing definition need to be applied to a particular piece of geometry (such as a face) or to be associated with another item (a Point Control needs to be associated with a particular Spacing Definition, for example).

Where you are required to select an object in the Section : Tree View, then you can do this as follows:

1. Click in the box in the Section : Details View which requires the selection, to make it active. This step may not be needed if Auto Activate is set to **Yes** and there is no valid selection already made.
2. Click on the item in the Tree View to select it.
3. Click on the **Apply** button in the relevant box in the Details View.

The process for selecting a geometric object from the Section : Graphics Window is similar.

The following points apply to selection in general:

- Use the left mouse button to select a single object.
- Hold down the Ctrl key on the keyboard to select a second or subsequent item.
- To remove an item from the selection, hold down the Ctrl key and select it again.
- To select multiple items at once, see Section : Selection Mode Toolbar, Box Select and Flood Select.
- If you have faces in the Graphics window which are hidden behind other faces, then when you click on the front face, a stack of *Selection Rectangles* (shown below) will appear at the bottom left of the Graphics window. The rectangles are stacked in appearance, with the topmost rectangle representing the visible (selected) geometry and subsequent rectangles representing geometry hit by a ray normal to the screen passing through the pointer, front to back. The front face will be selected by the original click on it. You can deselect it and/or select any of the hidden faces by clicking on the corresponding rectangles instead of the actual faces in the geometry, using the Ctrl key in the same way as for picking directly from the geometry. When multiple Solid Bodies with shared faces are present in the geometry, then the shared faces are represented by two linked rectangles, one for each side of the face or “2D Region”.

![Selection Rectangles Diagram]

- Sometimes you may want to select both objects from the Tree View and faces from the Graphics window - for instance, if you wish to apply Section : Inflation to a set of faces which can be selected most conveniently by selecting a Composite 2D Region and then adding a few faces selected directly from the Graphics window. In this case, selecting the objects of the two different types acts independently. For instance, if you have selected a Composite 2D Region, you can simply click on a face in the Graphics window to add it to the selection, without holding down the Ctrl key. If you click on a face in the Graphics window (without holding down a key) then that will add that face to the selection and clear any existing selection of faces, but not affect any selection of Composite 2D Regions. If you want to clear the selection of Composite 2D Regions as well, you must explicitly deselect them (by holding down Ctrl and clicking on them).
- Usually, if you are required to select geometric objects of a particular type, then your selection will be automatically restricted to select only objects of the required type. For instance, when choosing faces to apply a Face Spacing to, only faces will be able to be selected. If the selection is not being restricted automatically but you want to enforce a restriction, then you can use a Selection Filter.

### Selection Filters

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>Allow only points to be selected.</td>
</tr>
<tr>
<td>Edge</td>
<td>Allow only edges to be selected.</td>
</tr>
</tbody>
</table>
Point Selection

When you need to select a point from the Graphics window, then in general you can select either a model vertex (corner of a face), an arbitrary point on any of the model faces, or specify coordinates. How to do either of these is described below.

Vertex Selection:

1. If the **Point** entry in the Details View shows the word “None” on a yellow background, or some coordinates are displayed, then click on **None** or the coordinate entry, to make the **Point** entry change to show two buttons, **Apply** and **Cancel**.

2. Move the mouse over the required vertex in the Graphics window until a small red wireframe sphere appears (see the picture below). Whilst the sphere is visible, click with the left mouse button.

3. Click on **Apply** in the Details View. The **Point** entry will now show **1 Vertex**.

Point on a Face:

1. If the **Point** entry in the Details View shows the word “None” on a yellow background, or some coordinates are displayed, then click on **None** or the coordinate entry, to make the **Point** entry change to show two buttons, **Apply** and **Cancel**.

2. Move the mouse over the part of the face in the Graphics window where you want the point to be, and click with the left mouse button.

3. If there is more than one face under the mouse at the point when you click, then the Selection Rectangles will appear in the bottom left-hand corner of the Graphics window. If you click on one of these, you can move the point so that it appears not on the face closest to you, but one of the faces underneath the mouse which is not at the front. In order to see the location of the point at this stage, you will need to make the geometry partially transparent.

4. Click on **Apply** in the Details View. The **Point** entry will now show the coordinates of the point that you picked. Note that these coordinates now specify the point, so if the geometry changes (from a geometry update, it is possible that this point may no longer lie on a face.

Specify Coordinates:

1. If the **Point** entry in the Details View shows two buttons reading **Apply** and **Cancel**, click on **Cancel** to make the **Point** entry show the word “None” or show some coordinates.

2. Right-click on **None** or the coordinate entry and choose **Edit**.

3. Edit the coordinates as required. The only allowed formats are three numbers (X, Y, Z) separated by either spaces or commas (you may not use a comma to separate two numbers and only use a space to separate
the third). You must not enter the units string (such as “[mm]”); CFX-Mesh will add that in for itself using
the model dimensions. Press Return on the keyboard to finish editing the coordinates.

Selection Mode Toolbar, Box Select and Flood Select

There are two selection modes. To switch between them, you use the Selection Mode Toolbar, which is located
along with the rest of the toolbars at the top of the window.

· Flood Select - In this mode, you can select multiple geometric objects simply by pressing and
holding down the left mouse button and then moving the mouse over them. Any object which the mouse
touches is added to the selection.

· Box Select - In this mode, you can select geometric objects from the Graphics window by clicking
with the left mouse button and then dragging it across other objects. All the objects that the box fully
encloses are selected. If you hold down the Ctrl key while you draw the box, then these items will be added
to the current selection.

Note that with both selection methods, hidden faces or hidden bodies cannot be selected. The faces or bodies
must be made visible in the model view in order that they can be selected.

Display Toolbar

The Display Toolbar controls what is visible in the Graphics window.

<table>
<thead>
<tr>
<th>Display Triad</th>
<th>Toggle the display of the Section : Triad.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Ruler</td>
<td>Toggle the display of the Section : Ruler.</td>
</tr>
</tbody>
</table>

Triad

The Triad in the bottom right corner of the Graphics window shows the orientation of the model. It can also be
used to position the model in one of several pre-defined viewing positions:

· Click on one of the arrows along the axes to put the model into a view normal to that arrow.
· Click on the cyan ball to put the model into an isometric view.

Moving the mouse over the Triad identifies the axis (X, Y, Z) and direction (+/-) of the arrow, using tool tips.
Positive-direction arrows are labeled and color-coded. Negative direction arrows display only when you hover
the mouse cursor over the appropriate region, but can still be clicked on to put the model in a view normal to the arrow.

To control whether the Triad is visible or not, use the Section : Display Toolbar.

**Ruler**

You can use the ruler, shown at the bottom of the Graphics window, to obtain a good estimate of the scale of the displayed geometry.

To control whether the Ruler is visible or not, use the Section : Display Toolbar.

**Geometry Toolbar**

The Geometry Toolbar gives you access to the actions which can be performed on the geometry.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Geometry</td>
<td>This allows you to re-import the geometry after it has been changed, keeping as many of the mesh settings applied as possible. See Section : Geometry Update for more details.</td>
</tr>
<tr>
<td>Geometry Check</td>
<td>Geometry Checking is described in Section : Geometry Checking.</td>
</tr>
</tbody>
</table>

**Meshing Toolbar**

The Meshing Toolbar gives you access to the meshing actions which can be performed on the model.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate Surface Mesh</td>
<td>This allows you to generate or regenerate the surface mesh. You must use a Section : Preview Group to view the mesh in CFX-Mesh.</td>
</tr>
<tr>
<td>Generate Volume Mesh</td>
<td>This allows you to generate or regenerate the volume mesh and write a CFX-Pre Mesh File. See Section : Creating the Volume Mesh for more details.</td>
</tr>
</tbody>
</table>

**Interrupt**

Sometimes you may want to interrupt a lengthy meshing operation before it finishes, perhaps because you realise that you have made a mistake, or that the resulting mesh is going to take too long to generate or be too big. In this case, you can use the **Interrupt** (or “Halt current processing”) button. This is located in the CFX-Mesh toolbar near the top of the ANSYS Workbench window.

Clicking on the **Interrupt** button will interrupt any meshing operation in progress (including the **Verify Geometry** functionality). After a short delay, CFX-Mesh will return an error showing that the meshing operation has failed, and an Error will appear in the Tree View which shows that the meshing has terminated because the user has interrupted it. The user interface is then unlocked for use again.
A limitation of the **Interrupt** functionality is that it only takes effect when the underlying meshing process exchanges data with the user interface. Usually this data exchange occurs very frequently; for example, data exchange takes place every time the progress bar is incremented. In a small number of circumstances, however, the underlying meshing processes may go for a relatively long period of time without exchanging data with the user interface (for example, if such a large mesh is being generated that there is no significant progress to report, or in certain unusual cases when the mesher fails). In this case, **Interrupt** will appear to have no effect. If you do need to interrupt the meshing process under such circumstances, then use the Task Manager (Windows) or the `kill` command (UNIX) to end the following processes:

- `srfmsh_wb.exe` (Delaunay surface mesher)
- `nsurf3d_wb.exe` (Advancing Front surface mesher)
- `inflate_wb.exe` (Inflation layer generator)
- `nvol3d.exe` (Advancing Front volume mesher)
- `nvol2d_wb.exe` (Extruded 2D Mesher)
## File Menu

The File Menu contains the following items.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Clear Settings</td>
<td>Clears all the user-defined settings from the CFX-Mesh database (reinitialize the database). This is equivalent to starting a new CFX-Mesh database with the same geometry, but is quicker since the geometry does not need to be re-imported.</td>
</tr>
<tr>
<td>File &gt; Revert Settings to Saved</td>
<td>Reverts the settings to how they were when you last saved the CFX-Mesh database.</td>
</tr>
<tr>
<td>File &gt; Save</td>
<td>Saves the current setup. The filename and location are shown on the Project Page.</td>
</tr>
<tr>
<td>File &gt; Save As...</td>
<td>Saves a copy of the current setup as a different file. The Project Page is updated to show the new name and location of the files.</td>
</tr>
<tr>
<td>File &gt; Export CCL...</td>
<td>Exports the current mesh settings as a CCL file.</td>
</tr>
<tr>
<td>File &gt; Close CFX-Mesh</td>
<td>Closes CFX-Mesh leaving ANSYS Workbench open.</td>
</tr>
<tr>
<td>File &gt; Exit Workbench</td>
<td>Exits from ANSYS Workbench. You will be prompted to save any open files.</td>
</tr>
</tbody>
</table>

## Mesh Settings as CCL

_CCL_ is the CFX-5 Command Language. It is used both here to encapsulate the mesh settings and elsewhere in the CFX-5 software for specifying (for example) the physical model setup for the CFX-5 Solver. CFX-Mesh allows you to export the mesh setup as a CCL file. This would be useful if you wanted a summary of the mesh settings in a readable format.

## Tools Menu

The Tools Menu contains the following items.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools &gt; Rotate</td>
<td>These functions are identical to those on the Rotation Modes Toolbar.</td>
</tr>
<tr>
<td>Tools &gt; Mouse Pan</td>
<td></td>
</tr>
<tr>
<td>Tools &gt; Mouse Zoom</td>
<td></td>
</tr>
<tr>
<td>Tools &gt; Box Zoom</td>
<td></td>
</tr>
</tbody>
</table>
Menus

<table>
<thead>
<tr>
<th>Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools &gt; Zoom to Fit</td>
<td>These functions are identical to those on the Selection Filters Toolbar.</td>
</tr>
<tr>
<td>Tools &gt; Pick Vertex</td>
<td></td>
</tr>
<tr>
<td>Tools &gt; Pick Edge</td>
<td></td>
</tr>
<tr>
<td>Tools &gt; Pick Surface</td>
<td></td>
</tr>
<tr>
<td>Tools &gt; Pick Body</td>
<td></td>
</tr>
<tr>
<td>Tools &gt; Options</td>
<td>This function allows you to set up various preferences both for CFX-Mesh and ANSYS Workbench. See CFX-Mesh Options for more details.</td>
</tr>
</tbody>
</table>

**View Menu**

The View Menu contains the following items.

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View &gt; Shaded Display with 3D Edges</td>
<td>These functions toggle the geometry display between a view with shaded faces and a view with just the wireframe outline. This setting is not stored in the CFX-Mesh database but is a property of the ANSYS Workbench session. If you open a different CFX-Mesh database within the same ANSYS Workbench session, then the setting persists. To change the default setting (i.e., the setting for when ANSYS Workbench is opened), use <strong>Tools &gt; Options</strong> and change the View setting under Graphics View.</td>
</tr>
<tr>
<td>View &gt; Wireframe Display</td>
<td></td>
</tr>
<tr>
<td>Tools &gt; Show Triad</td>
<td>These functions are identical to those on the Display Toolbar.</td>
</tr>
<tr>
<td>Tools &gt; Show Ruler</td>
<td></td>
</tr>
<tr>
<td>Restore Original Window Layout</td>
<td>This function allows you to restore the original layout of the Details View, Tree View, and Graphics window.</td>
</tr>
</tbody>
</table>

**Go Menu**

The Go Menu contains the following items.

<table>
<thead>
<tr>
<th>Go</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go &gt; Update Geometry</td>
<td>These functions are identical to those on the Geometry Toolbar.</td>
</tr>
<tr>
<td>Go &gt; Verify Geometry</td>
<td></td>
</tr>
<tr>
<td>Go &gt; Generate All Surface Meshes</td>
<td>These functions are identical to those on the Meshing Toolbar.</td>
</tr>
<tr>
<td>Go &gt; Generate Volume Mesh</td>
<td></td>
</tr>
</tbody>
</table>
Before using CFX-Mesh, you must have already created the necessary geometry. You can either create the geometry from scratch in DesignModeler or import it into DesignModeler or CFX-Mesh from another CAD package or an external geometry file such as a Parasolid file. This is described in Section : Geometry Creation and Import.

After importing the geometry, it is possible to modify it and update the geometry in CFX-Mesh at a later time. This is described in Section : Geometry Update.

Whether the geometry originates from an external import or is created from scratch in DesignModeler, it must satisfy certain requirements in order that it can be used successfully in meshing. Additionally, you should bear in mind how you want to use the geometry in the CFX-5 software as you create it, because if you want to model Solid domains (e.g. for heat transfer), fluid subdomains (e.g. to specify a resistance source) or Thin Surfaces, you will need to create the geometry using multiple Solid Bodies. You will also need to make sure that each region you need for a boundary condition in CFX-5 is available as a separate face or faces.

CFX-Mesh includes a geometry-checking utility which can be run to check for the presence of certain features in faces and edges which can cause meshing difficulties.

If the geometry consists of multiple Bodies and/or Parts, then it is possible to choose to mesh the different Bodies and Parts separately or together, or not at all. This is described in Section : Suppression of Bodies and Parts.

CFX-Mesh also allows you to control the display of geometry in order to see the model more clearly and to facilitate selection of faces in multiple body geometries.

**Geometry Creation and Import**

Geometry creation is performed outside CFX-Mesh in either DesignModeler within ANSYS Workbench or an external CAD package.

**Creating Geometry in DesignModeler**

If you have created geometry in DesignModeler then ensure that you have a ANSYS Workbench project open which contains the DesignModeler file. Select the .agdb file on the Project Page and then choose the option *Generate CFX Mesh* to open CFX-Mesh with that geometry. Named Selections created in DesignModeler can be supported in CFX-Mesh if the instructions in Section : Named Selections are followed.

**Creating Geometry in an External CAD Package**

In the case of geometry created externally, there are three options for importing it into CFX-Mesh, depending on the source of the geometry.

1. **Save the external CAD file.** Then import it into DesignModeler by using the *File>Import External Geometry File* menu item. Then select the .agdb file on the Project Page and then choose the option *Generate CFX Mesh* to open CFX-Mesh with that geometry. You will need an appropriate license for DesignModeler to use this route.

2. **Save the external CAD file and close the CAD package.** Then browse to find the geometry file from the Project Page, highlight its name and select *Generate CFX Mesh*. This method uses the CAD interfaces in *reader mode*. You need a license for the CAD interface appropriate for your CAD package to use this route.
3. Open the CAD model in the external CAD package. Then open ANSYS Workbench, either by using the **ANSYS 10.0** in the CAD package, or by opening it manually. On the Project Page, you will see your part name listed under the **Link to Active CAD Geometry** group. If it is not listed, you will need to click **Refresh**. Once your part is listed there, click this part and then set the preferences under the **Default Geometry Options** group and the **Advanced Geometry Defaults** group. Afterwards, choose the option **Generate CFX Mesh** to import the geometry into CFX-Mesh. This method uses the CAD interface in **plug-in mode**. You need a license for the CAD interface appropriate for your CAD package to use this route.

If you are going to use the direct CAD interfaces, then it is probably more convenient in general to use plug-in mode rather than reader mode, since this will allow for more convenient geometry updates when you modify the geometry. However, not all CAD interfaces support the plug-in mode. A list of those which do can be found in CAD Systems.

Whether or not you import the CAD via DesignModeler or not will be dictated by which licenses you have available. If you have both types of license, then you can consider either method.

One advantage of importing external CAD into DesignModeler rather than directly into CFX-Mesh is that you can combine Bodies into one Part in DesignModeler. Simply select all of the Bodies and then use **Tools> Form New Part** in DesignModeler. Where surfaces from different Bodies are coincident, then they will be converted into shared surfaces and CFX-Mesh will then be able to produce a matching mesh on these surfaces, and place the mesh for the Bodies on each side into one assembly. This, in turn, means that CFX-Pre will not need to use GGI connections between the two Bodies.

Another advantage of importing external CAD into DesignModeler is that you have more choice of the units you want to work in. For many of the external CAD files, you will be unable to change the units if they are imported into CFX-Mesh directly.

If you import CAD into DesignModeler then DesignModeler does some checking and clean-up to ensure that the geometry is clean enough for use with solid modeling. This means that in some rare cases, you may get a better mesh if the geometry has been imported via DesignModeler. On the other hand, some CAD geometries will fail to import into DesignModeler as they do not satisfy its more stringent requirements, but can be imported into CFX-Mesh directly and meshed with no difficulty.

One advantage of importing the CAD directly into CFX-Mesh is that geometry updates will be more convenient than if you import via DesignModeler.

### External CAD formats

The list of supported CAD packages for CFX-Mesh is the same as Simulation (with one exception) and can be found in CAD Systems, including the supported version number(s). The one exception is that the import of CATIA version 4 files into CFX-Mesh is not supported. Notes on the import of files of a particular format into CFX-Mesh are given below. CAD Systems contains additional notes which you may wish to refer to if you are having problems importing, although not all of these will apply to CFX-Mesh.

#### ACIS

The ACIS reader supports **.sat** files which include single or multiple bodies. You must specify the length units of the geometry when CFX-Mesh initialises. We recommend verifying dimensions before meshing; this can be done by matching a known length in the geometry against the Section : Ruler.
Autodesk Inventor

The Autodesk Inventor interface supports files containing parts or assemblies, using the extensions .ipt or .iam. CFX-Mesh will always use a length unit of centimeters for imported Autodesk Inventor geometries.

Autodesk Mechanical Desktop

The Autodesk Mechanical Desktop interface supports files containing both parts and assemblies. You must specify the length units of the geometry when CFX-Mesh initialises. We recommend verifying dimensions before meshing; this can be done by matching a known length in the geometry against the Section : Ruler.

CATIA V4

The import of this file format into CFX-Mesh is not supported as the mesher is unable to mesh the resulting geometry.

CATIA V5

The CATIA V5 reader supports CATIA V5 parts (*.CATPart) and assemblies (*.CATProduct). CATIA V5 surface bodies consisting of closed surfaces are transferred as solid bodies. You must specify the length units of the geometry when CFX-Mesh initialises. We recommend verifying dimensions before meshing; this can be done by matching a known length in the geometry against the Section : Ruler.

IGES

The IGES reader supports IGES files containing parts or assemblies, using the extensions .igs or .iges. Closed surfaces and hollow solids from an IGES file are transferred as full solids. CFX-Mesh will always use a length unit of meters for imported IGES geometries.

Parasolid

The Parasolid reader supports Parasolid files containing parts or assemblies, using the extensions .x_t or .xmt_txt. CFX-Mesh will always use a length unit of meters for imported Parasolid geometries.

Pro/ENGINEER

The Pro/ENGINEER interface supports Pro/Engineer part (.prt) or assembly (.asm) files. CFX-Mesh uses the units which are stored in the Pro/Engineer file.

Solid Edge

The Solid Edge interface supports Solid Edge part, assembly, sheet metal, and weldment documents. CFX-Mesh will always use a length unit of meters for imported Solid Edge geometries.

SolidWorks

The SolidWorks interface supports SolidWorks part and assembly documents. CFX-Mesh will always use a length unit of meters for imported SolidWorks geometries.

STEP

The STEP reader supports STEP files containing parts or assemblies, using the extensions .stp or .step. CFX-Mesh will always use a length unit of millimeters for imported STEP geometries.
Unigraphics

The Unigraphics interface supports Unigraphics files containing parts or assemblies. CFX-Mesh uses the units which are stored in the Unigraphics file.

Geometry Update

After you have imported a geometry into CFX-Mesh you may find at some stage that you need to modify it. For instance, perhaps you made a mistake in the original construction, or you want to update a dimension or remove a small feature that you do not want to resolve in your CFX-5 simulation. CFX-Mesh has the capability to update your geometry whilst retaining most or all of the settings (depending on the complexity of the changes made to the geometry, the CAD format and the method of import).

If your geometry was imported into CFX-Mesh from DesignModeler or from an external CAD package using plug-in mode, then you only need to open the original CAD file in the CAD package (DesignModeler in the case of .agdb files) and make the appropriate modifications to the geometry. You can then return to CFX-Mesh and access Geometry Update by right-clicking on Geometry in the Tree View and selecting Update Geometry. Alternatively, it is available from the Geometry Toolbar ( ). You will be warned before the update takes place, and asked to confirm it.

If your geometry was imported into CFX-Mesh from an external CAD package using reader mode, then you must modify the geometry and save the new geometry into the appropriate file. You can then return to CFX-Mesh and access Geometry Update by right-clicking on Geometry in the Tree View and selecting Update Geometry. Alternatively, it is available from the Geometry Toolbar ( ). You will be warned before the update takes place, and asked to confirm it.

On import of the new geometry, CFX-Mesh checks to see whether the CAD entities (faces, edges, vertices, etc.) that were present in the original geometry still exist in the new geometry. It then updates the features in the Tree View as follows.

- If the geometric location for a CFX-Mesh feature (e.g. a list of faces for a Face Spacing) consists entirely of geometric entities which no longer exist, then CFX-Mesh marks that feature as invalid by using the invalid status symbol . In order to make the model valid again, you must either delete that feature or modify it to specify an appropriate location for the feature.
- If the geometric location for a CFX-Mesh feature (e.g. a list of faces for a Face Spacing) consists of both geometric entities which no longer exist and entities which do still exist, then the non-existent entities are removed from the location list. For example, if a Face Spacing is applied to three faces, and after the update one of these faces no longer exists, then the Face Spacing will be automatically modified so that after the geometry update, it is applied to just the two remaining faces. Where features are automatically updated in this way, CFX-Mesh marks them as such by using the status symbol . Where you see this symbol after a geometry update, you are advised to check that the feature is applied to where you expect it to be. If you want to change this symbol back to the normal symbol, simply click on the feature name in the Tree View then click next to Location in the Details View and just press Apply without modifying anything.
- New faces are automatically added to the Default 2D Region, Default Face Spacing and Default Preview Group.

After a geometry update, you should always check that your settings are still applied to their required location.
In order to keep applying existing meshing features to the correct locations, CFX-Mesh needs to be able to identify a geometric location such as a face as being the same in the old geometry and the new geometry. How well it is able to do that depends on both the CAD format and the method of import.

If your geometry was creating in DesignModeler, then you should find that most geometry updates work with the minimum required modification to your meshing model. The one exception to this is that if you combine bodies to form a single part using the Form New Part functionality, or use the Explode Part functionality to reverse this change. In this case, the underlying faces do not maintain their identity during the geometry update and you may need to re-apply the locations of all the mesh settings.

If you have used a direct CAD interface in plug-in mode, then once again you can expect that many geometry updates will work with the minimum required modification to your meshing model. However, if you are using a CAD interface in reader mode, then it is more difficult to maintain the identities of the geometric locations during import, and you may find that you have to re-apply the locations of all the mesh settings.

When you create a new CFX-Mesh database, it is associated with a particular geometry file on the Project Page. CFX-Mesh will always update the geometry from the geometry file which is listed on the Project Page, even if this is a different file location to the original location. If the Project Page does not have a valid file location for this geometry then you will not be able to perform a geometry update until you have updated the Project Page to show a valid file location.

If you have a CFX-Mesh database which is not associated with a geometry file through the Project Page (e.g. if you chose to open the CFX-Mesh database directly when you first started ANSYS Workbench, rather than opening the project which contains it) then CFX-Mesh will use the geometry with the same filename as the original for a geometry update. The filename is stored with a full path so you must have not renamed the file or its directory for this to work. If the original file is not available then you will not be able to perform a geometry update.

**Geometry Requirements**

Geometry requirements and how to create certain desired topologies are described in the following sections.

- General Geometry Requirements
- Multiple Bodies, Parts and Assemblies
- Geometry and Topology for Solid Bodies
- Geometry and Topology for the Faces of Solid Bodies
- Geometry and Topology for the Faces of an Inflated Boundary
- Geometry for Thin Surfaces
- Poorly-Parameterized Surfaces
- Degenerate Geometry

**General Geometry Requirements**

- The geometry used for meshing must consist of one or more Solid Bodies which are grouped into one or more Parts. Surface Bodies in ANSYS Workbench are not supported. However, on import of certain geometry file formats (currently CATIA v5, IGES, Solid Edge and Unigraphics), ANSYS Workbench will convert sets of surfaces which fully enclose a volume into Solid Bodies, so the requirement to have a Solid Body does not restrict the use of these formats.

- The use of multiple Solid Bodies is described in Section: Multiple Bodies, Parts and Assemblies.

- Solid Bodies in a single Part must not overlap each other.

- Where Solid Bodies in a single Part touch, they must have common faces if you want a common mesh. This is illustrated in Section: Bodies Touching at a Face.
• It does not matter whether or not the Solid Bodies are Frozen in DesignModeler; they will still appear in CFX-Mesh and can be meshed regardless of this state. If you want to exclude a Solid Body from meshing, you must suppress it in CFX-Mesh or suppress or delete it in DesignModeler.

Multiple Bodies, Parts and Assemblies

• Parts are groups or collections of Bodies. Parts can include multiple Bodies and are then referred to as Multi-body Parts. If your geometry contains multiple Parts then each Part will be meshed with separate meshes with no connection between them, even if they apparently share faces.

• You can convert a geometry which has multiple Parts into one with a single Part by using the Form New Part functionality in DesignModeler. Simply select all of the Bodies and then use Tools> Form New Part in DesignModeler. If you have an external geometry file that has multiple Parts that you wish to mesh with one mesh, then you will have to import it into DesignModeler first and perform this operation, rather than importing it directly into CFX-Mesh.

• By default, every time you create a new Solid Body in DesignModeler, it is placed in a new Part. To create a single mesh, you will have to follow the instructions in the previous step to place them in the same Part after creation.

• Multiple Solid Bodies within a single Part will be meshed with one mesh provided that they have at least one face which CFX-Mesh recognises as being “shared” with another of the Bodies in that part. This is the desired topology if you require a single mesh with multiple domains or subdomains in CFX-Pre. For a face to be shared in this way, it is not sufficient for two Bodies to contain a coincident face; the underlying representation of the geometry must also recognise it as being shared. Normally, geometry imported from external CAD packages (not DesignModeler) does not satisfy this condition and so separate meshes will be created for each Body, even if they are in the same Part. However, if you have used the Form New Part function in DesignModeler to create the Part, then the underlying geometry representation will include the necessary information on shared faces when faces are coincident (i.e. the Bodies touch).

• An Assembly is a collection of Parts. Multiple Assemblies are not supported.

Geometry and Topology for Solid Bodies

This section shows examples of allowed and disallowed topology for Solid Bodies together with notes on the methods which can be used to generate them in DesignModeler. The two governing principles are:

• Solid Bodies must not overlap.

• where Solid Bodies meet, they must share a common face if you want a single mesh.

The examples are:
  Bodies Joined by a Common Face
  Bodies Touching at a Face
  Body with a Hole
  Body with an Enclosed Body
  Bodies with an Enclosed Body and a Hole
  Body with an Enclosed Body Touching the Face

Bodies Joined by a Common Face

This example shows a simple configuration with two Solid Bodies which have a common face. Assuming that they are contained within the same part, one mesh will be produced.
In order to construct this geometry in DesignModeler, you could

1. create one cube and Freeze it,
2. create the second cube, and
3. select both Bodies and combine them into one Part using **Tools>Form New Part**.

**Bodies Touching at a Face**

This example shows two Solid Bodies, which meet at a face. A single mesh will be produced throughout the two Bodies only if they are in the same part and if they share a common face where they touch.

If you just create the two Bodies shown, then they do not meet at a common face: the circle at the end of the cylinder is not one of the faces of the cube. The picture below shows this situation.

In order to make a common face between the two, the cube needs to have the square face that touches the cylinder split into two: one face is the circle at the end of the cylinder, and the other face is the remaining square with a circular cut. This is shown in the picture below. Green and black are used to color the faces of the cube.
In order to construct this geometry in DesignModeler, you could

1. create the cylinder,
2. Freeze it and use the Body Operation **Copy** to copy it,
3. create the cube,
4. use the Body Operation **Imprint Faces**, selecting one copy of the cylinder as the Body, to split the face of the cube which touches the cylinder into the two required pieces (this operation removes one copy of the cylinder, leaving two Solid Bodies, the cube and the cylinder), and
5. select both Bodies and combine them into one Part using **Tools>Form New Part**.

**Body with a Hole**

This example shows a single Solid Body which has a cube-shaped hole in it.

In order to construct this geometry in DesignModeler, you could

1. create the outside cube, and
2. use an Extrude operation to create the inner cube (which forms the hole), setting **Operation** to **Cut Material**.

**Body with an Enclosed Body**

This example shows two Solid Bodies, one of which is entirely enclosed by the other. It is assumed that you want to be able to refer to the mesh on the inner Body explicitly, perhaps because you want to model that region as
a conducting solid in your CFX-5 simulation. A single mesh will be produced throughout the two Bodies (providing that they are in the same part) but the mesh on either Body will be available separately for selection in CFX-5.

In order to construct this geometry in DesignModeler, you could

1. create the inner cube,
2. use the Enclosure operation, with Shape set to Box and Merge Parts? to Yes, to create the outside cube with the inner cube cut out of it, without removing the inner cube.

This method only works if the outside Body is a cube, sphere or cylinder, since these are the only Bodies that the Enclosure operation can create directly. If the two Bodies were not just simple shapes, then to create a geometry with this topology, you could do the following:

1. create the inner Body,
2. Freeze it,
3. create the outer Body,
4. use the Enclosure operation with Shape set to User Defined, User Defined Body set to the outer Body, Target Bodies set to All Bodies, and Merge Parts? to Yes.

In this example, setting Merge Parts? to Yes has the effect of combining the two Bodies into one part without having to do this explicitly.

The following configuration, in which the outer Body has no hole, is NOT correct:
Bodies with an Enclosed Body and a Hole

This example shows two Solid Bodies, one inside the other, with a hole in the center of both. It is assumed that you want to be able to refer to the mesh on the inner Body explicitly, perhaps because you want to model that region as a conducting solid in your CFX-5 simulation. A single mesh will be produced throughout the two Bodies (providing that they are in the same part) but the mesh on either Body will be available separately for selection in CFX-5.

In order to construct this geometry in DesignModeler, you could

1. create the middle cube (which forms the outside faces of the red Body),
2. use the Enclosure operation to create the outside cube with the middle cube cut out of it, without removing the inner cube,
3. use an Extrude operation to create the inner cube (which forms the hole), setting Operation to Cut Material, and
4. select both Bodies and combine them into one Part using Tools>Form New Part.

Once again, this method only works if the outside Body is a cube, sphere or cylinder, since these are the only Bodies that the Enclosure operation can create. If the two Bodies were not just simple shapes, then to create a geometry with this topology, you could do the following:

1. create the middle cube (which forms the outside faces of the red Body),
2. Freeze it,
3. create the outer Body,
4. use the Enclosure operation with Shape set to User Defined, User Defined Body set to the outer Body, Target Bodies set to All Bodies, and Merge Parts? to Yes.
5. Unfreeze the middle cube and choose to Freeze Others? (to make the middle cube the active Body),
6. use an Extrude operation to create the inner cube (which forms the hole), setting Operation to Cut Material.

In this example, setting Merge Parts? to Yes has the effect of combining the two Bodies into one part without having to do this explicitly.
Body with an Enclosed Body Touching the Face

This example shows two Solid Bodies, one of which is contained by the other but touching at a face. It is assumed that you want to be able to refer to the mesh on the inner Body explicitly, perhaps because you want to model that region as a conducting solid in your CFX-5 simulation. A single mesh will be produced throughout the two Bodies (providing that they are in the same part) but the mesh on either Body will be available separately for selection in CFX-5.

Since the cylinder is not entirely enclosed by the outside Body, you cannot use the Enclosure operation to make a geometry with this topology. In order to construct this geometry in DesignModeler, you could

1. create the cylinder,
2. Freeze it,
3. create the outer cube,
4. use the Enclosure operation with Shape set to User Defined, User Defined Body set to the outer Body, Target Bodies set to All Bodies, and Merge Parts? to Yes.

In this example, setting Merge Parts? to Yes has the effect of combining the two Bodies into one part without having to do this explicitly.

The following configuration, in which the cube has no hole, is NOT correct:
Geometry and Topology for the Faces of Solid Bodies

The Solid Bodies to be meshed can all be thought of as a volume enclosed by a set of faces. The geometry and topology of these faces can affect how well the surface meshing process is able to produce a good-quality surface mesh, so it is important to bear the following considerations in mind.

- Non-Manifold Geometry
- Closed Faces
- Merging Topology

Non-Manifold Geometry

The CFX-Mesh surface meshers are unable to mesh certain face topologies. An example of one such topology is shown below, and is an example of a non-manifold face topology. In the example below, four faces are associated with one edge: two with the outer body, and two with the inner body.

The way to work around this particular problem is to split the outer body as shown in the picture below.

Problems can also arise if there is no non-manifold edge present but there is a face which has a non-manifold vertex, as shown below.
Closed Faces

A *closed face* has two distinct edges which occupy the same location in space. The most common example of a closed face is a cylindrical face. Both of the two cylinders shown below have a closed face - the curved part of the cylinder is made up of just one face.

Closed faces are not a problem for the default surface mesher, the Section : Delaunay Surface Mesher. However, they cannot be meshed with the Section : Advancing Front (AF) Surface Mesher. If you want to use the Advancing Front Surface Mesher, then you will have to split the cylindrical face into two parts:

In DesignModeler this can be done as follows, assuming that the cylindrical face was created by Extruding, Revolving or Sweeping a circle.

1. Select the sketch containing the circle, and then use *Split* from the Modify Toolbox of the Sketching tab to divide the circle into two or more distinct edges.
2. On the Details View for the Extrude/Revolve/Sweep that created the face, set *Merge Topology?* to *No*. Then click on *Generate* to regenerate the cylindrical face.

The second step is required to stop DesignModeler from optimizing the topology of the created face(s), which would have resulted in this case in DesignModeler still creating a single face, even though the circle being extruded/revolved/swept was formed of two edges.

**Merging Topology**

CFX-Mesh will create a surface mesh on each individual face. This means that in the case where (for example) very narrow faces are present, a mesh length scale must be chosen which is sufficiently small relative to the width of the narrow dimension to allow a reasonable mesh to be created on the narrow faces, even though the physics of your CFD simulation is such that there is no need to have a fine mesh in this area.
In some cases, this may not be avoidable. However, if you are using DesignModeler to generate your geometry, then you may be able to avoid this situation by setting **Merge Topology** to **Yes** when creating the Solid Bodies in DesignModeler. In summary, this setting allows DesignModeler to optimize the faces created and in some cases this will result in faces that would otherwise be separate being merged into one face. More details can be found in the DesignModeler Help under Section : Merge Topology.

CFX-Mesh also allows you to merge two or more faces into one **Virtual Face**. The surface meshing operation will then mesh across the Virtual Face rather than the smaller constituent faces, thus removing the requirement for the mesh length scale to resolve the width of any of these constituent faces. Virtual Faces and their limitations are discussed in Virtual Topology.

**Geometry and Topology for the Faces of an Inflated Boundary**

There is a class of face topologies for which Section : Inflation can be performed, but where the results might not be what you expect. An example is shown in the picture below.

![Diagram of Inflation Face](image)

If you try to perform Inflation with such a topology, you will not get a uniform thickness of inflation near where the triangular Face A touches the inflation face. Instead, the number of layers of inflation at the point where Face A meets the inflation face will be reduced to zero; as one moves away from this point, the number of layers will increase by 1 in successive elements, until it reaches the number of layers that you requested.

There are two ways of overcoming this problem:

1. Redefine the non-inflated faces to be inflated ones. In this case the inflation will cause elements to be produced normal to these faces, and the problem does not arise.
2. You can edit the non-inflated faces by merging them, and so removing one of the internal edges. One way to merge the faces is to make use of the Merge Topology feature in DesignModeler; another way is to use the Virtual Topology feature in CFX-Mesh.

Geometry for Thin Surfaces

Suppose that you are trying to model a geometry which has a very thin feature (for example, a thin sheet of metal in an enclosure). If you mesh such a geometry as a three-dimensional feature, you would have to use a very small mesh edge length on the end of the thin protrusion. In CFX-5, you can model this as a two-dimensional Thin Surface as shown below.

The CFX-5 Solver treats each side of the Thin Surface uniquely and computes the flow variables for both sides separately.

The Thin Surface must be the face of a Solid Body, so to set up a Thin Surface in CFX-Mesh, you must have more than one Solid Body present in the model, and this must be a consideration when constructing the geometry. You can also set up a Composite 2D Region which actually forms the Thin Surface boundary condition for the CFD simulation, if you choose.

Thin Surface Topology Restrictions
2D Regions for Thin Surfaces

**Thin Surface Topology Restrictions**

The following points should be noted when creating geometries with Thin Surfaces:

- The Thin Surface must be the face of a Solid Body.
- The Thin Surface must have mesh on both its sides. For this reason it is not possible to create a Thin Surface that forms part of the external boundary of the model (unless it is embedded into a Periodic Pair - see below). Thin Surfaces are allowed to share a vertex or vertices with the model boundary.
- Thin Surfaces are allowed to share a vertex or vertices with a face forming a Section: Periodic Pair.
- If you need to embed a Thin Surface into a Periodic Pair, you must make sure that identical faces are embedded into each location of the Periodic Pair. The example below shows one possible configuration.

The following examples demonstrate the use of multiple Solid Bodies to create Thin Surfaces. There is usually more than one way in which the Solid Bodies can be defined to create the same Thin Surface.

**Example 1: Free Floating Thin Surface**

**Example 2: Attached Thin Surface**
In each case, the Solid Bodies have been created in order to put the Thin Surface at the edge of a Solid Body. They must also satisfy the rules for creating multiple Solid Bodies:

- Solid Bodies must not overlap.
- where Solid Bodies meet, they must share a common face.

In each case, the Solid Bodies are contained within the same part. More details on allowed configurations of Solid Bodies can be found in Section : Geometry and Topology for Solid Bodies.

**Example 2: Attached Thin Surface**

![Diagram of Solid Bodies and Thin Surface](image)

In each case, the Solid Bodies have been created in order to put the Thin Surface at the edge of a Solid Body. They must also satisfy the rules for creating multiple Solid Bodies:

- Solid Bodies must not overlap.
- where Solid Bodies meet, they must share a common face.

In each case, the Solid Bodies are contained within the same part. More details on allowed configurations of Solid Bodies can be found in Section : Geometry and Topology for Solid Bodies.

In addition, for case (1) above, the intersection between the two Solid Bodies must consist of two faces, one for the Thin Surface and one for the part not in the Thin Surface. To break the face which forms the intersection, you can use **Imprint Faces** in DesignModeler - see the DesignModeler Help for more details. In order to construct this geometry (1) in DesignModeler, you could

1. create the left-hand body (colored blue),
2. create the thin surface (colored red), perhaps by extruding a sketch containing a single line,
3. use the Body Operation **Imprint Faces**, selecting the thin surface as the **Bodies** and turning on **Preserve Bodies**,
4. freeze the model,
5. create the right-hand body (colored green),
6. use the Body Operation **Imprint Faces**, selecting the thin surface as the **Bodies** and turning off **Preserve Bodies**,
7. select both Bodies and combine them into one Part using **Tools>Form New Part**.
2D Regions for Thin Surfaces

To create a Composite 2D Region that will be used for a Thin Surface in CFX-Pre, simply create the Composite 2D Region on a face or faces required. After importing the mesh into CFX-Pre, you will find that two regions will exist - one for each side of the Thin Surface. You must then assign boundary conditions to BOTH sides to create a Thin Surface.

Poorly-Parameterized Surfaces

Some external CAD packages may allow some control over the type of surfaces which can be created. This section gives some guidelines which can be applied when using these CAD packages, in order to produce high-quality surfaces which are the most suitable for meshing. It is intended for advanced users only. You will need to refer to your CAD package's documentation to find out what control over surfaces it allows.

A four-sided surface is often a parametric surface, that is, it can be thought of as topologically equivalent to a flat square which has been distorted, as shown below. The position of a point upon the surface can then be described by the values of two parameters, $\xi_1$ and $\xi_2$, which usually take values in the range 0 to 1.

A poorly-parameterized surface is one where the shape of the surface is distorted so much that this parametric description of the surface becomes difficult to work with. For example, near the “corners” of the surface, a small change in actual position on the surface can lead to a very large change in the values of $\xi_1$ and $\xi_2$, or vice versa.

The parameterization of a surface can affect the quality of the mesh produced on it. For a non-trimmed parametric surface, the surface mesh is created on a unit square in parametric space. This mesh is then mapped back to corresponding physical locations on the actual surface. The uniformity of the mapping between parametric and physical space is an important factor in retaining the quality of the triangulation in physical space.

Parametric lines are the lines in physical space which map to even straight lines parallel to the edges of the square in parametric space. By visualizing the parametric lines on a surface, you can gain a qualitative representation of the parameterization of a surface; consult your CAD package documentation to see if this is possible within it. As a guide, the more uniform the distribution of these lines, the better the parameterization of the surface. Parametric lines should also not meet at very small or very large angles. You can clearly see that the parametric lines on the circular parametric surface meet at angles very far away from 90 degrees, when 10 equally-spaced parametric lines are used in the diagram below.
To improve the parameterization of the surface, it may be necessary to regenerate the surface in the original CAD package. To identify and fix poorly-parameterized surfaces, you need to understand how a surface is represented and how a mesh is created on the surface. One of the simplest examples is a unit cube. The six planar surfaces which share common edges form a solid enclosing a volume of 1 unit cubed. Let us assume that the edges of the cube are aligned with the three principle axes (X, Y, Z). The surface meshing algorithms implemented in CFX-Mesh are, in effect, two-dimensional meshing algorithms, creating a group of connected planar triangles for each individual planar surface of the cube. Each surface mesh is then mapped to the physical coordinates of the geometry. For a unit cube it is relatively simple to see how this mapping takes place. The two-dimensional coordinates map to each side of the cube, so \( \xi_1 \) and \( \xi_2 \) directly replace the x or y or z physical coordinates, as shown in the table and diagram below.

<table>
<thead>
<tr>
<th>Surface Location</th>
<th>Mapping ((\xi_1, \xi_2)) to ((x, y, z))</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low X</td>
<td>((0, \xi_1, \xi_2))</td>
</tr>
<tr>
<td>High X</td>
<td>((1, -\xi_1, \xi_2))</td>
</tr>
<tr>
<td>Low Y</td>
<td>((-\xi_1, 0, \xi_2))</td>
</tr>
<tr>
<td>High Y</td>
<td>((\xi_1, 1, \xi_2))</td>
</tr>
<tr>
<td>Low Z</td>
<td>((\xi_1, \xi_2, 0))</td>
</tr>
<tr>
<td>High Z</td>
<td>((\xi_1, -\xi_2, 1))</td>
</tr>
</tbody>
</table>

The range of \( \xi_1 \) and \( \xi_2 \) is \([0,1]\) (for a parametric surface) and in the case of a unit cube the coordinates \((x, y, z)\) also have a range \([0,1]\), so the mappings between \( \xi_1, \xi_2 \) and \( x, y, z \) are one-to-one. This is obviously not the case for all surfaces and geometries, simply stretching the unit cube in the x-direction by scaling the geometry using the vector \((3,1,1)\) immediately changes the mapping between \( \xi_1, \xi_2 \) and the x-coordinate. This implies that there is a direct relationship between the parametric and physical coordinates for a surface and that we need to consider the linearity of the mapping between the two coordinate systems. This is particularly true in the case of parametric surfaces where we mesh a unit square in parametric space which is mapped to the related geometrical surface. The following examples demonstrate particular problems:

- Example 1: Distorting the Square
- Example 2: Circle
- Example 3: Uneven Parametric Lines
- Example 4: Degenerate Surfaces
Example 5: Cusps

Example 1: Distorting the Square

(i)

In case (i) it is easy to see that any triangle created in parametric space will be mapped to a triangle in physical space which possesses the same internal angles.

(ii)

In case (ii), the internal angles of a mapped triangle can be seen to be different, but not by a significant amount.

(iii)

In case (iii) there is a significant variation in the internal angles and in the case where a triangle is created at the origin of \((\xi_1, \xi_2)\) the mapping to physical space does not create a valid triangle. The parametric lines provide you with guidance with respect to the amount of distortion relating to the parameterization.

Example 2: Circle

The second example is that of a circular parametric surface created from four curves. Near the “corners” of the surface (where \(\xi_1\) and \(\xi_2\) are zero, for example), a small change in actual position on the surface can lead to a very large change in the values of \(\xi_1\) and \(\xi_2\). The parametric lines are displayed to show the surface more clearly.
A workaround to this problem is to re-create the surface as some sort of planar surface which is trimmed by the circle boundary. In some CAD packages you may be able to do this by creating the circle from five edges rather than four.

**Example 3: Uneven Parametric Lines**

The uneven distribution of parametric lines can also cause surface meshing problems. This usually occurs when a surface is generated using a collection of unequally spaced curves. The image below shows the distribution of 8 parametric lines on a surface. The parametric lines are equally spaced vertically, however, horizontally this is not the case. It can be seen that two of the parametric lines are very close together and this means that when the mesh is mapped from parametric space to physical space the mesh will also be distorted, as shown in the second image.

Some CAD packages may allow such a surface to be refitted to have a more even distribution of the parametric lines. Otherwise the surface will have to be regenerated using a different method or using a collection of more evenly spaced curves.

**Example 4: Degenerate Surfaces**

Two examples of degenerate surfaces are shown below:

A degenerate surface occurs when one or more sides of the parametric quadrilateral surface used for meshing collapse to a singularity.

Degenerate surfaces should be recreated ensuring that the singularity is avoided. More information is given in Section : Degenerate Geometry.
Example 5: Cusps

Another example of a poorly-parameterized surface is shown below. The problem is the sharp point on the surface (the sharper the point, the more likely it is to cause a problem).

![Example of a poorly-parameterized surface](image)

This time, a large change in position may correspond to only a small change in $\xi_1$ and $\xi_2$.

One way to avoid this problem in some CAD packages is to break one of the curves into two pieces, so that that surface has five sides and can no longer be a parametric surface, as shown below.

Degenerate Geometry

Degenerate entities are those whose length, area or volume degenerate to zero because of the coincidence of one or more points or vertices.

Although CFX-Mesh can handle some forms of degenerate geometry, you may find that if you try to mesh degenerate geometry, you may get an error message when the surface or volume meshing operations encounter the degenerate geometry entity, and the meshing operation will terminate. Whether the mesher terminates at the surface meshing or volume meshing stage depends on the type of degeneracy it has encountered.

The most common problems with degenerate geometry occur as a result of importing parametric surfaces and parametric solids which comprise degenerate edges or faces. A parametric surface is a four-sided surface which is represented as topologically equivalent to a flat square which has been distorted (see Section: Poorly-Parameterized Surfaces). A parametric solid is a six-faced solid which is represented as topologically equivalent to a cube which has been distorted.

Surface Meshing

Surface meshing problems usually occur as a result of the surface mesher trying to mesh a surface of zero area. This can occur if your imported parametric solid or B-rep solid contains a solid face which has degenerated to an edge. Meshing problems will occur if:

- during creation of a B-rep solid your original surface list contained a zero area degenerate surface; or
- a zero area degenerate face is present in a parametric solid. This can occur if you used a degenerate entity to create the solid (e.g. creating a solid prism by extruding with a three-sided triangular parametric surface) or you explicitly defined a parametric solid with a degenerate face (e.g. by defining two pairs of vertices at the same location).
In both cases, depending upon the CAD package used to create the geometry, the solution could involve the following steps.

1. Disassemble your solid into its constituent surfaces.
2. Identify the zero area surface, and delete it.
3. Recreate a B-rep solid from the remaining surfaces.

**Volume Meshing**

Volume meshing problems with degenerate geometry tend to occur when Section : Inflation is used on faces which are connected to a degenerate edge of a non-inflated face. If Inflation cannot proceed along a non-inflated adjacent face edge the mesher will fail trying to create inflated elements. The general solution is to follow the guidelines for Inflation described in Section : Geometry and Topology for the Faces of an Inflated Boundary.

**Geometry Checking**

The geometry checking facility in CFX-Mesh checks for the presence of certain undesirable features in faces and edges, which can cause the mesher to generate a low quality mesh or to fail to generate a mesh at all.

You can access it by right-clicking on Geometry in the Tree View and selecting Verify Geometry. Alternatively, it is available from the Meshing Toolbar.

The results of all of the checks are given in warning messages which can be viewed under the Errors section of the Tree View. The last warning issued gives a summary of the checks:

```
Summary for CAD quality checking
--------------------------------
Sliver edge checking
-----------------------
Shortest edge  2.000E-02 (Tolerance =  2.100E-03)
Sliver face checking
---------------------
Worst sliver factor  1.273E+00 (limit =  2.500E+01)
Parameterization face checking
-----------------------------
Worst parameter  1.676E-07 (limit =  1.000E+01)
```

Other warnings are issued about particular faces or edges which fail each check. Clicking on any of the warnings which refer to faces will highlight the face it concerns. If it is difficult to see the highlighted face, you could hide the display of the geometry before clicking on the error. The part of the model causing the error will still highlight, which should make it much easier to see. Hiding the geometry (or part of the geometry) can be done by right-clicking on the name of the Body or Part under Geometry in the Tree View.

Note that a failed check may not necessarily result in a poor mesh, particularly if default tolerances are used. However, it may be worth checking the mesh on any faces which fail the checks, to ensure that a high-quality mesh has been achieved.

Also note that these checks will not pick up all problems which can be associated with the geometry; they only check for a few specific problems. General geometry requirements are described in Section : Geometry Requirements.
To set the limits and tolerances used to judge when an edge or face has failed the checks, you can use the Section: Verify Options under Geometry in the Tree View.

The individual checks are described separately:

- Section: Sliver Edge Checking
- Section: Sliver Face Checking
- Section: Parameterization Face Checking

**Sliver Edge Checking**

Sliver Edge Checking looks for short edges in the geometry. These edges can produce a mesh which is over-refined in regions near the short edges. A more detailed description and details on how these short edges can be removed is given in Section: Geometry Fixing: Short Edge Removal.

The default tolerance given depends upon the size of the geometry. As a general rule of thumb, you should start by adjusting this so that it is a bit less than the finest mesh length scale that you want to use, so that you can see regions where short edges will affect the mesh.

Sliver Edge Checking is one of the checks performed when using the Section: Geometry Checking feature. You can change the tolerance used for the check by using Section: Verify Options; valid values for the Short Edge Limit are anything above zero.

**Sliver Face Checking**

Sliver Face Checking computes a ratio of perimeter length to area for each face. This is known as the sliver factor. Faces with a high sliver factor can result in a poor quality surface mesh. The sliver factor associated with a face is computed as:

\[
\text{Sliver factor} = \frac{(\text{perimeter length})^2}{4\pi \times \text{surface area}}
\]

The table below shows some examples of sliver factors that would be computed.

<table>
<thead>
<tr>
<th>Surface Description</th>
<th>Sliver Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Square</td>
<td>1.27</td>
</tr>
<tr>
<td>Circle</td>
<td>1</td>
</tr>
<tr>
<td>Rectangle with sides 10 and 1 units</td>
<td>3.85</td>
</tr>
<tr>
<td>Rectangle with sides 100 and 1 units</td>
<td>32.47</td>
</tr>
</tbody>
</table>

When the Sliver Face Check is run, faces with a sliver factor greater than the limit set will be identified as potential sliver surfaces. The default value of 25 is usually sensible. Each face identified will be highlighted when the individual warning message is selected.

Sliver Face Checking is one of the checks performed when using the Section: Geometry Checking feature. You can change the limit used for the check by using Section: Verify Options. The Sliver Factor Limit must be greater than 1.0.

Faces identified that possess an unacceptable sliver factor may be removed by merging them with neighbouring faces. More details of this process can be found in Section: Virtual Faces.
**Parameterization Face Checking**

Parameterization Face Checking provides guidance on the parameterization quality of the surfaces. Each potentially poorly-parameterized surface will be highlighted when the individual warning message is selected.

More details on what is meant by face parameterization is given in Section: Poorly-Parameterized Surfaces.

Parameterization Face Checking is one of the checks performed when using the Section: Geometry Checking feature.

**Verify Options**

The **Verify Options** item (under Geometry in the Tree View) allows you to set the tolerances and limits for the Section: Geometry Checking feature.

The available options are:

- **Short Edge Limit** - This limit is used with Section: Sliver Edge Checking. When the check is performed, all edges which are shorter than this limit will generate warnings.
- **Sliver Factor Limit** - This limit is used with Section: Sliver Face Checking. When the check is performed, all faces which have sliver factors greater than the limit will generate warnings.

**Geometry Fixing: Short Edge Removal**

Sometimes, particularly with imported geometries, there may be some short edges which are part of the boundary of a face, where the length of the edges is much less than the required mesh spacing in that region of the geometry. Since the mesher will place a minimum of three points on every edge which makes up a face, the presence of these short edges will result in some elements that are of the same size as these short edges, rather than a mesh using the required spacing. This results in an uneven mesh with many more mesh elements than would have been desired.

To get round this problem, CFX-Mesh allows you to remove short edges. To set this up, use the **Fix Options** item under **Geometry** in the Tree View. The default is NOT to remove any edges.

If you set **Remove Short Edges** to **Yes**, then you will be asked for an Edge Length (which must be shorter than the Maximum Spacing set for the Default Body Spacing). All edges shorter than this length will be ignored by the mesher (although they will still show up in the geometry display) and the two ends will collapse to a point. You must make sure that the Edge Length specified is shorter than the mesh length scale at any point where edges may be removed, and you must also make sure that removing the edges does not cause any face to collapse (to give a face with zero area).

The pictures below show the effect of short edge removal. The face shown is a square with sides of 1 m. However, the bottom of it is made up from two edges: one is only 2 cm long and the other is 98 cm long. The mesh is shown first without short edge removal, meshed with a length scale of approximately 0.1 m. The short edge has caused a patch of fine mesh which was not required. The magnified inset clearly shows the mesh resolving the short edge.
The second picture shows the mesh after short edge removal. The edge tolerance was set to 0.08 m. The mesh is much smoother since it does not need to resolve the short edge.

Removing short edges in this way does not give you control over individual edges; you can only specify a length and then remove all edges shorter than this length. CFX-Mesh allows you to remove individual short edges in certain circumstances by merging them with adjacent edges to form a Virtual Edge. This is described in Section: Virtual Edges, and a comparison between the Short Edge Removal described in this section and Virtual Edges is given in Section: Virtual Edges and Short Edge Removal.
Suppression of Bodies and Parts

By default, all Parts and Bodies imported into CFX-Mesh are listed in the Tree View, displayed in the Graphics window and will appear in the surface and volume meshes. This behavior can be changed by using the Suppress functionality.

In order to suppress a Body or Part, right-click over the relevant entry under Geometry in the Tree View, and select Suppress. For example, to suppress Body 1, right-click on the entry for Body 1. To unsuppress a Body or Part which has previously been suppressed, right-click on its name and select Unsuppress. Note that suppressing a Part is equivalent to suppressing all of the Bodies within the Part.

Suppressing a Body has the following effects:

- The Body or Part will be listed in the Tree View as being suppressed, using the following status symbol: instead of or
- The Body will no longer be displayed in the Graphics window. This can make it easier to manipulate and select from geometrical objects in the Graphics window when you have complex geometries. (Note that you can also use the Hide functionality to achieve this effect.)
- The faces, edges and vertices of the Body are no longer available for selection. This means, for example, that if you have multiple Bodies and want to select all of the faces in one Body for a 2D Composite Region, then you can suppress all the other Bodies, use Box Select to select all visible faces, then unsuppress the other Bodies. (Note that you can also use the Hide functionality to achieve this effect.)
- The Body will not appear in any mesh that you generate. Features that are applied to a suppressed Body only will be ignored: for example, a Face Spacing which is applied to only a single face on a suppressed Body will be ignored as if it was suppressed itself. Features which is applied to both suppressed and unsuppressed Bodies will be applied to just the unsuppressed Bodies: for example, a Face Spacing which is applied to faces across several bodies will just be applied to those faces on unsuppressed Bodies. A Periodic Pair which has only faces from a suppressed Body in one of the two location lists will be ignored, even if the other location list contains faces from an unsuppressed Body.

Note that if you mesh multiple Bodies together, then in general you will get a different mesh than if you mesh each one separately (by suppressing all the Bodies and then unsuppressing them one at a time). This is because certain meshing features affect the mesh on nearby Bodies. An example of this would occur if you have a Face Spacing on Body 1 which is close enough to affect Body 2. If you mesh the two Bodies together, then Body 2 is affected by the Face Spacing. If you mesh Body 2 without meshing Body 1, then the Face Spacing is not applied and so the mesh on Body 2 is different. Features which can result in the mesh being different if Bodies are meshed separately include Face Spacings, the existence of shared faces between a suppressed Body and an unsuppressed Body, Periodic Pairs which are across multiple Bodies, and Surface Proximity.

The model must always be valid regardless of the state of the suppression of the Bodies. For example, you are not allowed to create a Section : Periodic Pair on any shared faces. Even if you suppress one of the Bodies which makes up half of that shared face so that it appears that the other half of the shared face is not shared any more, you are still not allowed to create a Periodic Pair on that face, because that would be invalid if the Body was then unsuppressed.

Note that suppressing a Body is different from hiding a Body. If you hide a Body, it is no longer available for selection and no longer displayed in the Graphics window; however, it will still be including in any meshing operation.
Control over how the Bodies are displayed is described in Section: Geometry Display.

**Geometry Display**

The display of geometry is controlled using the Geometry section of the Tree View. To change the appearance of the geometry, left-click on **Geometry** in the Tree View and modify the controls in the Details View.

The available controls are:

- **Transparency (%)** - Choose the transparency of the Bodies. 100% means that the geometry is completely transparent (i.e., it won't show up) and 0% means that the geometry is completely opaque.

- **Shine (%)** - Shine controls how much light is reflected by the faces of the Bodies. 0% gives the lowest amount of reflection and will result in the geometry looking matt in texture. 100% gives the most amount of reflection and will make the geometry very bright.

It is also possible to control which parts and bodies are displayed; this is described in Section: Suppression of Bodies and Parts.
Virtual Topology

By default, a surface mesh is generated on every face of every body to be meshed, and at least three mesh vertices are placed on each edge. Where there are very short edges or very narrow faces, this can result in you having to use a fine mesh length scale (and produce a large mesh) in order to resolve these edges and faces, even though the physics of your CFD problem may not require a fine mesh in these areas. If you do not resolve these small features, then the final mesh may be of low quality or the mesher may be unable to produce a mesh at all.

In order to remove this limitation, CFX-Mesh allows you to combine faces and edges into Virtual Faces and Virtual Edges. Once faces and edges have been combined in this way, then only the Virtual Faces and Virtual Edges are seen by the meshers, and you do not need to resolve their constituent narrow faces or short edges. Virtual Faces and Virtual Edges collectively are referred to as Virtual Topology.

General Information on Virtual Topology

The following rules apply to the creation of Virtual Topology:

- A Virtual Face or Virtual Edge may be created and then added to, or alternatively it may be included in a new Virtual Face or Virtual Edge. If an existing Virtual Face or Edge is added to a new Virtual Face or Edge and this is successfully created, the original Virtual Face(s) or Edge(s) will be removed from the Tree View.

- Once Virtual Topology is created, then as far as the rest of CFX-Mesh is concerned, the underlying merged faces or edges no longer exist; the Virtual Faces and Virtual Edges are seen instead. This means that if you perform, for example, a Section : Geometry Checking, then short edges which have been merged into Virtual Edges will no longer show up as being short edges. Faces which have been merged into a Virtual Face will no longer be available for selection; you will only be able to select the Virtual Face. Virtual entities can be used wherever the ordinary geometric entities of the same type can be used.

- If, for example, you have two faces in Face Spacing 1, and you then create a Virtual Face from these two faces, then CFX-Mesh treats this as if the two faces had disappeared from the geometry and one new one (the Virtual Face) had appeared. This means that the new Virtual Face will be added to the Default Face Spacing (not Face Spacing 1) and the existing Face Spacing, which no longer contains any valid geometry, will be marked as invalid. In general, on creation of a Virtual entity, CFX-Mesh checks to see whether the CAD entities (faces, edges, vertices, etc.) that were present prior to the creation of entity still exist. It then updates the features in the Tree View as follows.
  - If the geometric location for a CFX-Mesh feature (e.g. a list of faces for a Face Spacing) consists entirely of geometric entities which no longer exist, then CFX-Mesh marks that feature as invalid by using the invalid status symbol. In order to make the model valid again, you must either delete that feature or modify it to specify an appropriate location for the feature (perhaps the new Virtual Face).
  - If the geometric location for a CFX-Mesh feature (e.g. a list of faces for a Face Spacing) consists of both geometric entities which no longer exist and entities which do still exist, then the non-existent entities are removed from the location list. For example, if a Face Spacing is applied to three faces, and after the creation of the Virtual Face one of these faces no longer exists, then the Face Spacing will be automatically modified so that after the creation of the Virtual Face, it is applied to just the two remaining faces. Where features are automatically updated in this way, CFX-Mesh marks them as such by using the status symbol. Where you see this symbol after creating Virtual Topology, you are advised to check that the feature is applied to where you expect it to be. If you want to change this symbol back to the normal symbol, simply click on the feature name in the Tree View then click next to Location in the Details View and just press Apply without modifying anything.
Virtual Topology

- New Virtual Faces are automatically added to the Default 2D Region, Default Face Spacing and Default Preview Group.

After the creation of Virtual Topology, you should always check that your existing mesh settings are still applied to their required location.

- If you perform a Geometry Update after creating Virtual Topology, then the Virtual Topology will continue to be applied in its existing locations provided that all of these locations exist. If any of the locations no longer exist, then the Virtual entity will be marked as invalid and you will have to remove it in order to make the model valid again. You can, of course, then add another Virtual entity to take its place.
- Virtual Topology is removed along with all other settings if you choose to Clear Settings.

Virtual Faces

Virtual Faces are created by merging together two or more faces from the geometry to make one larger surface. The reason why you might want to do this is to avoid having to mesh individual faces. Normally, a surface mesh is created for every face of each body which is being meshed. In order to produce a reasonable quality mesh (or in some cases, any mesh at all) on a face which is very narrow, you may need to use a very small mesh length scale (and hence a large mesh) for regions where the physics of the CFD model do not require this. If you can merge such narrow faces with other faces, then you can drastically increase the mesh length scale in this region, which will result in a mesh with fewer elements. Additionally, you may be able to merge faces together in such a way that very small angles on the original surfaces are eliminated, which also leads to a higher quality mesh.

The following simple example shows the use of Virtual Faces.

The geometry contains a very narrow face (only 0.25 mm across compared to the overall dimensions of 30 mm cubed.).
If it is just meshed without Virtual Topology, then even though overall mesh length scale is relatively coarse, a region of very fine mesh is produced around the narrow face to resolve.
Create a Virtual Face from the three faces along the front left of the cube, to merge the narrow face with its immediate neighbors.

Now when the mesh is created, the coarse mesh length scale is used to mesh right across the narrow face, which is no longer resolved, as required. The creation of a Virtual Face will, where possible, automatically merge its external edges to form Virtual Edges. If this is not desired, automatic merging of edges bounding a new virtual surface can be turned off on the Virtual Topology section of the Options panel. The figure to the left shows the behaviour if automatic edge merging is turned on (the default).
This figure shows the behaviour if automatic edge merging is turned off. This results in a fine mesh along the two short edges that are left where the ends of the narrow surface used to be. Even if automatic edge merging is turned off, you can create any desired Virtual Edges manually; see Section: Virtual Edges.

To create a Virtual Face, right-click on Virtual Topology in the Tree View, and select Insert > Virtual Face. You can then select the faces required from the Graphics window (you cannot select faces by selecting a Composite 2D Region). All faces must be adjacent so that the Virtual Face is a single continuous entity. Virtual Faces are NOT restricted to groups of surfaces where the angle between the average combined surface normal and any normal on the combined faces exceeds 90 degrees. However, Virtual Faces cannot form a closed region, for example, all six sides of the cube shown above cannot be combined into a Virtual Face, but if any one of the sides of the cube is not included, then the new Virtual Face is not a closed region and creation is allowed.
Note that if you merge faces which do not meet at a tangent, then the sharp angle where they meet will be rounded off over a distance of approximately 1 local element size.

Virtual Faces cannot be created on shared faces.

Some general notes on Virtual Topology (which apply to Virtual Faces) are given in Section : General Information on Virtual Topology.

**Virtual Edges**

Virtual Edges are created by merging together two or more edges from the geometry to make one larger edge. The reason why you might want to do this is to avoid having to mesh an individual edge. Normally, when the surface mesh is created for a face, at least three nodes are placed on every edge. This will result in a very fine mesh near short edges, in regions where the physics of the CFD model do not necessarily require this. If you can merge these short edges with other edges, then you can drastically increase the mesh length scale in this region and make a mesh containing fewer elements.

The following simple example shows the use of Virtual Edges. Virtual Edges can be used to eliminate edges independent of the presence of Virtual Faces.
The geometry is a cube which contains six square faces, each of side length 30 mm. However, two of the edges are broken into three segments each, including a very short edge of only 0.25 mm across. The mesh is very refined around the two short edges.
Create a Virtual Edge from three edges to merge the short edge with its immediate neighbors. Also create another Virtual Edge from the three edges at the bottom of the cube to merge that short edge, too (not shown in the diagram).

Now when the mesh is created, the coarse mesh length scale is used to mesh right across the whole geometry, with no need for small elements near where the short edge used to be.

To create a Virtual Edge, right-click on Virtual Topology in the Tree View, and select Insert > Virtual Edge. You can then select the edges required from the Graphics window. All edges must be adjacent so that the Virtual Edge is a single continuous entity. You can only merge edges which form part of the boundary of the same two faces.

Some general notes on Virtual Topology (which apply to Virtual Faces) are given in Section: General Information on Virtual Topology. See Section: Virtual Edges and Short Edge Removal for a discussion of how Virtual Edges are different from Short Edge Removal.
Virtual Edges and Short Edge Removal

CFX-Mesh contains two ways of removing short edges: Short Edge Removal and Virtual Edges. This section describes the differences between them.

Short Edge Removal removes all edges shorter than a certain length (which you specify) in the geometry. When the mesher sees a short edge which is to be removed, the behavior is as if the edge was collapsed to zero length: a single node is placed at one end of the edge and no other nodes are put on the edge at all. As a result, you can only merge short edges which are shorter than the local mesh length scale, or your resulting mesh will be badly distorted. There is no individual control over which edges should be regarded as short; all edges below the specified length scale will be removed.

The creation of a Virtual Edge is effectively a merger of two or more edges, creating a single, longer edge. The mesher will place nodes along the Virtual Edge with no regard for where the original edges were. There is no requirement that the merged edges are smaller than the mesh length scale. However, you can only merge edges which are shared between the same two faces of the geometry. You have individual control over which edges are merged and must create each Virtual Edge separately.

Short Edge Removal and Virtual Edges can be used in the same mesh setup. Where the setup contains both, Virtual Edges take precedence i.e. Virtual Edges are created first, and then Short Edge Removal removes any remaining edges of a length shorter than the given length scale.

In general, where it is possible, it is recommended that you remove short edges by using Virtual Edges rather than Short Edge Removal. This approach results in greater consistency with other features of CFX-Mesh.

Some examples are shown in the table below.

<table>
<thead>
<tr>
<th>Example</th>
<th>Geometry</th>
<th>Mesh with short edge</th>
<th>Mesh without short edge</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><img src="image1" alt="Geometry Image" /></td>
<td><img src="image2" alt="Mesh with short edge" /></td>
<td><img src="image3" alt="Mesh without short edge" /></td>
</tr>
</tbody>
</table>

In this example, the short edge to be eliminated can be removed by using Short Edge Removal, providing that the mesh length scale is large enough and there are no shorter edges elsewhere in the geometry that you need to keep. In this example the mesh length scale is only a few times longer than the length of the short edge and so there is a very slight distortion in the mesh where the node from one end of the edge has been collapsed onto the node at the other end of the edge. The short edge cannot be removed using Virtual Edges because there is no edge shared between the same two faces that it can be merged with.
In this example there is a whole series of short edges to be removed. Short Edge Removal cannot be used because the entire length of the series of edges would be collapsed and the distortion would be too large. However, the series of short edges can be merged into one Virtual Edge.

In this example, either Short Edge Removal could be used or the short edge could be merged with its neighbor to its right to make Virtual Edge. The decision on which method to use would depend on whether you had other short edges you wanted to remove and whether you needed the individual control that you get by using Virtual Edges. The resulting mesh produced by the two methods is slightly different. The top mesh, produced by Short Edge Removal, is very slightly distorted since the mesh length scale is not much greater than the length of the short edge. The bottom mesh is produced by the Virtual Edge method.
Regions

The geometry which defines your simulation is a collection of one or more Solid Bodies and the faces which bound them. CFX-Mesh has several features which require you to select some part of the geometry in order to provide a location for the feature.

CFX-Mesh also allows you to give names to parts of the geometry. These Composite Regions can then be used for specifying locations in CFX-Mesh. They will also label collections of nodes or elements in the mesh output from CFX-Mesh, for use in the CFX-Pre. Currently, only Composite 2D Regions can be created in CFX-Mesh.

You do not need to define any Composite Regions in CFX-Mesh, since you can always select the parts of the geometry directly in CFX-Mesh. Mesh associated with particular Solid Bodies and faces is accessible in CFX-Pre even without creating a Composite Region. However, it is often much easier or clearer to select parts of the geometry for a Composite Region and then to use it by name later during the mesh setup than it is to select the geometry directly each time it is to be used. It is also easier to select and name parts of the geometry (for use in the CFD simulation) within CFX-Mesh than it is to select the appropriate mesh regions within CFX-Pre.

The Regions part of the Tree View contains details of all of the Composite Regions which have been defined in the model.

2D Regions

When you are asked to select a 2D Location for your meshing feature, in most cases you will be able to select 2D Regions directly from the geometry or from a list of Composite 2D Regions which you have previously defined.

If your geometry has more than one solid body meeting at a shared face, then you need to understand the difference between a 2D Region and a face.

Available Composite 2D Regions are shown under Regions in the Tree View.

2D Regions and Faces

CFX-Mesh will often ask you to select one or more 2D Regions for the location of a meshing feature. Where two Solid Bodies meet at a common face, there is just one face present in the geometry; however, there are two 2D Regions, as shown in the example below.

If your model has only one solid, then each face is also a 2D Region, and vice versa. If your model has more than one solid, then all of the external faces will also be 2D Regions. However, two 2D Regions will exist for every shared (internal) face (assuming that you have combined the solids into the same part). Each meshing feature that requires you to specify a location has its own rules about whether or not you can set different properties for the two 2D Regions which make up a shared face.
**Composite 2D Region:** You may include any combination of 2D Regions in a Composite 2D Region (including just one or both sides of a shared face). However, if you are going to use a Composite Region to specify the location for any other meshing feature, then you must make sure that it only includes 2D Regions which satisfy the requirements of the appropriate feature.

**Section: Face Spacing:** It is important that you do not try to apply different Face Spacings to 2D Regions which are the two sides of a common face, since the surface mesh is generated on the common face, not on the 2D Regions separately. It is acceptable to include a 2D Region which forms one half of a shared face in a Face Spacing without including the other side of the shared face, but only if the 2D Region which forms the other side is not included in any other Face Spacing (other than the Default Face Spacing).

**Section: Inflated Boundary:** When creating an Inflated Boundary, you can have different settings for the two different 2D Regions which make up a common face i.e. you can apply Inflation to one 2D Region and not the other, or to both but with different settings. The example below shows the difference in one particular case.

If you try to pick a 2D Region which is half of a shared face, then the Selection Rectangles will appear. Each shared face will be represented by two rectangles which are attached to each other, one for each side or 2D Region, as shown below. You can use these rectangles to select individual 2D Regions easily and accurately.
CFX-Mesh will not allow you to select locations for meshing features which break the rules given for each feature.

**Composite 2D Regions and Default 2D Region**

In places where you are required to select a 2D Region to specify a location for a meshing feature, CFX-Mesh recognizes two types of 2D Region: Primitive and Composite. The *primitive* regions are those which exist in the geometry by default: there is one for every external face and two for each shared face (see Section : 2D Regions and Faces for more details). You can select these 2D Regions directly from the geometry in the Graphics window. The *composite* regions are those which you create explicitly, and consist of one or more primitive 2D Regions which you select and give a name to.

You can create a Composite 2D Region from any single primitive 2D Region or group of primitive 2D Regions. No primitive 2D Region can be assigned to more than one Composite 2D Region. A Default 2D Region is created by CFX-Mesh and cannot be renamed or deleted; this always contains any primitive 2D Regions that have not been used in other Composite 2D Regions, and its contents change dynamically as you create and modify other Composite 2D Regions. In this way, every primitive 2D Region is always assigned to exactly one Composite 2D Region. You must always leave at least one primitive 2D Region in the Default 2D Region.

To create a Composite 2D Region, right-click over Regions in the Tree View, and select Insert>Composite 2D Region. You can then select the required primitive 2D Regions from the Graphics window. A Composite 2D Region can be deleted or renamed by right-clicking over its name in the Tree View.

You can use the Composite 2D Regions to specify locations for meshing features in CFX-Mesh, rather than having to select the faces individually. Simply click on the name of the Composite 2D Region from the Section : Tree View to select it, instead of clicking on the faces in the Graphics window.

Any Composite 2D Regions that you create in CFX-Mesh appear in CFX-Pre and can be used as locations for boundary conditions and domain interfaces. The 2D Regions and their names are written to the Section : CFX-Pre Mesh File with the mesh. Even if you do not specify any Composite 2D Regions in CFX-Mesh, mesh on the primitive 2D Regions will still be available for selection to define boundary conditions in CFX-Pre. However, the following advantages apply if you create at least some Composite 2D Regions in CFX-Mesh:

- It may be easier to select the primitive 2D Regions you require in CFX-Mesh than in CFX-Pre.
- If the faces you need are not available to be selected, then you will find this out before meshing the geometry, rather than creating the mesh and then discovering that the face you need is not available in CFX-Pre. This might happen, for example, if two faces that you expected to be separate actually form a single face, due to the way that you created the geometry.

You may also want to create additional Composite 2D Regions if, for example, you want to create plots on individual or groups of faces during post-processing.

**Named Selections**

Named Selections created in DesignModeler can be imported into CFX-Mesh as Composite 2D Regions.

This functionality has to be enabled before it can be used, and then it only applies to new CFX-Mesh databases. Existing databases (from both this release and previous releases) cannot be updated to use Named Selections if it is not enabled when they are created.

You can choose to enable this functionality for all databases or on a database-by-database basis. To enable it for all new databases, do the following:
1. Open the Options dialog box, either from Tools>Options or from the Start page which appears when you first open ANSYS Workbench.

2. Under Common Settings > Geometry Import, set Named Selection Processing to Yes.

3. To import all Named Selections regardless of their name, remove all characters from the Named Selection Prefix setting. If you want to restrict the import of Named Selection according to their names, then enter the Named Selection prefix key into the Named Selection Prefix box. All Named Selections whose name starts with this prefix will then be imported.

4. Named Selections will then be imported into CFX-Mesh every time you start a new CFX-Mesh database from a DesignModeler database which contains Named Selections.

If you only want to enable this functionality for selected databases, then do the following:

1. On the Project Page, select the DesignModeler geometry file.

2. On the left-hand side of the Project Page, you will see a series of Default Geometry Options. Set the Named Selections options to be on.

3. To import all Named Selections regardless of their name, remove all characters from the type-in box to the right of the Named Selection option setting. If you want to restrict the import of Named Selection according to their names, then enter the Named Selection prefix key into this type-in box. All Named Selections whose name starts with this prefix will then be imported.


In CFX-Mesh there are restrictions on the use of Composite 2D Regions, in that no primitive 2D Region can be assigned to more than one Composite 2D Region. This restriction does not apply to Named Selections when created in DesignModeler and therefore, when geometry containing Named Selections is imported into CFX-Mesh, the Named Selections will be ignored if they do not comply with the rules governing CFX-Mesh Composite 2D Regions. The warning message will reference the Named Selections that are causing the problem. If this occurs, then you will need to return to DesignModeler and remove the Named Selection(s) that overlap. In CFX-Mesh, you can then perform an Update Geometry or open the geometry in a new CFX-Mesh session.
Meshing Features

The following functions are available to control the mesh generation process:

- Section: Body Spacing
- Section: Face Spacing
- Section: Edge Spacing
- Section: Point Spacing
- Section: Point Control
- Section: Line Control
- Section: Triangle Control
- Section: Periodicity
- Section: Inflation
- Section: Stretch
- Section: Proximity
- Section: Mesh Options

**Spacing**

You can specify the background mesh length scale for a body or bodies by using a Section: Body Spacing.

You can also specify the mesh length scale for particular faces or edges using a Section: Face Spacing or Section: Edge Spacing. A Face or Edge Spacing can also influence the mesh in the nearby volume.

Other controls over the mesh length scale at any given point are described in Section: Controls, Section: Stretch and Section: Proximity.

**Body Spacing**

The Body Spacing for a body gives the background length scale for its volume i.e. the length scale before any Section: Face Spacing, Section: Controls or other explicit length scale controls are applied. It should be set to the coarsest length scale required anywhere in the body, since no elements can be created that are larger than the Body Spacing in that body.

One Body Spacing exists by default: “Default Body Spacing”. This applies to all bodies. Only one parameter can be controlled for the Default Body Spacing:

- **Maximum Spacing** - This is the maximum element size which will be used when creating triangles on the faces of the body and tetrahedra in the volume of the body. The default is set to around 5% of the maximum extent of the model. CFX-Mesh will accept any length (greater than zero) for this size.

Currently, no other Body Spacing objects may be created.
Face Spacing

A Face Spacing is used to specify the mesh length scale on a face (or faces) and in the volume adjacent to the selected faces.

One Face Spacing exists by default: “Default Face Spacing”. This applies to all faces which have not been explicitly selected for inclusion in other Face Spacings. Each additional Face Spacing is applied to a face or faces which you must select.

To create a new Face Spacing, right-click on Spacing in the Tree View. After creation, Face Spacings (except the Default Face Spacing) can be deleted, suppressed (made inactive) or renamed by right-clicking on their names in the Tree View.

You must specify the following information to define a Face Spacing:

- **Face Spacing Type** - This can be set to one of four types:
  - Section : Angular Resolution
  - Section : Relative Error
  - **Constant** - Set a Constant Edge Length for the faces, overriding the Section : Body Spacing. You cannot set this length scale to be larger than the Maximum Spacing specified in the Default Body Spacing.
  - **Volume Spacing** - Use the same spacing on the face as the Maximum Spacing specified for the Body on the faces selected.

- **Minimum Edge Length** - Enter the Minimum Edge Length for the surface mesh on the faces. This only applies when Angular Resolution or Relative Error has been selected as the Face Spacing Type.

- **Maximum Edge Length** - Enter the Maximum Edge Length for the surface mesh on the faces. This only applies when Angular Resolution or Relative Error has been selected as the Face Spacing Type. It must be given a value between the Minimum Edge Length and the Maximum Spacing set under Default Body Spacing.

- **Radius of Influence** - Specify the extent of the Face Spacing influence. If, for example, you specify a Radius of Influence of 2 cm then the region of space within 2 cm of the Face Spacing is filled with mesh with the same length scale as on the face itself. Beyond the Radius of Influence, the size of the elements expands as you move away from the faces, in accordance with the Expansion Factor. This parameter does not apply when the Face Spacing Type is set to Volume Spacing.

- **Expansion Factor** - Specify how fast the mesh length scale returns to its background value away from a region where it has been constrained by a Face Spacing. Each successive element as you move away from the face (outside the Radius of Influence specified above) is approximately one Expansion Factor larger than the previous one. Hence large values tend to coarsen the mesh rapidly away from the face. This parameter also governs how fast a local surface length scale that has been overridden near a curve (because of its curvature) expands back to its global value. It therefore controls both the rate of growth of volume elements away from faces and the rate of growth of surface elements away from curved boundaries into the middle of a flat face. It does not apply when the Face Spacing Type is set to Volume Spacing. Expansion Factors should be between 1.0 and 1.5.

- **Location** - Select the face(s) of the model from the Graphics window to use for the Face Spacing. You can either select faces directly from the Graphics window or select Composite 2D Regions (or the Default 2D Region) from the Tree View. The Default Face Spacing does not allow you to make this selection, since it automatically applies to all faces which have not been explicitly selected for inclusion in other Face Spacings.
A face cannot be in more than one Face Spacing. If you have multiple Solid Bodies in your geometry, then you should read the information on the difference between faces and 2D Regions to understand how you can apply Face Spacings to the faces which form the boundaries between the bodies.

The figure below shows a Face Spacing on a 1 m cube, with a Constant Edge Length of 0.05 m, Radius of Influence 0.2 m, and Expansion Factor 1.2.

Any Face Spacing other than the Default Face Spacing will have a volumetric effect, except when set to use the Volume Spacing. The Radius of Influence determines the volume that the Face Spacing is applied to away from the face. This will affect both the volume mesh and the surface mesh on faces within the Radius of Influence.

The Radius of Influence can be set to zero, in this case the Face Spacing is applied only to the selected faces. A volumetric effect will still be seen as the edge length scale is expanded back into the volume mesh, but the expansion will begin as soon as you move away from the face.

When Face Spacings are used (other than the Default Face Spacing using the Volume Spacing option), then nearby faces may also be affected. For example, if you create a Face Spacing with a Radius of Influence of 2 cm, then another face which is 2 cm away will also be affected. In order to achieve this, the surface mesher will run twice; once to generate an initial mesh and detect faces which are within the region of influence of a Face Spacing, and then a second time after reducing the local background mesh length scale based on the proximity of faces.

**Edge Spacing**

An *Edge Spacing* is used to specify the mesh length scale on an edge (or edges) and in the volume adjacent to the selected edges.

To create a new Edge Spacing, right-click on *Spacing* in the Tree View. After creation, Edge Spacings can be deleted, suppressed (made inactive) or renamed by right-clicking on their names in the Tree View.

You must specify the following information to define an Edge Spacing:

- **Edge Spacing Type** - This can be set to one of four types:
  - Section : Angular Resolution
  - Section : Relative Error
- **Constant** - Set a Constant Edge Length for the edges, overriding the Section : Body Spacing. You cannot set this length scale to be larger than the Maximum Spacing specified in the Default Body Spacing.

- **Volume Spacing** - Use the same spacing on the face as the Maximum Spacing specified for the Body on the faces selected.

- **Minimum Edge Length** - Enter the Minimum Edge Length for the surface mesh on the edges. This only applies when Angular Resolution or Relative Error has been selected as the Edge Spacing Type.

- **Maximum Edge Length** - Enter the Maximum Edge Length for the surface mesh on the edges. This only applies when Angular Resolution or Relative Error has been selected as the Edge Spacing Type. It must be given a value between the Minimum Edge Length and the Maximum Spacing set under Default Body Spacing.

- **Radius of Influence** - Specify the extent of the Edge Spacing influence. If, for example, you specify a Radius of Influence of 2 cm then the region of space within 2 cm of the Edge Spacing is filled with mesh with the same length scale as on the edge itself. Beyond the Radius of Influence, the size of the elements expands as you move away from the edges, in accordance with the Expansion Factor. This parameter does not apply when the Edge Spacing Type is set to Volume Spacing.

- **Expansion Factor** - Specify how fast the mesh length scale returns to its background value away from a region where it has been constrained by an Edge Spacing. Each successive element as you move away from the edge (outside the Radius of Influence specified above) is approximately one Expansion Factor larger than the previous one. Hence large values tend to coarsen the mesh rapidly away from the edge. It does not apply when the Edge Spacing Type is set to Volume Spacing. Expansion Factors should be between 1.0 and 1.5.

- **Location** - Select the edge(s) of the model from the Graphics window to use for the Edge Spacing. You can select edges directly from the Graphics window.

An edge cannot be in more than one Edge Spacing.

The figure below shows an Edge Spacing on a 1 m cube, with a Constant Edge Length of 0.05 m, Radius of Influence 0.2 m, and Expansion Factor 1.2.

Any Edge Spacing will have a volumetric effect, except when set to use the Volume Spacing. The Radius of Influence determines the volume that the Edge Spacing is applied to away from the edge. This will affect both the volume mesh and the surface mesh on faces within the Radius of Influence.
The Radius of Influence can be set to zero, in this case the Edge Spacing is applied only to the selected edges. A volumetric effect will still be seen as the edge length scale is expanded back into the volume mesh, but the expansion will begin as soon as you move away from the edge.

When Edge Spacings are used, then nearby edges and faces may also be affected. For example, if you create an Edge Spacing with a Radius of Influence of 2 cm, then another edge or face which is 2 cm away will also be affected.

There are certain circumstances where an Edge Spacing may not have the effect which you intend i.e.:

- one or both faces which are adjacent to the edge with the Edge Spacing have a Face Spacing defined with the Angular Resolution or Relative Error option, and
- the Edge Spacing refines the spacing on the edge to less than the Minimum Edge Length set for the one or both of the Face Spacings on the adjacent faces.

In this case the nodes are placed on the edge in accordance with the Edge Spacing. However, when nodes are then placed on the adjacent face(s) with the Minimum Edge Length which is greater than the local edge spacing, the mesh length scale immediately transitions to the Minimum Edge Length specified by the Face Spacing (rather than expanding away using the Expansion Factor specified by the Edge Spacing). This can result in significant distortion of the mesh. Under some circumstances, the mesher is able to detect when this would occur, and if it does so, it will coarsen the spacing on the edge back to the Minimum Edge Length of the face with the largest Minimum Edge Length. This can make it appear as if the Edge Spacing is being ignored. If the mesher is unable to detect in advance when a distorted mesh would be obtained, then it will warn you about the poor angles in the resulting surface mesh as necessary. The type of distortion obtained in such a case is shown in the second figure below. In either case, the way to avoid the situation occurring is to set the Minimum Edge Length of the Face Spacing(s) of the two adjoining faces to be less than or equal to the smallest edge length arising from the Edge Spacing.

The following two figures show examples of this.

In the first figure, the two faces shown have a Face Spacing which is defined to give a Constant edge length of 2 mm. The edge in the center has an Edge Spacing which gives a Constant edge length of 0.15 mm. You can see that the mesh spacing transitions smoothly from 0.15 mm on the edge to the 2 mm on the face, and the surface mesh is of a high quality.

The second figure shows an example where the Edge Spacing does not have the desired effect. The two faces shown have a Face Spacing defined using the Angular Resolution option, with a Minimum Edge Length of 1.9 mm and a Maximum Edge Length of 2.0 mm. The edge in the center has an Edge Spacing which gives a Constant edge length of 0.15 mm. The resulting mesh is distorted and of a poor quality. The way to avoid this is to set the
Minimum Edge Length of the Face Spacing to less than or equal to the smallest edge spacing arising from the Edge Spacing.

**Angular Resolution**

The Angular Resolution option for Section : Face Spacing and Section : Edge Spacing allows the edge length on particular faces or edges to vary depending upon the local curvature. That is, a short edge length is used where the face or edge is highly curved, and a longer edge length is used where it is flatter. It is used for automatically refining the mesh in geometries that have curved faces or edges and can replace the need for other Section : Controls in such geometries. It has a similar effect to using the Section : Relative Error setting, but is specified differently.

In order to control how much the curvature is resolved, you must set the **Angular Resolution** parameter. This represents the maximum angle allowed to be subtended by the arc between two adjacent surface mesh nodes. When the angle is made smaller, more nodes will be placed on the edge or surface to resolve the curvature better. CFX-Mesh will allow you to set this parameter to anything between 1.0 degree and 90.0 degrees.

When this option is used, you can set a *Minimum* and *Maximum Edge Length* in the Details View for the Face Spacing, to prevent over-refinement in regions of high curvature and over-coarsening on flat faces.

**Relative Error**

The Relative Error option for Section : Face Spacing and Section : Edge Spacing allows the edge length on particular faces or edges to vary depending upon the local curvature. That is, a short edge length is used where the face or edge is highly curved, and a longer edge length is used where it is flatter. It is used for automatically refining the mesh in geometries that have curved faces or edges and can replace the need for other Section : Controls in such geometries. It has a similar effect to using the Section : Angular Resolution setting, but is specified differently.
In order to control how much the curvature is resolved, you must set the **Relative Error**. The Relative Error is the maximum deviation of the resulting mesh away from the geometry face or edge expressed as

\[
error = \frac{\Delta r}{r}
\]

where \( r \) is the local radius of curvature. The value entered should be in the range of approximately 0.00004 to 0.292, which corresponds to 360 edges and 4 edges per circumference, respectively. When the Relative Error is made smaller, more nodes will be placed on the edge or face to resolve the curvature better.

**Controls**

Mesh **Controls** are used to refine the surface and volume mesh in specific regions of your model. The mesh refining effect decays with increasing distance from the control, generating progressively coarser elements. Controls can be defined using any point on the model (e.g. corners of faces) or by specifying coordinates. They can be located anywhere in the 3D space of your model: inside, outside or on the edge.

Three types of volumetric Controls are available: Point, Line and Triangle. In addition, a volumetric effect may be obtained by using a Section : Face Spacing.

- Point Spacing
- Point Control
- Line Control
- Triangle Control

You can suppress (make inactive) all of the Controls in the model by right-clicking on **Controls** in the Tree View.

**Point Spacing**

Each of the three volumetric controls (Point, Line, and Triangle) require you to specify spacing attributes for the Control at appropriate points. A **Point Spacing** is a set of values which can be used for this purpose. There are three required values:

- **Length Scale** - a length scale for the mesh size in the locality of the point to which the Point Spacing is applied. This must be less than the Maximum Spacing set under Default Body Spacing.
- **Radius of Influence** - the radial extent of the fixed local length scale influence. If, for example, you specify a Radius of Influence of 2 cm then the region of space within 2 cm of the Control is filled with mesh with the length scale given by the Length Scale specified above.
- **Expansion Factor** - the mesh coarsening rate is determined by a geometric expansion factor. Each successive element as you move away from the Control (outside the radius specified above) is approximately
one Expansion Factor larger than the previous one. Hence large values tend to coarsen the mesh rapidly from the Control. Expansion Factors should be set to between 1.0 and 1.5.

A new Point Spacing can be created by right-clicking on Controls in the Tree View and selecting Insert>Point Spacing. After creation, a Point Spacing can be renamed, deleted or duplicated by right-clicking on its name in the Tree View. Note that Delete is only available if the Point Spacing is not in use by a Point, Line or Triangle Control. Also note that if you duplicate a Point Spacing, its values are copied into the new Point Spacing, but there is no further link between them i.e. if you change the original Point Spacing, then the duplicate will not be updated in any way.

**Point Control**

A Point Control controls the mesh spacing in a spherical region.

You must specify two things to define a Point Control:

- **Point** - You can select a point for the Control by selecting a vertex from the model, selecting an arbitrary point on the model faces or by specifying its coordinates. See Section : Point Selection for details.

- **Spacing** - Select a Section : Point Spacing which defines the mesh attributes for the Point Control (Length Scale, Radius of Influence and Expansion Factor). To make the selection, click in the box next to Spacing, click on the name of the required Point Spacing in the Tree View, and then click on Apply back in the Details View.

The figure below shows a Point Control on a 1 m cube, with Length Scale 0.05 m, Radius of Influence 0.2 m, and Expansion Factor 1.2.
A new Point Control can be created by right-clicking on **Controls** in the Tree View and selecting **Insert>Point Control**. After creation, a Point Control can be renamed, suppressed (made inactive), deleted or duplicated by right-clicking on its name in the Tree View. Note that if you duplicate a Point Control, its settings are copied into the new Point Control, but there is no further link between them i.e. if you change the original Point Control, then the duplicate will not be updated in any way. If you want to suppress all the Controls in the model, right-click over **Controls** and select **Suppress**.

Once a Point Control is created and is valid, then if you click on its name in the Tree View, the Point Spacing that it refers to will be highlighted, and a small graphic similar to the one shown below will appear at the location of the Point Control.

![Graphic of Point Control](image)

In this graphic, the small sphere at the center shows you where the point itself is located. The middle sphere (green in the picture) shows you the mesh **Length Scale** at that point, and the largest sphere (blue) shows you the **Radius of Influence**. If the **Radius of Influence** is zero, then this sphere will not show up separately.

**Line Control**

![Graphic of Line Control](image)

A Line Control controls the mesh spacing in a region defined by a cylindrical volume between two spheres.

You must specify a Point location and a Section : Point Spacing for each of two points to define a Line Control. The line for the control is the straight line between the two end-points, not the model edge which joins the two points (if any).

Each of the two points which form the line can have different Point Spacings, which means different settings of Length Scale, Radius of Influence, and Expansion Factor. Where the settings for any parameter are different, the two values are blended linearly as you move along the line.

The items you need to specify for a Line Control are:

- **Point 1 / Point 2** - You can select points for the Control by selecting a vertices from the model, selecting arbitrary points on the model faces or by specifying coordinates. See Section : Point Selection for details.
- **Spacing Definitions** - If you want to specify the same Section : Point Spacing for both points, set **Spacing Definitions** to Uniform. If you want to specify a different Section : Point Spacing for each point, set **Spacing Definitions** to Individual.

- **Spacing / Spacing 1 / Spacing 2** - Select a Section : Point Spacing which defines the mesh attributes. If you selected to set one Point Spacing for both points, then the selection you make for **Spacing** will apply to both points; if you selected to set a different Point Spacing for each point, then you must separately select a **Spacing 1** and **Spacing 2** to apply to Point 1 and Point 2 respectively. To make the selection, click in the box next to **Spacing / Spacing 1 / Spacing 2**, click on the name of the required Point Spacing in the Tree View, and then click on **Apply** back in the Details View.

The figure below shows a Line Control on a 1 m cube, with Length Scale 0.05 m, Radius of Influence 0.2 m, and Expansion Factor 1.2.

![Line Control](image)

A new Line Control can be created by right-clicking on **Controls** in the Tree View and selecting **Insert>Line Control**. After creation, a Line Control can be renamed, suppressed (made inactive), deleted or duplicated by right-clicking on its name in the Tree View. Note that if you duplicate a Line Control, its settings are copied into the new Line Control, but there is no further link between them i.e. if you change the original Line Control, then the duplicate will not be updated in any way. If you want to suppress all the Controls in the model, right-click over **Controls** and select **Suppress**.

Once a Line Control is created and is valid, then if you click on its name in the Tree View, the Point Spacing that it refers to will be highlighted, and a small graphic similar to the one shown below will appear at the location of the Line Control.

![Graphic](image)

In this graphic, the red line shows you where the line is located. The inner spheres (green in the picture) shows you the mesh **Length Scale** at that point, and the outer spheres (blue) shows you the **Radius of Influence**. If the **Radius of Influence** is zero, then the green spheres will not show up separately.

**Triangle Control**

![Triangle Control](image)
A *Triangle Control* controls the mesh spacing in a region defined by a prismatic volume between three spheres.

You must specify a Point location and a Section : Point Spacing for each of the three points needed to define the triangle. The triangle is formed from the three lines which join up the points, regardless of where the model faces are.

Each of the three points which form the triangle can have different Point Spacings, which means different settings of Length Scale, Radius of Influence, and Expansion Factor by selecting different Spacing Definitions to apply at each point. Where the settings are different, the three values are linearly blended as you move around the triangle.

The items you need to specify for a Triangle Control are:

- **Point 1 / Point 2 / Point 3** - You can select points for the Control by selecting a vertices from the model, selecting arbitrary points on the model faces or by specifying coordinates. See Section : Point Selection for details.

- **Spacing Definitions** - If you want to specify the same Section : Point Spacing for all three points, set Spacing Definitions to *Uniform*. If you want to specify a different Section : Point Spacing for each point, set Spacing Definitions to *Individual*.

- **Spacing / Spacing 1 / Spacing 2 / Spacing 3** - Select a Section : Point Spacing which defines the mesh attributes. If you selected to set one Point Spacing for all three points, then the selection you make for Spacing will apply to all the points; if you selected to set a different Point Spacing for each point, then you must separately select a Spacing 1, Spacing 2 and Spacing 3 to apply to Point 1, Point 2 and Point 3 respectively. To make the selection, click in the box next to Spacing / Spacing 1 / Spacing 2 / Spacing 3, click on the name of the required Point Spacing in the Tree View, and then click on Apply back in the Details View.

The figure below shows a Triangle Control on a 1 m cube, with Length Scale 0.05 m, Radius of Influence 0.2 m, and Expansion Factor 1.2.
A new Triangle Control can be created by right-clicking on Controls in the Tree View and selecting Insert>Triangle Control. After creation, a Triangle Control can be renamed, suppressed (made inactive), deleted or duplicated by right-clicking on its name in the Tree View. Note that if you duplicate a Triangle Control, its settings are copied into the new Triangle Control, but there is no further link between them i.e. if you change the original Triangle Control, then the duplicate will not be updated in any way. If you want to suppress all the Controls in the model, right-click over Controls and select Suppress.

Once a Triangle Control is created and is valid, then if you click on its name in the Tree View, the Point Spacing that it refers to will be highlighted, and a small graphic similar to the one shown below will appear at the location of the Triangle Control.

In this graphic, the red triangle shows you where the triangle is located. The inner spheres (green in the picture) shows you the mesh Length Scale at that point, and the outer spheres (blue) shows you the Radius of Influence. If the Radius of Influence is zero, then the green spheres will not show up separately.

### Periodicity

Some CFD simulations can make effective use of periodic pair boundary conditions, which force the flow leaving at one face to re-enter at that face’s equivalent in the periodic mapping. The CFX-5 Solver is capable of making more accurate calculations on this type of boundary condition if the mesh on each face in the periodic boundary is identical to the mesh on the equivalent face in the periodic mapping. The use of Periodicity allows you to generate identical meshes for faces that will later be specified as part of a periodic boundary condition in the
simulation set-up. This is achieved by the specification of Periodic Pairs in CFX-Mesh. When you create a Periodic Pair, you supply two faces (or lists of faces) and a transformation which maps one face (or list) onto the other face (or list). The mesh on these two faces (or lists of faces) is then constrained to be identical.

Periodic Pair

Geometry Requirements for Periodic Pairs
Mesh Generation Process for a Periodic Pair
Extruded Periodic Pair

Periodic Pair

To define a Periodic Pair, right-click on Periodicity in the Tree View and choose Insert>Periodic Pair. The use of Periodic Pairs is described in Section: Periodicity.

You must specify the following items for the Periodic Pair definition:

- **Location 1** - Select a face or a set of faces of the model from the Graphics window. You can either select faces directly from the Graphics window, or select a Composite 2D Region from the Tree View. In either case, all the faces selected must be on the external boundary of the model and must not be included in an Inflated Boundary.

- **Location 2** - Select a face or a set of faces of the model from the Graphics window. The faces must be related to those selected for Location 1 as described in Section: Geometry Requirements for Periodic Pairs. Again, you can either select faces directly from the Graphics window, or select a Composite 2D Region from the Tree View.

- **Periodic Type** - This can either be set to Translation or Rotation. If Translation is selected, then in most cases no further input is required. If, however, Rotation is selected, then you must specify the axis, by specifying any two points on it. You can select the points by selecting a vertices from the model, selecting arbitrary points on the model faces or by specifying coordinates. See Section: Point Selection for details.

- **Translation Vector** - In certain cases, CFX-Mesh cannot determine automatically what the translation vector for a translational periodic pair is. In these cases, you will be asked to supply the translation vector for the Periodic Pair explicitly. You should specify the translation vector which moves the faces in Location 1 to those in Location 2.

- **Angle of Rotation** - In certain cases, CFX-Mesh cannot determine automatically what the rotation angle for a rotational periodic pair is. In these cases, you will be asked to supply the rotation angle for the Periodic Pair explicitly. You should specify the angle which rotates the faces in Location 1 to those in Location 2, using the right-hand rule. The vector for the rotation axis is the vector between the specified Point 1 and Point 2. Only angles greater than zero are permitted. If your setup requires the use of an angle less than zero, then switch Point 1 and Point 2 to reverse the rotation axis. See the picture below.
After creation, a Periodic Pair can be renamed, suppressed (made inactive) or deleted by right-clicking on its name in the Tree View. If you want to suppress all the Periodic Pairs in the model, right-click over Periodicity and select Suppress.

When a Periodic Pair has been created, then if you click on its name in the Tree View, the faces it is using will be highlighted. In addition, if the Periodic Pair is rotational, the axis of rotation will be shown as a highlighted line.

More than one Periodic Pair can be created, as required.

**Geometry Requirements for Periodic Pairs**

Strict rules regarding the location and topology of faces in the Section : Periodic Pair are enforced. For a valid Periodic Pair, each face in the Location 1 face list must map to an equivalent face in the Location 2 face list under either a rotation or translation. The mapping must be the same for each pair of faces. Multiple faces can be selected for each of Location 1 and Location 2, provided each face in the Location 1 face list maps onto a face in the Location 2 face list using the specified transformation. Both the topology and location of the faces is checked to ensure that they are valid through the transformation specified in the Details View. The transformation or Periodic Type can either be Translation by a fixed vector or Rotation.

If it is not possible to conform to these rules for your geometry, then you should create standard Composite 2D Regions for the periodic faces (one for each half of the periodic pair). You will then be able to make a periodic boundary using these faces when setting up your CFD simulation, but the mesh will not be identical between the faces, which will reduce the accuracy of the CFX-5 solver on these boundaries.

**Mesh Generation Process for a Periodic Pair**

When a Section : Periodic Pair has been specified, the surface mesher generates a surface mesh on all the faces in the Location 1 list using all the available Control and Spacing information. It then uses the transformation to map the mesh to the faces in the Location 2 list. These then form the basis for the remaining surface mesh generation.

It is possible for Section : Controls to affect the mesh in unexpected locations when Periodic Pair regions are used. Controls originally located outside a Solid Body can be copied into the Body through the transformation and affect the local face and volume mesh length scale.

The process which the mesher uses to generate mesh on periodic faces is as follows:

1. The faces are checked with the transformation.

2. Controls are mapped using this transformation.
3. A surface mesh is produced for **Location 1**.

4. The surface mesh for Location 1 is mapped to Location 2.

5. The remaining faces are meshed.

**Extruded Periodic Pair**

An Extruded Periodic Pair is a specific example of a more general Periodic Pair. It is used to define the transformation when using the Extruded 2D Mesh capability. More details about the Extruded Periodic Pair and the rules for its creation can be found in Section : Extruded 2D Meshing.
Inflation

In near-wall regions, boundary layer effects give rise to velocity gradients which are greatest normal to the face. Computationally-efficient meshes in these regions require that the elements have high aspect ratios. If tetrahedra are used, then a prohibitively fine surface mesh may be required to avoid generating highly distorted tetrahedral elements at the face.

CFX-Mesh overcomes this problem by using prisms to create a mesh that is finely resolved normal to the wall, but coarse parallel to it. The mesher can use the local face element normals to ‘inflate’ 2D triangular face elements into 3D prism elements at selected walls or boundaries. You can control the creation of these elements and determine their size and distribution in near-wall regions.

The figures below show the inflated mesh region and the transition between the inflation mesh and the tetrahedral mesh.

![Inflated mesh region and transition to tetrahedral mesh](image)

You can set different inflation parameters for different faces. When two inflated faces meet at a common edge and use different inflation heights, the heights are smoothed.

To apply inflation to any face in the model, you must define an Section : Inflated Boundary which includes that face. The Inflation process is controlled by a global set of parameters (located under Inflation in the Tree View), as well as the parameters set for an individual Inflated Boundary. These are described in:

- Section : Inflation - Details
- Section : Inflated Boundary
Inflation can be applied to all ordinary boundaries but not to boundaries specified as a Section : Periodic Pair. Inflation also can be applied to faces which are internal to the region to be meshed, and you can choose separately to inflate off either side of the face. How to do this is described in Section : 2D Regions and Faces.

**Inflation - Details**

The following parameters are available for Section : Inflation and provide global control over all Inflated Boundaries. All can be set using the Details View for the Inflation object in the Tree View.

- **Number of Inflated Layers** - This controls the number of inflation layers. If **First Layer Thickness** is used to specify the thickness of the inflation layer, then this is a maximum number of inflation layers. Otherwise, it will be the actual number of inflation layers, except in places where layers are removed locally for reasons of improving mesh quality (e.g. where inflation layers would otherwise collide with each other). The Number of Inflated Layers is restricted to be no more than 50.

- **Expansion Factor** - The relative thickness of adjacent inflation layers is determined by a geometric expansion factor. Each successive layer, as you move away from the face to which the Inflation is applied, is approximately one Expansion Factor thicker than the previous one. Expansion Factors must be set to between 1.0 and 1.5.

- **Number of Spreading Iterations**
- **Minimum Internal Angle**
- **Minimum External Angle**
- **Inflation Option** - This option controls how the inflation height is specified. The two options are:
  - First Layer Thickness
  - Total Thickness

**First Layer Thickness**

You can select this option and specify a height for the first prism layer by selecting **First Layer Thickness** as the **Inflation Option** on the Details View for Inflation. This option does not control the overall height of the inflation layers, but creates prisms based upon the First Prism Height, Expansion Factor and Number of Inflated Layers (all set on the Details View for Inflation). This method of inflation creates a smoother transition from the inflated prism mesh elements to the tetrahedral mesh elements than the alternative, which is to set the **Inflation Option** to Section : Total Thickness.

The process used for creating the layers of prisms when using the First Layer Thickness option (with **Extended Layer Growth** set to No) is as follows:

1. Put a single layer of prisms against the faces of the inflated boundary, of a height equal to the **First Prism Height**.
2. Check the aspect ratio of the prisms (ratio of height to base length). Where this is unity or the height is already greater than the base length, stop adding prisms. Where the height is still less than the base length, add another layer of prisms of height calculated by multiplying the height of the previous layer by the Expansion Factor.
3. Repeat step 2 until all the prisms have a height approximately equal to the base length, or until the **Number of Inflated Layers** setting is reached (this setting is used as a maximum number of inflated layers).
If you set **Extended Layer Growth** to **Yes**, then you can carry on adding prisms even after the aspect ratio has reached 1. The prisms are added with a height equal to the base length, until the **Number of Inflated Layers** is reached. The following two pictures show the difference.

The upper picture shows the situation where **Extended Layer Growth** is set to **No**, the default. Although the **Number of Inflated Layers** was set to 20, only 14 layers have been created, because unit aspect ratio was reached. The lower picture shows the situation where **Extended Layer Growth** is set to **Yes**. The extra 6 layers have now been added, all with a height equal to their base length.

The First Prism Height must be less than the Maximum Spacing set under Default Body Spacing.

It is recommended that you examine the mesh wherever possible to allow you to visualize the extent of the inflation and the quality of the transition from the prisms to the tetrahedral elements. You can view the inflated mesh (and see the extent of the inflation) by using a Section : Preview Group. The Details View for Preview allows you to specify exactly how you view the inflated mesh. The full volume mesh can be viewed in CFX-Post.

The following two images help to demonstrate the effect of enabling the First Layer Thickness option. The first image uses default values and the Total Thickness option, and the second uses a specified First Prism Height.
The following two images help to demonstrate the effect of combining Section : Controls with a specified First Prism Height. The first image uses default values and the Total Thickness option with the Point Control, and the second uses a specified First Prism Height.

An additional option is **Layer by Layer Smoothing**, which by default is set to No. This option allows prisms to grow out normal to the surface, i.e. orthogonal to the surface, the layer normals and heights are then progressively smoothed, during the creation of each layer, to maximize the number of layers obtained. Layer by Layer Smoothing can only be employed when the Inflation Option is First Layer Thickness. Note that invoking Layer by Layer Smoothing will result in longer mesh generation times as the smoothing process is applied on each prism layer rather than just the once that happens by default.
Total Thickness

You can select this option by selecting **Total Thickness** as the **Inflation Option** on the Details View for Inflation.

With this option enabled, the total thickness of the inflation is controlled by the **Thickness Multiplier**, the local element edge length and the **Maximum Thickness**. (The local element edge length is determined by the Section : Face Spacing and Section : Controls, and the Maximum Thickness is set individually for each Section : Inflated Boundary.)

This method of inflation creates a less smooth transition from the inflated prism mesh elements to the tetrahedral mesh elements than the alternative, which is to set the **Inflation Option** to Section : First Layer Thickness. However, the number of inflated layers is more constant, and you can have some control over the height of the inflation layers on a face-by-face basis, given that the Maximum Thickness parameter can be specified separately for each individual Inflated Boundary.

The process used for creating the layers of prisms when using the Total Thickness option is given below:
1. Calculate the total thickness of the inflation layers as follows:
   a. Multiply the Thickness Multiplier by the local element edge length.
   b. Where this is less than the specified Maximum Thickness, then this gives the total thickness of the layers.
   c. Where this is greater than the specified Maximum Thickness, then the Maximum Thickness is taken to be the total thickness of the layers.

2. Use the specified Number of Inflated Layers and Expansion Factor to calculate the height of each layer, given the total thickness that has just been calculated.

If the element edge length changes in the region of the inflation layer, due to (say) a Control, then the inflation thickness will not be constant over the inflated face. The figure below shows what happens to the inflation thickness in the vicinity of a Point Control.

Additionally, sometimes inflation layers may be removed (for example, where the inflation layers from two different faces would otherwise collide) and this will also cause the total thickness of the inflation layer to decrease.

Some comparisons between the effect of choosing the Total Thickness option and choosing the First Layer Thickness option are shown in Section: First Layer Thickness.

**Advanced Quality Checking**

There are two controls associated with the quality of the resulting prism elements in the inflated layers. The two controls are set on the Details View for **Inflation**. In general, you will not need to change these.

**Number of Spreading Iterations** - This governs how far the effects of deleted elements propagate. By default it is set to zero and only the original elements marked for deletion will actually be deleted. However by increasing this value, neighboring elements are also marked for deletion. The value specifies the number of layers of neighboring elements that are also deleted. It cannot be set to above 10.
For adjacent inflation boundaries where the relative gap between inflation elements is small, interstitial tetrahedral elements can become distorted. Increasing the number of spreading iterations reduces the probability of this occurring, although the default settings do not usually require modification.

**Minimum Internal Angle** - This governs the minimum angle that is allowed in the triangular face of a prism nearer to the surface before it is deemed to be of unacceptable quality and marked for deletion. The default value is 2.5 degrees but you may want to increase this if you are having problems with high aspect ratio elements adjacent to inflated layers. You must set a value between 0.0 and 40.0 degrees.

**Minimum External Angle** - This governs the minimum angle that is allowed in the triangular face of a prism farthest from the surface before it is deemed to be of unacceptable quality and marked for deletion. The default value is 10 degrees but you may want to increase this if you are having problems with high aspect ratio elements adjacent to inflated layers. You must set a value between 0.0 and 40.0 degrees. This parameter controls the minimum angle in a triangular face seen by the tetrahedral volume mesher, triangles containing small angles are more difficult to create tetrahedral on and therefore increasing this parameter will increase the reliability of the volume mesher.

**Inflated Boundary**

The creation of an Inflated Boundary is how you specify which faces you want **Inflation** to apply to. There are some limitations on the topology that you can have for the inflation process to work well.

When creating an Inflated Boundary, you must specify two things:

- **Location** - Select the face(s) of the model from the Graphics window. You can either select the faces directly from the Graphics window, or select a Composite 2D Region from the Tree View. A face cannot be in more than one Inflated Boundary, and it may not be in both an Inflated Boundary and a Section : Periodic Pair. If you have multiple Solid Bodies in your geometry, then you should read the information on the difference between faces and 2D Regions to understand how you can apply Inflation to the faces which form the boundaries between the bodies and determine which side(s) of these faces have Inflation.

- **Maximum Thickness** - Set the Maximum Thickness for the whole inflation layer. The way that this parameter is used is described in Section : Total Thickness. It must be set to a value less than the Maximum Spacing set under Default Body Spacing. The parameter is not used if the Inflation Option is set to First Layer Thickness in the Section : Inflation - Details.

A new Inflated Boundary can be created by right-clicking on **Inflation** in the Tree View and selecting **Insert>Inflated Boundary**. After creation, an Inflated Boundary can be renamed, suppressed (made inactive) or deleted by right-clicking on its name in the Tree View. If you want to suppress all the Inflated Boundaries in the model, right-click over **Inflation** and select **Suppress**.
A inflated boundary can also be created on any internal face; this includes faces that are intended to be Thin Surfaces. Inflation will not occur on an exposed edge of such a face, as such the inflation layers will be gradually reduced to zero as the mesh approaches the exposed edge nodes.

You can also choose to inflate only one side of a face that will be used as a Thin Surface. How to do this is described in Section: 2D Regions and Faces.

There are some considerations to make when setting up the Inflated Boundary, particularly when setting the Maximum Thickness (and not using First Layer Thickness):
- Inflating Between Thin Gaps
- Inflating the Inside Walls of Cylindrical Pipes

**Inflating Between Thin Gaps**

When using the Section: Total Thickness option from the Inflation Details, care must be taken when inflating from faces which are close but not touching. If the Thickness Multiplier is set to 1 (the default) and the Maximum Thickness is set to anything larger than the local mesh length scale on the faces in question, then the total thickness of the inflation layer is approximately equal to the local length mesh scale. In this case, if you ensure that the local length scale is less than a quarter of the gap thickness then this will allow inflation to be performed between the gaps in a way that leaves a sufficient gap for the volume mesher to fill the remaining void with good quality tetrahedra.
If you change the setting of the Thickness Multiplier and/or the Maximum Thickness, then you will have to ensure that enough of a gap remains between the inflation layers for the volume mesher to be able to fill the remaining void with good quality tetrahedra.

The refinement of the surface mesh in order to fulfil this criteria can be undertaken automatically using Section: Surface Proximity, and the default setting of four elements across the gap satisfies exactly this criteria.

**Inflating the Inside Walls of Cylindrical Pipes**

If you inflate the inside walls of a cylindrical pipe then there are two potential problems:

- The inflated layers will grow towards each other and eventually collide on the axis of the cylinder. Even if they stop short of colliding they will leave a narrow cylindrical void that must be filled by the volume mesher.
- The quality of the exposed element faces on the inflated layer deteriorates as the thickness of the inflated layer grows. The face topology of the inflated triangulated face is the same as the original one so the the exposed triangles have a greater aspect ratio.

If the inflation thickness is too great then the resulting void can be difficult to mesh and can lead to either

- volume meshing failure, or,
- high aspect ratio elements in the volume mesh.

When using the Section: Total Thickness option in the Inflation Details View, then providing that the Thickness Multiplier is set to 1 (the default) and the Maximum Thickness is set to something larger than the local mesh length scale on the faces which form the cylinder, then the total thickness of the inflation layer is approximately equal to the local mesh length scale.

A simple calculation shows that in this case, the inflated layers will not meet in the middle as long as there are at least seven equal sub-divisions around the circumference of the pipe. For a more typical value of sub-divisions, i.e. 12 or more, it will also guarantee that the resulting void is not too thin and that the exposed faces are of a reasonable quality.

If you do encounter problems, there are a number of possible solutions:

- Increase the number of sub-divisions around the circumference of the pipe. This can be done by applying a Section: Face Spacing to the faces of the cylinder.
- Modify the Maximum Thickness of the inflated layers on these faces to restrict their growth. This can be done in the Details View of the Section: Inflated Boundary that they are part of.
- Increase the value of the Minimum External Angle. This will ensure that any prismatic elements with a high aspect ratio triangular face are removed from the inflated layer. The parameter can be changed using the Details View for Section: Inflation.
Increase the Number of Spreading Iterations. This will increase the number of layers that are removed when a collision is detected and should leave a larger gap. The parameter can be changed using the Details View for Section: Inflation.

**Stretch**

*Stretch* can be used to expand or contract the mesh elements in a particular direction. In practice, the geometry is expanded by the specified factors, meshing takes place and then the geometry is contracted back to its original size.

The Stretch object is present in the Tree View by default. Three items are required to specify the stretch:

- **Stretch in X** - Stretch in the X-direction (default is 1.0)
- **Stretch in Y** - Stretch in the Y-direction (default is 1.0)
- **Stretch in Z** - Stretch in the Z-direction (default is 1.0)

The maximum and minimum stretches allowed are 0.2 and 5.0 respectively. Stretch factors below 0.6 are not recommended.

The following pictures show the effect of stretching.

Before stretching:

![Before stretching](image)

After stretching:

![After stretching](image)
When a stretch factor is used, the effective influence of a Section : Point Control, which is treated as a spherical mesh control whilst meshing takes place, will NOT be modified to elliptical. Hence a Point Control will appear to influence an elliptical region when the mesh is examined; this is caused by the modified influence of the mesh control not being mapped between stretched and non-stretched space. A Section : Line Control and Section : Triangle Control will be affected in a similar way.

Stretch cannot be used if the Extruded 2D Meshing option is enabled. Any stretch factors set will be ignored.

**Proximity**

The *Proximity* settings control automatic refinement of the mesh when edges or faces are found to be in close proximity to other edges or faces, but not connected. There are two types of proximity setting:

- Section : Edge Proximity
- Section : Surface Proximity

Edge Proximity is ON by default, but Surface Proximity is OFF.

**Edge Proximity**

When *Edge Proximity* is enabled, your model will be examined for locations where relatively small mesh elements are used on a curved face in close proximity to relatively large coarse elements on a flat face. In these locations, the coarse elements will be automatically refined to improve the model in this region.

The effect of using Edge Proximity is carried over to adjacent faces. This can be seen in the figure below where the mesh has been refined on the lower face when Edge Proximity is ON.
There are no user controls for Edge Proximity, other than allowing it to be enabled and disabled. The default is for it to be enabled.

Edge Proximity is only available when using the Section : Delaunay Surface Mesher.

**Surface Proximity**

When *Surface Proximity* is enabled, your model will be examined for locations where distinct faces are in close proximity. The surface mesh will then be automatically modified to reduce the mesh size in regions where faces are in close proximity and the original mesh does not resolve the gap sufficiently.

When using Surface Proximity, you need to specify two things:

- **Number of Elements Across Gap** - The aim when Surface Proximity is enabled is to have at least the number of elements specified by this setting spanning the gap between the faces. We do not recommend using a value less than the default of 4. This will allow higher quality inflated (prismatic) and tetrahedral volume elements to be created in the gap region. If you use values of 1 or 2, and inflation is applied to the faces, then you may encounter meshing problems. The maximum allowed setting is 10.

- **Maximum Number of Passes** - This specifies the maximum number of times that the surface mesher will run in order to satisfy the criteria for **Number of Elements Across Gap**. It must be between 1 and 10.

The Surface Proximity process requires an initial surface mesh to be generated. The relative proximity of triangular face elements is then compared with the size of the triangles themselves. If the triangular element size is greater than $1/n$ of the gap between the faces, where $n$ is the setting of **Number of Elements Across Gap**, then local mesh controls are introduced into the mesh and the surface mesh is modified.

The process allows the mesh length scales to be reduced by a factor of 2 each time the mesh is regenerated, and the process is applied up to a maximum of $n$ times, where $n$ is the **Maximum Number of Passes**. This results in the Surface Proximity option potentially reducing an original triangular edge to $1/2^n$ of the initial length if the maximum reduction in length scale is applied on each pass of the surface meshing. For reference, a setting of $n = 5$ gives up to a 1/32 reduction in edge length, and this corresponds to an original triangle being replaced by approximately 1000 triangles.

Surface Proximity is available for both the Section : Delaunay Surface Mesher and Section : Advancing Front (AF) Surface Mesher. An example of the effect of Surface Proximity is shown below.
The surface mesh was created using Angular Resolution as the Section : Face Spacing option. This refines the mesh on the cylindrical pipes but not the box. It can be seen that the mesh on the cylindrical pipes is considerably finer where the pipes are in close proximity and the same is true where the pipe and box are close. In the corresponding volume mesh (not shown), the number of volume elements crossing the gap region is 4.

Caution should be exercised on geometries where one geometrical component intersects a second component at an acute angle. If Surface Proximity is used in this case, the mesh length scale may be dramatically reduced in the region of the intersection. It is important, therefore, to introduce a minimum mesh length scale, possibly using the Minimum Edge Length available when the Angular Resolution option is used for the Section : Face Spacing.

Note that if you have multiple parts which are very close together (e.g. they would have a shared face if the parts were combined into one part), then using Surface Proximity can result in unexpected refinement on the faces which are close to faces from the other parts. If this is a problem, then you can instead mesh each part separately: this can be achieved by suppressing all but one part in CFX-Mesh and meshing that, and then repeating for every other part.

**Mesh Options**

The following settings are available under the Options part of the Tree View:

- Section : Global Mesh Scaling
- Section : Surface Meshing
Global Mesh Scaling

The Global Mesh Scaling factor is a property of the whole mesh, and is set using Options settings in the Tree View.

Every length scale (except for those applied to Face Spacings) that you set anywhere in CFX-Mesh is multiplied by the Global Mesh Scaling factor before meshing takes place. This can be very useful if you have set up a mesh including several Controls and then want to refine it uniformly without having to change all of these settings.

The Global Mesh Scaling Factor can be given a value between 0.5 and 2. Making it smaller makes the mesh length scales smaller i.e. gives you a larger mesh.

Only mesh length scales are affected by the Global Mesh Scaling factor. For example, the Radius of Influence for Controls is not affected. This makes its behaviour different to just using Section : Stretch with Stretch in X, Stretch in Y and Stretch in Z all set to the same values. If you try to scale the mesh using the Stretch functionality in this way, then all lengths (including Radius of Influence) will be affected.

Note that the Global Mesh Scaling factor is only applied at the meshing stage. For instance, the display of the size of Controls will show the size as if the Global Mesh Scaling factor is set to 1, although when the mesh is generated, the actual size of the mesh in the vicinity of the Control will be affected by this factor.

Surface Meshing

Two surface meshers are available in CFX-Mesh:
- Delaunay Surface Mesher
- Advancing Front (AF) Surface Mesher

Delaunay Surface Mesher

Delaunay surface meshing is characterized by its speed and its ability to mesh closed faces. In general it is recommended that the Delaunay Surface Mesher be used for surface meshing, and this is the default. In some cases where faces are poorly-parameterized, improved mesh quality may be obtained by using the Section : Advancing Front (AF) Surface Mesher.

The surface mesher used by CFX-Mesh can be changed using the Options settings in the Tree View.

Advancing Front (AF) Surface Mesher

The Advancing Front Surface Mesher is slower than the Section : Delaunay Surface Mesher, but for some geometries it can be more robust and may produce a higher quality mesh. It is not possible to mesh closed faces using the AF Surface Mesher.

The surface mesher used by CFX-Mesh can be changed using the Options settings in the Tree View.

Meshing Strategy

The Meshing Strategy option, set on the Details View for Options in the Tree View, controls the global behaviour of the mesher. This setting has fundamental implications for the type of meshing which takes place. The following options are available.
Advancing Front and Inflation 3D - This is the default choice of meshing strategy. This meshing strategy creates a 3D mesh consisting of tetrahedra, with prisms and pyramids if Section : Inflation is used. Most models will require the use of this meshing strategy.

Extruded 2D mesh - This meshing strategy allows you to generate a 2D or simple extruded mesh. It is only applicable for geometries (or parts of geometries) which can be created by a rotation or translation of a collection of faces. It generates a mesh consisting of prisms, with hexahedra if Section : Inflation is used.

These options are described in more detail below:

- Section : Advancing Front and Inflation 3D
- Section : Extruded 2D Meshing

Advancing Front and Inflation 3D

Advancing Front and Inflation 3D is the default meshing strategy, creating a 3D mesh consisting of tetrahedra, with prisms and pyramids if Section : Inflation is used. Most models will need to use this strategy. If this is selected (on the Details View for Options in the Tree View), then you have a further choice of your Volume Meshing method. Both methods use the Advancing Front Volume Mesher and will produce essentially the same mesh. The two choices are:

- Advancing Front - This is the default choice for volume meshing. It uses the Advancing Front Volume Mesher to generate a mesh using a single processor on your local machine (the machine which is running ANSYS Workbench).
- Parallel Advancing Front - This choice uses the Advancing Front Volume Mesher to generate a mesh using more than one process on your local machine. You may wish to use this if you are generating a large mesh and want to speed up the mesh generation process on a machine with more than one processor, or to overcome the memory limitations of a single process.

The Advancing Front Volume Mesher is described in Section : Advancing Front Volume Mesher, and using it in parallel is described in Section : Parallel Volume Meshing.

Advancing Front Volume Mesher

The Advancing Front Volume Mesher is the default volume mesher in CFX-Mesh. It includes Section : Inflation, which is used for resolving the mesh in the near wall regions to capture flow effects for viscous problems. The Advancing Front Volume Mesher will rapidly generate a mesh consisting of tetrahedra (and prisms and pyramids if Section : Inflation is used), with low memory usage.

When the volume mesh of tetrahedral elements (together with prismatic and pyramidal elements if Inflation is used) is generated, it is written to the Section : CFX-Pre Mesh File.

Parallel Volume Meshing

When using Section : Advancing Front and Inflation 3D as the Section : Meshing Strategy (under Section : Mesh Options in the Tree View), you can use Parallel Volume Meshing by selecting Parallel Advancing Front for Volume Meshing. This allows you to generate your volume mesh using multiple processes on the same or different machines. You may wish to use this if you are generating a large mesh and want to speed up the mesh generation process, or to overcome the memory limitations of a single process. You should note that this feature is separately licensed, although if you have licenses which allow you to run the CFX-S Solver in parallel, then you should also be able to perform volume meshing in parallel.
Parallel Volume Meshing has been implemented to increase the maximum mesh size that can be created. You can also speed up mesh generation by running in parallel. A typical speed-up is of the order of 50% when using 4 processors on a mesh greater than 5 million tetrahedral elements. To achieve a reasonable speed-up, we do not recommend using less than 500,000 elements per partition for a tetrahedral mesh.

If you select to use the Parallel Advancing Front option, then you must specify the Parallel Meshing option. The two choices are:

- **PVM Local Parallel** - Generates the mesh in parallel using multiple processes on the same machine (your local machine).
- **PVM Distributed Parallel** - Generates the mesh in parallel on multiple processors spread over your local machine and other machines. This is a beta feature.

When using Parallel Volume Meshing, the meshing process divides the geometry up into sections (“partitions”) which are meshed separately (one in each process specified) and then the mesh is consolidated into one volume mesh. A volume mesh produced in parallel is indistinguishable from a volume mesh produced in serial (using only one process). You will NOT be able to see partition boundaries in the mesh.

Partitioning is the process of dividing the geometry into sections (partitions) each to be meshed individually. To control this process, you must specify how many times the geometry should be divided along each of the major coordinate axes X, Y and Z, by specifying Number of Partitions in X, Number of Partitions in Y and Number of Partitions in Z. If you specify Number of Partitions in X to be 2, Number of Partitions in Y to be 1, and Number of Partitions in Z to be 1, then the geometry is divided along the X-axis, giving two partitions in total. In general, the product of these three numbers will give the total number of partitions used for the parallel meshing operation.

In general, it is best to have as few mesh elements intersecting a partition boundary as possible, to minimize the amount of communication required between processes. This means that if you have a long thin pipe geometry, then it is best to partition the geometry so that it is divided along the coordinate direction which is along the length of the pipe, for example.

Although you need to decide how many partitions there should be along each of the three major axes, you do not need to specify the locations at which the geometry is divided. The location of the partitions in each coordinate direction is determined automatically, taking into account variations in the mesh length scale, in order to produce partitions that will each contain roughly the same number of volume elements. This is important for getting the best speed-up for the number of partitions.

You should not use more partitions than there are processors on the local machine if you want to see a speed-up in the mesh generation process, since this will cause more than one partition to be assigned to some processors, resulting in slower volume meshing.

If you are using PVM Distributed Parallel (which uses processors on different machines), then you can use as many partitions as you have available processors on the different machines. You should also bear in mind that each processor will be given a similar size of mesh to produce, so adding in an extra processor which is significantly slower than the others will actually slow the whole meshing process down, since it has to wait for the slowest processor to finish.

If you are using the PVM Distributed Parallel option for generating your mesh, then you need to specify which machines you want to use for the meshing process by using the Hosts List option. You can select any hosts to run on by entering a comma-separated list e.g. “machine1,machine2”, subject to the following restrictions:

- **PVM Distributed Parallel** is a beta feature.
• PVM Distributed Parallel is only supported on machines which are of the same type (e.g. the machines in each parallel run must be all Windows machines, all HP machines, all SUN machines or all Linux machines).

• Each machine you want to run on must have network access to the local machine and must have an installation of ANSYS Workbench which includes CFX-Mesh in the same location as the local machine.

• Each machine must have been set up to run ANSYS CFX software in parallel. On Windows machines:
  – The rsh service supplied with the ANSYS CFX software (not the ANSYS Workbench software) must be installed and available on each machine other than the local (master) machine. The setup of this rsh service is described in ANSYS CFX 10.0 Installation Guide in the section “Installing ANSYS CFX on Windows Systems > Windows Parallel Setup > Setting up the rsh Service”. Please note the relevant security warnings in this section.

On UNIX machines:
  – Each machine other than the local (master) machine must be configured to allow remote shell commands (rsh, or remsh on HP systems) to be executed from the local machine. If your network is not already set up to do this, then this set up is described in ANSYS CFX 10.0 Installation Guide in the section “Installing ANSYS CFX on UNIX Systems > UNIX Parallel Setup > General Requirements > Remote Access”.

• Your username must be the same on each machine.

• Your local machine (the one which you are using to run CFX-Mesh) must be included in the list of machines.

• Include a host name more than once if you want more than one process on that host.

• The total number of hosts selected must equal the number of partitions.

Extruded 2D Meshing

CFX-Mesh has the capability of generating 2D meshes (1 element thick) or simple extruded meshes. 2D meshes can be used for 2D simulations, and extruded meshes can be used to create a mesh which is more aligned with the flow, or with fewer elements than the equivalent 3D mesh (for example, if you have a long thin pipe where there is little variation in the flow variables along the pipe length). In either case, the method of creating the mesh is the same: you must specify which faces of the geometry the extrusion takes place between, and then the Extruded 2D mesher generates the mesh on these faces and performs the extrusion between them (more detail is given below). An example of a simple extruded mesh is shown below.
This image shows a curved pipe, meshed with the Extrude 2D Mesh option, including Inflation. The surface mesh is a mixture of triangles and quads, but the volume mesh is now a mixture of hexahedra near the walls and triangular prisms of the pipe.

Only certain geometries are suitable for use with this meshing option. The basic requirement is that the geometry must be capable of being created by taking a set of surfaces and either revolving them about an axis to form a set of solids, or translating them along a fixed vector to form a set of solids (you do not need to have actually created the geometry in this fashion for Extruded 2D Meshing to work). See Section : Geometry Requirements for Extruded 2D Meshing for more details.

To enable the Extruded 2D mesher, set Meshing Strategy (under Options in the Tree View) to Extrude 2D Mesh. When you make this setting, then any Periodic Pairs currently in the Tree View are removed and replaced by a single Section : Extruded Periodic Pair entry. You use the Extruded Periodic Pair entry to define the faces for the extrusion, and the transformation between them. (If you later set the Meshing Strategy back to Advancing Front with Inflation 3D then the original Periodic Pairs are restored and the Extruded Periodic Pair is removed.)

**Extruded 2D Meshing Options**

Once Extruded 2D Meshing has been enabled (by setting Meshing Strategy, under Options in the Tree View, to Extrude 2D Mesh), several extra entries appear in the Details View for Options to allow you to control this process.

- **2D Extrusion Option** - The default setting for this option is Full, and this generates a mesh using the full extent of your geometry. However, if you want to generate a 2D mesh (1 element thick) then you may not wish to use the full extent of the geometry, but to select a thickness which allows high quality mesh elements to be generated. In this case, you can select Partial. When this setting is selected with a rotational extrusion, then CFX-Mesh automatically sets the angle of rotation for the extrusion to be 1 degree. When this setting is selected with a translational extrusion, then CFX-Mesh automatically determines a thickness which is appropriate given the local mesh element sizes. The example below illustrates this.

This image shows the geometry.
This image shows the 2D mesh that would be generated using the **Full** option. Note that the elements have a very high aspect ratio.

This image shows the 2D mesh that would be generated using the **Partial** option with a coarse mesh. The elements have an aspect ratio which is much closer to 1.

This image shows the 2D mesh that would be generated using the **Partial** option with a finer mesh. The elements have an aspect ratio which is still reasonable, and to ensure this, the length of the extrusion is lower than in the previous mesh.

If you want to control the thickness of the extrusion exactly, then you must create the geometry with the appropriate thickness and use the **Full** option.

If you select the **Partial** option, then you are restricted to having just one element thick and none of the other options listed below are available.

- **Number of Layers** - This setting allows you to control the number of layers which the extruded mesh is divided into.

  This setting is set to 10.
- **Distribution** - This determines how the mesh elements are distributed along the length of the extrusion. It is only relevant if **Number of Layers** is set to 2 or greater. The options are described in the table below.

This image shows the geometry, including which faces are set up to be **Location 1** and **Location 2** in the specification of the Section : Extruded Periodic Pair.

This image shows the 2D mesh that would be generated using the **Uniform** distribution. The elements are distributed uniformly throughout the extrusion.
This image shows the 2D mesh that would be generated using the Symmetric distribution. The elements are distributed so that they are clustered near the ends of the extrusion. The size ratio between successive elements is determined by the Expansion Factor, described below.

This image shows the 2D mesh that would be generated using the Grow From Location 1 distribution. The elements are distributed so that they are clustered near the faces specified as Location 1 for the Extruded Periodic Pair. The size ratio between successive elements is determined by the Expansion Factor, described below.

This image shows the 2D mesh that would be generated using the Grow From Location 2 distribution. The elements are distributed so that they are clustered near the faces specified as Location 1 for the Extruded Periodic Pair. The size ratio between successive elements is determined by the Expansion Factor, described below.

- **Expansion Factor** - For the non-uniform Distribution settings, the Expansion Factor determines the rate of growth of the element thickness between successive elements. Each element is one Expansion Factor bigger than the previous one. Values between 1 and 1.5 are allowed.

**Extruded Periodic Pair**
An Extruded Periodic Pair is a specific example of the more general Periodic Pair which is used to define the transformation for Extruded 2D Meshing.

Only one Extruded Periodic Pair is allowed, and this will be created automatically when you activate the Extrude 2D Meshing option, and removed when you stop using the Extrude 2D Meshing option. An Extruded Periodic Pair cannot be renamed, suppressed or manually deleted.

You must specify the following items for the Extruded Periodic Pair definition:

- **Location 1** - Select a face or a set of faces of the model from the Graphics window. You can either select faces directly from the Graphics window, or select a Composite 2D Region from the Tree View. In either case, all the faces selected must be on the external boundary of the model and must not be included in an Inflated Boundary.

- **Location 2** - Select a face or a set of faces of the model from the Graphics window. The faces must be related to those selected for Location 1 as described in Section : Geometry Requirements for Extruded 2D Meshing. Again, you can either select faces directly from the Graphics window, or select a Composite 2D Region from the Tree View.

- **Periodic Type** - This can either be set to **Translation** or **Rotation**. If Translation is selected, then in most cases no further input is required. If, however, Rotation is selected, then you must specify the axis, by specifying any two points on it. You can select the points by selecting a vertices from the model, selecting arbitrary points on the model faces or by specifying coordinates. See Section : Point Selection for details.

- **Translation Vector** - In certain cases, CFX-Mesh cannot determine automatically what the translation vector for a translational periodic pair is. In these cases, you will be asked to supply the translation vector for the Extruded Periodic Pair explicitly. You should specify the translation vector which moves the faces in Location 1 to those in Location 2.

- **Angle of Rotation** - In certain cases, CFX-Mesh cannot determine automatically what the rotation angle for a rotational periodic pair is. In these cases, you will be asked to supply the rotation angle for the Extruded Periodic Pair explicitly. You should specify the angle which rotates the faces in Location 1 to those in Location 2, using the right-hand rule. The vector for the rotation axis is the vector between the specified Point 1 and Point 2. Only angles greater than zero are permitted. If your setup requires the use of an angle less than zero, then switch Point 1 and Point 2 to reverse the rotation axis. See the picture below.

When an Extruded Periodic Boundary has been created, then when you click on its name in the Tree View, the faces it is using will be highlighted. In addition, if the Extruded Periodic Boundary is rotational, the axis of rotation will be shown as a highlighted line.

**Geometry Requirements for Extruded 2D Meshing**

Only certain types of geometry are suitable for meshing using the Extruded 2D Mesher. All geometries used must satisfy the following conditions:
- Each Body in the geometry must be capable of being constructed by taking a single face and either revolving it or translating it to define the solid Body. (You do not need to have actually created the geometry in this fashion for Extruded 2D Meshing to work.)

- To set up the Extruded 2D meshing, you need to define an Extruded Periodic Pair. The transformation specified for this Extruded Periodic Pair, which relates Location 1 and Location 2 in the Extruded Periodic Pair definition, must match the transformation (revolve or extrude) that could be used to construct the Body from a face.

- If there are multiple Bodies in the geometry, then each one must be capable of being constructed using the same transformation. Every Body in the geometry must have faces in both Location 1 and Location 2 in the Extruded Periodic Pair.

- Each face in the Location 1 face list must map to an equivalent face in the Location 2 face list under the specified transformation. The mapping must be the same for each pair of faces. Multiple faces can be selected for each of Location 1 and Location 2, provided each face in the Location 1 face list maps onto a face in the Location 2 face list using the specified transformation.

Some examples are shown below.

These two examples are the simplest examples of valid geometry for extruded meshing. The geometry is constructed from a translation or rotation of a single face. Location 1 and Location 2, used to define the appropriate Extruded Periodic Pair for the extruded mesh, are marked.

This geometry is valid for extruded meshing as it can be constructed by a single translation or revolution of the two end faces (marked red and green). The geometry contains two Bodies. Both Location 1 and Location 2 must be defined to contain two faces, and this marked on the diagram.

This geometry is invalid for extruded meshing with Location 1 and Location 2 as marked; it contains two Bodies but neither is constructed by rotating or translating the end face in the same single transformation that relates Location 1 and Location 2. Neither Body contains faces in both Location 1 and Location 2. Note that this geometry would be fine to mesh with the normal Advancing Front and Inflation 3D meshing with a Section : Periodic Pair on Location 1 and Location 2 as shown in the diagram.

This geometry is invalid for extruded meshing with Location 1 and Location 2. If both Bodies are meshed, then this violates the condition that geometries with multiple Bodies are only valid for extruded meshing if each Body has faces in both Location 1 and Location 2. You cannot suppress the second body in CFX-Mesh to get around this, because the model must always be valid regardless of the state of the suppression of the Bodies. (You could, however, suppress the second body in your CAD package and then update the geometry.) Note that this geometry would also be invalid for meshing with normal Advancing Front and Inflation 3D meshing with a Section : Periodic Pair on Location 1 and Location 2 as shown in the diagram.
This geometry is invalid for extruded meshing because the cut-out from the middle of the geometry means that the geometry cannot be constructed by single transformation of faces. However, this geometry would be fine to mesh with the normal Advancing Front and Inflation 3D meshing with a Section : Periodic Pair on Location 1 and Location 2 as shown in the diagram.

Mesh Generation Process for Extruded 2D Meshing

When an Extruded Periodic Pair has been specified, the surface mesher generates a surface mesh on all the faces in the Location 1 list using all the available Control and Spacing information. It then uses the transformation to map the mesh to the faces in the Location 2 list. These then form the basis for the creation of the 2D or extruded mesh.

It is possible for Section : Controls to affect the mesh in unexpected locations when Extruded Periodic Pairs are used. Controls originally located outside a Solid Body can be copied into the Body through the transformation and affect the local face and volume mesh length scale.

The process which is used to generate a 2D or Extruded Mesh is as follows:

1. The Extruded Periodic Pair faces are checked with the specified transformation.

2. Controls are mapped using this transformation.

3. A surface mesh is produced for the face(s) in Location 1.
4. The surface mesh for Location 1 is mapped to Location 2.

5. The remaining faces are meshed, using all of the usual meshing settings (e.g. Inflation, Controls). Although the surface mesh on these faces is not used in the final mesh, this step is necessary to allow the appropriate inflation elements to be generated. To avoid wasting large amounts of computing time, the mesher actually only creates the necessary parts of this surface mesh rather than the full mesh. This is the end of the surface meshing procedure.

6. The Extruded 2D Mesher then removes the surface mesh from all faces but those in Location 1 and Location 2.

7. The volume mesh is obtained by joining up the equivalent nodes on Locations 1 and 2, taking into account the settings for **2D Extrusion Option**, **Number of Layers** and **Distribution**.
Previewing the Mesh

The Preview function in the Tree View allows you to preview mesh on a face or faces of your geometry.

Faces are selected by creating a Section : Preview Group, and you can choose whether to generate the mesh on just a few faces or whether to generate the whole surface mesh at one go. The Details View for Preview allows you to control how the mesh is displayed in the Graphics window, including whether or not to display the inflated elements if you have set up Inflated Boundaries.

Preview Group

Controlling the Display of Surface Mesh

Preview Group

A Preview Group is created to allow you to specify which part of the surface mesh you want to preview, in order to verify that the settings applied have the desired effect.

To create a Preview Group, right-click on Preview in the Tree View, and ask to insert a Preview Group. In the Details View, you will be asked to select 2D Regions to form the group. Only 2D Regions can be placed in a preview group; you cannot preview the mesh in the volume of a body (away from any faces). If you want to preview the mesh on an edge, you must add a 2D Region which is bounded by that edge to a Preview Group.

One Preview Group is created automatically: the Default Preview Group. This contains all of the faces in the geometry and can be used to view the full surface mesh. As you make changes to your geometry (e.g. by geometry update or using Virtual Topology) the Default Preview Group is automatically updated to contain all the faces of the new geometry.

Once a Preview Group is created, you can right-click on its name in the Tree View and choose Generate This Surface Mesh in order to preview the mesh just on the selected faces. Click on the Preview Group name at any time to display the mesh.

If you change the mesh settings, then the mesh will no longer be up-to-date and instead of seeing the green tick status symbol (✔) next to the Preview Group entries in the Tree View, you will instead see this symbol: выполнено. You will still be able to view the existing mesh elements, but the mesh will not reflect your latest settings. To regenerate just the mesh in any preview group, just right-click on its name and choose Generate This Surface Mesh again.

If you have several Preview Groups, then rather than regenerating the mesh on each one separately, you can instead right-click over Preview and choose to Generate All Surface Meshes. This will generate the full surface mesh, and so update all preview groups. To view the full surface mesh at once, just click on the Default Preview Group name. The function Generate All Surface Meshes is also available from the Meshing Toolbar ( ) and the Go menu at the top of the window.

If you are using Section : Inflation, Section : Surface Proximity or Face Spacings, then the mesh on each face is affected by the mesh on the faces which are near it, and so the full surface mesh will always be generated behind the scenes (otherwise the displayed surface mesh would not be the same mesh that you would get if you asked...
to create a volume mesh). In this case, you do not save any time by using Generate This Surface Mesh instead of Generate All Surface Meshes.

Control over how the mesh is displayed is described in Section : Controlling the Display of Surface Mesh.

To hide the mesh, simply click on one of the other objects in the Tree View. To show the mesh again, click on the Preview Group name. To delete a Preview Group, right-click over its name in the Tree View and select Delete.

If you are generating a large mesh, you may find that after you have displayed the surface mesh in ANSYS Workbench, the ANSYS Workbench process is using a lot of memory. This may result in a volume mesh failure due to not enough memory being available, or make the viewer very slow to respond. In this case, right-click over Preview in the Tree View, and select Clear Surface Mesh. This removes the surface mesh from memory. When you do this you will only be able to view surface meshes again once you have regenerated them.

To see the statistics for the mesh, expand the Preview Group object in the Tree View (by clicking on the plus sign next to its name) and then click on the Mesh Statistics ( ) entry which opens up. The numbers of quads (four-sided surface elements) and triangles in the mesh is shown in the Details View.

If non-fatal warning messages or errors are produced by the mesher, then these messages will be shown under the Errors item in the Section : Tree View. You can click on each error to view it. If the error or warning concerns a particular face or element, then when you click on that error, the appropriate face or element will be highlighted in the Graphics window.

If fatal errors are produced, then the error messages can be accessed in the same way. In addition, a pop-up message will notify you that the meshing operation has failed.

You should note that by default, the surface mesh is displayed after it has been modified due to the presence of inflation layers, if you are using Inflation. You can use the Details View for Preview to change from viewing the surface mesh after inflation to viewing the surface mesh before inflation, or to view the inflated layers themselves.

If you want to view the volume mesh, of 3D elements, you can do so in CFX-Post by loading either the Section : CFX-Pre Mesh File or the Results File.

**Controlling the Display of Surface Mesh**

To control the display of mesh in the Graphics window, click on Preview in the Tree View and then edit the parameters in the Details View.

- **Display Mode** - Choose between Wire on Face Mesh (shows the mesh faces and the mesh lines), Wire Mesh (shows just the mesh lines) or Face Mesh (shows the mesh faces).
- **Display Mesh** - This controls how the surface mesh elements are displayed if you are using Section : Inflation. The table below describes the different options and shows a simple case as an example.
The pictures in the right-hand column show a simple, coarsely-meshed cube with inflation specified on just single face (shown in green in the top picture).

**Mesh Before Inflation**

This option shows the mesh before any inflation is applied. It is the only Display Property available if you have not set up inflation for your model. If you are using inflation, then it can be useful to view this mesh if the inflation process has not worked how you expected, since the quality of this uninflated surface mesh will affect the quality of the inflated elements.

**Mesh After Inflation**

This option shows the mesh after the inflated elements have been generated. It is the default if you have specified inflation in your model. It shows the surface mesh as it will appear after volume meshing, including the quad (four-sided) surface elements created during the inflation process.
**Inflated Front**

This option shows the mesh along the top of the inflated elements. If you view this mesh on all faces, then you can see the space which the volume mesher has to fill with tetrahedral elements. This can be useful for determining why the volume mesher is having difficulty creating an element or to predict areas where there may be a low quality volume mesh (for instance, if there is only a very narrow gap for it to fill).

**Inflated Mesh**

This option shows just the inflator layers. It can help you to view exactly how the inflated layers have been generated, to check your inflation settings. Note: if the Preview Group selected for display does not contain any inflated surfaces, then no mesh will be displayed.

---

The **Display Mesh** parameter is not available if the Extruded 2D Meshing option is enabled. When this meshing option is used, the surface mesh is always displayed after both the inflation and extrusion processes have taken place.

- **Transparency (%)** - Choose the transparency of the mesh. 100% means that the mesh is completely transparent (i.e. it won't show up) and 0% means that the mesh is completely opaque.

- **Shine (%)** - Shine controls how much light is reflected by the faces of the mesh. 0% gives the lowest amount of reflection and will result in the mesh looking matt in texture. How much light is reflected by the displayed mesh is also affected by the **Shine** setting under **Geometry** in the Tree View. In particular, if **Shine** under **Geometry** is set to 0%, then the **Shine** setting under **Preview** has no effect: the mesh is always displayed as matt.

- **Face Color Mode** - This controls the color of the faces (if Display Mode is set to show the Face Mesh) or lines (if Display Mode is set to show the Wire Mesh). Choose between:
  - **Body** - Shows the mesh in the same color as the body.
  - **Uniform** - Choose a color for the mesh using the Uniform Color setting. Click on the displayed color in the Details View to change it. You can either select one of the predefined colors, or use **Define Custom Colors** to specify the exact color that you require.
  - **Rainbow** - Shows the mesh on each face in a different color, chosen to be as different as possible.
Volume Meshing

Creating the Volume Mesh

Once you have finished setting up your mesh, you can generate the volume mesh by right-clicking on **Mesh** in the Tree View and selecting **Generate Volume Mesh**. You can also generate the volume mesh using the Section : Meshing Toolbar.

The volume mesh is written to the Section : CFX-Pre Mesh File ready for import into CFX-Pre.

You will not be able to view the volume mesh or any 3D elements (including the prism elements produced by the Section : Inflation process) in CFX-Mesh. Instead, after generating the mesh you must load the mesh into CFX-Post to view it.

To regenerate the mesh, simply right-click on **Mesh** in the Tree View and choose **Generate Volume Mesh** again.

If non-fatal warning messages or errors are produced by the mesher, then these messages will be shown under the Errors item in the Section : Tree View. You can click on each error to view it. If the error or warning concerns a particular face or element, then when you click on that error, the appropriate face or element will be highlighted in the Graphics window.

If fatal errors are produced, then the error messages can be accessed in the same way. In addition, a pop-up message will notify you that the meshing operation has failed.

**CFX-Pre Mesh File**

The volume mesh generated by CFX-Mesh is written to a CFX-Pre Mesh File (otherwise known as a CFX-5 GTM File), ready for import into CFX-Pre, and this file contains all the mesh and region information that is required by CFX-Pre. The mesh is stored in the CFX-Pre Mesh File using double-precision coordinates.

The file name and location is specified by using the file browser which appears each time you ask to create the volume mesh. The extension is **.gtm**. By default, CFX-Mesh will not overwrite any existing CFX-Pre Mesh file. If you specify a name of a file which already exists, then CFX-Mesh will tell you that the file already exists. You can either change the file name specified, remove or move the existing file, or choose to overwrite the existing file.

If you have installed CFX-5.7.1 so that you can run CFX-5 in ANSYS Workbench, then the first time you create a volume mesh within a project, a new **Advanced CFD** entry will appear on your Project Page, which will contain the CFX-Pre Mesh File. Every subsequent CFX-Pre Mesh File that you create will appear under this entry. Each of these entries can be used to start CFX-5 in ANSYS Workbench; see the CFX-5 User Documentation for details.

When you start CFX-Pre in ANSYS Workbench, using one of these CFX-Pre Mesh Files, then CFX-Pre automatically saves its simulation setup using this file and the simulation file **.cfx** with the same base name. If you later regenerate the volume mesh, you must choose a different name for your new CFX-Pre Mesh File to avoid overwriting data placed in the existing CFX-Pre Mesh File by CFX-Pre.

If you start CFX-Pre outside of ANSYS Workbench and import a CFX-Pre Mesh File into a new simulation, then you can choose whether to save the simulation with the same name as the CFX-Pre Mesh File or with a different name. If you choose to save with the same name, then when you regenerate the volume mesh, you must choose a different name for your new CFX-Pre Mesh File to avoid overwriting data placed in the existing CFX-Pre Mesh.
File by CFX-Pre. If you choose to save the simulation with a different name then you can safely use the same CFX-Pre Mesh File name when regenerating the volume mesh.
CFX-Mesh Options

The CFX-Mesh Options are used to set preferences which apply from one ANSYS Workbench session from another, rather than settings which apply to a particular CFX-Mesh database.

To access the CFX-Mesh Options via the Tools menu:

1. From the main menu, choose **Tools>Options**. An **Options** dialog box appears and the CFX-Mesh options are displayed on the left.
2. Click on a specific option.
3. Change any of the option settings by clicking directly in the option field on the right. You will first see a visual indication for the kind of interaction required in the field (examples are drop down menus, secondary dialog boxes, direct text entries).
4. Click **OK**.

The following **CFX-Mesh** options appear in the **Options** dialog box:

- **Graphics View**
- **Graphics window**
- **Properties View**
- **Geometry**
- **Virtual Topology**
- **Miscellaneous**

Other help descriptions available that describe the **Options** dialog box:

- **Common Settings**
- **DesignModeler**
- **Simulation**
- **DesignXplorer**
- **Licensing**

**Graphics View**

The **Assembly** category includes:

- **View**: This determines the type of geometry display which is used for CFX-Mesh at the start of each ANSYS Workbench session. After that, changes to the View type can be made through the Tools menu and the setting of View type will persist if you open or create a new CFX-Mesh database. The View type is not a property of the CFX-Mesh database and is not stored in a CFX-Mesh database.

- **Transparency**: This determines the value of **Transparency** which is given to the geometry whenever a new CFX-Mesh database is started. After that, the Transparency of the mesh is stored in the database and changes are made by using the Details View for Geometry through the normal CFX-Mesh user interface. See Section : Geometry Display for details.

- **Shine**: This determines the value of **Shine** which is given to the geometry whenever a new CFX-Mesh database is started. After that, the Shine of the mesh is stored in the database and changes are made by using the Details View for Geometry through the normal CFX-Mesh user interface. See Section : Geometry Display for details.
The **Preview** category includes:

- **Transparency**: This determines the value of Transparency which is given to the mesh whenever a new CFX-Mesh database is started. After that, the Transparency of the mesh is stored in the database and changes are made by using the Details View for Preview through the normal CFX-Mesh user interface. See Section : Controlling the Display of Surface Mesh for details.

- **Shine**: This determines the value of Shine which is given to the mesh whenever a new CFX-Mesh database is started. After that, the Shine of the mesh is stored in the database and changes are made by using the Details View for Preview through the normal CFX-Mesh user interface. See Section : Controlling the Display of Surface Mesh for details.

**Graphics window**

The **Tree Colors** category includes:

- **Normal**: This setting determines the normal color of the text in the Tree View.

- **Dimmed**: This setting determines the dimmed color of the text in the Tree View, which is used when the Tree View is not in focus i.e. you are entering information in the Details View.

- **Highlighted**: This setting determines the text color when a Tree View entry is being highlighted; for example, a **Point Spacing** will be highlighted if a **Point Control** which uses that Point Spacing is selected.

**Properties View**

The **List Behaviour** category includes:

- **Auto Activate**: If this is set to **Yes**, then when you click on an object in the Tree View which requires a selection and is currently invalid, the item which requires selection is opened automatically. For example, if you create a new Inflated Boundary, then it requires you to select a location for the inflation. If **Auto Activate** is turned on, then you can select the required faces from the Graphics window immediately. If **Auto Activate** is turned off, then you must click next to **Location** in the Details View before you can start selecting faces.

  The default setting is **Yes**. Select **No** if you want to revert back to the behavior of CFX-Mesh 8.1 or earlier.

**Geometry**

The **CAD** category includes:

- **Auto Verify on Change**: If you set this to **Yes**, then every time you perform a Geometry Update or Clear Settings operation, the CAD Check operation is performed on the new setup. This would be useful if you were making changes to your geometry and wanted to find out immediately if it was invalid or poor, before you did any other operations. The default setting is **No**.

**Virtual Topology**

The **General** category includes:

- **Automatically Remove Invalidated Virtual Cells**: If this is set to **Yes** (this is the default setting), then every time a virtual face or edge is edited to include an existing virtual face (or edge), that virtual entity will be automatically deleted. If this is set to **No**, then existing virtual entities cannot be added to a new or existing virtual face (or edge).
The **Automatic Edge Merge** category includes:

- **Merge Edges Bounding New Virtual Faces**: If this is set to **Yes** (this is the default setting), then all edges that bound a newly created virtual face will be assessed to see if they can be merged. The merging will be dependent on the Automatic Edge Merging Tolerance, so if the angle between the two tangents of connected edges that bound a virtual face is less than the tolerance they will be merged. If this is set to **No**, then the edges that bound a newly created virtual face will not be modified.

- **Automatic Edge Merging Tolerance (Degrees)**: This angle sets the threshold at which connected edges on a newly created virtual face can be automatically merged.

### Miscellaneous

The **Files** category includes:

- **Folder for Temporary Files**: During meshing operations, CFX-Mesh can write large amounts of data to temporary files. This option allows you to specify where these files should be written: you should select a directory with plenty of disk space, particularly if you are generating large meshes. It only takes effect when CFX-Mesh is started for the first time in an ANSYS Workbench session. The default value is specified by the **TEMP** environment variable. If this environment variable is not set, then the default directory is specified by **TMP** or **TMPDIR**, or if neither of these are set, the directory used is **C:\Temp** (Windows) or **/tmp** (UNIX).

The **Backup** category includes:

- **Frequency of Auto Backup**: This determines how often a backup file is written. The options are **Frequently**, which will back up your CFX-Mesh database after (approximately) every 10 changes to your mesh setup, **Moderately**, which will back up after every 20 changes, **Infrequently**, which will back up after every 40 changes, and **Never**. The default is **Moderately**. Additionally, you can choose to backup your database just before each meshing action; see below for details.

- **Auto Backup Before Action**: In addition to the backups which take place after every so many changes, you can also choose to take a backup copy of your CFX-Mesh database immediately before performing any meshing action, by setting this option to **Yes** (the default).

Backup files are saved in a directory called `<tmpdir>\cfx.cm.vXX.Y\recovery`, where `<tmpdir>` is the **Folder for Temporary Files** set by the previous option, and `XX.Y` are numbers chosen to make the directory name unique. If your original `.cmdb` and `.cmdat` names were `Project.cmdb` and `Project.cmdat`, respectively, then the backup files will be called `_Project.cmdb` and `_Project.cmdat`, for example. In order to restore these backup files, you should do the following:

1. Open a new ANSYS Workbench session. On the Start Page, choose to **Open** an existing file and set the filter to look for existing CFX-Mesh files. Browse to locate the required backup files in the temporary folder.

2. Once CFX-Mesh has opened, choose **File>Save As...** and save the backup files to the name and location that you wish to restore them to.

3. Close the project without saving it.

Do NOT just manually move and rename the files back to where you want them, or CFX-Mesh will NOT be able to re-open them.
Troubleshooting

Common Queries
Valid and Invalid Values for Parameters, Locations and Names
Meshing Warning and Error Messages

Common Queries

Why can the Mesher Fail Trying to Create a Surface Mesh?
Why can the Mesher Fail Trying to Create a Mesh with Inflation?
How can I Create a Mesh Greater than 1 km Across?
How can I Ask to See the Warning Messages that the Mesher Produces?
Which Part of my Model is Causing the Problem?
Why do I get Messages About Disk Space when I Have Plenty of Space in my Project Directory?
What are the Files which CFX-Mesh Produces?

Why can the Mesher Fail Trying to Create a Surface Mesh?

There are several reasons why this could occur:

1. You may be trying to mesh Section : Closed Faces with the Section : Advancing Front (AF) Surface Mesher, which cannot mesh such faces.

   The simplest solution to this problem is to use the Section : Delaunay Surface Mesher which is selected by default. If you need to use the AF Surface Mesher, then there are two possible solutions to this problem.

   For relatively simple geometries you can recreate your model without closed faces, for example using two curved faces to define a cylinder. You can find more help with this in Section : Closed Faces.

   For larger, more complicated, or imported models, you can break closed faces into one or more non-closed faces using the Split action in DesignModeler to split the Solid Body in such a way as to also break the closed face.

2. You may be trying to mesh an invalid face topology. Some non-manifold topologies cannot be meshed with either surface mesher.

   Also see Section : Meshing Warning and Error Messages for additional information on meshing warnings and error messages.

Why can the Mesher Fail Trying to Create a Mesh with Inflation?

Check your geometry model to make sure adjoining non-inflated faces do not contain two or more edges which meet at an intermediate edge point.

For tips on how to use the surface meshers most effectively, see Section : Geometry and Topology for the Faces of Solid Bodies.

How can I Create a Mesh Greater than 1 km Across?

The geometry kernel underlying ANSYS Workbench has a built-in limit of a cube 1 km across, centered on the origin. DesignModeler will not allow you to generate any geometry feature which touches or extends beyond this box.
If you want to create a mesh which is larger than this, then we suggest that you generate a scaled-down version of your geometry and mesh. It is then straight-forward to scale the mesh up again on import into CFX-Pre.

**How can I Ask to See the Warning Messages that the Mesher Produces?**

By default, warning messages from the mesher are ignored to allow meshing to continue uninterrupted unless a fatal error occurs.

If non-fatal warning messages or errors are produced by the mesher, then they will be displayed under the Errors item in the Section : Tree View.

**Which Part of my Model is Causing the Problem?**

If a particular part of your model is causing the mesher to fail or to produce warning messages, then by clicking on the error (under the Errors item in the Section : Tree View), you will be able to highlight the appropriate region or element.

If it is difficult to see the highlighted face or element, you could hide the display of the geometry before clicking on the error. The part of the model causing the error will still highlight, which should make it much easier to see. Hiding the geometry (or part of the geometry) can be done by right-clicking on the name of the Body or Part under Geometry in the Tree View.

**Why do I get Messages About Disk Space when I Have Plenty of Space in my Project Directory?**

The meshers work in a temporary directory before writing the CFX-Pre Mesh File back into the project directory. If the temporary directory does not have enough disk space then they cannot complete.

The temporary directory is specified on starting CFX-Mesh for the first time by the TEMP environment variable, or, if this environment variable is not set, by TMP or TMPDIR, or if neither of these are set, the directory used is C:\Temp (Windows) or /tmp (UNIX). After the first start-up of CFX-Mesh the temporary directory location is stored in the CFX-Mesh preferences and these environment variables will not be looked at again unless the stored temporary directory no longer exists.

You can change the temporary directory by selecting Tools>Options>CFX-Mesh>Miscellaneous from anywhere in ANSYS Workbench, and setting an appropriate value for Folder for Temporary Files.

**What are the Files which CFX-Mesh Produces?**

The files used and produced by CFX-Mesh are as follows:

- **Project.wbdb** - ANSYS Workbench project database.
- **Project.agdb** - DesignModeler geometry file. This is used by DesignModeler and read by CFX-Mesh the first time it is initiated using this geometry, and during any geometry updates. (If you are not using DesignModeler for producing geometry, then you will not have this type of file; instead you will have the CAD files from whichever CAD package you are using.)
- **Project.cmdb** - CFX-Mesh database. This contains the mesh settings.
- **Project.cmdat** - CFX-Mesh database. This contains data for use by CFX-Mesh. It must always be kept alongside the .cmdb.
- **Project.gtm** - volume mesh ready for import into CFX-Pre.
You should never rename any of these files except by using the Project Page in ANSYS Workbench. If you need to contact customer support then all of the files (except the `.gtm`) must be provided to allow your problem to be reproduced.

**Valid and Invalid Values for Parameters, Locations and Names**

Valid and Invalid Values
Valid and Invalid Locations
Valid and Invalid Names

**Valid and Invalid Values**

Most of the settings which require you to enter a number will only allow you to set numbers within a particular range. This section lists the valid ranges, with some notes on the reason for the restriction.

<table>
<thead>
<tr>
<th>Tree Section</th>
<th>Parameter</th>
<th>Range of Validity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geometry</td>
<td>Transparency (%)</td>
<td>0 to 100</td>
</tr>
<tr>
<td>Geometry</td>
<td>Shine (%)</td>
<td>0 to 100</td>
</tr>
<tr>
<td>Geometry&gt;Verify Options</td>
<td>Short Edge Limit</td>
<td>above zero</td>
</tr>
<tr>
<td>Geometry&gt;Verify Options</td>
<td>Sliver Factor Limit</td>
<td>above 1.0</td>
</tr>
<tr>
<td>Geometry&gt;Fix Options</td>
<td>Short Edge Tolerance</td>
<td>below 5% of the maximum extent of the geometry</td>
</tr>
<tr>
<td>Mesh&gt;Spacing&gt;Default Body Spacing</td>
<td>Maximum Spacing</td>
<td>above zero</td>
</tr>
<tr>
<td>Mesh&gt;Spacing&gt;(Default) Face Spacing</td>
<td>Angular Resolution [Degrees]</td>
<td>1.0 to 90.0</td>
</tr>
<tr>
<td>Mesh&gt;Spacing&gt;(Default) Face Spacing</td>
<td>Constant Edge Length</td>
<td>below 50% of the maximum extent of the geometry</td>
</tr>
<tr>
<td>Mesh&gt;Spacing&gt;(Default) Face Spacing</td>
<td>Expansion Factor</td>
<td>1.00001 to 1.5</td>
</tr>
<tr>
<td>Mesh&gt;Spacing&gt;(Default) Face Spacing</td>
<td>Maximum Edge Length</td>
<td>below the maximum extent of the geometry, above the Minimum Edge Length</td>
</tr>
<tr>
<td>Mesh&gt;Spacing&gt;(Default) Face Spacing</td>
<td>Minimum Edge Length</td>
<td>below 5% of the maximum extent of the geometry</td>
</tr>
<tr>
<td>Mesh&gt;Spacing&gt;(Default) Face Spacing</td>
<td>Radius of Influence</td>
<td>above zero</td>
</tr>
<tr>
<td>Mesh&gt;Spacing&gt;(Default) Face Spacing</td>
<td>Relative Error</td>
<td>0.000038 to 0.292 (corresponds to between 360 and 4 edges round a circle</td>
</tr>
<tr>
<td>Mesh&gt;Controls&gt;Point Spacing</td>
<td>Expansion Factor</td>
<td>1.00001 to 1.5</td>
</tr>
<tr>
<td>Mesh&gt;Controls&gt;Point Spacing</td>
<td>Length Scale</td>
<td>below 5% of the maximum extent of the geometry</td>
</tr>
<tr>
<td>Mesh&gt;Controls&gt;Point Spacing</td>
<td>Radius of Influence</td>
<td>above zero</td>
</tr>
<tr>
<td>Mesh&gt;Periodicity&gt;Periodic Pair</td>
<td>Angle of Rotation</td>
<td>-360 to 360 degrees</td>
</tr>
<tr>
<td>Mesh&gt;Periodicity&gt;Periodic Pair</td>
<td>Translation Along Axis (all three axes)</td>
<td>any real number</td>
</tr>
<tr>
<td>Mesh&gt;Inflation</td>
<td>Expansion Factor</td>
<td>1.00001 to 5.0</td>
</tr>
<tr>
<td>Mesh&gt;Inflation</td>
<td>First Prism Height</td>
<td>below 5% of the maximum extent of the geometry</td>
</tr>
<tr>
<td>Mesh&gt;Inflation</td>
<td>Minimum Internal Angle</td>
<td>0.0 to 40.0</td>
</tr>
<tr>
<td>Mesh&gt;Inflation</td>
<td>Minimum External Angle</td>
<td>0.0 to 40.0</td>
</tr>
<tr>
<td>Mesh&gt;Inflation</td>
<td>Number of Inflated Layers</td>
<td>1 to 50</td>
</tr>
<tr>
<td>Mesh&gt;Inflation</td>
<td>Number of Spreading Iterations</td>
<td>0 to 10</td>
</tr>
<tr>
<td>Tree Section</td>
<td>Parameter</td>
<td>Range of Validity</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Mesh&gt; Inflation&gt; Inflated Boundary</td>
<td>Maximum Thickness</td>
<td>above zero</td>
</tr>
<tr>
<td>Mesh&gt; Stretch</td>
<td>Stretch in X/Y/Z</td>
<td>0.2 to 5.0</td>
</tr>
<tr>
<td>Mesh&gt; Proximity</td>
<td>Elements Across Gap</td>
<td>1 to 10</td>
</tr>
<tr>
<td>Mesh&gt; Proximity</td>
<td>Maximum Number of Passes</td>
<td>1 to 10</td>
</tr>
<tr>
<td>Mesh&gt; Options</td>
<td>Global Mesh Scaling</td>
<td>0.5 to 2.0</td>
</tr>
<tr>
<td>Mesh&gt; Options</td>
<td>Number of Layers</td>
<td>1 to 10,000</td>
</tr>
<tr>
<td>Preview</td>
<td>Transparency (%)</td>
<td>0 to 100</td>
</tr>
<tr>
<td>Preview</td>
<td>Shine (%)</td>
<td>0 to 100</td>
</tr>
</tbody>
</table>

**Valid and Invalid Locations**

If CFX-Mesh won’t allow you to select the locations that you require (either by selecting from the Graphics window or selecting a Composite 2D Region from the Tree View), then it will be due to one or more of the following restrictions:

- The location of an Inflated Boundary must not be contained in any other Inflated Boundary or any Periodic Pair or Extruded Periodic Pair.
- The location of a Periodic Pair must not be contained in any Inflated Boundary or any other Periodic Pair.
- The location of an Extruded Periodic Pair must not be contained in any Inflated Boundary.
- The location of a Composite 2D Region must not be contained in any other Composite 2D Region.
- The location of a Face Spacing must not already be contained in any other Face Spacing, except the Default Face Spacing.

CFX-Mesh allows you to select any combination of locations from the Graphics window and Tree View and then checks that the selection does not break any of the rules above at the time when you press **Apply** in the Details View. If the new selection does break one of the rules, then the new selection will not be applied and the contents of the Location will remain as they were. So even if it is only one part of the selection that breaks the rules, the whole new selection will be reverted.

If you have multiple bodies in your geometry, then you should refer to Section : 2D Regions and Faces for more details on what is valid to apply to 2D Regions which form the two sides of a face.

**Valid and Invalid Names**

When naming or renaming anything in the Tree View, you must take account of the restrictions on what names can be used. Any name must start with an alphabetic character, can be any length and can contain alphabetic characters, numbers and single spaces (underscores are NOT allowed). Names are case-sensitive i.e. “inlet” and “Inlet” are treated as different.

**Meshing Warning and Error Messages**

The following error messages may be produced from CFX-Mesh. Note that where specific geometry is referred to in the message, this will be highlighted in the geometry.

- The Advancing Front Surface Mesher Cannot be Used When Parametrically Closed Surfaces or Curves are Present in the Geometry
- CAD Edge Referenced n Times by Faces
- CAD Model Contains Faces with Small Angles
- CAD Vertex Referred to n Times by CAD Face
Edge is Periodic
Face for Edge is Periodic
Face has Less than 2 Edges
Invalid Periodicity in Faces Detected
Matching Periodic CAD Vertices Exceed Tolerance
No Edges Found in Search Box
Summary for CAD quality checking
Storage Allocation Failed
Surface is Parametrically Closed
Surface Mesh has Triangles which are Identical
There was a Problem Converting the Mesher Output into the GTM Database
2 Transformations Specified
Two or More CAD Edges Between Non-inflated Surfaces Meet at a CAD Vertex on an Inflated Surface
The Volume Mesher Cannot Continue. It is Continually Adding and Removing the Same Elements.
Zero Length Vector

The Advancing Front Surface Mesher Cannot be Used When Parametrically Closed Surfaces or Curves are Present in the Geometry

Closed surfaces and curves are described in Section : Closed Faces. To mesh a geometry which contains such surfaces, you cannot use the Section : Advancing Front (AF) Surface Mesher but must instead use the Section : Delaunay Surface Mesher. You can switch between the two meshers by using the Surface Mesher option from the Section : Mesh Options section in the Tree View.

CAD Edge Referenced n Times by Faces

This is the error message that can result from trying to mesh a geometry with a non-manifold edge.

CAD Model Contains Faces with Small Angles

This message occurs when one or more faces contain edges which meet at small angles. It is only a warning message and your mesh may generate successfully and be of the expected high quality. However, it may be worth checking the mesh in the region of the face with the small angle to ensure that the quality is what you expect.

CAD Vertex Referred to n Times by CAD Face

This is the error message that results from trying to mesh a geometry that contains a non-manifold vertex.

Edge is Periodic

If you are using the Section : Advancing Front (AF) Surface Mesher, edges of faces that form closed loops must not be made up of a single curve. See Section : Closed Faces for help on working around this problem.

Face for Edge is Periodic

If you are using the Section : Advancing Front (AF) Surface Mesher, two ends of a face may not share the same curve. See Section : Closed Faces for help on working around this problem.
Troubleshooting

Face has Less than 2 Edges

The face has less than 2 edges. This usually occurs when a face is closed. This type of face cannot be meshed with the Section : Advancing Front (AF) Surface Mesher.

Invalid Periodicity in Faces Detected

CAD faces with double periodicity have been detected. These are most likely torii or connected components of toroidal surfaces. To mesh the problem you must cut these surfaces in two to avoid periodicity in at least one parametric direction. The problem faces are:

(Body, Face) = (4, 5)

This message occurs when the mesher detects a surface which is closed in two directions, such as a torus. This is invalid geometry. You should eliminate the face referred to, perhaps by splitting it into two parts as suggested in the error message.

Matching Periodic CAD Vertices Exceed Tolerance

This error message can occur if you have a Periodic Pair specified which is not actually periodic in the way that you specified. For example, your faces may not be quite periodic, or you may have specified the translation or rotation angle incorrectly (in the few cases where you are asked to supply these). Although CFX-Mesh will check your periodic specification and will not allow you to set up most invalid cases, it cannot catch all problems in advance of the meshing stage.

No Edges Found in Search Box

This is an error message generated by the volume mesher. It occurs when there is a problem with the geometry (e.g. mesh length scale is too large to resolve a feature) and you are using Section : Proximity and Section : Stretch. You may be able to avoid the problem by removing or reducing the amount of Stretch.

Summary for CAD quality checking

This is output from Section : Geometry Checking. Although it is always presented as a warning, it may in fact indicate that there are no problems uncovered.

Storage Allocation Failed

This message occurs when you are trying to generate a mesh which is too big for your machine's available memory. You need to either reduce the size of the mesh (by making some of the length scales larger, for instance), free up or add some more memory to your machine, or mesh on a different machine.

Surface is Parametrically Closed

This occurs when a face is closed. This type of face cannot be meshed with the Section : Advancing Front (AF) Surface Mesher.

Surface Mesh has Triangles which are Identical

CFX-Mesh allows some cone faces to be meshed. However, if the angle at the apex is too small, then this leads to a degenerate mesh with two triangles back to back at the apex, which can cause this message. The only workaround is to remove the tip of the cone from the geometry.
There was a Problem Converting the Mesher Output into the GTM Database

The meshers work in a temporary directory before writing the CFX-Pre Mesh File back into the project directory. If the temporary directory does not have enough disk space then they cannot complete, and this message is one indication that this may be the problem. You can change the temporary directory by selecting Tools>Options>CFX-Mesh>Miscellaneous from anywhere in ANSYS Workbench, and setting an appropriate value for Folder for Temporary Files.

This message can also occur if the meshing fails right at the end, when occasionally the file filename.gtm.lck (where filename.gtm is the name of the temporary CFX-Pre Mesh File) is created and not removed. After this happens, you will not be able to write to that file location again; you will continue to get the same error each time you try. The workaround in this case is to remove the file filename.gtm.lck manually from the directory.

2 Transformations Specified

Source terms will be made periodic for each transformation. This may result in unexpected mesh densities occurring.

This warning occurs when you have two or more Periodic Pairs with different transformations. It is there to warn you that when more than one transformation is in use, Section : Controls will be mapped according to all of the transformations, and that this can sometimes result in them being applied in locations that you did not expect. It is recommended that you check the resulting mesh to ensure that it is all as you intended.

Two or More CAD Edges Between Non-inflated Surfaces Meet at a CAD Vertex on an Inflated Surface

The situation which leads to this warning message is described in Section : Geometry and Topology for the Faces of an Inflated Boundary.

The Volume Mesher Cannot Continue. It is Continually Adding and Removing the Same Elements.

This error message usually occurs when the mesh length scale is inappropriate for the geometry or the gap between inflated layers. Check that the length scales specified will resolve all of the features in the geometry. If you have surfaces which are in close proximity, you could try using Section : Proximity to automatically refine the mesh to ensure that the gap is resolved properly.

Zero Length Vector

This error message can occur when Section : Inflation is applied at a point where the normals of the adjacent faces are in opposite directions. An example of such a geometry is shown below.
In this case the average of the normal created at the point A is zero. This type of geometry is uncommon and should be avoided when using Inflation.
Mesh Length Scale

Length scale is a term used to describe the size of a mesh element. CFX-Mesh automatically selects a global length scale for the model, typically 5% of the maximum model dimension. This length scale is often referred to as the background length scale or Maximum Spacing for the simulation domain as a whole.

The Maximum Spacing will be the actual length scale of the mesh all over the region to be meshed, unless it is overridden as a result of some sort of mesh control, which is used to modify locally the size of mesh elements. This is particularly beneficial in an area of highly irregular flow or in a local area of interest.

Finally, length scales can be described in two forms. A face length scale is used to describe the size of the triangles of a two-dimensional surface mesh. A volume length scale is used to describe the size of volume elements of a three-dimensional volume mesh.

The following points should be considered and noted as good meshing practice:

- The length scale you use should reflect the features of the flow you wish to model. It is important to resolve geometric features that affect the flow with adequate mesh resolution.
- If the size of the geometric features vary significantly, then you will require local control over the mesh. It is recommended that you use at least 10 elements across any features of interest.
- For the highest accuracy, you should generally seek a mesh-independent solution, which means that the results of your simulation do not change by reducing the mesh length scale. You can approach this by gradually decreasing the Maximum Spacing of your mesh (and that of any Controls or Face Spacings applied to it) and comparing solutions. A straightforward way to do this is to use the Section : Global Mesh Scaling. Mesh independence means that errors due to the scale of the mesh affecting the computed results have been eliminated. In the majority of industrial simulations, mesh independent solutions cannot be achieved due to limits of available memory and computing power. For these simulations, it is still sensible to perform simulations for two or more mesh sizes in order to be able to make some estimate of the accuracy of the solution.
Simulation Help
Simulation Help
**Table of Contents**

**Simulation Approach** ...................................................................................................................... 1–1
- Simulation Types .............................................................................................................................. 1–1
- Structural Static Simulations ............................................................................................................. 1–2
- Sequenced Simulations ...................................................................................................................... 1–16
- Thermal Transient Simulations ......................................................................................................... 1–27
- Electromagnetic Simulations ............................................................................................................ 1–46
- 2-D Simulations ............................................................................................................................... 1–59
- Using Generalized Plane Strain ....................................................................................................... 1–60
- Coupled Environments ...................................................................................................................... 1–62
- Surface Forces at Fluid-Structure Interface ..................................................................................... 1–63
- Wizards ........................................................................................................................................... 1–65
- Simulation Wizard ............................................................................................................................ 1–66

**Simulation Objects Reference** ........................................................................................................ 2–1
- Page Listings ..................................................................................................................................... 2–1
- Alert .................................................................................................................................................. 2–2
- Body ................................................................................................................................................ 2–3
- Commands ....................................................................................................................................... 2–5
- Comment ......................................................................................................................................... 2–7
- Contact .......................................................................................................................................... 2–8
- Contact Region ............................................................................................................................... 2–9
- Convergence .................................................................................................................................... 2–11
- Coordinate System ......................................................................................................................... 2–11
- Coordinate Systems ........................................................................................................................ 2–13
- Environment ................................................................................................................................... 2–13
- Figure ............................................................................................................................................. 2–14
- Geometry ....................................................................................................................................... 2–15
- Global Coordinate System .............................................................................................................. 2–19
- Initial Condition ............................................................................................................................... 2–20
- Loads and Supports (Group) ........................................................................................................... 2–21
- Mesh .............................................................................................................................................. 2–23
- Mesh Control Tools (Group) .......................................................................................................... 2–24
- Model ............................................................................................................................................ 2–26
- Named Selections ............................................................................................................................ 2–27
- Parameter Manager ......................................................................................................................... 2–28
- Part .................................................................................................................................................. 2–29
- Point Mass ..................................................................................................................................... 2–30
- Project ............................................................................................................................................ 2–31
- Result Tracker ................................................................................................................................. 2–32
- Results and Result Tools (Group) .................................................................................................... 2–33
- Solution .......................................................................................................................................... 2–39
- Solution Combination ....................................................................................................................... 2–42
- Solution Information ......................................................................................................................... 2–42
- Spot Weld ....................................................................................................................................... 2–43
- Transient Settings ............................................................................................................................ 2–44
- Variable Graph ............................................................................................................................... 2–46
- Virtual Cell ..................................................................................................................................... 2–46
- Virtual Topology ............................................................................................................................. 2–47

**Simulation Basics** ............................................................................................................................ 3–1
- Simulation License Options ............................................................................................................. 3–1
- Simulation Interface .......................................................................................................................... 3–2
Simulation Help

Simulation Window ............................................................................................................................ 3–2
Tree Outline Conventions ......................................................................................................................... 3–4
Tree Outline ............................................................................................................................................. 3–5
Suppress/Unsuppress Items .................................................................................................................... 3–5
Tabs .......................................................................................................................................................... 3–6
Geometry ................................................................................................................................................... 3–6
Graphical Selection ................................................................................................................................. 3–6
Details View .................................................................................................................................................. 3–15
Worksheet Tab ............................................................................................................................................. 3–21
Transient Settings Worksheet .................................................................................................................... 3–23
Parameters ................................................................................................................................................. 3–28
Toolbars ..................................................................................................................................................... 3–28
Main Menu ................................................................................................................................................. 3–28
Standard Toolbar ...................................................................................................................................... 3–30
Graphics Toolbar ....................................................................................................................................... 3–31
Context Toolbar ......................................................................................................................................... 3–33
Unit Conversion Toolbar ............................................................................................................................ 3–46
Named Selection Toolbar ........................................................................................................................... 3–46
Print Preview ............................................................................................................................................. 3–49
Triad and Rotation Cursors ...................................................................................................................... 3–50
Customizing Simulation ......................................................................................................................... 3–52
Simulation Options ..................................................................................................................................... 3–52
Variables .................................................................................................................................................... 3–61
Macros .......................................................................................................................................................... 3–61
Simulation System Files ............................................................................................................................ 3–62

Using Simulation Features ......................................................................................................................... 4–1
Simulation Startup Notes ........................................................................................................................... 4–1
Physics Filter ............................................................................................................................................... 4–1
Attaching Geometry .................................................................................................................................. 4–1
How to Attach Geometry ............................................................................................................................ 4–2
Branches ..................................................................................................................................................... 4–5
Solids ............................................................................................................................................................ 4–8
Surface Models .......................................................................................................................................... 4–8
Assemblies, Parts, and Bodies ...................................................................................................................... 4–9
Point Mass ................................................................................................................................................... 4–10
Coordinate Systems ................................................................................................................................. 4–11
Contact ......................................................................................................................................................... 4–12
Spot Welds ................................................................................................................................................... 4–12
Virtual Topology ....................................................................................................................................... 4–13
Graphics ......................................................................................................................................................... 4–13
Annotations .................................................................................................................................................. 4–13
Controls ....................................................................................................................................................... 4–18
Figures ......................................................................................................................................................... 4–18
Applying Loads .......................................................................................................................................... 4–19
Types of Loads ............................................................................................................................................. 4–19
  Acceleration ................................................................................................................................................. 4–20
  Standard Earth Gravity ............................................................................................................................ 4–21
  Rotational Velocity .................................................................................................................................. 4–22
  Pressure Loads ......................................................................................................................................... 4–22
  Force Load ................................................................................................................................................ 4–23
  Remote Force Load .................................................................................................................................. 4–26
  Bearing Load ............................................................................................................................................. 4–26
Bolt Load ............................................................................................................................... 4–28
Moment ................................................................................................................................. 4–31
Generalized Plane Strain .................................................................................................... 4–32
Thermal Condition .............................................................................................................. 4–32
Inertia Relief ........................................................................................................................ 4–34
Motion Load ......................................................................................................................... 4–34
Convection ......................................................................................................................... 4–35
Temperature ....................................................................................................................... 4–36
Radiation ............................................................................................................................. 4–38
Internal Heat Generation ................................................................................................. 4–38
Heat Flux ............................................................................................................................ 4–38
Heat Flow ............................................................................................................................ 4–39
Perfectly Insulated ............................................................................................................ 4–41
Electromagnetic Boundary Conditions and Excitations ..................................................... 4–41
Magnetic Flux Boundary Conditions ................................................................................... 4–42
Conductor .......................................................................................................................... 4–44
Solid Conductor Body ...................................................................................................... 4–44
Voltage Excitation for Solid Conductors .......................................................................... 4–47
Current Excitation for Solid Conductors .......................................................................... 4–48
Winding Conductor Body .................................................................................................. 4–49
Harmonic Loads ................................................................................................................ 4–52
Resolving Thermal Boundary Condition Conflicts ............................................................ 4–53
How to Apply Loads .......................................................................................................... 4–53
Direction ............................................................................................................................. 4–54
Scope ................................................................................................................................ 4–56
Types of Supports .............................................................................................................. 4–56
Fixed Surface ...................................................................................................................... 4–57
Fixed Edge .......................................................................................................................... 4–57
Fixed Vertex ....................................................................................................................... 4–58
Displacement for Surfaces ............................................................................................. 4–58
Displacement for Edges ..................................................................................................... 4–59
Displacement for Vertices ............................................................................................... 4–60
Remote Displacement ........................................................................................................ 4–61
Frictionless Surface .......................................................................................................... 4–64
Compression Only Support ............................................................................................. 4–65
Cylindrical Support .......................................................................................................... 4–66
Simply Supported Edge ..................................................................................................... 4–67
Simply Supported Vertex .................................................................................................. 4–67
Fixed Surface Rotation ..................................................................................................... 4–68
Fixed Edge Rotation .......................................................................................................... 4–68
Fixed Vertex Rotation ....................................................................................................... 4–69
Applying Loads Demonstration ....................................................................................... 4–69
Load ANSYS ....................................................................................................................... 4–70
Results ................................................................................................................................ 4–72
Scoping Results .................................................................................................................. 4–73
Cleaning Results Data ....................................................................................................... 4–73
Renaming Results Based on Definition ........................................................................... 4–73
Nonlinear (Solution Information) ...................................................................................... 4–73
Stress Tools ........................................................................................................................ 4–77
Maximum Equivalent Stress Safety Tool ........................................................................... 4–77
Maximum Shear Stress Safety Tool .................................................................................. 4–79
Mohr-Coulomb Stress Safety Tool .................................................................................... 4–80
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Tensile Stress Safety Tool</td>
<td>4–82</td>
</tr>
<tr>
<td>Fatigue (Fatigue Tool)</td>
<td>4–83</td>
</tr>
<tr>
<td>Contact Tool</td>
<td>4–84</td>
</tr>
<tr>
<td>Beam Tool</td>
<td>4–86</td>
</tr>
<tr>
<td>Frequencies (Frequency Finder)</td>
<td>4–87</td>
</tr>
<tr>
<td>Buckling</td>
<td>4–88</td>
</tr>
<tr>
<td>Harmonics (Harmonic Tool)</td>
<td>4–90</td>
</tr>
<tr>
<td>Harmonic Tool Configuration</td>
<td>4–90</td>
</tr>
<tr>
<td>Results Types</td>
<td>4–91</td>
</tr>
<tr>
<td>Stress/Strain</td>
<td>4–94</td>
</tr>
<tr>
<td>Equivalent</td>
<td>4–94</td>
</tr>
<tr>
<td>Maximum, Middle, and Minimum Principal</td>
<td>4–95</td>
</tr>
<tr>
<td>Maximum Shear</td>
<td>4–95</td>
</tr>
<tr>
<td>Intensity</td>
<td>4–96</td>
</tr>
<tr>
<td>Error (Structural)</td>
<td>4–96</td>
</tr>
<tr>
<td>Vector Principals</td>
<td>4–98</td>
</tr>
<tr>
<td>Equivalent Plastic Strain</td>
<td>4–98</td>
</tr>
<tr>
<td>Deformation</td>
<td>4–99</td>
</tr>
<tr>
<td>Thermal</td>
<td>4–100</td>
</tr>
<tr>
<td>Shape Environments</td>
<td>4–102</td>
</tr>
<tr>
<td>Electromagnetic</td>
<td>4–104</td>
</tr>
<tr>
<td>Electric Potential</td>
<td>4–104</td>
</tr>
<tr>
<td>Flux Density</td>
<td>4–104</td>
</tr>
<tr>
<td>Directional Flux Density</td>
<td>4–104</td>
</tr>
<tr>
<td>Field Intensity</td>
<td>4–104</td>
</tr>
<tr>
<td>Directional Field Intensity</td>
<td>4–105</td>
</tr>
<tr>
<td>Force</td>
<td>4–105</td>
</tr>
<tr>
<td>Directional Force/Torque</td>
<td>4–105</td>
</tr>
<tr>
<td>Current Density</td>
<td>4–105</td>
</tr>
<tr>
<td>Inductance</td>
<td>4–105</td>
</tr>
<tr>
<td>Flux Linkage</td>
<td>4–106</td>
</tr>
<tr>
<td>Reactions</td>
<td>4–106</td>
</tr>
<tr>
<td>Convergence</td>
<td>4–108</td>
</tr>
<tr>
<td>Probe Tool</td>
<td>4–110</td>
</tr>
<tr>
<td>Recovering Unconverged Results</td>
<td>4–112</td>
</tr>
<tr>
<td>Solving Overview</td>
<td>4–113</td>
</tr>
<tr>
<td>Solution Scenarios</td>
<td>4–119</td>
</tr>
<tr>
<td>Solving Overview (Transient Simulations)</td>
<td>4–121</td>
</tr>
<tr>
<td>Solving</td>
<td>4–122</td>
</tr>
<tr>
<td>Solving Units</td>
<td>4–123</td>
</tr>
<tr>
<td>Results of Solving</td>
<td>4–126</td>
</tr>
<tr>
<td>Saving your Results in Simulation</td>
<td>4–127</td>
</tr>
<tr>
<td>Saving Your Results in the ANSYS Workbench</td>
<td>4–128</td>
</tr>
<tr>
<td>Solution Combinations</td>
<td>4–130</td>
</tr>
<tr>
<td>Commands Objects</td>
<td>4–131</td>
</tr>
<tr>
<td>View Results</td>
<td>4–136</td>
</tr>
<tr>
<td>Graphics</td>
<td>4–136</td>
</tr>
<tr>
<td>Exporting Data</td>
<td>4–136</td>
</tr>
<tr>
<td>Reporting</td>
<td>4–137</td>
</tr>
<tr>
<td>Introduction</td>
<td>4–137</td>
</tr>
<tr>
<td>Report Preview</td>
<td>4–138</td>
</tr>
<tr>
<td>Outline by Tree</td>
<td>4–138</td>
</tr>
<tr>
<td>CAD Systems</td>
<td>Page</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>General Information</td>
<td>5–9</td>
</tr>
<tr>
<td>CAD System Support</td>
<td>5–9</td>
</tr>
<tr>
<td>ACIS</td>
<td>5–9</td>
</tr>
<tr>
<td>Autodesk Inventor</td>
<td>5–10</td>
</tr>
<tr>
<td>Autodesk Mechanical Desktop</td>
<td>5–10</td>
</tr>
<tr>
<td>CATIA V4</td>
<td>5–11</td>
</tr>
<tr>
<td>CATIA V5</td>
<td>5–12</td>
</tr>
<tr>
<td>DesignModeler</td>
<td>5–12</td>
</tr>
<tr>
<td>IGES</td>
<td>5–13</td>
</tr>
<tr>
<td>OneSpace Designer Modeling</td>
<td>5–13</td>
</tr>
<tr>
<td>Parasolid</td>
<td>5–14</td>
</tr>
</tbody>
</table>

| Inserting Figures                             | 4–139|
| Publishing                                     | 4–139|
| Customizing Your Reports                       | 4–139|
| Troubleshooting Reports                        | 4–140|
| Meshing Overview                               | 4–141|
| Global Meshing Settings                        | 4–141|
| Mesh Control Tools                             | 4–143|
| Other Meshing Tools                            | 4–151|
| Mesh Sweeping                                  | 4–154|
| Parameters                                     | 4–155|
| Specifying Parameters                          | 4–155|
| Scenario Grids                                 | 4–160|
| What Ifs                                       | 4–161|
| Failures                                       | 4–162|
| CAD Parameters                                 | 4–163|
| Fatigue Overview                               | 4–164|
| Fatigue Material Properties                    | 4–164|
| Fatigue Analysis and Loading Options           | 4–165|
| Reviewing Fatigue Results                      | 4–167|
| Contact                                        | 4–172|
| Global Contact Settings                        | 4–173|
| Contact Region Settings                        | 4–175|
| Scope Settings                                 | 4–175|
| Definition Settings                            | 4–175|
| Advanced Settings                              | 4–177|
| Supported Contact Types and Formulations       | 4–180|
| Setting Contact Conditions Manually            | 4–181|
| Contact Ease of Use Features                   | 4–182|
| Controlling Transparency for Contact Regions   | 4–182|
| Hiding Bodies Not Scoped to a Contact Region   | 4–182|
| Renaming Contact Regions Based on Geometry Names| 4–183|
| Identifying Contact Regions for a Body         | 4–183|
| Flipping Contact/Target Scope Settings         | 4–184|
| Merging Contact Regions That Share Geometry   | 4–184|
| Saving or Loading Contact Region Settings      | 4–185|
| Resetting Contact Regions to Default Settings | 4–185|
| Locating Bodies Without Contact                | 4–186|
| Virtual Topology Overview                      | 4–186|
| Introduction                                   | 4–186|
| Virtual Cell Creation                          | 4–186|
I. Appendices

A. Glossary of General Terms ................................................................. A–1
B. ANSYS Workbench and ANSYS Meshing Differences ...................... B–1

List of Figures

1. A Worksheet Tab View of a Geometry Folder .................................. 3–22
2. Annotation of a force on a surface .................................................. 4–15
3. Max and Min annotations and two probe annotations: .................... 4–17
4. Racetrack Coil Configuration ............................................................ 4–49
5. Circular Coil ...................................................................................... 4–50
6. 1/4 Symmetry Model of Actuator ...................................................... 4–51
7. Symmetry Mesh for Actuator with Full Winding Conductor ............... 4–52
8. Example of Report ............................................................................ 4–138
List of Tables

1. Available Capabilities by License ................................................................. 3–1
1. A Model Transferred to ANSYS ................................................................. 4–71
Simulation Approach

Use the Workbench Simulation module to define your model’s environmental loading conditions, solve the simulation, and review results in various formats depending on the type of simulation.

**Overall steps to using Simulation:**

1. Attach Geometry or open a .dsdb file from the Workbench Start Page or Project Page. Check the Simulation Startup Notes before continuing.
2. Assign materials to parts.
3. (If applicable) Set Contact Options.
4. (Optional) Apply Mesh controls or preview the mesh.
5. Apply Loads.
6. Select Results.
7. Solve.
8. Review Results.
9. (Optional) Set Parameters.
10. (Optional) Create Reports.
11. (Optional) Send parameters with any changes back to CAD system or DesignModeler.

*Note* — If you are familiar with ANSYS commands, you can use **Commands** objects.

Are you new to Simulation? If so, we encourage you to study the walkthrough example of a basic structural static simulation presented later in this Simulation Approach section. In addition to showing a real world implementation of the overall Simulation steps presented above, this example includes showing some of the basic features of Simulation that are used in all simulation types. Study this walkthrough example even if your main interest is in a simulation type other than structural static.

**Simulation Types**

The following simulation types are available. The overall steps presented under Simulation Approach are used in all types with some variations. The primary differences are in the specific types of loads and results you use, as described below.

- **Structural** - Use global and structural loads to produce a variety of structural results. By default, 3-D structural simulations are performed. You can configure Workbench for a 2-D structural simulation. Non-linear structural simulations are also realizable. The following specialized structural simulations are available:
  - **Static** - Use when loads are constant for individual sets of results. Typical applications include determining safety factors, stresses and deformation for a body or assembly under structural loading. A **Stress Simulation** wizard is available in the product as well as a walkthrough example in the Simulation Help.
  - **Sequenced** - Use when loads vary or for reviewing individual stages of results. The **Stress Simulation** wizard mentioned above for static structural simulations can be used. A walkthrough example of a sequenced simulation is available in the Simulation Help.
  - **Harmonic** - Use for sustained cyclic loads that produce a sustained cyclic or harmonic response. The **Stress Simulation** wizard mentioned above for static structural simulations can be used. Before ap-
plying loads, set the drop down menu to **Harmonic** in the **Environment** context toolbar. Then use the **Harmonic Tool** to assist you with the simulation. The **Harmonic Tool** is available from the **Solution** context toolbar under the **Tools** drop down menu.

- **Fatigue** - Use to simulate performance under anticipated cyclic loading conditions over the life span of the product or structure you are modeling. Specifically, a fatigue simulation determines the life and safety factor for a body or assembly under fatigue loading. A **Fatigue Simulation** wizard is available in the product along with a **Fatigue Tool** to assist you with the simulation. The **Fatigue Tool** is available from the **Solution** context toolbar under the **Tools** drop down menu. See Section : Fatigue Overview in the Simulation Help for more information.

- **Frequency (Modal)** - Use to determine the natural frequencies for a body or assembly. A **Frequency Simulation** wizard is available in the product along with a **Frequency Finder** to assist you with the simulation. The **Frequency Finder** is available from the **Solution** context toolbar under the **Tools** drop down menu.

- **Buckling** - Use to simulate a sudden large deformation of a structure due to an increase of an existing load. The **Stress Simulation** wizard mentioned above for static structural simulations can be used. In addition, use the **Buckling Tool** to assist you with the simulation. The **Buckling Tool** is available from the **Solution** context toolbar under the **Tools** drop down menu.

- **Shape Optimization** - Use to determine efficient ways to reduce the weight of a body or assembly. A **Shape Optimization** wizard is available in the product along with a **Shape Finder** to assist you with the simulation. The **Shape Finder** is available as a button in the **Solution** context toolbar.

- **Thermal** - Use to determine thermal results for a body or assembly under thermal loading. By default, 3-D thermal simulations are performed. You can configure Workbench for a 2-D thermal simulation with provisions.

  - **Static** - Use when thermal loads are constant for individual sets of results. Typical applications include determining temperature or heat flux for a body or assembly under thermal loading. A **Thermal Simulation** wizard is available in the product.

  - **Transient** - Use when thermal solutions vary with time, typically occurring with time-varying loads and/or boundary conditions. The **Thermal Simulation** wizard, mentioned above for static simulations can be used. A walkthrough example of a thermal transient simulation is available in the Simulation Help.

- **Electromagnetic** - Use to determine electromagnetic results for a body or assembly with electromagnetic loads. An **Electromagnetic Simulation** wizard is available in the product. Electromagnetic simulations are available only in 3-D. A walkthrough example of an electromagnetic simulation is available in the Simulation Help.

### Structural Static Simulations

A structural static simulation involves using the Simulation approach with constant global and structural loads to produce a variety of structural results.

Presented below is an example structural static simulation of a 12-part control arm assembly used in a race car. The assembly is made of structural steel and the objective is to determine if using a lighter material, such as aluminum, will preserve the structural integrity of the assembly under the rigors of its operating environment.

The assembly is shown below within its environment, which includes:

- The end cylinders are fixed except for being free to rotate in the tangential direction.
The back surfaces at the top are constrained from moving in the normal direction.

A constant downward force of 4450 N (~1000 lbf) is applied to the top surface.

Two simulation scenarios are examined where the assignment of material is the only difference between the two. Maximum Equivalent Stress Safety Factors for each scenario are compared to determine how strong the designs are relative to material yield.

This example makes use of the Simulation Wizard for many of the actions associated with the overall tasks.

The following procedure illustrates the structural simulation after the model is constructed in a supported CAD system.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the DesignModeler geometry database file.</td>
<td><strong>Browse ...</strong> to one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Windows platform:</td>
</tr>
<tr>
<td></td>
<td>• Unix platform:</td>
</tr>
<tr>
<td></td>
<td>• Windows platform:</td>
</tr>
<tr>
<td></td>
<td>• Unix platform:</td>
</tr>
</tbody>
</table>

...\Program Files\ANSYS Inc\v100\AISOL\Samples\Simulation\ControlArm.agdb | .../ansys_inc/v100/aisol/Samples/Simulation/ControlArm.agdb |
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
</table>
| 2. Move geometry into Simulation. | - Click on the [Project tab] to leave DesignModeler and go to the Workbench Project Page.  
- Click on New Simulation.  
- After geometry appears in Simulation, ensure Units> Metric (m, kg, N, °C, s, V, A) is checked.  

*Note* — It is recommended that you save the Simulation database file (dsdb) using File> Save As to save the file under another name and in another location. |

| 3. Examine contact regions in the control arm assembly. Upon import, Simulation automatically detects and applies contact conditions. | - Close the Simulation Wizard panel that is displayed on the right. We will use the wizard in the next step.  
- In Outline, expand Contact folder (+).  
- Select random Contact Regions. The individual regions are highlighted in the assembly, as shown in the following animated demonstration.  

*The following is an animated GIF. Please view online if you are reading the PDF version of the help.*  

- Collapse the Contact folder (-). |
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4. Open the Simulation Wizard.</td>
<td><strong>Note</strong> — Under <strong>Required Steps</strong> in the <strong>Simulation Wizard</strong> are the overall ordered simulation steps. An adjacent green check indicates the task is complete. A yellow “X” indicates that the task requires an input. A green “i” indicates the task has required information, such as a default value. Choosing a task with an adjacent “†” allows you to quickly change that default value. The wizard is fully customizable to facilitate specific in-house procedures.</td>
</tr>
<tr>
<td>5. Assign structural steel as material.</td>
<td><strong>In Simulation Wizard, Required Steps = Verify Materials.</strong> A flashing callout balloon shows you where and how to verify or change the material. The default material is <strong>Structural Steel</strong>.</td>
</tr>
<tr>
<td>Task</td>
<td>Action</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>6. Insert supports.</td>
<td>Note</td>
</tr>
<tr>
<td></td>
<td>— Using the middle button as a “temporary” view control is often easier than changing the function of the left button from selecting to rotating.</td>
</tr>
</tbody>
</table>
• In **Simulation Wizard**, **Required Steps = Insert Supports.**

• Rotate the assembly by holding down middle mouse button (or scrolling wheel) so that the end cylinders are visible as shown.

• Select (click) the two end cylinders (use the [Ctrl] key for multiple selection).

• From **Structural** toolbar drop-down menu (at callout balloon), click on **Cylindrical Support**.

*Note — You can also add loads and supports by using a right mouse button click on the **Environment** folder in the **Outline**, and choosing **Insert > load or support** from the context menu.*

• Under **Details of “Cylindrical Support”**, set **Tangential = Free**. This allows free rotation of the end cylinders in the tangential direction.
• Rotate the assembly and select the two surfaces shown.

• From **Structural** toolbar drop-down menu, click on **Frictionless Support**.
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
</table>
| 7. Insert load. | · In **Simulation Wizard**, Required Steps = **Insert Loads**.  
· Reorient the assembly and select the face as shown.  
· From **Structural** toolbar drop-down menu (at callout balloon), click on **Force**.  
· Under **Details of “Force”**, set the following:  
  - **Define By** = **Components**.  
  - **Z Component** = -4450.  
· [Enter]. |

![Diagram of Insert load action](Image)
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
</table>
| 8. Capture environment. After “staging” the model by rotating it to a particular perspective and including labels, you can use the **Figure** toolbar button to capture snapshots for later presentation in the report. | • In **Outline**, click on the **Environment** folder.  
• Orient display so that all three load and support labels are visible as shown.  

![Capture environment diagram](image)

• In **Simulation Wizard**, **Optional Tasks** = **Insert Figure**.  

![Optional Tasks](image)

• Click the **Figure** toolbar button.  

![Figure toolbar](image) |
| 9. Insert Results. | • In **Simulation Wizard**, **Required Steps** = **Insert Results**.  

![Required Steps](image)  

• **Tools** > **Stress Tool**.  
• Click on **Solution** folder.  
• From the **Solution** toolbar, **Stress** > **Equivalent (vonMises)**.  

![Stress Tool](image) |
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>10. Obtain solution.</td>
<td>• In Simulation Wizard, Required Steps = Solve.</td>
</tr>
<tr>
<td></td>
<td>• Click the Solve toolbar button. You will see progress bars during the</td>
</tr>
<tr>
<td></td>
<td>solution.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Solve toolbar screenshot" /></td>
</tr>
<tr>
<td></td>
<td>The solution is complete when you see a green check mark adjacent to</td>
</tr>
<tr>
<td></td>
<td>the Solution folder in the Outline.</td>
</tr>
</tbody>
</table>
## Simulation Approach

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>11. Review results and capture picture for report.</td>
<td></td>
</tr>
<tr>
<td><strong>Note</strong> — Your results may vary from the results values shown.</td>
<td></td>
</tr>
</tbody>
</table>
• In the **Outline**, under the **Solution** folder, click on **Equivalent Stress**.

![Equivalent Stress](image)

• Click the **Figure** toolbar button.

• Click the **Probe** toolbar button.

• Hover cursor over the assembly to display the result value at specific locations. Click to “stamp” the value, as shown in the animated demonstration below.

The following is an animated GIF. Please view online if you are reading the PDF version of the help.

• In the **Outline**, under the **Solution** folder, click on **Equivalent Stress**.

• Click the **Animation** tab at the bottom of the window.

• On the Animation toolbar, click the **Play** button.

• Examine the animation and then click the **Stop** toolbar button.

These steps are illustrated in the following animated demonstration.

The following is an animated GIF. Please view online if you are reading the PDF version of the help.
12. Examine Safety Factor and capture picture for report.

The criterion for interpreting Safety Factor is as follows:

- A value of 1 or lower indicates that material yield will most likely occur.
- A value of 3 to 4 is ideal.
- A value greater than 4 indicates an overdesign.

Clearly in this case there is a comfortable Safety Factor and an indication that we can experiment with a lighter material such as Aluminum.
### Task | Action
--- | ---
**13. Duplicate simulation for Safety Factor comparison. This will preserve the original simulation and geometry for comparison.**
- In **Outline**, collapse the Model folder (-).
- In **Simulation Wizard, Advanced Tasks = Compare Models**.
  
  ![](image)

  - Right mouse click on the Model folder, then click on **Duplicate**.

**14. Assign Aluminum Alloy as material.**
- In **Outline**, click on the Model2 folder.
- In **Simulation Wizard, Required Steps = Verify Materials**.
- Under **Details of “Multiple Selection”**, set Material = Import.
- Under **Material Data to Import**, choose Aluminum Alloy.

  ![](image)

  - Click **OK**.

**15. Obtain solution for second simulation.**
- Click **Solve**.
**Simulation Approach**

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
</table>
| 16. Compare Safety Factors of both simulations and include picture for report. | - In **Outline**, under the **Model2** folder, expand **Environment** (+).  
- Under the **Environment** folder, expand **Solution** (+).  
- Under the **Solution** folder, expand **Stress Tool** (+).  
- Click on **Safety Factor**. |

Using Aluminum, the Safety Factor is well within the acceptable minimum value, while the weight of the assembly has been reduced to almost 1/3 the weight of the original Structural Steel design. Reducing weight is a critical consideration in automotive racing.

- Click the **Figure** toolbar button.

| 17. Generate report. | - Click on the **Report Preview** tab.  
- Click the **Generate Report** button. |

**Sequenced Simulations**

A sequenced simulation is recommended for simulating varying structural load applications or for reviewing individual stages of results. In a sequenced simulation, you can define each load condition as an independent
load step. Upon solving, final results are available from the last load step as well as from any of the intermediate load steps.

**To perform a sequenced simulation:**

1. Attach Geometry or open a .dsdb file from the Workbench Start Page or Project Page.
2. Highlight **Environment** in the tree, and from the **Environment** context toolbar, verify that **Static** (default selection) is displayed in the drop-down menu, then enter the number of sequence steps in the **Steps** field.

   ![Screenshot of environment settings](image)

   When the number of sequence steps is greater than 1, a **Timeline** controller and **Tabular Data** window appear as shown below:

   ![Screenshot of timeline controller and tabular data window](image)

   **Note** — The management of these windows (for example, repositioning) differs on Windows platforms vs. Unix platforms.

   You use the **Timeline** controller to select which load step you will be defining or modifying, or which load step’s results you want to display. The **Timeline** controller also displays the magnitude of the loads.

3. Apply the loads for each step.

   **Note** — If you use a Displacement in a sequenced simulation, the degrees of freedom used must not change, although the component values can change.

   Inserting a load under the **Environment** updates the **Tabular Data** window with a grid to enable you to enter data on a per-step basis. As you enter the data, the values are reflected in the **Timeline** controller, also on a per-step basis.

   ![Screenshot of tabular data window](image)

   A check box is available for each component of a load in order to turn on or turn off the viewing of the load in the **Timeline** controller display. Components are color-coded to match the component name in the **Tabular Data** widow. Clicking on a step value in the **Tabular Data** window or selecting a step value in the **Timeline** controller will update the display in the upper left corner of the **Graphics** window with the appropriate step number and load data.

   To select a step value in the **Timeline** controller, hover the mouse over the step until a circle cursor appears then click on that location. The selected step number appears bolded, as shown in the following example:
Step 3 is selected.

The following options are also available in a context menu that displays when you click the right mouse button within the Timeline controller and/or the Tabular Data widow:

- **Retrieve Results**: Retrieves and presents the results for the object at the selected step.
- **Insert Step**: Inserts a new step before the currently selected step in the Timeline controller or Tabular Data window. The values from the current step will be copied to the new step. All load objects in the Environment will be updated with a new step.
- **Cut Step**: Deletes a step, but retains the information in a buffer for subsequent use in the Paste Step After option.
- **Paste Step After**: Takes step information in the buffer (resulting from Copy Step or Cut Step) and pastes the step after the currently selected (highlighted) step.
- **Copy Step**: Copies single step information into a buffer. Use in conjunction with Paste Step After to duplicate load step information from one step number to another.
- **Cut Cell**: Clears the entries for selected cells.
- **Copy Cell**: Copies the cell data into the clipboard for a selected cell or group of cells. The data may then be pasted into another cell or group of cells. The contents of the clipboard may also be copied into Microsoft Excel. Cell operations are only valid on load data and not data in the Step column.
- **Paste Cell**: Pastes the contents of the clipboard into the selected cell, or group of cells. Paste operations are compatible with Microsoft Excel.
- **Select All**: Selects all cells in the Tabular Data window.
- **Delete Step**: Removes the selected step from the sequence. The step will be removed from all load objects in the multistep environment.
- **Zoom to Range**: Zooms in on a subset of the data in the Timeline controller. Click and hold the left mouse at a step location and drag to another step location. The dragged region will highlight in blue. Next, select Zoom to Range. The chart will update with the selected step data filling the entire axis range.
- **Zoom to Fit**: If you have chosen Zoom to Range and are working in a zoomed region, choosing Zoom to Fit will return the axis to full range covering all steps.

4. Select result items. You can associate a result item with a particular load step by highlighting the result item and then specifying the Sequence Number in the Details View for that result.

   Note — If you insert a Commands object under an Environment or Solution object, a Sequence Selection Mode control is available in the Details View of the Commands object. Use this control to specify which sequence steps are to process the Commands object.

5. Solve. If a sequenced simulation fails to solve completely, Simulation includes a feature that allows you to recover partially solved or unconverged results.
6. Review Results. After a solution is completed, click on the results object in the Tree. The Timeline controller and Tabular Data window appear. Result data is charted in the Timeline controller and listed in the Tabular Data window. The result data includes the Maximum and Minimum values of the results object over the steps.

To view the results in the Graphics window for the desired step, select the step in the Timeline controller or Tabular Data window, then click the right mouse button and choose Retrieve Results. The Details View for the chosen result object will also update to the selected step.

The Probe Tool is also available to assist you in reviewing results.

Presented below is an example of a sequenced simulation that involves the successive application of three bolts to a flange assembly. The bolts are shown below along with the Fixed Support that is applied to the inner tube.

The goal of the simulation is to examine the Total Deformation resulting after tightening the first bolt, then the second bolt, then the third bolt. A sequenced simulation is the ideal approach for this problem.

Three load steps are planned with each step defining a specific combination of bolt status for the three bolts. The bolt status for each load step is shown in the following table.

<table>
<thead>
<tr>
<th>Bolt Status</th>
<th>Load Step 1: Only first bolt is tightened.</th>
<th>Load Step 2: Only first and second bolts are tightened.</th>
<th>Load Step 3: All bolts are tightened.</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Bolt</td>
<td>Load</td>
<td>Lock</td>
<td>Lock</td>
</tr>
<tr>
<td>Second Bolt</td>
<td>Open</td>
<td>Load</td>
<td>Lock</td>
</tr>
<tr>
<td>Third Bolt</td>
<td>Open</td>
<td>Open</td>
<td>Load</td>
</tr>
</tbody>
</table>

Follow the procedure below to perform this simulation.
### Simulation Approach

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1. Open the DesignModeler geometry database file. | **Browse ...** to one of the following:  
- Windows platform: `\Program Files\ANSYS Inc\v100\AISOL\Samples\Simulation\Bolts.agdb`  
- Unix platform: `../ansys_inc/v100/aisol/Samples/Simulation/Bolts.agdb` |
| 2. Move geometry into Simulation. |  
- Click on the **[Project tab]** to leave DesignModeler and go to the Workbench Project Page.  
- Click on **New Simulation**.  
  
To match the layout in the picture above, click on the **Rotate** button in the toolbar.  
- Ensure **Units > Metric (m, kg, N, °C, s, V, A)** is checked.  
  
**Note** — It is recommended that you save the Simulation database file (dssdb) using **File > Save As** to save the file under another name and in another location. |
| 3. Set configuration for a sequenced simulation with 3 steps. |  
- In **Outline**, click on the **Environment** folder.  
- In the **Environment** context toolbar, type **3** in the **Steps** field and press **Enter**. |
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4. Apply <strong>Bolt</strong> load to the first bolt.</td>
<td>• On the assembly, click on the cylindrical surface representing the first bolt.</td>
</tr>
<tr>
<td></td>
<td>• From the <strong>Environment</strong> context toolbar, choose <strong>Bolt</strong> from the <strong>Structural</strong> drop down menu.</td>
</tr>
<tr>
<td>Task</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
<tr>
<td>5. Apply <strong>Bolt</strong> load to the second and third bolts.</td>
<td></td>
</tr>
</tbody>
</table>
• Repeat step 4 for **Bolt 2**.

• Repeat step 4 for **Bolt 3**.
### Task | Action
--- | ---
6. Add fixed support. | • Click on the inner tube of the assembly.  
• From the Environment context toolbar, choose Fixed Support from the Structural drop-down menu.

7. Set loading conditions for the first bolt that represent all steps. | • Click on Bolt in the tree.  
• Enter the following load information into the Tabular Data window. This information is taken from the Bolt Status table presented at the beginning of this walkthrough example:  
  - Step 1 = Load; 10000  
  - Step 2 = Lock  
  - Step 3 = Lock  
  
To change a load condition in a Define By cell, click in the cell and choose a condition from the drop down menu. You can type values directly in the Value cells.
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
</table>
| 8. Set loading conditions for the second bolt that represent all steps. | • Click on Bolt 2 in the tree.  
• Enter the following load information into the Tabular Data window:  
  - Step 1 = Open  
  - Step 2 = Load; 10000  
  - Step 3 = Lock |
| 9. Set loading conditions for the third bolt that represent all steps. | • Click on Bolt 3 in the tree.  
• Enter the following load information into the Tabular Data window:  
  - Step 1 = Open  
  - Step 2 = Open  
  - Step 3 = Load; 10000 |
| 10. Review the details of the load step information.               | You can make any data changes directly in the Tabular Data window. In addition to the graphical display in the Timeline controller of loads vs. steps for the highlighted load, you can click on Environment, then on the Worksheet tab to display reaction forces. |
| 11. Select result item for load step 1.                             | • In Outline, click on the Solution folder.  
• From the Solution context toolbar, choose Total from the Deformation drop down menu.  
• Select 1 for the Sequence Number in the Details View. |
| 12. Select result item for load step 2.                             | • Repeat step 11 but select 2 for the Sequence Number in the Details View of Total Deformation 2. |
| 13. Select result item for load step 3.                             | • Repeat step 11 but select 3 for the Sequence Number in the Details View of Total Deformation 3. |
14. Solve the simulation.
   - Click on **Solve** in the toolbar.

15. Review result of load step 1.
   (Your results may vary from what is shown for the 3 steps.)
   - Click on **Total Deformation** in the tree.

   **Total Deformation when only the first bolt is tightened:**

   - Click on **Total Deformation 2** in the tree.

   **Total Deformation when only the first and second bolts are tightened:**
To perform a thermal transient simulation:

1. Attach Geometry or open a .dsdb file from the Workbench Start Page or Project Page.

2. Assign materials to parts. For a thermal transient simulation, you must specify Specific Heat and Density, in addition to Thermal Conductivity. You add these properties in Engineering Data.

3. Set configuration for a transient simulation by choosing Transient in the drop down menu located in the Environment context toolbar or in the Solution context toolbar. The following items are displayed as a result of this action:
   - An End Time field located in the toolbar.
   - An Initial Condition tree object inserted under Environment (see step 5).
   - A Transient Settings tree object inserted under Solution (see step 7).
   - A Solution Information tree object that includes two Temperature Result Tracker objects inserted under Solution (see step 9).
   - A Timeline controller and Tabular Data window (see step 6).

4. Enter the end time (in seconds) in the End Time field. The beginning time is assumed to be 0.0 seconds so the end time must be greater than 0.0 seconds.

5. Specify the initial temperature in the Details View of the Initial Condition object.
To specify a uniform temperature across the model, set Initial Temperature to Uniform Temperature, then set Initial Temperature Value to the desired value.

- To specify a non-uniform temperature from another environment, set Initial Temperature to Non-Uniform Temperature, then set Initial Condition Environment to the name of a static environment. The temperature solution from this environment will be used as the initial condition.

**Note** —
- If the environment that includes the non-uniform temperature does not exist (for example, if the environment was deleted), the Initial Condition object changes to the underdefined state.
- Convergence objects inserted under an environment that is referenced by an Initial Condition object will invalidate the Initial Condition object, and not allow a solution to progress.

**TIP:** If you already have a steady state environment set up in Simulation and you want to use the results from this environment as the initial condition for a subsequent transient analysis, a short cut is available. To generate the new environment, click the right mouse button on the Temperature result and choose Generate Transient Environment with Initial Condition from the context menu. All loads and supports from the original static environment are duplicated in the new transient environment. In the Details View of the new Initial Condition object, Non-Uniform Temperature is set, and Initial Condition Environment is set to the name of the static environment.

6. Apply thermal loads using the general procedure for applying loads in any simulation with additional provisions for transient settings as described below. The thermal loads can either be constant (such as an unchanging Heat Flux or applied Temperature), or tabular (such as Internal Heat Generation from turning a computer chip on and off for a specified time period).

- To define a constant thermal load, set Define As to Constant in the Details View of the thermal load and enter a value for the Magnitude.
- To define a time-dependent thermal load, set Define As to Load History in the Details View of the thermal load and choose one of the following options from the History Data menu:
  - New Load History... - Transfers to Engineering Data where you can define a new load history by entering load values and corresponding time values. The name of the load history appears in the tree in Engineering Data.
  - Import... - Displays a dialog box where you can access existing load history definitions from library files. Choosing an existing load definition assigns it as part of the load specification.
  - Edit <load history name> ... - Transfers to Engineering Data where you can edit the data representing the load history currently assigned to the part.

When you return to Simulation (click the Simulation tab), the new load history name appears in the History Data area. The data is charted in the Timeline controller and listed in the Tabular Data window. The load history data is read-only.
A checkbox is available for each component of a load in order to turn on or turn off the viewing of the load in the **Timeline** controller display. Components are color-coded to match the component name in the **Tabular Data** window. Clicking on a time value in the **Timeline** controller or **Tabular Data** window will update the display in the **Graphics** window with the appropriate time and load data.

Note — The management of these windows (for example, repositioning) differs on Windows platforms vs. Unix platforms.

7. **Adjust transient settings (optional).** The default settings for a transient simulation will provide accurate and robust answers for most problems. You can proceed to solving in the next step or you can customize your transient solution options (especially useful if you are an advanced user) by selecting the **Transient Settings** object under **Solution**. A corresponding **Transient Settings** worksheet appears. You can make adjustments directly on this page.

8. **Solve.** The solution to a transient simulation will typically have multiple result points. This can lead to large solution result files. Since the potential amount of results is large, only results that you request will be read into memory. As long as the result file is present, the program can calculate any additional results. However, if the result file is missing, then any additional results, animation, or using the solution as input in a coupled environment simulation will require a full solution in order to recreate the result file. In order to save on disk space, you can control which output types will be put into the result file.

If a transient simulation fails to solve completely, Simulation includes a feature that allows you to recover partially solved or unconverged results.

9. **Review Results.** Click on a result object in the tree. The **Timeline** controller display will show the **Maximum** and **Minimum** values of the result over time. The **Tabular Data** window lists the time values at which results were requested (refer to step 7 on transient settings) along with the **Maximum** and **Minimum** values.

   - To view the complete results of the result object, click on the first column of the **Tabular Data** window at a results time point of interest. Click the right mouse button and choose **Retrieve Results** from the context menu. This action will retrieve the results for the object at the selected time point. The **Graphics** window will display the results, and the **Timeline** controller will update the cursor to the time point. The Details View will be updated to reflect the results at the selected time point.

   - To retrieve results at points intermediate to the requested result time points, click on a desired time in the **Timeline** controller and choose **Retrieve Results**. Results will be interpolated from the nearest result time points and displayed in the **Graphics** window. The **Maximum** and **Minimum** values will appear in the chart and in the **Tabular Data** window. The Details View for the result object will also update to this interpolated time value.

**TIP:** You may create a static **Environment** containing the temperature results applied as a **Thermal Condition**. The **Thermal Condition** provides temperatures as a "load" to a static simulation for evaluating thermal strains. To create a single step simulation, highlight a time point in the **Timeline** controller or **Tabular Data** window, then click the right mouse button and choose **Generate Static Environment with Thermal Condition** from the context menu. If several static simulations are required using temperature results from different time points, highlight the multiple time points choose **Generate Static Environment with Thermal Condition**. A multi-step sequenced static **Environment** object will be created. The Worksheet view **Thermal Condition** load object will reflect the time values at which temperatures will be applied as thermal loads.
The following options are available in a context menu that displays when you click the right mouse button within the **Timeline** controller and/or the **Tabular Data** widow:

- **Retrieve Results**: Retrieves and presents the results for the object at the selected time point.

- **Generate Static Environment with Thermal Condition**: Creates a new static environment that includes a **Thermal Condition** load object that is based on the temperature result from a thermal simulation. The temperature can vary with time. Refer to the **TIP** above for additional variations.

- **Copy Cell**: Copies the cell data into the clipboard for a selected cell or group of cells. The data may then be pasted into another cell or group of cells. The contents of the clipboard may also be copied into Microsoft Excel. Cell operations are only valid on load data and not data in the **Step** column.

- **Select All**: Selects all cells in the **Tabular Data** window.

- **Zoom to Range**: Zooms in on a subset of the data in the **Timeline** controller. Click and hold the left mouse at a step location and drag to another step location. The dragged region will highlight in blue. Next, select **Zoom to Range**. The chart will update with the selected step data filling the entire axis range.

- **Zoom to Fit**: If you have chosen **Zoom to Range** and are working in a zoomed region, choosing **Zoom to Fit** will return the axis to full range covering all steps.

The following additional features are available to assist you in reviewing results in a transient simulation:

- **Contour Results** - Because the simulation is time dependent, part of the definition of a contour result is to set at which time the result will be calculated. You can set this using the **Display Time** setting in the Details View of the result object.

- **Animation** - A result animation may be useful over the time period of interest.

- **Probe Results** - A probe result is scoped to a specified region such as an XYZ point (to model a thermocouple for example). The result output can be at a given point in time or across all points in time (to create a result time history plot of output as a function of time).

- **Result Trackers** - For a transient simulation, two **Temperature Result Tracker** objects are provided under a **Solution Information** object. As the solution progresses, output will be plotted in real solution time. The **Temperature Result Tracker** objects can be scoped either to a vertex or be set to display global **Minimum** and **Maximum** values at a solution point. Note that the output is plotted for each solution point.

  **Note** — If you request a result before the first solved time point, the result is reported at the first solved time point. Simulation cannot extrapolate before the first time point. In this case, the values appearing in the Details View of the result object for **Display Time** and **Time** (under **Information**) may not be in agreement.

Presented below is an example of a thermal transient simulation that examines the overall structural effect on a circuit board (shown below), resulting from the switching states of computer chips on the board.
You will actually be performing the following three simulations:

A. **Thermal Steady State.** The goal is to determine the constant steady state temperature that results from the internal heat generation and convection experienced by the circuit board and computer chips before the switching of the chips occurs. This steady state temperature will be used as the initial condition for the thermal transient simulation that follows.

B. **Thermal Transient.** The goal is to determine the temperature change resulting from the switching states of two computer chips over a specified time period. The switching of each chip occurs at different times within the time period. The resulting temperature at the end of the time period will be used as a thermal condition load that will be applied in the thermal stress simulation that follows.

C. **Thermal Stress.** The goal is to determine the total deformation and equivalent stress experienced by the thermal changes in the circuit board and the switching states of the chips.

Follow the procedure below to perform these simulations.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the DesignModeler geometry database file.</td>
<td>Browse ... to one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Windows platform: ...\Program Files\ANSYS Inc\v100\AISOL\Samples\Simulation\BoardWithChips.agdb</td>
</tr>
<tr>
<td></td>
<td>• Unix platform: .../ansys_inc/v100/aisol/Samples/Simulation/Board-WithChips.agdb</td>
</tr>
<tr>
<td>Task</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| 2. Move geometry into Simulation. | · Click on the [Project tab] to leave DesignModeler and go to the Workbench Project Page.  
· Click on **New Simulation**.  
· To match the layout in the picture above, click on the **Rotate** button in the toolbar.  
*Note* — It is recommended that you save the Simulation database file (dsdb) using **File > Save As**, to save the file under another name and in another location. |
| 3. Begin **thermal steady state** simulation. | · Click right mouse button on **Environment**.  
· Choose **Rename**.  
· Type **Thermal Steady State** and press **Enter**.  
· Ensure **Units > Metric** (m, kg, N, °C, s, V, A) is checked. |
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4. Apply <strong>Internal Heat Generation</strong> load to one chip.</td>
<td>- Select the computer chip shown below. To select the chip, first click on the <strong>Body</strong> selection filter toolbar button, then click on the chip. If the entire board is selected, click on the rear depth picking (stack) indicator in the lower left to select only the chip.</td>
</tr>
<tr>
<td></td>
<td>- Click right mouse button on <strong>Thermal Steady State</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Choose <strong>Insert &gt; Internal Heat Generation</strong>.</td>
</tr>
<tr>
<td></td>
<td>- In Details View, type $5\times10^7$ in the <strong>Magnitude</strong> field and press <strong>Enter</strong>.</td>
</tr>
</tbody>
</table>
5. Add **Convection** load representing Stagnant Air - Simplified Case to entire board.

- Select the board and all bodies on the board by choosing **Edit > Select All** from the main menu. You know that you have made the correct selection if **16 Bodies** is displayed at the bottom of the Workbench window. If it does not, make sure that the **Body** toolbar button selection filter is set, then retry the selection.

- Click right mouse button on **Thermal Steady State**.

- Choose **Insert > Convection**.

- Set the following in the Details View:
  - **Define As** = Temperature-Dependent
  - **Correlation** = Stagnant Air - Simplified Case (if not already displayed, click in the field and choose it from the menu, or choose **Import...**, then select it from the dialog box).
  - **Ambient Temperature** = type **23** and press **Enter**.

6. Add **Temperature** result.

- Click right mouse button on **Solution**.

- Choose **Insert > Thermal > Temperature**.

7. Solve.

- Click right mouse button on **Solution**.

- Choose **Solve**.

The solution is complete when green checks are displayed next to all of the objects.
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>8. Review result.</td>
<td>• Highlight <strong>Temperature</strong> result.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Temperature result" /></td>
</tr>
<tr>
<td></td>
<td><strong>You have completed the thermal steady state simulation.</strong></td>
</tr>
<tr>
<td>9. Begin thermal transient simulation.</td>
<td>• Click right mouse button on <strong>Temperature</strong> result.</td>
</tr>
<tr>
<td></td>
<td>• Choose <strong>Generate Transient Environment with Initial Condition</strong>. Note that the following occurs as a result of this action:</td>
</tr>
<tr>
<td></td>
<td>- A <strong>Thermal Transient</strong> environment and associated <strong>Solution</strong> are added to the tree. The environment includes an <strong>Initial Condition</strong> object along with the <strong>Internal Heat Generation</strong> and <strong>Convection</strong> loads that you added in the thermal steady state simulation.</td>
</tr>
<tr>
<td></td>
<td>- A <strong>Transient Settings</strong> object and a <strong>Solution Information</strong> object are added under the new thermal transient <strong>Solution</strong> object.</td>
</tr>
<tr>
<td></td>
<td>- A <strong>Timeline</strong> controller and <strong>Tabular Data</strong> window are displayed.</td>
</tr>
<tr>
<td></td>
<td>- If you highlight the <strong>Thermal Transient</strong> environment, the <strong>Environment</strong> context toolbar changes to display <strong>Transient</strong> and an <strong>End Time</strong> field.</td>
</tr>
<tr>
<td>Task</td>
<td>Action</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 10. Specify an end time of 200 seconds for the transient simulation. | • Highlight the **Thermal Transient** object.  
• In toolbar, type **200** in the **End Time** field and highlight the **Initial Condition** object.  

The **Timeline** controller initializes based on your **End Time** setting. |

| 11. Ensure that the **Initial Condition** is set to the **Thermal Steady State** environment. | • With the **Initial Condition** object highlighted, note that the **Initial Condition Environment** field is already set correctly to the **Thermal Steady State** environment. This was a further result of choosing Generate Transient Environment with Initial Condition in step 8 above.  
In general, you can choose (or change) an environment from the drop down list in this field whose temperature will be set as the initial condition for the thermal transient simulation. Only those environments that have a thermal steady state temperature result will be available in the drop down list. |
12. Add **Internal Heat Generation** load to a chip such that the load represents the following time history based on the switching states of that chip:

- 0 - 20 sec. = Off
- 20 - 40 sec. = On
- 40 - 200 sec. = Off

- Select the computer chip shown below.

- Click right mouse button on **Thermal Transient**.
- Choose **Insert > Internal Heat Generation**.
- In the Details View, set **Define As** to **Load History**.
- Click in **History Data** field and choose **New Load History ...** You are transferred to Engineering Data.
- Type the following data into the **Heat Generation vs. Time** table. Click in the first yellow field, type the data, then press the Enter key after each entry.

  - Time = 20; Heat Generation = 0
  - Time = 20.1; Heat Generation = 5e7
  - Time = 40; Heat Generation = 5e7
  - Time = 40.1; Heat Generation = 0

- After pressing the Enter key following entry of the last data point, click the [Simulation] tab at the top to return to Simulation. Note that the switching curve and data that you just defined are displayed in the **Timeline** controller and **Tabular Data** windows.
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
</table>
| 13. Add **Internal Heat Generation** load to a second chip such that the load represents the following time history based on the switching states of that chip: 0 - 60 sec. = Off 60 - 70 sec. = On 70 - 200 sec. = Off | • Select the computer chip shown below.  
  ![Diagram of computer chip](image)

- Click right mouse button on **Thermal Transient**.
- Choose **Insert > Internal Heat Generation**.
- In the Details View, set **Define As** to **Load History**.
- Click in **History Data** field and choose **New Load History**. You are transferred to Engineering Data.
- Type the following data into the **Heat Generation vs. Time** table:
  - Time = 60; Heat Generation = 0
  - Time = 60.1; Heat Generation = 1e8
  - Time = 70; Heat Generation = 1e8
  - Time = 70.1; Heat Generation = 0
- Click the [Simulation] tab at the top to return to Simulation. Note that the switching curve and data that you just defined are displayed in the **Timeline** controller and **Tabular Data** windows.  

![Timeline and Tabular Data](image)
### Task
14. Note transient settings established so far.

- Highlight the **Transient Settings** object. The **Transient Settings** worksheet displays a summary of your transient settings so far. You need not make any changes here because all default settings and adjustments are acceptable for this simulation.

![Transient Settings Worksheet](image.png)

15. Solve.

- Click right mouse button on **Solution** in **Thermal Transient** environment.
- Choose **Solve**.

The solution is complete when green checks are displayed next to all of the objects.
16. Review results.

- Highlight **Temperature** result.

- Open the **Solution Information** object and note that there are two **Temperature** result tracker objects listed. These represent the **Maximum** and **Minimum** temperature results.

- Highlight each result tracker and note the graphical display (**Global Maximum** is shown below).
### Task
17. Probe specific results on each of the three chips.

### Action
- Highlight **Solution** object in **Thermal Transient** environment and select same chip used in the **Thermal Steady State** simulation (see step 4).
  - Click right mouse button on **Solution** object.
  - Choose *Insert* > **Probe Tool** > **Probe Tool**.
  - Select first chip used in the **Thermal Transient** simulation (see step 12).
  - Click right mouse button on **Probe Tool**.
  - Choose *Insert* > **Probe Tool** > **Probe**.
  - Select second chip used in the **Thermal Transient** simulation (see step 13).
  - Click right mouse button on **Probe Tool**.
  - Choose *Insert* > **Probe Tool** > **Probe**.
  - Click right mouse button on **Probe Tool**.
  - Choose **Solve** to obtain the probed results.

---

You have completed the thermal transient simulation.
18. Begin *thermal stress* simulation.
- Click right mouse button on *Temperature* result in *Thermal Transient* environment.
- Choose *Generate Static Environment with Thermal Condition*. Note that the following occurs as a result of this action:
  - A *Thermal Stress* environment is added to the tree that includes a *Thermal Condition* load.
  - A *Total Deformation* result object is added under *Solution*.

19. Ensure that the *Thermal Condition* load is set to the *Thermal Transient* temperature at the end time of 200 sec.
- Highlight the *Thermal Condition* object.
- Note that the *Thermal Environment* field is already set correctly to the *Thermal Transient* environment and the *Time* is set correctly to 200 seconds. These were further results of choosing *Generate Static Environment with Thermal Condition* in step 17 above. In general, you can choose (or change) an environment from the drop down list in this field whose temperature will be set as the *Thermal Condition* load for a thermal stress simulation. Only those environments that have a thermal temperature result will be available in the drop down list. If temperatures are defined as load histories, a *Time* field is also included.
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
</table>
| 20. Add **Fixed Support** constraints to each of the holes on the circuit board. | · Click on the **Face** selection filter toolbar button, then select the inside surface of the top hole as shown.  
   · Click right mouse button on **Thermal Stress**.  
   · Choose **Insert> Fixed Support**.  
   · Select the inside surface of the bottom hole.  
   · Click right mouse button on **Thermal Stress**.  
   · Choose **Insert> Fixed Support**. |
| 21. Add **Equivalent Stress** result for the board and the board components. | · Click right mouse button on **Solution** under **Thermal Stress** environment.  
   · Choose **Insert> Stress> Equivalent (von Mises)**. This result is scoped to the default selection of **All Bodies**, as displayed in the Details View **Geometry** field. |
| 22. Add **Equivalent Stress** result for the board components without the board. | · Click the **Body** selection filter toolbar button, then select the board and all chips by choosing **Edit> Select All** from the main menu.  
   · Unselect the board by holding the **Ctrl** key while clicking on an empty region of the board. Ensure that **15 Bodies** is displayed at the bottom of the Workbench window.  
   · Click right mouse button on **Solution** under **Thermal Stress** environment.  
   · Choose **Insert> Stress> Equivalent (von Mises)**. Ensure that the **Geometry** field in the Details View displays **15 Bodies**. |
| 23. Solve. | · Click right mouse button on **Solution** in **Thermal Stress** environment.  
   · Choose **Solve**.  
   The solution is complete when green checks are displayed next to all of the objects. |
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>24. Review results.</td>
<td></td>
</tr>
</tbody>
</table>
• Highlight **Total Deformation**.

![Total Deformation Image]

- Max: 5.072e-001
- Min: 4.056e-002
- Scale: 1 to 40

• Highlight **Equivalent Stress**.

![Equivalent Stress Image]

- Max: 1.830e+009
- Min: 8.703e+004
- Scale: 1 to 1.5e+10

• Highlight **Equivalent Stress 2**.

![Equivalent Stress 2 Image]
You have completed the thermal stress simulation.

**Electromagnetic Simulations**

An electromagnetic simulation typically involves the Simulation approach (presented above) with some variations. The main variation is that the geometry must be a single solid body, a single solid multi body part, or a winding conductor body. Electromagnetic loads are used to produce a variety of electromagnetic results.

*Note* — The use of pyramid elements in critical regions should be minimized. Pyramid elements are used to transition from hexagonal to tetrahedral elements. You can eliminate pyramid elements from the model by specifying **All Tetrahedrons** using a **Method** mesh control tool.

The following problem consists of simulating the performance of the solenoid actuator shown below.

![Image of CAD model](image)

The CAD model is a 1/4 symmetry view of the system, which includes a moving armature, a yoke, and a wound coil (represented by a line body). The objective of the simulation is to compute the force on the armature, the inductance of the coil, and the flux linking the coil.

The coil is a wound structure consisting of 100 turns, carrying 10 amps per turn. The coil is modeled using a winding body. The original CAD model includes a line body that represents the centerline of the coil.
The overall steps to be accomplished are:

- In DesignModeler, promote the line body to a winding body, and supply the coil cross-section information and number of turns.
- In DesignModeler, provide an enclosure for the model that simulates the surrounding air domain.
- In Simulation, set up the boundary conditions, specify the results quantities, and simulate the performance of the actuator.

After the CAD model is prepared in DesignModeler, the following procedure illustrates the electromagnetic simulation.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1. Open the DesignModeler geometry database file. | · **Browse** ... to one of the following:  
Windows platform:  
...\Program Files\ANSYS Inc\v100\AISOL\Samples\Simulation\Actuator-Demo.agdb  
Unix platform:  
.../ansys_inc/v100/aisol/Samples/Simulation/ActuatorDemo.agdb  
*Note* — It is recommended that you save the DesignModeler database file (agdb) using **File> Save As**, to save the file under another name and in another location. |
| 2. Promote the line body to a winding body. | · In the **Modeling** tab, expand the **Parts/Bodies** folder and click on **Line Body**.  
· Under **Details of Line Body**, set the following:  
  - **Winding Body?** = Yes.  
  - **Number of Turns** = 100 (the number of winding turns in the coil).  
  - **CS Length** = 96.6 mm (length of coil).  
  - **CS Width** = 18 mm (width of coil).  
· **View> Show Cross Section Solids** (ensure that it is checked) to view the coil geometry. |
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>3. Define enclosure with two symmetry planes.</td>
<td></td>
</tr>
</tbody>
</table>
- **Tools > Enclosure.**
- Under **Details of Enclosure1**, set the following:
  - **Shape** = Box
  - **Number of Planes** = 2 (for 2 symmetry planes).
  - **Symmetry Plane1**: click on field, click **ZXPlane** in the **Modeling** tab, then [Apply].

- **Symmetry Plane2**: click on field, click **YZPlane** in the **Modeling** tab, then [Apply].

- **Merge Parts?** = Yes.

- [Generate].
### Task | Action
--- | ---
4. Move geometry into Simulation. | - Click on the [Project] tab to leave DesignModeler and go to the Workbench Project Page.  
- Click on **New Simulation**.  
  
  - To match the layout in the picture above, click on the **Rotate** button in the toolbar.  

5. Define material properties. | - In **Outline**, expand the **Model** folder, then expand the **Geometry** folder down to the **Part** level, and click on **armature**.  
- Under **Details of “armature”**, accept the default of **Material = Structural Steel**.
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
</table>
| 6. Define coil current. | • In Outline, under the Environment folder, click on Conductor Winding Body.  
• Under Details of “Conductor Winding Body”, set Conductor Current = 10 A. |
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>7. Apply flux parallel boundary condition.</td>
<td></td>
</tr>
</tbody>
</table>
· In Outline, click on the Environment folder.
· From Electromagnetic toolbar drop-down menu, click on Magnetic Flux Parallel.
· Under Details of “Magnetic Flux Parallel”, set the following:
  – Scoping Method = Named Selection.
  – Named Selection = Open Domain.

· Right mouse click on Magnetic Flux Parallel in the Outline, then click on Duplicate.
· Repeat the procedure above for Under Details of “Magnetic Flux Parallel”, but set Named Selection = Symmetry:YZPlane.

· Right mouse click on Magnetic Flux Parallel 2 in the Outline, then click on Duplicate.
· Repeat the procedure above for Under Details of “Magnetic Flux Parallel”, but set Named Selection = Symmetry:ZXPlane.
8. Add a picture of the boundary conditions for publishing in the report.

- In **Outline**, click on the **Environment** folder.

- From the Standard toolbar, click on the **Figure** button to add this picture.
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
</table>
| 9. Select solution results. | • In **Outline**, click on the **Solution** folder.  
• From **Electromagnetic** toolbar drop-down menu, click on **Total Flux Density**.  
• Repeat above for **Total Field Intensity**, **Inductance**, **Flux Linkage**, and **Directional Force/Torque**.  
• Under Details of “**Directional Force/Torque**”, set **Orientation** = **Y Axis**.  
• From the Graphics Toolbar, click the **Body** selection button.  
• Click on armature body in the **Geometry** window as shown below.  
• In the Details View, click in the **Geometry** field, then click **Apply**. |
<p>| 10. Obtain solution | <strong>[Solve]</strong>. |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>11. Review results and add result pictures for publishing in the report.</td>
<td></td>
</tr>
</tbody>
</table>
• In **Outline**, click on **Total Field Intensity**. Note the field in the air gap region.

![Total Field Intensity](image)

- From the Standard toolbar, click on the **Figure** button to add this picture.
- In **Outline**, expand the **Model** folder, the **Geometry** folder and the **Part** folder, then right mouse click on **Solid** and chose **Hide Body** to hide the enclosure body.

• In **Outline**, click on **Total Flux Density**.

![Total Flux Density](image)

- From the Standard toolbar, click on the **Figure** button to add this picture.
- In **Outline**, click on **Directional Force/Torque**, then note the **Sum** value under **Details of “Directional Force/Torque”**, and the result plot. The **Sum** value equals 1/4 the total force on the armature because a quarter symmetry model was used.
From the Standard toolbar, click on the **Figure** button to add this picture.

In **Outline**, click on **Inductance**.

Under **Details of “Inductance”**, then under **Symmetry**, set **Multiplier** = 4 and note the result in the **Worksheet** tab.

- In **Outline**, click on **Flux Linkage**.
- Under **Details of “Flux Linkage”**, then under **Symmetry**, set **Multiplier** = 4 and note the result in the **Worksheet** tab.
### 2-D Simulations

Simulation has a provision that allows you to run structural and thermal problems that are strictly two-dimensional (2-D). For models and environments that involve negligible effects from a third dimension, running a 2-D simulation can save processing time and conserve machine resources.

You can configure Workbench for a 2-D simulation by first creating or opening a surface model in DesignModeler, or in any supported CAD system that has provisions for surface bodies (Autodesk Mechanical Desktop and Autodesk Inventor do not support surface bodies). The model must be in the x-y plane. 2-D planar bodies are supported, 2-D wire bodies are not. Then, on the Project Page, choose 2-D in the Analysis Type drop-down menu located under Advanced Geometry Defaults, and attach the model into Simulation. You can specify a 2-D simulation only when you attach the model. After attaching, you cannot change from a 2-D simulation to a 3-D simulation or vice versa.

A 2-D simulation has the following characteristics:

- For Geometry items in the tree, you have the following choices located in the 2D Behavior field within the Details View:
  - **Plane Stress** (default): Assumes zero stress and non-zero strain in the z direction. Use this option for structures where the z dimension is smaller than the x and y dimensions. Example uses are flat plates subjected to in-plane loading, or thin disks under pressure or centrifugal loading. A **Thickness** field is also available if you want to enter the thickness of the model.
  - **Axisymmetric**: Assumes that a 3-D model and its loading can be generated by revolving a 2-D section 360° about the y-axis. The axis of symmetry must coincide with the global y-axis. The geometry has to lie on the positive x-axis of the x-y plane. The y direction is axial, the x direction is radial, and the z direction is in the circumferential (hoop) direction. The hoop displacement is zero. Hoop strains and stresses are usually very significant. Example uses are pressure vessels, straight pipes, and shafts. **Axisymmetric** behavior cannot be used in a shape simulation.
— **Plane Strain**: Assumes zero strain in the z direction. Use this option for structures where the z dimension is much larger than the x and y dimensions. The stress in the z direction is non-zero. Example uses are long, constant, cross-sectional structures such as structural beams. **Plane Strain** behavior cannot be used in a thermal simulation or a shape simulation.

*Note* — Since thickness is infinite in plane strain calculations, different results (displacements/stresses) will be calculated for extensive loads (that is, forces/heats) if the solution is performed in different unit systems (MKS vs. NMM). Intensive loads (pressure, heat flux) will not give different results. In either case, equilibrium is maintained and thus reactions will not change. This is an expected consequence of applying extensive loads in a plane strain analysis. In such a condition, if you change the Simulation unit system after a solve, you should clean the result and solve again.

— **Generalized Plane Strain**: Assumes a finite deformation domain length in the z direction, as opposed to the infinite value assumed for the standard **Plane Strain** option. **Generalized Plane Strain** provides more practical results for deformation problems where a z direction dimension exists, but is not considerable. See Section : Using Generalized Plane Strain for more information.

→ **Fiber Length**: Sets the length of the extrusion when using the **Generalized Plane Strain** option. This choice is displayed only if **2D Behavior** is set to **Generalized Plane Strain**.

→ **End Plane Rotation About X**: Sets the rotation of the extrusion end plane about the x-axis when using the **Generalized Plane Strain** option. This choice is displayed only if **2D Behavior** is set to **Generalized Plane Strain**.

→ **End Plane Rotation About Y**: Sets the rotation of the extrusion end plane about the y-axis when using the **Generalized Plane Strain** option. This choice is displayed only if **2D Behavior** is set to **Generalized Plane Strain**.

— **By Body**: Allows you to set the **Plane Stress** (with **Thickness** option), **Plane Strain**, or **Axisymmetric** options for individual bodies that appear under **Geometry** in the tree. If you choose **By Body**, then click on an individual body, these 2-D options are displayed for the individual body.

- For a 2-D simulation, use the same procedure for applying loads and supports as you would use in a 3-D simulation. The loads and results are in the x-y plane and there is no z component.
- You can apply all loads and supports in a 2-D simulation except for the following: Bolt Load, Simply Supported, Fixed Rotation, and all electromagnetic loads.
- A Pressure load can only be applied to an edge.
- A Bearing Load and a Cylindrical Support can only be applied to a circular edge.
- For simulations involving plane stress and plane strain behavior, a Rotational Velocity load can be applied about an individual x, y, or z-axis. Combinations of x and y components can be applied, but combinations of x and z components, and combinations of y and z components cannot be applied.
- For simulations involving axisymmetric behavior, a Rotational Velocity load can only be applied about the y-axis.
- For loads applied to a circular edge, the direction flipping in the z axis will be ignored.

**Using Generalized Plane Strain**

The generalized plane strain feature can be used in structural, modal, and buckling simulations. Shape optimizations are not supported. The feature assumes a finite deformation domain length in the z direction, as opposed
to the infinite value assumed for standard plane strain. It provides a more efficient way to simulate certain 3-D deformations using 2-D options.

The deformation domain or structure is formed by extruding a plane area along a curve with a constant curvature, as shown below.

The extruding begins at the starting (or reference) plane and stops at the ending plane. The curve direction along the extrusion path is called the fiber direction. The starting and ending planes must be perpendicular to this fiber direction at the beginning and ending intersections. If the boundary conditions and loads in the fiber direction do not change over the course of the curve, and if the starting plane and ending plane remain perpendicular to the fiber direction during deformation, then the amount of deformation of all cross sections will be identical throughout the curve, and will not vary at any curve position in the fiber direction. Therefore, any deformation can be represented by the deformation on the starting plane, and the 3-D deformation can be simulated by solving the deformation problem on the starting plane. The Plane Strain and Axisymmetric options are particular cases of the Generalized Plane Strain option.

All inputs and outputs are in the global Cartesian coordinate system. The starting plane must be the x-y plane, and must be meshed. The applied nodal force on the starting plane is the total force along the fiber length. The geometry in the fiber direction is specified by the rotation about the x-axis and y-axis of the ending plane, and the fiber length passing through a user-specified point on the starting plane called the starting or reference point. The starting point creates an ending point on the ending plane through the extrusion process. The boundary conditions and loads in the fiber direction are specified by applying displacements or forces at the ending point.

The fiber length change is positive when the fiber length increases. The sign of the rotation angle or angle change is determined by how the fiber length changes when the coordinates of the ending point change. If the fiber length decreases when the x coordinate of the ending point increases, the rotation angle about y is positive. If the fiber length increases when the y coordinate of the ending point increases, the rotation angle about x is positive.

For buckling and modal simulations, the Generalized Plane Strain option usually reports fewer Eigenvalues and Eigenvectors than you would obtain in a 3-D analysis. Because it reports only homogenous deformation in the fiber direction, generalized plane strain employs only three DOFs to account for these deformations. The same 3-D analysis would incorporate many more DOFs in the fiber direction.

Because the mass matrix terms relating to DOFs in the fiber direction are approximated for modal and transient analyses, you cannot use the lumped mass matrix for these types of simulations, and the solution may be slightly different from regular 3-D simulations when any of the three designated DOFs is not restrained.

Overall steps to using Generalized Plane Strain

1. Attach a 2-D model in Simulation.
2. Click on **Geometry** in the tree.

3. In the Details View, set **2D Behavior** to **Generalized Plane Strain**.

4. Define extrusion geometry by providing input values for **Fiber Length**, **End Plane Rotation About X**, and **End Plane Rotation About Y**.

5. Add a **Generalized Plane Strain** load under **Environment** in the tree.

   *Note — The **Generalized Plane Strain** load is applied to all bodies. There can be only one **Generalized Plane Strain** load per **Environment** so this load will not be available in any of the load drop-down menu lists if it has already been applied.*

6. In the Details View, input the x and y coordinates of the reference point, and set the boundary conditions along the fiber direction and rotation about the x and y-axis.

7. Add any other loads or boundary conditions that are applicable to a 2-D model.

8. Solve. Reactions are reported in the Details View of the **Generalized Plane Strain** load.

9. Review results.

### Coupled Environments

Many times the analysis of a phenomenon involves more than one type of solution. Typical examples of these so called **coupled environments** include thermal-stress, pre-stress modal, and fluid-structure interactions. Simulation will implicitly determine a coupled environment depending on how the environment is defined.

Presented below is a list of the available coupled analysis types and how Simulation determines a given type. The **Analysis Type** is reported as a read-only indication in the Details View of the **Solution** object.

- **Thermal Stress** - There are two methods for defining a coupled thermal stress solution.
  - Implicit: Here the program determines the solution is coupled thermal-stress by the presence of thermal loads and structural results under the same environment. This method is supported for legacy databases but is not the recommended method.
  - Explicit: Here you insert a **Thermal Condition** load into your structural environment. The thermal condition may either be a uniform or non-uniform temperature. This is the recommended method as it clearly shows the coupled phenomenon.

- **Thermal Shape** - Same conditions as **Thermal Stress** except for the presence of shape tools instead of structural results.

- **Free Vibration With Pre-Stress** (pre-stress modal) - A structural solution is performed followed by a modal solution (where stress stiffening effects are accounted for in the modal analysis), if structural loads exist in the environment of a **Solution** object that includes a **Frequency Finder**.

- **Free Vibration With Thermal Pre-Stress** - Here, three individual solutions are performed in the following order: thermal solution, followed by a structural solution, followed by a modal solution.

- **Fluid-Structure Interaction (FSI)** - This feature enables you to import fluid forces from a steady-state or transient CFD analysis performed using ANSYS CFX, into Simulation. This one way transfer of surface forces at a fluid-structure interface allows you to investigate the effects of fluid flow on a structure's deformation and stresses.
Surface Forces at Fluid-Structure Interface

You can use boundary results from an ANSYS CFX (10.0 or above) simulation as surface forces (pressures) on corresponding faces in Simulation. The import process involves interpolating an ANSYS CFX solution onto the Simulation surface mesh. This requires that the following conditions are met:

- The fluid-structure interface must be a defined boundary in ANSYS CFX.
- The location of the ANSYS CFX boundary (with respect to the global Cartesian coordinate system) must be the same as the corresponding face(s) in the Simulation model.

Note — When mapping ANSYS CFX results onto the Simulation face(s) the Simulation nodes are projected on to the ANSYS CFX surface. All Simulation face nodes will map to the ANSYS CFX surface according to the following rules:

  a. Project normal to the ANSYS CFX mesh faces.
  b. If rule a fails, project to the closest edge.
  c. If rule b. fails, project to the closest node on the ANSYS CFX surface.

Rule c. will always work, so in the end every node will get some kind of mapping. However the most accurate load mapping occurs for nodes projected normal to the mesh face. The percentage of Simulation nodes that mapped successfully using rule a. above is reported in the diagnostics. When the Simulation mesh is very coarse, there can be some misses near the edges of the ANSYS CFX boundary. However all nodes become mapped eventually. The accuracy of force transfer improves as the Simulation mesh is refined.

To provide some feedback on how well the mapped loads match the ANSYS CFX solution, images of both ANSYS CFX solution and the mapped load values are created. In addition a CFX Load Transfer Summary is also created that shows the net force on the surface computed in ANSYS CFX and the net force transferred to the Simulation surfaces.

To import a pressure load from an ANSYS CFX boundary into Simulation:

  Note — To use this feature on Unix platforms, you must have run the cfxwbinst script after the ANSYS CFX installation in order to enable ANSYS CFX in Workbench. This script is provided as part of the ANSYS CFX installation and details of its use can be found in the ANSYS CFX 10.0 Installation Guide.

1. Select the Simulation model's surfaces on which this load transfer is to occur.
2. Insert a Pressure load in the environment of interest.
3. In the Details View, set Define As to CFX Results.
4. Click the CFX Surface field and choose Import... from the menu.
5. **Browse...** to choose a **CFX Result File (.res)**. After you specify the .res file, the ANSYS CFX boundary names (equivalent to Named Selections) are displayed with selection radio buttons, along with the time points at which results are available.

The selected ANSYS CFX surface solution will be mapped onto the Simulation surfaces on which the **Pressure** load is applied. The CFD solution on the selected boundary will be represented as image object(s) under the **Pressure** load in the tree.
6. Proceed with solution in Simulation. You can apply other boundary conditions and loads. During the solution procedure Simulation interacts with CFX-Post to map the ANSYS CFX results onto the Simulation surfaces. In addition to the images that show the ANSYS CFX mapped loads on the Simulation surfaces, a **CFX Load Transfer Summary** is also created as a Comment, which shows the net force on the surface computed in ANSYS CFX and the net force transferred to the Simulation surfaces.

```
<table>
<thead>
<tr>
<th>CFX Load Transfer Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFX Computed Forces from CFX Results File D:\110.0\tests\CFXIDemo_ScriptIRelative_Safe_Copy\TJunction_002.res</td>
</tr>
<tr>
<td>X-component = 68,413 lbf</td>
</tr>
<tr>
<td>Y-component = -14,721 lbf</td>
</tr>
<tr>
<td>Z-component = 1,859.59 lbf</td>
</tr>
</tbody>
</table>

| Simulation Mapped Forces for Simulation Surface File C:\DOCUME~1\cs1\LOCALS~1\Temp\ansysfskl0.cdb |
| X-component = 68,5629 lbf |
| Y-component = 21,992 lbf |
| Z-component = 1,862.24 lbf |

96% of Simulation nodes were mapped to the CFX surface, remaining nodes mapped to closest edge or node.
```

**Note** — The force values shown in the **CFX Load Transfer Summary** should only be used as a qualitative measure of the load transferred from ANSYS CFX to the Simulation mesh. The closer the **CFX Computed forces** are to the **Simulation Mapped Forces**, the better the mapping. The actual force transferred to Simulation is reflected in the reaction forces.

---

## Wizards

Wizards provide a layer of assistance above the standard user interface. They are made up of tasks or steps that help you interpret and work with simulations. Conceptually, the wizards act as an agent between you and the standard user interface.

Wizards include the following features:

- An interactive checklist for accomplishing a specific goal
- A reality check of the current simulation
- A list of a variety of high-level tasks, and guidance in performing the tasks
- Links to useful resources
A series of Callout windows which provide guidance for each step

Note — Callouts close automatically, or you may click inside a Callout to close it.

Wizards use hyperlinks (versus command buttons) because they generally represent links to locations within the standard user interface, to content in the help system, or to a location accessible by a standard HTML hyperlink. The status of each step is taken in context of the currently selected Section : Tree Outline object. Status is continually refreshed based on the Outline state (not on an internal wizard state). As a result you may:

• Freely move about the Section : Tree Outline (including between branches).
• Make arbitrary edits without going through the wizards.
• Show or hide the wizards at any time.

Wizards are docked to the right side of the standard user interface for two reasons:

• The Section : Tree Outline sets the context for status determination. That is, the wizards interpret the Outline rather than control it. (The user interface uses a top-down left-right convention for expressing dependencies.)
• Visual symmetry is maintained.

To close wizards, click the . To show/hide tasks or steps, click the section header. Options for wizards are set in the Wizard section of the Options dialog box under Simulation.

The Section : Simulation Wizard is available for your use in Simulation.

**Simulation Wizard**

The Simulation Wizard appears in the right side panel whenever you click the in the toolbar. You can close the Simulation Wizard at any time by clicking at the top of the panel. To show or hide the sections of steps in the wizard, click the section header.

**Features of the Simulation Wizard**

The Simulation Wizard works like a web page consisting of collapsible groups and tasks. Click a group title to expand or collapse the group; click a task to activate the task.

When activated, a task navigates to a particular location in the user interface and displays a callout with a message about the status of the task and information on how to proceed. Activating a task may change your tab selection, cursor mode, and Section : Tree Outline selection as needed to set the proper context for proceeding with the task.

You may freely click tasks to explore Simulation. Standard tasks WILL NOT change any information in your simulation.

Callouts close automatically based on your actions in the software. Click inside a callout to close it manually.

Most tasks indicate a status via the icon to the left of the task name. Rest your mouse on a task for a description of the status. Each task updates its status and behavior based on the current Section : Tree Outline selection and software status.

Tasks are optional. If you already know how to perform an operation, you don’t need to activate the task.
Click the **Choose Wizard** task at the top of the Simulation Wizard to change the wizard goal. For example, you may change the goal from **Find safety factors** to **Find fatigue life**. Changing the wizard goal does not modify your simulation.

At your discretion, simulations may include any available feature not covered under **Required Steps** for a wizard. The Simulation Wizard does not restrict your use of Simulation.

You may use the Simulation Wizard with databases from previous versions of Simulation.

To enable the Simulation Wizard, click or select **View> Simulation Wizard**.

**Types of Simulation Wizards**

There are wizards that guide you through the following simulations:

- Safety factors, stresses and deformation
- Fatigue life and safety factor
- Contact region type and formulation
- Electromagnetic results
- Heat transfer and temperatures
- Natural frequencies
- Optimizing the shape of a part

**Simulation Wizard Editor**

You can create your own customized Simulation Wizard using the Simulation Wizard Editor, a stand-alone application available on Windows platforms and in the English version of Simulation. An expert in an established company process, such as validating a gear design, could create a customized simulation wizard that could be deployed to multiple users, guiding them through the simulation process and ensuring consistency.

To customize a wizard using the Simulation Wizard Editor:

1. Choose **Tools> Simulation Wizard Editor...** in the Main Menu.
2. Create or modify a wizard following the displayed instructions, then save the wizard XML file.

To use a customized wizard created in the Simulation Wizard Editor:

1. In Simulation, activate the Simulation Wizard by clicking in the Standard Toolbar, or choose **View> Simulation Wizard** in the Main Menu.
2. In the Simulation Wizard, click **Choose Wizard**.
3. Click the bulleted option to browse for a custom wizard definition.
4. Browse to the wizard XML file that you saved from the Simulation Wizard Editor (step 2 in the first procedure above).

In addition to the instructions that appear within the Simulation Wizard Editor, a Simulation Wizard Customization Guide is also available and is accessible from inside the Simulation Wizard Editor.
Welcome to the Simulation Objects Reference. This reference provides a specification for every Simulation object in the tree. Each object is represented in either its own reference page, or is combined with similar objects and represented on one group reference page. For example, the Virtual Cell object is represented on its own Virtual Cell object reference page, whereas the Part Relevance object is represented on the Mesh Control Tools (Group) object reference page. All pages representing groups of objects include "(Group)" as part of the page's title.

A complete alphabetical listing of Simulation objects reference pages is included in a later section. To determine the reference page for an object in a group, consult the group page whose title matches the object, and check the entry: “Applies to the following objects”.

The following is a description of each component of a Simulation object reference page:

- **Title** - For individual object reference pages, the title is the default name of the object as it appears in the tree. For group reference pages, the title is a name given to the collection of objects represented.
- **Object definition** - A brief description of the individual object or group of objects.
- **License level** - The required license level you must have in order to use the object or group of objects.
- **Applies to the following objects** - Appears only on group reference pages and includes the default name of all objects represented on the group reference page.
- **Tree dependencies** - The valid location of the object or group of objects in the tree (Valid Parent Tree Object), as well as other possible objects that you can insert beneath the object or group of objects (Valid Child Tree Objects).
- **Insertion options** - Procedure for inserting the object (individual or one in the group) in the tree. Typically this procedure includes inserting the object from a context toolbar button or through a context menu option when you click the right mouse button with the cursor on the object.
- **Additional related information** - a listing of topics related to the object or object group that are in the help. Included are links to those topics.
- **Tree location graphic** - an indication of where the object or group of objects appears in the Simulation tree.
- **Details View** - a listing of every setting or indication available in the Details View (located directly beneath the object tree) for the object. Included are links to more detailed information on an item within the help.
- **Relevant right mouse button context menu options** - a listing of options directly relevant to the objects that are available in the context menu through a right mouse click on the object. Included are links to more detailed information on an item within the help. The options listed are in addition to the options for inserting child objects from the Insert menu, as well as options that are common to most of the objects (such as Solve, Copy, Cut, and Delete).

The objects reference is not intended to be your primary source of procedural information for performing simulations -- see the Simulation Approach section for introductory and procedural guidelines concerning when and where to use the Simulation objects.

**Page Listings**

The following is an alphabetical listing of object reference pages:

- Alert
- Body
Alert

Sets pass or fail thresholds for individual results. When a threshold is exceeded, the status symbol changes in front of the associated result object. The status is also displayed in the Details View of the Alert object. Alerts facilitate the presentation of comparisons in automatic reports.

License Level: All levels

Tree Dependencies:
• **Valid Parent Tree Objects:** All result objects (not result tools), except Damage Matrix, Fatigue Sensitivity, Flux Linkage, Hysteresis, Phase Response, Probe, Rainflow Matrix, Reactions, Status, Vector Principal Elastic Strain, Vector Principal Stress.

• **Valid Child Tree Objects:** Comment

**Insertion Options:** Use any of the following methods after highlighting a result object:

• Insert> Alert
• Click right mouse button on a result object or in the Geometry window> Insert> Alert.

**Additional Related Information:**

• Working with Buckling Results
• Deformation
• Frequencies (Frequency Finder)

---

**Details View:**

<table>
<thead>
<tr>
<th>Definition</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Definition:</strong></td>
<td></td>
</tr>
<tr>
<td>Fails If - Set failure threshold as <strong>Minimum Below Value</strong> or <strong>Maximum Above Value</strong>, where you set the value in the next field.</td>
<td></td>
</tr>
<tr>
<td><strong>Value</strong> - Threshold value in the units of the associated result.</td>
<td></td>
</tr>
<tr>
<td><strong>Results:</strong></td>
<td></td>
</tr>
<tr>
<td>Status - Read-only indication of the pass/fail status; also includes criterion (for example: “Passed: Minimum Above Value”).</td>
<td></td>
</tr>
</tbody>
</table>

**Body**

Defines a component of the attached geometry included under a **Geometry** object (for example, **Body 1** in the figure below), or under a **Part** object if under a multi body part (for example, **Body 2** in the figure below).

**License Level:** All levels

**Tree Dependencies:**
• **Valid Parent Tree Object:** Geometry or Part (if under a multi body part)

• **Valid Child Tree Objects:** Commands, Comment, Figure

**Insertion Options:**
Appears by default when geometry is attached.

**Additional Related Information:**
• Attaching Geometry
### Relevant Right Mouse Button Context Menu Options:

<table>
<thead>
<tr>
<th>Details View:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Graphics Properties:</strong></td>
<td><strong>Create Selection Group</strong></td>
</tr>
<tr>
<td>Visible - Turns part display On or Off in the Geometry window.</td>
<td></td>
</tr>
<tr>
<td>Transparency - Varies the body between being completely transparent (0) to completely opaque (1).</td>
<td></td>
</tr>
<tr>
<td>Color - Sets the color of the body.</td>
<td></td>
</tr>
<tr>
<td><strong>Definition:</strong></td>
<td></td>
</tr>
<tr>
<td>Suppressed</td>
<td></td>
</tr>
<tr>
<td>Brick Integration Scheme</td>
<td></td>
</tr>
<tr>
<td>Material</td>
<td></td>
</tr>
<tr>
<td>Nonlinear Material Effects</td>
<td></td>
</tr>
<tr>
<td><strong>Bounding Box:</strong></td>
<td></td>
</tr>
<tr>
<td>Length X</td>
<td></td>
</tr>
<tr>
<td>Length Y</td>
<td></td>
</tr>
<tr>
<td>Length Z</td>
<td></td>
</tr>
<tr>
<td><strong>Mass Properties</strong> - Read-only indication of the mass properties originally assigned to the body. Each property can be designated as a parameter.</td>
<td></td>
</tr>
<tr>
<td>Volume</td>
<td></td>
</tr>
<tr>
<td>Mass</td>
<td></td>
</tr>
</tbody>
</table>

**Note** — If density is temperature dependent, then the density value at 22°C (default reference temperature for an environment) will be used to compute the **Mass**.

**Statistics** - Read-only indication of the entities that comprise the body.

**Nodes**

**Elements**

### Commands

Allows use of ANSYS commands or APDL programming in a simulation.

**License Level:** ANSYS Professional and above

**Tree Dependencies:**
Valid Parent Tree Objects: Body, Contact Region (shown in figure), Environment, Solution
Valid Child Tree Objects: Comment

**Insertion Options:**

- Use any of the following methods after highlighting **Body** object:
  - **Insert> Geometry Item> Commands**
  - Click right mouse button on **Body** object or in the **Geometry** window> **Insert> Commands**.

- Use any of the following methods after highlighting **Contact Region** object:
  - **Insert> Model Item> Commands**
  - Click right mouse button on **Contact Region** object or in the **Geometry** window> **Insert> Commands**.

- Use any of the following methods after highlighting **Environment** object:
  - **Insert> Environment Item> Commands**
  - Click right mouse button on **Environment** object or in the **Geometry** window> **Insert> Commands**.

- Use any of the following methods after highlighting **Solution** object:
  - **Insert> Solution Item> Commands**
  - Click right mouse button on **Solution** object or in the **Geometry** window> **Insert> Commands**.

**Additional Related Information:**

- Commands Objects
### Details View:

<table>
<thead>
<tr>
<th>File:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File Name</strong> - Read-only indication of imported text file name (including path) if used.</td>
<td>Export...</td>
</tr>
<tr>
<td><strong>File Status</strong> - Read-only indication of the status of an imported text file if used.</td>
<td>Import...</td>
</tr>
<tr>
<td><strong>Definition</strong></td>
<td>Refresh</td>
</tr>
<tr>
<td><strong>Suppressed</strong></td>
<td>Suppress</td>
</tr>
<tr>
<td><strong>Output Search Prefix</strong></td>
<td>Search Parameters - appears only if <strong>Command</strong> object is under a <strong>Solution</strong> object.</td>
</tr>
<tr>
<td><strong>Sequence Selection Mode</strong></td>
<td>Rename Based on Definition</td>
</tr>
<tr>
<td><strong>Sequence Number</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Input Arguments:**
ARG1 through ARG9

**Results:** - applicable only when inserting under a **Solution** object.

---

### Comment

Inserts a comment for a Simulation parent object. The comment editor creates a fragment of HTML, and the object itself consists of that HTML fragment, a string denoting the author's name, and a color. Report adds the resulting HTML fragment directly in line, in the specified color and notes the author. The **Comment** context toolbar provides buttons to insert various HTML tags as well as buttons for inserting pictures and hyperlinks.

*Note* — For UNIX versions of Simulation, you must first click the **Pencil** button before you can edit the comment. To close the editor, click the **Pencil** button again.

**License Level:** All levels

**Tree Dependencies:**
Valid Parent Tree Objects: All objects except those that serve only as containers.

Valid Child Tree Objects: None.

**Insertion Options:** Use any of the following methods after highlighting the parent object:

- Click **Comment** button on standard toolbar.
- **Insert > Comment**
- Click right mouse button on parent object or in the **Geometry** window > **Insert > Comment**.

**Additional Related Information:**

- **Comment** Context Toolbar
- Reporting

<table>
<thead>
<tr>
<th>Details View:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author:</td>
<td>Name</td>
</tr>
</tbody>
</table>

**Contact**

Defines conditions when two or more parts meet. Includes global settings in Details View that apply to all **Contact Region** child objects.

**License Level:** ANSYS DesignSpace and above

**Tree Dependencies:**
Valid Parent Tree Object: Model

Valid Child Tree Objects: Comment, Contact Region, Figure, Spot Weld

Insertion Options:

- Automatically inserted in the tree if contact is detected when model is attached.
- For setting manual contact conditions, use any of the following methods after highlighting Model object:
  - Click Contact button on Model context toolbar.
  - Insert> Model Item> Contact
  - Click right mouse button on Model object or in the Geometry window> Insert> Contact.

Note — These options are not available if a Contact object already exists in the tree.

Additional Related Information:

- Contact Overview
- Contact Region Settings
- Supported Contact Types and Formulations
- Contact Ease of Use Features
- Contact Tool and Results
- Contact Options Preferences

<table>
<thead>
<tr>
<th>Details View:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Detection: Generate Contact on Update</td>
<td>Create Automatic Contact</td>
</tr>
<tr>
<td>Tolerance Type</td>
<td>Enable/Disable Transparency</td>
</tr>
<tr>
<td>Tolerance Slider</td>
<td>Rename Based on Geometry</td>
</tr>
<tr>
<td>Tolerance Value</td>
<td></td>
</tr>
<tr>
<td>Face/Face</td>
<td></td>
</tr>
<tr>
<td>Face/Edge</td>
<td></td>
</tr>
<tr>
<td>Edge/Edge</td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>Same Body Grouping</td>
<td></td>
</tr>
<tr>
<td>Transparency: Enabled</td>
<td></td>
</tr>
</tbody>
</table>

Contact Region

Defines conditions for individual contact and target pairs. Several Contact Regions can appear as child objects under a Contact object.

License Level: ANSYS DesignSpace and above

Tree Dependencies:
· Valid Parent Tree Object: Contact
· Valid Child Tree Objects: Commands, Comment, Figure

**Insertion Options:** Use any of the following methods after highlighting Contact object:

- Click **Contact** button on Contact context toolbar.
- **Insert > Model Item > Manual Contact Region**
- Click right mouse button on **Contact** object or in the **Geometry window > Insert > Manual Contact Region**.

**Additional Related Information:**

- **Contact** Context Toolbar
- Contact Overview
- Global Contact Settings
- Supported Contact Types and Formulations
- Setting Contact Conditions Manually
- Contact Ease of Use Features
- Contact Tool and Results
- Contact Options Preferences

---

**Details View:**

<table>
<thead>
<tr>
<th><strong>Scope:</strong></th>
<th><strong>Relevant Right Mouse Button Context Menu Options:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope:</td>
<td>Enable/Disable Transparency</td>
</tr>
<tr>
<td>Scoping Method</td>
<td>Hide All Other Bodies</td>
</tr>
<tr>
<td>Contact</td>
<td>Flip Contact/Target</td>
</tr>
<tr>
<td>Target</td>
<td>Merge Selected Contact Regions - appears if contact regions share the same geometry type.</td>
</tr>
<tr>
<td>Contact Bodies</td>
<td>Save Contact Region Settings</td>
</tr>
<tr>
<td>Target Bodies</td>
<td>Load Contact Region Settings</td>
</tr>
<tr>
<td>Definition:</td>
<td>Reset to Default</td>
</tr>
<tr>
<td>Type</td>
<td>Rename Based on Geometry</td>
</tr>
<tr>
<td>Friction Coefficient</td>
<td></td>
</tr>
<tr>
<td>Scope Mode</td>
<td></td>
</tr>
<tr>
<td>Behavior</td>
<td></td>
</tr>
<tr>
<td>Suppressed</td>
<td></td>
</tr>
</tbody>
</table>

**Advanced:**

- Formulation
- Interface Treatment
- Specify Offset
- Normal Stiffness
- Normal Stiffness Factor
- Update Stiffness
- Thermal Conductance
- Thermal Conductance Value
- Pinball Region
- Pinball Radius
- Search Direction

---
Convergence

Controls the relative accuracy of a solution by refining solution results on a particular area of a model.

**License Level:** All levels

**Tree Dependencies:**

- **Valid Parent Tree Objects:** All result objects (not result tools), except Damage Matrix, Frictional Stress, Flux Linkage, Hysteresis, Phase Response, Probe, Rainflow Matrix, Reactions, Status, Structural Error, Thermal Error, Vector Principal Elastic Strain, Vector Principal Stress.

- **Valid child tree objects:** Comment

**Insertion Options:** Use any of the following methods after highlighting a result object:

- Insert> Convergence
- Click right mouse button on a result object or in the Geometry window> Insert> Alert.

*Note* — Only one Convergence object is valid per result object.

**Additional Related Information:**

- Convergence
- Error (Structural)
- Error (Thermal)
- Simulation Options - Convergence

<table>
<thead>
<tr>
<th><strong>Details View:</strong></th>
<th><strong>Relevant Right Mouse Button Context Menu Options:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Definition:</strong></td>
<td><strong>Type</strong></td>
</tr>
</tbody>
</table>
| **Allowable Change** | **Results:**
|                  | **Last Change** - Read-only indication of the most recent change in convergence.  
|                  | **Converged** - Read-only indication of the convergence state (Yes or No). |

**Coordinate System**

Represents a local coordinate system that you can add under a Coordinate Systems object.

**License Level:** All levels

**Tree Dependencies:**
Valid Parent Tree Object: Coordinate Systems
Valid Child Tree Objects: Comment, Figure

Insertion Options: Use any of the following methods after highlighting Coordinate Systems object, or Global Coordinate System object, or another Coordinate System object:

- Choose Coordinate System on Coordinate Systems context toolbar.
- Insert > Model Item > Coordinate System
- Click right mouse button on Coordinate Systems object, or Global Coordinate System object, or another Coordinate System object, or in the Geometry window > Insert > Coordinate System.

Additional Related Information:

- Coordinate Systems
- Creating Coordinate Systems

Details View:

<table>
<thead>
<tr>
<th>Definition:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope Mode</td>
<td>- Read-only indication.</td>
</tr>
<tr>
<td>Type</td>
<td></td>
</tr>
<tr>
<td>Origin</td>
<td></td>
</tr>
<tr>
<td>X Direction</td>
<td></td>
</tr>
<tr>
<td>Y Direction</td>
<td></td>
</tr>
<tr>
<td>Z Direction</td>
<td></td>
</tr>
<tr>
<td>Origin Data:</td>
<td></td>
</tr>
<tr>
<td>Origin X</td>
<td></td>
</tr>
<tr>
<td>Origin Y</td>
<td></td>
</tr>
<tr>
<td>Origin Z</td>
<td></td>
</tr>
<tr>
<td>X Axis Data:</td>
<td>- Read-only indications.</td>
</tr>
<tr>
<td>Component X</td>
<td></td>
</tr>
<tr>
<td>Component Y</td>
<td></td>
</tr>
<tr>
<td>Component Z</td>
<td></td>
</tr>
<tr>
<td>Y Axis Data:</td>
<td>- Read-only indications.</td>
</tr>
<tr>
<td>Component X</td>
<td></td>
</tr>
<tr>
<td>Component Y</td>
<td></td>
</tr>
<tr>
<td>Component Z</td>
<td></td>
</tr>
<tr>
<td>Z Axis Data:</td>
<td>- Read-only indications.</td>
</tr>
<tr>
<td>Component X</td>
<td></td>
</tr>
<tr>
<td>Component Y</td>
<td></td>
</tr>
<tr>
<td>Component Z</td>
<td></td>
</tr>
<tr>
<td>Advanced:</td>
<td></td>
</tr>
<tr>
<td>Ansys System Number</td>
<td></td>
</tr>
</tbody>
</table>
Coordinate Systems

Houses any new coordinate systems that can include a **Global Coordinate System** object and local **Coordinate System** objects.

**License Level:** All levels

**Tree Dependencies:**

- Valid Parent Tree Object: Model
- Valid Child Tree Objects: Comment, Coordinate System, Figure, Global Coordinate System

**Insertion Options:** Use any of the following methods after highlighting Model object:

- Choose **Coordinate Systems** on Model context toolbar.
- **Insert > Model Item > Coordinate Systems**
- Click right mouse button on Model object or in the Geometry window > **Insert > Coordinate Systems**.

**Note** — Only one **Coordinate Systems** object is valid per **Model**.

**Additional Related Information:**

- Coordinate Systems
- Creating Coordinate Systems

Environment

Represents the combination of all load and support objects for a given **Model** object.

**License Level:** All levels

**Tree Dependencies:**
Valid Parent Tree Object: Model

Valid Child Tree Objects: Comment, Figure, Initial Condition (available only when Transient is set in the Environment context toolbar), all load and support objects, Thermal Condition (available only when Static is set in the Environment context toolbar)

Insertion Options:

- Appears by default for a new Simulation or for attached geometry.
- Click New Model button on Project context toolbar.
- Click right mouse button on Model object or in the Geometry window> Insert> Environment.

Additional Related Information:

- Environment Context Toolbar
- Types of Loads
- Types of Supports

<table>
<thead>
<tr>
<th>Details View:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The following applies only for the Static and Harmonic settings in the Environment context toolbar.</td>
<td></td>
</tr>
<tr>
<td>Definition: Reference Temp Inertia Relief</td>
<td></td>
</tr>
</tbody>
</table>

Figure

Captures any graphic displayed for a particular object in the Geometry window. Popular uses are for presenting specific views and settings for later inclusion in a report.

License Level: All levels

Tree Dependencies:
• **Valid Parent Tree Object:** All objects except Alert, Commands, Comment, Convergence, Parameter Manager, Project, Result Tracker, Solution Combination, Solution Information, and Variable Graph

• **Valid Child Tree Objects:** None

**Insertion Options:** Use any of the following methods after highlighting the parent object:

• Click **Figure** button on standard toolbar.
• **Insert**> **Figure**
• Click right mouse button on parent object or in the **Geometry** window> **Insert**> **Figure**.

**Additional Related Information:**

- Figures
- Viewports
- Reports
- Usage Example
- Standard Toolbar

<table>
<thead>
<tr>
<th>Details View:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Caption:</strong></td>
<td><strong>Text</strong></td>
</tr>
</tbody>
</table>

**Geometry**

Represents attached geometry in the form of an assembly or multi body part from a CAD system or from DesignModeler. The geometry can be updated using the **Geometry** context toolbar. Assembly parameters, if available, are viewable under the **Geometry** object.

**License Level:** All levels

**Tree Dependencies:**
• Valid Parent Tree Object: Model
• Valid Child Tree Objects: Comment, Figure, Part, Point Mass

**Insertion Options:**
• Appears by default for a new Simulation or for attached geometry.
• Appears with a new Model object if you click New Model button on Project context toolbar.

**Additional Related Information:**
• Attaching Geometry
• Model Context Toolbar
• Geometry Context Toolbar
<table>
<thead>
<tr>
<th>Details View:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
</table>


**Definition:**

**Source** - Read-only indication of the path and file name associated with the geometry.

**Type** - Read-only indication of how the original geometry was created (CAD product name or DesignModeler).

**Length Unit** - Read-only indication of the length unit originally assigned to the geometry.

**Element Control** - Allows manual control of the underlying ANSYS element options (KEYOPTS) for individual **Part** or **Body** objects beneath the **Geometry** object. To manually set ANSYS element options, set **Element Control** to **Manual**, then select the **Part** or **Body** object. Any element options that are available for you to manually set appear in the Details View of the **Part** or **Body** object. For example, the **Brick Integration Scheme** setting for a **Part** or **Body** object becomes available only when **Element Control** is set to **Manual**. When **Element Control** is set to **Program Controlled**, all element options are automatically controlled and no settings are displayed. The ANSYS equivalent to this setting is the inclusion of the **ETCON,SET** command in the input file, which automatically resets options for the 18x series of elements to optimal settings. Refer to the **ANSYS Elements Reference** in the ANSYS Help for more information on ANSYS elements and element options.

**2D Behavior** - appears only for a designated 2-D simulation.

**Bounding Box:**

- **Length X**
- **Length Y**
- **Length Z**

**Mass Properties** - Read-only indication of the mass properties originally assigned to the geometry. Each property can be designated as a parameter. Any suppressed **Part** or **Body** child objects are not included in the mass property values that are displayed.

- **Volume**
- **Mass**

**Note** — If density is temperature dependent, then the density value at 22°C (default reference temperature for an environment) will be used to compute the **Mass**.

**Statistics:** - Read-only indication of the entities that comprise the geometry. **Active Bodies** are those that are unsuppressed compared to the total number of **Bodies**.

**Bodies**

- **Active Bodies**
- **Nodes**
- **Elements**

**Preferences:**

- **Import Solid Bodies**
- **Import Surface Bodies**
Global Coordinate System

Represents a new coordinate system that results from inserting a **Coordinate Systems** object. The origin is defined as 0,0,0 in the model coordinate system. This location serves as the reference location for any local **Coordinate System** objects inserted under the **Global Coordinate System** object.

**License Level:** All levels

**Tree Dependencies:**

- Valid Parent Tree Object: **Coordinate Systems**
- Valid Child Tree Objects: **Comment, Figure**

**Insertion Options:**

Automatically inserted in the tree when you insert a **Coordinate Systems** object.

**Additional Related Information:**

- Coordinate Systems
- Creating Coordinate Systems
Initial Condition

For transient simulations, sets the initial temperature to a uniform temperature that you can input, or to a non-uniform temperature that you can set to refer to thermal results from another environment.

License Level: All levels

Tree Dependencies:

- Valid Parent Tree Object: Environment (available only for Transient setting in the Environment context toolbar)
- Valid Child Tree Objects: Comment, Figure

Insertion Options:

Automatically inserted in the tree if Transient is set in the Environment context toolbar.

Additional Related Information:

- Thermal Transient Simulations
- Environment Context Toolbar
Details View:

Definition:
- Initial Temperature
- Initial Temperature Value - appears if Initial Temperature is set to Uniform Temperature.
- Initial Conditions Environment - appears if Initial Temperature is set to Non-Uniform Temperature.

Relevant Right Mouse Button Context Menu Options:

---

Loads and Supports (Group)

Defines the individual components that make up an environment for a model.

License Level: ANSYS DesignSpace and above


Tree Dependencies:
• **Valid Parent Tree Object:**
  - For **Current** or **Voltage**: Conductor
  - For all other objects: Environment

• **Valid Child Tree Objects:**
  - For **Conductor**: Comment, Current, Figure, Voltage
  - For all other objects: Comment, Figure

**Insertion Options:**

• For **Current** or **Voltage**, scope to a body, then use any of the following methods after highlighting Conductor object:
  - Choose Electromagnetic > Voltage or Current on Environment context toolbar.
  - Insert > Environment Item > Electromagnetic Load > Voltage or Current
  - Click right mouse button on Environment object, or in the Geometry window > Insert > Voltage or Current

• For all other objects, use any of the following methods after highlighting Environment object:
  - Choose Structural, or Thermal, or Electromagnetic > {Load or support name} on Environment context toolbar.
  - Insert > Environment Item > Global Load, or Structural Load, or Displacement, or Thermal Load, or Electromagnetic Load > {Load or support name}
  - Click right mouse button on Environment object, any load or support object, or in the Geometry window > Insert > {Load or support name}

*Note* — A Thermal Condition load can only be applied for the Static setting in the Environment context toolbar.

**Additional Related Information:**

• Applying Loads
• Types of Loads
• Types of Supports
• How to Apply Loads/Supports
• Applying Loads Demonstration
### Relevant Right Mouse Button Context Menu Options:

<table>
<thead>
<tr>
<th>Details View:</th>
<th>Mesh</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scope:</strong></td>
<td>Manages all meshing functions and tools for a model; includes global</td>
</tr>
<tr>
<td>Scoping Method - specify either Geometry Selection or Named Selection.</td>
<td>controls that govern the entire mesh.</td>
</tr>
<tr>
<td>Not applicable to global loads, Generalized Plane Strain, or Thermal</td>
<td><strong>License Level:</strong> All levels</td>
</tr>
<tr>
<td>Condition.</td>
<td><strong>Tree Dependencies:</strong></td>
</tr>
<tr>
<td>Geometry - Read-only indication for global loads and for Generalized</td>
<td></td>
</tr>
<tr>
<td>Plane Strain. For all other objects except Thermal Condition, appears if</td>
<td></td>
</tr>
<tr>
<td>Scoping Method is set to Geometry Selection. In this case, use selection</td>
<td></td>
</tr>
<tr>
<td>filters to pick geometry, click in the Geometry field, then click Apply.</td>
<td></td>
</tr>
<tr>
<td>Named Selection - appears if Scoping Method is set to Named Selection.</td>
<td></td>
</tr>
<tr>
<td><strong>Definition:</strong></td>
<td></td>
</tr>
<tr>
<td>Define By - specify either Vector or Components (the choices are different</td>
<td></td>
</tr>
<tr>
<td>for Bolt). Applicable to Acceleration, Rotational Velocity, and all</td>
<td></td>
</tr>
<tr>
<td>structural load objects except Generalized Plane Strain, Pressure, and</td>
<td></td>
</tr>
<tr>
<td>Thermal Condition.</td>
<td></td>
</tr>
<tr>
<td>Type - Read-only indication of load or support type. Not applicable to</td>
<td></td>
</tr>
<tr>
<td>global loads, Conductor, Current, Generalized Plane Strain, Thermal</td>
<td></td>
</tr>
<tr>
<td>Condition, or Voltage.</td>
<td></td>
</tr>
<tr>
<td>Magnitude - appears if Define By is set to Vector, or as a field to enter</td>
<td></td>
</tr>
<tr>
<td>magnitude of load. Not applicable to Standard Earth Gravity, Generalized</td>
<td></td>
</tr>
<tr>
<td>Plane Strain, Thermal Condition, all support objects, Convection, Radiation,</td>
<td></td>
</tr>
<tr>
<td>and all electromagnetic load objects.</td>
<td></td>
</tr>
<tr>
<td>Direction - appears if Define By is set to Vector, or read-only indication</td>
<td></td>
</tr>
<tr>
<td>for global loads except for Standard Earth Gravity.</td>
<td></td>
</tr>
<tr>
<td>X, Y, Z Component - appears if Define By is set to Components (one field per</td>
<td></td>
</tr>
<tr>
<td>direction).</td>
<td></td>
</tr>
<tr>
<td>Suppressed</td>
<td></td>
</tr>
</tbody>
</table>

*Note* — Additional settings may be available. Check the description of the individual type of load or type of support for details.
- **Valid Parent Tree Object:** Model

- **Valid Child Tree Objects:** all mesh control tool objects, Comment, Figure

**Insertion Options:**

Appears by default when geometry is attached.

**Additional Related Information:**

- Meshing Overview
- **Mesh** Context Toolbar

<table>
<thead>
<tr>
<th>Details View:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Defaults:</strong></td>
<td>Preview Mesh</td>
</tr>
<tr>
<td>Global Control</td>
<td>Preview Sweep</td>
</tr>
<tr>
<td>Relevance - appears if Global Control is set to Basic.</td>
<td></td>
</tr>
<tr>
<td>The following appear under Defaults if Global Control is set to Advanced:</td>
<td></td>
</tr>
<tr>
<td>Element Size</td>
<td></td>
</tr>
<tr>
<td>Curv/Proximity</td>
<td></td>
</tr>
<tr>
<td>Shape Checking</td>
<td></td>
</tr>
<tr>
<td>Solid Element Order</td>
<td></td>
</tr>
<tr>
<td>Straight Sided Element - appears if the model includes an enclosure from DesignModeler.</td>
<td></td>
</tr>
<tr>
<td>Initial Size Seed</td>
<td></td>
</tr>
<tr>
<td>Statistics: - Read-only indications</td>
<td></td>
</tr>
<tr>
<td>Nodes</td>
<td></td>
</tr>
<tr>
<td>Elements</td>
<td></td>
</tr>
</tbody>
</table>

**Mesh Control Tools (Group)**

Objects available for fine tuning the mesh.

**License Level:** ANSYS DesignSpace and above

**Applies to the following objects:** Contact Sizing, Gap Sizing, Gap Tool, Mapped Face Meshing, Match Face Mesh, Method, Part Proximity, Part Relevance, Refinement, Sizing

**Tree Dependencies:**
• **Valid Parent Tree Object:**
  - For **Gap Sizing**: **Gap Tool**
  - For all other objects: **Mesh**

• **Valid Child Tree Objects:** **Comment**, **Figure**

**Insertion Options:**

• For **Gap Sizing**, automatic insertion under the **Gap Tool** based on detection of gap face pairs.

• For all other objects, use any of the following methods after highlighting **Mesh** object:
  - Choose **Mesh Control**> {Mesh control tool name} on **Mesh** context toolbar.
  - **Insert**> **Model Item**> **Mesh Control**> {Mesh control tool name}
  - Click right mouse button on **Mesh** object, any mesh control tool object, or in the **Geometry** window> **Insert**> {Mesh control tool name}.

**Additional Related Information:**

• Meshing Overview
• **Mesh** Context Toolbar
• **Gap Tool** Context Toolbar - applicable to **Gap Sizing** and **Gap Tool**
• Convergence - applicable to **Refinement**
• Error (Structural) - applicable to **Refinement**
### Relevant Right Mouse Button Context Menu Options:

- **Details View:**
  - Except where noted, the following applies to all objects other than **Gap Tool**:
    - **Scope:**
      - Scoping Method - specify either **Geometry Selection** or **Named Selection**. Not applicable to **Contact Sizing**, **Gap Sizing**, or **Match Face Meshing**.
      - Geometry - appears if Scoping Method is set to **Geometry Selection**. In this case, use selection filters to pick geometry, click in the **Geometry** field, then click **Apply**. Not applicable to **Contact Sizing**.
      - Named Selection - appears if Scoping Method is set to **Named Selection**. Not applicable to **Contact Sizing**, **Gap Sizing**, or **Match Face Meshing**.
      - Contact Region - applicable only to **Contact Sizing**.
    - **Definition:**
      - Suppressed

  *Note* — Additional Definition settings may be available, depending on the specific mesh control tool.

- The following applies only to the **Gap Tool**:
  - **Definition:**
    - Define By
    - Minimum
    - Maximum
    - Gap Aspect Ratio
    - Gap Density
    - Generate on Update

---

### Model

Defines the geometry for the particular branch of the tree. The **Environment** object and sub-levels provide additional information about the **Model** object, including loads, supports and results, but do not replace the geometry. Graphic settings applied to the **Model** object apply to lower level objects in the tree. The **Model** object groups geometry, material assignments, contact and mesh settings. The **Geometry**, **Contact** and **Mesh** objects are not created until geometry is successfully attached.

**License Level:** All levels

**Tree Dependencies:**
Valid Parent Tree Object: Project

Valid Child Tree Objects: Comment, Contact, Coordinate Systems, Environment, Figure, Geometry, Mesh, Named Selection, Solution Combination, Virtual Topology

**Insertion Options:**

- Appears by default for a new Simulation or for attached geometry.
- Click **New Model** button on **Project** context toolbar.

**Additional Related Information:**

- Attaching Geometry
- **Model** Context Toolbar

---

<table>
<thead>
<tr>
<th><strong>Details View:</strong></th>
<th><strong>Relevant Right Mouse Button Context Menu Options:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Lighting:</strong></td>
<td></td>
</tr>
<tr>
<td>Ambient Light</td>
<td></td>
</tr>
<tr>
<td>Diffuse Light</td>
<td></td>
</tr>
<tr>
<td>Specular Light</td>
<td></td>
</tr>
<tr>
<td>Light Color</td>
<td></td>
</tr>
</tbody>
</table>

**Named Selections**

Represents all child objects grouped as named selections for a model.

**License Level:** All levels

**Tree Dependencies:**
Valid Parent Tree Object: Model
Valid Child Tree Objects: Individual named selection objects, Comment, Figure

Note — Comment and Figure are also child objects of individual named selection objects.

Insertion Options: Use any of the following methods:

- Select geometry items for grouping in the Geometry window, or select Body objects in the tree, then choose Create Selection Group.
- Import named selections from a CAD system or from DesignModeler.
- Automatically inserted in the event of a mesher failure so that problem surfaces can be identified.

Additional Related Information:
- Named Selection Toolbar
- Geometry Preferences
- Named Selection (DesignModeler Help)
- Enclosure (DesignModeler Help)

<table>
<thead>
<tr>
<th>Details View:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>No entries for the Named Selections parent object itself. The following applies only to the child objects of a Named Selections object:</td>
<td></td>
</tr>
<tr>
<td><strong>Scope:</strong> Geometry - Use selection filters to pick geometry, click in the Geometry field, then click Apply.</td>
<td></td>
</tr>
<tr>
<td><strong>Statistics:</strong> Read-only status indications. Type - Manual if named selection was created in Simulation or generated due to a mesher failure; Imported if named selection was imported. <strong>Total Selection Suppressed Hidden</strong></td>
<td></td>
</tr>
</tbody>
</table>

Parameter Manager

Collects and manages parameters and displays them in the Parameter Manager Worksheet.

License Level: All levels

Tree Dependencies:
• Valid Parent Tree Object: Solution
• Valid Child Tree Objects: Comment, Variable Graph

Insertion Options: Use any of the following methods after highlighting Solution object:

• Choose Parameter Manager on Solution context toolbar.

  Note — The Parameter Manager toolbar button may not be displayed, especially if your screen display is set to a low resolution. If you experience this situation, use either of the other two insertion options that follow.

• Insert> Parameter Item> Parameter Manager
• Click right mouse button on Solution object or in the Geometry window > Insert> Parameter Item> Parameter Manager.

  Note — Only one Parameter Manager object can be inserted per Solution.

Additional Related Information:

• Parameters
• Section : Specifying Parameters
• Section : Scenario Grids
• Section : What Ifs
• Section : Failures
• Section : CAD Parameters

<table>
<thead>
<tr>
<th>Details View:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>General - Read-only status indications</td>
<td>Export</td>
</tr>
<tr>
<td>Parameter Count</td>
<td></td>
</tr>
<tr>
<td>Run Count</td>
<td></td>
</tr>
</tbody>
</table>

Part

Defines a component of the attached geometry included under a Geometry object. The Part object is assumed to be a multi body part with Body objects beneath it as depicted in the figure below. Refer to the Body objects reference page if the Geometry object does not include a multi body part, but instead only includes individual bodies, as depicted by Body 1 in the figure below.

License Level: All levels

Tree Dependencies:
- **Valid Parent Tree Object:** Geometry
- **Valid Child Tree Objects:** Body, Comment, Figure

**Insertion Options:**

Appears by default when geometry is attached that includes a multi body part.

**Additional Related Information:**

- Attaching Geometry

---

<table>
<thead>
<tr>
<th>Details View:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Graphics Properties:</strong></td>
<td></td>
</tr>
<tr>
<td>Visible - Turns part display On or Off in the Geometry window.</td>
<td></td>
</tr>
<tr>
<td><strong>Definition:</strong></td>
<td></td>
</tr>
<tr>
<td>Suppressed</td>
<td></td>
</tr>
<tr>
<td>Material</td>
<td></td>
</tr>
<tr>
<td><strong>Bounding Box:</strong></td>
<td></td>
</tr>
<tr>
<td>Length X</td>
<td></td>
</tr>
<tr>
<td>Length Y</td>
<td></td>
</tr>
<tr>
<td>Length Z</td>
<td></td>
</tr>
<tr>
<td><strong>Mass Properties</strong> - Read-only indication of the mass properties originally assigned to the part.</td>
<td></td>
</tr>
<tr>
<td>Volume</td>
<td></td>
</tr>
<tr>
<td>Mass</td>
<td></td>
</tr>
<tr>
<td>Note — If density is temperature dependent, then the density value at 22°C (default reference temperature for an environment) will be used to compute the Mass.</td>
<td></td>
</tr>
<tr>
<td><strong>Statistics</strong> - Read-only indication of the entities that comprise the part.</td>
<td></td>
</tr>
<tr>
<td>Nodes</td>
<td></td>
</tr>
<tr>
<td>Elements</td>
<td></td>
</tr>
</tbody>
</table>

**Point Mass**

Represents the inertial effects from a body.
**License Level:** ANSYS DesignSpace and above

**Tree Dependencies:**

- Valid Parent Tree Object: Geometry
- Valid Child Tree Objects: Comment, Figure

**Insertion Options:** Use any of the following methods after highlighting Geometry object or Body object:

- Click **Point Mass** button on Geometry context toolbar.
- **Insert > Geometry Item > Point Mass**
- Click right mouse button on Geometry object, Body object, or in the Geometry window > **Insert > Point Mass.**

**Additional Related Information:**

- Point Mass
- Coordinate Systems
- **Geometry** Context Toolbar

**Details View:**

<table>
<thead>
<tr>
<th>Scope</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geometry - Use selection filters to pick geometry, click in the Geometry field, then click Apply.</td>
<td></td>
</tr>
<tr>
<td>Coordinate System - Assign load to a local coordinate system if previously defined using one or more Coordinate System objects.</td>
<td></td>
</tr>
<tr>
<td>X Coordinate - Define x coordinate location; can be designated as a parameter.</td>
<td></td>
</tr>
<tr>
<td>Y Coordinate - Define y coordinate location; can be designated as a parameter.</td>
<td></td>
</tr>
<tr>
<td>Z Coordinate - Define z coordinate location; can be designated as a parameter.</td>
<td></td>
</tr>
<tr>
<td>Location - Change location of the load. Pick new location, click in the Location field, then click Apply.</td>
<td></td>
</tr>
<tr>
<td>Definition:</td>
<td></td>
</tr>
<tr>
<td>Magnitude - Define magnitude; can be designated as a parameter.</td>
<td></td>
</tr>
<tr>
<td>Suppressed</td>
<td></td>
</tr>
</tbody>
</table>

**Project**

Includes all objects in Simulation and represents the highest level in the object tree. Only one **Project** can exist per Simulation session.

**License Level:** ANSYS DesignSpace and above
Tree Dependencies:

- **Valid Parent Tree Object:** None - highest level in the tree.
- **Valid Child Tree Objects:** Comment, Model

**Insertion Options:**

Appears by default in every Simulation session.

<table>
<thead>
<tr>
<th>Details View</th>
<th>Relevant Right Mouse Button Context Menu Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title Page</strong> - You can enter the following information that will appear on the title page of the report. <strong>Author</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Subject</strong></td>
<td><strong>Product Version</strong></td>
</tr>
<tr>
<td><strong>Prepared for</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Information</strong> - Simulation provides the following information that will appear on the title page of the report. <strong>First Saved</strong></td>
<td><strong>Solution</strong></td>
</tr>
<tr>
<td><strong>Last Saved</strong></td>
<td><strong>Convergence</strong></td>
</tr>
<tr>
<td><strong>Result Tracker</strong></td>
<td><strong>Result Tracker</strong></td>
</tr>
<tr>
<td>Provides results graphs of deformation, contact, or temperature, vs. time or cumulative iteration.</td>
<td><strong>Parameter Manager</strong></td>
</tr>
<tr>
<td><strong>License Level:</strong> ANSYS Professional and above</td>
<td><strong>Variable Graph</strong></td>
</tr>
<tr>
<td><strong>Tree Dependencies:</strong></td>
<td></td>
</tr>
</tbody>
</table>

Simulation Objects Reference
• Valid Parent Tree Object: Solution Information

• Valid Child Tree Objects: Comment

**Insertion Options:** Use any of the following methods after highlighting Solution Information object:

• Choose Result Tracker > Deformation, or Contact, or Temperature on Solution Information context toolbar.

• Insert > Solution Item > Solution Information > Result Tracker > Deformation, or Contact, or Temperature

• Click right mouse button on Solution Information object or in the Geometry window > Insert > Deformation, or Contact, or Temperature.

**Additional Related Information:**

• Result Tracker Objects

• Solution Options

• Solution Context Toolbar

---

### Details View:

**Scope:**
Scoping Method - appears for a Temperature result tracker object.

Geometry - appears for a Deformation result tracker object, or for a Temperature object if Scoping Method is set to Geometry Selection. Use selection filters to pick geometry, click in the Geometry field, then click Apply.

Contact Region - appears for a Contact result tracker object.

**Definition:**
Type - Read-only indication of result tracker type for Deformation and Temperature objects. For Contact object, specify contact output.

Orientation - appears for a Deformation result tracker object.

X-Axis Values - specify Time or Cumulative Iteration.

### Relevant Right Mouse Button Context Menu Options:

- Export - available in Worksheet tab view.
- Rename Based on Definition

---

### Results and Result Tools (Group)

Defines the engineering output for displaying and analyzing the results from a solution.

**License Level:** ANSYS DesignSpace and above.

**Applies to the following objects:** 1st Buckling Mode, Beam Tool, Biaxiality Indication, Buckling Tool, Contact Tool, Current Density, Damage, Damage Matrix, Direct Stress, Directional Deformation, Directional Field Intensity, Directional Flux Density, Directional Force/Torque, Directional Heat Flux, Elastic Strain Intensity, Electric Potential, Equivalent Alternating Stress, Equivalent Plastic Strain, Equivalent Stress, Fatigue Sensitivity, Fatigue Tool, Flux Linkage, Frequency Finder, Frequency Mode in Range [1st - 6th], Frequency
Response, Frictional Stress, Gap, Harmonic Tool, Hysteresis, Inductance, Life, Maximum Bending Stress, Maximum Combined Stress, Maximum Principal Elastic Strain, Maximum Principal Stress, Maximum Shear Elastic Strain, Maximum Shear Stress, Middle Principal Elastic Strain, Middle Principal Stress, Minimum Bending Stress, Minimum Combined Stress, Minimum Principal Elastic Strain, Minimum Principal Stress, Normal Elastic Strain, Normal Stress, Penetration, Phase Response, Pressure, Probe, Probe Tool, Rainflow Matrix, Reactions, Safety Factor [fatigue], Safety Factor [stress], Safety Margin, Shape Finder, Shear Elastic Strain, Shear Stress, Sliding Distance, Status, Stress Intensity, Stress Ratio, Stress Tool, Structural Error, Temperature, Thermal Error, Thermal Strain, Total Deformation, Total Field Intensity, Total Flux Density, Total Force, Total Heat Flux, Vector Principal Elastic Strain, Vector Principal Stress

Tree Dependencies:
• **Valid Parent Tree Object:**
  - For **Direct Stress, Maximum Bending Stress, Maximum Combined Stress, Minimum Bending Stress, Minimum Combined Stress**: Beam Tool
  - For **1st Buckling Mode**: Buckling Tool
  - For **Frictional Stress, Gap, Penetration, Pressure, Reactions, Sliding Distance, Status**: Contact Tool
  - For **Biaxiality Indication, Damage, Damage Matrix, Equivalent Alternating Stress, Fatigue Sensitivity, Hysteresis, Life, Rainflow Matrix, Safety Factor [fatigue]**: Fatigue Tool
  - For **Frequency Mode in Range [1st - 6th]**: Frequency Finder
  - For **Frequency Response, Phase Response**: Harmonic Tool
  - For **Safety Factor [stress], Safety Margin, Stress Ratio**: Stress Tool
  - For **Directional Deformation, Total Deformation**: Beam Tool, Buckling Tool, Frequency Finder, Solution
  - For all stress and strain result objects: Buckling Tool, Frequency Finder, Solution
  - For all other objects: Solution

• **Valid Child Tree Objects:**
  - For **Beam Tool**: Comment, Direct Stress, Directional Deformation, Figure, Maximum Bending Stress, Maximum Combined Stress, Minimum Bending Stress, Minimum Combined Stress, Total Deformation
  - For **Buckling Tool**: 1st Buckling Mode, Comment, all stress and strain result objects, Directional Deformation, Figure, Total Deformation
  - For **Contact Tool**: Comment, Figure, Frictional Stress, Gap, Penetration, Pressure, Reactions, Sliding Distance, Status
  - For **Fatigue Tool**: Biaxiality Indication, Comment, Damage, Damage Matrix, Equivalent Alternating Stress, Fatigue Sensitivity, Hysteresis, Life, Rainflow Matrix, Safety Factor [fatigue]
  - For **Frequency Finder**: Comment, all stress and strain result objects, Directional Deformation, Frequency Mode in Range [1st - 6th], Figure, Total Deformation
  - For **Harmonic Tool**: Frequency Response, Phase Response
  - For **Stress Tool**: Comment, Figure, Safety Factor [stress], Safety Margin, Stress Ratio
- For all other objects: Comment, Figure

Note — Alert and Convergence may also apply.

Insertion Options:

- For results and result tools that are direct child objects of a Solution object, use any of the following methods after highlighting the Solution object:
  - Choose Tools {or a result category}> {specific tool/result} on Solution context toolbar.
  - Insert> Solution Item> {tool/result category}> {in some cases, specific tool/result}
  - Click right mouse button on Solution object, or in the Geometry window> Insert> {tool/result category}> {in some cases, specific tool/result}

Note — Shape Finder is not available under a Solution object that contains any other result object except a Buckling Tool or Contact Tool object.

- For results that are direct child objects of a specific result tool, use any of the following methods after highlighting the specific result tool object:
  - Choose result on the context toolbar related to the result tool.
  - Insert> Solution Item> {specific result tool/category}> {specific result related to result tool}
  - Click right mouse button on specific result tool object> Insert> {specific result related to result tool}

Additional Related Information:

- Result Types
- Solution Context Toolbar
- Fatigue Overview
Relevant Right Mouse Button Context Menu Options:

- Evaluate Results
- Generate Static Environment with Thermal Condition - available only for all thermal results and Thermal Strain.
- Generate Transient Environment with Initial Condition - available only for all thermal results and Thermal Strain when Static is set in the Environment or Solution context toolbar.

Details View:

- Except where noted, the following applies to all result objects whose direct parent object is Solution, except result tool objects, Flux Linkage and Inductance.

Scope
Geometry - Use selection filters to pick geometry, click in the Geometry field, then click Apply.

Definition:
Type - result type indication, can be changed within the same result category. Read-only indication for: Current Density, Electric Potential, Equivalent Plastic Strain, Structural Error, Temperature, Thermal Error, Vector Principal Elastic Strain, Vector Principal Stress.
Display Time - appears if Transient is set in the Environment or Solution context toolbar.
Sequence Number - appears if Steps: is set to greater than 1 in the Environment or Solution context toolbar.
Orientation - appears only for: Directional Deformation, Directional Field Intensity, Directional Flux Density, Directional Force/Torque, Directional Heat Flux, Normal Elastic Strain, Normal Stress, Shear Elastic Strain, Shear Stress, Thermal Strain.

Results - Read-only status indication of result object.
Minimum - not available for Vector Principal Stress.
Maximum - not available for Vector Principal Stress.
Sum - appears only for Directional Force/Torque.
Torque - appears only for Directional Force/Torque.
Symmetry Multiplier - appears only for Directional Force/Torque.

Information - Read-only status indication of time stepping.
Time
Load Step
Substep
Iteration Number

- Check individual descriptions for all result tools, Flux Linkage and Inductance.
Solution

Defines result types and formats for viewing a solution. Also includes settings that can be established prior to a solve.

License Level: All levels

Tree Dependencies:

- Valid Parent Tree Object: Environment
- Valid Child Tree Objects: All general Results and Result Tools, Commands, Comment, Figure

Insertion Options:

- Appears by default for a new Simulation or for attached geometry.
- Click New Model button on Project context toolbar.

Additional Related Information:

- Solving Overview
- Solution Context Toolbar
- Convergence
- Problem Situations
<table>
<thead>
<tr>
<th>Details View:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Evaluate Results</td>
</tr>
<tr>
<td></td>
<td>Process Settings</td>
</tr>
<tr>
<td>Adaptive Convergence</td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td></td>
</tr>
<tr>
<td>Max Refinement Loops</td>
<td></td>
</tr>
<tr>
<td>Refinement Depth</td>
<td></td>
</tr>
</tbody>
</table>

**Options**
- **Save ANSYS db**
  - **ANSYS db File Name** - appears if **Save ANSYS db** is set to Yes.
- **Solver Type**
  - **Weak Springs**
    - **Spring Stiffness** - appears if **Weak Springs** is set to On.
    - **Spring Stiffness Factor** - appears if **Spring Stiffness** is set to Factor.
  - **Spring Stiffness Value** - appears if **Spring Stiffness** is set to Manual.
- **Large Deflection**
  - **Auto Time Stepping** - appears if **Static** or **Harmonic** is set in the **Environment** or **Solution** context toolbar.
  - **Initial Substeps** - appears if **Auto Time Stepping** is set to On.
  - **Minimum Substeps** - appears if **Auto Time Stepping** is set to On.
  - **Maximum Substeps** - appears if **Auto Time Stepping** is set to On.
  - **Number of Substeps** - appears if **Auto Time Stepping** is set to Off.

**Solution**
- **Analysis Type** - Read-only indication.
- **Nonlinear Solution** - Read-only indication.
- **Solver Working Directory** - Read-only indication.
- **Result File Name Selection**
  - **Result File** - Read-only indication if **Result File Name Selection** is set to **Program Controlled**.
- **Solver Messages** - Read-only indication.

**Solver Process Settings**
- **Run Process on**
  - **RSM Web Server** - appears if **Run Process on** is set to WB Cluster.
  - **Assignment** - appears if **Run Process on** is set to WB Cluster.
  - **Queue** - appears if **Run Process on** is set to LSF Cluster or if **Assignment** is set to Queue.
  - **Compute Server** - appears if **Assignment** is set to Server.
  - **User Name** - appears if **Run Process on** is set to WB Cluster.
  - **Password** - appears if **Run Process on** is set to WB Cluster.
  - **Working Directory** - appears if **Run Process on** is set to WB Cluster.
  - **Command** - appears if **Run Process on** is set to WB Cluster.
  - **License to Use** - appears if **Run Process on** is set to LSF Cluster or WB Cluster.
  - **Number Of Processors**
  - **ANSYS Memory Settings**
| **Workbench Memory** - appears if ANSYS Memory Settings is set to Manual.  
*Database Memory* - appears if ANSYS Memory Settings is set to Manual.  
**Output Controls**  
Calculate Stress  
Calculate Strain  
Calculate Contact  
Calculate Error  
Calculate Thermal Flux |

**Solution Combination**

Manages solutions that are derived from the results of one or more environments.

**License Level:** ANSYS Professional and above except if **Fatigue Tool** is included, then ANSYS DesignSpace and above

**Tree Dependencies:**

- **Valid Parent Tree Object:** Model
- **Valid Child Tree Objects:** all stress and strain result objects, Directional Deformation, Total Deformation, Contact Tool (only for Frictional Stress, Penetration, Pressure, and Sliding Distance), Fatigue Tool, Stress Tool, Comment

**Insertion Options:** Use any of the following methods after highlighting **Model** object:

- Choose **Solution Combination** on **Model** context toolbar.
- **Insert > Model Item > Solution Combination**
- Click right mouse button on **Model** object or in the **Geometry** window > **Insert > Solution Combination**.

**Additional Related Information:**

- Solution Combinations
- Underdefined Solution Combinations (Troubleshooting)

**Solution Information**

Allows tracking, monitoring, or diagnosing of problems that arise during a nonlinear solution.

**License Level:** ANSYS Professional and above

**Tree Dependencies:**
Valid Parent Tree Object: Solution
Valid Child Tree Objects: Commands, Comment, Result Tracker

**Insertion Options:** Use any of the following methods after highlighting Solution object:

- Choose **Tools** > **Solution Information** on Solution context toolbar.
- **Insert** > **Solution Item** > **Solution Information** > Solution Information
- Click right mouse button on **Solution** object or in the Geometry window > **Insert** > **Solution Information** > Solution Information.

*Note* — Only one **Solution Information** object is valid per **Model**.

**Additional Related Information:**

- Solution Information
- **Solution** Context Toolbar

<table>
<thead>
<tr>
<th>Details View:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Solution Information</strong></td>
<td><strong>Solution</strong> Information</td>
</tr>
<tr>
<td>Solution Output</td>
<td><strong>Solution Output</strong></td>
</tr>
<tr>
<td>Newton-Raphson Residuals</td>
<td><strong>Newton-Raphson Residuals</strong></td>
</tr>
<tr>
<td>Update Interval</td>
<td><strong>Update Interval</strong></td>
</tr>
</tbody>
</table>

**Spot Weld**

Defines conditions for individual contact and target pairs for a spot weld, which is used to connect individual surface parts to form a surface model assembly, just as a **Contact Region** object is used to form a solid model assembly. Several **Spot Weld** objects can appear as child objects under a **Contact** object.

**License Level:** ANSYS DesignSpace and above

**Tree Dependencies:**
Valid Parent Tree Object: Contact
Valid Child Tree Objects: Commands, Comment, Figure

**Insertion Options**: Use any of the following methods after highlighting Contact object:

- Inserted automatically if spot welds are defined in the CAD model.
- Click Spot Weld button on Contact context toolbar.
- Insert> Model Item> Spot Weld
- Click right mouse button on Contact object or in the Geometry window> Insert> Spot Weld.

**Additional Related Information**:

- Spot Welds
- Contact Context Toolbar

<table>
<thead>
<tr>
<th>Details View:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope:</td>
<td>Enable/Disable Transparency</td>
</tr>
<tr>
<td>Scoping Method</td>
<td>Hide All Other Bodies</td>
</tr>
<tr>
<td>Contact</td>
<td>Flip Contact/Target</td>
</tr>
<tr>
<td>Target</td>
<td>Merge Selected Contact Regions - appears if contact regions share the same geometry type.</td>
</tr>
<tr>
<td>Contact Bodies</td>
<td>Save Contact Region Settings</td>
</tr>
<tr>
<td>Target Bodies</td>
<td>Load Contact Region Settings</td>
</tr>
<tr>
<td>Definition:</td>
<td>Reset to Default</td>
</tr>
<tr>
<td>Scope Mode</td>
<td>Rename Based on Geometry</td>
</tr>
<tr>
<td>Suppressed</td>
<td></td>
</tr>
</tbody>
</table>

**Transient Settings**

For transient simulations, displays a Transient Settings worksheet that provides a graphical display of the transient settings, and allows you to adjust these settings prior to solving.

**License Level**: ANSYS Professional and above (except ANSYS Structural)

**Tree Dependencies**:
- **Valid Parent Tree Object: Solution** (available only for Transient setting in the Environment or Solution context toolbar)

- **Valid Child Tree Objects: Comment**

**Insertion Options:**

Automatically inserted in the tree if Transient is set in the Environment or Solution context toolbar.

**Additional Related Information:**

- Thermal Transient Simulations
- Transient Settings Worksheet
- Environment Context Toolbar
- Solution Context Toolbar

---

**Details View:**

<table>
<thead>
<tr>
<th>Time Options:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Nonlinear Formulation</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Reformulation Tolerance</strong> - appears if Nonlinear Formulation is set to Quasi.</td>
<td></td>
</tr>
<tr>
<td><strong>Auto Time Stepping</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Define By</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Initial Substeps</strong> - appears if Auto Time Stepping is set to On and Define By is set to Substeps.</td>
<td></td>
</tr>
<tr>
<td><strong>Minimum Substeps</strong> - appears if Auto Time Stepping is set to On and Define By is set to Substeps.</td>
<td></td>
</tr>
<tr>
<td><strong>Maximum Substeps</strong> - appears if Auto Time Stepping is set to On and Define By is set to Substeps.</td>
<td></td>
</tr>
<tr>
<td><strong>Number of Substeps</strong> - appears if Auto Time Stepping is set to Off and Define By is set to Substeps.</td>
<td></td>
</tr>
<tr>
<td><strong>Initial Time Step</strong> - appears if Auto Time Stepping is set to On and Define By is set to Time.</td>
<td></td>
</tr>
<tr>
<td><strong>Minimum Time Step</strong> - appears if Auto Time Stepping is set to On and Define By is set to Time.</td>
<td></td>
</tr>
<tr>
<td><strong>Maximum Time Step</strong> - appears if Auto Time Stepping is set to On and Define By is set to Time.</td>
<td></td>
</tr>
<tr>
<td><strong>Time Step</strong> - appears if Auto Time Stepping is set to Off and Define By is set to Time.</td>
<td></td>
</tr>
</tbody>
</table>

**Visibility:**

- **Chart Legend** - displays the chart legend to the right of the chart.
- **DT Legend** - displays the time increment legend beneath the chart.
- **Tabular Data** - displays timeline grid of Time and Step Reset beneath the chart (On by default).
- **Curve Type Column** - displays the Type column of the timeline legend, located in the lower right area of the worksheet.
Variable Graph

Displays a graph of parameters defined in the Parameter Manager Worksheet. At least two parameters must be defined.

License Level: All levels

Tree Dependencies:

- Valid Parent Tree Object: Parameter Manager
- Valid Child Tree Objects: Comment

Insertion Options: Use any of the following methods after highlighting Parameter Manager object:

- Choose Variable Graph on Parameter Manager context toolbar.
- Insert> Parameter Item> Variable Graph
- Click right mouse button on Parameter Manager object > Insert> Parameter Item> Variable Graph.

Additional Related Information:

- Parameters
- Section : Specifying Parameters
- Section : Scenario Grids
- Section : What Ifs
- Section : Failures
- Section : CAD Parameters

### Details View: Relevant Right Mouse Button Context Menu Options:

<table>
<thead>
<tr>
<th>Options</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options - Drop down menu choices of possible axes quantities.</td>
<td>X-Axis Selection</td>
</tr>
<tr>
<td></td>
<td>Y-Axis Selection</td>
</tr>
</tbody>
</table>

Virtual Cell

Defines an individual surface or edge group, defined manually or automatically. The collection of all Virtual Cell objects exists under one Virtual Topology object.

License Level: All levels

Tree Dependencies:
Valid Parent Tree Object: Virtual Topology

Valid Child Tree Objects: Comment, Figure

Insertion Options:

- For automatic creation of virtual cell regions, Simulation inserts a Virtual Cell object for each region that meets the criterion specified in the Details View of the Virtual Topology object.
- For manual creation of Virtual Cell objects, use any of the following methods after highlighting Virtual Topology object:
  - Choose Virtual Cell on Virtual Topology context toolbar.
  - Insert > Model Item > Virtual Cell
  - Click right mouse button on Virtual Topology object, on an existing Virtual Cell object, or in the Geometry window > Insert > Virtual Cell.

Additional Related Information:

- Virtual Topology Overview
- Virtual Topology Context Toolbar

<table>
<thead>
<tr>
<th>Details View:</th>
<th>Relevant Right Mouse Button Context Menu Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Definition</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Cell Class</strong> - Read-only indication of cell class for selected Virtual Cell object.</td>
<td></td>
</tr>
<tr>
<td><strong>Suppressed</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Scope</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Geometry</strong> - Read-only indication of components that make up the Virtual Cell object.</td>
<td></td>
</tr>
</tbody>
</table>

Virtual Topology

 Represents all definitions of surface or edge groups within a model. Each definition is represented in a Virtual Cell object.

License Level: All levels

Tree Dependencies:
Valid Parent Tree Object: Model

Valid Child Tree Objects: Comment, Figure, Virtual Cell

**Insertion Options:** Use any of the following methods after highlighting Model object:

- Choose Virtual Topology on Model context toolbar.
- Insert > Model Item > Virtual Topology
- Click right mouse button on Model object or in the Geometry window > Insert > Virtual Topology.

*Note* — Only one Virtual Topology object is valid per Model.

**Additional Related Information:**

- Virtual Topology Overview
- Virtual Topology Context Toolbar

### Details View:

<table>
<thead>
<tr>
<th>Relevant Right Mouse Button Context Menu Options:</th>
<th>Generate Virtual Cells</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All settings apply to automatic creation of virtual cells.</strong></td>
<td><strong>Definition</strong></td>
</tr>
<tr>
<td><strong>Region Flatness</strong></td>
<td><strong>Advanced</strong></td>
</tr>
<tr>
<td><strong>Smallest Edge Tolerance</strong></td>
<td><strong>Shared Boundary Ratio</strong></td>
</tr>
<tr>
<td><strong>Region Size</strong></td>
<td><strong>Generate on Update</strong></td>
</tr>
<tr>
<td><strong>Generate on Update</strong></td>
<td><strong>Region Size</strong></td>
</tr>
</tbody>
</table>
Simulation Basics

- Simulation License Options
- Simulation Interface
- Customizing Simulation
- Simulation System Files

To access the ANSYS Workbench Help, see Section: Using Help.

Simulation License Options

The following table lists the available capabilities by ANSYS license.

Table 1  Available Capabilities by License

<table>
<thead>
<tr>
<th>Feature/Capability</th>
<th>License Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Meshing Module (including Hex Dominant Element Shape Control)</td>
<td>ANSYS Structural and above</td>
</tr>
<tr>
<td>Equivalent Plastic Strain</td>
<td>ANSYS Structural and above</td>
</tr>
<tr>
<td>Hyperelastic Material Model, Plasticity</td>
<td>ANSYS Structural and above</td>
</tr>
<tr>
<td>Large Deformation (Solid Parts)</td>
<td>ANSYS Structural and above</td>
</tr>
<tr>
<td>Contact Friction</td>
<td>ANSYS Structural and above</td>
</tr>
<tr>
<td>Beta Damping</td>
<td>ANSYS Structural and above</td>
</tr>
<tr>
<td>Bolt Load</td>
<td>All levels</td>
</tr>
<tr>
<td>Specified Displacement on Harmonic loads</td>
<td>ANSYS Structural and above</td>
</tr>
<tr>
<td>One Way Transfer of Fluid-Structure Pressure Load</td>
<td>ANSYS Professional and above, CFX-Post license, and a local installation of CFX-Post.</td>
</tr>
<tr>
<td>Sequenced Simulations</td>
<td>ANSYS Professional and above</td>
</tr>
<tr>
<td>Temperature Dependent Material Properties</td>
<td>ANSYS Professional and above</td>
</tr>
<tr>
<td>Commands Objects</td>
<td>ANSYS Professional and above</td>
</tr>
<tr>
<td>Orthotropic Material Properties</td>
<td>ANSYS Professional and above</td>
</tr>
<tr>
<td>Result Tracker</td>
<td>ANSYS Professional and above</td>
</tr>
<tr>
<td>Return Newton-Raphson Residuals</td>
<td>ANSYS Professional and above</td>
</tr>
<tr>
<td>Harmonic Analysis</td>
<td>ANSYS Professional and above</td>
</tr>
<tr>
<td>Large Deformation (Sheet Parts)</td>
<td>ANSYS Professional and above</td>
</tr>
<tr>
<td>Contact input options and results</td>
<td>ANSYS Professional and above</td>
</tr>
<tr>
<td>Contact Formulations and Update Stiffness options</td>
<td>ANSYS DesignSpace and above</td>
</tr>
<tr>
<td>Virtual Topology</td>
<td>All levels</td>
</tr>
<tr>
<td>Mapped Meshing</td>
<td>All levels</td>
</tr>
<tr>
<td>Load ANSYS</td>
<td>ANSYS Professional and above</td>
</tr>
</tbody>
</table>
### Feature/Capability | License Type
--- | ---
Solution Combinations | ANSYS Professional and above. If Fatigue Tool is included: ANSYS DesignSpace and above
Contact that involves faces of surface bodies, or edges of surface bodies, or edges of solid bodies. | ANSYS Professional and above
Contact that involves only faces of solid bodies | ANSYS DesignSpace and above
2-D Simulations | ANSYS DesignSpace and above
Electromagnetic Boundary Conditions and Excitations | ANSYS Emag
Electromagnetic Results | ANSYS Emag
Thermal Condition | ANSYS DesignSpace and above
Import of surface and solid bodies. The only contact option applicable for the presence of surface and solid bodies is spot welds. | ANSYS DesignSpace and above
Nonlinear output and convergence monitoring | All levels
Coordinate Systems | All levels
Export data to files or Excel | All levels
Named selections | All levels
Worksheet tab | All levels
Mesh failure visualization | All levels

### Simulation Interface

- Section: Simulation Window
- Section: Tree Outline Conventions
- Section: Tree Outline
- Section: Tabs
- Section: Geometry
- Section: Graphical Selection
- Section: Details View
- Section: Parameters
- Section: Toolbars
- Section: Print Preview
- Section: Triad and Rotation Cursors

### Simulation Window

The following is an example of the Simulation interface.
The functional elements of the interface include the following.

<table>
<thead>
<tr>
<th>Window Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section : Main Menu</td>
<td>This menu includes the basic menus such as <strong>File</strong> and <strong>Edit</strong>.</td>
</tr>
<tr>
<td>Section : Standard Toolbar</td>
<td>This toolbar contains commonly used application commands such as <strong>Save</strong>.</td>
</tr>
<tr>
<td>Section : Graphics Toolbar</td>
<td>This toolbar contains commands that control pointer mode or cause an action in the graphics browser.</td>
</tr>
<tr>
<td>Section : Context Toolbar</td>
<td>This toolbar contains task-specific commands that change depending on where you are in the Section : Tree Outline.</td>
</tr>
<tr>
<td>Section : Unit Conversion Toolbar</td>
<td>Not visible by default.</td>
</tr>
<tr>
<td>Section : Named Selection Toolbar</td>
<td>This toolbar contains options to manage named selections.</td>
</tr>
<tr>
<td>Section : Tree Outline</td>
<td>Outline view of the simulation project. Always visible. Location in the outline sets the context for other controls. Provides access to object's context menus. Allows renaming of objects. Establishes what details display in the Section : Details View.</td>
</tr>
<tr>
<td>Section : Details View</td>
<td>The Section : Details View corresponds to the Outline selection. Displays a details window on the lower left panel of the Simulation window which contains details about each object in the Outline.</td>
</tr>
</tbody>
</table>
Window Component | Description
--- | ---
**Section : Geometry** | Displays and manipulates the visual representation of the object selected in the Outline. This window displays:
- 3D Geometry
- 2D/3D Graph
- Spreadsheet
- HTML Pages

Note — The Geometry window may include splitter bars for dividing views.

**Section : Tabs** | The document tabs that are visible on the lower right portion of the Simulation Window.

**Status Bar** | Brief in-context tip. Selection feedback.

**Splitter Bar** | Application window has up to 3 splitter bars.

### Tree Outline Conventions

The Tree Outline uses the following conventions:

- A symbol to the left of an item’s icon indicates that it contains associated subitems. Click to expand the item and display its contents.
- To collapse all expanded items at once, double-click the Project name at the top of the tree.
- Drag-and-drop function to move and copy objects.
- Branching. For more information, see Section : Branches.
- To delete a tree object from the Section : Tree Outline, right-click on the object and select Delete. A confirmation dialog asks if you want to delete the object.

### Status Symbols

A small status icon displays just to the left of the main object icon in the Section : Tree Outline

<table>
<thead>
<tr>
<th>Status Symbol Name</th>
<th>Symbol</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Underdefined</td>
<td><img src="image" alt="Structural Load 1" /></td>
<td>A load requires a nonzero magnitude.</td>
</tr>
<tr>
<td>Error</td>
<td><img src="image" alt="Convection 1" /></td>
<td>Load attachments may break during an Update.</td>
</tr>
<tr>
<td>Mapped Face or Match Face Mesh Failure</td>
<td><img src="image" alt="Result 1" /></td>
<td>Surface could not be mapped meshed, or mesh of face pair could not be matched.</td>
</tr>
<tr>
<td>Ok</td>
<td><img src="image" alt="Result 1" /></td>
<td>Everything is ok.</td>
</tr>
<tr>
<td>Needs to be Updated</td>
<td><img src="image" alt="Parameter Simulation 1" /></td>
<td>Equivalent to “Ready to Answer!”</td>
</tr>
<tr>
<td>Hidden</td>
<td><img src="image" alt="rectbar" /></td>
<td>A body or part is hidden.</td>
</tr>
<tr>
<td>Suppress Body</td>
<td><img src="image" alt="DE002" /></td>
<td>A body is suppressed.</td>
</tr>
</tbody>
</table>
### Status Symbol Name

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Example</th>
</tr>
</thead>
</table>
| [Total Deformation](https://example.com) | - Yellow lightning bolt: Item has not yet been solved.  
- Green lightning bolt: Solve in progress.  
- Green check mark: Successful solution.  
- Red lightning bolt: Failed solution.  
- Green down arrow: Successful asynchronous solution ready for download.  
- Red down arrow: Failed asynchronous solution ready for download. |

See also Section : Tree Outline.

### Tree Outline

The object Tree Outline matches the logical sequence of simulation steps. Object sub-branches relate to the main object. For example, the Environment object contains loads. You can right-click on an object to open a context menu which relates to that object. You can rename objects, provided the objects are not being solved.

Refer to the Simulation objects reference pages for more information.

### Suppress/Unsuppress Items

Several items in the Simulation tree outline can be suppressed, meaning that they can be individually removed from any further involvement in the analysis. For example, suppressing a part removes the part from the display and from any further loading or solution treatment.

### Items That Can Be Suppressed/Unsuppressed

The following tree items can be suppressed/unsuppressed:

- Parts and bodies
- Loads
- Supports
- Contact regions
- Mesh Controls
- Named selections
- Virtual cells

### How to Suppress/Unsuppress an Item

Except for named selections, you can suppress the items listed above by setting the Suppressed option in the Details View to Yes. Conversely, you can unsuppress items by setting the Suppressed option to No.

For all items listed above, including named selections, you can suppress/unsuppress items through context menu options available via a right mouse button click. Included is the context menu option Invert Suppressed Body Set, which allows you to reverse the suppression state of all bodies (unsuppressed bodies become sup-
pressed and suppressed bodies become unsuppressed). You can suppress named selections using either the context menu options mentioned above, or through the Named Selection Toolbar.

Another way to suppress a body is by selecting it in the graphics window, then using a right mouse button click in the graphics window and choosing **Suppress Body** in the context menu. Conversely, the **Unsuppress All Bodies** option is available for unsuppressing bodies. Options are also available in this menu for hiding or showing bodies. Hiding a body only removes the body from the display. A hidden body is still active in the analysis.

**Tabs**

The bottom of the browser pane in the application window contains the five main document tabs shown above. The Worksheet tab is available when tabular, graphic, or text data concerning the object is available.

The tabs provide alternative views of the current Outline object. You can move among the Section : Geometry, Animation, Section : Worksheet Tab, Section : Print Preview, and Section : Report Preview at any time by clicking the tabs. The Outline remains visible.

**Geometry**

The Geometry window displays the geometry model. All view manipulation, geometry selection and graphics display of a model occurs in the Geometry window. The window contains:

- 3D Graphics.
- A DHTML page (which may contain graphics such as charts).
- A scale ruler.
- A legend and a triad control (when you display the solution).
- Contour results objects.

*Note* — When you click **Insert**, then select **Comment**, the Geometry window splits horizontally, and the HTML comment editor displays in the bottom of the window. The Geometry representation of the model displays at the top. For more information about editing comments, refer to the **Comment object reference**.

**Graphical Selection**

**Tips for working with graphics**

- You can use the ruler, shown at the bottom of the Geometry window, to obtain a good estimate of the scale of the displayed geometry or results (similar to using a scale on a geographic map). The ruler is useful when setting mesh sizes.
- You can rotate the view in a geometry selection mode by dragging your middle mouse button. You can zoom in or out by rolling the mouse wheel.
- Hold the control key to add or remove items from a selection. You can **paint select** surfaces on a model by dragging the left mouse button.
- You can pan the view by using the arrow keys.
- Click the interactive Section : Triad and Rotation Cursors to quickly change the graphics view.
• Use the stack of rectangles in the lower left corner of the Section : Geometry to select surfaces hidden by your current selection.

• To rotate about a specific point in the model, switch to rotate mode and click the model to select a rotation point. Click off the model to restore the default rotation point.

• To multi-select one or more surfaces, hold the [CTRL] key and click the surfaces you wish to select, or use Box Select to select all surfaces within a box. The [CTRL] key can be used in combination with Box Select to select surfaces within multiple boxes.

• Click the Viewports icon to view up to four images in the Section : Geometry window.

• Controls are different for Graphs & Charts.

Rotation Cursors for Display
Pointer Modes
Defining Direction
Direction Defaults
Highlighting Geometry in Select Direction Mode
Selecting Direction by Surface
Selecting Direction Using the Section : Triad and Rotation Cursors
Highlighting
Picking
Blips
Painting
Depth Picking
Selection Filters
The Extend Selection Command
The Select Command
Viewports
Graph Chart Control

Rotation Cursors for Display

Activates rotational controls in the Geometry window (left mouse button). The cursor changes appearance depending on its window location.

Pointer Modes

The pointer in the graphics window is always either in a picking filter mode or a view control mode. When in a view control mode the selection set is locked. To resume the selection, repress a picking filter button.

The Graphics Toolbar offers several geometry filters and view controls as the default state, for example, surface, edge, rotate, and zoom.

If a Geometry field in the Section : Details View has focus, inappropriate picking filters are automatically disabled. For example, a pressure load can only be scoped to surfaces.

If the Direction field in the Section : Details View has focus, the only enabled picking filter is Select Direction. Select Direction mode is enabled for use when the Direction field has focus; you never choose Select Direction manually. You may manipulate the view while selecting a direction. In this case the Select Direction button allows you to resume your selection.
Defining Direction

Orientation may be defined by any of the following geometric selections:

- A planar face (normal to).
- A straight edge.
- Cylindrical or revolved face (axis of).
- Two vertices.

If an axis is required (e.g. for rotational velocity) selection of a planar face also requires a vertex.

Alternatively, world (X, Y, Z) components may be used to define vector loads.

Direction Defaults

If you create an object by selecting Geometry and choosing Insert, the Direction field may default if the geometry defines an orientation. For example, a force applied to a planar face by default acts normal to the face. One of the two directions is chosen automatically. The load annotation displays the default direction.

Highlighting Geometry in Select Direction Mode

Unlike other picking filters (where one specific type of geometry highlights during selection) the Select Direction filter highlights any of the following during selection:

- Planar faces
- Straight edges
- Cylindrical or revolved faces
- Vertices

If one vertex is selected, you must hold down the [CTRL] key to select the other. When you press the [CTRL] key, only vertices highlight.

Selecting Direction by Surface

The following figure shows the graphic display after choosing a surface to define a direction. The same display appears if you edit the Direction field later.

- The selection blip indicates the hit point on the surface.
- Two arrows show the possible orientations. They appear in the upper left corner of the Section: Geometry.

If either arrow is clicked, the direction flips.

When you finish editing the direction, the hit point (initially marked by the selection blip) becomes the default location for the annotation:
Highlighting

Highlighting provides visual feedback about the current pointer behavior (e.g. select surfaces) and location of the pointer (e.g. over a particular surface).

The surface edges are highlighted in colored dots.

Picking

A pick means a click on visible geometry. A pick becomes the current selection, replacing previous selections. A pick in empty space clears the current selection.

By holding the [CTRL] key down, you can add unselected items to the selection and selected items can be removed from the selection. Clicking in empty space with [CTRL] depressed does not clear current selections.

Blips

A crosshair blip appears at the location where you release the mouse button:
A blip serves to:

- Mark a picked point on visible geometry.
- Represent a ray normal to the screen passing through all hidden geometry.

Note — This is important for depth picking, a feature discussed below.

Blips disappear when you clear the selection or make another pick.

**Painting**

*Painting* means dragging the mouse on visible geometry to select more than one entity. A pick is a trivial case of painting. Without holding the [CTRL] key down, painting picks all appropriate geometry touched by the pointer.

**Depth Picking**

*Depth Picking* allows you to pick geometry through the Z-order behind the blip.

Whenever a blip appears above a selection, the graphics window displays a stack of rectangles in the lower left corner. The rectangles are stacked in appearance, with the topmost rectangle representing the visible (selected) geometry and subsequent rectangles representing geometry hit by a ray normal to the screen passing through the blip, front to back. The stack of rectangles is an alternative graphical display for the selectable geometry. Each rectangle is drawn using the same edge and surface colors as its associated geometry.

Highlighting and picking behaviors are identical and synchronized for geometry and its associated rectangle. Moving the pointer over a rectangle highlights both the rectangle its geometry, and vice versa. [CTRL] key and painting behaviors are also identical for the stack. Holding the [CTRL] key while clicking rectangles picks or unpicks associated geometry. Dragging the mouse (Painting) along the rectangles picks geometry front-to-back or back-to-front.

**Selection Filters**

The mouse pointer in the graphics window is either in a *picking filter* mode or a *view control* mode. A latched button in the graphics toolbar indicates the current mode.
### The Extend Selection Command

The **Extend Selection** drop-down menu is enabled only for edge or face selection mode and only with a selection of one or more edges or faces. The following options are available in the drop-down menu:

- **Extend to Adjacent**
  - For **faces**, **Extend to Adjacent** searches for faces adjacent to faces in the current selection that meet an angular tolerance along their shared edge.
  - For **edges**, **Extend to Adjacent** searches for edges adjacent to edges in the current selection that meet an angular tolerance at their shared vertex.
- **Extend to Limits**

  - For faces, **Extend to Limits** searches for faces that are tangent to the current selection as well as all faces that are tangent to each of the additional selections within the part. The selections must meet an angular tolerance along their shared edges.

  - For edges, **Extend to Limits** searches for edges that are tangent to the current selection as well as all edges that are tangent to each of the additional selections within the part. The selections must meet an angular tolerance along their shared vertices.
For all options, you can modify the angle used to calculate the selection extensions in the **Options** dialog box setting **Extend Selection Angle Limit**, under the **Common Settings**.

### The Select Command

The **Select Mode** toolbar button allows you to select items designated by the Selection Filters through the **Single Select** or **Box Select** drop-down menu options.

- **Single Select** (default): Click on an item to select it.
- **Box Select**: Define a box that selects filtered items. When defining the box, the *direction* that you drag the mouse from the starting point determines what items are selected, as shown in the following figures:
  - Dragging to the **right** to form the box selects entities that are *completely* enclosed by the box.
  - **Visual cue**: 4 tick marks completely inside the box.
Dragging to the left to form the box selects all entities that touch the box.

**Visual cue:** 4 tick marks that cross the sides of the box.

You can use the [CTRL] key for multiple selections in both modes.

**Viewports**

The **Viewports** toolbar button allows you to split the graphics display into a maximum of four simultaneous views. You can see multiple viewports in the Section: Geometry window when any object in the tree is in focus except Project. You can choose one, horizontal, vertical, or four viewports. Each viewport can have separate camera angles, labels, titles, backgrounds, etc. Any action performed when viewports are selected will occur only to the active viewport. For example, if you animate a viewport, only the active viewport will be animated, and not the others.

A figure can be viewed in a single viewport only. If multiple viewports are created with the figure in focus, all other viewports display the parent of the figure.

*Note* — Each viewport has a separate Slice tool, and therefore separate Draw Slice Plane. The concept of copying a Slice Plane from one window to the next does not exist. If you want Slice Planes in a new window, you must create them in that window.

Viewports are not supported in sequenced simulations.
Graph Chart Control

The following controls are available for Graphs/Charts in these areas: Section : Convergence, Parameter Manager Variable Graphs, and Section : Fatigue Overview result items.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan</td>
<td>[Right Mouse Button]</td>
</tr>
<tr>
<td>Zoom</td>
<td>[Middle Mouse Button]</td>
</tr>
<tr>
<td>Box Zoom</td>
<td>[[Alt]Left Mouse Button]</td>
</tr>
<tr>
<td>Rotate (3D only)</td>
<td>[Left Mouse Button]</td>
</tr>
<tr>
<td>Perspective Angle (3D only)</td>
<td>[[Shift]Left Mouse Button]</td>
</tr>
<tr>
<td>Display Coordinates (2D only)</td>
<td>[[Ctrl]Left Mouse Button] along graph line</td>
</tr>
</tbody>
</table>

Tips for working with graphs and charts:

- Some features are not available for certain graphs.
- Zoom will zoom to or away from the center of the graph. Pan so that your intended point of focus is in the center prior to zooming.
- If the graph has a Pan/Zoom control box, this can be used to zoom (shrink box) or pan (drag box).
- Double-clicking the Pan/Zoom control box will return it to its maximum size.

Details View

The Details View is located in the bottom left corner of the window. It provides you with information and details that pertain to the object selected in the Section : Tree Outline. Some selections require you to input information (e.g., force values, pressures). Some selections are drop-down dialogs, which allow you to select a choice. Fields may be grayed out. These cannot be modified.

The following example illustrates the Details View for the object called Geometry.
For more information, see:

Features
Header
Categories
Undefined or Invalid Fields
Decisions
Text Entry
Ranges
Increments
Geometry
Exposing Fields as Parameters
Callouts
Options
Features

The Details View allows you to enter information that is specific to each section of the Tree Outline. It automatically displays details for branches such as Geometry, Model, Contact, etc. Features of the Details View include:

- Collapsible bold headings.
- Dynamic cell background color change.
- Row selection/activation.
- Auto-sizing/scrolling.
- Sliders for range selection.
- Combo boxes for boolean or list selection.
- Buttons to display dialog box (e.g. browse, color picker).
- Apply / Cancel buttons for geometry selection.
-Obsolete items are highlighted in red.

Header

The header identifies the control and names the current object.

The header is not a windows title bar; it cannot be moved.

Categories

Category fields extend across both columns of the Details Pane:

This allows for maximum label width and differentiates categories from other types of fields. To expand or collapse a category, double-click the category name.
Undefined or Invalid Fields

Fields whose value is undefined or invalid are highlighted in yellow:

<table>
<thead>
<tr>
<th>Details of &quot;Pressure&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scope</strong></td>
</tr>
<tr>
<td>Scoping Method</td>
</tr>
<tr>
<td>Geometry</td>
</tr>
<tr>
<td><strong>Definition</strong></td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Magnitude</td>
</tr>
<tr>
<td>Suppressed</td>
</tr>
</tbody>
</table>

Decisions

Decision fields control subsequent fields:

<table>
<thead>
<tr>
<th>Details of &quot;Force&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scope</strong></td>
</tr>
<tr>
<td>Scoping Method</td>
</tr>
<tr>
<td>Geometry</td>
</tr>
<tr>
<td><strong>Definition</strong></td>
</tr>
<tr>
<td>Define By</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Magnitude</td>
</tr>
<tr>
<td>Suppressed</td>
</tr>
</tbody>
</table>

Note — The left column always adjusts to fit the widest visible label. This provides maximum space for editable fields in the right column. You can adjust the width of the columns by dragging the separator between them.

Text Entry

Text entry fields may be qualified as strings, numbers, or integers. Units are automatically removed and replaced to facilitate editing:
Inappropriate characters are discarded (for example, typing a Z in an integer field). A numeric field cannot be entered if it contains an invalid value. It is returned to its previous value.

**Ranges**

If a numeric field has a range, a slider appears to the right of the current value:

If the value changes, the slider moves; if the slider moves the value updates.

**Increments**

If a numeric field has an increment, a horizontal up/down control appears to the right of the current value:
The up/down control behaves the same way a slider does.

**Geometry**

Geometry fields filter out inappropriate selection modes. For example, a bearing load can only be scoped to a face. Geometries other than face will not be accepted.

Direction fields require a special type of selection:

Clicking **Apply** locks the current selection into the field. Other gestures (clicking **Cancel** or selecting a different object or field) do not change the field's preexisting selection.

**Exposing Fields as Parameters**

A P appears beside the name of each field that may be treated as a parameter. Clicking the box exposes the field as a parameter. For more information, see Section : Parameters.
Callouts

Callouts provide specific information and instructions for fields within the control:

<table>
<thead>
<tr>
<th>Details of &quot;Pressure&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scope</strong></td>
</tr>
<tr>
<td>Scoping Method</td>
</tr>
<tr>
<td><strong>Geometry</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Definition</strong></td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Magnitude</td>
</tr>
<tr>
<td>Suppressed</td>
</tr>
</tbody>
</table>

Options

Option fields allow you to select one item from a short list. Options work the same way as Decisions, but don’t affect subsequent fields. Options are also used for boolean choices (true/false, yes/no, enabled/disabled, fixed/free, etc.) Double-clicking an option automatically selects the next item down the list.

Selecting an option followed by an ellipsis causes an immediate action. In this case, **Import...** allows selection of a material not already in the list:

Worksheet Tab

The **Worksheet** tab contains predominately tabular or text data (but may also contain graphical data) about the following types of Simulation objects:
• Geometry
• Coordinate Systems
• Contact
• Environment
• Tabular Loads
• Harmonic loads
• Fatigue Tool
• Contact Tool
• Frequency Finder
• Buckling Tool
• Solution Information
• Solution Combination
• Parameter Manager
• Variable Graph
• Contact Tool reactions
• Harmonic Tool
  – Frequency and phase response results
• Any result except contact result scoped to an edge
• Commands
• Transient Settings

**Figure 1  A Worksheet Tab View of a Geometry Folder**

![Worksheet Tab View of a Geometry Folder]

**Displaying Information**  The Worksheet tab lists the information for child objects of an Outline Tree's folder. The information can be displayed graphically for comparison. For example, with harmonic loads you can select multiple loads to compare to one another for variance. Also, for all load and support objects listed under the Environment folder (except rotations and accelerations), the Worksheet tab displays a Time View -- a graph of that object's value vs. time.

**Go To Selected items**  A useful feature in the worksheets associated with most of the folders mentioned above is the ability to instantly select items in the tree that you pick in the Name column (leftmost column) on the worksheet. The graphical equivalents of the items also display in the Geometry window. This feature allows you to quickly change properties in the Details View, and is available for worksheets associated with the Geometry, Coordinate Systems, Contact, Environment, Frequency, and Buckling folders.
To use this feature, select one or more items in the **Name** column of the worksheet (standard Windows controls for multiple selection apply), right-click on one of the selected items and choose **Go To Selected Items in Tree**. The items are selected in the tree, and the **Geometry** window replaces the worksheet and displays graphics associated with the selected items. An example is shown here:

*The following is an animated GIF. Please view online if you are reading the PDF version of the help.*

![Diagram](image)

*Note — A weak spring reaction in the Environment worksheet has no equivalent in the **Environment** folder so choosing this item and then choosing **Go To Selected Items in Tree** has no effect.*

**Viewing Selected Columns for Contact** When viewing a worksheet from a **Contact** folder, or a **Contact Reactions** item (under a **Contact Tool** folder), you can choose which columns will display.

To choose the columns that will display, right mouse click anywhere inside the worksheet table. From the context menu, click on any of the column names. A check mark signifies that the column will appear. There are some columns in the **Contact** folder worksheet that will not always be shown even if you check them. For example, if all the contact regions have a **Pinball Region** set to **Program Controlled** and the **Pinball Radius** column is checked, **Pinball Radius** will not show because you have not set any of this data.

**Transient Settings Worksheet**

The **Transient Settings** worksheet is available for transient simulations. The worksheet contains information and setting options to prepare a model for a solution.
By default, the **Transient Settings** worksheet will define time step reset points based on significant load changes and will request results data at every time point used by the solver. If these settings are appropriate for your simulation, then no additional processing of data in this worksheet is required.

### Timeline Chart

The timeline chart presents a graphical representation of **Environment** loads as a function of time. The chart will display constant loads as well as time-history loads. The chart also contains a time increment legend that displays the solver settings for minimum time step ($\Delta T_{\text{min}}$), initial time step ($\Delta T_{\text{initial}}$), and maximum time step ($\Delta T_{\text{max}}$). These time step increments are scaled to the **Time** axis of the chart to give a visual reference to the time increment settings.
A context menu is available in the chart area. Use the right mouse button to display the following list of options available in the chart area:

- **Add Result**: Adds a result at a particular time point. Position the cursor at a time point where result data is desired. Choosing **Add Result** will add an orange marker to the **Time** axis indicating that results data will be available at this time point.

- **Delete All Results**: Deletes the requested time points for results data.

- **Add Manual Reset**: Selects a time point for resetting the time step size (**Step Reset**) to the initial time step. Choosing a time step reset is usually done at time points corresponding to significant time-varying load changes to accurately capture the time phenomena. The time point selected for rest is displayed with a white marker. The worksheet controls provide a convenient option to automatically select time step resets based on the time-varying load curves (**Automatic Step Resets**). Automatic reset points are displayed with a blue marker. **Automatic** and **Manual** time step resets may be active simultaneously.

- **Delete Manual Resets**: Deletes manual time step reset points.

The chart area supports selection of time points over a time range. Use the left mouse button to drag over a time range within the chart area. The dragged area will highlight in blue. Pressing the right mouse button presents several context menus: **Add** and **Delete** options for **Results Sets** and time step reset points operating within the selected time range. A **Zoom to Fit** option will zoom the chart such that the requested time range fills the chart area. A **Zoom to Fit** context menu option will allow you to return to the original timeline range.

**Step Reset Constraints** are shown in gray at the top of the chart. Time points within the time ranges highlighted in gray cannot be selected for time step reset points.

**Result Set Constraints** are shown in gray at the bottom of the chart. Time points within the time ranges highlighted in gray cannot be selected for results data.

Load data is viewed in the chart for loads defined in the **Environment** object. Loads of a mixed type (i.e., **Temperature** and **Heat Flux**) are normalized along the vertical axis. Loads of a similar type are shown to scale. Use the timeline legend to control visibility of load data.

Below the time axis on the chart is a display of the solution point markers. This is only visible after a solution. The black markers indicate the time points where a solution occurred. This can be used as a reference to visually check the frequency and location of solution points relative to the time-history loads. The black markers only appear if **Result Sets** is set to **Manual** in the Worksheet Controls, as discussed in the next section.
Worksheet Controls

The worksheet controls section of the worksheet provides options for automatically creating time step reset points and for selecting time points where results output will be made available.

- The **Automatic Step Resets** slider control selects critical time points where the solver resets the time increment to the initial time step value. Use this control to capture the transient response to a sharp change in loads. By default, the slider control is set mid-span and will pick up time step reset time points for severe load changes. You can adjust the slider to be more or less aggressive in selecting time points. You can select automated time points in conjunction with manually defined time points using the context menu in the chart area.

- The **Result Sets** control enables you to select the time points where you wish the solver to compute results data. By default, the program will compute results at all solution time points (**Automatic** option). You can use the **Manual** option to select equally spaced time points over a time range. You may issue the **Manual** option several times, allowing for multiple selections of result time points.

- Choosing the **Reset** button allows you to restore the default settings for both the **Automatic Step Resets** and **Result Sets** time points. You can also clear the manual results sets using a context menu option in the chart area.

- After completing a solution, the **Transient Settings** worksheet is in a "locked" mode where options cannot be changed. This is done to keep the settings in line with the current results. If you wish to change the options to prepare for another run, choose the **Unlock** button.
Timeline Grid

The timeline grid is a non-editable record of the time Step Reset points and Results Set points.

Timeline Legend

The timeline legend lists the Environment loads for the simulation. Checkboxes in the Visible column control the display of the load in the chart. Checkboxes in the Active column control which loads are to be used to determine the automatic time step reset points that you set with the Automatic Step Resets slider control in the Worksheet Controls.

The Curve and Type columns include load data (circles) and Result Tracker data (triangles), including the two Result Tracker objects that are displayed by default for a transient simulation: minimum temperature (RTMin) and maximum temperature (RTMax).

Note — If you duplicate the Environment, the checkbox status in the Active column will be duplicated only for the load data because the Result Tracker data does not affect the Results Set or Step Reset points.
Parameters

To parameterize a variable, click the box next to it. A P appears in the box. Items that cannot be parameterized do not display a check box and are left-aligned to save space.

The boxes that appear in Simulation apply only to the Simulation Parameter Manager. Checking or unchecking these boxes will have no effect on which CAD parameters are transferred to DesignXplorer.

For more information, see Section: Parameters.

Toolbars

Toolbars are displayed across the top of the window, below the menu bar. Toolbars can be docked to your preference. The layouts displayed are typical. You can double-click the vertical bar in the toolbar to automatically move the toolbar to the left.

Main Menu

The Main Menu includes the following items. Click a menu item to see a description of the tasks associated with that item.

<table>
<thead>
<tr>
<th>Menu Command</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>New</td>
<td>Establishes a new file.</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>Opens an existing file.</td>
</tr>
<tr>
<td></td>
<td>Close Simulation</td>
<td>Exits the Simulation session (Simulation tab is removed).</td>
</tr>
<tr>
<td></td>
<td>Save</td>
<td>Allows you to save the file.</td>
</tr>
<tr>
<td></td>
<td>Save As</td>
<td>Allows you to save the file under a different name and to a different path location.</td>
</tr>
<tr>
<td></td>
<td>Clean</td>
<td>Clears all results and meshing data from the database depending on the object selected in the tree.</td>
</tr>
<tr>
<td>Menu Command</td>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td><strong>Duplicate</strong></td>
<td>Duplicates the object you highlight. For example, if you highlight Environment and click Duplicate, another Environment is inserted into the Outline.</td>
</tr>
<tr>
<td></td>
<td><strong>Copy</strong></td>
<td>Copies an object.</td>
</tr>
<tr>
<td></td>
<td><strong>Cut</strong></td>
<td>Cuts the object and saves it for pasting.</td>
</tr>
<tr>
<td></td>
<td><strong>Paste</strong></td>
<td>Pastes a cut or copied object.</td>
</tr>
<tr>
<td></td>
<td><strong>Delete</strong></td>
<td>Deletes the object you select.</td>
</tr>
<tr>
<td></td>
<td><strong>Select All</strong></td>
<td>Selects all items in the Model of the current selection filter type. Select All is also available in a context menu if you click the right mouse button in the Geometry window.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td><strong>Physics Filter</strong></td>
<td>Enables toolbar and menu options that apply to chosen type of physics.</td>
</tr>
<tr>
<td></td>
<td><strong>Simulation Wizard</strong></td>
<td>Displays a wizard on the right side of the window which prompts you to complete tasks required for an analysis.</td>
</tr>
<tr>
<td></td>
<td><strong>Named Selection Toolbar</strong></td>
<td>Displays the Section : Named Selection Toolbar</td>
</tr>
<tr>
<td></td>
<td><strong>Unit Conversion Toolbar</strong></td>
<td>Displays the Section : Unit Conversion Toolbar</td>
</tr>
<tr>
<td></td>
<td><strong>Triad</strong></td>
<td>Shows / Hides Triad.</td>
</tr>
<tr>
<td></td>
<td><strong>Ruler</strong></td>
<td>Shows / Hides Ruler.</td>
</tr>
<tr>
<td></td>
<td><strong>Legend</strong></td>
<td>Shows / Hides Legend.</td>
</tr>
<tr>
<td></td>
<td><strong>Reset Tree</strong></td>
<td>Restores tree objects to their original state.</td>
</tr>
<tr>
<td></td>
<td><strong>Collapse to Model</strong></td>
<td>Collapses all tree objects under the Model object(s).</td>
</tr>
<tr>
<td></td>
<td><strong>Collapse to Environment</strong></td>
<td>Collapses all tree objects under the Environment object(s).</td>
</tr>
<tr>
<td></td>
<td><strong>Restore Original Window Layout</strong></td>
<td>Displays the same layout used as when you started Simulation</td>
</tr>
<tr>
<td><strong>Insert</strong></td>
<td><strong>Model Item</strong></td>
<td>Inserts a Model item.</td>
</tr>
<tr>
<td></td>
<td><strong>Geometry Item</strong></td>
<td>Inserts a Point Mass or a Commands Object.</td>
</tr>
<tr>
<td></td>
<td><strong>Environment Item</strong></td>
<td>Inserts an Environment item.</td>
</tr>
<tr>
<td></td>
<td><strong>Solution Item</strong></td>
<td>Inserts a Solution item.</td>
</tr>
<tr>
<td></td>
<td><strong>Outline Branch</strong></td>
<td>Inserts a complete outline branch from the current point in the outline.</td>
</tr>
<tr>
<td></td>
<td><strong>Figure</strong></td>
<td>Inserts a Figure.</td>
</tr>
<tr>
<td></td>
<td><strong>Comment</strong></td>
<td>Inserts a Comment.</td>
</tr>
<tr>
<td></td>
<td><strong>Convergence</strong></td>
<td>Adds convergence control to a solution item.</td>
</tr>
<tr>
<td></td>
<td><strong>Alert</strong></td>
<td>Inserts an alert on a solution item.</td>
</tr>
<tr>
<td></td>
<td><strong>Template</strong></td>
<td>Allows you to import a template file (.dst).</td>
</tr>
<tr>
<td></td>
<td><strong>Parameter Item</strong></td>
<td>Inserts the Parameter Manager or a Variable Graph.</td>
</tr>
<tr>
<td></td>
<td><strong>Units</strong></td>
<td>Metric: m, kg, Pa, °C, s, V, A</td>
</tr>
<tr>
<td>Units</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>Metric</td>
<td>cm, g, dyne, °C, s, V, A</td>
<td></td>
</tr>
<tr>
<td>Metric</td>
<td>mm, kg, N, °C, s, mV, mA</td>
<td></td>
</tr>
<tr>
<td>U.S. Customary</td>
<td>ft, lbm, lbf, °F, s, V, A</td>
<td></td>
</tr>
<tr>
<td>U.S. Customary</td>
<td>in, lbm, lbf, °F, s, V, A</td>
<td></td>
</tr>
<tr>
<td>Degrees</td>
<td>Sets angle units to degrees.</td>
<td></td>
</tr>
<tr>
<td>Radians</td>
<td>Sets angle units to radians.</td>
<td></td>
</tr>
<tr>
<td>rad/s</td>
<td>Sets angular velocity units to radians per second.</td>
<td></td>
</tr>
<tr>
<td>RPM</td>
<td>Sets angular velocity units to revolutions per minute.</td>
<td></td>
</tr>
</tbody>
</table>

### Menu Command | Function | Description
--- | --- | ---
**Tools** | Solve | Solves the simulation for the current level in the outline down.
| Write ANSYS Input File | Writes an ANSYS input file from the active solution branch. This option does not initiate a Solve.
| Addins | Launches the Addins manager dialog that allows you to load/unload third-party add-ins that are specifically designed for integration within the Workbench environment.
| Options | Allows you to customize the application and to control the behavior of Simulation functions.
| Variable Manager | Allows you to enter an application variable.
| Simulation Wizard Editor | Opens the Simulation Wizard Editor.
| Run Macro | Opens a dialog box to locate a script (.vbs, .js) file.

### Help
- **ANSYS Simulation Help**
  - Displays the Help system in another browser window.
- **Installation and Licensing**
  - Displays the Installation and Licensing Help in another browser window.
- **About ANSYS Simulation**
  - Provides information about your system and the program.

### Standard Toolbar

The Standard Toolbar contains application-level commands, configuration toggles and important general functions. Each icon button and its description follows:

<table>
<thead>
<tr>
<th>Icon Button</th>
<th>Application-level command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon" alt="New" /></td>
<td>New</td>
<td>Establishes a new file.</td>
</tr>
<tr>
<td><img src="icon" alt="Open" /></td>
<td>Open</td>
<td>Opens an existing file.</td>
</tr>
<tr>
<td><img src="icon" alt="Save" /></td>
<td>Save</td>
<td>Standard Windows functions.</td>
</tr>
<tr>
<td><img src="icon" alt="Save As" /></td>
<td>Save As</td>
<td>Standard Windows functions.</td>
</tr>
<tr>
<td>Icon Button</td>
<td>Application-level command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>----------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Simulation Wizard" /></td>
<td>Simulation Wizard</td>
<td>Activates the Simulation Wizard in the user interface.</td>
</tr>
<tr>
<td><img src="image" alt="Data" /></td>
<td>Data</td>
<td>Transfers to the Engineering Data for viewing or editing material properties and convection data.</td>
</tr>
<tr>
<td><img src="image" alt="Solve" /></td>
<td>Solve</td>
<td>Solves the branch from the current outline object down.</td>
</tr>
<tr>
<td><img src="image" alt="Comment" /></td>
<td>Comment</td>
<td>Adds a comment within the currently highlighted outline branch.</td>
</tr>
<tr>
<td><img src="image" alt="Section : Figures" /></td>
<td>Section : Figures</td>
<td>Adds an image within the currently highlighted outline branch.</td>
</tr>
<tr>
<td><img src="image" alt="Image Capture" /></td>
<td>Image Capture</td>
<td>Saves the current graphics image to a file (.png, .jpg, .tif, .bmp, .eps).</td>
</tr>
</tbody>
</table>

### Graphics Toolbar

The **Graphics Toolbar** sets the selection/manipulation mode for the cursor in the graphics window. The toolbar also provides commands for modifying a selection or for modifying the viewpoint. Each icon button and its description follows:

<table>
<thead>
<tr>
<th>Icon Button</th>
<th>Tool Tip Name Displayed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Select Mode" /></td>
<td>Select Mode</td>
<td>Sets selection as either Single Select or Box Select; used in conjunction with the selection filters.</td>
</tr>
<tr>
<td><img src="image" alt="Label" /></td>
<td>Label</td>
<td>Manages annotations.</td>
</tr>
<tr>
<td><img src="image" alt="Direction" /></td>
<td>Direction</td>
<td>Chooses a direction by selecting either a single face, two vertices, or a single edge (enabled only when <strong>Direction</strong> field in the Details View has focus). See Pointer Modes.</td>
</tr>
<tr>
<td><img src="image" alt="Coordinates" /></td>
<td>Coordinates</td>
<td>(Active only if you are setting a location, for example, a local coordinate system.) Enables the exterior coordinates of the model to display adjacent to the cursor and updates the coordinate display as the cursor is moved across the model. If you click with the cursor on the model, a label displays the coordinates of that location.</td>
</tr>
<tr>
<td><img src="image" alt="Vertex" /></td>
<td>Vertex</td>
<td>Designates vertices only for picking or viewing selection.</td>
</tr>
<tr>
<td><img src="image" alt="Edge" /></td>
<td>Edge</td>
<td>Designates edges only for picking or viewing selection.</td>
</tr>
<tr>
<td><img src="image" alt="Face" /></td>
<td>Face</td>
<td>Designates faces only for picking or viewing selection.</td>
</tr>
<tr>
<td><img src="image" alt="Body" /></td>
<td>Body</td>
<td>Designates bodies only for picking or viewing selection.</td>
</tr>
<tr>
<td><img src="image" alt="Extend Selection" /></td>
<td>Extend Selection</td>
<td>Adds adjacent surfaces (or edges) within angle tolerance, to the currently selected surface (or edge) set, or adds tangent surfaces (or edges) within angle tolerance, to the currently selected surface (or edge) set.</td>
</tr>
<tr>
<td>Icon Button</td>
<td>Tool Tip Name Displayed</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>🔄</td>
<td>Rotate</td>
<td>Activates rotational controls based on the positioning of the mouse cursor.</td>
</tr>
<tr>
<td>🔄</td>
<td>Pan</td>
<td>Moves display model in the direction of the mouse cursor.</td>
</tr>
<tr>
<td>🧐</td>
<td>Zoom</td>
<td>Displays a <em>closer</em> view of the body by dragging the mouse cursor vertically toward the <em>top</em> of the graphics window, or displays a <em>more distant</em> view of the body by dragging the mouse cursor vertically toward the <em>bottom</em> of the graphics window.</td>
</tr>
<tr>
<td>🎉</td>
<td>Box Zoom</td>
<td>Displays selected area of a model in a box that you define.</td>
</tr>
<tr>
<td>🧐</td>
<td>Fit</td>
<td>Fits the entire model in the graphics window.</td>
</tr>
<tr>
<td>🧐</td>
<td>Toggle Magnifier Window On/Off</td>
<td>Displays a Magnifier Window, which is a shaded box that functions as a magnifying glass, enabling you to zoom in on portions of the model. When you toggle the Magnifier Window on, you can:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <em>Pan</em> the Magnifier Window across the model by holding down the <em>left</em> mouse button and dragging the mouse.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <em>Increase the zoom</em> of the Magnifier Window by adjusting the <em>mouse wheel</em>, or by holding down the <em>middle</em> mouse button and dragging the mouse upward.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <em>Recenter</em> or <em>resize</em> the Magnifier Window using a <em>right</em> mouse button click and choosing an option from the context menu. Recenter the window by choosing <em>Reset Magnifier</em>. Resizing options include <em>Small Magnifier</em>, <em>Medium Magnifier</em>, and <em>Large Magnifier</em> for preset sizes, and <em>Dynamic Magnifier Size On/Off</em> for gradual size control accomplished by adjusting the <em>mouse wheel</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Standard model zooming, rotating, and picking are disabled when you use the Magnifier Window.</td>
</tr>
<tr>
<td>🧐</td>
<td>Previous View</td>
<td>See <em>Previous View</em> under Workbench Graphics Controls.</td>
</tr>
<tr>
<td>🧐</td>
<td>Next View</td>
<td>See <em>Next View</em> under Workbench Graphics Controls.</td>
</tr>
<tr>
<td>🧐</td>
<td>Set (ISO)</td>
<td>See <em>Isometric View</em> under Workbench Graphics Controls.</td>
</tr>
<tr>
<td>🧐</td>
<td>Look at</td>
<td>Centers the display on the currently selected face or plane.</td>
</tr>
<tr>
<td>🧐</td>
<td>Wireframe</td>
<td>Displays model as a wireframe (recommended for seeing gaps in surfaces).</td>
</tr>
<tr>
<td>🧐</td>
<td>Viewports</td>
<td>Splits the graphics display into a maximum of four simultaneous views.</td>
</tr>
</tbody>
</table>
Context Toolbar

The **Context Toolbar** occupies the 2nd row of toolbars. The Context Toolbar configures its buttons based on the type of object selected in the Section : Tree Outline. The Context Toolbar makes a limited number of relevant choices more visible and readily accessible.

Context Toolbars include:

- Project Context Toolbar
- Model Context Toolbar
- Geometry Context Toolbar
- Virtual Topology Context Toolbar
- Contact Context Toolbar
- Meshing Context Toolbar
- Gap Tool Context Toolbar
- Environment Context Toolbar
- Solution Context Toolbar
- Vectory Display Context Toolbar
- Result Context Toolbar
- Capped Isosurface Context Toolbar
- Animation Context Toolbar
- Comment Context Toolbar
- Print Preview Context Toolbar
- Report Preview Context Toolbar

**Note** —

- Drop-down menus from Context Toolbar buttons display the same submenu from the corresponding item under Insert in the Section : Main Menu.
- Some Context Toolbar items, such as Contact or Mesh Controls, can be hidden.
- The Context Toolbar cannot be hidden (for simplicity and to avoid jumbling the screen). The toolbar appears blank when no options are relevant.
- The toolbar displays a text label for the current set of options.
- An **Options** dialog box setting turns off button text labels to minimize context toolbar width.

Most context toolbars include the button ![Jump Up One Level](image) to jump “Up One Level.” The command selects the parent of the current object in the Outline. In most cases this button changes the contents of the context toolbar.

**Project Context Toolbar**

The Project Context toolbar becomes active when **Project** is selected in the tree. From the Project Context toolbar you can create a new **Model** branch in the tree.
Model Context Toolbar

The Model Context toolbar becomes active when a Model is selected in the tree. The Model Context toolbar contains options to attach or update geometry, create virtual topology, create a coordinate systems branch and define one or more solution combinations.

Geometry

Choosing the Geometry option allows you to attach geometry by listing recently used geometry files or by allowing you to choose a file from a directory. You can also update geometry using parameter values.

Virtual Topology

You can use the Virtual Topology option to reduce the number of elements in a model by merging surfaces and lines. This is particularly helpful when small surfaces and lines are involved. The merging will impact meshing and selection for loads and supports. See Virtual Topology Overview for details.

Contact

You can transfer structural loads and heat flows across the contact boundaries and “connect” the various parts. See the Contact section for details. The Contact button is available only if a Contact object is not already in the tree (such as a model that is not an assembly), and you wish to create a Contact object.

Coordinate Systems

All geometry is displayed in the world (global) coordinate system by default. To create a new unique coordinate system, select the Coordinate Systems button from the toolbar, which inserts a Coordinate System folder into the Section : Tree Outline. The folder includes one Global Coordinate System object by default. You can then insert one or more local coordinate system objects to the Coordinate Systems folder. You define the Type of local coordinate system as either Cartesian or Cylindrical in the Section : Details View. You then define the Origin through one of the methods.

- Selecting any point on the exterior of the model:
  1. Choose Click to Change in the Origin row.
  2. Depress the Coordinate toolbar button.
  3. Move the cursor across the model and notice that the coordinates display and update as you reposition the cursor.
  4. Click at the desired origin location. A label displays the coordinates at this location. You can click again to change the label location.
  5. Click Apply. A coordinate system symbol displays at the origin location. Also, the coordinates display in the Details View. You can change the location by repositioning the cursor, clicking at the new location, and then clicking Apply, or by editing the coordinates in the Details View.

- Selecting a topology:
  1. Select a vertex or vertices, edge, face, cylinder, circle, or circular arc.
  2. Choose Click to Change in the Origin row.
3. Click **Apply**. A coordinate system symbol displays at the origin location as determined by the following:

- Select a vertex. The origin will be on the vertex.
- Select multiple vertices. The origin will be at the center of the area or volume enclosed by the selected vertices.
- Select a face or an edge. The origin will be at the centroid of the face or edge.
- Select a cylinder. The origin will be at the center of the cylinder.
- Select a circle or a circular arc. The origin will be at the center of the circle or circular arc.

Preselecting one or more topologies and then inserting a **Coordinate System** will automatically locate its origin as stated above.

- Entering the coordinates directly in the Details View. The origin will be at this location.

Coordinate systems defined when geometry is imported from DesignModeler, Pro/ENGINEER, or SolidWorks will automatically be created in Simulation. For more information, see the **Attaching Geometry** section under DesignModeler, or see the **Notes** section under Pro/ENGINEER or SolidWorks.

Any local coordinate systems that were created in Simulation, or imported from DesignModeler, Pro/ENGINEER, or SolidWorks, can be applied to a part, or to a Point Mass, Acceleration, Standard Earth Gravity, Rotational Velocity, Force, Bearing Load, Remote Force, Remote Displacement, Moment, Displacement, or Contact Reaction using the **Coordinate System** menu in the Details View of the particular part, load, Displacement, or Contact Reaction.

Through an **Options** dialog box Simulation setting for Export, you can specify your results to automatically open in Excel when exporting. When exporting results (see Section : Exporting Data) for a particular result object, that object’s scope and coordinate system will be taken into account. You may save the results in three different formats:

- Excel (.xls)
- Text (.txt)
- all files (.*) where you can specify the extension

Options are also available for transferring coordinate systems to ANSYS.

**Solution Combination**

Use the Solution Combination option to combine multiple environments and solutions to form a new solution. A solution combination folder can be used to linearly combine the results from an arbitrary number of load cases (environments). Note that the environments must be structural static with no solution convergence. Results such as stress, elastic strain, displacement, contact, and fatigue may be requested. To add a load case to the solution combination folder, right click on the worksheet view of the solution combination folder, choose add, and then select the scale factor and the environment name. An environment may be added more than once and its effects will be cumulative. You may suppress the effect of a load case by using the check box in the worksheet view or by deleting it through a right click. For more information, see Section : Solution Combinations.

**Geometry Context Toolbar**
The Geometry Context toolbar is active when you select the **Geometry** branch in the tree or any items within the **Geometry** branch. The **Geometry** button functions the same as it does under the Model Context toolbar. Using the Geometry toolbar you can also apply a **Point Mass**.

**Virtual Topology Context Toolbar**

The Virtual Topology Context toolbar includes an option to insert **Virtual Cell** objects where you can group surfaces or edges.

**Contact Context Toolbar**

The Contact Context toolbar contains options to insert a spot weld or a manual contact region.

**Meshing Context Toolbar**

The Meshing Context toolbar allows you to add the Mesh Controls option to your model, or view feedback from the mesher (grayed out if the mesher gathered no warnings or errors).

**Gap Tool Context Toolbar**

The Gap Tool Context toolbar is used to have Simulation search for face pairs within a specified gap distance that you specify.

**Environment Context Toolbar**

The Environment Context toolbar allows you to choose a simulation type, and apply Structural Loads (including displacements and global loads), Thermal Loads, or Section : Electromagnetic Boundary Conditions and Excitations to your model. One or more load types may not be displayed depending on the settings in the **Physics Filter** located in the **View** menu.

The toolbar display varies depending on the type of simulation you choose, as shown below.

- **Static** - Choose **Static** in the drop down menu and enter 1 in the **Steps** field:

  ![Environment Static Steps](image)

  - **Structural** - **Thermal** - **Electromagnetic**

- **Sequenced** - Choose **Static** in the drop down menu and enter the number of sequenced steps (any number greater than 1) in the **Steps** field:

  ![Environment Static Steps](image)

  - **Structural** - **Thermal** - **Electromagnetic**

- **Harmonic** - Choose **Harmonic** in the drop down menu. There is no other field in the toolbar:

  ![Environment Harmonic](image)

  - **Structural** - **Thermal** - **Electromagnetic**
• **Transient** - Choose **Transient** in the drop down menu and enter the final time of interest in the **End Time** field:

![Environment Transient End Time](image)

### Solution Context Toolbar

The Solution toolbar applies to Solution level objects that either:

- Never display contoured results (such as the Solution object), or
- Have not yet been solved (no contours to display).

A portion of the toolbar display varies depending on the type of simulation you choose, displaying the same information as the **Environment** context toolbar.

Objects created via the **Solution** toolbar are automatically selected in the Outline. Prior to a solution this toolbar always remains in place (no contours to display). Structural and/or thermal result types may not be displayed, depending on the settings in the **Physics Filter** located in the **View** menu.

A table in the Results section indicates which bodies can be represented by the various choices available in the drop-down menus of the Solution toolbar.

Inserting some other tools changes the solution context toolbar to other toolbars (e.g., **Solution Information**).

### Result Context Toolbar

The Result toolbar applies to Solution level objects that display contour or vector results.

### Scaling Deformed Shape

For results with an associated deformed shape, the Scaling combo box provides control over the on-screen scaling:

![Scaling Deformed Shape](image)

Scale factors precede the descriptions in parentheses in the list. The scale factors shown above apply to a particular model’s deformation and are intended only as an example. Scale factors vary depending on the amount of deformation in the model.

You can choose a preset option from the list or you can type a customized scale factor relative to the scale factors in the list. For example, based on the preset list shown above, typing a customized scale factor of 0.6 would equate to approximately 3 times the **Auto Scale** factor.
Simulation Basics

- **Undeformed** does not change the shape of the part or assembly.
- **True Scale** is the actual scale.
- **Auto Scale** scales the deformation so that it’s visible but not distorting.
- The remaining options provide a wide range of scaling.

The system maintains the selected option as a global setting like other options in the Result toolbar.

As with other presentation settings, figures override the selection.

For results that are not scaled, the combo box has no effect.

**Relative Scaling**

The combo list provides five “relative” scaling options. These options scale deformation automatically relative to preset criteria:

- **Undeformed**
- **True Scale**
- **0.5x Auto**
- **Auto Scale**
- **2x Auto**
- **5x Auto**

**Legend**

When you choose the **Legend** button, a **Legend** dialog box appears that allows you to customize the default settings and appearance of the result contour legend. Refer to Customizing Result Legend for a description of the tasks you can perform within this dialog box.

**Geometry**

You can observe different views from the Geometry drop-down menu.

- **Exterior**
  This view displays the surface results of the selected geometry.
  - **IsoSurfaces**
  This view displays the interior only of the model at the transition point between values in the legend, as indicated by the color bands.
• **Capped IsoSurfaces**

This view displays contours on interior and exterior surfaces. When you choose **Capped IsoSurfaces**, a **Capped Isosurface** toolbar appears beneath the **Result** context toolbar. Refer to Capped Isosurfaces for a description of the controls included in the toolbar.

• **Slice Planes**

This view displays planes cutting through the result geometry; only previously drawn slice planes are visible. The model image changes to a wireframe representation.

**Contours Options**

To change the way you view your results, click any of the options on this toolbar.

- **Smooth**
  
  This view displays gradual distinction of colors.

- **Contour**
  
  This view displays the distinct differentiation of colors.

- **Isolines**
  
  This view displays a line at the transition between values.

- **Solid**
  
  This view displays the model only with no contour markings.

**Edges Options**

You can switch to wireframe mode to see gaps in surface models. Red lines indicate shared edges.

In addition, you can choose to view wireframe edges, include the deformed model against the undeformed model, or view elements.

Showing a subdued view of the undeformed model along with the deformed view is especially useful if you want to view results on the interior of a body yet still want to view the rest of the body's shape as a reference. An example is shown here.
The **Show Undeformed Model** option is useful when viewing any of the options in the Geometry drop-down menu.

- **No Wireframe**
  This view displays a basic picture of the body.

- **Show Undeformed Wireframe**
  This view shows the body outline before deformation occurred.

- **Show Undeformed Model**
  This view shows the deformed body with contours, with the undeformed body in translucent form.

- **Show Elements**
  This view displays element outlines.
**Vectory Display Context Toolbar**

Using the **Graphics** button, you can display results as vectors with various options for controlling the display.

- Click the **Graphics** button on the **Result** context toolbar to convert the result display from contours (default) to vectors.
- When in vector display, a **Vector Display** toolbar appears with controls as described below.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Displays vector length proportional to the magnitude of the result.</td>
</tr>
<tr>
<td></td>
<td>Displays a uniform vector length, useful for identifying vector paths.</td>
</tr>
<tr>
<td>Auto</td>
<td>Controls the relative length of the vectors in incremental steps from 1 to 10 (default = 5), as displayed in the tool tip when you drag the mouse cursor on the slider handle.</td>
</tr>
<tr>
<td></td>
<td>Displays all vectors, aligned with each element.</td>
</tr>
<tr>
<td></td>
<td>Displays vectors, aligned on an approximate grid.</td>
</tr>
<tr>
<td>Controls the relative size of the grid, which determines the quantity (density) of the vectors. The control is in uniform steps from 0 [coarse] to 100 [fine] (default = 20), as displayed in the tool tip when you drag the mouse cursor on the slider handle.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Displays vector arrows in line form.</td>
</tr>
<tr>
<td></td>
<td>Displays vector arrows in solid form.</td>
</tr>
</tbody>
</table>

- When in vector display, click the **Graphics** button on the **Result** context toolbar to change the result display back to contours. The **Vector Display** toolbar is removed.

Presented below are examples of vector result displays.
Uniform vector lengths identify paths using vector arrows in line form.

Course grid size with vector arrows in solid form.  
Same using wireframe edge option.
Uniform vector lengths, grid display on slice plane with vector arrows in solid form.

Zoomed-in uniform vector lengths, grid display with arrow scaling and vector arrows in solid form.

**Draw Slice Plane**

You can create a slice plane to display a section within the result geometry.
• Click the toolbar button and then drag the mouse across the part to create the Slice Plane. To view the newly created plane, rotate the model.
• You can construct additional Slice Planes by clicking and dragging additional lines across the model.
• To exit Draw Slice Plane mode, click the toolbar button again.

**Edit Planes**

You can use the **Edit Planes** toolbar button to display Slice Plane anchors.

• Click on the line on either side of the anchor to view the colored exterior on that side of the plane. This is called a “Capping Plane.” A dashed line indicates a Slice Place, a solid line denotes a Capping Plane. You cannot display a Slice Plane within a Capping Plane.
• Drag the Slice Plane or Capping Plane anchor to change the position of the plane.
• To maneuver between multiple planes, press the **TAB** key. You can also mouse over the square selection boxes. The active Slice Plane or Capping Plane displays a blue box within the anchor. Inactive planes display a white box. Locate the desired box and click to select. When your mouse is over a box, it turns red.
• To delete the selected Slice Plane or Capping Plane, press the [Delete] key. If you delete all of the planes, you'll be left with a wireframe model (you can then click the **Geometry** drop-down menu and select **Exterior**, or add new Slice Planes if you wish).
• To exit Edit Planes Mode, click the toolbar button again.

**Usage Tip:** To more fully grasp the new features of planes, you can experiment using different models.
Max, Min, and Probe Annotations

Toolbar buttons allow for toggling Max and Min annotations and for creating probe annotations.

See also Section: Annotations.

Animation Context Toolbar

The Animation toolbar allows you to control animation of the result and to export a movie file. To access the Animation toolbar, display a result plot in the Geometry window, then click on the Animation tab. The Animation toolbar replaces the Result toolbar. Refer to Results Animation for a description of the animation controls included in the toolbar.

Comment Context Toolbar

When you select a Comment object in the Outline, the Comment Context toolbar and Comment Editor appear. For more information about editing comments, refer to the Comment object reference.

Note — For UNIX versions of the product, you must first click the Pencil button before you can edit the comment. You must click the Pencil button again to close the editor.
Print Preview Context Toolbar

The Print Preview toolbar allows you to print the currently-displayed image, or send it to an e-mail recipient or to a Microsoft Word or PowerPoint file.

Report Preview Context Toolbar

The Report Preview toolbar allows you to select a language for the report and adjust the image resolution. The graphics browser exports images to a specific resolution (e.g. 512x384 pixels); the HTML page specifies the display resolution for images. By default the resolutions match. By increasing the resolution of the bitmap while holding the HTML resolution constant the print quality of image may be increased. The options below correspond to 100%, 200% and 400% image resolutions. Changing the language or the image quality setting forces regeneration of the HTML page.

You can also print the report, save it to a file, send it to an e-mail recipient or to a Microsoft Word or PowerPoint file, refresh the images, and adjust the font size.

Unit Conversion Toolbar

The Unit Conversion Toolbar is a built-in conversion calculator. It allows conversion between five consistent unit systems.

The Units menu sets the active unit system. The status bar shows the current unit system. The units listed in the toolbar and in the Section: Details View are in the proper form (i.e. no parenthesis).

The Unit Conversions toolbar is hidden by default. To see it, select View> Unit Conversion Toolbar.

Named Selection Toolbar

The Named Selection Toolbar contains options to group and control like-grouped items. It is available for use on all types of selections: vertices, edges, faces, and bodies.

Use named selections with large models to improve the visibility of selected parts. Named selections are automatically created in the event of a mesher failure so that problem surfaces can be identified.

To create a named selection in Simulation:

1. Select geometry items in the graphics window that are to be members of the named selection group. The controls in the Named Selection Toolbar remain grayed out until you select one or more items, or...

   Select one or more bodies under the Geometry tree object.

2. If you selected geometry items in the graphics window, click the Create Selection Group button (located on the left of the Named Selection Toolbar) or right mouse click in the Geometry window after a selection, and choose Create Selection Group in the context menu.
If you selected bodies under the **Geometry** tree object, right mouse click on one of the body objects and choose **Create Selection Group** in the context menu.

3. Type a name for the group (or accept a default name), in the **Selection Name** dialog box. A **Named Selections** branch object is added to the Simulation tree. The name of the selection appears as a selectable item in the **Named Selection** display (located to the right of the **Create Selection Group** button), and as an annotation on the selected graphic items that make up the group.

To use a named selection:

1. Select the name of the group in the **Named Selection** display.
2. Choose any of the following options that are available using the remaining controls in the Named Selection Toolbar:

   • **Selection** drop-down menu: controls selection options on items that are part of the group whose name appears in the **Named Selection** display.
     
     - **Select Items in Group**: selects only those items in the named group.
     
     - **Add to Current Selection**: Selects items in the named group combined with other items that are already selected. This option is grayed out if the geometry type in the named selection does not match the geometry type of the other selected items.
     
     - **Remove from Current Selection**: Removes the selection of items in the named group from other items that are already selected. Selected items that are not part of the group remain selected. This option is grayed out if the geometry type in the named selection does not match the geometry type of the other selected items.

     *Note* — Choosing any of these options affects only the current selections in the **Geometry** view. These options have no effect on what is included in the named selection itself.

   • **Visibility** drop-down menu: controls display options on bodies that are part of the group whose name appears in the **Named Selection** display.

     - **Hide Bodies in Group**: Turns off display of bodies in the named group (toggles with next item). Other bodies that are not part of the group are unaffected.
     
     - **Show Bodies in Group**: Turns on display of bodies in the named group (toggles with previous item). Other bodies that are not part of the group are unaffected.
     
     - **Show Only Bodies in Group**: Displays only items in the named group. Other items that are not part of the group are not displayed.

     You can also hide or show bodies associated with a named selection using a right mouse button click on the particular tree item under the **Named Selections** object and choosing **Hide** or **Show** from the context menu.

   • **Suppression** drop-down menu: controls options on items that affect if bodies of the group whose name appears in the **Named Selection** display are to be suppressed, meaning that, not only are they not displayed, but they are also removed from any treatment such as loading or solution.

     - **Suppress Bodies in Group**: Suppresses bodies in the named group (toggles with next item). Other bodies that are not part of the group are unaffected.
     
     - **Unsuppress Bodies in Group**: Unsuppresses bodies in the named group (toggles with previous item). Other bodies that are not part of the group are unaffected.
- **Unsuppress Only Bodies in Group**: Unsuppresses only bodies in the named group. Other bodies that are not part of the group are suppressed.

You can also suppress or unsuppress bodies associated with a named selection using a right mouse button click on the particular tree item under the Named Selections object and choosing Suppress or Unsuppress from the context menu. The Suppress and Unsuppress options are also available if you select multiple named selection items under a Named Selections object. The options will not be available if your multiple selection involves invalid conditions (for example, if you want to suppress multiple items you have selected and one is already suppressed, the Suppress option will not be available from the context menu.

The status bar shows the selected group area only when the areas are selected. The group listed in the toolbar and in the Section : Details View provides statistics that can be altered.

The Named Selection Toolbar is on by default and can be turned off or on by selecting **View> Named Selection Toolbar**.

You can import named selections that you defined in a CAD system or in DesignModeler. A practical use in this case is if you want the entities of the named selection group to be selected for the application of loads or boundary conditions.

To import a named selection from a CAD system or from DesignModeler:

1. On the Project Page, check **Named selections** and complete the name field; or, in the Geometry Details View under Preferences, set **Named Selection Processing** to **Yes** and complete the **Named Selection Prefixes** field (refer to these entries under Geometry Preferences for more details).

2. A Named Selections branch object is added to the Simulation tree. In the Named Selection Toolbar, the name of the selection appears as a selectable item in the Named Selection display (located to the right of the Create Selection Group button), and as an annotation on the graphic items that make up the group.

You can scope any of the following items to named selections: contact regions, mesh controls, loads, or supports.

To scope any of these items to a named selection:

1. Insert the item under the appropriate object:
   - Contact region under **Contact**.
   - Mesh control under **Mesh**.
   - Load or support under **Environment**.

2. Under the Details View, in the Scoping Method drop-down menu, choose **Named Selection**.

3. In the **Named Selection** drop-down menu, choose the particular name. For a contact region, there are two drop-down menus, one for **Contact** and one for **Target**.

**Notes on scoping items to a named selection:**

- Only valid named selections will show in the **Named Selection** drop-down menu. If there are no valid named selections, the drop-down menu will be empty. No two **Named Selections** branches can have the same name. It is recommended that you use unique and intuitive names for the **Named Selections**.

- If you change a named selection that is used by an item, the associated geometry will update accordingly.
• If you delete a named selection used by an item, the item becomes underdefined.
• If all the components in a named selection cannot be applied to the item, the named selection is not valid for that item. This includes components in the named selection that may be suppressed. For example, in the case of a bolt load scoped to cylindrical surfaces, only 1 cylinder can be selected for its geometry. If you have a named selection with 2 cylinders, one of which is suppressed, that particular named selection is still not valid for the bolt load.

Notes on conversion of Simulation named selection groups to ANSYS components:

When you write an ANSYS input file that includes a named selection group, the group is transferred to ANSYS as a component provided the name contains only standard English letters, numbers, and underscores. The following actions occur automatically to the group name in Simulation to form the resulting component name in ANSYS:

• A name exceeding 32 characters is truncated.
• A name that begins with a number is renamed to include “C_” before the number.
• Spaces between characters in a name are replaced with underscores.

Example: The named selection group in Simulation called 1 Edge appears as component C_1_Edge in the ANSYS input file.

Print Preview

Print Preview runs a script to generate an HTML page and image. The purpose of the Print Preview tab is to allow you to view your results or graphics image.
The title block is an editable HTML table. To change the information, double click inside the table.

The image is generated in the same way as figures in Report.

**Triad and Rotation Cursors**

The triad and rotation cursors allow you to control the viewing orientation as described below.
| Triad | • Located in lower right corner.  
|       | • Visualizes the world coordinate system directions.  
|       | • Positive directions arrows are labeled and color-coded. Negative direction arrows display only when you hover the mouse cursor over the particular region.  
|       | • Clicking an arrow animates the view such that the arrow points out of the screen.  
|       | • Arrows and the isometric sphere highlight when you point at them.  
|       | • Isometric sphere visualizes the location of the isometric view relative to the current view.  
|       | • Clicking the sphere animates the view to isometric.  

| Rotation Cursors | Click the **Rotate** button ![Rotate button](image.png) to display and activate the following rotation cursors:  
|                  | • ![Free rotation](image.png) Free rotation.  
|                  | • ![Roll](image.png) Rotation around an axis that points out of the screen (roll).  
|                  | • ![Yaw](image.png) Rotation around a vertical axis relative to the screen ("yaw" axis).  
|                  | • ![Pitch](image.png) Rotation around a horizontal axis relative to the screen ("pitch" axis).  

**Cursor Location Determines Rotation Behavior**

The type of rotation depends on the starting location of the cursor. In general, if the cursor is near the center of the graphics window, the familiar 3D free rotation occurs. If the cursor is near a corner or edge, a constrained rotation occurs: pitch, yaw or roll.

Specifically, the circular free rotation area fits the window. Narrow strips along the edges support pitch and yaw. Corner areas support roll. The following figure illustrates these regions.
Customizing Simulation

Section : Simulation Options
Section : Variables
Section : Macros

You can also customize your reports.

Simulation Options

You can control the behavior of functions in Simulation through the Options dialog box. To access Simulation options:

1. From the main menu, choose Tools > Options. An Options dialog box appears and the Simulation options are displayed on the left.

2. Click on a specific option.

3. Change any of the option settings by clicking directly in the option field on the right. You will first see a visual indication for the kind of interaction required in the field (examples are drop-down menus, secondary dialog boxes, direct text entries).

4. Click OK.

The following Simulation options appear in the Options dialog box:

- Contact
- Convergence
- Export
- Fatigue
- Frequency
Other help descriptions available that describe the Options dialog box:

- Common Settings
- DesignModeler
- CFX-Mesh (available only if CFX-Mesh is selected at installation)
- DesignXplorer
- Licensing

**Contact**

The **Auto Detection** category allows you to change the default values in the Details View for the following:

- **Auto Detect Contact on Attach**: Indicates if contact detection should be computed upon geometry import or not. The default is **Yes**.
- **Tolerance**: Sets the default for the contact detection slider; i.e., the relative distance to search for contact between parts. The higher the number, the tighter the tolerance. In general, creating contacts at a tolerance of 100 finds less contact surfaces than at 0. The default is **0**. The range is from **-100** to **+100**.
- **Face/Face**: Sets the default preference for automatic contact detection between faces of different parts. The choices are **Yes** or **No**. The default is **Yes**.
- **Face/Edge**: Sets the default preference for automatic contact detection between faces and edges of different parts. The choices are:
  - **Yes**
  - **No** (default)
  - **Only Solid Edges**
  - **Only Surface Edges**
- **Edge/Edge**: Sets the default preference for automatic contact detection between edges of different parts. The choices are **Yes** or **No**. The default is **No**.
- **Priority**: Sets the default preference for the types of contact interaction priority between a given set of parts. The choices are:
  - **Include All** (default)
  - **Face Overrides**
  - **Edge Overrides**
1Unless changed here in the Options dialog box, the preference remains persistent when starting any Workbench project.

The Transparency category includes the following exclusive controls for this category. There are no counterpart settings in the Details View.

- **Parts With Contact**: Sets transparency of parts in selected contact region so the parts are highlighted. The default is 0.8. The range is from 0 to 1.
- **Parts Without Contact**: Sets transparency of parts in non-selected contact regions so the parts are not highlighted. The default is 0.1. The range is from 0 to 1.

The Default category allows you to change the default values in the Details View for the following:

- **Type**: Sets the definition type of contact. The choices are:
  - Bonded (default)
  - No Separation
  - Frictionless
  - Rough
  - Frictional

- **Formulation**: Sets the type of contact formulation method. The choices are:
  - Augmented Lagrange
  - Pure Penalty (default)
  - MPC
  - Normal Lagrange

- **Update Stiffness**: Enables an automatic contact stiffness update by the program. The choices are:
  - Never (default)
  - Each Equilibrium Iteration
  - Each Substep

### Convergence

The Convergence category allows you to change the default values in the Details View for the following:

- **Target Change**: Change of result from one adapted solution to the next. The default is 20. The range is from 0 to 100.
- **Allowable Change**: This should be set if the criteria is the max or min of the result. The default is Max.

The Solution category allows you to change the default values in the Details View for the following:

- **Max Refinement Loops**: Allows you to change the number of loops. The default is 1. The range is from 1 to 10.
Export

The Export category includes the following exclusive controls for this category. There are no counterpart settings in the Details View.

- **Automatically Open Excel**: Excel will automatically open with exported data. The default is Yes.
- **Include Node Numbers**: Nodal numbers will be included in exported file. The default is Yes.
- **Include Node Location**: Nodal location can be included in exported file. The default is No.

Fatigue

The General category allows you to change the default values in the Details View for the following:

- **Design Life**: Number of cycles that indicate the design life for use in fatigue calculations. The default is 1e9.
- **Analysis Type**: The default fatigue method for handling mean stress effects. The choices are:
  - SN - None (default)
  - SN - Goodman
  - SN - Soderberg
  - SN - Gerber
  - SN - Mean Stress Curves

The Goodman, Soderberg, and Gerber options use static material properties along with S-N data to account for any mean stress while Mean-Stress Curves use experimental fatigue data to account for mean stress.

The Cycle Counting category allows you to change the default values in the Details View for the following:

- **Bin Size**: The bin size used for rainflow cycle counting. A value of 32 means to use a rainflow matrix of size 32 X 32. The default is 32. The range is from 10 to 200.

The Sensitivity category allows you to change the default values in the Details View for the following:

- **Lower Variation**: The default value for the percentage of the lower bound that the base loading will be varied for the sensitivity analysis. The default is 50.
- **Upper Variation**: The default value for the percentage of the upper bound that the base loading will be varied for the sensitivity analysis. The default is 150.
- **Number of Fill Points**: The default number of points plotted on the sensitivity curve. The default is 25. The range is from 10 to 100.
- **Sensitivity For**: The default fatigue result type for which sensitivity is found. The choices are:
  - Life (default)
  - Damage
  - Factor of Safety

Frequency

The Frequency category allows you to change the default values in the Details View for the following:
- **Max Number of Modes**: The number of modes that a newly created frequency branch will contain. The default is 6. The range is from 1 to 100.

- **Limit Search to Range**: You can specify if a frequency search range should be considered in computing frequencies. The default is No.

- **Min Range**: Lower limit of search range. The default is 0.

- **Max Range**: Upper limit of search range. The default is 100000000.

**Graphics**

The **Default Graphics Options** category allows you to change the default values in the Details View for the following:

- **Show Min Annotation**: Indicates if Min annotation will be displayed by default (for new databases). The default is Yes.

- **Show Max Annotation**: Indicates if Max annotation will be displayed by default (for new databases). The default is Yes.

- **Contour Option**: Selects default contour option. The choices are:
  - Smooth Contour
  - Contour Bands (default)
  - Isolines
  - Solid Fill

- **Edge Option**: Selects default edge option. The choices are:
  - No Wireframe (default)
  - Show Undeformed Wireframe
  - Show Undeformed Model
  - Show Elements

**Meshing**

Except for **Relevance**, the **Meshing** category includes the following exclusive controls for this category. There are no counterpart settings in the Details View.

- **Relevance**: Allows setting of the default mesher, known as relevance. The Details View default is 0, but can be changed here. The range is from -100 to +100.

- **Unmeshable Areas**: Highlights the problematic areas encountered when meshing. The choices are:
  - Show First Failed (default)
  - Show All Failed

- **Number of Retries**: Number of times the mesher will try to remesh. The default is 4. The range is from 0 to 4.
The mesher will increase the fineness of the mesh with each retry in an effort to obtain a good mesh. It is possible that the mesh will contain more elements than you intended. If this is not acceptable, you should lower the number of retries.

- **Extra Pass With Proximity Control After Failure**: Performs 2 extra passes in addition to the number of retries with a proximity control added internally. The default is **Yes**.

  *Note* — If you set **Number of Retries** to 0, the mesher executes *only* one remeshing attempt, regardless of the setting of **Extra Pass With Proximity Control After Failure**.

**Miscellaneous**

The **Miscellaneous** category allows you to change the default values in the Details View for the following:

- **Load Orientation Type**: Specifies the orientation input method for certain loads. This input appears in the **Define By** option in the Details View of the load, under **Definition**.
  - **Vector** (default)
  - **Component**

The **Image** category includes the following exclusive controls for this category. There are no counterpart settings in the Details View.

- **Image Transfer Type**: Defines the type of image file created when you send an image to Microsoft Word or PowerPoint, or when you select Print Preview. The choices are:
  - **PNG** (default)
  - **JPEG**
  - **BMP**

**Report**

The **Tables** category includes the following exclusive controls for this category. There are no counterpart settings in the Details View.

- **Table Border**: Specifies the thickness of the tables’ borders (in pixels). It will give the table more of a 3D look. The default is 2. The range is from 0 to 10.
- **Cell Spacing**: Specifies the amount of space between each cell (in pixels) in a table. The default is 0. The range is from 0 to 10.
- **Cell Padding**: Specifies the free space inside each cell of a table (in pixels). It will make the text and numbers look less ‘cramped’ into a cell. The default is 4. The range is from 0 to 10.

The **Miscellaneous** category includes the following exclusive controls for this category. There are no counterpart settings in the Details View.

- **Maximum Number of Digits Trailing a decimal**: Choose the number of decimals to be displayed. The default is 2. The range is from 1 to 12.
**Solution**

Except for **Save Ansys Files**, the **Solution** category allows you to change the default values in the Details View for the following:

- **Save Ansys Files**: Allows you to keep the Ansys solver files. The default is **No**. There is no relation between this setting and the **Save ANSYS db** option in the Details View of a **Solution** object. **Save Ansys Files** refers to files created by ANSYS during a solve and does not have a counterpart setting in the Details View. **Save ANSYS db** refers to ANSYS creating and saving a database file in a specified location.

- **Number of Processors to Use**: Allows you to choose the number of processors to utilize during solution. Setting this to 2 does not harm a single processor computer. The default is **2**. The range is from **1** to **8**.

- **ANSYS Memory Settings**: Specifies the amount of system memory used for the ANSYS workspace and database. The following options can be set as defaults:
  - **Programmed Controlled**: Workbench determines the best memory settings for the solve. You are advised to use this setting unless you are fully aware of the consequences resulting from manually inputting the settings.
  - **Manual**: Allows you to specify the memory settings (in MB) in the **WS Memory** and **DB Memory** fields.

- **WS Memory**: Default setting for the workspace memory when **ANSYS Memory Settings** is set to **Manual**.

- **DB Memory**: Default setting for the database memory when **ANSYS Memory Settings** is set to **Manual**.

- **Solver Type**: Specifies which ANSYS solver will be used. The choices are:
  - **Program Controlled** (default)
  - **Direct**
  - **Iterative**

- **Use Weak Springs**: Specifies whether weak springs are added to the model. The Programmed Controlled setting automatically allows weak springs to be added if an unconstrained model is detected, if unstable contact exists, or if compression only supports are active. The choices are:
  - **Program Controlled** (default)
  - **On**
  - **Off**

- **Solution Information Tool Refresh Times (s)**: Specifies how often any of the result tracking items under a Solution Information object get updated while a solution is in progress. The default is **2.5 s**.

- **Run Solver Process on**: Specifies where the solve process will run. The following choices are available:
  - **Local Machine** (default): Sets a synchronous solution that will run on the local desktop machine.
  - **WB Cluster**: Solution will be submitted to a Remote Solution Manager local or web service. The latter requires that you have a Remote Solution Manager network configured according to the **ANSYS Workbench Products Remote Solution Manager Configuration Guide** (included as part of the **ANSYS Workbench Products Installation and Configuration Guides**, accessible from the main menu under **Help> Installation and Licensing Help**).
- **LSF Cluster**: Solution will be submitted to an LSF cluster (Windows only). This requires that you have LSF, a separate product from Platform™ Computing that manages job queues and balances machine resources. The Workbench client machine must be a member of the LSF cluster.

- **Job Assignment**: Specifies whether the solution is to run on a **Queue** or on a specific **Server**.

- **License to Use on Cluster/Server**: Specifies the name of a valid ANSYS product license (ANSYS Professional or higher) to be used for a solution on the remote server. You can specify the license by entering the license name or product code. For example, for an ANSYS Professional license, you can type either **ANSYS Professional** or **prf**. See Section 3.4. **Product Variable Table** in the ANSYS, Inc. Licensing Guide, accessible from the main menu under **Help> Installation and Licensing Help**.

The **Default Process Settings - Local Machine** category allows you to change the default values in the Details View for the following:

- **Solver Working Directory**: Allows you to change the location of the solver’s temporary files and log files. The choices are:
  - **Use Project Directory**
  - **Use System Directory** (default)
  - **browse...** (to a new directory location)

*Note* — If you do not override the Solver Working Directory, the application uses the system working directory. The system working directory is specified through the TEMP environment variable UNLESS the TMP variable is defined in which case it uses this variable.

The **Default Process Settings - Server Assignment** category allows you to change the default values in the Details View for the following:

- **Compute Server**: Specifies the name of a server machine that is accessible on your network.
- **User Name**: Specifies a valid login name for the **Machine Name** that you entered.
- **User Password**: Specifies a valid password for the **Machine Name** and **User Name** that you entered.
- **Solve Command**: Specifies a valid command line for running ANSYS on the machine whose name is entered in **Machine Name**.
- **Working Directory**: Specifies a valid directory on the machine whose name is entered in **Machine Name**. The user whose name is entered in **User Name** must have write access to this directory.

The **Default Process Settings - LSF Cluster** category allows you to change the default values in the Details View for the following:

- **Queue Name**: Specifies the name of a particular queue on the LSF Cluster.

The **Default Process Settings - WB Cluster** category allows you to change the default values in the Details View for the following:

- **Machine Name**: Specifies the name of the Web Service machine that is accessible on your Remote Solution Manager network. If you enter **localhost** for the **Machine Name**, the client machine acts as the local web service and server.
- **Queue Name**: Specifies the name of a particular queue on the Remote Solution Manager network.
The **Output Controls** category allows you to change the default values in the Details View for the following (all are originally set to **Yes**):

- Calculate Contact
- Calculate Error
- Calculate Strain
- Calculate Stress
- Calculate Thermal Flux

**Startup**

The **Startup** category includes the following exclusive controls for this category. There are no counterpart settings in the Details View.

- **Show Startup Panel**: Indicates if the Simulation Wizard assistance panel should appear when you first start the application. You might not want to see this every time you launch the application. The default is **Yes**.

**Visibility**

The **Visibility** category includes the following exclusive controls for this category. There are no counterpart settings in the Details View.

- **Mesh Folder**: Indicates if mesh folder should appear in the Tree Outline. You may not want to see or know about meshes. The default is **Visible**.
- **Part Mesh Statistics**: Indicates if mesh information (the number of nodes and elements) should show in the Details View of a part. The default is **Visible**.
- **Fatigue Tool**: Turns on/off Fatigue tool capability. The default is **Visible**.
- **Parameter Manager**: Turns on/off Parameter Manager capability. The default is **Visible**.
- **Shape Finder**: Turns on/off Shape finder capability. The default is **Visible**.
- **Harmonic Tool**: Turns on/off Harmonic Tool capability. The default is **Visible**.
- **Contact Tool**: Turns on/off Contact Tool capability. The default is **Visible**.

**Wizard**

The **Wizard Options** category includes the following exclusive controls for this category. There are no counterpart settings in the Details View.

- **Default Wizard**: This is the URL to the XML wizard definition to use by default when a specific wizard isn’t manually chosen or automatically specified by a simulation template. The default is **StressWizard.xml**.
- **Flash Callouts**: Specifies if callouts will flash when they appear during wizard operation. The default is **Yes**.

The **Skins** category includes the following exclusive controls for this category. There are no counterpart settings in the Details View.

- **Cascading Style Sheet**: This is the URL to the skin (CSS file) used to control the appearance of the Simulation Wizard. The default is **Skins/System.css**.
The **Customization Options** category includes the following exclusive controls for this category. There are no counterpart settings in the Details View.

- **Simulation Wizard URL**: For advanced customization. See *Running the Simulation Wizard from a Custom Location* in the *Customization Guide* for details.

- **Enable WDK Tools**: Advanced. Enables the Wizard Development Kit. The WDK adds several groups of tools to the Simulation Wizard. The WDK is intended only for persons interested in creating or modifying wizard definitions. The default is **No**. See *Using the Integrated Wizard Development Kit (WDK)* in the *Customization Guide* for details.

**Note** —

- URLs in the Simulation Wizard follow the same rules as URLs in web pages.
- *Relative URLs* are relative to the location of the Simulation Wizard URL.
- *Absolute URLs* may access a local file, a UNC path, or use HTTP or FTP.

**Variables**

Variables provide you the capability to override default settings.

**To set variables:**

1. Choose Variable Manager from the **Tools** menu.
2. Click in the row to add a new variable.
3. Type a value.
4. Click **OK**.

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Allowable Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSMESH OUTPUT</td>
<td>filename</td>
<td>Writes mesher messages to a file during solve (default = no file written). If the value is a filename, the file is written to the temporary working folder (usually c:\temp). To write the file to a specific location, specify the full path.</td>
</tr>
<tr>
<td>DSMESH DEFEATUREPER-CENT</td>
<td>a number between 1e-6 and 1e-3</td>
<td>Tolerance used in simplifying geometry (default = .0005).</td>
</tr>
</tbody>
</table>

**Status**

The status box indicates if a particular variable is active or not. Checked indicates that the variable is active. Unchecked indicates that the variable is available but not active. This saves you from typing in the variable and removing it.

**Macros**

Simulation allows you to execute custom functionality that is not included in a standard Simulation menu entry via its **Run Macro** feature. The functionality is defined in a *macro* - a script that accesses the Simulation application programming interface (API).

Macros can be written in Microsoft’s JScript or VBScript programming languages. Several macro files are provided with the ANSYS Workbench installation under `\ANSYS Inc\v100\AISOL\DesignSpace\DSPages\macros`. Macros
cannot currently be recorded from Simulation. Also see the Customization Guide for additional information about the use of JScript.

The ANSYS Workbench API is documented and available to Workbench-licensed developers. Please contact ANSYS, Inc. for more information on the Workbench programming capabilities.

To access a macro from Simulation:

1. Choose Run Macro from the Tools menu.
2. Navigate to the directory containing the macro.
3. Open the macro. The functionality will then be accessible from Simulation.

Simulation System Files

Simulation needs to use a location on your system for the solver to perform its tasks. You can override the default location for this directory. Simulation also needs to store configuration information in a file called a User Preference File.

Solver working directory

- The solver directory defaults to the Windows TMP and TEMP environment variable setting. (C:\TEMP)
- You may specify a different location via the Simulation Solution setting in the Options dialog box.

User Preferences File

- This file stores the Simulation configuration on a per-user basis.
- It is created the first time you start Simulation.
- The default location is

C:\Documents and Settings\<user initials>\Application Data\Ansys\v100\dsPreferences.xml

Example of a User Preferences File

This is a partial example of a User Preference File:

```xml
<!-- Control Panel Preferences definitions for DesignSpace -->
<Preferences>
  <Contact>
    <Auto_Detect PreferenceID="PID_Auto_Detect" Type="4" Name="Auto " onumlist="Yes;No" valuelist="1;0" />
```
Using Simulation Features

Section : Simulation Startup Notes
Section : Attaching Geometry
OR
Simulation Approach
Section : Simulation Wizard

Simulation Startup Notes

You can initiate a Simulation through the ANSYS Workbench Start Page or Project Page.

If you open a .dsdb file that includes multi body parts (formerly known as “generalized bodies”), and was created in ANSYS DesignSpace version 7.0 or a previous version, that file will not include any meshing data or results data.

If you open a .dsdb file that was created in version 6.1 or 7.0 having AGP version 6.1 or 7.0 models, these models will lose all associativity after updating the .dsdb file. You will need to re-link the Environment to the geometry.

If you created custom shortcuts in ANSYS DesignSpace version 7.0, which were based on predefined shortcuts supported with that product (called “simulation templates”), they will need to be modified to be used as shortcuts in Simulation under ANSYS Workbench 10.0.

Caution: Please note that meshed and/or solved databases from ANSYS Workbench 8.1, or earlier versions, that are migrated into version 10.0 will be in an obsolete state. This means that they cannot be migrated into the current version of Workbench in the meshed or solved state. Simply re-mesh and/or re-solve databases prior to version 9.0 to resolve this condition.

Physics Filter

You can set a Physics Filter under the View menu. When chosen, a Physics Filter makes available toolbar and menu options at the Environment and Solution levels that apply only to the chosen type of physics. For example, in a thermal only analysis, you would set the Thermal Physics Filter on (depressed icon under View > Physics Filter > Thermal), and the Structural Physics Filter to off. The following items would then be unavailable:

- Structural and Electromagnetic items in the Environment and Solution context toolbars.
- Structural loads and supports and Electromagnetic boundary conditions and excitations that you would insert at the Environment level of the tree.
- Structural and Electromagnetic result items that you would insert at the Solution level of the tree.

An application for turning all items in the Physics Filter off is for types that are not supported in Simulation but are supported in ANSYS. For these cases, you can have Simulation write an ANSYS input file, as described in a related section.

Physics Filter settings are saved as program preferences and will remain unchanged from project to project until reset. When beginning Simulation, the Physics Filter turns on all physics types by default.

Attaching Geometry

To Attach Geometry, refer to:
How to Attach Geometry

From the Workbench Project Page
Using CAD Interfaces
Geometry Setup
Attaching and Updating Geometry from Within Simulation
Model Dimensions
Materials

From the Workbench Project Page

1. You should see the file name listed under Link to Active CAD Geometry or under Link to Geometry File. If the name in an open CAD system is not listed, you will need to click Refresh.

   If the name of the geometry file is not listed, click the Browse... button.

2. Choose the part or file name and set the preferences under the Default Geometry Options group and the Advanced Geometry Defaults group.

3. Click New simulation under the CAD Geometry Tasks group to start the attach process.

Using CAD Interfaces

The CAD interfaces can be run in either plug-in mode or in reader mode.

• Attaching geometry in plug-in mode: requires that the CAD system be running. To attach a geometry in plug-in mode, open a document (part/assembly) first in a CAD system. Then select Simulation from the ANSYS 10.0 menu to attach the geometry automatically. For this to work, it is required that the part file exist. If the part file is not recognized, the attach process will have to go through the ANSYS Workbench Start Page. This can also be directly activated through the Workbench menu item in the ANSYS 10.0 menu. If you have to go through the Start Page, you can create a new project, open an existing project or import a Simulation database from a particular directory that has write access. When you are in the Project Page, you will see your part name listed under the Link to Active CAD Geometry group. If it is not listed, you will need to click Refresh. Once your part is listed there, click this part and then set the preferences under the Default Geometry Options group and the Advanced Geometry Defaults group. Afterward, click the New simulation task under the CAD Geometry Tasks group to start the attach process.

• Attaching geometry in reader mode: does not require that the CAD system be running. To attach a geometry in reader mode, start the ANSYS Workbench (Start> Programs> ANSYS 10.0> ANSYS Workbench). After opening a project, click the Browse... button under the Link to Geometry File group and select the part file whose geometry you want to attach into Simulation. Then set the preferences under
the Default Geometry Options group and the Advanced Geometry Defaults group. Afterward, click the New simulation task under the CAD Geometry Tasks group to start the attach process.

Geometry Setup

After you attach the geometry from the Project Page, Simulation opens and displays the model, along with a Choose Simulation Template panel on the right that allows you the opportunity to add typically used items to the Solution object in the tree. Available templates are grouped under General Simulation (Fatigue Branch, Frequency Branch, Shape Branch, Thermal Branch), and Structural Simulation (Stress Branch — Brittle Material, Stress Branch — Ductile Material). Choose a template by highlighting the Solution object and clicking on a simulation template branch. Items that are typically used for the branch that you chose are added under the Solution object. The Simulation Wizard panel then replaces the Choose Simulation Template panel after the items are added to the Solution object. The appearance of the Choose Simulation Template can be turned off using the Startup category under Simulation in the Options dialog box.

 Attaching and Updating Geometry from Within Simulation

You can attach a geometry file by using the Geometry button on the Model Context Toolbar:

- **Recent Geometry** lists the most recent geometry files used.
- **From File...** allows you to choose geometry from a file.

You can update your geometry by also using the Geometry button:

- **Update: Use Simulation Parameter Values** attempts to update the CAD model to the parameter values set currently displayed in Simulation. If successful, the updated geometry is sent back to Simulation. This option is necessary only if Simulation is being used to drive the design of the CAD model.
- **Update: Use Geometry Parameter Values** synchronizes the Simulation model to the CAD model. This will read the latest geometry and process other data (parameters, attributes, etc.) based on the current user preferences for that model. Coordinate systems defined in DesignModeler or SolidWorks are updated as well.

  Note — If you change either the number of turns or the thickness properties associated with a body, these changes are not updated to the CAD model when you choose either Update: Use Simulation Parameter Values or Update: Use Geometry Parameter Values.

If you change any CAD parameters in Simulation, you must click Update: Use Simulation Parameter Values to implement the change (and the solution will change to the unsolved state).

Model Dimensions

When you attach your geometry or model, the model dimensions display in the Section : Details View in the Bounding Box sections of the Geometry or Part objects. Dimensions have the following characteristics:

- Units are created in your CAD system.
- ACIS, CATIA, and Autodesk Mechanical Desktop model units may be set.
- Other geometry units are automatically detected and set.
- Assemblies must have all parts dimensioned in the same units.
To see the dimensions of your attached geometry, click **Geometry** in the Section : Tree Outline. The Section : Details View appears, providing the details of your geometry.

*Note* — If density is temperature dependent, then the density value at 22°C (default reference temperature for an environment) will be used to compute the **Mass** that is displayed in the Details View.

---

**Materials**

Once you have attached your geometry, you can choose a material for the simulation. When you select a part in the tree outline, the **Material** entry in the Details View lists a default material for the part. You can perform the following tasks involving materials:

**To change the default material:**

1. Click the **Data** button in the Standard Toolbar. You are transferred to the Engineering Data.
2. Follow the procedure under Configuring Default Materials.

**To add a new material:**

1. With a part selected, click the **Material** entry in the Details View and activate the drop down list.
2. Choose **New Material...** from the list. You are transferred to the Engineering Data.
3. Rename the new material in the **Project** pane.
4. Follow the procedure under Create New Materials in the Engineering Data Help. The name of the new material will be included in the drop down list the next time you activate the list.
To assign a material to part(s):

1. With the part(s) selected, click the Material entry in the Details View and activate the drop down list.
2. Choose the material if it is listed. If the material is not listed, choose Import...
   - The dialog box displays a list of library files in the Data Source field.
   - The default library file is the Workbench_Samples.xml library supplied with the application.
   - From this option, you can Add or Remove data libraries from the list.
   - As different libraries are added, they display in the list as recently used files. By selecting a source and clicking Remove you can delete the source from this list.
   - The materials associated with the selected library file are displayed in the bottom half of the dialog box.
3. From the Material Data to Import field, choose a material to assign to the part and then click OK. The material is assigned to the part(s).

Note — Materials are assigned to parts in Simulation, however the properties of the material can only be changed using the Engineering Data.

To edit a material's properties:

1. With material name displayed in the Material entry in the Details View, activate the drop down list.
2. Choose Edit <material name> from the list. You are transferred to the Engineering Data.
3. Follow the procedure under Review or Modify the Properties of a Material in the Engineering Data Help.

Setting the Nonlinear Material Effects control in the Details View to No allows you the option of ignoring nonlinear material effects for a particular body, avoiding the need to define a duplicate material in this situation. The following nonlinear material effects can be ignored:

- Structural simulation: ignores plasticity and hyperelasticity.
- Electromagnetic simulation: ignores BH curve.
- Thermal simulation: ignores temperature dependency for Thermal Conductivity and Specific Heat.

In an Electromagnetic simulation, you can orient a polarization axis for a Linear or Nonlinear Hard material in either the positive or negative x direction with respect to a local or global coordinate system. Use the Material Polarization setting in the Details View for each body to establish this direction. The Material Polarization setting appears only if a hard material property is defined for the body. For a cylindrical coordinate system, a positive x polarization is in the positive radial direction, and a negative x polarization is in the negative radial direction.

Branches

A branch is an outline that contains appropriate results for a particular simulation type. If you choose not to use the wizards to prompt you for a simulation type, you may choose to insert a branch. To insert an outline branch, highlight the Environment or Solution node, then click Insert > Outline Branch. The Outline Branch Macros wizard displays, showing the kinds of branches (simulations) you can add. The lower portion of the Outline Branch Macros wizard panel includes fields for entering input data that is specific to the particular simulation type you choose at the top of the panel. As an example, presented below are the input fields that appear if you select the Transient Thermal radio button.
After choosing the Run button, the appropriate branches are added to the tree and the associated simulation wizard is displayed in place of the Outline Branch Macros wizard.

You may freely hide, show and choose wizards any time in the simulation.

**Types of Branches**

- Structural Simulation - Ductile Material
- Structural Simulation - Brittle Material
- Fatigue Branch
- Thermal Branch
- Transient Thermal Branch
- Electromagnetic Branch
- Frequency Branch
- Shape Branch

**Structural Simulation - Ductile Material**

Tools to find the factor or margin of safety based on the maximum equivalent stress safety theory and the maximum shear stress safety theory for ductile materials. Includes applicable stresses and deformation.
Structural Simulation - Brittle Material

Tools to find the factor or margin of safety based on the Mohr-Coulomb stress safety theory and the maximum tensile stress safety theory for brittle materials. Includes applicable stresses and deformation.

Fatigue Branch

In addition to the objects found in the Structural Simulation - Ductile Material, this branch includes a Fatigue Tool in order to determine if a failure due to fatigue is a possibility. Includes life and fatigue safety factor results under the Fatigue Tool.

Thermal Branch

Provides temperature and total heat flux results.

Transient Thermal Branch

Provides temperature and total heat flux results for transient conditions.
Electromagnetic Branch

Calculates results for a body or assembly with electromagnetic loading, including total flux density and total field intensity.

Frequency Branch

Determines the fundamental frequencies and mode shapes.

Shape Branch

Inserts a shape finder, which for a given structural loading scenario, gives the user some measure of the best location to remove material from the structure to make it lighter while maximizing structural compliance.

Solids

You can process and solve solid models, including individual parts and assemblies. An arbitrary level of complexity is supported, given sufficient computer time and resources.

Surface Models

You can import surface models from the DesignModeler, UG, Solid Edge, SolidWorks, and Pro/Engineer CAD systems, as well as CATIA, IGES, Parasolid, and SAT files. The IGES, Parasolid, and SAT surface files may actually come from other CAD systems, such as Solid Edge. Surface models are often generated using mid surface extraction, but not always. UG has a mid surface extraction capability. In the case of IGES, SAT, and Parasolid, surface models can be generated in a variety of ways.

Single surfaces, multiple surfaces (connected by spot welds), surfaces and lines can be analyzed.
You should work with UG to clean and repair your surface models.

**Importing Surface Models**

To import a surface model (called a sheet body in Unigraphics), open the model in the CAD system and import the geometry as usual. If your model mixes solids and surfaces, you should select which type of entity you want to import via the Geometry preferences on the ANSYS Workbench project page. Once in Simulation, you can adjust the Geometry preferences in the Details view, where they take effect upon updating.

*Note* — If you want to retain a preference selection in the Project Page, you must first save before exiting the ANSYS Workbench.

**Importing Sheet Thickness**

Sheet thickness will be imported from CAD (including DesignModeler) if, and only if, the existing sheet thickness value in Simulation is set to 0 (zero). This is true on initial attach and if you set the sheet thickness value to zero prior to an update. This allows you the flexibility of updating sheet thickness values from CAD or not.

**Assemblies, Parts, and Bodies**

While there is no limit to the number of parts in an assembly that can be treated, large assemblies may require unusually high computer time and resources to compute a solution. Contact boundaries can be automatically formed where parts meet. The application has the ability to transfer structural loads and heat flows across the contact boundaries and to “connect” the various parts.

Parts are a grouping or a collection of bodies. Parts can include multiple bodies and are referred to as *multi body parts*. The mesh for multi body parts will share nodes where the bodies touch one another, that is, they will have common nodes at the interfaces. This is the primary reason for using multi body parts. The only viable multi body parts include the following combinations:

- Line body with surface bodies.
- Solid bodies and solid bodies.

All other combinations are not practically supported.

**Working with Parts**

There are several useful and important manipulations that can be performed with parts in an assembly.

- Each part may be assigned a different material.
- Parts can be hidden for easier visibility.
- Parts can be suppressed, which effectively eliminates the parts from treatment.
- Parts can be assigned Full or Reduced integration schemes. The full method is used mainly for purely linear analyses, or when the model has only one layer of elements in each direction. This method does not cause hourglass mode, but can cause volumetric locking in nearly incompressible cases. The reduced method helps to prevent volumetric mesh locking in nearly incompressible cases. However, hourglass mode might propagate in the model if there are not at least two layers of elements in each direction.
- The contact detection tolerance and the contact type between parts can be controlled.
Working with Bodies

There are several useful and important manipulations that can be performed with bodies in a part.

- Bodies grouped into a part result in connected geometry and shared nodes in a mesh.
- Each body may be assigned a different material.
- Bodies can be hidden for easier visibility.
- Bodies in a part group can be individually suppressed, which effectively eliminates these bodies from treatment. A suppressed body is not included in the statistics of the owning part or in the overall statistics of the model.
- Bodies can be assigned Full or Reduced integration schemes, as described above for parts.
- When bodies in part groups touch they will share nodes where they touch. This will connect the bodies. If a body in a part group does not touch another body in that part group, it will not share any nodes. It will be free standing. Automatic contact detection is not performed between bodies in a part group. Automatic contact detection is performed only between part groups.

To Hide or Suppress Bodies

For a quick way to hide bodies (that is, turn body viewing off) or suppress bodies (that is, turn body viewing off and remove the bodies from further treatment in the analysis), select the bodies in the tree or in the Geometry window (choose the Body select mode, either from the toolbar or by a right-click in the Geometry window). Then right-click and choose Hide Body or Suppress Body from the context menu. Choose Show Body, Show All Bodies, Unsuppress Body, or Unsuppress All Bodies to reverse the states.

The following options are also available:

- Hide All Other Bodies, allows you to show only selected bodies.
- Suppress All Other Bodies, allows you to unsuppress only selected bodies.

Assumptions and Restrictions for Assemblies, Parts, and Bodies

Thermal and shape analysis is not supported for surface bodies or line bodies.

In order for multiple bodies inside a part to be properly connected by sharing a node in their mesh the bodies must share a face or edge. If they do not share a face or an edge the bodies will not be connected for the analysis which could lead to rigid body motion.

For a solid body within a multi body part that does not touch another body, Contact objects can be inserted to connect the bodies. This must be done manually. Automatic contact detection is only performed between bodies between different parts.

Startup restrictions apply when opening and updating a .dsdb file created in version 6.1 or 7.0 that contains AGP version 6.1 or 7.0 models.

Point Mass

You can idealize the inertial effects from a body using a Point Mass. Applications include applying a force with an acceleration or any other body load; or adding inertial mass to a structure, which affects modal and harmonic solutions.
To insert a **Point Mass**, select a **Geometry** branch and either choose **Point Mass** from the toolbar, or right mouse button click and choose **Insert> Point Mass** from the context menu. You then apply it on a face of a solid or surface model, or on an edge of a surface model. The location of the **Point Mass** can be anywhere in space and can also be defined in a local coordinate system if one exists.

**Coordinate Systems**

The following coordinate system capabilities are available in Simulation. Cartesian coordinate systems apply in all cases. You can also apply cylindrical coordinates to parts and Forces applied to surfaces.

- Create new coordinate systems.
- Import coordinate systems from DesignModeler, from Pro/ENGINEER, or from SolidWorks. If you update the model in Simulation, coordinate systems from these products are refreshed, or newly defined coordinate systems in these products are added to the model.

If a coordinate system was brought in from one of these products but changed in Simulation, the change will not be reflected on an update. Upon an update, a coordinate system that originated from DesignModeler, Pro/ENGINEER, or SolidWorks will be re-inserted into the object tree. The coordinate system that was modified in Simulation will also be in the tree.

- Apply created or imported local coordinate systems to a part, or to a Point Mass, Acceleration, Standard Earth Gravity, Rotational Velocity, Force, Bearing Load, Remote Force, Moment, Displacement, Remote Displacement, or Contact Reaction. This feature is useful because it avoids having to perform a calculation for transforming to the global coordinate system.

To apply a local coordinate system:

2. For an Acceleration, Rotational Velocity, Force, Bearing Load, or Moment, in the specific Details View, under **Define By**, select **Components** then proceed to step 3. For the other items, proceed directly to step 3.
3. Under **Coordinate System**, select the name of the local coordinate system that you want to apply. The names in this drop-down list are the same names as those listed in the **Coordinate Systems** branch of the tree outline.

   *Note* — If you define a load by **Components** in a local coordinate system, changing the **Define By** field to **Vector** will define the load in the global coordinate system. Do not change the **Define By** field to **Vector** if you want the load defined in a local coordinate system.

- Transfer coordinate systems to ANSYS:
  - Main Menu> Tools > Write ANSYS Input File...
  - Load ANSYS (from Project Page).
  - Commands Objects

Any coordinate system defined in Simulation and sent to ANSYS as part of the finite element model, will be added to the ANSYS input file as **LOCAL** commands. For example:

```
/com,*********** Send User Defined Coordinate System(s) ***********
local,11,0,0.,0.,0.,0.,0.,0.,0.,0.
```
If you create a coordinate system, the coordinate system reference number (first argument of the LOCAL command) is assigned automatically. You can however specify a particular reference number for identification or quick reference of the coordinate system within the input file. You accomplish this using the Advanced control settings in the Details View of a Coordinate System object.

To specify a particular coordinate system reference number:

2. Set Ansys System Number to a value greater than or equal to 12.

If you create more than one local coordinate system, you must ensure that you do not duplicate the Ansys System Number.

Contact

You can transfer structural loads and heat flows across the contact boundaries and “connect” the various parts. See the Contact section for details.

Spot Welds

Spot welds are used to connect individual surface parts together to form surface model assemblies, just as contact is used for solid part assemblies. Structural loads are transferred from one surface part to another via the spot weld connection points, allowing for simulation of surface model assemblies.

Spot Weld Details

Spot welds are usually defined in the CAD system and automatically generated upon import, although you can define them manually in Simulation after the model is imported. Spot welds then become hard points in the geometric model. Hard points are vertices in the geometry that are linked together using beam elements during the meshing process.

Spot weld objects are located in the Contact object in the Section : Tree Outline. When selected in the tree, they appear in the graphical window highlighted by three concentric circles about the underlying vertices, with an annotation.

If a surface model contains spot weld features in the CAD system, then spot welds are auto-generated when the model is read into Simulation or when Generate Contact on Update is set to Yes in the Details view of the Contact object in the Section : Tree Outline. This is similar to the way in which Simulation automatically constructs contact condition when reading in assemblies of solid models.

You can manually generate spot welds as you would insert any new object into the Outline tree. Either insert a spot weld object from the context menu and then pick two appropriate vertices in the model, or pick two appropriate vertices and then insert the spot weld object.

You can define spot welds for CAD models that do not have a spot weld feature in the CAD system, as long as the model contains vertices at the desired locations. You must define spot welds manually in these cases.
Spot Weld Assumptions and Restrictions

Spot welds do not act to prevent penetration of the connected surface in areas other than at the spot weld location. Penetration of the joined surface is possible in areas where spot welds do not exist.

Spot welds only transfer structural loads and structural effects between surface parts. Therefore they are appropriate for displacement, stress, elastic strain, and frequency solutions.

DesignModeler generates spot welds. The only CAD system whose spot welds can be fully realized in ANSYS Workbench at this time is Unigraphics. The APIs of the remaining CAD systems either do not handle spot welds, or the ANSYS Workbench software does not read spot welds from these other CAD systems.

Virtual Topology

You can use virtual topology to aid you in reducing the number of elements in the model, simplifying small features out of the model, and simplifying load abstraction. See Virtual Topology Overview for details.

Graphics

Annotations

Basics
Highlight and Selection Graphics
Scope Graphics
Annotation Graphics and Positioning
Environment Annotations
Solution Annotations
Message Annotations

Basics

Annotations provide the following visual information:

- Boundary of the scope region by coloring the geometry for edges, surfaces or points.
- An explicit point within the scope.
- A 3D arrow to indicate direction, if applicable.
- Text description or a value.
- A color cue (structural vs. thermal, etc.).

Highlight and Selection Graphics

You can interactively highlight a surface. The geometry highlights when you point to it.
See Section: Graphical Selection for details on highlighting and selection.

**Scope Graphics**

In general, selecting an object in the Section: Tree Outline displays its Scope by painting the geometry and displays text annotations and symbols as appropriate. The display of scope via annotation is carried over into the Section: Report Preview if you generate a figure.

Contours are painted for results on the scoped geometry. No boundary is drawn.

**Annotation Graphics and Positioning**

A *label* consists of a block arrow auto-sized to the text it contains. For vector annotations, a 3D arrow originates from the tip of the label to visualize direction relative to the geometry.
Figure 1  Annotation of a force on a surface

Use the pointer after selecting the **Label** toolbar button for managing annotations and to drag the annotation to a different location within the scope.

- If other geometry hides the 3D point (e.g. the point lies on a back face) the block arrow is unfilled (transparent).
- The initial placement of an annotation is at the pick point. You can then move it by using the **Label** toolbar button for managing annotations.
- Drag the label to adjust the placement of an annotation. During the drag operation the annotation moves only if the tip lies within the scope. If the pointer moves outside the scope, the annotation stops at the boundary.

**Environment Annotations**

With the **Environment** object selected in the Section : Tree Outline, an annotation for each load and support appears on the geometry:
The scope of loads and supports is usually displayed.

The label fill color indicates the type or state of the annotation. Here are some examples:

- Green - structural load
- Blue/Cyan - structural support
- Red - applied temperature
- Yellow - body load
- Transparent - geometry pointed at is not currently visible

**Solution Annotations**

Solution annotations work similar to Environment Annotations. The **Max** annotation has red background. The **Min** annotation has blue background. **Probe** annotations have cyan backgrounds.
Figure 2 Max and Min annotations and two “probe” annotations:

- By default, annotations for **Max** and **Min** appear automatically for results but may be controlled by buttons in the Result Context Toolbar or by Simulation preferences in the **Options** dialog box.

- You may create “probe” annotations by clicking ![Probe](image) in the Result Context Toolbar. **Probe** annotations show the value of the result at the location beneath the tip, when initially constructed. They are not saved to the database.

- If you apply a probe annotation to a very small thickness, such as when you scope results to an edge, the probe display may seem erratic or non-operational. This is because, for ease of viewing, the colored edge result display is artificially rendered to appear larger than the actual thickness. You can still add a probe annotation in this situation by zooming in on the thin region *before* applying the probe annotation.

- To delete a probe annotation, activate the **Label** button ![Label](image), select the probe, and then press the [Delete] key.

- Probes will be cleared if the results are re-solved.

- See the Solution Context Toolbar for more information.

**Message Annotations**

If an error occurs during meshing, the application attempts to annotate the problem geometry.
Controls

When you click **Model** in the Section: Tree Outline, you can view details that control lighting in the Section: Geometry window.

**Figures**

Figures allow you to:

- Preserve different ways of viewing an object (viewpoints and settings).
- Define illustrations and captions for a report.
- Capture result contours, mesh previews, environment annotations etc., for later display in Report.

Clicking the **Figure** button in the Section: Standard Toolbar creates a new **Figure** object inside the selected object in the Section: Tree Outline. Any object that displays 3D graphics may contain figures. The new figure object copies all current view settings and gets focus in the Outline automatically.

View settings maintained by a figure include:

- Camera settings
- Result toolbar settings
- Legend configuration

A figure's view settings are fully independent from the global view settings. Global view settings are maintained independently of figures.

Behaviors:

- If you select a figure after selecting its parent in the Outline, the graphics window transforms to the figure's stored view settings automatically (e.g. the graphics may automatically pan/zoom/rotate).
- If you change the view while a figure is selected in the Outline, the figure's view settings are updated.
• If you reselect the figure's parent in the Outline, the graphics window resumes the global view settings. That is, figure view settings override but do not change global view settings.

• Figures always display the data of their parent object. For example, following a geometry Update and Solve, a result and its figures display different information but reuse the existing view and graphics options. Figures may be moved or copied among objects in the Outline to display different information from the same view with the same settings.

• You may delete a figure without affecting its parent object. Deleting a parent object deletes all figures (and other children).

• In the Section: Tree Outline, the name of a figure defaults to simply Figure appended by a number as needed.

• You may enter a caption for a figure as a string in the figure's details. It is your responsibility to maintain custom captions when copying figures.

Applying Loads

Note — All loads and supports are applicable to a 2-D or 3-D simulation except where noted in the description of the specific load or support.

Section: Types of Loads
Section: Harmonic Loads
Section: Resolving Thermal Boundary Condition Conflicts
Section: How to Apply Loads
Section: Direction
Section: Scope
Section: Types of Supports
Section: Applying Loads Demonstration

Types of Loads

Global Loads

Section: Acceleration
Section: Standard Earth Gravity
Section: Rotational Velocity

Structural Loads

Section: Pressure Loads
Section: Force Load
Remote Force Load
Section: Bearing Load
Bolt Load
Section: Moment
Section: Generalized Plane Strain
Section: Thermal Condition
Inertia Relief
Section: Motion Load

Thermal Loads

Section: Convection
Note — Some thermal loads are also supported for a transient simulation.

Electromagnetic Boundary Conditions and Excitations

Acceleration

Translational acceleration accounts for the structural effects of a constant linear acceleration.

The global Acceleration load defines the linear acceleration of the structure in each of the global Cartesian axis directions. To simulate gravity (by using inertial effects), accelerate the structure in the direction opposite to gravity. Units are length/time². For example, apply a positive acceleration to simulate gravity acting in the negative Y direction as shown below.

Global Acceleration load applied in the +Y direction to simulate gravity.
Resulting deformation.

Define the vector in terms of either:

- a magnitude and direction (based on selected geometry) [**Define By: Vector**]
- components (in the world coordinate system or local coordinate system, if applied) [**Define By: Components**]

*Note* — While loads are associative with geometry changes, load directions are not. This applies to any load that requires a vector input, such as: moment, acceleration, rotational velocity, force, and bearing load.

**Standard Earth Gravity**

Applies gravitational acceleration effects.

- Gravitational acceleration vector
  - Define the vector in terms of any of the following directions in the world coordinate system or local coordinate system, if applied: \(+x, -x, +y, -y, +z, -z\).
  - Gravity is a specific example of acceleration.
  - The magnitude is set: 9.80665 m/s² (in metric units)
  - The direction is changeable.
  - The vector is added to acceleration when it is present.
**Rotational Velocity**

Rotational velocity accounts for the structural effects of a part spinning at a constant rate.

Define rotational velocity in terms of either:

- a magnitude and an axis of rotation (based on selected geometry) [Define By: Vector]
- a point and components (in the world coordinate system or local coordinate system, if applied) [Define By: Components]

For 2-D plane stress and plane strain simulations, a Rotational Velocity load can be applied about an individual x, y, or z-axis. Combinations of x and y components can be applied, but combinations of x and z components cannot be applied, and combinations of y and z components cannot be applied.

For 2-D axisymmetric simulations, a Rotational Velocity load can only be applied about the y-axis.

*Note* — While loads are associative with geometry changes, load directions are not. This applies to any load that requires a vector input, such as: moment, acceleration, rotational velocity, force, and bearing load.

**Pressure Loads**

For 3-D simulations, a pressure load applies a pressure to one or more flat or curved surfaces.
Constant Pressure Load

You apply a constant pressure load by setting Define As to Constant in the Details View of the Pressure object. The following applies to a constant pressure load:

- Uniform positive pressure

Pressure is uniform and acts normal to a surface at all locations on the surface. A positive pressure acts into the surface, compressing the solid body.

If you select multiple surfaces when defining the pressure, the same pressure value gets applied to all selected surfaces.

If a pressurized surface enlarges due to a change in CAD parameters, the total load applied to the surface increases, but the pressure (force per unit area) remains constant.

For 2-D simulations, a pressure load applies a pressure to one or more edges.

ANSYS CFX Load Transfer

You can perform fluid-structure interaction by importing a pressure load resulting from an ANSYS CFX boundary by setting Define As to CFX Results in the Details View of the Pressure object. See Section : Surface Forces at Fluid-Structure Interface for more information.

Force Load

There are three types of forces:

- Surface
- Edge
- Vertex

Surface

Distributes a force vector across one or more flat or curved surfaces.
Force vector

- Resulting uniform traction across the surface

Define the vector in terms of either:

- a magnitude and direction (based on selected geometry) [Define By: Vector]
- components (in the world coordinate system or local coordinate system, if applied) [Define By: Components]

If you select multiple surfaces when defining the force, the magnitude gets apportioned across all selected surfaces.

If a surface enlarges due to a change in CAD parameters, the total load applied to the surface remains constant, but the pressure (force per unit area) decreases.

If you try to apply a force to a multiple surface selection that spans multiple parts, the surface selection is ignored. The geometry property for the load object displays 'No Selection' if the load was just created, or it maintains its previous geometry selection if there was one.

**Edge**

Distributes a force vector along one or more straight or curved edges.
Force vector

Resulting uniform line load along the edge

Define the vector in terms of either:

- a magnitude and direction (based on selected geometry) [Define By: Vector]
- components (in the world coordinate system or local coordinate system, if applied) [Define By: Components]

If you select multiple edges when defining the force, the magnitude gets apportioned across all selected edges.

If an edge enlarges due to a change in CAD parameters, the total load applied to the edge remains constant, but the line load (force per unit length) decreases.

A force applied to an edge is not realistic and leads to singular stresses (that is, stresses that approach infinity near the loaded edge). You should disregard stress and elastic strain values in the vicinity of the loaded edge.

If you try to apply a force to a multiple edge selection that spans multiple parts, the edge selection is ignored. The geometry property for the load object displays 'No Selection' if the load was just created, or it maintains its previous geometry selection if there was one.

**Vertex**

Applies a force vector to one or more vertices.

Define the vector in terms of either:

- a magnitude and direction (based on selected geometry) [Define By: Vector]
- components (in the world coordinate system or local coordinate system, if applied) [Define By: Components]

If you select multiple vertices when defining the force, the magnitude gets apportioned across all selected vertices.

A force applied to a vertex is not realistic and leads to singular stresses (that is, stresses that approach infinity near the loaded vertex). You should disregard stress and elastic strain values in the vicinity of the loaded vertex.

While loads are associative with geometry changes, load directions are not. This applies to any load that requires a vector input, such as: moment, acceleration, rotational velocity, force, and bearing load.

If you try to apply a force to a multiple vertex selection that spans multiple parts, the vertex selection is ignored. The geometry property for the load object displays 'No Selection' if the load was just created, or it maintains its previous geometry selection if there was one.
Remote Force Load

A remote force load is equivalent to a regular force load on a face or a force load on an edge, plus some moment.

A remote force load can be used as an alternative to building a rigid part and applying a force load to it. The advantage of using a remote force load is that you can directly specify the location in space from which the force originates.

You apply a remote force load like you apply a force load except that the location of the load origin can be replaced anywhere in space either by picking or by entering the XYZ locations directly. The default location is at the origin of the global coordinate system. The location and the direction of a remote force can be defined in the global coordinate system or in a local coordinate system.

A remote force can be applied to a face of a solid model, or to an edge or a face of a shell model.

While loads are associative with geometry changes, load directions are not. This applies to any load that requires a vector input, such as: moment, acceleration, rotational velocity, force, and bearing load.

Bearing Load

Applies a variable distribution of force to one complete right cylinder in a 3-D simulation, or to a circular edge in a 2-D simulation.

In a 3-D simulation, a complete right cylinder is capped on both ends by circles normal to the axis of the cylinder.
Load direction

Radial component distribution

Region of loaded cylinder not affected by radial distribution

Given an arbitrary force direction, the bolt force is decomposed into two components, radial and axial. The radial component is distributed based on the projected surface area with respect to the radial force direction. It therefore acts on elements where the dot product between the force vector and surface normal is negative (meaning that the force is applied to the model in a compressive fashion). The axial component is uniformly distributed over the entire surface.

Define the vector in terms of either:

- a magnitude and direction (based on selected geometry) [Define By: Vector]
- components (in the world coordinate system or local coordinate system, if applied) [Define By: Components]

If the loaded surface enlarges (e.g., due to a change in parameters), the total load applied to the surface remains constant, but the pressure (force per unit area) decreases.

Note —

- While loads are associative with geometry changes, load directions are not. This applies to any load that requires a vector input, such as: moment, acceleration, rotational velocity, force, and bearing load.
- If your CAD system split the cylinder into two or more surfaces, select all of the surfaces when defining the bearing load.
- Use one bearing load per cylinder. Do not use multiple select to apply a bearing load to different cylinders. If you do, the load is divided among the multiple cylindrical surfaces by area ratio, as shown in the following example of a single bearing load applied to two cylinders. The length of the cylinder on the right is twice the length of the cylinder on the left. Note that the reactions are proportional to each cylinder’s area as a fraction of the total load area.
**Bolt Load**

*Available for 3-D simulations only.*

Applies a pretension load to a cylindrical surface or to a body, typically to model a bolt under pretension. If you apply the bolt load to a body, you will need to have a local **Coordinate System** object in the tree. The application of the bolt load will be at the origin and along the z-axis of the local coordinate system. You can place the coordinate system anywhere in the body and reorient the z-axis.

This load is applicable to pure structural (static and sequenced) or thermal-stress simulations. You specify how the bolt load is applied by choosing one of the following options under the **Define By** setting in the Details View.
- **Load**: Applies a force as a preload. A *Load* field is displayed where you enter the value of the load in force units.

- **Adjustment**: Applies a length as a preadjustment (for example, to model x number of threads). An *Adjustment* field is displayed where you enter the value of the adjustment in length units.

- **Lock** (displayed only for sequenced simulations): Fixes all displacements. For static simulations, this state is applied automatically as a second load step (see below). For sequenced simulations, you can set this state for any load step except the first load step.

- **Open** (displayed only for sequenced simulations): Use this option to leave the bolt load open so that the load has no effect on the applied step, effectively suppressing the load for the step. Note that in order to avoid convergence issues from having underconstrained conditions, a small load (0.01% of the maximum load across the steps) will be applied. For sequenced simulations, you can set this state for any load step.

Presented below is the same model showing a pretension bolt load as a preload force and as a preadjustment length:

The following animation shows total deformation:

*The following is an animated GIF. Please view online if you are reading the PDF version of the help.*
For static simulations ...

When a pretension bolt load is present, the simulation automatically executes 2 load steps. For the first load step, the preloads will be applied. These include any direct boundary conditions (fixed supports, specified displacements), and any contact conditions. For the second load step, the pretension loads will become "locked" (displacements fixed) and the working loads (that is, other user-applied loads and any thermal temperatures causing thermal expansion) will be applied. This is important for path dependent problems where nonlinear contact is present.

The specific user interaction and Workbench process for an analysis with pretension bolt loads is as follows:

1. User applies a pretension load to a cylindrical surface or to a body.
2. User defines other loads that will be applied after the pretension loads are set.
3. During the solve, if the load is applied to a cylindrical surface, the program will slice the body mesh at the centroid of the applied surface and create pretension elements in the direction of the cylinder axis. If the load is applied to a body, the program will slice the body mesh at the origin of the local coordinate system and create pretension elements in the direction of the local coordinate system z-axis.
4. In the first load step only pretension loads are applied.
5. In the second load step, the relative motion of the pretension section is fixed (locked) and the other user loads are applied.
6. Results for the final configuration are brought back into Workbench. To see results from the first load step, the user should apply only pretension loads.

For sequenced simulation ...

The process described above for static simulations applies except you can “manually” specify the Lock and Open states for particular load steps. You can set the Open state for any load step, and you can set the Lock state for any load step except the first load step.
Limitations

The following limitations apply to using bolt loads:

- If you try to apply a preload on the same surface more than once, all definitions except the first one are ignored.
- Be sure that a sufficiently fine mesh exists on a surface or body that contains pretension bolt loads so that the mesh can be correctly partitioned along the axial direction (that is, at least 2 elements long).
- For simulating one bolt through multiple split surfaces, you should apply only one pretension bolt load to one of the split surfaces, as the bolt load will slice though the whole cylinder even though only part of the cylinder is selected.
- Care should be used when applying a pretension load to a cylindrical surface that has bonded contact. There is a possibility that if you apply a pretension load to a cylinder that had a bonded contact region, the bonded contact will block the ability of the pretension load to deform properly.
- The pretension load should be applied to cylindrical surfaces that contain the model volume (that is, do not try to apply the pretension load to a hole).

Moment

Distributes a moment about an axis across one or more flat or curved surfaces.

Define the moment vector in terms of either:

- a magnitude and direction (based on selected geometry) [Define By: Vector]
- components (in the world coordinate system or local coordinate system, if applied) [Define By: Components]

The moment is applied “about” the vector. Use the right-hand rule to determine the sense of the moment.
If you select multiple surfaces when defining the moment, the magnitude gets apportioned across all selected surfaces.

If a surface enlarges (e.g., due to a change in parameters), the total load applied to the surface remains constant, but the load per unit area decreases.

If you try to apply a moment to a multiple selection that spans multiple parts, the selection is ignored. The geometry property for the moment object displays 'No Selection' if the load was just created, or it maintains its previous geometry selection if there was one.

Note —

- If you are using a surface model, you can apply a moment load to an edge or vertex.
- While loads are associative with geometry changes, load directions are not. This applies to any load that requires a vector input, such as: moment, acceleration, rotational velocity, force, and bearing load.

**Generalized Plane Strain**

Used in 2-D applications involving generalized plane strain behavior.

The Details View includes settings for controlling the items listed below. Refer to Section : Using Generalized Plane Strain for detailed information on these settings and on the overall application of this load.

- Setting the x and y coordinates of the reference (starting) point.
- Establishing the magnitude and boundary conditions of the fiber direction. Choices for the boundary condition are:
  - Free
  - Force
  - Displacement

- Establishing the boundary conditions for rotation about the x-axis and the y-axis. Choices for the boundary conditions are:
  - Free
  - Moment
  - Rotation

Specific reactions are also reported in the Details View after solving.

**Thermal Condition**

Applies a uniform temperature (default) or non-uniform temperature throughout an environment in a static simulation. The initial value for a uniform temperature equals the reference temperature for the environment.

The non-uniform temperature is applicable to a thermal-stress simulation where this temperature is from another environment in the project that includes thermal results. The non-uniform temperature can be time dependent. For example, a temperature that occurs at a specific time in the results of a thermal transient simulation can be
used as the non-uniform temperature for a **Thermal Condition** load applied in the environment of a static simulation.

**To apply a uniform temperature:**

1. Set the **Environment** context toolbar to **Static**.
2. Insert a **Thermal Condition** load.
3. In the Details View, set **Thermal Condition** to **Uniform Temperature**.
4. In the **Uniform Temp** field, enter the value of the uniform temperature in your working units. The default value is the reference temperature for the environment.

**To apply a non-uniform temperature to an existing environment:**

1. Ensure that your project includes another environment with thermal solutions.
2. For the environment you want to solve, set the **Environment** context toolbar to **Static**.
3. Insert a **Thermal Condition** load.
4. In the Details View, set **Thermal Condition** to **Non-Uniform Temperature**.
5. In the **Thermal Environment** field, select the environment that includes the temperature result to be used as the non-uniform temperature in the environment you want to solve.
6. If the non-uniform temperature results are from a time transient simulation, a **Time** field is included in the Details View of the **Thermal Condition** load. In the **Time** field, enter the time that corresponds to the specific non-uniform temperature you want to apply. To determine the time, you may want to refer to a time history graph of this temperature. This graph is displayed in the **Worksheet** view of the **Transient Settings** object for the time transient **Solution**.

**Note** —

- If the environment that includes the non-uniform temperature does not exist (for example, if the environment was deleted), the **Thermal Condition** object changes to the underdefined state.
- **Convergence** objects inserted under an environment that is referenced by a **Thermal Condition** load object will invalidate the **Thermal Condition** object, and not allow a solution to progress.
- **Thermal Condition** objects cannot be copied from a single step environment to a multiple step sequenced environment, or vice-versa. Also, if you copy a **Thermal Condition** load from one sequenced environment to another, the number of steps must match between the two environments.

**To generate a new static environment from a thermal result:**

1. Click the right mouse button on a thermal result object in the tree.
2. Choose **Generate Static Environment with Thermal Condition** from the context menu. A new static **Environment** object named **Thermal Stress** is automatically added under the same **Model** object. Included in the environment is a **Thermal Condition** load and a **Total Deformation** result (under the **Solution** object). The **Thermal Condition** load is automatically set to a **Non-Uniform Temperature** in the Details View and to the name of the original environment that includes the thermal result. If the original environment was transient, the **Time** is set to that environment’s transient end time.
Note — If you choose **Generate Static Environment with Thermal Condition** to create more than one static environment, _each_ new environment object is named **Thermal Stress**. The object title is not incremented (**Thermal Stress 1, Thermal Stress 2**, etc.) as is the case if the **Model** object is duplicated.

**Inertia Relief**

Calculates accelerations to counterbalance the applied loads. Displacement constraints on the structure should only be those necessary to prevent rigid-body motions (6 for a 3-D structure). The sum of the reaction forces at the constraint points will be zero. Accelerations are calculated from the element mass matrices and the applied forces. Data needed to calculate the mass (such as density) must be input. Both translational and rotational accelerations may be calculated.

This option applies only to the structural, static, linear analyses. Displacements and stresses are calculated as usual.

**Motion Load**

The application interacts with motion simulation software such as Dynamic Designer™ from MSC, and MotionWorks from Solid Dynamics. Motion simulation software allows users to define and analyze the motion in an assembly of bodies. One of the computed results from the motion simulation is forces and moments at the joints between the bodies in the assembly. Choosing **Insert Motion Loads** (from the **Insert** menu or from a right-mouse click menu item on an **Environment**) allows you to import these loads into the **Environment**.

**Single Body Capability**

**Insert Motion Loads** is intended to work only with a single body from an assembly. If more than one body is unsuppressed in the **Model** during **Import**, you will receive an error message stating that only one body should be unsuppressed.

**Frame Loads File**

The application reads a text file produced by the motion simulation software. This file contains the load information for a single frame (time step) in the motion simulation. To study multiple frames, create multiple **Environment** objects for the **Model** and import each frame to a separate **Environment**. The frame loads file includes joint forces and inertial forces which “balance” the joint forces and gravity.

**Inertial State**

If the part of interest is a moving part in the assembly, the frame loads file gives the inertial state of the body. This includes gravitational acceleration, translational velocity and acceleration, and rotational velocity and acceleration. Of these inertial “loads” only the rotational velocity is applied in the environment. The remaining loads are accounted for by solving with inertia relief (see below).

If the part of interest is grounded (not allowed to move) in the motion simulation, corresponding supports need to be added in the environment before solving.

**Joint Loads**

For each joint in the motion simulation, the frame loads file reports the force data - moment, force, and 3D location - for the frame. Features are also identified so that the load can be applied to the appropriate face(s) within the application. These features are identified by the user in the motion simulation software before exporting the
frame loads file. For all nonzero moments and forces, a corresponding “Moment” and “Remote Force” are attached to the face(s) identified in the frame loads file.

The Remote Force takes into account the moment arm of the force applied to the joint.

**Solving with Inertia Relief**

Inertia relief is enabled when solving an environment with motion loads. Inertia relief balances the applied forces and moments by computing the equivalent translational and rotational velocities and accelerations. Inertia relief gives a more accurate balance than simply applying the inertia loads computed in the motion simulation.

Weak springs are also enabled. The computed reaction forces in the weak springs should be negligible.

This option will automatically be turned on if you import any motion loads.

*Note* — Material properties have to be manually set to match density used in motion analysis.

**Modifying Parts with Motion Loads**

If you modify a part having a motion load, you should rerun the solution in the motion simulator software (e.g., Dynamic Designer) and re-export the loads to Simulation. Then, in Simulation, you must update the geometry, delete the load (from the Environment object) and re-insert the motion load.

**Modifying Loads**

You can modify loads that have been inserted, but you should only do so with great care. Modifying loads in Simulation after importing from the motion simulation software will nullify the original loading conditions sets in the motion simulation software. Therefore, you need to examine your results in Simulation carefully.

See Inserting Motion Loads.

**Convection**

*Available for 3-D simulations, and 2-D simulations for Plane Stress and Axisymmetric behaviors only.*

Causes convective heat transfer to occur through one or more flat or curved surfaces (in contact with a fluid).
The bulk fluid temperature is uniform and measured at a distance from the surface outside of the thermal boundary layer. The surface temperature refers to the temperature at the surface of the simulation model.

The film coefficient (also called the heat transfer coefficient or unit thermal conductance) is based on the composition of the fluid in contact with the surface, the geometry of the surface, and the hydrodynamics of the fluid flow past the surface. It is possible to have a temperature dependent film coefficient. Temperature dependent convection coefficients are defined and managed using Engineering Data application. Refer to heat transfer handbooks or other references to obtain appropriate values for film coefficient.

The film coefficient value can be evaluated at the average film temperature (average of surface and bulk temperatures), the surface temperature, the bulk temperature, or the absolute value of the difference between bulk and surface temperatures. You can specify this evaluation procedure in Engineering Data using Coefficient Type in the Property Attributes section. Available coefficient types include:

- Average Film Temperature (default)
- Surface Temperature
- Bulk Temperature
- Difference of Surface and Bulk Temperature

Convective Heat Transfer

Convection is related to heat flux by use of Newton's law of cooling:

\[ \frac{q}{A} = h(t_s - t_f) \]

where

- \( \frac{q}{A} \) is heat flux out of the surface (calculated within the application)
- \( h \) is the film coefficient (you provide)
- \( t_s \) is the temperature on the surface (calculated within the application)
- \( t_f \) is the bulk fluid temperature (you provide)

When the fluid temperature exceeds surface temperature, energy flows into a part. When the surface temperature exceeds the fluid temperature, a part loses energy.

If you select multiple surfaces when defining convection, the same bulk fluid temperature and film coefficient is applied to all selected surfaces.

Temperature

Available for 3-D simulations, and 2-D simulations for Plane Stress and Axisymmetric behaviors only.

There are three types of temperatures:

- Known Surface Temperature
- Known Edge Temperature
- Known Vertex Temperature

Known Surface Temperature

Imposes a constant temperature on one or more flat or curved surfaces.
Temperature

If you select multiple surfaces when defining the temperature, the same value gets applied to all selected surfaces.

**Known Edge Temperature**

Imposes a constant temperature on one or more straight or curved edges.

Temperature

If you select multiple edges when defining the temperature, the same value gets applied to all selected edges.

**Known Vertex Temperature**

Imposes a temperature on one or more vertices.

Temperature

If you select multiple vertices when defining the temperature, the same value gets applied to all selected vertices.
**Radiation**

Applies thermal radiation to a face of a 3-D model, or to an edge of a 2-D model. All the radiation energy is exchanged with the *Ambient Temperature*, that is, the Form Factor\(^1\) is assumed to be 1.0.

You can set the following radiation properties in the Details View of a Radiation object:

- **Emissivity**: The ratio of the radiation emitted by a surface to the radiation emitted by a black body at the same temperature.
- **Ambient Temperature**: The temperature of the surrounding space.

*Note* — Radiation exchange between surfaces is restricted to *gray-diffuse* surfaces. *Gray* implies that emissivity and absorptivity of the surface do not depend on wavelength (either can depend on temperature). *Diffuse* signifies that emissivity and absorptivity do not depend on direction. For a gray-diffuse surface, emissivity = absorptivity; and emissivity + reflectivity = 1. Note that a black body surface has a unit emissivity.

1 - Refer to the Radiation chapter in the ANSYS Thermal Analysis Guide within the ANSYS Help for more information.

**Internal Heat Generation**

*Available for 3-D simulations, and 2-D simulations for Plane Stress and Axisymmetric behaviors only.*

Applies a uniform generation rate internal to a body.

A positive heat generation acts into a body, adding energy to it. Heat generation is defined as energy per unit time per unit volume.

If you select multiple bodies when defining the heat generation, the same value gets applied to all selected bodies.

If a body enlarges due to a change in CAD parameters, the total load applied to the body increases, but the heat generation remains constant.

**Heat Flux**

*Available for 3-D simulations, and 2-D simulations for Plane Stress and Axisymmetric behaviors only.*

Applies a uniform heat flux to one or more flat or curved surfaces.
Uniform positive heat flux

A positive heat flux acts into a surface, adding energy to a body. Heat flux is defined as energy per unit time per unit area.

If you select multiple surfaces when defining the heat flux, the same value gets applied to all selected surfaces.

If a surface enlarges due to a change in CAD parameters, the total load applied to the surface increases, but the heat flux remains constant.

Heat Flow

Available for 3-D simulations, and 2-D simulations for Plane Stress and Axisymmetric behaviors only.

There are three types of Heat Flow Rates:

- Surface Heat Flow Rate
- Edge Heat Flow Rate
- Vertex Heat Flow Rate

Surface Heat Flow Rate

Specifies the rate of heat flow through one or more flat or curved surfaces.
Positive heat flow

A positive heat flow acts into a surface, adding energy to a body. Heat flow is defined as energy per unit time.

If you select multiple surfaces when defining the heat flow rate, the magnitude gets apportioned across all selected surfaces.

If a surface enlarges due to a change in CAD parameters, the total load applied to the surface remains constant, but the heat flux (heat flow rate per unit area) decreases.

If you try to apply a heat flow to a multiple surface selection that spans multiple bodies, the surface selection is ignored. The geometry property for the load object displays No Selection if the load was just created, or it maintains its previous geometry selection if there was one.

**Edge Heat Flow Rate**

Specifies the rate of heat flow through one or more straight or curved edges.

![Diagram of heat flow through an edge](image)

Positive heat flow

A positive heat flow acts into an edge, adding energy to a body. Heat flow is defined as energy per unit time.

If you select multiple edges when defining the heat flow rate, the magnitude gets apportioned across all selected edges.

If an edge enlarges due to a change in CAD parameters, the total load applied to the edge remains constant, but the line load (heat flow rate per unit length) decreases.

If you try to apply a heat flow to a multiple edge selection that spans multiple bodies, the edge selection is ignored. The geometry property for the load object displays No Selection if the load was just created, or it maintains its previous geometry selection if there was one.

**Vertex Heat Flow Rate**

Specifies the rate of heat flow through one or more vertices.
Positive heat flow

A positive heat flow acts into a vertex, adding energy to the body. Heat flow is defined as energy per unit time.

If you select multiple vertices when defining the heat flow rate, the magnitude gets apportioned among all selected vertices.

If you try to apply a heat flow to a multiple vertex selection that spans multiple bodies, the vertex selection is ignored. The geometry property for the load object displays No Selection if the load was just created, or it maintains its previous geometry selection if there was one.

Perfectly Insulated

Available for 3-D simulations, and 2-D simulations for Plane Stress and Axisymmetric behaviors only.

Overrides or applies a “no load” insulated condition to a surface.

An insulated surface is a no load condition meant to override any thermal loads scoped to a body. The heat flow rate is 0 across this surface. This load is useful in a case where most of a model is exposed to a given condition (such a free air convection) and only a couple of surfaces do not share this condition (such as the base of a cup that is grounded). This load will override only thermal loads scoped to a body. See Resolving Thermal Boundary Condition Conflicts for a discussion on thermal load precedence.

If you select multiple surfaces when defining an insulated surface, all selected surfaces will be insulated.

Electromagnetic Boundary Conditions and Excitations

You can apply electromagnetic excitations and boundary conditions to surfaces in Simulation. A boundary condition is considered to be a constraint on the field domain. An excitation is considered to be a non-zero boundary condition which causes an electric or magnetic excitation to the system. Boundary conditions are applied to the field domain at exterior faces. Excitations are applied to conductors.

- Section : Magnetic Flux Boundary Conditions
- Section : Conductor
  - Section : Solid Conductor Body
    - Section : Voltage Excitation for Solid Conductors
    - Section : Current Excitation for Solid Conductors
  - Section : Winding Conductor Body
Magnetic Flux Boundary Conditions

*Available for 3-D simulations only.*

Magnetic flux boundary conditions impose constraints on the direction of the magnetic flux on a model boundary. This boundary condition may only be applied to surfaces. By default, this feature constrains the flux to be normal to all exterior faces.

Selecting Flux Parallel forces the magnetic flux in a model to flow parallel to the selected surface. In the figure below, the arrows indicate the direction of the magnetic flux. It can be seen that the flux flows parallel to the xy plane (for any z coordinate).

A flux parallel condition is required on at least one surface of the simulation model. It is typically applied on the outer faces of the air body to contain the magnetic flux inside the simulation domain or on symmetry plane surfaces where the flux is known to flow parallel to the surface.

To set this feature, right-click on the **Environment** item in the Tree View and select **Magnetic Flux Parallel** from the context menu or select **Magnetic Flux Parallel** from the drop-down **Electromagnetic** menu in the toolbar. It can only be applied to geometry surfaces and Named Selections (surfaces).
Half-symmetry model of a keepered magnet system. Note that the XY-plane is a Flux Parallel boundary. The flux arrows flow parallel to the plane.

Half-symmetry model of a keepered magnet system. Note that the YZ-plane is a Flux Normal boundary. The flux arrows flow normal to the plane. This is a natural boundary condition and requires no specification.
Note — Applying the flux parallel boundary conditions to the exterior surfaces of the air domain may artificially capture more flux in the simulation domain than what physically occurs. This is because the simulation model truncates the open air domain. To minimize the effect, ensure the air domain extends far enough away from the physical structure. Alternatively, the exterior surfaces of the air domain may be left with an unspecified surface boundary condition. An unspecified exposed exterior surface imposes a condition whereby the flux flows normal to the surface. Keep in mind that at least one surface in the model must have a flux parallel boundary condition.

**Conductor**

*Available for 3-D simulations only.*

A conductor body provides current excitation to a magnetic field simulation. Conductor bodies may be defined from solid CAD geometry, or, in special cases, from a CAD line-body.

Solid CAD geometry is typically used to model solid conductors such as bus bars, rotor cages, etc. In solid conductors, the current can distribute non-uniformly due to geometry changes, hence the program performs a simulation that solves for the currents in the solid conductor prior to computing the magnetic field.

Line bodies, created in DesignModeler and promoted to a Winding Body, can be used to represent wound coils. Wound coils are used most often as sources of current excitation for rotating machines, actuators, sensors, etc. When the DesignModeler geometry is attached to Simulation, all winding bodies are assigned as Winding Conductor bodies. You may directly define a current for each winding conductor body.

- Section : Solid Conductor Body
- Section : Winding Conductor Body

**Solid Conductor Body**

This feature allows you to tag a solid body as a conductor. A conductor body is characterized as a body that can carry current and possible excitation to the system. When assigned as a conductor, additional options are exposed for applying electrical boundary conditions and excitations to the conductor. These include applying an electrical potential (voltage) or current. (See Section : Voltage Excitation for Solid Conductors and Section : Current Excitation for Solid Conductors.)

To set this condition, right-click the Environment object in the Tree View and select Conductor from the Insert drop-down menu. Select the body you want to designate as a conductor body, then use the Details view to scope the body to the conductor. The default Number of Turns is 1, representing a true solid conductor. To approximate a wound conductor, you can set the Number of Turns for the coil to a value greater than 1.

After defining the conductor body, you may apply voltage and current conditions to arrive at the desired state.
Note — Conductors require two material properties: relative permeability and resistivity. They also must not terminate interior to the model with boundary conditions that would allow current to enter or exit the conductor. Termination points of a conductor may only exist on a plane of symmetry.
Only bodies can be scoped to a conductor. Solid conductor bodies must have at least one voltage excitation and either a second voltage excitation or a current excitation. Also, two solid conductor bodies may not ‘touch’ each other, i.e. they must not share vertices, edges, or surfaces.

To establish current in the conductor, you must apply excitation to at least two locations on the conductor, typically at terminals. For example, you could

- apply a voltage drop at two terminals of a conductor body residing at symmetry planes.

- ground one end of a conductor (set voltage to zero) and apply the net current at the terminal’s other end.
Voltage Excitation for Solid Conductors

This feature allows you to apply an electric potential (voltage) to a conductor body. A voltage excitation is required on a conductor body to establish a ground potential. You may also apply one to apply a non-zero voltage excitation at another location to initiate current flow. Voltage excitations may only be applied to surfaces.

To apply a voltage excitation to a conductor body, right-click on the Conductor object under the Environment object in the Tree View and select Voltage from the Insert drop-down menu.

You define the voltage by magnitude and phase angle in the Details View, according to the equation below.

\[ V = V_0 \cos(\omega t + \phi) \]

\( V_0 \) is the magnitude of the voltage (input value Voltage), \( \omega \) is the frequency, and \( \phi \) is the phase angle. For a static analysis, \( \omega t = 0 \).

Note — Voltage excitations may only be applied to conductor bodies and at symmetry planes.

An applied voltage drop across the terminals of a conductor body will induce a current. In this simple example, the current in the conductor is related to the applied voltage drop, using the equations shown below. \( \Delta V = \) applied voltage drop, \( I = \) current, \( \rho = \) resistivity of the conductor (material property), \( L = \) length of the conductor, and \( \text{Area} = \) cross section area of the conductor.

\[ \Delta V = IR \]

\[ R = (\rho \times L)/\text{Area} \]
Current Excitation for Solid Conductors

This feature allows you to apply a current to a conductor body. Use this feature when you know the amount of current in the conductor.

To apply a current excitation to a conductor body, right-click on the Conductor object under the Environment object in the Tree View and select Current from the Insert drop-down menu. A positive current applied to a surface flows into the conductor body. A negative current applied to a surface flows out of the conductor body.

You define the current by magnitude and phase angle in the Details View, according to the equation below.

\[ I = I_o \cos(\omega t + \phi) \]

\( I_o \) is the magnitude of the current (input value Current), \( \omega \) is the frequency, and \( \phi \) is the phase angle. For a static analysis, \( \omega t = 0 \).

Note — Current excitations may only be applied to a surface of a conductor body at symmetry planes. An excitation must be accompanied by a ground potential set at another termination point of the conductor body on another symmetry plane. No current may be applied to a conductor body surface interior to the model domain. The symmetry plane on which the current excitation is applied must also have a magnetic flux-parallel boundary condition.

An applied current to a conductor surface will calculate and distribute the current within the conductor body. A ground potential (voltage=0) must be applied to a termination point of the conductor body.

Both the applied current and voltage constraints must be applied at a symmetry plane.
Winding Conductor Body

Winding bodies are created in DesignModeler (see Section: Body Types). This is a special class of line bodies intended to model wound coil forms. They can be used in lieu of three-dimensional CAD geometry to create conductor sources for electromagnetic simulations. This can provide significant time savings in modeling.

When Simulation attaches to the DesignModeler geometry, winding bodies are brought into Simulation and designated as conductor bodies. Any future update of the CAD geometry from DesignModeler will not update the winding conductor bodies. The geometry update may reposition winding bodies, but any added or deleted winding bodies will not be brought over as conductor bodies.

Winding conductor bodies are applicable to any magnetic field problem where the source of excitation comes from a coil. The coil must have a rectangular cross section (defined in DesignModeler) and a defined number of coil “turns.” Winding body geometry is limited to constructs of bars and arcs. The first image below shows a “racetrack” conductor body constructed from four bar and four arc edges. The second image shows a winding body created from a single circular arc. Source loading for a coil is by a defined current (per turn) and a phase angle.

Figure 3  Racetrack Coil Configuration
After a winding body geometry is passed to Simulation and automatically assigned as a conductor body, you can view information about the body in the Details View. Current can be defined in the Details View as well, by magnitude and phase angle according to the equation below.

\[ I = I_0 \cos(\omega t + \phi) \]

\( I_0 \) is the magnitude of the current (input value Current), \( \omega \) is the frequency, and \( \phi \) is the phase angle. For a static analysis, \( \omega t = 0 \). The direction of the current is determined by the tangent orientation vector (blue arrow) in DesignModeler. A positive or negative assigned value of current will be respective to that orientation vector.

The winding conductor body appears as a yellow line in Simulation displays. When the model is meshed, the body is displayed with the cross section information passed from DesignModeler.

Winding conductor bodies cannot take advantage of model symmetry like solid conductor bodies. Instead, they must be modeled in full, even if the underlying solid geometry is modeled in symmetry. This is illustrated in the figures below. In this case, a one-quarter symmetry CAD model of an actuator is modeled. The winding conductor body must be modeled in full symmetry.
Figure 5  1/4 Symmetry Model of Actuator
Harmonic Loads

You can use the following loads in a harmonic analysis:

- Acceleration
- Pressure
- Force (applied to a surface, edge, or vertex)
- Bearing load
- Moment
- Given (Specified) displacement
- Remote Force
- Remote Displacements

You can apply multiple loads to the same surface. The following restrictions apply to harmonic loads:

- All loads must be sinusoidally time-varying.
- All loads must have the same frequency.
- No nonlinearities are permitted.
- Transient effects are not calculated.
- Thermal loads are not supported.

To create a harmonic load, select **Harmonic** in the drop down menu on the **Environment** toolbar before choosing a load. For pressures, forces (vertex, edge, or surface), and given (specified) displacements, you can set the **Phase Angle**.
Resolving Thermal Boundary Condition Conflicts

Conflicts between boundary conditions scoped to parts and individual surfaces

Boundary conditions applied to individual geometry surfaces always override those that are scoped to a part(s). For conflicts associated with various boundary conditions, the order of precedence is as follows:

1. Applied temperatures (Highest).
2. Convection, heat fluxes, and flows (Cumulative, but overridden by applied temperatures).
3. Insulated (Lowest. Overridden by all of the above).

How to Apply Loads

To apply a load, you must have an Environment object selected in the tree.

To apply loads from the toolbar or from the Insert menu:

1. Select the appropriate geometry on the model.
2. Click on the appropriate icon on the toolbar or select Insert> Environment Item> load type and select the load.
3. Go to the Details View and type in the appropriate values on any highlighted item, such as direction, magnitude, etc. For loads that vary with temperature (Convections) or time (Load Histories - used in Thermal Transient Simulations), use the Define As field to classify the load as either Temperature-Dependent for convections or Load History for transient simulations. You can modify the tabular data for these loads in Engineering Data. You can also import engineering data, that is, Convections or Load Histories from an existing library, into Simulation.
4. You can also use the Section : Simulation Wizard to walk through these steps.

To apply loads via right mouse click:

1. Select the appropriate geometry on the model and right-click the mouse.
2. Select Insert and choose the load type.
3. Go to the Details View and type in the appropriate values on any highlighted item, such as direction, magnitude, etc. For loads that vary with temperature (Convections) or time (Load Histories - used in Thermal Transient Simulations), use the Define As field to classify the load as either Temperature-Dependent for convections or Load History for transient simulations. You can modify the tabular data for these loads in Engineering Data. You can also import engineering data, that is, Convections or Load Histories from an existing library, into Simulation.
Using Simulation Features

Thermal Transient Simulations), use the Define As field to classify the load as either Temperature-Dependent for convections or Load History for transient simulations. You can modify the tabular data for these loads in Engineering Data. You can also import engineering data, that is, new Convections or Load Histories, into Simulation.

4. Repeat for all required loads.

The availability of the types of loads and supports you can insert is dependent on the settings in the Physics Filter located in the View menu.

For most loads, the Details View includes settings for you to specify the Scoping Method to either the geometry where the load is to be applied (Geometry Selection) or to a Named Selection. If you want to move a load from one part of a model to another, click the Geometry field, click on the new model location, then click Apply.

Inserting Motion Loads

You must make sure the files and data are up to date and consistent when analyzing motion loads. Use the following procedure to ensure that the correct loads are applied for a given time frame.

To insert motion loads after solving the motion simulation:

1. Advance the motion simulation to the frame of interest.
2. Export the frame loads file from the motion software.
3. Attach the desired geometry.
4. Suppress all bodies except the one of interest.
5. Click Environment in the tree outline, then right-click and select Insert> Motion Loads.
6. Select the Frame Load file that you exported from Dynamic Designer.
7. Click Solve. If more than one body is unsuppressed in the Model corresponding to the Environment, you will receive an error message at the time of solution stating that only one body should be unsuppressed.
8. View the results.

The exported loads depend on the part geometry, the part material properties, and the part’s location relative to the coordinate system in the part document. When any of these factors change, you must solve the motion simulation again by repeating the full procedure. Verify that material properties such as density are consistent in the motion simulation and in the material properties.

Insert Motion Loads is intended to work with a single body only. Results with grounded bodies (bodies not in motion in the mechanism) are not currently supported.

If an assembly feature (such as a hole) is added after Dynamic Designer generates its Joint attachments for FEA, the attachments may become invalid. These attachments can be verified by opening the Properties dialog box for a Joint and selecting the FEA tab. An invalid attachment will have a red "X" through the icon. To correct this problem, manually redefine the joint attachments using the FEA tab in the Joint Properties dialog.

A .log file is created when motion loads are imported. This troubleshooting file has the same name (with an .log extension) and file location as the load file. If the .log file already exists, it is overwritten by the new file.

Direction

There are four types of Direction:
Planar Face
Edge
Cylindrical Surface or Geometric Axis
Two Vertices

**Planar Face**

![Selected planar face. The load is directed normal to the surface.](image)

*Note* — Not applicable to rotational velocity. Rotational velocity gets aligned along the normal to a planar face and along the axis of a cylindrical surface.

**Edge**

**Straight**
Colinear to the edge

**Circular or Elliptical**
Normal to the plane containing the edge

![Selected straight edge](image)

**Cylindrical Surface or Geometric Axis**

Applies to cylinders, cones, tori, and cylindrical or conical fillets
Scope

Scope refers to geometry over which load/support applies. If you apply a force of 1000N in the X-direction, applied to a vertex, the load is “scoped” to that vertex. You can “scope” that load to some other geometry such as a surface.

Environment objects in general can be scoped (such as force, pressure, temperature) to geometry that you select, or to a named selection. Some Environment objects, such as acceleration, cannot be scoped.

Shared faces exist in the case of multi body parts. Contact regions, pressures, surface forces, surface moments, compression only supports, bearing loads, remote forces, convections, heat fluxes, and heat flows are not allowed to be applied to shared faces.

Types of Supports

Fixed

Section : Fixed Surface
Section : Fixed Edge
Section : Fixed Vertex
Displacement

- Section: Displacement for Surfaces
- Section: Displacement for Edges
- Section: Displacement for Vertices
- Section: Remote Displacement

Frictionless Support

- Section: Frictionless Surface

Compression Only Support

Cylindrical Support

Simply Supported

- Section: Simply Supported Edge
- Section: Simply Supported Vertex

Fixed Rotation

- Fixed Surface Rotation
- Fixed Edge Rotation
- Fixed Vertex Rotation

Fixed Surface

Prevents one or more flat or curved surfaces from moving or deforming.

Fixed Edge

Prevents one or more straight or curved edges from moving or deforming.
Immobilized edge (e.g., of a bolt hole)

A fixed edge is not realistic and leads to singular stresses (that is, stresses that approach infinity near the fixed edge). You should disregard stress and elastic strain values in the vicinity of the fixed edge.

**Fixed Vertex**

Prevents one or more vertices from moving.

Immobilized vertex

A fixed vertex fixes both translations and rotations on surfaces or line bodies.

A fixed vertex is not realistic and leads to singular stresses (that is, stresses that approach infinity near the fixed vertex). You should disregard stress and elastic strain values in the vicinity of the fixed vertex.

If you are using a surface model, see Section: Simply Supported Vertex.

**Displacement for Surfaces**

Requires one or more flat or curved surfaces to displace relative to their original location by one or more components of a displacement vector in the world coordinate system or local coordinate system, if applied.
Nonzero X-, Y-, and Z-components. The surface retains its original shape but moves relative to its original location by the specified displacement vector. The enforced displacement of the surface causes a model to deform.

Zero Y-component. No part of the surface can move, rotate, or deform in the Y-direction.

Blank (undefined) X- and Z-components. The surface is free to move, rotate, and deform in the XZ plane.

Use multiple select to apply a displacement load to more than one surface.

Note —

- Entering a zero for a component prevents deformation in that direction.
- Entering a blank for a component allows free deformation in that direction.
- Avoid using multiple Displacements on the same surface and on surfaces having shared edges.

**Displacement for Edges**

Requires one or more flat or curved edges to displace relative to their original location by one or more components of a displacement vector in the world coordinate system or local coordinate system, if applied.
Nonzero X-, Y-, and Z-components. The edge retains its original shape but moves relative to its original location by the specified displacement vector. The enforced displacement of the edge causes a model to deform.

Zero Y-component. No part of the edge can move, rotate, or deform in the Y-direction.

Blank (undefined) X- and Z-components. The edge is free to move, rotate, and deform in the XZ plane.

Use multiple select to apply a displacement load to more than one edge.

Note —

- Entering a zero for a component prevents deformation in that direction.
- Entering a blank for a component allows free deformation in that direction.
- Avoid using multiple Displacements on the same edge and on edges having shared vertices.

Enforced displacement of an edge is not realistic and leads to singular stresses (that is, stresses that approach infinity near the loaded edge). You should disregard stress and elastic strain values in the vicinity of the loaded edge.

Displacement for Vertices

Requires one or more vertices to displace relative to their original location by one or more components of a displacement vector in the world coordinate system or local coordinate system, if applied.
Nonzero X-, Y-, and Z-components. The vertex moves relative to its original location by the specified displacement vector. The enforced displacement of the vertex causes a model to deform.

Zero Y-component. The vertex cannot move in the Y-direction.

Blank (undefined) X- and Z-components. The vertex is free to move in the XZ plane.

Use multiple select to apply a displacement load to more than one vertex.

Note —

- Entering a zero for a component prevents deformation in that direction.
- Entering a blank for a component allows free deformation in that direction.
- Avoid using multiple Displacements on the same vertex.

Enforced displacement of a vertex is not realistic and leads to singular stresses (that is, stresses that approach infinity near the loaded vertex). You should disregard stress and elastic strain values in the vicinity of the loaded vertex.

**Remote Displacement**

A Remote Displacement allows you to apply both displacements and rotations at an arbitrary remote location in space. You specify the origin of the remote location under **Scope** in the Details View by picking, or by entering the XYZ coordinates directly. The default location is at the origin of the global coordinate system. You specify the displacement and rotation under **Definition**.

The location and the direction of a Remote Displacement can be defined in the global coordinate system or in a local Cartesian coordinate system. A common application is to apply a rotation on a model at a local coordinate system. An example is shown below along with a plot of the resulting Total Deformation.
You can also specify the Behavior of the scoped geometry for a Remote Displacement in the Details View as either Rigid or Deformable. You must determine which Behavior best represents the actual loading. Presented below are examples of the Total Deformation resulting from the same Remote Displacement applied first to a Rigid body, then to a Deformable body.
You are advised to check reaction forces to ensure that a Remote Displacement has been fully applied, especially if the load shares geometry with Remote Force, Remote Mass, or Moment loads. The underlying reason why this load may not be fully applied is because it and the other loads mentioned all make use of MPC contact used in core ANSYS. See the ANSYS Contact Technology Guide in the core ANSYS Help for more information.

**Frictionless Surface**

Prevents one or more flat or curved surfaces from moving or deforming in the normal direction.
Normal direction relative to the surface. No portion of the surface can move, rotate, or deform normal to the surface.

Tangential directions. The surface is free to move, rotate, and deform tangential to the surface.

For a flat surface, the frictionless support is equivalent to a symmetry condition.

**Compression Only Support**

Applies a compression only constraint normal to one or more surfaces.

Consider the following model with a bearing load and supports as shown.

Note the effect of the compression only support in the animation of total deformation.

*The following is an animated GIF. Please view online if you are reading the PDF version of the help.*
Since the region of the surfaces in compression is not initially known, a nonlinear solution is required and may involve a substantial increase in solution time.

**Cylindrical Support**

For 3-D simulations, prevents one or more cylindrical surfaces from moving or deforming in combinations of radial, axial, or tangential directions. Any combination of fixed and free radial, axial, and tangential settings are allowed.
Radial directions relative to the cylinder (Fixed). Such cylindrical surfaces cannot move, rotate, or deform radially to the cylinder.

Axial directions relative to the cylinder (Fixed). Such cylindrical surfaces cannot move, rotate, or deform axially to the cylinder.

Tangential direction relative to the cylinder (Fixed). Such cylindrical surfaces cannot move, rotate, or deform tangentially to the cylinder.

Axial and tangential directions (Free). The cylinder is free to move, rotate, and deform axially and tangentially.

Radial and tangential directions (Free). The cylinder is free to move, rotate, and deform radially and tangentially.

Radial and axial directions (Free). The cylinder is free to move, rotate, and deform radially and axially.

For 2-D simulations, cylindrical supports can only be applied to circular edges.

**Simply Supported Edge**

*Available for 3-D simulations only.*

- Edge is fixed in all directions.

- Rotation, however, is permitted about the edge.

Applicable for surface models or line models only.

Prevents one or more straight or curved edges from moving or deforming but rotations about the line are allowed. If you want to fix the rotations as well, use Section : Fixed Edge.

**Simply Supported Vertex**

*Available for 3-D simulations only.*
Vertex is fixed in all directions.

Rotations, however, are permitted.

Applicable for surface models or line models only.

Prevents one or more vertices from moving. Rotation about the vertex is allowed. If you want to prevent rotations, use Section: Fixed Vertex.

A simply supported vertex is not realistic and leads to singular stresses (that is, stresses that approach infinity near the simply supported vertex). You should disregard stress and elastic strain values in the vicinity of the simply supported vertex.

**Fixed Surface Rotation**

*Only available for:*

- 3-D simulations.
- *Surface, edge, and vertex entities of shells.*

Prevents one or more flat or curved surfaces from rotating.

**Fixed Edge Rotation**

*Available for 3-D simulations only.*

Prevents one or more straight or curved edges from rotating.
Fixed Vertex Rotation

Available for 3-D simulations only.

- Vertex is free in all directions.
- Rotations, however, are fixed.

Applicable for surface models or line models only.

Prevents one or more vertices from rotating. Translation of the vertex is allowed. If you want to prevent translations, use either Section : Fixed Vertex or Section : Simply Supported Vertex.

A fixed vertex rotation support is not realistic and leads to singular stresses (that is, stresses that approach infinity near the fixed vertex rotation support). You should disregard stress and elastic strain values in the vicinity of the fixed vertex rotation support.

Applying Loads Demonstration

The following is a demonstration of applying loads (also applies to supports). For best possible viewing, maximize the window. To restart the demonstration, click Applying Load> Applying Loads Demonstration in the Table of Contents.

The following is an animated GIF. Please view online if you are reading the PDF version of the help.
Load ANSYS

Simulation can solve most linear static 3D analyses; however, for other types of problems you will need to transfer the model to ANSYS to complete the analysis. You can send a model to ANSYS from the Project Page by choosing this option in the left panel. Keep in mind that only the finite element model is transferred to ANSYS. Also, some commands that are automatically created in Workbench may not have the same default values they have if they are created directly in ANSYS.

Finite element data (element type, nodes, elements), boundary conditions, and components are transferred to ANSYS. Solid model information is not transferred. You can use the ANSYS Workbench’s ability to create node components based on geometry to more easily manipulate the model once in ANSYS environment.

Any named selection group from Simulation is transferred to ANSYS as a component according to specific naming rules and conventions.

While you can go back to the ANSYS Workbench by clicking any of the Workbench tabs, no data is returned. You receive a message stating that operations you performed while in ANSYS are not automatically recorded in ANSYS Workbench. The message then prompts you to save a copy of the ANSYS database and command log.
### Table 1 A Model Transferred to ANSYS

<table>
<thead>
<tr>
<th>Description</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>A solid model in the ANSYS Workbench.</td>
<td><img src="image1.png" alt="Solid Model" /></td>
</tr>
<tr>
<td>The finite element model after transfer to ANSYS.</td>
<td><img src="image2.png" alt="Finite Element Model" /></td>
</tr>
<tr>
<td>An element plot of the same model in ANSYS.</td>
<td><img src="image3.png" alt="Element Plot" /></td>
</tr>
</tbody>
</table>

[Simulation Help . © SAS IP, Inc.]
Results

Depending on the type of simulation, you can view the following results:

- Section : Nonlinear (Solution Information)
- Section : Stress Tools
- Section : Fatigue (Fatigue Tool)
- Contact (Contact Tool)
- Beam Stresses (Beam Tool)
- Section : Frequencies (Frequency Finder)
- Section : Buckling
- Section : Harmonics (Harmonic Tool)
- Section : Stress/Strain
- Section : Deformation
- Section : Thermal
- Section : Shape Environments
- Section : Electromagnetic
- Reactions
- Probe Tool

To form results, Simulation averages across geometric discontinuities, but does not average across bodies. Also, contact results are averaged across all contact regions, not across individual regions.

To insert a result, you must highlight a Solution object in the tree. You can then select the appropriate result: Tools, Stress, Elastic Strain, Deformation, Thermal, or Frequency from the Solution Context Toolbar or use the Insert menu (Insert> Solution Item> result), or use the right-mouse click option to insert an object. In addition, you can Section : Scope your results.

Note — If you Duplicate a Fatigue Tool or a Contact Tool (Edit > Duplicate or through a right mouse button click on the tool), the result items are unsolved in the duplicated tool. After duplicating the tool, you must choose Solve to obtain a solution for the duplicated tool.

The following table indicates which bodies can be represented by the various choices available in the drop-down menus of the Solution toolbar.

<table>
<thead>
<tr>
<th>Body</th>
<th>Tools</th>
<th>Stress</th>
<th>Elastic Strain</th>
<th>Deformation</th>
<th>Thermal</th>
<th>Shape</th>
<th>Electromagnetic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solids</td>
<td>All choices¹</td>
<td>All choices</td>
<td>All choices</td>
<td>All choices</td>
<td>All choices</td>
<td>All choices</td>
<td>All choices²</td>
</tr>
<tr>
<td>Surfaces</td>
<td>All choices¹</td>
<td>All choices</td>
<td>All choices</td>
<td>All choices</td>
<td>All choices</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Lines</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>All choices</td>
<td>Temperature</td>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

1 - Contact results are not reported, and are not applicable to the following:

- Edges.
- MPC contact.
Target side of asymmetric contact.

2 - Electric Potential, Inductance, and Flux Linkage can only be scoped to conductor bodies.

**Scoping Results**

Most result objects (such as stress, stress tool, fatigue life, temperature) can be scoped to edges, a single vertex, surfaces, parts, bodies, or the entire assembly. When you scope results to contiguous edges, a graph is superimposed on the model that shows the variation of the result along the length of the scoped edges, except for shell edges and closed circles. The same graph is displayed when you click on the Worksheet tab.

Frequency results cannot be scoped. Shape results can be scoped only to the assembly, parts, or bodies. Harmonic response results can be scoped only on vertices, or edges, or faces.

Once a solution is computed, the scope of the result object cannot change. You must either add a new result object with the desired scope, or you can right mouse click on that result item, and choose **Clean** to change its scope.

Result scoping has an impact on convergence. Refinement doesn’t happen outside the scope for a given convergence control. Multiple convergence controls are possible, however.

Results cannot be scoped to shared faces that exist in multi body parts.

**Cleaning Results Data**

You can clear results and meshing data from the database using the **Clean** command from the **File** menu, or from a right-mouse click menu item. This reduces the size of the database file, which can be useful for archiving.

To clean all results data, simply select the **Solution** object and choose the **Clean** menu item from the **File** menu or from a right-mouse click menu. You can clean individual results by selecting a result object before choosing the **Clean** menu item.

**Renaming Results Based on Definition**

The option **Rename Based on Definition** is available when you right mouse click on any result (under **Solution** objects), or any **Result Tracker** (under **Solution Information** objects). When you choose this option, Simulation automatically renames the result or **Result Tracker** based on the selected parts (for example, **Temperature** can be renamed to **Temperature on Tube**, or **Directional Deformation** can be renamed to **Directional Deformation on All Bodies**).

**Nonlinear (Solution Information)**

You can track, monitor, or diagnose problems that arise during a nonlinear solution by inserting a **Solution Information** object branch under a **Solution** object (RMB click, then **Insert> Solution Information> Solution Information**). When you select a **Solution Information** object in the tree, the following controls are available in the Details View:

- **Solution Output**: Determines how you want solution response results displayed. All of the options are displayed in real time as the solution progresses:
  - **Solver Output** (default): Displays the ANSYS solution output file (text). This option is useful for ANSYS users who are accustomed to viewing this type of output.

Choosing any of the following options displays a graph of that option as a function of **Cumulative Iteration**.
- Force Convergence
- Displacement Convergence
- Max DOF Increment
- Line Search
- Time
- Time Increment
- CSG Convergence (magnetic current segments)
- Heat Convergence

1 - All convergence plots include designations where any bisections, converged substeps, or converged load steps occur. These designations are the red, green, and blue dotted lines shown in the example below of a Force Convergence plot.

Newton-Raphson Residuals: Specifies the maximum number of Newton-Raphson residual forces to return. The default is 0 (no residuals returned). You can request that the Newton-Raphson residual restoring forces be brought back for nonlinear solutions that either do not converge or that you aborted during the solution. The Newton-Raphson force is calculated at each Newton-Raphson iteration and can give you an idea where the model is not satisfying equilibrium. If you select 10 residual forces and the solution doesn’t converge, those last 10 residual forces will be brought back. The following information is available in the Details View of a returned Newton-Raphson Residual Force object:

- Results - Minimum and Maximum residual forces across the model
- Convergence - Global convergence Criterion and convergence Value
- Information - Time based information
These results cannot be scoped and will automatically be deleted if another solution is run that either succeeds or creates a new set of residual forces.

- **Update Interval**: Specifies how often any of the result tracking items under a Solution Information object get updated while a solution is in progress. The default is **2.5** seconds.

### Result Tracker Objects

In addition to the real time solution response graphs you can view from the Solution Information object, you can also view graphs of specific displacement and contact results as a function of either time or cumulative iteration using Result Tracker objects. These objects are inserted as branch objects under a Solution Information object. To insert a Result Tracker object, select a Solution Information object in the tree and either choose an option under the Result Tracker drop-down menu in the Solution Information context toolbar, or perform a RMB click on the Result Tracker object, then Insert> Deformation or Insert> Contact. The following Result Tracker controls are in the Details View:

- **Deformation**: for displacement scoped to a vertex.
  - **Geometry**: Specifies vertex.
  - **Orientation**: Specifies X-Axis, Y-Axis, or Z-Axis.
  - **X-Axis Values**: Specifies either **Time** or **Cumulative Iteration** for the x-axis of the plot.

- **Contact**: for contact outputs scoped to a given contact pair.
  - **Contact Region**: Specifies the particular contact region in the pair. Default names are Contact Region and Contact Region 2.
  - **Type**: Specifies the particular contact output. For each of these options, the result tracking is performed on the Contact side of the pair. If you want to perform the result tracking on the Target side, you should flip the source and target sides. If this occurs you can change the contact region to Asymmetric and flip the source and target surfaces in order to specify the side of interest that is to be the contact side. If Auto Asymmetric contact is active (either by the Behavior contact region setting equaling Auto Asymmetric or by the Formulation setting equaling Augmented Lagrange or MPC) and the contact side is chosen by the program to be disabled, the Results Tracker will not contain any results (as signified by a value of -2 for Number Contacting output). Contact results will be valid depending on the type of contact (for example, edge-edge) and the contact formulation.
    - **Pressure**: Maximum pressure
    - **Penetration**: Maximum penetration
    - **Gap**: Minimum gap. The values will be reported as negative numbers to signify a gap. A value of zero is reported if the contact region is in contact (and thus has a penetration). Also, if the region is in far-field contact (contact surfaces are outside the pinball radius), then the gap will be equal to the resulting pinball size for the region.
    - **Frictional Stress**: Maximum frictional stress
    - **Sliding Distance**: Maximum sliding distance
    - **Number Sticking**: Number of elements that are sticking
    - **Number Contacting** (default): Number of elements in contact. A value of -1 means the contact pair is in far field contact (meaning the surfaces lie outside the contact pinball region).
    - **Chattering**: Maximum chattering level
→ **Elastic Slip**: Maximum elastic slip
→ **Normal Stiffness**: Maximum normal stiffness
→ **Max Tangential Stiffness**: Maximum tangential stiffness
→ **Min Tangential Stiffness**: Minimum tangential stiffness

→ **X-Axis Values**: Specifies either **Time** or **Cumulative Iteration** for the x-axis of the graph.

Multiple **Result Tracker** objects may be selected at the same time to create a combined chart assuming they share the same X and Y output types (such as pressure for Y and time for X). An example is shown here:

The **Result Tracker** has an option for renaming the object based on the result and the scoping. You choose the option in the context menu (RMB click). This option is useful in having the program create meaningful names of the result trackers. An example would be **Result Tracker 5** being renamed to **Pressure on Contact Region 2**.

**Result Tracker** objects can be exported to an Excel file by selecting **Export** in the context menu using a right-mouse button click on the **Result Tracker** object.
Note — You must right-mouse click on the selected object in the tree to use this Export feature. On Windows platforms, if you have the Microsoft Office 2002 (or later) installed, you may see an Export to Excel option if you right-mouse click in the Worksheet tab. This is not the Simulation Export feature but rather an option generated by Microsoft Internet Explorer.

A Note on Solution Information and Result Tracker Plots

Any of the graphs created by either the Result Tracker or nonlinear convergence items have the following features:

- The graph can be zoomed by using the [ALT] key + left mouse button. Moving down and to the right zooms in, and moving up and to the left zooms out.
- A plot can be saved by using the Image Capture toolbar button.
- If a new Result Tracker is added to an otherwise up to date solution, a new solution will not be invoked automatically. In order for the new result to be solved, you must Clean at the Solution level and then resolve (which will force a complete resolve and thus fill the result tracker).

Caution: Because nodes may be rotated, deformation Result Trackers may not record the expected component of the deformation. Should this occur, a warning message alerting you to this will appear after the solve in the Details View of the Solution object, in the Solver Messages field. This situation can occur when Result Trackers are adjacent to supported surfaces, lines, or vertices. One possible approach to avoid this situation is to add 3 deformation Result Trackers, one for each of the x, y, and z directions. This will ensure that the tracker is showing all deformation of that vertex of the model.

Stress Tools

You can insert any of the following stress tools in a Solution object by choosing Stress Tool under Tools in the Solution context toolbar, or by using a right mouse button click on a Solution object and choosing Stress Tool:

- Section : Maximum Equivalent Stress Safety Tool
- Section : Maximum Shear Stress Safety Tool
- Section : Mohr-Coulomb Stress Safety Tool
- Section : Maximum Tensile Stress Safety Tool

After adding a Stress Tool object to the tree, you can change the specific stress tool under Theory in the Details View.

Maximum Equivalent Stress Safety Tool

The Maximum Equivalent Stress Safety tool is based on the maximum equivalent stress failure theory for ductile materials, also referred to as the von Mises-Hencky theory, octahedral shear stress theory, or maximum distortion (or shear) energy theory. Of the four failure theories supported by Simulation, this theory is generally considered as the most appropriate for ductile materials such as aluminum, brass and steel.

The theory states that a particular combination of principal stresses causes failure if the maximum equivalent stress in a structure equals or exceeds a specific stress limit:

$$\sigma_e \geq S_{\text{limit}}$$

Expressing the theory as a design goal:

$$\frac{\sigma_e}{S_{\text{limit}}} < 1$$
If failure is defined by material yielding, it follows that the design goal is to limit the maximum equivalent stress to be less than the yield strength of the material:

\[
\frac{\sigma_e}{S_y} < 1
\]

An alternate but less common definition states that fracturing occurs when the maximum equivalent stress reaches or exceeds the ultimate strength of the material:

\[
\frac{\sigma_e}{S_u} < 1
\]

**Options**

Define the stress limit in the Details View under **Stress Limit Type**. Use either **Tensile Yield Per Material**, or **Tensile Ultimate Per Material**, or enter a **Custom Value**. By default, **Stress Limit Type** equals **Tensile Yield Per Material**.

Choose a specific result from the **Stress Tool** context toolbar or by inserting a stress tool result using a right mouse button click on **Stress Tool**:

**Safety Factor**

\[
F_s = \frac{S_{\text{limit}}}{\sigma_e}
\]

**Safety Margin**

\[
M_s = F_s - 1 = \frac{S_{\text{limit}}}{\sigma_e} - 1
\]

**Stress Ratio**

\[
\sigma_e^* = \frac{\sigma_e}{S_{\text{limit}}}
\]

**Notes**

- The reliability of this failure theory depends on the accuracy of calculated results and the representation of stress risers (peak stresses). Stress risers play an important role if, for example, yielding at local discontinuities (e.g., notches, holes, fillets) and fatigue loading are of concern. If calculated results are suspect, consider the calculated stresses to be nominal stresses, and amplify the nominal stresses by an appropriate stress concentration factor \(K_t\). Values for \(K_t\) are available in many strength of materials handbooks.

- If fatigue is not a concern, localized yielding will lead to a slight redistribution of stress, and no real failure will occur. According to J. E. Shigley (Mechanical Engineering Design, McGraw-Hill, 1973), “We conclude, then, that yielding in the vicinity of a stress riser is beneficial in improving the strength of a part and that stress-concentration factors need not be employed when the material is ductile and the loads are static.”

- Alternatively, localized yielding is potentially important if the material is marginally ductile, or if low temperatures or other environmental conditions induce brittle behavior.

- Yielding of ductile materials may also be important if the yielding is widespread. For example, failure is most often declared if yielding occurs across a complete section.
The proper selection and use of a failure theory relies on your engineering judgment. Refer to engineering texts such as *Engineering Considerations of Stress, Strain, and Strength* by R. C. Juvinall (McGraw-Hill) and *Mechanical Engineering Design* by J. E. Shigley (McGraw-Hill) for in-depth discussions on the applied theories.

**Maximum Shear Stress Safety Tool**

The Maximum Shear Stress Safety tool is based on the maximum shear stress failure theory for ductile materials. The theory states that a particular combination of principal stresses causes failure if the Section : Maximum Shear equals or exceeds a specific shear limit:

$$\tau_{\text{max}} \geq f S_{\text{limit}}$$

where the limit strength is generally the yield or ultimate strength of the material. In other words, the shear strength of the material is typically defined as a fraction ($f < 1$) of the yield or ultimate strength:

$$M_s = F_S - 1 = \frac{f S_{\text{limit}}}{\tau_{\text{max}}} - 1$$

In a strict application of the theory, $f = 0.5$. Expressing the theory as a design goal:

$$\frac{\tau_{\text{max}}}{f S_{\text{limit}}} < 1$$

If failure is defined by material yielding, it follows that the design goal is to limit the shear stress to be less than a fraction of the yield strength of the material:

$$\frac{\tau_{\text{max}}}{f S_y} < 1$$

An alternate but less common definition states that fracturing occurs when the shear stress reaches or exceeds a fraction of the ultimate strength of the material:

$$\frac{\tau_{\text{max}}}{f S_u} < 1$$

**Options**

Define the stress limit in the Details View under **Stress Limit Type**. Use either **Tensile Yield Per Material**, or **Tensile Ultimate Per Material**, or enter a **Custom Value**. By default, **Stress Limit Type** equals **Tensile Yield Per Material**.

Define coefficient $f$ under **Factor** in the Details View. By default, the coefficient $f$ equals 0.5.

Choose a specific result from the **Stress Tool** context toolbar or by inserting a stress tool result using a right mouse button click on **Stress Tool**:

**Safety Factor**

$$F_S = \frac{f S_{\text{limit}}}{\tau_{\text{max}}}$$
Safety Margin
\[ M_s = F_s - 1 = \frac{f S_{\text{limit}}}{\tau_{\text{max}}} - 1 \]

Stress Ratio
\[ \frac{\tau_{\text{max}}}{f S_{\text{limit}}} \]

Notes

- The reliability of this failure theory depends on the accuracy of calculated results and the representation of stress risers (peak stresses). Stress risers play an important role if, for example, yielding at local discontinuities (e.g., notches, holes, fillets) and fatigue loading are of concern. If calculated results are suspect, consider the calculated stresses to be nominal stresses, and amplify the nominal stresses by an appropriate stress concentration factor \( K_t \). Values for \( K_t \) are available in many strength of materials handbooks.

- If fatigue is not a concern, localized yielding will lead to a slight redistribution of stress, and no real failure will occur. According to J. E. Shigley (Mechanical Engineering Design, McGraw-Hill, 1973), “We conclude, then, that yielding in the vicinity of a stress riser is beneficial in improving the strength of the part and that stress-concentration factors need not be employed when the material is ductile and the loads are static.”

- Alternatively, localized yielding is potentially important if the material is marginally ductile, or if low temperatures or other environmental conditions induce brittle behavior.

- Yielding of ductile materials may also be important if the yielding is widespread. For example, failure is most often declared if yielding occurs across a complete section.

- The proper selection and use of a failure theory relies on your engineering judgment. Refer to engineering texts such as Engineering Considerations of Stress, Strain, and Strength by R. C. Juvinall (McGraw-Hill) and Mechanical Engineering Design by J. E. Shigley (McGraw-Hill) for in-depth discussions on the applied theories.

Mohr-Coulomb Stress Safety Tool

The Mohr-Coulomb Stress Safety Tool is based on the Mohr-Coulomb theory for brittle materials, also known as the internal friction theory.

The theory states that failure occurs when the combination of the Section: Maximum, Middle, and Minimum Principal equal or exceed their respective stress limits. The theory compares the maximum tensile stress to the material’s tensile limit and the minimum compressive stress to the material’s compressive limit. Expressing the theory as a design goal:

\[ \frac{\sigma_1}{S_{\text{tensile limit}}} + \frac{\sigma_3}{S_{\text{compressive limit}}} < 1 \]

where \( \sigma_1 > \sigma_2 > \sigma_3; \sigma_3 \) and the compressive strength limit take negative values.

Note that the Mohr-Coulomb Stress Safety tool evaluates maximum and minimum principal stresses at the same locations. In other words, this tool does not base its calculations on the absolute maximum principal stress and the absolute minimum principal stress occurring (most likely) at two different locations in the body. The tool bases its calculations on the independent distributions of maximum and minimum principal stress. Consequently, this tool provides a distribution of factor or margin of safety throughout the part or assembly. The minimum factor or margin of safety is the minimum value found in this distribution.
For common brittle materials such as glass, cast iron, concrete and certain types of hardened steels, the compressive strength is usually much greater than the tensile strength, of which this theory takes direct account.

The design goal is to limit the maximum and minimum principal stresses to their ultimate strength values by means of the brittle failure relationship:

$$\frac{\sigma_1}{S_{ut}} + \frac{\sigma_3}{S_{uc}} < 1$$

An alternative but less common definition compares the greatest principal stresses to the yield strengths of the material:

$$\frac{\sigma_1}{S_{yt}} + \frac{\sigma_3}{S_{yc}} < 1$$

The theory is known to be more accurate than the maximum tensile stress failure theory used in the Maximum Tensile Stress Safety tool, and when properly applied with a reasonable factor of safety the theory is often considered to be conservative.

**Options**

Define the tensile stress limit in the Details View under Tensile Limit Type. Use either Tensile Yield Per Material, or Tensile Ultimate Per Material, or enter a Custom Value. By default, Tensile Limit Type equals Tensile Yield Per Material.

Define the compressive stress limit in the Details View under Compressive Limit Type. Use either Comp. Yield Per Material, or Comp. Ultimate Per Material, or enter a Custom Value. By default, Compressive Limit Type equals Comp. Yield Per Material.

Choose a specific result from the Stress Tool context toolbar or by inserting a stress tool result using a right mouse button click on Stress Tool:

**Safety Factor**

$$F_s = \left(\frac{\sigma_1}{S_{tensile\,limit}} + \frac{\sigma_3}{S_{compressive\,limit}}\right)^{-1}$$

**Safety Margin**

$$M_s = F_s - 1 = \left(\frac{\sigma_1}{S_{tensile\,limit}} + \frac{\sigma_3}{S_{compressive\,limit}}\right)^{-1} - 1$$

**Stress Ratio**

$$\sigma^* = \frac{\sigma_1}{S_{tensile\,limit}} + \frac{\sigma_3}{S_{compressive\,limit}}$$

**Notes**

- The use of a yield strength limit with brittle materials is not recommended since most brittle materials do not exhibit a well-defined yield strength.
For ductile and some other types of materials, experiments have shown that brittle failure theories may be inaccurate and unsafe to use. The brittle failure theories may also be inaccurate for certain brittle materials. Potential inaccuracies are of particular concern if the accuracy of calculated answers is suspect.

The reliability of this failure criterion is directly related to treatment of stress risers (peak stresses). For brittle homogeneous materials such as glass, stress risers are very important, and it follows that the calculated stresses should have the highest possible accuracy or significant factors of safety should be expected or employed. If the calculated results are suspect, consider the calculated stresses to be nominal stresses, and amplify the nominal stresses by an appropriate stress concentration factor $K_t$. Values for $K_t$ are available in many strength of materials handbooks. For brittle nonhomogeneous materials such as gray cast iron, stress risers may be of minimal importance.

If a part or structure is known or suspected to contain cracks, surface flaws, or is designed with sharp notches or re-entrant corners, a more advanced analysis may be required to confirm its structural integrity. Such discontinuities are known to produce singular (i.e., infinite) elastic stresses; if the possibility exists that the material might behave in a brittle manner, a more rigorous fracture mechanics evaluation needs to be performed. An analyst skilled in fracture analysis can use the ANSYS program to determine fracture mechanics information.

The proper selection and use of a failure theory relies on your engineering judgment. Refer to engineering texts such as *Engineering Considerations of Stress, Strain, and Strength* by R. C. Juvinall (McGraw-Hill) and *Mechanical Engineering Design* by J. E. Shigley (McGraw-Hill) for in-depth discussions on the applied theories.

### Maximum Tensile Stress Safety Tool

The Maximum Tensile Stress Safety tool is based on the maximum tensile stress failure theory for brittle materials.

The theory states that failure occurs when the maximum principal stress equals or exceeds a tensile stress limit. Expressing the theory as a design goal:

$$\frac{\sigma_1}{S_{lim}} < 1$$

The maximum tensile stress failure theory is typically used to predict fracture in brittle materials with static loads. Brittle materials include glass, cast iron, concrete, porcelain and certain hardened steels.

The design goal is to limit the greatest principal stress to be less than the material's ultimate strength in tension:

$$\frac{\sigma_1}{S_{ut}} < 1$$

An alternate definition compares the greatest principal stress to the yield strength of the material:

$$\frac{\sigma_1}{S_{yt}} < 1$$

For many materials (usually ductile materials), strength in compression and in tension are roughly equal. For brittle materials, the compressive strength is usually much greater than the tensile strength.

The Mohr-Coulomb theory used in the Mohr-Coulomb Stress Safety tool is generally regarded as more reliable for a broader range of brittle materials. However, as pointed out by R. C. Juvinall (*Engineering Considerations of Stress, Strain, and Strength*, McGraw-Hill, 1967), “There is some evidence to support its use with porcelain and concrete. Also, it has been used in the design of guns, as some test results on thick-walled cylinders tend to agree with this theory.”
Options

Define the stress limit in the Details View under Stress Limit Type. Use either Tensile Yield Per Material, or Tensile Ultimate Per Material, or enter a Custom Value. By default, Stress Limit Type equals Tensile Yield Per Material.

Choose a specific result from the Stress Tool context toolbar or by inserting a stress tool result using a right mouse button click on Stress Tool:

Safety Factor

\[ F_s = \frac{S_{\text{limit}}}{\sigma_1} \]

Safety Margin

\[ M_s = F_s - 1 = \frac{S_{\text{limit}}}{\sigma_1} - 1 \]

Stress Ratio

\[ \sigma^* = \frac{\sigma_1}{S_{\text{limit}}} \]

Notes

- The use of a yield strength limit with brittle materials is not recommended since most brittle materials do not exhibit a well-defined yield strength.
- For ductile and some other types of materials, experiments have shown that brittle failure theories may be inaccurate and unsafe to use. The brittle failure theories may also be inaccurate for certain brittle materials. Potential inaccuracies are of particular concern if the accuracy of calculated answers is suspect.
- The reliability of this failure criterion is directly related to treatment of stress risers (peak stresses). For brittle homogeneous materials such as glass, stress risers are very important, and it follows that the calculated stresses should have the highest possible accuracy or significant factors of safety should be expected or employed. If the calculated results are suspect, consider the calculated stresses to be nominal stresses, and amplify the nominal stresses by an appropriate stress concentration factor \( K_t \). Values for \( K_t \) are available in many strength of materials handbooks. For brittle nonhomogeneous materials such as gray cast iron, stress risers may be of minimal importance.
- If a part or structure is known or suspected to contain cracks, surface flaws, or is designed with sharp notches or re-entrant corners, a more advanced analysis may be required to confirm its structural integrity. Such discontinuities are known to produce singular (i.e., infinite) elastic stresses; if the possibility exists that the material might behave in a brittle manner, a more rigorous fracture mechanics evaluation needs to be performed. An analyst skilled in fracture analysis can use the ANSYS program to determine fracture mechanics information.
- The proper selection and use of a failure theory relies on your engineering judgment. Refer to engineering texts such as Engineering Considerations of Stress, Strain, and Strength by R. C. Juvinall (McGraw-Hill) and Mechanical Engineering Design by J. E. Shigley (McGraw-Hill) for in-depth discussions on the applied theories.

Fatigue (Fatigue Tool)

See Fatigue Overview.
Contact Tool

You can apply a Contact Tool to any assembly to verify the transfer of loads (forces and moments) across the various contact regions. The Contact Tool is an object you can insert under a Solution branch or Solution Combination branch that allows you to conveniently scope contact results to a common selection of geometry or contact regions. In this way, all possible contact results (pressure, frictional stress, status, gap, penetration, distance, and reactions), can be investigated at once for a given scoping. The Contact Tool also has provision for including contact Reactions as objects that hold the reaction forces and moments at the contact and target topologies for any contact region.

A Contact Tool is scoped to a given topology, and there exist two methods for achieving this: Geometry Selection method and Worksheet method. Under Geometry Selection method, the Contact Tool can be scoped to any geometry on the model. Under Worksheet method, the Contact Tool is scoped to one or more contact regions. Regardless of the method, the scoping on the tool is applied to all results or reactions grouped under it.

To use a Contact Tool, prepare a structural analysis for an assembly with contacts. You then use either the Geometry Selection or Worksheet scoping method as follows:

- **Geometry Selection method:**
  1. Select one or more bodies that are in contact.
  2. Insert a Contact Tool in the Solution folder (Tools> Contact Tool from the Solution context toolbar, or right mouse button click on Solution, then Insert> Contact Tool> Contact Tool). You will see a Contact Tool inserted with a default contact result. Because you have already selected one or more bodies, Geometry Selection is automatically set in the Scoping Method field within the Details View.¹
  3. Add more contact results as needed in the Contact Tool folder (Contact> [Contact Result, for example, Pressure] from the Contact Tool context toolbar, or right mouse button click on Contact Tool, then Insert> [Contact Result, for example, Pressure]).
  4. Solve database. Upon completion, you will see contact results with the common scoping of the Contact Tool.

- **Worksheet method:**
  1. Insert a Contact Tool in the Solution folder (Tools> Contact Tool from the Solution context toolbar, or right mouse button click on Solution, then Insert> Contact Tool> Contact Tool). You will see a Contact Tool inserted with a default contact result.
  2. In the Details View, select Worksheet in the Method field.¹ The Worksheet tab appears. Scoped contact regions are those that are checked in the table.
  3. You can modify your selection of contact regions in the Worksheet using the following procedures:
     - To add or remove pre-selected groups of contact regions (All Contacts, Nonlinear Contacts, or Linear Contacts), use the drop-down menu and the corresponding buttons.
     - To add any number of contact regions, you can also drag-drop or copy-paste any number of contact regions from the Contact folder into the Contact Tool in the Tree View. Also, one or more contact regions can be deleted from the Contact Tool worksheet by selecting them in the table and pressing the [Delete] key.
     - To change the Contact Side of all contact regions, choose the option in the drop-down menu (Both, Contact, or Target from the drop-down menu and click the Apply button).
To change an individual Contact Side, click in the particular cell and choose Both, Contact, or Target from the drop-down menu.

1The default method will be the last one that you manually chose in the Scoping Method drop down menu. If you have already selected geometry, the Scoping Method field automatically changes to Geometry Selection. The default however will not change until you manually change the Scoping Method entry.

Contact Reactions are allowed for any Contact Tool scoped using Worksheet method. To test them, insert an appropriately scoped Contact Tool and add a contact reaction table. Solve. The contact reaction table will reflect the contact regions scoped in the Contact Tool Worksheet. Contact reactions will display the force and moment at the summation point for every contact region.

Note — The location of the summation point may not be exactly on the contact region itself. Also, the reaction calculations work from summing the internal forces on the underlying elements under a contact region. Thus, a reported reaction may be inappropriate on a contact surface if that surface shares topology with another contact surface/edge or external load (such as a force or fixed support), which would contribute to the underlying elements’ internal force balance.

Contact Reactions include the following features/characteristics:

- You can display contact Reactions in a local coordinate system. Apply a local coordinate system before solving. The reaction forces and moments will be expressed in this local coordinate system and displayed in the contact reaction Worksheet. Summation points are defined as the location in global or local Cartesian coordinates about which the reaction forces and moments are reported by the ANSYS software.
- After solving, you can designate any of the forces or moments (components and/or magnitude) as parameters by clicking in the box adjacent to the value.
- You can view selected columns for contact Reactions.
- You can display Contact Reactions graphically on the geometry as a free body diagram. To view this, click on the Geometry Tab on a solved contact Reactions object. Forces will display as single headed arrows, and moments as double-headed arrows.

The configuration of the Contact Tool, in particular the location (Solution vs Solution Combination) and the scoping method, affects the availability of results. The following are the limitations:

- Contact Tool in the Solution folder: Supports all results and reactions when using the Worksheet scoping method. It does not support reactions when using Geometry Selection method.
- Contact Tool in the Solution Combination folder: Supports only pressure, frictional stress, penetration and distance. No reactions are supported.

Contact Results

If your model contains Contact Regions, you can define the following contact results under the Solution object by inserting a Contact Tool:

- Frictional Stress
- Gap
- Penetration
- Pressure (to reflect total contact pressures, you must either set the Behavior option to Asymmetric or Auto Asymmetric, or manually create an asymmetric contact pair).
• Sliding Distance

• Status. Status codes are:
  – 0-open and not near contact
  – 1-open but near contact
  – 2-closed and sliding
  – 3-closed and sticking

The labels Far, Near, Sliding, and Sticking are included in the legend for Status.

Note — Be aware of the following restrictions regarding contact results:

• When a contact result is scoped to a surface of an assembly, a contact result may not be obtained in certain cases, especially if the scoped surface is not a part of any contact region.
• Contour contact results are not reported for 3-D edge contact.

Beam Tool

You can apply a Beam Tool to any assembly in order to view the linearized stresses on beam bodies. It is customary in beam design to employ components of axial stress that contribute to axial loads and bending in each direction separately. Therefore, the stress outputs (which are linearized stresses) associated with beam bodies have been focused toward that design goal.

The Beam Tool is similar to the Contact Tool in that the tool, not the results themselves control the scoping. By default, the scoping is to all beam bodies. You can change the scoping in the Details View, if desired.

To insert a Beam Tool, highlight the Solution object then choose Tools> Beam Tool from the Solution context toolbar. Three beam stress results are included under the Beam Tool object: Direct Stress, Minimum Combined Stress, and Maximum Combined Stress. You can add additional beam stress results or deformation results by highlighting the Beam Tool object and choosing the particular result from the Beam Tool context toolbar. As an alternative, you can right mouse button click on the Beam Tool object and, from the context menu, choose Insert> Beam Tool> Stress or Deformation.

Presented below are definitions of the beam stress results that are available:

• Direct Stress: The stress component due to the axial load encountered in a beam element.
- **Minimum Bending Stress**: From any bending loads a bending moment in both the local Y and Z directions will arise. This leads to the following four bending stresses: Y bending stress on top/bottom and Z bending stress the top/bottom. **Minimum Bending Stress** is the minimum of these four bending stresses.

- **Maximum Bending Stress**: The maximum of the four bending stresses described under **Minimum Bending Stress**.

- **Minimum Combined Stress**: The linear combination of the **Direct Stress** and the **Minimum Bending Stress**.

- **Maximum Combined Stress**: The linear combination of the **Direct Stress** and the **Maximum Bending Stress**.

**Frequencies (Frequency Finder)**

The frequencies can be selected and calculated in two ways:

1. The first N frequencies (N > 0).
2. Frequencies in a selected range of frequencies.
You can view the mode shape associated with a particular frequency by drawing a picture or by animating the deformed shape. The contours represent relative displacement of the part as it vibrates.

Mode shape pictures are helpful in understanding how a part or an assembly vibrates, but do not represent actual displacements. If there are structural loads present in the Environment, then the frequencies and mode shapes will depend on the loads and their magnitudes.

“Stresses” from a modal analysis do not represent actual stresses in the structure, but give you an idea of the relative stress distributions for each mode.

**Vibration Environments**

Attach one or more structural supports to one or more parts. One or more zero (0 Hz) frequencies can result if the supports allow rigid body motion of the part or assembly in space.

*Note* — Due to their nonlinear nature, compression only supports are not recommended in a modal analysis. Extraneous or missed natural frequencies may result.

**Prestress Effects**

If structural loads, structural body loads and/or thermal loads are included in the Environment, then the frequency results will depend on these loads. This is due to the fact that the stiffness of a structure is dependent on its stress state. This stiffening (or weakening) of the structure due to its loads is sometimes referred to as pre-stressing, geometric stiffening, or initial stress stiffening.

**Working with Frequency Results**

Resulting frequencies can be used to:

- Set Alert objects for selected frequencies.
- Control accuracy and convergence and to view converged results.

The mode shape is always available for a given frequency. Optionally, you can add additional results for a specified frequency. The result is inserted into the frequency tool in focus. You may plot any contour results except for thermal strains, viewing structural stress, elastic strain or displacement at the desired mode.

- The mode number is a required input. The default is Mode 1.
- Convergence is not allowed on modal stress results.
- To conserve memory and project file size, only requested modal stress results are calculated. A full solution is performed if additional frequency stresses or elastic strains are added to a current solution.
- Deformations do not require a full solution, as they are a component of the frequency solution.

**Buckling**

Buckling, a failure mechanism, can be defined as the sudden large deformation of a structure due to an increase of an existing load. Buckling occurs from a compressive stress state in which the structure becomes geometrically unstable. For example, an empty beverage container can withstand a somewhat large axial compression such as standing on the can. However, a sudden collapse can occur due to a slight lateral perturbation, like a finger pressing into the side of the can.

- You can request buckling results by inserting a **Buckling Tool** under a Solution object. The default number of buckling modes is 1.
To view the buckled mode shape, click on the result. The contours represent relative displacement of the part as it buckles.

Buckling mode shape pictures are helpful in understanding how a part or an assembly buckles, but do not represent actual displacements.

For more information, see:

- Buckling Environments
- Working with Buckling Results

**Buckling Environments**

Attach one or more structural supports to one or more parts. In addition, since external loads are required for buckling to occur, one or more structural loads must be defined. If you apply unit loads, the load factor represents the critical buckling load. If you specify actual loads, then the load factors represent the fraction of the load that would cause buckling.

*Note —

- Due to their nonlinear nature, compression only supports are not recommended in a buckling analysis. Extraneous or missed buckling may result.
- Thermal buckling is not supported.
- Non Zero Displacements are not allowed.

**Working with Buckling Results**

Resulting buckling load factors can be used to:

- Set Alert objects for selected buckling modes.
- Control accuracy and convergence and to view converged results.

Buckling shapes (relative displacement) are always available for a given load factor. Optionally, you can add additional results for a specified load factor. The result is inserted into the buckling tool in focus. You may plot any contour results except for thermal strains, viewing structural stress, elastic strain or displacement at the desired mode.

- The mode number is a required input. The default is Mode 1.
- Convergence is not allowed on buckling stress results.
- To conserve memory and project file size, only requested buckling stress results are calculated. A full solution needs to be performed if additional buckling stresses or elastic strains are added to a current solution.
- Deformations do not require a full solution, as they are a component of the buckling solution.

**Notes**

- Eigenvalue buckling analysis predicts the theoretical buckling strength of an ideal linear elastic structure. This method corresponds to the textbook approach to elastic buckling analysis. Eigenvalue buckling analysis often yields unconservative results, as imperfections and nonlinearities prevent most real-world structures from achieving their theoretical elastic buckling strength. A buckling analysis may be warranted on a structure where a relatively thin member experiences compressive loads.
Using Simulation Features

- Occasionally, a buckling solution may not be found and the message “Unable to Find Requested Modes” will appear.
- Different buckling loads may be predicted from seemingly equivalent pressure and force loads in a buckling analysis because in Simulation a force and a pressure are not treated the same. As with any numerical analysis, we recommend that you use the type of loading which best models the in-service component. For more information, see the ANSYS, Inc. Theory Reference, under Structures with Geometric Non-linearities > Stress Stiffening > Pressure Load Stiffness.
- “Stresses” from a buckling analysis do not represent actual stresses in the structure, but give you an idea of the relative stress distributions for each mode.

Harmonics (Harmonic Tool)

You can use the Harmonic Tool to define harmonic results. In a structural system, any sustained cyclic load will produce a sustained cyclic or harmonic response. Harmonic results are used to determine the steady-state response of a linear structure to loads that vary sinusoidally (harmonically) with time. The results encompass the structure's response at several frequencies and provide graphs or animations of a response quantity, such as displacement versus frequency.

You can obtain harmonic results for the steady-state, forced vibrations of a structure. The transient vibrations, which occur at the beginning of the excitation, are not accounted for.

Harmonic Tool Configuration

The options available for configuring the Harmonic Tool change based on the Solution Method selected.

Mode Superposition
This is the default method, and generally provides results faster than the Full method. It also allows solutions to be clustered about the structure's natural frequencies. This results in a smoother, more accurate response curves. It cannot be used if you have specified nonzero harmonic displacement load(s).

Full
The full method calculates all displacements and stresses in a single pass. Its chief disadvantages are that:

- It is more “expensive” in CPU time than the Mode Superposition method.
- It does not allow clustered results, but rather requires the results to be evenly spaced within the specified frequency range.

With the Harmonic Tool selected, you must define the following values in the Details View:

Frequency Sweep Range
This is set by defining the Range Minimum and Range Maximum values.

Solution Interval (Full and Mode Superposition)
This sets the number of the solution points between the Frequency Sweep Range settings. You can request any number of harmonic solutions to be calculated. The solutions are evenly spaced within the specified frequency range, as long as clustering is not active. For example, if you specify 10 solutions in the range 30 to 40 Hz, the program will calculate the response at 31, 32, 33, ..., 39, and 40 Hz. No response is calculated at the lower end of the frequency range.

Cluster Number (Mode Superposition only)
Specifies the number of solutions on each side of a natural frequency. The default is to calculate four solutions, but you may specify any number from 2 to 20.

Options for Solution Method = Mode Superposition, Cluster Results = Yes:
Modal Frequency Range (Mode Superposition only)
Specifies the modal sweep range:

- **Program Controlled**: The modal sweep range is automatically set to 200% of the upper harmonic limit and 50% of the lower harmonic limit. This setting is adequate for most simulations.
- **Manual**: Allows you to manually set the modal sweep range. Choosing Manual displays the Modal Range Minimum and Modal Range Maximum fields where you can specify these values.

Constant Damping
The simplest way of specifying damping in the structure, this value is a constant damping ratio. If you set this in conjunction with Beta Damping, the effects are cumulative.

Beta Damping
Defines the stiffness matrix multiplier for damping. Beta Damping is the option for Direct Input or Damping versus Frequency. For Direct Input, enter a Beta Damping value. For Damping versus Frequency, you can enter both a Frequency value and a Beta Damping value.

**Results Types**

You can insert two types of results:

**Results viewed over the entire model.** These include stress, elastic strain, and deformation, and are basically the same as those for other analyses. For these results, you must specify a frequency and phase angle.

The following is an animated GIF. Please view online if you are reading the PDF version of the help.
Results for a specified geometric entity (vertex, surface, or edge), viewed as a value graphed along a specified frequency range. These include the frequency or phase results for stress, elastic strain, deformation, or acceleration (frequency only) plotted as a graph. The number of results points plotted on the graph is set in the Harmonic Tool Details. When you generate frequency response results, the default plot (Bode) shows the amplitude. For phase response results, there is only one graph shown and there are no display options for them. The following figure shows a reduced version of the Bode plot.

Optionally, you can plot the following results values: real, imaginary, amplitude, and phase angle. You can select any of these from a drop-down list in the Details View for the results. For edges, surfaces, shells, and multiple
vertex selections (which contain multiple nodes), the results can be scoped as minimum, maximum, or average. This is also available for frequency and phase response results scoped on a single vertex.

The **Use Minimum** and **Use Maximum** settings are based on the amplitude and thus are reported from the location with either the largest or smallest amplitude. The **Use Average** setting calculates the average by calculating the real and imaginary components separately.

*Note* — You cannot use Simulation convergence capabilities for any results item under the **Harmonic Tool**. Instead, you can first do a convergence study on a frequency analysis and reuse the mesh from that analysis.

Right-clicking on any graph produces the **Graph Property** dialog. You can use this dialog to adjust the appearance of the graph. It controls such graphing options as:

- Line and data point visual properties
- Linear or log scales
- Use of exponential notation
- Precision of values on axes
Stress/Strain

Stress solutions allow you to predict safety factors, stresses, strains, and displacements given the model and material of a part or an entire assembly and for a particular structural loading environment.

A general three-dimensional stress state is calculated in terms of three normal and three shear stress components aligned to the part or assembly world coordinate system.

The principal stresses and the maximum shear stress are called invariants; that is, their value does not depend on the orientation of the part or assembly with respect to its world coordinate system. The principal stresses and maximum shear stress are available as individual results.

The principal strains $\varepsilon_1$, $\varepsilon_2$, and $\varepsilon_3$ and the maximum shear strain $\gamma_{\text{max}}$ are also available. The principal strains are always ordered such that $\varepsilon_1 > \varepsilon_2 > \varepsilon_3$. As with principal stresses and the maximum shear stress, the principal strains and maximum shear strain are invariants.

You can choose from the following stress/strain results:

- Section : Equivalent
- Section : Maximum, Middle, and Minimum Principal
- Section : Maximum Shear
- Section : Intensity
- Section : Error (Structural)
- Section : Vector Principals
- Equivalent Plastic Strain

It is assumed that whatever holds true for stress applies to strain as well. However, the relationship between maximum shear stress and stress intensity does not hold true for an equivalent relationship between maximum shear strain and strain intensity.

For more information about Stress/Strain, see the ANSYS, Inc. Theory Reference.

Considerations

The degree of uncertainty in the numerical calculation of Stress answers depends on your accuracy preference. See Section : Convergence for information on available options and their effect on Stress answers.

For your convenience and future reference, Report can include stress, strain, and deformations value, convergence histories, and any alerts for these values.

Equivalent

Equivalent stress is related to the principal stresses by the equation:

$$\sigma_e = \left( \frac{(\sigma_1 - \sigma_2)^2 + (\sigma_2 - \sigma_3)^2 + (\sigma_3 - \sigma_1)^2}{2} \right)^{1/2}$$

Equivalent stress (also called von Mises stress) is often used in design work because it allows any arbitrary three-dimensional stress state to be represented as a single positive stress value. Equivalent stress is part of the maximum equivalent stress failure theory used to predict yielding in a ductile material.
The von Mises or equivalent strain $\varepsilon_e$ is computed as:

$$
\varepsilon_e = \frac{1}{1+\nu'} \left[ \frac{1}{2} \left( (\varepsilon_1 - \varepsilon_2)^2 + (\varepsilon_2 - \varepsilon_3)^2 + (\varepsilon_3 - \varepsilon_1)^2 \right) \right]^{1/2}
$$

where:

$\nu'$ = effective Poisson's ratio, which is defined as follows:

- Material Poisson's ratio for elastic and thermal strains computed at the reference temperature. Each material's reference temperature property is used as the reference temperature. If this property does not exist for a material then the environment's reference temperature is used.
- 0.5 for plastic strains.

**Maximum, Middle, and Minimum Principal**

From elasticity theory, an infinitesimal volume of material at an arbitrary point on or inside the solid body can be rotated such that only normal stresses remain and all shear stresses are zero. The three normal stresses that remain are called the principal stresses:

- $\sigma_1$ - Maximum
- $\sigma_2$ - Middle
- $\sigma_3$ - Minimum

The principal stresses are always ordered such that $\sigma_1 > \sigma_2 > \sigma_3$.

**Maximum Shear**

The maximum shear stress $\tau_{\text{max}}$ also referred to as the maximum shear stress, is found by plotting Mohr's circles using the principal stresses:

$$
\tau = \sigma_1 - \sigma_3
$$

or mathematically through:
For elastic strain, the maximum shear elastic strain $\gamma_{\text{max}}$ is found through:

$$\gamma_{\text{max}} = \varepsilon_1 - \varepsilon_3$$

since the shear elastic strain reported is an engineering shear elastic strain.

**Intensity**

*Stress intensity* is defined as the largest of the absolute values of $\sigma_1 - \sigma_2$, $\sigma_2 - \sigma_3$, or $\sigma_3 - \sigma_1$:

$$\sigma_1 = \text{MAX} \left( |\sigma_1 - \sigma_2|, |\sigma_2 - \sigma_3|, |\sigma_3 - \sigma_1| \right)$$

Stress intensity is related to the maximum shear stress:

$$\sigma_1 = 2\tau_{\text{max}}$$

Elastic Strain intensity is defined as the largest of the absolute values of $\varepsilon_1 - \varepsilon_2$, $\varepsilon_2 - \varepsilon_3$, or $\varepsilon_3 - \varepsilon_1$:

$$\varepsilon_1 = \text{MAX} \left( |\varepsilon_1 - \varepsilon_2|, |\varepsilon_2 - \varepsilon_3|, |\varepsilon_3 - \varepsilon_1| \right)$$

Elastic Strain intensity is equal to the maximum shear elastic strain:

$$\varepsilon_1 = \gamma_{\text{max}}$$

*Equivalent Stress* (and *Equivalent Elastic Strain*) and *Stress Intensity* are available as individual results.

*Note* — Computation of *Equivalent Elastic Strain* uses Poisson’s ratio. If Poisson’s ratio is temperature dependent then the Poisson’s ratio value at the reference temperature is used to compute the *Equivalent Elastic Strain*.

**Error (Structural)**

You can insert an *Error* result based on stresses to help you identify regions of high error and thus show where the model would benefit from a more refined mesh in order to get a more accurate answer. You can also use the *Error* result to help determine where Workbench will be refining elements if Convergence is active. The *Error* result is based on the same errors used in adaptive refinement. Information on how these errors are calculated is included in Section 19.7, POST1 - Error Approximation Technique, in the *ANSYS, Inc. Theory Reference*.

*Note* — Scoping is limited to assembly or body scoping (that is, surface/edge/vertex scoping is not allowed). The *Error* result is based on linear stresses and as such may be inaccurate in certain type of nonlinear analysis (for example, when plasticity is active).

Presented below are example applications of using the *Error* result in a Structural simulation.

3-D Model:
Section: Results

2-D Model, Base Mesh:

2-D Model, Adaptive Refinement (Convergence Added):

2-D Model, With Mesh Control:
Vector Principals

A Vector Principals plot provides a three-dimensional display of the relative size of the principal quantities (stresses or elastic strains), and the directions along which they occur. Positive principals point outwards and negative ones inwards.

Plots of Vector Principals help depict the directions that experience the greatest amount of normal stress or elastic strain at any point in the body in response to the loading condition. The locus of directions of maximum principal stresses, for example, suggests paths of maximum load transfer throughout a body.

Request a Vector Principals plot in the same way that you would request any other result. Scoping is also possible. Numerical data for these plots can be obtained by exporting the result values to an .XLS file. These files have 6 fields. The first three correspond to the maximum, middle, and minimum principal quantities (stresses or elastic strains). The last three correspond to the ANSYS Euler angle sequence (CLOCAL command in the ANSYS environment) required to produce a coordinate system whose X, Y and Z-axis are the directions of maximum, middle and minimum principal quantities, respectively. This Euler angle sequence is ThetaXY, ThetaYZ, and ThetaZX and orients the principal coordinate system relative to the global system. These results can be viewed using the Graphics button, so that you can use the Vector Display toolbar.

Equivalent Plastic Strain

The equivalent plastic strain gives a measure of the amount of permanent strain in an engineering body. The equivalent plastic strain is calculated from the component plastic strain as defined in the Equivalent stress/strain section.

Most common engineering materials exhibit a linear stress-strain relationship up to a stress level known as the proportional limit. Beyond this limit, the stress-strain relationship will become nonlinear, but will not necessarily become inelastic. Plastic behavior, characterized by nonrecoverable strain or plastic strain, begins when stresses exceed the material’s yield point. Because there is usually little difference between the yield point and the proportional limit, the ANSYS program assumes that these two points are coincident in plasticity analyses.
In order to develop plastic strain, plastic material properties must be defined. You may define plastic material properties by defining either of the following in the Engineering Data:

- Bilinear Stress/Strain curve.
- Multilinear Stress/Strain curve.

Note — Yield stresses defined under the Stress Limits section in the Engineering Data are used for the post tools only (that is, Stress Safety Tools and Fatigue tools), and do not imply plastic behavior.

**Deformation**

Physical deformations can be calculated on and inside a part or an assembly. Fixed supports prevent deformation; locations without a fixed support usually experience deformation relative to the original location. Deformations are calculated relative to the part or assembly world coordinate system.

\[
U = \sqrt{U_x^2 + U_y^2 + U_z^2}
\]

- Component deformations
- Deformed shape (total deformation vector)

The three component deformations \(U_x, U_y, \) and \(U_z\) and the deformed shape \(U\) are available as individual results.
Scoping is also possible. Numerical data is for deformation in the global X, Y, and Z directions. These results can be viewed with the model under wireframe display, facilitating their visibility at interior nodes.

**Working with deformations**

Deformations can be used to

- Set Alert objects.
- Control accuracy and convergence and to view converged results.
- Study deformations in a selected or scoped area of a part or an assembly.

**Plots of Vector Deformation**

A Vector Deformation plot provides the relative magnitude and orientation of displacement in response to the loading environment.

Request Vector Deformation plots in the same way that you would request any other result. After inserting the result object in the Details View under Graphics (listed in the Definition category), choose Vector in the drop-down menu.

**Thermal**

- Thermal-Stress Environments
- Thermal-Stress Results
- Thermal Results
- Error (Thermal)

**Thermal-Stress Environments**

To determine stress-related information, the environment must strain the part or assembly. To cause strain, the environment must contain at least one of the following:

- a structural load
- a structural body load (acceleration or rotation)
- thermal loads causing expansion or contraction

To determine thermal information and to include the effect of thermal expansion in stress answers, the environment must either include a uniform temperature throughout the body or a temperature distribution throughout. You can apply a uniform temperature by inserting a Thermal Condition load.

To cause a temperature distribution and heat transfer inside the body, the environment must contain two or more thermal loads. One known temperature or convection is required.

To account for thermal expansion or contraction in stress answers, define reference temperature. The effects of thermal expansion are calculated relative to the difference in the temperature inside the part or assembly and the reference temperature.

Since all stress-related calculations assume static equilibrium, attach at least one structural support.

Simulation automatically restrains a part if it accelerates under load (i.e. if the supports do not prevent all rigid body motions). The automatic restraints cause reaction forces inside the part and may in some cases permit very large displacement of the entire part. If large displacement occurs, the automatic restraints may affect the results.
In general, when defining an environment, either use at least one fixed-type support, or a combination of supports that prevent all possible rigid body motion of the part in space.

**Thermal-Stress Results**

Thermal-Stress provides access to all Section: Stress Tools, structural results, and thermal results.

In addition, given that the part exhibits a temperature distribution or a uniform temperature differs from the reference temperature, Simulation determines strain resulting from the thermal expansion or contraction of the part or assembly. All stress results account for the affect of thermal strains.

For uniform thermal expansion of an unsupported body, component strains are defined as:

\[ \varepsilon_x = \varepsilon_y = \varepsilon_z = \alpha (\Delta T) \]

where \( \alpha \) is the coefficient of thermal expansion (in the material definition) and \( \Delta T \) is the difference between the temperature of the body and the reference temperature. You can input a positive or negative value for the thermal expansion coefficient.

**Thermal Results**

When the environment causes heat transfer to occur inside a part or across an assembly, Simulation calculates the temperature at all locations on and inside the body.

Additionally, Simulation calculates the heat flux \((q/A, energy per unit time per unit area)\) throughout the body.

Scoping is also possible. Numerical data is for heat flux in the global X, Y and Z directions.

If the environment contains a single known temperature anywhere on the part or assembly, the entire body assumes that temperature (given steady-state conditions). Heat flux is zero.

**Plots of Vector Heat Flux**

A Vector Heat Flux plot provides the direction of heat flux (relative magnitude and direction of flow) at each point in the body.

The following graphic illustrates an example showing a high temperature area at the top and a low temperature area at the bottom. Note the direction of the heat flow as indicated by the arrows.
Request Vector Heat Flux plots in the same way that you would request any other result. After inserting the result object in the tree and solving, click the **Graphics** button in the **Result** context toolbar.

**Error (Thermal)**

The description of this result is the same as Error (Structural) except that heat flux is the basis for the errors instead of stresses.

**Shape Environments**

*Available for 3-D simulations, and 2-D simulations for Plane Stress behavior only.*

To determine Shape results, the **Environment** must strain the part or assembly. To cause strain, the environment must contain at least one of the following:
• Structural Loads
  • Structural body load (acceleration or rotation)
  • Thermal Loads causing expansion or contraction

To include the effect of thermal expansion in the Shape solution, the environment must either include a uniform temperature throughout the part or a temperature distribution throughout the assembly.

A single known temperature load attached anywhere on a part or an assembly causes a uniform temperature distribution (given steady-state conditions).

To cause a temperature distribution and heat transfer inside the part or assembly, the environment must contain two or more thermal loads. One known temperature or convection is required.

To account for thermal expansion or contraction in shape answers, define a reference temperature. The effects of thermal expansion are calculated relative to the difference in the temperature inside the body and the reference temperature.

Since all calculations assume static equilibrium, you must attach at least one structural support. Use at least one fixed-type support, or a combination of supports that prevent all possible rigid body motion of the body in space.

**Shapes Results**

The Section: Details View of the Shape Finder shows the following information:

• Target reduction percentage.
• Original mass of the part or assembly.
• Optimized mass of the part or assembly.
• Mass of material determined to be “marginal.”

*Note* — If Density is temperature dependent, then the mass values reported use a density value calculated at the reference temperature.

The estimation of optimized weight includes all “marginal” material.

Shape displays results as contour plots of the original part or assembly, with regions of material to remove specially colored.

Shape optimization pictures provide insight into the optimal layout of material to carry a given load. Use this information as a guide in determining parametric or feature changes to improve the design of a part or the assembly.

**Scoping Shape Results**

Shape results can be obtained for a part, selected parts, or an entire assembly. Use results scoping to select parts to study.

**Interpreting the Results**

Shown in the Geometry View, contoured pictures display the shape of the original part or assembly with three distinct regions painted on its surface: regions to keep, regions that are “marginal,” and regions to remove. These areas are indicated by individual colors and the names Keep, Marginal, and Remove, as shown on the legend.
The legend indicates ranges of pseudodensity. Pseudodensity is a number from 0 to 1. Zero represents a prediction of no material in that region of the model. One represents fully dense material in those regions of the model.

Regions falling between 1.0 and .6 (Keep) are regions of material which efficiently carry the given load. In many cases, removing material from these regions will have the greatest impact on stress in the part.

Regions falling between .6 and .4 (Marginal) are regions of material which represent the fuzziness or uncertainty between material to keep and material to remove. Shape predicts that marginal regions will carry a relatively low level of load in comparison to the material to keep. Marginal regions generally decrease in size as you increase your accuracy preference, that is, mesh density. That is, higher accuracy tends to “focus” shape optimization pictures.

Regions falling between .4 and 0.0 (Remove) are regions of material that can be removed with the least impact on the overall strength of the structure.

**Electromagnetic**

An Electromagnetic Simulation offers several Results items for viewing. Results may be scoped to bodies and, by default, all bodies will compute results for display. You can use the Details View to view vector results in several ways. Flux Density, Field Intensity, and Force represent the magnitude of the results vector and can be viewed as a contour or as a directional vector. Any directional solution represents direction vector components (X, Y, Z) of the vector. They may be displayed as a contour.

- Section : Electric Potential
- Section : Flux Density
- Section : Directional Flux Density
- Section : Field Intensity
- Section : Directional Field Intensity
- Section : Force
- Section : Directional Force/Torque
- Section : Current Density
- Section : Inductance
- Section : Flux Linkage

**Electric Potential**

Electric potential represents contours of constant electric potential (voltage) in conductor bodies. This is a scalar quantity.

**Flux Density**

Flux density is computed throughout the simulation domain and is a vector quantity. Selecting this option allows you to view the magnitude of the vector as a contour or as a directional vector.

**Directional Flux Density**

Flex density vector components are computed throughout the simulation domain. Selecting this option allows you to view individual vector components (X, Y, Z) as a contour.

**Field Intensity**

Field intensity is computed throughout the simulation domain and is a vector quantity. Selecting this option allows you to view the magnitude of the vector as a contour or as a directional vector.
**Directional Field Intensity**

Field intensity vector components are computed throughout the simulation domain. Selecting this option allows you to view individual vector components (X, Y, Z) as a contour.

**Force**

Force results represent electromagnetic forces on bodies. This is a vector quantity. Selecting this option allows you to view the magnitude of the vector as a contour or as a directional vector.

**Directional Force/Torque**

Force vector components are computed throughout the simulation domain. They are meaningful only on non-air bodies. Selecting this option allows you to view individual vector components (X, Y, Z) as a contour. The total summed forces are available in the Details view.

Torque results represent the torque on a body due to electromagnetic forces. Torque is specified about the origin of a coordinate system. By default, the global coordinate system is used. To change the specification point, create a local coordinate system and specify the results about the new origin. The torque result is listed in the Details view.

**Current Density**

Current density can be computed for any solid conductor body. It is displayed as a vector and is best viewed in wireframe mode. You can use the Vector toolbar to adjust the vector arrow viewing options. You can use the element-aligned option in the Vector toolbar for current density vectors, but not the grid-aligned option.

**Inductance**

Inductance can be computed for conductor bodies. It is defined as a measure of the differential change in flux linkage to the differential change in current. This is represented by the equation below, where \( d\psi \) is the differential change in flux linking conductor \( j \) produced by a differential change in current for conductor \( i \). Note that this is valid for linear and nonlinear systems, the inductance will be a function of current.

\[
L_{ij} = \frac{d\psi_{ij}}{di}
\]

Inductance is often used as a parameter in electric machine design and in circuit simulators.

A conduct body must have a current load to be considered in inductance calculations. All conductors with defined currents will be considered. Inductance results are presented in the Worksheet View. The results are presented in table form. The example below shows inductance results for a two-conductor system. The diagonal terms represent self-inductance, while the off-diagonal terms represent mutual inductance. In this case, \( L_{11} = 1e^{-4} \), \( L_{22} = 8e^{-4} \), \( L_{12} = L_{21} = 4e^{-4} \) Henries.

<table>
<thead>
<tr>
<th></th>
<th>Cond1 (H)</th>
<th>Cond2 (H)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cond1</td>
<td>1e^{-4}</td>
<td>4e^{-4}</td>
</tr>
<tr>
<td>Cond2</td>
<td>4e^{-4}</td>
<td>8e^{-4}</td>
</tr>
</tbody>
</table>

The Details View for inductance allows you to define a Symmetry Multiplier. Use this if your simulation model represents only a fraction of the full geometry. The multiplier should be set to compensate for the symmetry.
model. For example, if you create a half-symmetry model of the geometry for simulation, set the Multiplier to 2. Changing the multiplier will update the Worksheet results.

*Note* — Computing inductance can be time-consuming and should only be used if needed.

**Flux Linkage**

Flux linkage can be computed for any system incorporating a conductor. Solving for flux linkage calculates the flux, \( \psi \), linking a conductor. This is commonly referred to as the “flux linkage.” For nonlinear systems, the flux linkage will be a function of current. Flux linkage is also a function of stroke (e.g., displacement of an armature).

Flux linkage is often used to compute the emf (electromotive force) in a conductor, defined using the equation below, where \( V \) is the electromotive force, typically expressed in volts.

\[
V = -\frac{d\psi}{dt}
\]

Conductor bodies must have defined current loads to be considered in flux linkage calculations. Flux linkage results are presented in the Worksheet View. The results are presented in table form. The example below shows flux linkage results for a two-conductor system.

<table>
<thead>
<tr>
<th></th>
<th>Flux Linkages (Wb)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cond1</td>
<td>5e(^{-4})</td>
</tr>
<tr>
<td>Cond2</td>
<td>10e(^{-4})</td>
</tr>
</tbody>
</table>

The Details View for flux linkage allows you to define a Symmetry Multiplier. Use this if your simulation model represents only a fraction of the full geometry. The multiplier should be set to compensate for the symmetry model. For example, if you create a half-symmetry model of the geometry for simulation, set the Multiplier to 2. Changing the multiplier will update the Worksheet results.

*Note* — Computing flux linkage can be time-consuming and should only be used if needed.

**Reactions**

Simulation reports both reaction forces and reaction moments for the following types of supports (note that reaction moments are reported at the centroid of the support):

- Fixed surface
- Fixed edge
- Fixed vertex
- Displacement for surfaces (If a Displacement is defined in a local coordinate system, the reaction forces and moments are still reported in the global coordinate system.)
- Displacement for edges (If a Displacement is defined in a local coordinate system, the reaction forces and moments are still reported in the global coordinate system.)
- Displacement for vertices (If a Displacement is defined in a local coordinate system, the reaction forces and moments are still reported in the global coordinate system.)
- Remote Displacement (If a Remote Displacement is defined in a local coordinate system, the reaction forces and moments are still reported in the global coordinate system.)
- Frictionless surface
• Compression only support
• Cylindrical support
• Simply supported edge
• Simply supported vertex
• Fixed surface rotation (reaction moments only)
• Fixed edge rotation (reaction moments only)
• Fixed vertex rotation (reaction moments only)
• Weak springs (reaction forces only)

Simulation reports reaction heats for the following objects:

• Convection
• Temperature
• Radiation

Note — A reported reaction may be inappropriate if that support shares a surface, edge, or vertex with another support, contact pair, or load. This is because the underlying finite element model will have both loads and supports applied to the same nodes.

If a model contains two or more supports that share an edge or vertex, use caution in evaluating the listed reaction forces at those supports. Calculation of reaction forces includes the force acting along bounding edges and vertices. When supports share edges or vertices the global summation of forces may not appear to balance. Reaction forces may be incorrect if they share an edge or surface with a contact region.

When a Bolt load is applied, Simulation reports the following reactions:

• If a preload is applied, reactions are:
  – An Adjustment from the pretension load (in length units).
  – A Working Load, the algebraic sum of the equivalent working load resulting from other loads (if applied) or equal to the Preload (in force units).

• If a preadjustment is applied, reactions are:
  – A Preload from the specified adjustment (in force units).
  – A Working Load, the algebraic sum of the equivalent working load resulting from other loads (if applied) or equal to the Preload (in force units).

When a Generalized Plane Strain load is applied (2-D application), Simulation reports the following reactions:

• Fiber Length Change: Fiber length change at ending point.
• Rotation X Component: Rotation angle of end plane about x-axis.
• Rotation Y Component: Rotation angle of end plane about y-axis.
• Force: Reaction force at end point.
• Moment X Component: Reaction moment on end plane about x-axis.
• Moment Y Component: Reaction moment on end plane about y-axis.
Convergence

You can control the relative accuracy of a solution in two ways. You can use the meshing tools to refine the mesh before solving, or you can use convergence tools as part of the solution process to refine solution results on a particular area of the model. This section discusses the latter.

Through its convergence capabilities, the application can fully automate the solution process, internally controlling the level of accuracy for selected results. You can seek approximate results or adapted/converged results.

This section explains how to interpret accuracy controls.

Converged Results Control

You can control convergence to a predefined level of error for selected results. In the calculation of stresses, displacements, mode shapes, temperatures, and heat fluxes, the application employs an adaptive solver engine to identify and refine the model in areas that benefit from adaptive refinement. The criteria for convergence is a prescribed percent change in results. The default is 20%. You can change this default using the Convergence setting in the Options dialog box.

Adaptivity (Refinement of meshes based on solutions)

You can continue to refine the mesh based on a specific solution result. When you pick a result (Equivalent Stress, Deformation, etc.), indicate that you want to converge on this solution. You pick a value and the solution is refined such that the solution value does not change by more than that value.

To add convergence, click the result you added to your solution; for example, Equivalent Stress or Total Deformation. If you want to converge on deformation, right-click on Total Deformation and select Insert> Convergence. In the Section : Details View, you can specify convergence on either the Minimum or Maximum value. Additionally, you can specify the Allowable Change between convergence iterations.

Note — Convergence objects inserted under an environment that is referenced by an Initial Condition object or a Thermal Condition load object, will invalidate either of these objects, and not allow a solution to progress.

For an adaptive solution, a solution is first performed on the base mesh, and then the elements are queried for their solution information (such as deflection, X-stress, Y-stress, etc.). If the element’s results have a high Zienkiewicz-Zhu, or ZZ error (see the ANSYS, Inc. Theory Reference for more information on adaptivity theory), the element is placed in the queue to be refined. The application then continues to refine the mesh and perform additional solutions. If your mesh is initially made up of hexahedron, adaptivity will be more robust if you remesh the model with tetrahedron before your first solve.

You can control the aggressiveness of the adaptive refinement by adjusting the Refinement Depth setting under Adaptive Convergence in the Details View of a Solution object. The default value is 2 and the range is from 0 to 3. By default, when adaptive convergence occurs, the program will refine to a depth of 2 elements to help ensure smooth transitions and avoid excessive element distortion for repeated refinement. However, you can adjust this refinement depth to a value of 0 or 1 if for a particular problem, the deep refinement is not required and problem size is a major concern. In general the default value of 2 is highly recommended. However, you can lower the value if too much refinement is occurring and is overwhelming the solution in terms of size of solution time. If you use a value less than 2, be aware of the following:

- Verify that false convergence is not occurring because of too little refinement.
- More refinements may be required to achieve the desired tolerance, which may increase the total solution time.
The following pictures show the effects of various settings of **Refinement Depth** on plots of Total Deformation.

**General Notes**

Low levels of accuracy are acceptable for demonstrations, training, and test runs. Allow for a significant level of uncertainty in interpreting answers. Very low accuracy is never recommended for use in the final validation of any critical design.

Moderate levels of accuracy are acceptable for many noncritical design applications. Moderate levels of accuracy should not be used in a final validation of any critical part.

High levels of accuracy are appropriate for solutions contributing to critical design decisions.

When convergence is *not* sought, studies of problems with known answers yield the following behaviors and approximated errors:

- At maximum accuracy, less than 20% error for peak stresses and strains, and minimum margins and factors of safety.
- At maximum accuracy, between 5% and 10% error for average (nominal) stresses and elastic strains, and average heat flows.
- At maximum accuracy, between 1% and 5% error for average stress-related displacements and average calculated temperatures.
- At maximum accuracy, 5% or less error for mode frequencies for a wide range of parts.
When seeking highly accurate, Converged Results, more computer time and resources will be required than Manual control, except in some cases where the manual preference approaches highest accuracy.

Given the flexible nature of the solver engine, it is impossible to explicitly quantify the effect of a particular accuracy selection on the calculation of results for an arbitrary problem. Accuracy is related only to the representation of geometry. Increasing the accuracy preference will not make the material definition or environmental conditions more accurate. However, specified converged results are nearly as accurate as the percentage criteria.

Critical components should always be analyzed by an experienced structural engineer or analyst prior to final acceptance.

**Probe Tool**

The **Probe Tool** allows you to find results at a point on the model, or to find minimum or maximum results for a **Probe** on a body, face, edge or vertex. It can be used with the following simulation types: structural, thermal, structural sequenced, thermal transient, and electromagnetic.

You can insert a **Probe Tool** object under **Solution** in the tree, as you would any result tool. You can adjust options in the Details View or add results for specific points/geometry.

Options available for each simulation type are presented below:

- **Structural Simulation**
  - **Type**: Stress, Strain, Deformation
  - **Result Selection**
    → For Stress/Strain: All, Components, Principals, Normal X, Normal Y, Normal Z, XY Shear, YZ Shear, XZ Shear, Minimum Principal, Middle Principal, Maximum Principal, Intensity, and Equivalent (von-Mises)
    → For Deformation: All, X Axis, Y Axis, Z Axis, and Total

- **Thermal**
  - **Type**: Temperature, Heat Flux
  - **Result Selection**
    → For Temperature: Not applicable
    → For Heat Flux: All, X Axis, Y Axis, Z Axis and Total

- **Structural Sequenced**
  - **Type**: Stress, Strain, Deformation
  - **Display**: All Time Points, Single Time Point
    → Selecting Single Time Point will also display **Sequence Number** where you enter the sequence number to display results from (default = 1).
  - **Result Selection**
→ For Stress/Strain: All, Components, Principals, Normal X, Normal Y, Normal Z, XY Shear, YZ Shear, XZ Shear, Minimum Principal, Middle Principal, Maximum Principal, Intensity, and Equivalent (von-Mises)

→ For Deformation: All, X Axis, Y Axis, Z Axis, and Total

• Thermal Transient
  - **Type**: Temperature, Heat Flux
  - **Display**: All Time Points, Single Time Point
    
    → Selecting Single Time Point also displays the **Display Time** option where you enter the time to display results from (default = End Time).

  - **Result Selection**
    
    → For Temperature: Not applicable
    → For Heat Flux: All, X Axis, Y Axis, Z Axis, and Total

• Electromagnetic
  
  - **Type**: Flux Density, Field Intensity
  
  - **Result Selection**: All, X Axis, Y Axis, Z Axis, and Total

**Probe Object**

The result type specified under **Type** in the **Probe Tool** determines the result items that are displayed in the Details View of the **Probe** object.

If **Coordinate System** objects are in the tree under **Model**, an **Orientation** option will be displayed that allows you to specify a coordinate system. A **Location Method** option is also displayed with the following options:

• If **Coordinate System** is chosen, you will see a **Location** drop-down and the **X,Y,Z Coordinates** of the location.

• If **Geometry Selection** is chosen, a **Geometry** option is displayed. You can select an x,y,z point, edges, vertices, faces or bodies. If you select a point using the x,y,z picking method, the **X,Y,Z Coordinates** of the location will still be shown.

  **Note** — **Probe** objects scoped to x,y,z picking locations are achieved in such a way that a projection of the picked location in screen coordinates occurs onto the model based on the current view orientation, in other words, normal to the display screen onto the model at the picked location on the screen. If the geometry is updated, the update of the projection will follow the original vector that was established “behind the scenes” when the x,y,z pick was first made. Therefore the update of **Probe** objects scoped to x,y,z picking locations may not appear to be logical since it follows a vector that was established dependent on a view orientation when the original pick was made.

For the other geometries, an **Output** option is displayed. This allows you to elect to show either **Maximum** or **Minimum** result values across the given selection.
For sequenced or transient simulations, if you select **All Time Points** in the **Probe Tool**, you will see the maximum and minimum result values across sequence numbers/time.

### Timeline Controller and Tabular Data Window Displays

For sequenced or transient simulations, if you choose a **Probe Tool** or individual **Probe** object, the **Timeline** controller and **Tabular Data** window appear beneath the **Graphics** window on Windows platforms as shown below:

![Timeline and Tabular Data Window](image)

**Note** — The management of these windows (for example, repositioning) differs on Windows platforms vs. Unix platforms.

Results for each probe object are charted in the **Timeline** controller and listed in the **Tabular Data** window for all sequence steps or result time points.

The following options are also available in a context menu that displays when you click the right mouse button within the **Timeline** controller and/or the **Tabular Data** window. The descriptions that are linked below apply to either step numbers for a sequenced or time points for a transient simulation.

- **Copy Cell**: Copies the cell data into the clipboard for a selected cell or group of cells. The data may then be pasted into another cell or group of cells. The contents of the clipboard may also be copied into Microsoft Excel. Cell operations are only valid on load data and not data in the **Step** column.
- **Select All**: Selects all cells in the **Tabular Data** window.
- **Zoom to Range**: Zooms in on a subset of the data in the **Timeline** controller. Click and hold the left mouse at a step or time result location and drag to another step or time result location. The dragged region will highlight in blue. Next, select **Zoom to Range**. The chart will update with the selected steps or time points data filling the entire axis range.
- **Zoom to Fit**: If you have chosen **Zoom to Range** and are working in a zoomed region, choosing **Zoom to Fit** will return the axis to full range covering all steps.

### Recovering Unconverged Results

For sequenced or transient simulations that fail to solve completely, Simulation includes a feature that allows you to recover partially solved results. For a sequenced environment that fails to solve completely, Simulation will return results for the solved steps. Likewise, for a transient simulation that fails to solve completely, converged solutions at particular times are returned.

Partial results that are returned will be flagged as complete and up to date (green check), but the solution itself will be obsolete. So, if you choose **Solve** again, a full solution will occur. The partial results are also accompanied by an error message stating why the solution failed and a statement indicating that partial results were returned.

To post process additional results *without* a full solve, click the right mouse button on a **Solution** or **Result** object in the tree and choose **Evaluate Results** from the context menu. **Evaluate Results** will recalculate results that are based only on the **current** Workbench solution. It will not perform a full ANSYS solution (as it would if you
chose **Solve**), even if one is required. **Evaluate Results** can be useful to force the post processing of results in the following three cases:

- A partial solution has occurred.
- Results with Adaptive Convergence exist, but convergence has not yet been satisfied.
- An obsolete solution exists.

*Note* — Be aware of the following regarding recovery of unconverged results:

- If a partial thermal transient solution occurs, any results whose display time is past the last solved time will be displayed at that last solved time.
- Results in **Solution Combination** objects that use partial solutions will not be solved. You can view partial results but cannot use them in further post/solution work (for example, for **Thermal Condition** loads, **Solution Combination** objects).
- There may be some instances (for example, harmonic simulations), where a full solution is required and **Evaluate Results** should not be used.

**Solving Overview**

If you are using the **Simulation Wizard**, you must be sure that all the tasks in the wizard are complete before you try to solve. You can initiate a solve using programmed controlled and default settings by following any of these procedures:

- From the Section : Main Menu toolbar, select **Tools > Solve**.
- Click the **Solve** icon on the Solution Context Toolbar.
- Right-click the mouse on the **Solution** object and click **Solve**.

The Section : Details View of the **Solution** object includes settings that allow you to adjust conditions before you initiate the solve, based on your situation. These settings are described below and apply to all static and harmonic simulations. When solving a transient simulation, refer to Solving Overview (Transient Simulations), where differences and special provisions are described.

**Adaptive Convergence**

See Convergence.

**Solver Type**

If you want to specify a Solver type for Simulation to use, select the **Solver Type** field. You can choose between Program Controlled, Direct, or Iterative solvers. A direct solver works better with thin flexible models. An iterative solver works better for bulky models. In most cases, the program controlled option does select the optimal solver.

**Weak Springs**

For structural or shape simulations, the addition of weak springs can facilitate a solution by preventing numerical instability, while not having an effect on real world engineering loads. The following **Weak Springs** settings are available in the Details View:
• **Programmed Controlled** (default): Workbench determines if weak springs will facilitate the solution, then adds a standard weak springs stiffness value accordingly.

• **On**: Workbench always adds a weak spring stiffness. Choosing **On** causes a **Spring Stiffness** option to appear that allows you to control the amount of weak spring stiffness. Your choices are to use the standard stiffness mentioned above for the **Programmed Controlled** setting of **Weak Springs** or to enter a customized value. The following situations may prompt you to choose a customized stiffness value:

  a. The standard weak spring stiffness value may produce springs that are too weak such that the solution does not occur, or that too much rigid body motion occurs.
  b. You may judge that the standard weak spring stiffness value is too high (rare case).
  c. You may want to vary the weak spring stiffness value to determine the impact on the simulation.

The following **Spring Stiffness** settings are available:

  - **Programmed Controlled** (default): Adds a standard weak spring stiffness (same as the value added for the **Programmed Controlled** setting of **Weak Springs**).
  - **Factor**: Adds a customized weak spring stiffness whose value equals the **Programmed Controlled** standard value times the value you enter in the **Spring Stiffness Factor** field (appears only if you choose **Factor**). For example, setting **Spring Stiffness Factor** equal to 20 means that the weak springs will be 20 times stronger than the **Programmed Controlled** standard value.
  - **Manual**: Adds a customized weak spring stiffness whose value you enter (in units of force/length) in the **Spring Stiffness Value** field (appears only if you choose **Manual**).

• **Off**: Weak springs are not added. Use this setting if you are confident that weak springs are not necessary for a solution.

### Large Deflections

If you expect large deflections (as in the case of a long, slender bar under bending) or large strains, you can set **Large Deflection On**. When using hyperelastic material models, you must set **Large Deflection On**.

### Automatic Time Stepping

An automatic time stepping feature is available that allows the time step size or the applied loads to automatically be determined in response to the current state of a simulation. This feature is especially useful for nonlinear solutions. Settings for controlling automatic time stepping are included in a drop down menu under **Auto Time Stepping** in the Details View of a **Solution** object. The following options are available:

• **Programmed Controlled** (default): Workbench automatically switches time stepping on and off as needed. A check is performed on nonconvergent patterns. The physics of the simulation is also taken into account.

• **On**: You control time stepping by completing the following fields that only appear if you choose this option. No checks are performed on nonconvergent patterns and the physics of the simulation is not taken into account

  - **Initial Substeps**: Specifies the size of the first substep. The default is 1.
  - **Minimum Substeps**: Specifies the minimum number of substeps to be taken (that is, the maximum time step size). The default is 1.
  - **Maximum Substeps**: Specifies the maximum number of substeps to be taken (that is, the minimum time step size). The default is 10.
 managing the rth file (thermal simulations)

for a thermal simulation, an rth file (.rth) is the thermal results file generated by the ansys executable file and referenced by simulation.

the rth file is optional in that a dsdb file can be moved/copied/shared/archived without the rth file. you can still view the results in the tree without the rth file, but if new results are added to the tree, you will have to re-solve to see the results. however, if the rth file is in place, then new results can be added to the tree without a re-solve because they can be quickly read from the rth file.

the rth file name and location are displayed both in simulation and on the workbench project page. in simulation, you can specify the rth file name and location in the details view of a solution object using the result file name selection setting (displayed only for thermal simulations). the following options are available:

• manual: displays an editable result file field where you must enter the rth file name and path location. on each solve the program will overwrite this file. you can re-link to an rth file by specifying it in the result file field. a reason for doing this is if simulation does not know the location of the file (for example, if the dsdb file was moved to a new directory but the rth file was not).

• program controlled: the solve process decides the name and location of the rth file. the name and location are displayed in the read-only result file field after the solve.
  – the file name is based on the name of the dsdb file if the dsdb file has already been saved. otherwise, the name is based on the model and environment names.
  – the file is placed in the same directory as the dsdb file if the dsds file has already been saved, and if the dsdb file location is writeable. otherwise the file will be placed in your solver working directory as specified in the options dialog solution settings.
  – on each solution the result file name may change.
  – upon a first save of a dsdb file, the program will move rth files from the solver working directory to the dsdb file’s folder so that it will be easy for you to find the result files.
  – the program preserves an rth file until it is no longer needed. for example, consider a situation where you save aa.dsdb along with aa.rth. you then perform another solution that generates aa2.rth, and exit without saving. the program will delete aa2.rth and retain aa.rth because aa.rth is associated with the version of aa.dsdb that is saved on disk. if you save aa.dsdb on exit, the program will delete aa.rth and retain aa2.rth because now aa2.rth is the result file referenced by the version of aa.dsdb that is saved on disk.
Note — Be aware of the following items pertaining to the RTH file:

- If you choose Manual and specify the same RTH file path for two solutions in the dsdb file, or for two solutions in multiple dsdb files, the file will be overwritten without question for each solve. This means when one solution is solved, the RTH file will be lost for the other solutions. To avoid this, you must specify a different path for each solution or use the Program Controlled option to have Simulation manage the file naming.

- A second branch may be dependent on a thermal branch through a Thermal Condition load or an Initial Condition object. If you try to solve the second branch, the RTH file from the first branch must be present at the specified location on disk. If the RTH file is not present, an error dialog is displayed. You must either locate the RTH file and re-link it to the first branch, or solve the first branch again to regenerate the RTH file.

- The RTH file must be present for the user to animate temperature results.

**Synchronous and Asynchronous Solutions**

You can choose a synchronous or an asynchronous solution for your simulation.

- A *synchronous* solution runs exclusively on your local machine and finalizes while you are in the particular Workbench session. A synchronous solution is recommended for simulations that are not expected to be extremely CPU intensive.

- An *asynchronous* solution can be sent to run on a remote and more powerful machine. These solutions are queued and not restricted to run and finalize during any particular Workbench session. Asynchronous solutions are recommended for large models or other simulations that require a large amount of processing time and machine resources.

By default, a solution will run synchronously. The Details View of a Solution object includes the Run Solver Process on drop down menu under the Process Settings category that allows you to set an asynchronous solution. When set to Local Machine (the default), the solution will automatically be synchronous. When set to any of the other options, the solution will automatically be asynchronous.

*Note — Only synchronous solutions are available for the following:*

- **Parameter Manager** objects (in Simulation). These objects will automatically be suppressed if an asynchronous solving option is selected.

- **Convergence** objects.

- Implicit **Thermal Stress** simulations.

- Pressure object using the **CFX Load** option.

Presented below are further details on choices available in the Details View of a Solution object under the Process Settings category.

**Run Process on:** Specifies where the solve process will run. The following choices are available:

- **Local Machine** (default): Sets a synchronous solution that will run on the local desktop machine.

- **LSF Cluster:** Solution will be submitted to an LSF cluster (Windows only). This requires that you have LSF, a separate product from Platform™ Computing that manages job queues and balances machine resources. The Workbench client machine must be a member of the LSF cluster. If you choose LSF Cluster, the following fields also appear in the Details View:
Queue: Specifies a particular name of the queue on the LSF cluster.

License to Use: Specifies the name of a valid ANSYS product license (ANSYS Professional or higher) to be used for the solution on the remote LSF server.[1]

WB Cluster: Solution will be submitted to local Remote Solution Manager (RSM) or a Remote Solution Manager web service. The latter requires that you have a Remote Solution Manager configured according to the ANSYS Workbench Products Remote Solution Manager Configuration Guide (included as part of the ANSYS Workbench Products Installation and Configuration Guides, accessible from the main menu under Help> Installation and Licensing Help). If you choose WB Cluster, the following fields appear in the Details View:

- RSM Web Server: Specifies the name of the Web Service machine that is accessible on your network. If you enter localhost, the client machine acts as the local web service and server.
- Assignment: Specifies whether the solution is to run on a Queue or on a specific Server (Note: Server option only supported for Unix/Linux compute servers).
- Queue: (appears if Assignment is set to Queue) Specifies the name of the queue containing compute servers.
- Compute Server: (appears if Assignment is set to Server) Specifies the name of the server where the computation intensive portion of the solution will run (Unix/Linux only).
- User Name: Specifies a valid login name for the server name that you entered. Leave field blank if not applicable. Leave field blank to use preconfigured value on RSM compute server.
- Password: Specifies a valid password for the server name and User Name that you entered. Leave field blank if not applicable, or to use preconfigured value on RSM compute server.
- Working Directory: Specifies a valid directory on the machine whose name is entered in server. The user whose name is entered in User Name must have write access to this directory. Leave field blank to use preconfigured value on RSM compute server.
- Command: Specifies a valid command line for running ANSYS on the server machine. This field is required for Unix/Linux compute servers.
- License to Use: Specifies the name of a valid ANSYS product license (ANSYS Professional or higher) to be used for the solution on the Remote Solution Manager server or on the compute server.[1]

[1] You need to specify an ANSYS product license because a separate instance of ANSYS is being used. The license from your current ANSYS Workbench client session cannot be accessed from the remote ANSYS executable file.

Consult the following for more information on remote solutions:

- Section : Solution Scenarios
- Problems Unique to Asynchronous Solutions in the Troubleshooting section.

Number Of Processors: Specifies the number of processors to use during solution. The default is 2. The range is from 1 to 8. If you specify a number greater than the number of processors in the computer, the highest available number of processors is used.

ANSYS Memory Settings: Specifies the amount of system memory used for the ANSYS workspace and database. The following options are available:
• **Programmed Controlled** (default): Workbench determines the best memory settings for the solve. You are advised to use this setting unless you are fully aware of the consequences resulting from manually inputting the settings.

• **Manual**: Allows you to specify the memory settings. Choosing this option displays the *Workspace Memory* and *Database Memory* fields where you can enter the values in MB.

### Process Settings Context Menu

You can perform the following tasks related to process settings through a context menu (right mouse button click) on a *Solution* object:

- To copy the process settings from one *Solution* object to another:
  1. Right mouse click on a *Solution* object.
  2. Choose **Process Settings > Copy**.
  3. Right mouse click on another *Solution* object.
  4. Choose **Process Settings > Paste**.

The copied process settings are merely a starting point for the second *Solution* object and may be changed further from these settings.

- To copy default settings from the *Options* dialog box to a *Solution* object:
  1. Click on one or more *Solution* objects (hold down the [Ctrl] key for multiple selections).
  2. Right mouse click on one of the *Solution* objects.
  3. Choose **Process Settings > Restore Defaults**.

The copied process settings are merely a starting point and may be changed further from these settings.

- To save the process settings from one *Solution* object as the defaults for all newly created *Solution* objects:
  1. Right mouse click on a *Solution* object.
  2. Choose **Process Settings > Save as Defaults**. Only the settings that are currently visible are copied to the *Options* dialog box. For example, if the current *Solution* object is using an LSF cluster, only the *Run Solver Process on* and *Queue Name* entries will be copied. Entries associated with the *Local Machine*, *UNIX Server*, and *WB Cluster* locations will not be affected.

### Notes on Solution Object Process Settings

Process settings of *Solution* objects have the following characteristics:

- The settings are persistent for each *Solution* object.
- Each field has a default in the *Options* dialog box under *Solution*.
- Each field can be edited in the Details View.
- If a *Solution* object is created from scratch, its *Process Settings* fields are copied from the *Options* dialog box preferences.
- If a *Solution* object is created by copying another *Solution* object, the *Process Settings* are copied as well.
- When a solve process is running for a *Solution* object, its *Process Settings* are read-only.
Output Controls

The Details View of a Solution object includes an Output Controls section that allows you to suppress individual result output types from ANSYS so that those output types are not returned to the results file. Output Controls are applicable to result objects and affected Probe results under Solution, as well as result objects under a Solution Combination object involving a simulation that is using Output Controls. This feature is useful for conserving the size of the results file, especially for large simulations or transient simulations. Each result type under Output Controls has a Yes or No option that you can change through a drop down menu or by double-clicking in the particular result type field. Choosing Yes allows the result type from ANSYS to be included in the results file. Choosing No suppresses the result type. If any result object under Solution depends on a result type that was suppressed, that result object will appear as underdefined.

For more information on solving, see:

Section : Solution Scenarios
Section : Solving Overview (Transient Simulations)
Section : Solving
Section : Solving Units
Section : Results of Solving
Section : Saving your Results in Simulation

Solution Scenarios

This section describes Solver Process Settings for the following example solution scenarios:

- Synchronous Solve to Local Machine
- Asynchronous Solve to Local Machine
- Solve Directly to Unix/Linux Machine
- Solve to Queue Managed by Local RSM Job Manager
- Solve to Queue Managed by RSM Web Service
- Solve to Queue Managed by LSF

Synchronous Solve to Local Machine

- Run Process on = Local Machine

Asynchronous Solve to Local Machine

- Run Process on = WB Cluster
- RSM Web Server = localhost
- Assignment = Queue
- Queue = Local
- User Name = Not applicable
- Password = Not applicable
- Working Directory = Not applicable
- Command = Not applicable
Using Simulation Features

Note —

- The **Local** queue is available out-of-the-box and configured to run one solve at a time on the local machine.
- To run multiple simultaneous jobs on the local machine, add another server to the **Local** queue. For example, add **LocalHost2** and set machine to **localhost** so that 2 jobs can run at the same time.

**Solve Directly to Unix/Linux Machine**

... Monitored by the local RSM Job Manager or RSM Web Service.

- Run Process on = WB Cluster
- RSM Web Server = **localhost** or name of RSM Web Server
- Assignment = Server
- Compute Server = Unix/Linux machine name
- User Name = Required
- Password = Required
- Working Directory = Required (defaults to ~/)
- Command = Required

*Note* — If you are using the RSM Web Service, the client Workbench machine can be shutdown. You **must** save the Simulation database to reconnect to the job later.

**Solve to Queue Managed by Local RSM Job Manager**

- Run Process on = WB Cluster
- RSM Web Server = **localhost**
- Assignment = Queue
- Queue = Select user-created queue.
- User Name = Specify or leave blank.
- Password = Specify or leave blank.
- Working Directory = Specify or leave blank.
- Command = Required if queue contains Unix/Linux machines.

*Note* —

- Create servers and queues using the **Solution Status** monitor tray application.
- If **User Name**, **Password**, or **Working Directory** are blank, the settings in the server properties are used.
- For **RSM Web Server = localhost**, queues containing Windows machines is supported.
- To run multiple simultaneous jobs on a Unix/Linux machine, create multiple servers in the queue that represent the same machine.
Solve to Queue Managed by RSM Web Service

- Run Process on = WB Cluster
- RSM Web Server = name of RSM Web Server machine.
- Assignment = Queue
- Queue = Select queue.
- User Name = Specify or leave blank.
- Password = Specify or leave blank.
- Working Directory = Specify or leave blank.
- Command = Required if queue contains Unix/Linux machines.

Note —
- This scenario is basically the same as Solve to Queue Managed by Local RSM Job Manager except the queue is created by the RSM administrator.
- If the queue consists of Windows machines, Command is ignored.
- If User Name, Password, or Working Directory are blank, the settings in the server properties are used.

Solve to Queue Managed by LSF

- Run Process on = LSF Cluster
- Queue = Name of queue on LSF cluster.

Solving Overview (Transient Simulations)

When solving a transient simulation, all of the information presented under Solving Overview is applicable with the following additional settings available in the Details View of a Transient Settings object (automatically inserted under the Solution object for a transient simulation).

- Nonlinear Formulation - Controls how nonlinearities are to be handled for the solution. The following options are available:
  - Program Controlled (default) - Workbench automatically chooses between the Full or Quasi setting as described below. The Quasi setting is based on a default Reformulation Tolerance of 5%.
  - Full - Manually sets formulation for a full Newton-Raphson solution.
  - Quasi - Manually sets formulation based on a tolerance you enter in the Reformulation Tolerance field that appears if Quasi is chosen.

- Auto Time Stepping - For a transient simulation, these controls appear under the Transient Settings object instead of under the Solution object. The description of their function is the same as that described under Automatic Time Stepping for static and harmonic simulations except for the addition of a Define By setting, which allows you to define either Time or Substeps increments. If you choose the Program Controlled option, the default settings are as follows:
  - Time increments:
Initial Time Step = \( (1/100) \times \text{End Time} \)

Minimum Time Step = \( (1/1000) \times \text{End Time} \)

Maximum Time Step = \( (1/10) \times \text{End Time} \)

- Substeps increments:
  
  Initial Substeps = 100
  
  Minimum Time Step = 10
  
  Maximum Time Step = 1000

You may manually enter the Time step or Substeps increments by setting Auto Time Stepping to On. If constant time-stepping is desired, use the Off setting and enter the Time step or Number of Substeps.

Note — Refer to the troubleshooting section if you receive a warning message stating that the initial time increment may be too large for this problem.

• Visibility - Controls that allow you to selectively display various components of the Transient Settings worksheet that appears when you select the Transient Settings object.

Solving

1. Once you have defined your model, you are ready to solve. Click the Solve icon, to Solve.

   • If you want to solve all branches of your Outline, go to the project level and issue a solve.
   
   • If you want to solve particular branches, you can multi-select those branches and solve them simultaneously.
   
   • If you selected an asynchronous solution, you still see the Meshing dialog box because meshing will first be run locally and synchronously before the solve is sent to the queue. Meshing locally allows the same mesh to be used in each solve if multiple Solutions are being solved simultaneously under a single Model, rather than re-meshing for each solve. For both synchronous and asynchronous solves, you can check your mesh before solving through a right mouse click on the Mesh object and selecting Preview Mesh in the context menu.

2. A Solution Status window in Simulation monitors solution progress for synchronous solutions. Conventional progress bars are displayed in this window along with a Stop Solution button.

   Under most circumstances, error messages are displayed in a dialog box immediately after attempting the solution. If you attempt to solve for multiple branches (for example, from the Parameter Manager object or from the Project object) error messages from invalid branches will be suppressed to allow valid branches to proceed uninterrupted. In all cases, you can review error messages by clicking in the Solver Messages field under the Details View of the corresponding Solution object.

   The following characteristics apply to asynchronous solutions where a Solution Status monitor runs outside of Simulation:

   • While an asynchronous solution is in progress for a branch, that branch will be in a read-only state. Other branches can be edited freely.
• You can cancel a running job and reset the state of the tree by selecting Solution in the tree and choosing Stop Solution in the context menu (right mouse button click). Also, in the Solution Status monitor, you can remove a selected job name from the list. This should only be used to clean up the list. It will not impact the state of the tree.

• A down arrow status symbol indicates that a successful solution (green arrow) or failed solution (red arrow) is ready for download.

• When the green down arrow is displayed to indicate results are ready for download, choose Get Results from the context menu to perform the download.

• When the red down arrow is displayed to indicate a failed solution, choose Get Results from the context menu to download any error messages.

Note — While a solve is in progress on a UNIX server, do not reboot or log off of the Windows client machine. If you reboot or log off, the connection to the UNIX job will be lost and results will not be retrievable. If the UNIX job has completed, or if the job is running on an LSF Cluster or WB Cluster, then rebooting or logging off is safe.

3. The mathematical model is applied.

4. The results are evaluated.

5. You can rename Solution or Solution Information objects and items under these objects using a right mouse button click and choosing Rename. You then type a new name for the object (similar to renaming a file in Windows Explorer).

6. If you have chosen to use the Section : Simulation Wizard, it displays all tasks with a complete status.

7. To view your solution, select View Results from the Section : Simulation Wizard. Or, click the result and the solution appears in the Section : Geometry window.

Solving Units

There are five possible unit systems for a Simulation solution. The following table shows all the unit systems in the column headings that are available. For a given Simulation run, one of the five systems is selected and all quantities are converted into that system. This guarantees that all quantities, inputs and outputs to ANSYS, can be interpreted correctly in terms of the units in the system.

<table>
<thead>
<tr>
<th></th>
<th>m, kg, N, °C, s, V, A</th>
<th>cm, g, dyne, °C, s, V, A</th>
<th>mm, kg, N, °C, s, mV, mA</th>
<th>ft, lbm, lbf, °F, s, V, A</th>
<th>in, lbm, lbf, °F, s, V, A</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Acceleration</strong></td>
<td>meters/second² [m/s²]</td>
<td>centimeters/second² [cm/s²]</td>
<td>millimeters/second² [mm/s²]</td>
<td>feet/second² [ft/s²]</td>
<td>inches/second² [in/s²]</td>
</tr>
<tr>
<td><strong>Angle</strong></td>
<td>radians [rad]</td>
<td>radians [rad]</td>
<td>radians [rad]</td>
<td>radians [rad]</td>
<td>radians [rad]</td>
</tr>
<tr>
<td><strong>Angular Velocity</strong></td>
<td>radians/second [rad/s]</td>
<td>radians/second [rad/s]</td>
<td>radians/second [rad/s]</td>
<td>radians/second [rad/s]</td>
<td>radians/second [rad/s]</td>
</tr>
<tr>
<td><strong>Area</strong></td>
<td>meters² [m²]</td>
<td>centimeters² [cm²]</td>
<td>millimeters² [mm²]</td>
<td>feet² [ft²]</td>
<td>inches² [in²]</td>
</tr>
<tr>
<td><strong>Charge</strong></td>
<td>Coulombs [C]</td>
<td>Coulombs [C]</td>
<td>milliCoulombs [mC]</td>
<td>Coulombs [C]</td>
<td>Coulombs [C]</td>
</tr>
<tr>
<td></td>
<td>m, kg, N, °C, s, V, A</td>
<td>cm, g, dyne, °C, s, V, A</td>
<td>mm, kg, N, °C, s, mV, mA</td>
<td>ft, lbm, lbf, °F, s, V, A</td>
<td>in, lbm, lbf, °F, s, V, A</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>Charge Density</strong></td>
<td>Coulombs/meter² [C/m²]</td>
<td>Coulombs/centimeter² [C/cm²]</td>
<td>milliCoulombs/millimeter² [mC/mm²]</td>
<td>Coulombs/foot² [C/ft²]</td>
<td>Coulombs/inch² [C/in²]</td>
</tr>
<tr>
<td><strong>Conductivity</strong></td>
<td>Watts/meterdegree Centigrade [W/m·°C]</td>
<td>dynes/second degree Centigrade [dyne/s·°C]</td>
<td>ton/millimeters/second³ degree Centigrade [ton·mm/s³·°C]</td>
<td>(pound mass/32.2) feet/second³ degree Fahrenheit [(lbm/32.2) ft³/s³·°F]</td>
<td>(pound mass/386.4) inches/second³ degree Fahrenheit [(lbm/386.4) in³/s³·°F]</td>
</tr>
<tr>
<td><strong>Density</strong></td>
<td>kilograms/meter³ [kg/m³]</td>
<td>grams/cm³ [g/cm³]</td>
<td>tons/millimeter³ [ton·mm³]</td>
<td>(pounds mass/32.2) 1/foot³ [(lbm/32.2) 1/ft³]</td>
<td>(pounds mass/386.4) 1/in³ [(lbm/386.4) 1/in³]</td>
</tr>
<tr>
<td><strong>Displacement</strong></td>
<td>meters [m]</td>
<td>centimeters [cm]</td>
<td>millimeters [mm]</td>
<td>feet [ft]</td>
<td>inches [in]</td>
</tr>
<tr>
<td><strong>Electric Flux Density</strong></td>
<td>Coulombs/meter² [C/m²]</td>
<td>Coulombs/centimeter² [C/cm²]</td>
<td>milliCoulombs/millimeter² [mC/mm²]</td>
<td>Coulombs/foot² [C/ft²]</td>
<td>Coulombs/inch² [C/in²]</td>
</tr>
<tr>
<td><strong>Film Coefficient</strong></td>
<td>Watts/meter²degree Centigrade [W/m²·°C]</td>
<td>dynes/second centimeterdegree Centigrade [dyne/s·°C]</td>
<td>tons/second³ degree Centigrade [ton·s³·°C]</td>
<td>(pounds mass/32.2) 1/second³ degree Fahrenheit [(lbm/32.2) 1/s³·°F]</td>
<td>(pounds mass/386.4) 1/second³ degree Fahrenheit [(lbm/386.4) 1/s³·°F]</td>
</tr>
<tr>
<td><strong>Force</strong></td>
<td>Newtons [N]</td>
<td>dynes [dyne]</td>
<td>Newtons [N]</td>
<td>(pounds mass/32.2) feet/second² [(lbm/32.2) ft²/s²]</td>
<td>(pounds mass/386.4) inches/second² [(lbm/386.4) in²/s²]</td>
</tr>
<tr>
<td><strong>Force Intensity</strong></td>
<td>Newtons/meter [N/m]</td>
<td>dynes/centimeter [dyne/cm]</td>
<td>tons/second² [ton·s²]</td>
<td>(pounds mass/32.2) 1/second² [(lbm/32.2) 1/s²]</td>
<td>(pounds mass/386.4) 1/second² [(lbm/386.4) 1/s²]</td>
</tr>
<tr>
<td><strong>Frequency</strong></td>
<td>Hertz [Hz]</td>
<td>Hertz [Hz]</td>
<td>Hertz [Hz]</td>
<td>Hertz [Hz]</td>
<td>Hertz [Hz]</td>
</tr>
<tr>
<td><strong>Heat Flux</strong></td>
<td>Watts/meter² [W/m²]</td>
<td>dynes/second centimeter [dyne/s·cm]</td>
<td>tons/second³ [ton·s³]</td>
<td>(pounds mass/32.2) 1/second³ [(lbm/32.2) 1/s³]</td>
<td>(pounds mass/386.4) 1/second³ [(lbm/386.4) 1/s³]</td>
</tr>
<tr>
<td><strong>Heat Generation</strong></td>
<td>Watts/meter³ [W/m³]</td>
<td>dynes/second centimeter² [dyne/s·cm²]</td>
<td>tons/second³ millimeter [ton·mm³]</td>
<td>(pounds mass/32.2) 1/second³ foot [(lbm/32.2) 1/ft³·°F]</td>
<td>(pounds mass/386.4) 1/second³ inch [(lbm/386.4) 1/in³·°F]</td>
</tr>
<tr>
<td><strong>Heat Rate</strong></td>
<td>Watts [W]</td>
<td>dynes centimeters/second [dyne·cm/s]</td>
<td>ton/millimeters²/second³ [ton·mm²/s³]</td>
<td>(pounds mass/32.2) feet²/second³ [(lbm/32.2) ft²/s³]</td>
<td>(pounds mass/386.4) inches²/second³ [(lbm/386.4) in²/s³]</td>
</tr>
<tr>
<td>Inductance</td>
<td>m, kg, N, °C, s, V, A</td>
<td>Specific Weight</td>
<td>m, kg, N, °C, s, V, A</td>
<td>ft, lbm, lbf, °F, s, V, A</td>
<td>in, lbm, lbf, °F, s, V, A</td>
</tr>
<tr>
<td>------------</td>
<td>----------------------</td>
<td>----------------</td>
<td>----------------------</td>
<td>----------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Stiffness</td>
<td>Newtons/meter [N/m]</td>
<td>dyne/cm² [dyne/cm²]</td>
<td>Newtons/millimeter [N/mm]</td>
<td>pounds force/foot [lbf/ft]</td>
<td>pounds force/inch [lbf/in]</td>
</tr>
<tr>
<td>Specific Weight</td>
<td>Newtons/meter³ [N/m³]</td>
<td>dyne/cm³ [dyne/cm³]</td>
<td>tons/second²-millimeters² [ton/s²-mm²]</td>
<td>(pounds mass/32.2)²/second²-feet² [lbm/32.2]²/second²-ft²</td>
<td>(pounds mass/386.4)²/second²-inches² [lbm/386.4]²/second²-inch²</td>
</tr>
<tr>
<td>Specific Heat</td>
<td>Joules/kilogram degree Centigrade [J/kg°C]</td>
<td>dyne-centimeters/gram degree Centigrade [dyne·cm/g°C]</td>
<td>millimeters²/second²-degree Fahrenheit [mm²/s²°F]</td>
<td>inches²/second²-degree Fahrenheit [in²/s²°F]</td>
<td></td>
</tr>
<tr>
<td>Power</td>
<td>Watts [W]</td>
<td>dyne-centimeters/second [dyne·cm/s]</td>
<td>ton-millimeters²/second² [ton·mm²/s²]</td>
<td>(pound mass/32.2)²/second²-feet² [lbm/32.2]²/second²-ft²</td>
<td>(pound mass/386.4)²/second²-inches² [lbm/386.4]²/second²-inch²</td>
</tr>
<tr>
<td>Pressure</td>
<td>Pascals [Pa]</td>
<td>dyne/centimeter² [dyne/cm²]</td>
<td>Mega Pascal [MPa]</td>
<td>(pounds mass/32.2)²/second²-foot² [lbm/32.2]²/second²-ft²</td>
<td>(pounds mass/386.4)²/second²-inch² [lbm/386.4]²/second²-inch²</td>
</tr>
<tr>
<td>Relative Permeability</td>
<td>unitless</td>
<td>unitless</td>
<td>unitless</td>
<td>unitless</td>
<td>unitless</td>
</tr>
<tr>
<td>Relative Permittivity</td>
<td>unitless</td>
<td>unitless</td>
<td>unitless</td>
<td>unitless</td>
<td>unitless</td>
</tr>
<tr>
<td>Section Modulus</td>
<td>meters³ [m³]</td>
<td>centimeters³ [cm³]</td>
<td>millimeters³ [mm³]</td>
<td>feet³ [ft³]</td>
<td>inches³ [in³]</td>
</tr>
<tr>
<td>Shear Elastic Strain</td>
<td>radians [rad]</td>
<td>radians [rad]</td>
<td>radians [rad]</td>
<td>radians [rad]</td>
<td>radians [rad]</td>
</tr>
<tr>
<td>Moment</td>
<td>Newton-meters [N·m]</td>
<td>dyne-centimeters [dyne·cm]</td>
<td>ton-millimeters²/second² [ton·mm²/s²]</td>
<td>(pound mass/32.2)²/second²-feet² [lbm/32.2]²/second²-ft²</td>
<td>(pound mass/386.4)²/second²-inches² [lbm/386.4]²/second²-inch²</td>
</tr>
<tr>
<td>Moment of Inertia of Area</td>
<td>meters⁴ [m⁴]</td>
<td>centimeters⁴ [cm⁴]</td>
<td>millimeters⁴ [mm⁴]</td>
<td>feet⁴ [ft⁴]</td>
<td>inches⁴ [in⁴]</td>
</tr>
<tr>
<td>Moment of Inertia</td>
<td>unitless</td>
<td>unitless</td>
<td>unitless</td>
<td>unitless</td>
<td>unitless</td>
</tr>
<tr>
<td>Permeability</td>
<td>Henries/meter [H/m]</td>
<td>Henries/centimeter [H/cm]</td>
<td>milliHenries/millimeter [mH/mm]</td>
<td>Henries/foot [H/ft]</td>
<td>Henries/inch [H/in]</td>
</tr>
<tr>
<td>Density</td>
<td>kilograms [kg]</td>
<td>grams [g]</td>
<td>tons [ton]</td>
<td>(pounds mass/32.2) [lbm/32.2]</td>
<td>(pounds mass/386.4) [lbm/386.4]</td>
</tr>
<tr>
<td>Length</td>
<td>meters [m]</td>
<td>centimeters [cm]</td>
<td>millimeters [mm]</td>
<td>feet [ft]</td>
<td>inches [in]</td>
</tr>
</tbody>
</table>
### Results of Solving

Once the solve is complete, the Simulation Wizard shows complete check marks for each task in the simulation process.

**Required Steps**

- **Link to Geometry**
- **Verify Material**
- **Insert Loads**
- **Insert Supports**
- **Insert Results**
- **Solve**
- **View Results**
- **View Report**

You can Section : View Results in the Section : Geometry window. The model displays in the center of the screen. A legend appears which indicates the meaning of the colors in the model. The Section : Triad and Rotation Cursors appears in the lower right-hand corner, allowing you to manipulate the model. You can also use the mouse to move the model.

This is an example of a solution.
For more information, see

Section : Graphics
Legend
Section : View Results
Section : Saving your Results in Simulation

**Saving your Results in Simulation**

There are three ways to save your results in Simulation:

- As an ANSYS database file.

To save your Simulation results in an ANSYS database file, click **Solution** on the Section : Tree Outline and in its Details, click **Yes** next to **Save ANSYS db**. When you do this, the **ANSYS db File Name** box appears.

Click the button to view a dialog box which allows you to name the file and specify its location. This location is usually in your `Documents and Settings\<your ID>\Local Settings\Temp` folder. Note that there is no relation between **Save ANSYS db** and the **Save Ansys Files** setting in the **Options** dialog box under **Solution**. As mentioned above, **Save ANSYS db** refers to ANSYS creating and saving a database file in a specified location. **Save Ansys Files** refers to files created by ANSYS during a solve.
• As an input file for ANSYS

To create an ANSYS input file (.inp), select **Tools > Write Ansys Input File**... from the **Main Menu**. The **Save As** dialog box appears, allowing you to type the name of the file and specify its location. This location is usually in your **Program Files\Ansys Inc\v100\AISOL\Common Files** folder.

This feature can be used to perform analyses in ANSYS while taking advantage of the meshing capabilities within Simulation. The procedure is as follows:

1. Attach the model into Simulation.
2. Mesh the model.
3. Select the Solution Folder in the tree and verify that the **Analysis Type** is **Unknown** in the Details View.
4. **Tools > Write ANSYS Input File**... and specify a location and name for the input file.
5. Use this input file to complete your analysis in ANSYS. The meshed model will contain generic elements encoding only shape and connectivity information. Such elements can then be replaced by others that are appropriate to your desired analysis.

   *Note* — Any named selection group from Simulation is transferred to ANSYS as a component according to specific naming rules and conventions.

• As a Simulation database file.

To save your solution as a Simulation database file (.dsdb), select **File > Save As**... The **Save As** dialog box appears, allowing you to type the name of the file and specify its location.

### Saving Your Results in the ANSYS Workbench

The ANSYS Workbench (.dsdb) file is saved in the **Working Directory** specified in the ANSYS launcher.

![Working directory](image)

The ANSYS Workbench database file has a set of related files, specifically, the .log and .err files. These take their names from the Initial **Jobname** set in the ANSYS launcher.

![Initial jobname](image)

### Loading a Database File

If you load a file called beam_1.dsdb into the ANSYS Workbench, the jobname is reset to the new database filename. The database file will retain its original name and directory location, but the related files will all reside in the specified working directory (in this example, d:\my_anys).

The various results and log files related to the solutions for each **Environment Object** in the model reside in subdirectories of the working directory. These subdirectories take their name from the name of the database file, and the filename is incremented for each environment. So, if we continue with the example above and the beam_1.dsdb database contains two environments, the subdirectories that contain the various results files will have the names beam_1_1 and beam_1_2.

The file and directory structure generated by a solve for the example from above would look like this:
If you loaded a file from a directory other than the specified working directory, when you save the .dsdb file, the ANSYS Workbench will produce the **Save as...**, with the working directory as the default location and the current filename as the default name. You can now save the file anywhere you wish. What occurs when you use **Save as...** is covered in the following section.

### Using Save As...

If you use **File> Save As...** to change the name of the database file, this resets both the working directory and jobname based upon the directory and filename you pick for the database file. Upon solving, the ANSYS Workbench creates new results subdirectories (under the working directory) using the new name of the database file. For example, if you now save the same database file into the working directory under the name **new_name.dsdb**, the file structure after a solve will look like this.
Solution Combinations

You can create solutions that are calculated from other solutions. These are derived from the addition of results coming from one or more environments, each of which can include a multiplication coefficient that you supply. The calculated values cannot be parameterized.

To Create a Solution Combination Object  You can insert one or more Solution Combination objects under the Model object. Under the Solution Combination object, you can add the following results types:

- Stress Tool
- Fatigue Tool
- Contact Tool (for the following contact results: Frictional Stress, Penetration, Pressure, and Sliding Distance)
- Beam Tool
- Stresses
- Elastic Strains
**Deformations**

Each solution object contains its own configuration spreadsheet, available through the **Worksheet View**.

When setting up a Solution Combination, you select the **Environment Objects** you wish to add together from a drop-down list of all available environments. Enter the multiplication coefficient you wish for each environment.

The results values shown for these objects are derived from the same results objects in the referenced environments, including any defined multiplication coefficients. The basic formula for calculating the results is:

\[(\text{multiplication coefficient 1} \times \text{value from environment 1}) + (\text{multiplication coefficient 2} \times \text{value from environment 2}) + \text{etc.}\]

**Note** — At least one Environment must be checked in the Solution Combination Worksheet.

### Commands Objects

If you are familiar with using ANSYS commands or APDL programming, you can input commands directly in Simulation using a **Commands** object. You can insert single or multiple **Commands** objects under any of the following items using a right mouse button click and choosing **Insert> Commands** from the context menu.

- Bodies listed within **Geometry** objects.
- **Contact Regions** within **Contact** objects.
- **Environment** objects.
- **Solution** objects.

Upon inserting a **Commands** object, the **Worksheet** tab appears and displays information or special instructions tailored to the specific parent object. For example, the following information appears if you insert a **Commands** object under a **Contact Region** object:

```
**********contact region default statement**********
! Commands inserted into this file will be executed just after the contact region definition.
! The type number for the contact type is equal to the parameter "cid".
! The type number for the target type is equal to the parameter "tid".
! The real and mat number for the asymmetric contact pair is equal to the parameter "cid".
! The real and mat number for the symmetric contact pair(if it exists) is equal to the parameter "tid".
```
Input arguments are available on all Commands objects. There are nine arguments that you can pass to ANSYS APDL macros. Numerical values only are supported. Input Arguments are editable on the Details View of a Commands object under Input Arguments and listed as ARG1 through ARG9. If you enter a numerical value, including zero, for an argument, that value is passed along to ANSYS. If you leave the argument value field empty, no argument value is passed for that specific argument.

Note — If you are calling a user defined macro from within a Commands object, be aware of the macro’s location on the disk to make sure the macro is able to be located during the solution. Refer to the /PSEARCH command description located in the ANSYS Commands Reference within the ANSYS Help for more information.

For sequenced simulations, the Sequence Selection Mode control is also available in the Details View of a Commands object when you insert the object under an Environment or Solution object. This control allows you to specify which sequence steps are to process the Commands object. The choices are: First, Last, All, and By Number. If you choose By Number, a Sequence Number control appears that allows you to scroll through and select a specific numbered step that will process the Commands object.

---

**Warning:**

- Commands text cannot contain characters outside of the standard US ASCII character set due to the fact that this text will propagate into ANSYS input files and must follow the rules set aside for ANSYS APDL commands and input files. Use of languages other than English for the command text may cause erratic behavior. ANSYS commands should not be translated.

- Make sure that you use consistent units throughout a simulation. Commands objects whose inputs are units-dependent will not update if you change unit systems for solving.

Commands object input for electromagnetic simulations must be in MKS units (m, Kg, N, C, V, A).

---

The following controls are also available with Commands objects. Each control is available from the toolbar or from the context menu that appears from a right mouse button click on a Commands object:

- **Export...**: Exports the text in the Worksheet tab to an ASCII text file.

  Note — You must right-mouse click on the selected object in the tree to use this Export feature. On Windows platforms, if you have the Microsoft Office 2002 (or later) installed, you may see an Export to Excel option if you right-mouse click in the Worksheet tab. This is not the Simulation Export feature but rather an option generated by Microsoft Internet Explorer.

- **Import...**: Imports the text from an ASCII text file to the Worksheet tab.

  You can rename the Commands object to the name of an imported or exported file by choosing Rename Based on Definition from the context menu available through a right mouse button click. The Commands object is renamed to the name appearing in the File Name field under the Details View.

- **Refresh**: Synchronizes the text in the Worksheet tab to that of the currently used ascii text file. Refresh can be used to discard changes made to commands text and revert to a previously imported or exported version.

- **Suppress (available in context menu only)**: Suppressed commands will not propagate to the ANSYS input file.
Note — **Preprocessing Commands** objects or **Postprocessing Commands** objects, available in past releases are no longer supported. If you open a database that includes these objects, the objects are automatically converted to **Commands** objects.

- **Search Parameters (available only at the Solution level):** Scans the text output and updates the list of detected parameters. Matched ANSYS parameters can be parameterized just as other values in Workbench can be parameterized. Refer to the next section for details.

## Output Parameters: Using Parameters Defined in Solution Command Objects

For **Commands** objects at the **Solution** level, an *output search prefix* can be used to scan the text from a resulting solution run. After you choose **Search Parameters**, values for ANSYS parameter assignments are returned that match the output search prefix. The default output search prefix is `my_`. Changing the prefix at any time causes a rescan of the text for a matching list. After a SOLVE, the ANSYS parameters that are found to match the prefix are listed in the Details View for the **Commands** object with their values. This procedure is illustrated in the demonstration below. Parameters created using Commands objects can be used in DesignXplorer.

*The following is an animated GIF. Please view online if you are reading the PDF version of the help.*

### Viewing ANSYS Plots in Workbench

You can view ANSYS plots in Workbench that result from using **Commands** objects. The ANSYS plots are returned from ANSYS to display in the **Worksheet** tab. This feature is useful if you want to review result plots that are available in ANSYS but not in Workbench, such as unaveraged stress results or contact results only on a particular region.

**To view ANSYS Plots in Workbench:**

1. Create one or more **Commands** objects.
2. Direct plot(s) to PNG format.
3. Request plots in the **Commands** objects.

4. Make sure that there is at least one **Commands** object under **Solution** in the tree.

5. **Solve.** Requested plots for all **Commands** objects are displayed as objects under the first **Commands** object that appears below **Solution**.

Presented below is an example of a **Commands** object used to create two plots, one for unaveraged stress, and one for element error.

```
! Commands inserted into this file will be executed immediately after the Ansys /POST1 command.
! If a SET command is issued, results from that load step will be used as the basis of all
! result objects appearing in the Solution folder.
/show, png  ! output to png format
/gfile, 650  ! adjust size of file
/edge, 1, 1  ! turn on element outlines
/view,, 1, 1, 1  ! adjust view angle
ples, s, eqv  ! plot unaverage seqv
ples, serr   ! plot element error
```

The ANSYS plots are shown below.

**Unaveraged Stress Result:**

![Unaveraged Stress Result](image)

**Element Error Result:**

![Element Error Result](image)
Suggestions on Using Commands Objects with Materials

1. When using Commands objects, do not change the material IDs for elements. This will cause the results retrieval form ANSYS to Workbench to malfunction.

2. Instead of adding one large Commands object to change all of the materials, add individual Commands objects under each part. That way you will be able to reference the “matid” in the Commands object for the material ID of the elements that make up the part. You will also only need to enter the adjusted coefficient of thermal expansion and not the other materials.

3. Use the Worksheet view of the Geometry object to determine which materials are assigned to specific parts.

4. Click the right mouse button on a selected item in the Worksheet view, then choose Go To Selected Items in Tree to add Commands objects.

5. Copy and paste Commands objects from one part to another that have the same material assignment.

Possible Conflicts Between Workbench and ANSYS

Commands objects can be used to access ANSYS commands from within Workbench. The commands issued by the Commands objects affect the solution. However they do not alter settings within Workbench. ANSYS commands used in Commands objects may conflict with internal settings in Workbench.

One example where a possible conflict between ANSYS and Workbench can occur is when Commands objects are used to define material models. The user may have defined only linear elastic properties in Engineering Data. However, it is possible to use ANSYS commands in a Commands object to override the material properties defined in Engineering Data or even change the linear elastic material model to a nonlinear material model, such as adding a bilinear kinematic hardening (BKIN) model. In that case, the solution will use the BKIN model defined in the Commands object. However, since Simulation is unaware of the nonlinear material specified by the Commands object, nonlinear solution quantities such as plastic strain will not be available for postprocessing.

Another example where a possible conflict between ANSYS and Workbench can occur is when Commands objects are used to define boundary conditions. ANSYS nodal boundary conditions are applied in the nodal coordinate
system. For consistency, Workbench sometimes must internally rotate nodes. The boundary conditions specified by the commands in the **Commands** object will be applied in the rotated nodal coordinate system.

Other situations can occur where ANSYS commands issued in **Commands** objects are inconsistent with Workbench. It is the user’s responsibility to confirm that any ANSYS commands issued in a **Commands** object do not conflict with Workbench.

**View Results**

You can select results in the Section : Tree Outline under **Solution** to display contours in the Section : Geometry. You can also use the Result Context Toolbar to modify your view of the result.

If you click View Results on the Section : Simulation Wizard, you are directed to the area on the Section : Tree Outline where you can view the results.

- Legend
- Section : Graphics

**Graphics**

- Result Toolbar
- Animation

**Exporting Data**

You can export tabular data (any information about a model or results, except for 3D graphs) from the geometry and worksheet document tabs to an Excel spreadsheet file (.xls). The data will appear in Excel if it’s currently running, or will be written to an Excel file for later processing. You can export contour results objects through the context menu. From the worksheet tab you can export data from the following:

  - Geometry folder
  - Contact folder
  - Frequency folder
  - Buckling folder
  - Harmonics folder
  - Environment folder

Other exportable data includes:

- fatigue sensitivities
- any contour result

**Steps to export**

1. Select an object in the tree.
2. Click the Worksheet tab to give it focus.
3. Right-mouse click the selected object in the tree to produce the menu, then select **Export**.
Note — You must right-mouse click on the selected object in the tree to use this Export feature. On Windows platforms, if you have the Microsoft Office 2002 (or later) installed, you may see an Export to Excel option if you right-mouse click in the Worksheet tab. This is not the Simulation Export feature but rather an option generated by Microsoft Internet Explorer.

Options Settings

The Export Simulation settings in the Options dialog box allows you to:

- **Automatically Open Excel** (Yes by default)
- **Include Node Numbers** (Yes by default)
- **Include Node Location** (No by default)

Reporting

Section : Introduction
Section : Report Preview
Section : Outline by Tree
Section : Inserting Figures
Section : Publishing
Section : Customizing Your Reports
Section : Troubleshooting Reports

Introduction

The application provides powerful engineering tools that help you to develop concepts into well-understood designs, refine existing designs, and test designs under a variety of real-world conditions. The importance of this information is twofold:

- It guides and justifies your design decisions.
- It provides an important deliverable to your personal customers - clients, suppliers, colleagues, or managers.

In virtually all cases, you need to prepare materials to back up your design decisions and to document your design information. The Report function does the work of producing complete engineering documentation, including natural language discussions, tables, and color pictures, automatically, based on your work. This feature draws on the latest Internet and expert system technologies to deliver easily understood, ready-to-use materials in standard formats.

What Does Report Generate?

The documents generated by Report are in HTML. Report generates documents containing content and structure and uses an external Cascading Style Sheet (CSS) to provide virtually all of the formatting information. While the original Report system produced documents more analogous to typical web pages, this version of Report generates structured documents compliant to a vendor-independent international standard.
This new approach provides you with several key benefits:

**Rendering:** Documents display consistently across all modern browsers on all platforms. As browser support for CSS degrades, the formatting reverts to standard HTML but all content remains accessible and usable.

**Clean HTML Code:** All modern HTML authoring tools (e.g. Microsoft Word, Macromedia Dreamweaver, etc.) can directly edit documents produced by Report. The HTML code is formatted and readable for viewing and editing in Notepad.

**Warehousing:** Report documents were designed for archiving over years or decades. The focus on core HTML 4.0 ensures document integrity through a number of browser and operating system revisions.

**Visual Customization:** The standard Report package consists of an HTML file, a GIF image for the company logo, an optional JPEG image as a page background, a CSS external style sheet and an arbitrary number of JPEG figures. Without touching a line of code, it's possible to completely change the presentation of the report by replacing images and tweaking the style definitions in the CSS.

**Report Preview**

When you click on the **Report Preview** tab, and after clicking on the **Generate Report** button in the report setup page, a report displayed in a “table” view appears on the right side of the window. When first displayed (and following any selection in the Outline), the report scrolls to and selects the corresponding section in the Section : Tree Outline.

The Outline remains visible.

**Outline by Tree**

**Report** documents the design and analysis information you created and maintained. It is divided into sections that correspond to objects in the Section : Tree Outline. Each scenario in the report represents one complete engineering simulation. The definition of a simulation includes known factors about a design such as material properties per part, contact behavior between parts (in an assembly), and types and magnitudes of loading conditions. The results of a simulation provide insight into how the parts may perform and how the design might be improved. Multiple scenarios allow comparison of results given different loading conditions, materials, or geometric configurations.

**Report** is organized according to the Section : Tree Outline. Sections are numbered based on what section of the Section : Tree Outline they report on. For example, **Model** is Section 3.1, **Environment** is Section 3.2, **Solution**
is Section 3.3 and so on. **Loading and Supports**, which fall under the **Environment** heading in the Section : Tree Outline, are Sections 3.2.1 and 3.2.2.

The report scrolls to the location corresponding to the selected object in the outline. The report provides a table view of information, similar to **Object View** in Simulation.

### Inserting Figures

Each solution in Simulation may have multiple images. You may want to save a particular view of your model to insert into your report. These are called Section : Figures. The current model orientation is saved when you insert a figure. You can rename each figure to enhance meaning. Slice Plane views can also be saved as figures.

### Publishing

To post your report on a web page or save it for later use, click the **Publish** button on the Report Preview Context Toolbar. Choose a location to save the report. All required files that need to be saved can be placed in the same directory, or in a new directory with the same name as the html file. Just click the **save images in separate folder** box on or off. Separate folders will be easier to manage, but difficult to e-mail since the directory structure may not be preserved.

Report can be saved inside MS Word or E-mailed using MS Outlook by using the **Send To** command. This option will save images to the same folder as the html file. The **Send To> PowerPoint** command will only save the images as slides. It is meant to be used in conjunction with a printed report.

### Customizing Your Reports

You can customize your report by clicking on the **Report Preview** tab and completing a report setup page. This page includes provisions that you can specify for a title page, summary and introduction, body content (including reporting individual environments, even for Solution Combinations), appendices, and images. Information on the report page is saved with the `.dsdb` file. When you have completed specifying information on the report page, click the **Generate Report** button to generate the report.

In addition to using the report setup page, you can further customize your report as follows:

- Customize table characteristics and the maximum number of digits using the Simulation **Report** settings in the **Options** dialog box.

  *Note* — Any changes that you make to the Simulation **Report** settings in the **Options** dialog box can be tested by selecting the **Refresh** icon on the Report Preview Context Toolbar.

- Customize section titles on the Section : Tree Outline. Right-click on the name and select **Rename**. In the following example, the headings have been renamed.
Creating Report Editions

You may create your own edition of Report in order to support another language or to customize report contents without altering the default report files.

Language files are installed in the DesignSpace\DSPages\language folder. You may see one or more language files, depending on the locale you selected during installation.

To create a new Report edition, first find the language folder for your active language. For example, if you are running the US-English version, your language folder is en-us.

Open the DSSStringTable.xml file in the Pages\XML folder under your active language. Add a line near the end of the file to identify your Report edition name and folder. For example, if your edition is named “Corporate Standard” and will be stored in the Custom-1 folder, your entry would look like this:

```xml
<string id="ID_Custom-1">Corporate Standard</string>
```

Important

- `/stringtable` must be the last line in this file. You must add your new line before `/stringtable`.
- Remember to add “ID_” to the front of your folder name in order to define the string identifier.

Copy your active language folder to the new name specified in the previous step. This new folder must also be located under the DesignSpace\DSPages\language folder.

The next time you start Simulation and select the Report Preview tab, your custom report should be displayed in the Language selection box.

You may now edit the files in the Pages\Report folder under your edition folder name to create a custom Report edition.

Troubleshooting Reports

Some common errors that can occur—
No model attached to the .dsdb

In order for Report to process loads and solutions, there must be a model attached. Report will generate without a model, but no loads or solutions for that scenario will be shown. See Section: How to Attach Geometry for more information.

No Solution Branch

If all solution branches are deleted, Report will not generate at all and will display an error message. To enter a new solution branch, click Environment> Insert> New Solution.

Report in use

This normally occurs if the Send To command was used. If the report was sent to Word or PowerPoint and is still open in the background, an error will occur. Close these programs to stop the error.

Meshing Overview

All meshes are fully automatic. Mesh controls are available to assist you in fine tuning the mesh to your analysis.

To automatically mesh your body, simply proceed through your simulation. The body is meshed at solve time. The element size is determined based on the size of the body box (the smallest box that the body will fit in), the proximity of other topologies, body curvature, and the complexity of the feature. If necessary, the fineness of the mesh is adjusted up to four times (eight times for an assembly) to achieve a successful mesh.

You can also use the Mesh Preview feature before solving to see the mesh created. To do this, select Mesh from the Section: Tree Outline and right-click your mouse. From the right-click menu, choose Preview Mesh.

If you want more control over the mesh, you can do so using the Sizing controls. These controls can be accessed using the main menu. With the Mesh object highlighted, select Insert> Model Item and choose Mesh Control> Sizing. You can also use a right mouse click when Mesh is highlighted in the Section: Tree Outline, or in the Mesh Control context toolbar.

For more information on Meshing, see:

- Section : Mesh Control Tools
- Section : Other Meshing Tools
- Section : Mesh Sweeping

Global Meshing Settings

These controls are located in the Section: Details View when the Mesh item is selected in the Section : Tree Outline. Global settings are available as Basic or Advanced controls through drop-down menus.

- Basic Control
  - Relevance: Allows you to control the fineness of the mesh for the entire model.

To indicate a preference toward high speed (-100) or high accuracy (+100) solutions, use the slider located in the Section: Details View next to the Header, Relevance. To see the slider, click the Relevance value. This number is used in the report to document the relevance setting. The finer the mesh, the more accurate the result. A coarse mesh is less accurate. Keep in mind, however, a finer mesh uses more elements, more time, and ultimately, more system resources.

- Advanced Controls
- **Element Size**: Allows you to specify the element size used for the entire model. This size will be used for all edge, face, and volume meshing.

- **Curv/Proximity**: Allows you to adjust parameters that determine how closely the mesh follows the model and how many elements are generated based on the curvature of the model. This setting works in conjunction with the **Element Size** control to determine the number of element divisions.

  By default, the application will determine the element size for you. If given, the application will initially mesh the edges of the model with this size, and then refine the edges based on curvature and proximity. The **Curv/Proximity** slider gives you control over how much the application should refine the edges based on curvature and proximity. Curvature is how curved an edge is along with how much surface curvature there is on the surfaces attached to an edge. Proximity is how close the edges in a body are to each other. Proximity is only affected for swept models and models with proximity controls attached.

  *Note* — If **Element Size** is the default, the curvature and proximity behave the same as **Relevance**.

- **Shape Checking**: You can choose either the **Standard** setting (default) or the **Aggressive** setting. The **Standard** setting uses the current Simulation shape checking criterion. This criterion has proven to be effective for linear, modal, stress and thermal problems. The **Aggressive** value sets the shape checking criterion to be much more restrictive. This will usually produce more elements, longer meshing times, and possibly mesh failures. It is recommended that this option be used if the mesh is intended for large deformation or material nonlinear analysis inside the ANSYS environment.

- **Solid Element Order**: Use this feature if lower order elements perform well in the simulation, such as for field simulations or for highly nonlinear analyses. Lower order elements produce fewer degrees of freedom.

  - **Program Chosen** (default) automatically generates lower order elements for 3-D surfaces and lines, and higher order elements for 2-D and 3-D solids.
  - **High** forces all solid elements in the mesh to be higher order elements (include midside nodes).
  - **Low** forces all solid elements in the mesh to be lower order elements (no midside nodes).

  The **Solid Element Order** control is grayed-out when only surfaces, lines, or a combination of surfaces and line bodies are present in the model.

  *Note* — Modifying a **Solid Element Order** control setting will always force a complete remesh.

- **Straight Sided Elements** (displayed only when the model includes an enclosure from DesignModeler): specifies meshing to straight edge elements when set to **Yes**. You must set this option to **Yes** for Electromagnetic simulations.

- **Initial Size Seed**: Allows you to control the initial seeding of the mesh size for each part.

  - **Active Assembly** (default) bases the initial seeding on the diagonal of the bounding box that encloses only parts that are unsuppressed (“active” parts). With this choice, the mesh could change as you suppress and unsuppress parts because the bounding box grows and shrinks.
  - **Full Assembly** bases the initial seeding on the diagonal of the bounding box that encloses all assembly parts regardless of the number of suppressed parts. As a result, the mesh never changes due to part suppression.
Part bases the initial seeding on the diagonal of the bounding box that encloses each particular individual part as it is meshed. The mesh never changes due to part suppression. This option typically leads to a finer mesh and is recommended for situations where the fineness of an individual part mesh is important relative to the overall size of the part in the assembly.

Mesh Control Tools

The following mesh control tools are available when you highlight a Mesh object in the tree and choose a tool from either the Mesh Control drop down menu, or from first choosing Insert in the context menu (displayed from a right mouse click on a Mesh object). You can specify the scoping of the tool in the tool's Details View under Method to either a Geometry Selection or to a Named Selection.

Note — Be aware of the following items regarding mesh control tools:

- The latest mesh control tool that you add on a particular geometry overrides any prior mesh control tools that you already have added on that geometry. For example, if you apply a Sizing control setting of 0.5 to faces A,B,C then apply a setting of 1.0 to face B, faces A & C will retain the 0.5 setting, but the setting for face B will be 1.0.

- If you suppress a mesh control tool, the Suppress Body symbol appears ("x" adjacent to the name of the tool) and Suppressed is set to Yes in the Details View of the tool. If you do not suppress a mesh control tool, but the tool is either invalid or scoped to an object that is itself suppressed, the Suppress Body symbol appears adjacent to the tool but Suppressed is set to No in the Details View of the tool. Examples of the latter case are a tool applied to a uniform sheet mesh (not supported), a tool scoped to suppressed geometry, or a Contact Sizing tool scoped to a suppressed Contact Region.

Method Control

The Method control is valid only for a body. The default value selects element shapes that provide a successful automated mesh. By default, the application attempts to use auto sweeping for solid models and quadrilateral element generation for surface models.

To set the values of shape control, click Mesh on the Section : Tree Outline, and right-click to view the menu. Select Insert>Method. You can also click Mesh on the Section : Tree Outline, and select the Mesh Control button on the Section : Context Toolbar. Select Method.

In the Section : Details View, you can set Method to the following:

For solid bodies:

- Auto Sweep if Possible (default), where the body will be swept or map-meshed, if possible.
- All Tetrahedrons, where an all tetrahedral mesh is created.
- Hex Dominant, where a free hex dominant mesh is created. If you are interested in a hex mesh, this option is recommended for bodies that cannot be sweep meshed. To preview any bodies that can be sweep meshed, click Mesh on the Section : Tree Outline and right-click the mouse. Select Preview Sweep to display bodies that fulfill the requirements of a sweepable volume.

Hex dominant meshing adds the most value under the following conditions:

- Meshing bodies with large amounts of interior volume.
Meshing bodies that transition from sweepable bodies in a body that has been decomposed for sweeping.

Hex dominant meshing adds little value under the following conditions:

- Meshing thin complicated bodies (like a cellular phone case). The number of elements may actually increase compared to a tetrahedron mesh since the element size must be much smaller for this class of body when using hex dominant meshing to create well shaped hexes.

- A body is sweepable or can easily be decomposed to multiple sweepable bodies. The quality of a swept mesh is usually superior to that of a hex dominant mesh.

Mesh Matching for cyclic symmetry is not supported for hex dominant meshing.

Hex dominant meshing is not supported for Electromagnetic simulations.

Simulation assists you in determining if hex dominant meshing is applicable to your situation. When you apply the **Hex Dominant** option on a body or group of bodies, Simulation calculates the normalized volume to surface area ratio. If it detects a ratio less than 2, **Control Message** appears in a highlighted row under **Definition** in the Details View. If you click **Yes, Click To Display**, a warning message states that a low percentage of hex elements or poorly shaped hex elements may result. Suggestions are included for alternative meshing schemes.

The normalized volume to surface area ratio is defined by the following expression:

\[
\frac{\text{Volume of body}}{\left(\text{Surface area of body}\right)^{3/2}}/\text{factor}
\]

where factor, the ratio for a unit sphere = \(\frac{4/3 \pi}{4 \pi^{3/2}}\)

For **surface** bodies:

- **Quadrilateral Dominant** (default), where the body is free quad meshed.
- **All Triangles**, where an all triangle mesh is created.
- **Uniform Quad/Tri**, where a uniform mesh of quads and triangles is created over the entire part of the selected body, depending on values that you enter for the following input fields:

- **Defeaturing Tolerance** - Any edge that is less than or equal to this value may be meshed over by the mesher in a patch independent manner. A recommended setting is at least one-half the value set for **Element Size** to assure a successful mesh.
- **Element Size** - Allows you to specify the element size used for the selected geometry.
- **Fill Small Holes** - By default, holes in surface bodies are not removed regardless of the **Defeaturing Tolerance** setting. When **Fill Small Holes** is set to **Yes**, the mesher removes holes smaller than the **Defeaturing Tolerance** setting. The mesh simply paves over the small holes.
- **Quad Dominant on Failure** - Setting to **Yes** is equivalent to the **Quadrilateral Dominant** setting that includes the **Element Size** setting in the **Method** control. The **Quadrilateral Dominant** mesher will be invoked on a part by part basis when the **Uniform Quad/Tri** mesher cannot successfully mesh a part with the prescribed inputs.
- **Control Messages** - (appears only when **Method** controls are applied to uniform sheets) Displays an error message when the **Method** control is applied to a part that contains virtual topology.
• **Uniform Quad**, where a uniform mesh of all quads is created over the entire part of the selected body, depending on values that you enter for the same input fields mentioned above for the Uniform Quad/Tri option.

In some cases, the Uniform Quad option will create some triangular meshes. If this occurs, it will be reported in a mesh feedback message, accessible by choosing the View Mesher Feedback button.

**Note** — Be aware of the following regarding the Uniform Quad/Tri and Uniform Quad controls:

− These controls cannot be used for 2-D simulations.

− These controls are not available on Unix or 64 bit platforms. If you open a dsdb file that includes these controls on either of these platforms, the following occurs:

→ The Method mesh control tool is displayed as underdefined and an error message is displayed if you try to re-mesh.

→ If you try to copy or clone the Method mesh control tool to other geometries, the new tool is forced to Quadrilateral Dominant.

− These controls are sensitive to the scoping of all other objects in Simulation. If you add a load, support, or result to a group of surfaces, the part with either of these controls will need to be remeshed. If you change the scoping of the load, the part will need to be remeshed. It is recommended that you apply loads to the model before meshing when using either of these controls. These controls differ from the other mesh control tools in Simulation. The remaining mesh control tools are invariant to loading and mesh every selected surface. Every surface is not meshed when using either of these controls.

− The meshers associated with these controls will not retain the topology of named selections with a name containing the string "problematic geometry" (localized string) regardless of case of the string.

− Using either of these controls may allow meshing over very small bodies in a multi body part. This may lead to a solver error if a body load is associated with that body. If this is the case, you must suppress the body before solving your model.

− Once a uniform sheet mesh is created, deleting boundary conditions will not cause the mesh to become obsolete.

**Caution:** Multiple environments with different loadings may over-constrain the Uniform Quad/Tri and Uniform Quad meshers such that the mesher may not be able to return a mesh for the given inputs. If discretization error is not an issue, the mesher will be less constrained if you duplicate the model and change the environment instead of adding multiple environments under the same model.

### Sizing Control

The sizing control sets:

The element size for a selected body, face, or edge.
The number of divisions along an edge.
The element size within a user-defined “sphere of influence” that can include a selected body, face, edge, or vertex. This control is recommended for local mesh sizing. The control must also be attached to a coordinate system if it is to be scoped to anything other than a vertex.
To Access Sizing

1. Select a body, face, edge, or vertex.
2. Choose **Insert > Model Item > Mesh Control > Sizing**.
   
or
   Right click on the selected object and choose **Insert > Sizing**.
3. Specify options under **Details of “Sizing”** in the **Type** field. The available choices depend on the topology you selected in step 1 above.
   
   • If you selected a **body** or a **face**, the following options are available in the **Type** field:
     
   - **Element Size** (default) allows you to enter a value directly in the **Element Size** field. Enter a positive value (decimals are allowed) in this field. Smaller values generate more divisions. A value of “0” instructs the control to use its defaults. The following series of figures shows the effect of the sizing control applied to a face.

   ![Element Size default.](Image)
   ![Element Size set to 0.5.](Image)

   - **Sphere of Influence** allows you to apply mesh sizing within the confines of a sphere in space that you define as follows:
     
     a. Create a local coordinate system whose origin you intend to be the center of the sphere.
     b. Select this coordinate system in the **Sphere Center** field.
     c. Enter the radius of the sphere in the **Sphere Radius** field.
d. Enter a value in the **Element Size** field. The element size will be applied to all topologies within the confines of the sphere. For example, if you are applying the element size to a face, the size will also be applied to the edges of that face, and to the vertices of those edges, but only within the confines of the sphere. An example is shown below.

- If you selected an *edge*, the options available in the **Type** field are **Element Size** and **Sphere of Influence** (as described above for when you select a body or a face), along with the **Number of Divisions** option. Choosing **Number of Divisions** and entering a value in the **Number of Divisions** field is an alternative to choosing **Element Size** if you are interested in having the mesh be sized according to a discrete number of divisions along an edge.

- If you selected a *vertex*, the only option available in the **Type** field is **Sphere of Influence**. The description is the same as presented above for when you select a body or a face except that the center of the sphere is the vertex. There is no need to create or use a local coordinate system to define the center of the sphere. After applying element size to a vertex using **Sphere of Influence**, the element size is applied to all topologies connected to that vertex, such as all edges and faces containing that vertex, if they fall within the sphere. An example is shown below.
4. Specify a hard division option in the **Edge Behavior** field. For bodies or faces, the **Edge Behavior** option allows you to either accept (default) or ignore the **Curv/Proximity** global meshing setting. For edges, the size or number of divisions is fixed on the edge and cannot be changed by the meshing algorithm. When **Edge Behavior** is set to **No Curv/Proximity Refinement** ("hard"), the likelihood of a mesh failure increases. When **Curv/Proximity** is ignored on a face/body, curvature pre-refinement is not performed on the edges of the face/body, but the edge can be split by the mesher. The hard division option is not available for **Sphere of Influence**. It is also not applicable for vertices.

**Notes on Element Sizing**

- Visual aids are available to assist you. When you pick an edge, the edge length is displayed. A circle is displayed adjacent to the cursor whose diameter indicates the current setting in the **Element Size** field. The scale ruler is displayed below the graphic and provides a good estimate of the scale of the model.

- **When Applying Sizes to Edges:** If possible, the meshing algorithm places the requested number of divisions on the specified edge. Otherwise, the algorithm adjusts the number to allow a successful mesh generation.

- **When Sweeping:** Consider the following when applying size controls to source and target geometry:
  - If your sizing controls are scoped to either the source or target face, the mesher will transfer the size control to the opposite face. If you have a size control on both faces, the size on one of the faces will be used. That face is automatically determined by the software. However the size on the edges of the target face will not be affected if no sizes are explicitly defined on these edges.
  - If you have a sphere of influence on a possible source or target face, the face with the most spheres will be chosen as the source face. The edge mesh of the source face affected by the sphere of influence will not affect the target face. This may prevent the model from sweeping with acceptable element quality. To avoid this, place the sphere of influence on the edges of both the source and target face.
  - Applying sizes, regardless of type (that is, size, number of divisions, sphere of influence), to the edges of possible source and target faces will only affect the faces that use these edges.

If you want to control a side area, the problem must be properly constrained such that the interval assignment does not override your size control. The divisions on the edge may decrease in order to make the volume sweepable. When using a meshing process other than swept meshing, the divisions can only in-
crease. When applying a size to a part that is sweepable, the resulting mesh may have fewer divisions on the edge than specified due to the interval assignment logic of the sweepers.

- Using the **Sphere of Influence** sizing control may not have any effect on the generated mesh if the control is scoped to the Body of a Line Body.
- Elements falling within 3 overlapping spheres of influence will be created with an averaged size. Within 4 or more spheres, the size is calculated by a radius-dependent least-squares fit of all the spheres.
- Regardless of value for the sizing control you set, other factors such as edge and face curvature and the proximity of small features may override the effect of the sizing control.
- If several sizing controls are attached to the same edge, face, or body, the last control is applied. If a sizing control is placed on an edge and then another is placed on a face or body that contains that edge, the edge sizing takes precedence over the face or part sizing.
- If you have adjusted the element size, then changed length units in a CATIA, ACIS, or Autodesk Mechanical Desktop model, when you choose **Update** or **Clean** at a Model or Project node in the tree outline, you may need to re-adjust the element size. The sizing control does not automatically re-adjust to match this situation.

### Contact Sizing

**Contact Sizing** creates elements of relatively the same size on bodies from the surfaces of a face to face or face to edge contact region. This control generates spheres of influence internally with automatic determination of radius and size (if **Relevance** is selected for **Type**). You may want to apply a method control on sweepable bodies to force the elements to be tetrahedron in the case where the sweeper is not providing enough local sizing near your contact region. Your swept mesh may be quite dense if the contact size is small on the source and target faces of the body. You may also see very little effect on swept bodies in the case where a contact size is applied to a very small region of a large source face. You can apply contact sizing using either of the following procedures:

- Choose **Contact Sizing** from the **Mesh Control** drop down menu, or from the context menu through a RMB click on a **Mesh** object (**Insert**: **Contact Sizing**). Select a specific contact region under **Scope** in the Details View, then under **Type**, choose **Relevance** for a relative size (using the slider), or **Element Size** (and enter a value) for an absolute size.
- Drag a **Contact Region** object onto the **Mesh** object, then in the Details View, under **Type**, choose **Relevance** for a relative size (using the slider), or **Element Size** (and enter a value) for an absolute size.

### Refinement Controls

Refinement Controls specify the maximum number of meshing refinements that are applied to the initial mesh. Refinement controls are valid for faces, edges, and vertices.

To use refinement controls, click **Mesh** on the Section : Tree Outline, and right-click to view the menu. Select **Insert**: **Refinement**. You can also click **Mesh** on the Section : Tree Outline, and select the **Mesh Control** button on the Section : Context Toolbar. Select **Refinement**.

In the Section : Details View, specify a **Refinement** number between 1 and 3, where 1 provides minimal refinement, and 3 provides maximum refinement. If you attach several controls to the same entity, the last control applied takes precedence.

Refined elements are always tested against stricter shape metrics than the shape metrics used to create base elements. As an example, if you create a mesh using the **Standard** setting of the **Shape Checking** Control and then specify a refinement, the refined elements will have to pass an even stricter shape metric than the original.
elements. If you create a mesh using the Aggressive setting and then specify a refinement, the refined elements will have to pass a shape metric that is even more aggressive than the metrics used to create the base mesh with the Aggressive setting.

Some refinement controls can override or affect other refinements that are on connected topology. A face refinement control overrides a refinement control on any of the face's edges or vertices. An edge refinement control overrides a refinement control on either of the edge's vertices. Basically, a refinement control will lower the value of an overridden control by its own value. For example, consider a face with a refinement control of 1 and one of the face's edges with a refinement control of 2. One of the edge's vertices has a refinement control of 2. In this example, the face control reduces the value of the edge control by 1. It also reduces the value of the vertex control by 1. The edge control now has a value of 1, so it reduces the vertex's control by 1. Now the vertex has a value of zero, so it has no effect.

**Mapped Face Meshing Control**

Mapped Meshing controls place a mapped face mesh control on a surface, specifically, quadrilateral and triangular faces for sheet models and only triangular faces for solid models. The application will automatically determine a suitable number of divisions for the edges on the boundary face. If you specify the number of divisions on the edge with a Sizing control, the application will attempt to enforce those divisions.

To set the mapped face meshing controls, highlight Mesh in the Section : Tree Outline, and right-click to view the menu. Select Insert> Mapped Face Meshing. You can also click Mesh in the Section : Tree Outline, and select the Mesh Control Section : Context Toolbar, then select Mapped Face Meshing from the drop-down menu.

The Mapped Face Meshing control overrides the Method control.

The blue status icon that may appear in the Section : Tree Outline indicates that a mapped mesh cannot be provided on the scoped topology. One of three scenarios triggers the icon:

1. The surface cannot be map meshed.
2. The quality of the mapped mesh was not acceptable and a free mesh was generated.
3. The mapped mesh was modified so that an adjacent surface could be successfully meshed.

**Match Face Mesh Control**

The Match Face Mesh control matches the mesh on two faces for non-swept solid parts. The recommended use of this control is for problems that involve cyclic symmetry. The matching process involves copying the mesh of the first selected face in the control to the second selected face in the control.

To apply Match Face Mesh, select two faces of interest, then choose Match Face Mesh from the Mesh Control drop down menu, or from the context menu through a RMB click on a Mesh object (Insert> Match Face Mesh). You must also select a coordinate system to choose the z-axis of rotation for the copy. A blue status icon appears in the tree outline if the Match Face Mesh control failed on the face pair.

The Match Face Mesh control is not supported for swept parts and bodies whose Method control is set to Hex Dominant.

**Part Relevance**

Part Relevance allows you to control the fineness of the mesh for an individual part. To apply Part Relevance, select a part or any body in a multi body part, then follow the procedure for using the global Relevance control. If applied to a body of a multi body part, the relevance will be applied to the entire part.
Part Proximity

Part Proximity performs a pre-refinement on the meshed edges of a part. Swept parts always have proximity refinement turned on internally. The recommended use of Part Proximity is on thin parts, or parts where features are very close together and where discretization is very important. Using Part Proximity may create a very large number of elements, sometimes on the order of five times the number created without using the control.

To apply Part Proximity, select a part or any body within a multi body part, then choose Part Proximity from the Mesh Control drop down menu, or from the context menu through a RMB click on a Mesh object (Insert> Part Proximity). You can use the Relevance slider to control the amount of proximity refinement performed.

The following pictures show the effects of applying Part Proximity:

Without Part Proximity

With Part Proximity

Other Meshing Tools

View Mesher Feedback

The View Mesher Feedback button becomes active in the Mesh context toolbar if the mesher gathered any useful information, warnings, or errors that would be helpful to you. If you click this button, feedback messages appear as links in a panel on the right side of the Simulation screen (the Simulation Wizard area). The feedback is grouped by part. When you click an individual feedback message, topology is highlighted that is related to the message. You can view this topology more easily if you click outside of the Mesh object so that the geometry and mesh are not drawn to the screen at the same time.

Generation of Contact Elements

To model contact between parts in an assembly, you must define specific contact conditions.

One of those conditions is tolerance, which controls the extent of contact between parts in an assembly. Tolerance is set as a percentage of the bounding box of the assembly. The bounding box is the smallest volume that the assembly will fit in. You can change the tolerance (between -100 and 100) in the Options dialog box under the Simulation Contact category.

A loose tolerance generally increases the number of contact surfaces and areas of contact between parts, while a tight tolerance will decrease the number of contact surfaces.
Each face of the part is checked against the faces of other parts in the assembly. A contact pair is generated between any faces within the tolerance. When solving, the elements for the two faces that make up the pair are compared. If any of the faces are within the tolerance, contact elements are generated for them.

**Renaming Mesh Control Tool**

You can rename any of the mesh control tool objects to include the name assigned to the part or body. To do this, use a right mouse button click on the object and choose **Rename Based on Definition** from the context menu. For example, if you scope a Refinement tool to a body named Tube and choose **Rename Based on Definition**, the mesh control tool name changes from Refinement to Refinement on Tube. The name change is reflected both in the tree and as a label on the body.

**Gap Tool (Electromagnetic Simulations)**

The Gap Tool is applicable to Electromagnetic simulations where a refined mesh is required across an air gap in order to obtain accurate solutions. Typical applications are refined meshing in the air gap enclosure region of an actuator, or the air gap enclosure region between a rotor and a stator of a rotating machine.

The tool identifies face/face pairs in a multi body part and creates gap sizing controls for meshing. Within a Gap Tool object, you can specify settings for sizing on the bodies adjacent to the gap and for refinement of the mesh in the air gap.

*Note* — All Gap Tool controls and settings discussed in the following procedure are displayed only when the model includes an enclosure from DesignModeler.

**To use the Gap Tool:**

1. Insert a Gap Tool object in the tree using one of the following procedures:
   - Choose **Mesh Control > Gap Tool** on **Mesh** context toolbar.
   - **Insert > Model Item > Mesh Control > Gap Tool**
   - Click right mouse button on **Mesh** object (or any mesh control tool object) > **Insert > Gap Tool**.

2. Enter the width of the gap region between bodies (in your working units or as an existing CAD parameter). This entry represents the range for multiple gaps, or equals a single gap distance that varies about a certain tolerance. Your mesh density in the air gap is a direct function of the Gap Distance so your gap size should be quite accurate. The applicable settings in the Details View are the following:
   - **Define By**: Choose **Range** (default) if you will be entering numerical values, or **CAD Parameters** if you will be entering parameters to define the values.
   - **Minimum**: The lower end of the range for multiple gaps, or the single gap distance.
   - **Maximum**: (Optional) The upper end of the range for multiple gaps, or the single gap distance tolerance.

   After you set the gap distance, a crosshair appears adjacent to the cursor in the Geometry window. The crosshair is surrounded by a circle. The radius of the circle is a graphical indication of the maximum gap distance. The radius will change if you change this distance. The circle also appropriately adjusts when the model is zoomed in or out.

3. Click the right mouse button on the **Gap Tool** object and choose **Create Gap Sizes** from the context menu. Simulation searches the model to find all occurrences of face pairs separated by the gap distance.
you specified. All face pairs within an absolute distance from the minimum gap distance to the maximum gap distance will have controls generated. Each occurrence of the gap face pairs is inserted as a **Gap Sizing** object under the **Gap Tool** object. By changing to Wireframe mode (Graphics toolbar) and clicking through each **Gap Sizing** object, you can visually inspect the selected gap face pairs for use in mesh refinement.

**Note** — If you open a version 9.0 database file that includes **Gap Sizing** objects, **Gap Tool** object(s) are created automatically. These **Gap Tool** object(s) are reported in the tree with a yellow lightning bolt status, meaning that the items are not solved.

4. Right mouse click on **Mesh** object and choose **Preview Mesh** from the context menu.

5. Use the following controls to adjust the degree of sizing and mesh refinement, as needed, for the gap face pairs. These controls appear in the Details View of the **Gap Tool** object.

   - **Gap Aspect Ratio**: Slider control that adjusts the aspect ratio of elements in the gap between faces. The ratio represents the length of an element edge parallel to the face pairs, to the width of the element perpendicular to the face pairs. A lower ratio (for example, 1:1) will produce significantly more elements than a higher ratio (for example, 4:1), but will generate better quality elements. A good compromise is a value of 3:1 (default).

   - **Gap Density**: Controls the number of elements spanning the width of the air gap between the face pairs. The **Coarse** option (default) attempts to place at least two elements through the gap width, the **Fine** option attempts to place three to four elements through the gap width.

   - **Generate on Update**: Controls whether the **Gap Sizing** objects are regenerated when the simulation is updated from the geometry. By default the **Gap Sizing** objects are regenerated at their default settings. You may choose to not update a **Gap Sizing** object by selecting **No**. The **No** option will freeze the **Gap Sizing** object’s face pairs and settings. This option will only work properly if there are no topology changes for the face pairs during a geometry update. The **Generate on Update** feature default setting is most applicable to rotating machines where the gap distance is constant but the **Gap Sizing** object face pairs may change due to alignment. For linear devices (actuators), the **No** option may be preferred since the gap distance may change during a geometry update, but the face pairs will likely remain unchanged.
Note — For many applications, a typical **Gap Aspect Ratio** setting of 3:1 and **Gap Density** set to **Coarse** will produce good results. You may need to adjust the **Curv/Proximity** setting (under the **Advanced Global Control** option) in order to get a mesh. If this does not work, you may need to adjust the **Gap Aspect Ratio** or **Gap Density** settings or apply other size controls to the model.

The **Generate on Update** field should be set to **No** to generate gap sizing controls with multiple gap distances. Use multiple **Gap Tool** objects in this situation.

Note — Make sure that your maximum gap size is the actual gap size. A gap size that is too large will cause a meshing failure or incorrect size distribution.

### 1 - Algorithmic Notes

The size on the face pairs in regions that lie within the specified gap distance is determined as follows:

\[
\text{Size} = d_G \times \text{GA}
\]

where:

- \(d_G\) = the maximum **Gap Distance**
- \(\text{GA}\) = the **Gap Aspect Ratio**

Mesh refinement occurs across the gap on tetrahedron that lie within the gap.

If you have a very small gap, keep in mind that the original size on the faces of the bodies adjacent to the gap will be computed as described above. These elements may be difficult or impossible to refine if the gap is very small.

### Mesh Sweeping

This method of meshing complements the free mesher that produces tetrahedron elements. If a part’s topology is recognized as sweepable, the part can be meshed very efficiently with hexahedral and wedge elements using this technique. The number of nodes and elements for a swept part is usually much smaller than ones meshed with the free mesher. In addition, the time to create these elements is much smaller.

Simulation will automatically check to see if the part fulfills the topological requirements for sweeping. It will then choose two faces that are topologically on the opposite sides of the part. These faces are called the source and target faces. Simulation will mesh the source face with quadrilateral and triangular faces and then copy that mesh onto the target face. It then generates either hexahedral or wedge elements connecting the two faces and following the exterior topology of the part.

### Sweepable Parts

A part cannot be swept if any of these conditions exist:

- There is more than one set of continuously connected faces in the part.
- There is a completely contained internal void in the part.
- No two faces in the body are opposite to one another in the part’s topology and have edges connecting each of the first face’s vertices with the second face’s vertices (in other words it cannot find a source and target face).
- If a **Sizing** control is used on a body with hard edge sizing and the source and target faces contain hard divisions which are not the same for each respective edge.
When sweeping it is only necessary to apply hard divisions to one leg of the sweep path. If the path is multiple edges, you should apply your controls to that path.

If the sweep path is shared by another body and that path lies on the bodies source or target face then more hard divisions may be needed to constrain the sweeper.

To preview any parts that can be sweep meshed, click Mesh on the Section : Tree Outline and right-click the mouse. Select Preview Sweep to display parts that fulfill the requirements of a sweepable volume. However, even if these requirements are met, the shape of the part may at times still result in poorly shaped elements. In these cases, the tetrahedron mesher is used to mesh the part.

**Other Characteristics of Volume Sweeping**

Other characteristics of sweeping include the following:

- The source and target faces do not have to be flat or parallel.
- If the topology of the source and target face is the same, the sweeping operation will often succeed even if the shape of the source face is different from the shape of the target face. However, drastically different shapes can cause element shape failures.
- Sweeping does not require your model to have a constant cross section. However, the best results are obtained for constant or linearly varying cross sections.

**Parameters**

*Parameters* refer to the entire set of possible parameters allowable in Simulation, including CAD parameters and engineering parameters (pressure magnitude, maximum stress, fatigue life, dimension of a part, material property type, Young’s modulus, and others).

The Parameter Manager Worksheet collects all specified parameters and lists them in the Parameter Manager’s grids for later use and/or modification.

While engineering parameters are indicated simply by clicking the parameter box in the Section : Details View, CAD parameters must be given some extra attention, both in the CAD package and in Simulation.

**Specifying Parameters**

The Section : Details View in the application window provides check boxes for items that may be parameterized. The Parameter Manager Worksheet design provides an activity center for the enhanced definition of input and output parameters in a unified location.

The following screen shots illustrate parameter definition for typical objects in Simulation:

- Part Object
- Force Object
- Stress Object
- Material Properties
Part Object

The screen shot below shows the details of a part object:

A P defines the **Volume** as parameterized.

Force Object

The screen shot below shows the details for a Force object:
The Magnitude of the force is parameterized.

Other details, such as the **Geometry**, **Define By** and **Direction** cannot be parameterized.

**Stress Object**

The screen shot below shows the details for a Stress object.
A P appears next to the selected output parameters.

The Minimum is selected as an output parameter.

The Maximum is not selected as an output parameter. Maximum will not appear in the The Parameter Manager Worksheet.

**Material Properties**

The screen shot below, from the Engineering Data, illustrates parameter definition for material properties:
A P appears next to the definitions you are Parameterizing. Parameterizing a material definition affects all parts that use the definition.

**Parameter Restrictions**

If an object has a parameterized field, and that object definition is changed in a way that makes that parameterization non-meaningful, the parameterization will be removed by the program. Some examples include:

- A material in Engineering Data has a parameterized density, and then the user suppresses the material.
- A Force in Simulation has a parameterized magnitude, and then the user switches to a component definition.
- A result in Simulation is scoped to a surface and has a parameterized maximum value, and then the user re-scopes the result to a different topology.

*Note* — If the user suppresses an object, no parameter boxes will be shown for any property on that object. If the user parameterizes the **Suppressed** property on an object, no parameter boxes will be shown for any other property on that object, regardless of whether or not the object is suppressed.

**The Parameter Manager Worksheet**

The Parameter Manager is an HTML worksheet contained as an object in the Tree Outline under **Solution**. It performs the following tasks:

- Collects and manages input and output parameters.
- Manages the editing and solution of multiple “what if?” scenarios. A scenario is a variation on a simulation in which input parameters are varied to study the effect on output parameters.
The Parameter Manager worksheet appears in the Worksheet tab, replacing the graphics.

Read-only values are shaded in the Details View.

Note — In the Parameter Manager worksheet, angles and angular velocity are always displayed in units of radians and radians/second respectively, even though they may be displayed in degrees in Simulation.

Inserting a Parameter Manager Worksheet

To insert a Parameter Manager Worksheet, right-click Solution in the Section : Tree Outline, and select Insert> Parameter Item> Parameter Manager. A Parameter Manager icon appears under the Solution. After you have defined one or more Section : Parameters, this area includes a table of Section : Scenario Grids.

Note — If an environment includes parameters, and a second environment is formed that is coupled to the first environment, the second environment will retain the same parameters as the first environment. For example, if a Thermal Condition load is based on an environment with specific parameters defined in its Parameter Manager worksheet, then the second structural environment will include the same parameters defined in its Parameter Manager worksheet.

Inserting a Variable Graph

To insert a graph of items that are Section : Parameters in your analysis, choose Insert> Parameter Item> Variable Graph. Be sure at least two parameters have been defined.

Life Span of the Parameter Manager Worksheet

Only one Parameter Manager can exist under the Solution.

Parameters in general may be disabled in the Options dialog box. The Parameter Manager can be hidden or disabled. The P boxes still appear even if the parameter Manager is disabled.

Scenario Grids

The Scenarios Table
Creating Scenarios
Editing Parameter Values
Solving Scenarios
Exporting the Scenario Table

The Scenarios Table

The following table lists scenarios in which input parameters are varied to study the effect on output parameters. Right click on the grid to add, modify, and delete a scenario. The solve command calculates results for the current branch in addition to these scenarios. Solving many scenarios may take a lot of time. Uncheck any scenario that you do not want to include in the solution. A scenario in blue indicates that all input parameters match the values in the current branch in the Outline.

<table>
<thead>
<tr>
<th>Run</th>
<th>Bearing Load</th>
<th>Structural Steel Young's Modulus</th>
<th>Part 1 Volume m³</th>
<th>Total Deformation Max. m</th>
<th>Status</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5000</td>
<td>1.5e+005</td>
<td>24599</td>
<td>0.15395</td>
<td>Done</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>5000</td>
<td>2.0e+005</td>
<td>24899</td>
<td>0.11546</td>
<td>Done</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>5000</td>
<td>2.5e+005</td>
<td>24899</td>
<td>9.257e-002</td>
<td>Done</td>
<td></td>
</tr>
</tbody>
</table>

The Scenarios section contains a table used to edit and control multiple solutions with different input parameter values.
• Parameters are represented as columns arranged left to right in the same order as the Definitions tables: Input Parameters first, Output Parameters, second. Columns are added or removed automatically.
• The left-most column simply numbers the rows. The numbers help to identify rows, especially if the table spans multiple pages when printed.
• Rows are sorted (ascending or descending) by selecting one column. Clicking a column header toggles the sort criterion. When sorting, ascending order is always used with the first column click regardless of whether the selected column was previously sorted in ascending order. Columns containing numbers and strings (column header plus row values) are not able to be sorted.
• Highlighting (to show focus) is by row; selecting multiple cells is not allowed.
• A row in bold indicates that the input and output parameter values match the current values in the outline.
• A Comment column (to the right of all parameters) contains any text comments entered to describe a row.

Creating Scenarios

To create a scenario, click on the special area below the last row, as shown. This creates a new row at that location. Parameter values for the new scenario are copied from the current values in the Outline.

You may delete any scenario by pressing the [Delete] key on the keyboard.

Editing Parameter Values

To edit an input parameter value, click the cell containing the parameter’s value and then edit the numeric values, for example, Magnitude.

Solving Scenarios

Each scenario is solved independently when you choose Solve (typically from the button in the Main toolbar). The branch containing the Parameter Manager is also solved. You may exclude a scenario from the solution by removing the check from its second column. This essentially locks the output parameters in the scenario.

Only the information displayed in the Parameter Manager is preserved from the solution of the scenarios. To view contours or other information, the user must solve a branch that uses the parameter values from a particular scenario.

The last solved scenario exists in the Outline.

Note — When you choose Solve, precedence is given to scenario values that are checked over corresponding values listed in the Details View. For example, if you change a parameter value in the Details View that has a corresponding value in a checked scenario, that change is ignored and the scenario value is “pushed back” to become the value listed in the Details View.

Exporting the Scenario Table

To export the Scenario Table, right-click the Parameter Manager in the Section : Tree Outline. Select Export. A dialog box enables you to choose a name and location for an Excel spreadsheet file which will be generated.

What Ifs

By specifying different input and output parameters and by creating different scenarios using the The Scenarios Table, you can perform “What If” analyses.
Defining Input and Output Parameters

The Definitions section of The Parameter Manager Worksheet lists both input and output parameters. You can assign custom names to each.

- The default name for a parameter is the same as the Refers To name. You may arbitrarily rename parameters by typing in the table.
- The column Refers To shows the original name of the parameter.
- The column Current Value lists the value for each parameter as taken from the corresponding object. The values in this column are read-only. The current value of a parameter may not necessarily match its value in any of the scenarios below.
- The rows are sorted top-to-bottom by the order in which they appear in the Outline. This sort option cannot be changed.
- Rows are added or removed automatically as detail items are checked or unchecked. The user cannot delete rows to uncheck a detail item.

Failures

Handling Solution Errors in the Parameter Manager

A scenario may fail to solve for a number of reasons, including:

- Invalid parameter value.
- Failed CAD update.
- Insufficient memory or disk space.
- License not available.
- User stopped the solution.
- Load or support became unattached.
- Solution failed to converge.
- Solution failed to complete successfully.

It is possible for more than one scenario to fail within a given solution, for different reasons.

Goals for error handling include:

- Make failures clear in the Scenarios table.
- Not prevent other scenarios from finishing (e.g. by displaying modal error message boxes).
- Not obscure solved information in the table. That is, allow the user to focus on successes before addressing failures.

The following screen shot of the bottom of a Parameter Manager worksheet shows one scenario that failed the solution process:
The Status lists Failed.

**CAD Parameters**

CAD parameters are a subset of the application parameters. As the name implies, CAD parameters come from a CAD system and are used to define the geometry in the CAD system. If identified correctly in the CAD program, these parameters can then be managed in the application using The Parameter Manager Worksheet. Although each CAD system assigns its parameters differently, Simulation identifies them via a key (ds or DS). This identifier can appear either at the beginning or the end of the parameter name and does not need to be separated from the name with an underscore or any other character. By identifying the parameters of interest you can effectively filter CAD parameter exposure. Any of the following examples are valid CAD parameter names using DS or ds as the key:

- DSlength
- widthds
- dsradius

**DS** is the default key for importing CAD parameters into the application. You can change this default via the Personal Parameter Key option on the Geometry Preferences.

*Note — If you change the key phrase to nothing all parameters are exposed.*

CAD parameters must be assigned correctly in the CAD system in order to be imported. Refer to your CAD system instructions for detailed information on assigning these parameters. Some system specific notes are included here for your convenience. Remember that these are all actions that must be performed in the CAD system before importing the model.

**Autodesk Inventor**

After a part is open in Inventor, click **Tools> Parameters**. In the **Parameters** dialog box, click a parameter name under the **Parameter Name** column, modify the parameter name to include **ds** at either the beginning or end of the name and click [Enter]. Click **Done** to close the **Parameters** dialog box.

**Autodesk Mechanical Desktop**

In MDT, parameter names are associated with a part’s parameters through the use of a variable table. Create a variable table with the desired elements and their values (via the **Part Menu> Design Variable** and then type in their names and values). Then use **Dimensions> Dimensions as Equations** or **Edit Features> Edit** to set each dimension to its corresponding variable. Both methods can be accessed by a right mouse click and then selecting the appropriate entity.
Pro/ENGINEER

In Pro/Engineer, modify the parameter name by selecting **Modify** > **DimCosmetics** > **Symbol** and then select the model. If the model shows numeric values, then select **Info** > **SwitchDims** so that the names are text based instead of numeric. Click on the dimension cosmetic and enter `ds` or `DS` at the beginning or end of the string to expose that dimension for optimizing. You must click on all of the **Done** buttons in Pro/Engineer before trying to import the model.

Solid Edge

After a model is opened in Solid Edge, click **Tools** > **Variables**... If the dimensions (type Dim) are not shown in the **Variable Table** dialog box, click the **Filter** button for the **Filter** dialog box. Highlight both **Dimensions** and **User Variables** under the **Type** column; select **Both** under the **Named By** column and select **File** under the **Graphics in** column. Then click **OK**. Click the name of a dimension (under the **Name** column), modify the dimension name to include `ds` at either the beginning or end of the name and click Enter. Close the **Variable Table** dialog box.

SolidWorks

In SolidWorks, open the part and then click on the part or on the feature in the tree. Then right-click the dimension on the model, open the **Properties** dialog box, and edit the name of the dimension.

Unigraphics

After a model is opened in Unigraphics, click **Application** > **Modeling**... and the **Tools** > **Expression**... In the **Edit Expressions** dialog box, select the expression with the variable name that you want to rename and click **Rename**. Change the expression name in the **Rename Variable** dialog box to include `ds` at either the beginning or end of the name and click **OK**. Click **OK/Apply** to close the **Edit Expressions** dialog box.

Fatigue Overview

Fatigue provides life, damage, and factor of safety information and uses a stress-life or strain-life approach, with several options for handling mean stress and specifying loading conditions. Common uses for the strain-life approach are in notched areas where, although the nominal response is elastic, the local response may become plastic. The three components to a fatigue analysis are:

- Section : Fatigue Material Properties
- Section : Fatigue Analysis and Loading Options
- Section : Reviewing Fatigue Results

For detailed information on how these components are handled, go to the ANSYS web site.

Fatigue Material Properties

Materials in the material library may include fatigue curves populated with data from engineering handbooks. You can also add your own fatigue curves in the Engineering Data. The **Fatigue Tool** will use the information from these curves for each material in the model when calculating life, damage, safety factors, etc. If Young's Modulus is temperature dependent, then the fatigue calculations are carried out using the Young's Modulus computed at the reference temperature.

For the strain-life approach, the materials must have strain-life parameters defined.
• To define strain-life material properties, click Data to transfer to Engineering Data, then choose Add/Remove Properties and make sure that Strain-Life Parameters is checked.

• To define the values for the strain-life material properties, click on the graph icon for Strain-Life Parameters and make sure values are entered for the following four strain-life parameter properties and the two cyclic stress-strain parameters:
  - Strength Coefficient
  - Strength Exponent
  - Ductility Coefficient
  - Ductility Exponent
  - Cyclic Strength Coefficient
  - Cyclic Strain Hardening Exponent

Note that in Engineering Data, under Property Attributes, in the Display Curve Type drop down menu, you can plot either a Strain-Life or Cyclic Stress-Strain curve.

**Fatigue Analysis and Loading Options**

After you have defined the stress-life or strain-life curves for all materials in your model, you can choose your fatigue options and run the fatigue analysis.

To select the fatigue analysis and loading options, you must select a Solution object. Click Fatigue Tool either on the toolbar or via a right-mouse click. In the Section : Details View for the Fatigue Tool, you may specify the following options:

**Fatigue Strength Factor (Kf )**

This is the fatigue strength reduction factor. The stress-life or strain-life curve(s) are adjusted by this factor when the fatigue analysis is run. This setting is used to account for a “real world” environment that may be harsher than a rigidly-controlled laboratory environment in which the data was collected. Common fatigue strength reduction factors to account for such things as surface finish can be found in design handbooks.

**Loading Type**

Choose from the following:

- Zero-Based \((r=0)\)
- Fully Reversed \((r=-1)\)
- Ratio
- History Data (available only for stress-life applications)
- Non-proportional Loading (available only for stress-life applications)

The first three are all constant amplitude, proportional loading types and are illustrated with a graph in the Geometry window.

The fourth type, history data, allows you to navigate to a file containing the data points. This option is a non-constant amplitude proportional loading type. This data will also be depicted in a graph in the Geometry window.
The fifth option is a non-proportional constant amplitude loading type for models that alternate between two completely different stress states (for example, between bending and torsional loading). Problems such as an alternating stress imposed on a static stress can be modeled with this feature. Non-proportional loading is applicable on fatigue tools under Solution Combination where exactly two environments are selected.

**Scale Factor**

This setting scales the load magnitude. For example, if you set this to 3, the maximum amplitude of a zero-based curve will be 1.5 times the stress in the body. The graph in the Geometry window will update to reflect this setting. This option is useful to see the effects of different finite element loading magnitudes without having to run the complete structural analysis repeatedly.

**Analysis Type**

Choose either **Stress Life** or **Strain Life**.

**Mean Stress Theory**

This setting specifies how the mean stress effects should be handled.

- If **Analysis Type** is set to **Stress Life**, choose from **None**, **Goodman**, **Soderberg**, **Gerber**, and **Mean Stress Curves**. The **Goodman**, **Soderberg**, and **Gerber** options use static material properties along with S-N data to account for any mean stress while **Mean Stress Curves** use experimental fatigue data to account for mean stress. The default mean stress theory can be defined through the Simulation **Fatigue** settings in the **Options** dialog box.

- If **Analysis Type** is set to **Strain Life**, choose from **None**, **Morrow**, and **SWT** (Smith-Watson-Topper).

**Note** — A sample plot of each of these theories is shown at the bottom of the **Worksheet** view. This plot does not use live data, but is rather a generic representation of each theory. For more information on these theories, see "Metal Fatigue In Engineering" by Ralph I. Stephens, et. al.

**Stress Component**

Because stresses are multiaxial but experimental fatigue data is usually uniaxial, the stress must be converted from a multiaxial stress state to a uniaxial one. You can choose from several types, including component stresses, von Mises, and a **signed** von Mises, which takes the sign of the absolute maximum principal stress. The signed von Mises is useful for accounting for any compressive mean stresses.

**Bin Size**

This setting defines how many divisions the cycle counting history should be organized into for the history data loading type. Strictly speaking, this is number specifies the dimensions of the rainflow matrix. A larger bin size has greater precision but will take longer to solve and use more memory.

**Use Quick Rainflow Counting**

This option is only applicable for non-constant amplitude loading. Since rainflow counting is used, using a “quick counting” technique substantially reduces runtime and memory, especially for long time histories. In quick counting, alternating and mean stresses are sorted into bins before partial damage is calculated. This means that with quick counting active, calculations will be performed for maximum of binsize. Thus the accuracy will be dictated by the number of bins. Without quick counting, the data is not sorted into bins until after partial damages are found and thus the number of bins will not affect the results. The accuracy of quick counting is
usually very good if a proper number of bins are used when counting. To see the effects of using quick counting, compare the results of constant amplitude loading to simulated constant amplitude loading from a load history file. With quick counting off, the result should match exactly but with quick counting on, there will be some error depending on the bin size and alternating stress value in relation to the midpoint of the bin the count is sorted into.

**Infinite Life**

This option defines what life will be used if the stress amplitude is lower than the lowest stress on the SN curve. This option is only applicable for non-constant amplitude loading and may be important in how damaging small stress amplitudes from the rainflow matrix are.

Since the strain-life method is equation based it has no built-in limit, unlike stress-life for which the Fatigue Tool uses a maximum life equal to the last point on the SN curve. Thus to avoid skewed contour plots showing very high lives, you can specify Infinite Life in a strain-life analysis. For example, if you set a value of 1e9 cycles as the Infinite Life, the maximum life reported is 1e9.

**Reviewing Fatigue Results**

After you have included the Fatigue Tool in your analysis, you can then choose from among several results options. Any of these results can be scoped to individual parts or surfaces if desired. To select the fatigue solution items, you must be under a Solution object. Click Fatigue Tool either on the toolbar or via a right-mouse click and select any of the following options:

- Life
- Damage
- Safety Factor
- Biaxiality Indication
- Equivalent Alternating Stress
- Rainflow Matrix (history data only)
- Damage Matrix (history data only)
- Fatigue Sensitivity
- Hysteresis

**Life**

This result contour plot shows the available life for the given fatigue analysis. If loading is of constant amplitude, this represents the number of cycles until the part will fail due to fatigue. If loading is non-constant, this represents the number of loading blocks until failure. Thus if the given load history represents one month of loading and the life was found to be 120, the expected model life would be 120 months.

In a constant amplitude analysis, if the alternating stress is lower than the lowest alternating stress defined in the S-N curve, the life at that point will be used.

**Equivalent Alternating Stress**

The Equivalent Alternating Stress contour is the stress used to query the S-N curve. This result is not valid if the loading has non-constant amplitude (Loading Type = history data). The result is useful for cases where the design criteria is based on an equivalent alternating stress as specified by the fatigue analyst.
**Damage**

Fatigue damage is defined as the design life divided by the available life. The default design life may be set through the **Options** dialog box. A damage of greater than 1 indicates the part will fail from fatigue before the design life is reached.

**Safety Factor**

This result is a contour plot of the factor of safety (FS) with respect to a fatigue failure at a given design life. The maximum FS reported is 15.

**Biaxiality Indication**

This result is a stress biaxiality contour plot over the model that gives a qualitative measure of the stress state throughout the body. A biaxiality of 0 corresponds to uniaxial stress, a value of -1 corresponds to pure shear, and a value of 1 corresponds to a pure biaxial state.

For Non-proportional loading, you can choose between average biaxiality and standard deviation of biaxiality in the Details View.

**Rainflow Matrix (history data only)**

This graph depicts how many cycle counts each bin contains. This is reported at the point in the specified scope with the greatest damage.

The Navigational Control at the bottom right-hand corner of the graph can be used to zoom and pan the graph. You can use the double-sided arrow at any corner of the control to zoom in or out. When you place the mouse in the center of the Navigational Control, you can drag the four-sided arrow to move the chart points within the chart.
Damage Matrix (history data only)

Similar to the rainflow matrix, this graph depicts how much relative damage each bin has caused. This result can give you information related to the accumulation of the total damage (such as if the damage occurred through many small stress reversals or several large ones).

The Navigational Control at the bottom right hand corner of the graph can be used to zoom and pan the graph. You can use the double-sided arrow at any corner of the control to zoom in or out. When you place the mouse in the center of the Navigational Control, you can drag the four-sided arrow to move the chart points within the chart.
**Fatigue Sensitivity**

This plot shows how the fatigue results change as a function of the loading at the critical location on the scoped region. Sensitivity may be found for life, damage, or factory of safety. For instance, if you set the lower and upper fatigue sensitivity limits to 50% and 150% respectively, and your scale factor to 3, this result will plot the data points along a scale ranging from a 1.5 to a 4.5 scale factor. You can specify the number of fill points in the curve, as well as choose from several chart viewing options (such as linear or log-log).

The Navigational Control at the bottom right hand corner of the graph can be used to zoom and pan the graph. You can use the double-sided arrow at any corner of the control to zoom in or out. When you place the mouse in the center of the Navigational Control, you can drag the four-sided arrow to move the chart points within the chart.

To specify a result item, you must be under a **Solution** object.
In a strain-life fatigue analysis, although the finite element response may be linear, the local elastic/plastic response may not be linear. The Neuber correction is used to determine the local elastic/plastic response given a linear elastic input. Repeated loading will form close hysteresis loops as a result of this nonlinear local response. In a constant amplitude analysis a single hysteresis loop is created although numerous loops may be created via rainflow counting in a non-constant amplitude analysis. The **Hysteresis** result plots the local elastic-plastic response at the critical location of the scoped result (the **Hysteresis** result can be scoped, similar to all result items). **Hysteresis** is a good result to help you understand the true local response that may not be easy to infer. Notice in the example below, that although the loading/elastic result is tensile, the local response does venture into the compressive region.

*Loading/Elastic Response:*
Contact

Contact conditions are formed where bodies meet. You can transfer structural loads and heat flows across the contact boundaries and “connect” the various bodies. There are no limits placed on the number of bodies that comprise an assembly. Depending on the type of contact, the analysis can be linear or nonlinear. A nonlinear
analysis can increase runtime significantly, as the solver will internally run iterations to arrive at a converged solution.

By default, when an assembly is imported from a CAD system, contact is automatically detected and contact regions are assigned for face/face conditions. This default can be changed in the Options dialog box under the Simulation Contact settings.

The contact default settings and automatic detection capabilities are sufficient for most contact problems. However, additional contact controls are available that broaden the range of contact simulations you can perform:

- Global capabilities include controls for automatic contact detection and transparency for highlighting contact regions. These capabilities apply to all contact regions.
- Contact region controls include scoping, defining contact type, and advanced controls such as specifying contact formulation, normal stiffness, update stiffness, thermal conductance, and the pinball region.

Related References

- Global Contact Settings
- Contact Region Settings
- Supported Contact Types and Formulations
- Setting Contact Conditions Manually
- Contact Ease of Use Features
- Contact Tool and Results
- Contact Option Preferences

Global Contact Settings

These controls are located in the Details View when the Contact item is selected in the Section : Tree Outline.

- **Generate Contact on Update**: Face/face contact regions are automatically created when a model is imported (updated) provided this preference is set in the Options dialog box. Setting this option to No still allows you to manually activate automatic contact generation, or construct contact regions manually.
- **Tolerance Type, Tolerance Value, and Tolerance Slider**: Bodies in an assembly that were created in a CAD system may not have been placed precisely, resulting in small overlaps or gaps along the contact regions between bodies. You can account for any imprecision by specifying contact detection tolerance (applicable to automatic contact detection only).

To tighten the contact detection between bodies, move the Tolerance Slider bar closer to +100. To loosen the contact detection, move the Tolerance Slider bar closer to -100. A tighter tolerance means that the bodies have to be within a smaller region (of either gap or overlap) to be considered in contact; a loose tolerance will have the opposite effect. Be aware that as you adjust the tolerance, the number of contact pairs could increase or decrease.

Contact detection tolerance can also be adjusted using an exact distance. Change Tolerance Type to Value and enter a specific distance in the Tolerance Value field.

If you select a Contact branch in the tree and the Tolerance Type is set to Value, a circle appears around the current cursor location as shown here.
The radius of the circle is a graphical indication of the current Tolerance Value. The circle moves with the cursor, and its radius will change when you change the Tolerance Value or the Tolerance Slider. The circle appropriately adjusts when the model is zoomed in or out.

- Types of Contact Detection: By default, Auto Detection will detect contact between faces of different bodies (Face/Face). Contact can also be detected between the faces and edges (Face/Edge) of different bodies, or between edges and edges (Edge/Edge) of different bodies. For Face/Edge detection, faces are designated as targets and edges are designated as contacts. You can select any combination of contacts to be detected during Create Automatic Contact. You can also set default preferences for these contact filter options in the Options dialog box.

In addition, face to edge contact has the option to determine contact for only Solid edges or only Surface edges. If face to edge contact only for solid body edges is selected, face to edge contact will use only the edges of solid bodies to determine contact with all faces. Likewise, if face to edge contact only for surface body edges is selected, face to edge contact will use only edges of surface bodies to determine contact with all faces.

- Priority: For very large models the number of contact regions can sometimes become overwhelming and redundant, especially when multiple types of contact are allowed. Selecting some type of priority other than Include All will lessen the number of contact regions generated during Create Automatic Contact by giving designated contact types precedence over other types.

Priority refers to the type of contact interaction between a given set of geometry bodies. Face Overrides gives Face/Face contact precedence over both Face/Edge and Edge/Edge contact. Face Overrides also gives Face/Edge contact precedence over Edge/Edge contact. In general, when Face Overrides priority is set with Face/Edge and Edge/Edge contact, no Edge/Edge contact pairs will be detected. Edge Overrides gives Edge/Edge contact precedence over both Face/Edge and Face/Face contact. Edge Overrides also gives Face/Edge contact precedence over Face/Face contact. In general, when Edge Overrides priority is set with Face/Edge and Face/Face contact, no Face/Face contact pairs will be detected.

- Same Body Grouping: Allows you to control automatically generated contact regions.
With automatic detection enabled, setting **Same Body Grouping** to **Yes** (default) means that contact surfaces and edges that lie on the same bodies will be included into a single region. Automatically generated pairs may have multiple selections on the source side, or on the target side, or on both sides. Use this option for most problems. It will minimize the number of contact regions created.

With automatic detection enabled, setting **Same Body Grouping** to **No** means that the grouping of contact surfaces and edges that lie on the same bodies will not occur. Any regions generated will have only one entity scoped to its source and target (that is, one surface or one edge). Applications for choosing **No** are:

- If there are a large number of source/target surfaces in a single region. Choosing **No** avoids excessive contact search times in the ANSYS solver.
- If you want to define different contact behaviors on separate regions with contact of two parts. For example, for a bolt/bracket contact case, you may want to have bonded contact between the bolt threads/bracket and frictionless contact between the bolt head/bracket.

### Contact Region Settings

Various contact settings are available in the Details View when a **Contact Region** is selected in the Section : Tree Outline. Settings for displaying, selecting, or listing contact and target items are found under the **Scope** category. Commonly used contact settings are found under the **Definition** category, while less often used and more advanced contact settings are found under the **Advanced** category.

#### Scope Settings

- **Scoping Method**: Specifies whether the contact region is scoped to a **Geometry Selection** or to a **Named Selection**.
- **Contact**: Displays/selects what faces or edges are considered **contact**. This list will be automatically filled for auto generated contact pairs, and depends on the automatic contact detection types that you have specified. For **Face/Edge** contact, the edge must be designated as **Contact**.
- **Target**: Displays/selects what faces or edges are considered **target**. This list will be automatically filled for auto generated contact pairs and depends on the automatic contact detection types that you have specified. For **Face/Edge** contact, the face must be designated as **Target**.
- **Contact Bodies**: This read only property displays which bodies have faces or edges in the **Contact** list. Note that if you click on this field, the bodies are highlighted.
- **Target Bodies**: This read only property displays which bodies have faces or edges in the **Target** list. Note that if you click on this field, the bodies are highlighted.

#### Definition Settings

- **Type**: The differences in the contact settings determine how the contacting bodies can move relative to one another. This is the most common setting and has the most impact on what other settings are available. Most of these types only apply to contact regions made up of faces only.
  - **Bonded**: This is the default configuration for contact regions. If contact regions are bonded, then no sliding or separation between faces or edges is allowed. Think of the region as **glued**. This type of contact allows for a linear solution since the contact length/area will not change during the application of the load. If contact is determined on the mathematical model, any gaps will be closed and any initial penetration will be ignored.
- **No Separation**: This contact setting is similar to the bonded case. It only applies to regions of faces. Separation of faces in contact is not allowed, but small amounts of frictionless sliding can occur along contact faces.

- **Frictionless**: This setting models standard unilateral contact; that is, normal pressure equals zero if separation occurs. It only applies to regions of faces. Thus gaps can form in the model between bodies depending on the loading. This solution is nonlinear because the area of contact may change as the load is applied. A zero coefficient of friction is assumed, thus allowing free sliding. The model should be well constrained when using this contact setting. Weak springs are added to the assembly to help stabilize the model in order to achieve a reasonable solution.

- **Rough**: Similar to the frictionless setting, this setting models perfectly rough frictional contact where there is no sliding. It only applies to regions of faces. By default, no automatic closing of gaps is performed. This case corresponds to an infinite friction coefficient between the contacting bodies.

- **Frictional**: In this setting, two contacting faces can carry shear stresses up to a certain magnitude across their interface before they start sliding relative to each other. It only applies to regions of faces. This state is known as “sticking.” The model defines an equivalent shear stress at which sliding on the face begins as a fraction of the contact pressure. Once the shear stress is exceeded, the two faces will slide relative to each other. The coefficient of friction can be any non-negative value.

Choosing the appropriate contact type depends on the type of problem you are trying to solve. If modeling the ability of bodies to separate or open slightly is important and/or obtaining the stresses very near a contact interface is important, consider using one of the nonlinear contact types (**Frictionless**, **Rough**, **Frictional**), which can model gaps and more accurately model the true area of contact. However, using these contact types usually results in longer solution times and can have possible convergence problems due to the contact nonlinearity. If convergence problems arise or if determining the exact area of contact is critical, consider using a finer mesh (using the **Sizing** control) on the contact faces or edges.

- **Friction Coefficient**: Allows you to enter a friction coefficient. Displayed only for frictional contact applications.

- **Scope Mode**: Read-only property that displays how the contact region was generated.
  - **Automatic**: Program automatically generated contact region.
  - **Manual**: Contact region was constructed or modified by the user.

- **Behavior**: Sets contact pair to one of the following:
  - **Asymmetric**: Contact will be asymmetric for the solve. All face/edge and edge/edge contacts will be asymmetric.

    Asymmetric contact has one face as **Contact** and one face as **Target** (as defined under **Scope** Settings), creating a single contact pair. This is sometimes called “one-pass contact,” and is usually the most efficient way to model face-to-face contact for solid bodies.

  - **Symmetric**: (Default) - Contact will be symmetric for the solve.

  - **Auto Asymmetric**: Automatically creates an asymmetric contact pair, if possible. This can significantly improve performance in some instances. When you choose this setting, during the solution phase the solver will automatically choose the more appropriate contact face designation. Of course, you can designate the roles of each face in the contact pair manually.

To produce meaningful contact results for contact pressure, you must either choose the **Auto Asymmetric** setting or manually create an asymmetric contact pair.
**Advanced Settings**

Note — Cases involving large gaps and surfaces bonded together can result in fictitious moments being transmitted across a boundary.

- **Formulation**: Controls the underlying contact formulation method. The following choices are available:
  - **Augmented Lagrange**: Compared to the Pure Penalty method, this method usually leads to better conditioning and is less sensitive to the magnitude of the contact stiffness coefficient. However, in some analyses, the Augmented Lagrange method may require additional iterations, especially if the deformed mesh becomes too distorted.
  - **Pure Penalty**: Basic default formulation. For some contact geometries, refer to Supported Contact Types and Formulations.
  - **MPC**: Multipoint constraint equations are created internally during the ANSYS solve to tie the bodies together. This can be helpful if truly linear contact is desired or to handle the nonzero mode issue for free vibration that can occur if a penalty function is used. For some contact geometries, refer to Supported Contact Types and Formulations. Note that this setting is valid only for Bonded contact. Also note that contact based results (such as pressure) will be zero.
  - **Normal Lagrange**: Enforces zero penetration when contact is closed making use of a Lagrange multiplier on the normal direction and a penalty method in the tangential direction. Normal Stiffness is not applicable for this setting. Normal Lagrange adds contact traction to the model as additional degrees of freedom and requires additional iterations to stabilize contact conditions. It often increases the computational cost compared to the Augmented Lagrange setting. The Iterative setting (under Solver Type) cannot be used with this method.

- **Interface Treatment**: Indicates how the contact interface for the pair is treated. The following options are available:
  - **Adjust to Touch**: Any initial gaps are closed and any initial penetration is ignored creating an initial stress free state. Contact pairs are “just touching” as shown.

  ![Contact pair before any Interface Treatment.](image1)  
  ![Contact pair after Adjust to Touch treatment.](image2)  
  
  Gap exists.  
  Gap is closed automatically. Pair is “just touching”.
This setting is useful to make sure initial contact occurs even if any gaps are present (as long as they are within the pinball region). Without using this setting, the bodies may fly apart if any initial gaps exist. Although any initial gaps are ignored, gaps can still form during loading for the nonlinear contact types. This treatment is used inherently for the linear contact types (Bonded and No Separation), which is the reason why Interface Treatment is not displayed for these contact types. For nonlinear contact types (Frictionless, Rough, and Frictional), Interface Treatment is displayed where the choices are Adjust to Touch and Add Offset.

- **Add Offset**: Models the true contact gap/penetration plus adds in any user defined offset values. This setting is the closest to the default contact setting used in ANSYS except that the loading is ramped. Using this setting will not close gaps. Even a slight gap may cause bodies to fly apart. Should this occur, use a small contact offset to bring the bodies into initial contact. Note that this setting is displayed only for nonlinear contact and is the default value for nonlinear contact.

- **Specify Offset**: Defines the contact offset. Positive values move the contact closer together (increase penetration/reduce gap) and negative values move the contacts further apart. This setting is displayed only if Interface Treatment is set to Add Offset.

Contact pair before any Interface Treatment. **Penetration exists.**

Pair touches at interface. Contact pair after Adjust to Touch treatment.

Contact pair before any Interface Treatment. **Gap exists.** Contact pair after Add Offset treatment. Gap is closed "manually" based on value entered for Specify Offset (positive value shown that includes some penetration).
• **Normal Stiffness**: Defines a contact normal stiffness factor. The usual factor range is from 0.01-10, with the default selected programmatically. A smaller value provides for easier convergence but with more penetration. The default value is appropriate for bulk deformation. If bending deformation dominates, use a smaller value (0.01-0.1). If you encounter convergence difficulties or too much penetration, you can adjust the stiffness factor.

  - **Program Controlled** - (default) The Normal Stiffness Factor will be calculated by the program. If only Bonded or No Separation contact exists, the value is set to 10. If any other type of contact exists, all the program controlled regions (including Bonded or No Separation) will use the ANSYS default (Real constant FKN).
  - **Manual** - The Normal Stiffness Factor is input directly by the user.

• **Normal Stiffness Factor**: Allows input of the Normal Stiffness Factor. Only positive values are allowed. This choice is displayed only if **Manual** is specified for **Normal Stiffness**.

• **Update Stiffness**: Allows you to specify if the program should update (change) the contact stiffness during the solution. The update choices are at each equilibrium iteration or at each substep. If you choose either of these stiffness update settings, the program will modify the stiffness (raise/lower/leave unchanged) based on the physics of the model (that is, the underlying element stress and penetration). This choice is displayed only if you set the **Formulation** to Augmented Lagrange or Pure Penalty, the two formulations where contact stiffness is applicable.

  An advantage of choosing either of the program stiffness update settings is that stiffness is automatically determined that allows both convergence and minimal penetration. Also, if this setting is used, problems may converge in a Newton-Raphson sense, that would not otherwise.

  You can use a **Result Tracker** to monitor a changing contact stiffness throughout the solution.

  The following choices are available for **Update Stiffness**:

  - **Never**: (Default)¹ Turns off the program’s automatic Update Stiffness feature.
  - **Each Equilibrium Iteration**: Sets the program to update stiffness at the end of each equilibrium iteration. This choice is recommended if you are unsure of a Normal Stiffness Factor to use in order to obtain good results.
  - **Each Substep**: Sets the program to update stiffness at the end of each substep.

  ¹ - The default can be changed in the **Options** dialog box under **Contact**.

• **Thermal Conductance**: Controls the thermal contact conductance value used in a thermal contact simulation.

  - **Program Controlled** - (default) The program will calculate the value for the thermal contact conductance. The value will be set to a sufficiently high enough value (based on the thermal conductivities and the model size) to model perfect contact with minimal thermal resistance.
  - **Manual** - The Thermal Conductance Value is input directly by the user.

• **Thermal Conductance Value**: Allows input of the Thermal Conductance Value (in units of heat transfer film coefficient). Only positive values are allowed. This choice is displayed only if **Manual** is specified for **Thermal Conductance**.

• **Pinball Region**: Allows you to specify the contact search size, commonly referred to as the pinball region. Setting a pinball region can be useful in cases where initially, bodies are far enough away from one another.
that, by default, the program will not detect that they are in contact. You could then increase the pinball region as needed. Consider an example of a surface body that was generated by offsetting a surface of a solid body, possibly leaving a large gap, depending on the thickness. Another example is a large deflection problem where a considerable pinball region is required due to possible large amounts of over penetration. In general though, if you want two regions to be bonded together that may be far apart, you should specify a pinball region that is large enough to ensure that contact indeed occurs.

For bonded and no separation contact types, you must be careful in specifying a large pinball region. For these types of contact, any regions found within the pinball region will be considered to be in contact. For other types of contact, this is not as critical because additional calculations are performed to determine if the two bodies are truly in contact. The pinball region defines the searching range where these calculations will occur. Further, a large gap can transmit fictitious moments across the boundary.

- **Program Controlled** - (default) The pinball region will be calculated by the program.
- **Radius** - Specifies that you directly enter a value for the pinball region.

The pinball radius for the contact region is shown graphically at the annotation anchor for the Radius setting and possibly for the Program Controlled setting. You can move the annotation anchor to any point on the contact region, which helps in the visual verification of an appropriate pinball radius.

- **Pinball Radius**: The numerical value for the pinball radius. This choice is displayed only if Pinball Region is set to Radius.
- **Search Direction**: Allows you to specify the contact search direction when the contact region involves a surface body edge. This choice is displayed only if Formulation is set to MPC.

- **Target Normal** - (default) Contact search is in a direction normal to the target face.
- **Inside Pinball** - Contact search is initially in a direction normal to the target face. If contact is not detected, the search continues inside the pinball region. This setting is suggested for simulating bodies in contact that do not overlap. As an example, consider searching for contact between two surface bodies butted together with edge/edge type. If Target Normal is chosen, contact will not occur regardless of how large the pinball region is. If Inside Pinball is chosen, contact will occur assuming the pinball region is large enough.

### Supported Contact Types and Formulations

The following table identifies supported contact types, formulations, and whether symmetry is respected for various contact geometries:

<table>
<thead>
<tr>
<th>Contact Geometry</th>
<th>Solid Body Face (Scope = Contact)</th>
<th>Solid Body Edge (Scope = Contact)</th>
<th>Surface Body Face (Scope = Contact)</th>
<th>Surface Body Edge (Scope = Contact)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid Body Face (Scope = Target)</td>
<td>All types</td>
<td>Bonded, No Separation</td>
<td>Bonded, No Separation</td>
<td>Bonded</td>
</tr>
<tr>
<td></td>
<td>All formulations</td>
<td>All formulations</td>
<td>All formulations</td>
<td>MPC formulation</td>
</tr>
<tr>
<td></td>
<td>Symmetry respected</td>
<td>Symmetry NOT respected</td>
<td>Symmetry respected</td>
<td>Symmetry NOT respected</td>
</tr>
<tr>
<td>Solid Body Edge (Scope = Target)</td>
<td>Not supported for solving$^1$</td>
<td>Bonded, No Separation</td>
<td>Not supported for solving$^1$</td>
<td>Bonded</td>
</tr>
<tr>
<td></td>
<td>All formulations</td>
<td>Symmetry NOT respected</td>
<td>Symmetry NOT respected</td>
<td>MPC formulation</td>
</tr>
</tbody>
</table>

1. Not supported for solving when the contact is not a solid body edge.
### Setting Contact Conditions Manually

Manual contact regions represent contact over the entire extent of the contact scope, for example, faces of the contact region.

Automatic contact regions represent contact only to the extent of the scope where the corresponding bodies initially are close to one another. For automatic contact, the contact elements are “trimmed” before solution. The trimming is based on the detection tolerance. The tighter the tolerance, the less number of generated contact elements. Note that if you set Large Deflection effects to On in the Details View of a Solution object, no trimming will be done due to the possibility of large sliding.

Valid reasons to manually change or add/delete contact regions include:

- Modeling “large sliding” contact. Contact regions created through auto-detection assume "assembly contact," placing contact faces very near to one another. Manual contact encompasses the entire scope so sliding is better captured. In this case, you may need to add additional contact faces.
- Auto-detection creates more contact pairs than are necessary. In this case, you can delete the unnecessary contact regions.
- Auto-detection may not create contact regions necessary for your analysis. In this case, you must add additional contact regions.

You can set contact conditions manually, rather than (or in addition to) letting the application automatically detect contact regions.

Within a source or target region, the underlying geometry must be of the same geometry type (for example, all surface body faces, all solid body faces). The source and target can be of different geometry types, but within itself, a source must be of the same geometry type, and a target must be of the same geometry type.

#### To set contact regions manually:

1. Click the **Contact** item in the Section : Tree Outline.
2. Choose **Insert > Manual Contact Region** from the menu bar or via right mouse click. You can also select the **Contact** button on the toolbar.

3. A **Contact Region** item appears in the Outline. Click that item, and under the Section : Details View, specify the **Contact** and **Target** regions (faces or edges) and the contact type.

### Contact Ease of Use Features

The following features are intended to assist you in performing simulations involving contact:

- Controlling Transparency for Contact Regions
- Hiding Bodies Not Scoped to a Contact Region
- Renaming Contact Regions Based on Geometry Names
- Identifying Contact Regions for a Body
- Flipping Contact/Target Scope Settings
- Merging Contact Regions That Share Geometry
- Saving or Loading Contact Region Settings
- Resetting Contact Regions to Default Settings
- Locating Bodies Without Contact

### Controlling Transparency for Contact Regions

As shown below, you can graphically highlight an individual contact region.

The following is an animated GIF. Please view online if you are reading the PDF version of the help.

- Click on a contact region to highlight the bodies in that region.
- Highlighting is due to internal transparency settings:
  - Transparency is set to 0.8 for bodies in selected contact region.
  - Transparency is set to 0.1 for bodies not in selected contact region(s).
- You can change the default transparency values in the Simulation **Contact** settings of the **Options** dialog box.
- You can disable the contact region highlighting feature in either the Details View of a contact group branch, or by accessing the context menu (right mouse click) on a contact region or contact group branch of the tree, and choosing **Disable Transparency**.

### Hiding Bodies Not Scoped to a Contact Region

You can hide all bodies except those that are scoped to a specific contact region.

**To Hide All Bodies Not Scoped to a Contact Region:**

1. Select the **Contact Region** object whose bodies you do not want to hide.
2. Right-click to display the context menu.
3. Select **Hide All Other Bodies** in the menu. All bodies are hidden except those that are part of the selected contact region.

### Renaming Contact Regions Based on Geometry Names

You can change the name of any contact region using the following choices available in the context menu that appears when you click the right mouse button on a particular contact region:

- **Rename**: Allows you to change the contact region name to a name that you type (similar to renaming a file in Windows Explorer).
- **Rename Based on Geometry**: Allows you to change the contact region name to include the corresponding names of the items in the **Geometry** branch of the tree that make up the contact region. The items are separated by the word “To” in the new contact region name. You can change all the contact region names at once by clicking the right mouse button on the **Contact** branch, then choosing **Rename Based on Geometry** from that context menu. A demonstration of this feature follows.

*The following is an animated GIF. Please view online if you are reading the PDF version of the help.*

### Identifying Contact Regions for a Body

You can identify contact regions in the tree that are associated with a particular body.

**To Identify Contact Regions for a Body:**

1. Select one or more vertices, edges, faces, or bodies in the **Section : Geometry** window.
2. Right-click to display the context menu.
3. Select **Go To > Contacts for Selected Bodies** in the menu. The contact regions associated with the bodies of the selected items will be displayed in the **Geometry** window and highlighted in the tree.
Flipping Contact/Target Scope Settings

A valuable feature available when using asymmetric contact is the ability to swap contact and target face or edge Scope settings in the Details View. You accomplish this by clicking the right mouse button on the specific contact regions ([Ctrl] key or [Shift] key for multiple selections) and choosing Flip Contact/Target. This is illustrated below for a single region.

The following is an animated GIF. Please view online if you are reading the PDF version of the help.

Note — This feature is not applicable to Face/Edge contact where faces are always designated as targets and edges are always designated as contacts.

Merging Contact Regions That Share Geometry

You can merge two or more contact regions into one contact region, provided they share the same type of geometry (edges or faces).
To Merge Contact Regions That Share Geometry:

1. Select two or more contact regions in the tree that share the same type of geometry (edges or faces). Use the [Shift] or [Ctrl] key for multiple selections.
2. Right-click to display the context menu.
3. Select Merge Selected Contact Regions in the menu. This option only appears if the regions share the same geometry types. After selecting the option, a new contact region is appended to the list in the tree. The new region represents the merged regions. The individual contact regions that you selected to form the merged region are no longer represented in the list.

Saving or Loading Contact Region Settings

You can save the configuration settings of a contact region to an XML file. You can also load settings from an XML file to configure other contact regions.

To Save Configuration Settings of a Contact Region:

1. Select the contact region whose settings you want to save.
2. Right-click to display the context menu.
3. Select Save Contact Region Settings in the menu. This option does not appear if you selected more than one contact region.
4. Specify the name and destination of the file. An XML file is created that contains the configuration settings of the contact region.

Note — The XML file contains properties that are universally applied to contact regions. For this reason, source and target geometries are not included in the file.

To Load Configuration Settings to Contact Regions:

1. Select the contact regions whose settings you want to assign. Use the [Shift] or [Ctrl] key for multiple selections.
2. Right-click to display the context menu.
3. Select Load Contact Region Settings in the menu.
4. Specify the name and location of the XML file that contains the configuration settings of a contact region. Those settings are applied to the selected contact regions and will appear in the Details View of these regions.

Resetting Contact Regions to Default Settings

You can reset the default configuration settings of selected contact regions.

To Reset Default Configuration Settings of Contact Regions:

1. Select the contact regions whose settings you want to reset to default values. Use the [Shift] or [Ctrl] key for multiple selections.
2. Right-click to display the context menu.
3. Select Reset to Default in the menu. Default settings are applied to the selected contact regions and will appear in the Details View of these regions.
Locating Bodies Without Contact

When you are working with complex assemblies of more than one body, it is helpful to find bodies that are not in contact with any other bodies, but perhaps should be designated as contact regions. Bodies that are not in contact with other bodies generally cause problems for a solution.

To Locate Bodies Without Contacts in Tree:

1. Right-click in the Section : Geometry window.
2. Select Go To in the right-click context menu.
3. Select Bodies Without Contacts in Tree.

Note — This choice is available only if there is more than one body in your assembly.

Virtual Topology Overview

Before performing analysis of a CAD model, you may want to group surfaces/edges together to form virtual cells. Virtual Topology can aid you in reducing the number of elements in the model, simplifying small features out of the model, and simplifying load abstraction.

Introduction

A CAD Model in Simulation has two parts:

1. Topology: The connectivity of a CAD model, meaning: vertices are connected to edges, which are connected to faces, which are connected to volumes. Each one of these entities is referred to as a cell.
2. Geometry: The geometry of the CAD model is the underlying mathematical definition of the aforementioned cells.

A virtual cell in Simulation modifies the topology of only the local copy in Simulation. Your original CAD model remains unchanged because the model in Simulation is a virtual image.

Virtual Cell Creation

You can manually designate faces and edges for inclusion into a virtual cell or, for sheets only, you can have Simulation automatically create virtual cells based on settings that you specify. The geometry under a virtual cell is represented by the underlying cell’s graphic resolution. All cells must be adjacent to one another to create virtual topology. There is a geometric limitation when creating virtual cells.

Note — The tessellation of models from CATIA4 may not be appropriate for virtual topology, which could prevent the creation of virtual cells for these models.

Creating Virtual Cells Manually

1. Insert a Virtual Topology object in the tree.
2. Choose a face or edge selection filter, then pick adjacent faces or edges that you want to include in the virtual cell.
3. Insert a Virtual Cell object in the tree.
Creating Virtual Cells Automatically

1. Insert a Virtual Topology object in the tree.
2. Make adjustments as needed to any of the following settings in the Details View:
   - **Region Flatness** - Slider control that sets the flatness of the virtual cell region's Gauss map angle. The range is from 0° to 180°.
   - **Smallest Edge Tolerance** - Virtual cells will be created for any surface/edge whose edge length is less than or equal to this value.
   - **Shared Boundary Ratio** - Slider control that sets a threshold ratio of how much boundary is shared as a condition for merging. Surfaces below this tolerance are not merged. The range is from 0 to 1.
   - **Region Size** - Slider control that defines the target region size as a decimal number whose percentage is of the total surface area. The range is from 0 to 1.
   - **Generate on Update** - Sets whether you want to include the settings in this Details View when you update geometry.
3. Click right mouse button on Virtual Topology object and choose Generate Virtual Cells from the context menu. A Virtual Cell object is automatically inserted in the tree for each region containing only sheets that meets the criteria established by the settings in step 2.

*Note* —
- After automatic creation of the virtual cells, the state some Contact objects may change to Under-defined, implying that you must regenerate contact (right mouse button click on Contact object and choosing Create Automatic Contact from the context menu).
- If Generate on Update is set to Yes and you update the geometry, all Virtual Cell objects that were created automatically will be deleted and recreated based on the new geometry. Any loads that were attached to geometry within the deleted Virtual Cell objects will need to be reattached to the new geometry.
- If Generate on Update is set to No and you update the geometry, all Virtual Cell objects that were created automatically should remain persistent barring major topology changes of the model being updated. Reapplication of loads may not be necessary.
- When you suppress a face in a virtual cell, the virtual edges that bound the surface are suppressed. When you unsuppress the face in the virtual cell, you must manually unsuppress the virtual edges that bound the face.
## CAD Systems

### Geometry Interface Support for Windows

<table>
<thead>
<tr>
<th>Reader/Plug-In</th>
<th>Version of CAD Package</th>
<th>Windows 2000 (Service Pack 2, Version 5.00, Build 2195)</th>
<th>Windows XP Professional</th>
<th>Windows XP Professional x64</th>
<th>Windows XP Home</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Intel IA32 Windows</td>
<td>Intel IA32 Windows</td>
<td>EM64T, AMD64</td>
<td>Intel IA32 Windows</td>
</tr>
<tr>
<td>Reader for ACIS (SAT)</td>
<td>ACIS 14</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Reader for Parasolid</td>
<td>Parasolid 16.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Reader for CATIA for Simulation only</td>
<td>CATIA V4</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Reader for CATIA</td>
<td>CATIA V5 (R2–R15)</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Reader for IGES</td>
<td>IGES 4.0, 5.2, 5.3</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Reader for STEP</td>
<td>AP203, AP214</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Reader/Plug-In for Solid Edge</td>
<td>Solid Edge Version 16.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Reader/Plug-In for SolidWorks</td>
<td>SolidWorks 2004</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Reader/Plug-In for Autodesk</td>
<td>Inventor R9</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Reader/Plug-In for Pro/ENGINEER</td>
<td>Pro/ENGINEER Wildfire 1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Reader/Plug-In for Unigraphics</td>
<td>Unigraphics NX 2.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Reader/Plug-In for Mechanical Desktop</td>
<td>Mechanical Desktop 2005</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Geometry Interface Support for UNIX and Linux

<table>
<thead>
<tr>
<th>Reader/Plug-In</th>
<th>Version of CAD Package</th>
<th>Solaris 8</th>
<th>Solaris 8 ULTRA III*</th>
<th>HP-UX 11.0 (64–bit)</th>
<th>Intel IA-32 Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reader for <strong>ACIS</strong> (SAT)</td>
<td>ACIS 14</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Reader for <strong>Parasolid</strong></td>
<td>Parasolid 16.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Reader for <strong>CATIA</strong> for Simulation only</td>
<td>CATIA V4</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Reader for <strong>CATIA</strong></td>
<td>CATIA V5 (R2–R15)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader for <strong>IGES</strong></td>
<td>IGES 4.0, 5.2, 5.3</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Reader for <strong>STEP</strong></td>
<td>AP203</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for <strong>Solid Edge</strong></td>
<td>Solid Edge Version 16.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for <strong>SolidWorks</strong></td>
<td>SolidWorks 2004</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for <strong>Autodesk</strong></td>
<td>Inventor R9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In for <strong>Pro/ENGINEER</strong></td>
<td>Pro/ENGINEER Wildfire 1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>
* This version processor may run on the Sun UltraSPARC 64–bit platform, but with limited performance.

*** UGNX3.0.1.3 MP1 is supported on these systems.

**Geometry Preferences**

You can set the following geometry preferences on the Project Page or in the Details View of Geometry. Preferences on the Project Page are included in two categories: **Default Geometry Usage Options** and **Advanced Geometry Usage Defaults**, as shown below. You can set default options in the **Options** dialog box under **Common Settings: Geometry Import**.

- **Project Page Default Geometry Options**

<table>
<thead>
<tr>
<th>Project Page Selection</th>
<th>Details View and Options Dialog Box Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type (drop down menu)</td>
<td>Analysis Type</td>
<td>– On Project Page, sets the geometry for a 2-D simulation or a 3-D simulation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– In Options dialog box, sets default for the Project Page setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– In Details View, a read only indication of the current analysis type.</td>
</tr>
</tbody>
</table>

The preference applies to all supported CAD systems and to DesignModeler.
<table>
<thead>
<tr>
<th>Project Page Selection</th>
<th>Details View and Options Dialog Box Selection</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Solid Bodies**      | **Import Solid Bodies**                     | Imports solid bodies. ¹ The default is Yes. The preference applies to the following:  
  All CAD plug-ins  
  ACIS reader  
  CATIA reader  
  DesignModeler  
  IGES reader  
  STEP reader  
  OneSpace Designer Modeling  
  Parasolid reader |
| (check box)            |                                             |              |
| **Surface Bodies**    | **Import Surface Bodies**                   | Imports surface bodies. ¹ The default is Yes. The preference applies to the following:  
  Pro/ENGINEER  
  SolidWorks  
  Solid Edge  
  Unigraphics  
  ACIS reader  
  CATIA reader  
  DesignModeler  
  IGES reader  
  STEP reader  
  OneSpace Designer Modeling  
  Parasolid reader |
| (check box)            |                                             |              |
| **Line Bodies**       | **Import Line Bodies**                      | Imports line bodies. The default is Yes. The preference applies to the following:  
  DesignModeler |
| (check box)            |                                             |              |
| **Parameters**        | **Parameter Processing**                    | Allows you to turn off parameter processing because it can take too long. The default is Yes. The preference applies to the following:  
  DesignModeler  
  Inventor  
  Mechanical Desktop  
  Pro/ENGINEER  
  Solid Edge  
  SolidWorks  
  UG |
<p>| (check box)            |                                             |              |</p>
<table>
<thead>
<tr>
<th><strong>Project Page Selection</strong></th>
<th><strong>Details View and Options Dialog Box Selection</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameters (text field)</td>
<td>Personal Parameter Key (Displayed only when Parameter Processing is set to Yes in the Details View.) Allows you to specify a key that must appear at the beginning or end of a CAD parameter name for the application to display as a CAD parameter in the interface. The default is DS. You can customize this field. The preference applies to the following:</td>
<td>DesignModeler Inventor Mechanical Desktop Pro/ENGINEER Solid Edge SolidWorks UG</td>
</tr>
<tr>
<td>Attributes (check box)</td>
<td>CAD Attribute Transfer Allows import of CAD system attributes into Simulation models. Enable this option to import Motion Loads. The default is No. The preference applies to the following:</td>
<td>Inventor Mechanical Desktop Pro/ENGINEER Solid Edge (motion loads only) SolidWorks UG</td>
</tr>
<tr>
<td>Attributes (text field)</td>
<td>CAD Attribute Prefixes This field can have any number of prefixes with each prefix delimited by a semicolon. By default the filter is set to SDFEA;DDM. If the filter is set to an empty string all applicable entities will be imported as CAD system attributes.</td>
<td></td>
</tr>
<tr>
<td>Named Selections (check box)</td>
<td>Named Selection Processing Creates a named selection based on data generated in the CAD system or in DesignModeler. You must set the value in the Named Selection Prefixes field (described below) to the desired value. Upon attaching or updating, a Named Selection branch is added to the tree and its name appears in the drop down display within the Named Selection Toolbar. It is maintained as a CAD named selection unless the branch is altered (entities added or deleted, selection renamed). After updating, CAD named selections are deleted and replaced with named selections that are imported for the updated model. The default is No. The preference applies to the following:</td>
<td>DesignModeler Inventor Mechanical Desktop Pro/ENGINEER Solid Edge SolidWorks UG</td>
</tr>
<tr>
<td>Project Page Selection</td>
<td>Details View and Options Dialog Box Selection</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Named Selections</td>
<td>Named Selection Prefixes</td>
<td>(Displayed only when Named Selection Processing is set to Yes in the Details View.) Allows you to set the named selection processing prefix key. The default is NS. This field can have any number of prefixes with each prefix delimited by a semicolon (for example: NS_ForceFaces;NS_FixedSupports;NS_BoltLoaded). By default the filter is set to NS. If the filter is set to an empty string all applicable entities will be imported as named selections.</td>
</tr>
<tr>
<td>Material Properties</td>
<td>Material Properties Transfer</td>
<td>Allows import of material data defined in the CAD system. Only a subset of material data will be imported. This will include Young’s Modulus, Poisson Ratio, Mass Density, Specific Heat, Thermal Conductivity and Thermal Expansion Coefficient. Limited additional data may be imported depending on CAD support. A material file will be created that reflects each of the CAD materials assigned to the model. You can validate the imported data as well as edit all of the material property values in the Engineering Data. Choosing Update will allow you to import new materials but will not update values of previously imported materials. This is done to avoid overwriting user changes to previously imported material files. The default is No. The preference applies to the following: DesignModeler[3] Inventor Pro/ENGINEER UG</td>
</tr>
</tbody>
</table>

[1] These preferences are on a per part basis. Parts with solid bodies and surface bodies will result in an attach failure if both import type preferences are selected. For assemblies however, where different components are solely solid body or surface body, import of each part will be successful.

[2] Limitations on importing named selections:

- If you use a CAD system filter for entities, you must be able to create entities with names that correspond to the filter.
- Named selection sets should contain entities of only a single dimension (for example, faces, edges).
- SolidWorks and Pro/ENGINEER require unique identifiers. This limits a named selection to a single entity per part in the model.
- Refer to the Named Selection Import Based on Entities table to determine the CAD system support for the various entities (vertex, edge, face, body).

[3] You cannot define materials directly in DesignModeler, although DesignModeler can import material properties from Pro/ENGINEER, Inventor, or Unigraphics, and pass those properties on to Simulation.

- Project Page Advanced Geometry Defaults
<table>
<thead>
<tr>
<th>Project Page Selection</th>
<th>Details View Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAD associativity</td>
<td>CAD Associativity</td>
<td>Indicates if action should be taken to allow associativity. This option is present because some CAD systems take too long to compute associativity. The default is Yes. The preference applies to the following:</td>
</tr>
<tr>
<td>(check box)</td>
<td></td>
<td>- Inventor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Mechanical Desktop</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- OneSpace Designer Modeling</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Solid Edge</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- SolidWorks</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- UG</td>
</tr>
<tr>
<td>Reader mode saves updated CAD file</td>
<td>Reader Save Part File</td>
<td>When set to Yes, the Unigraphics reader interface will save the part file of a model at the end of an update process using the same file name in the same directory. The default is No. The preference applies to the following:</td>
</tr>
<tr>
<td>(check box)</td>
<td></td>
<td>- UG Reader</td>
</tr>
<tr>
<td>Smart CAD Update</td>
<td>Do Smart Update</td>
<td>Speeds up refresh of models that have unmodified components. If set to Yes and changes are made to other preferences, these will not be respected if the component is smart updated. The default is No. The preference applies to the following:</td>
</tr>
<tr>
<td>Temporary file during attach</td>
<td>Attach File Via Temp File</td>
<td>Specifies whether file should be imported directly or as a temporary file. Recommendation is Yes for large models to decrease import time. A file will be created and deleted during the processing of an attach or update. The default is No. The preference applies to the following:</td>
</tr>
<tr>
<td>(check box)</td>
<td></td>
<td>- All CAD plug-ins</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- All CAD readers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- DesignModeler</td>
</tr>
<tr>
<td>Browse...</td>
<td>Temporary Directory</td>
<td>(Displayed only when Attach File Via Temp File is set to Yes in the Details View.) Allows you to change the directory in which the temp file is created to a writable directory. The default is ...\Documents and Settings&lt;user id&gt;\Local Settings\Temp.</td>
</tr>
<tr>
<td>(button)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Named Selection Import Based on Entities**

An “X” represents entities that are supported by the CAD system in the first column.

<table>
<thead>
<tr>
<th>CAD System</th>
<th>Vertex</th>
<th>Edge</th>
<th>Face</th>
<th>Body</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autodesk Inventor</td>
<td>Part Level</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Assembly Level</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>DesignModeler</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Autodesk Mechanical Desktop</td>
<td>Part Level</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Assembly Level</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Pro/ENGINEER</td>
<td>Part Level</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Assembly Level</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Solid Edge</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>SolidWorks</td>
<td>Part Level</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Assembly Level</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unigraphics</td>
<td>Part Level</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Assembly Level</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
General Information

File Name Limitation

Part names from CAD systems will be truncated to 31 characters. If the file name is not unique within the first 31 characters, problems are likely to occur when data is refreshed.

Material Properties

The CAD system interfaces will process only the isotropic material type.

Multiple Versions of CAD Systems

For most CAD systems, you cannot use geometry that was created in a newer version of the same CAD system. For example, if you have both SolidWorks 2005 and SolidWorks 2004 installed, but only the 2004 version is registered, and you attempt to insert geometry created in SolidWorks 2005 from the Start Page, the registered 2004 version will not recognize the geometry created in the 2005 version.

This situation applies to all supported CAD systems except Pro/ENGINEER, Unigraphics, and Solid Edge. For Unigraphics, you can set environment variables to specify the version. Solid Edge does not support the installation of multiple versions.

CAD System Support

<table>
<thead>
<tr>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACIS</td>
</tr>
<tr>
<td>Autodesk Inventor</td>
</tr>
<tr>
<td>Autodesk Mechanical Desktop</td>
</tr>
<tr>
<td>CATIA V4</td>
</tr>
<tr>
<td>CATIA V5</td>
</tr>
<tr>
<td>DesignModeler</td>
</tr>
<tr>
<td>IGES</td>
</tr>
<tr>
<td>OneSpace Designer Modeling</td>
</tr>
<tr>
<td>Parasolid</td>
</tr>
<tr>
<td>Pro/ENGINEER</td>
</tr>
<tr>
<td>Solid Edge</td>
</tr>
<tr>
<td>SolidWorks</td>
</tr>
<tr>
<td>STEP</td>
</tr>
<tr>
<td>Unigraphics</td>
</tr>
</tbody>
</table>

ACIS

The application supports ACIS as a reader up to version 14 including all of its point releases. Based on previous ACIS version history, any point release is likely to work also.

See the release notes for updated compatibility information.

Notes

Although the ACIS geometry format does not have an assembly entity, the application supports ACIS files containing one or multiple bodies.
Length Unit

You should specify the length unit of the parts retrieved from the ACIS file in the Geometry Details View. You can verify length units by checking the details of the Geometry or Part, which shows the part’s bounding box size. We recommend verifying dimensions before Section: Solving.

Autodesk Inventor

The application supports Autodesk Inventor R9 and R10 as both a reader and a plug-in.

Attaching CAD Geometry

You can attach Autodesk Inventor solids only.

If, upon attaching, you receive the message **Failed to get reference key**, the attaching process will continue, but an associative relation during update cannot be guaranteed.

Parts and Assemblies

The application supports Autodesk Inventor part and assembly files. Motion loads can be imported by transferring CAD attributes. See Geometry Preferences for details on setting this preference.

Length Unit

The Geometry length unit is centimeters which is the unit used internally by Autodesk Inventor. The user or working unit system can be changed by **Main Menu> Units**.

Autodesk Mechanical Desktop

Simulation supports Autodesk Mechanical Desktop 2005 and 2006 as both a reader and a plug-in. See the release notes for updated compatibility information.

Updating Drawings

It is always recommended that you issue the **AMUPDATE, ALL** command before attempting to attach drawings from Autodesk Mechanical Desktop into Simulation.

Updating Autodesk Mechanical Desktop

If you update to a new version of Autodesk Mechanical Desktop after installing Simulation, you can manually register the **MD2004SetupU.dll**, located in the `<Install directory>\Program Files\Ansys Inc\V100\AISOL\CAD Integration\MDT5` directory, or rerun the Workbench setup and choose **Repair**.

Notes

It is recommended that Autodesk Mechanical Desktop and the Simulation Plug-in be running concurrently when attaching or updating a part or assembly.

Starting Autodesk Mechanical Desktop and Simulation

If Autodesk Mechanical Desktop is not displaying the **ANSYS 10.0** menu, the Simulation Plug-in may not be installed correctly, or it may be installed correctly, but only the menu is not being displayed. This can be confirmed...
by checking the loaded application (Assist> Load Application> Loaded Applications). If the file MD2004PlugIn100NU.arx is found, the plug-in is installed properly. Try the following steps to solve the problem:

- Add the menu by choosing Assist> Customize> Menus, then click the Menu Groups tab. Browse for the Workbench 10.0 menu (\ANSYS Inc\v100\AISOL\CAD Integration\MDT2004\WorkBench100.mnu) and load. Then select the Menu Bar tab and add the Workbench 10.0 menu to desired location.
- If Autodesk Mechanical Desktop is still not displaying the Workbench 10.0 menu, rerun the Simulation setup.

Note — Workbench writes its menu entries to: C:\Documents and Settings\<username>\Application Data\Autodesk\Mechanical Desktop 2005\R16.1\enu\support, but the menus are not being read by Autodesk Mechanical Desktop at that location.

If you open Autodesk Mechanical Desktop after installing the Workbench plugin and you do not see the ANSYS 10.0 drop down menu, go to Assist> Options, then under the Files tab, choose Support File Search Path, and move the entries under C:\Documents and Settings\<username>\Application Data\Autodesk\Mechanical Desktop 2005\R16.1\enu\support to the top of the list.

3D SOLIDS, Parts and Assemblies

Simulation supports Autodesk Mechanical Desktop parts and assemblies. If multiple documents are open in Autodesk Mechanical Desktop, the top most document is considered the active document. You must be in model mode.

Simulation cannot bring in assemblies with XRef parts. We strongly recommend that you use AMCATALOG rather than XRef to manage external part/assembly files in Autodesk Mechanical Desktop.

To use ACIS solids (lists as 3DSOLID) with Simulation, use the Autodesk Mechanical Desktop command Part> Part> Convert Solid to convert the solid to a part.

Length Unit

You should specify the length unit of the parts retrieved from Autodesk Mechanical Desktop in the Geometry Details View. You can verify length units by checking the details of the Geometry or Part, which shows the part’s bounding box size. Verification of dimensions is recommended before using Solve.

CATIA V4

Simulation supports CATIA V4 files as a reader.

Notes

Simulation reads CATIA .model and .export files, but does not support .asm files. Simulation supports reading of CATIA volumes and solid models. Although the CATIA geometry format does not have an assembly entity, Simulation supports CATIA files containing one or multiple bodies. Simulation supports reading of CATIA details/dittos by exploding them.

Length Unit

Simulation automatically sets the length unit in the model to match the unit saved in the CATIA V4 file. No adjustment of length unit is necessary or possible. Multiple bodies should all be constructed using the same length unit. We recommend verifying dimensions before Section : Solving.
**CATIA V5**

Simulation supports CATIA V5 releases 2 through 15 as a reader.

**Notes**

Simulation reads CATIA V5 parts (*.CATPart) and assemblies (*.CATProduct).

CATIA V5 surface bodies consisting of closed surfaces are transferred as solid bodies.

**Length Unit**

You should specify the length unit of the parts retrieved from the CATIA V5 file in the Geometry Details View. You can verify length units by checking the details of the Geometry or Part, which shows the part’s bounding box size. Multiple bodies should all be constructed using the same length unit. We recommend verifying dimensions before Section: Solving.

**DesignModeler**

Simulation supports the DesignModeler as both a reader and a plug-in.

**Attaching Geometry**

Coordinate systems defined in a model created in DesignModeler will automatically be created in Simulation after importing the model to Simulation. Any planes in DesignModeler that are flagged to be exported will appear in Simulation as a local Cartesian coordinate system upon attachment and will be inserted into the Simulation tree. The automatic creation of the coordinate system occurs during attachment and is updated during a refresh.

Any enclosures defined with a model in DesignModeler will be retained upon attaching. Once in Simulation, the enclosure has the following characteristics:

- A transparency value of 0.1 (subdued) is assigned to the enclosure in order to assist in the visualization of the model items inside the enclosure.
- A default field material of Air is automatically assigned to the enclosure. You can change the default field material in the Engineering Data. A field material is used in any open domain simulation where an artificial boundary such as an enclosure is used to surround the model. Any fields extending from the model to the edges of the enclosure experience the field material. Examples are antenna radiation fields or fluid flow fields in Electromagnetic and Fluid simulations (planned for future releases of ANSYS Workbench).

**Parts and Assemblies**

DesignModeler does not support assemblies, but does allow you to create and import multiple bodies. If you import a model made up of independent multiple bodies, they will be imported into Simulation as individual bodies using contact elements.

If you import a model that has multi body parts (that is, parts that include multiple bodies within them as a group), then the model will be imported using shared topology so that no contact is required and meshes on the volume interfaces will match.

DesignModeler parameters are all set at the model level and will be displayed in Simulation under the Geometry branch.
For line body properties that appear in Simulation, the values shown are for the raw cross section, that is, the offset type and/or user defined offset from DesignModeler’s body properties have no bearing on the calculations shown in Simulation. They are taken directly from the cross section without applying any offset.

Surface thicknesses and material properties are transferred from DesignModeler to Simulation.

**Notes**

If you are using DesignModeler as a reader, Simulation will maintain associativity with the DesignModeler model. If you modify parameters in Simulation, the DesignModeler model will change upon update.

**Length Unit**

Simulation automatically sets the length unit in the part or assembly to match the unit saved in the DesignModeler file. No adjustment of length unit is necessary or possible.

**IGES**

The IGES reader converts IGES information written in 5.3 format and before into Parasolid data.

**Part and Assemblies Files**

IGES files containing parts or assemblies are supported by Simulation. IGES files can use the extensions `.igs` or `.iges`.

Closed surfaces and hollow solids from an IGES file are transferred as full solids in Simulation.

**Length Unit**

Simulation automatically sets the length unit in the part or assembly to meters. No adjustment of length unit is necessary or possible.

**OneSpace Designer Modeling**

Simulation supports OneSpace Designer Modeling 2005, revision 13.20, as both a reader and plug-in. See the release notes for any updated compatibility information.

**Supported Documents**

The OneSpace Designer Modeling 2005 interface supports the import of solid and surface components. The plug-in will import all parts in the model based on body type import filters. Active CAD session models imported from OneSpace Designer Modeling can only be updated from an active session unless the model is relinked to a specified file. A model imported based on its file can only be updated from the file unless relinked to an active session.

**Notes**

Supported extension types include `(*.pkg;*.bdl;*.ses;*.sda;*.sdp;*.sdac;*.sdpc)`.

SES files are not portable between different versions of OneSpace Designer Modeling. They should be limited to use on a single machine.
**Parasolid**

Simulation supports Parasolid as a reader up to and including version 16.1. See the release notes for updated compatibility information.

**Part and Assemblies Files**

Parasolid files containing parts or assemblies are supported by Simulation. Parasolid files can use the extensions `.x_t` or `.xmt_text` (text) and `.x_b` or `.xmt_bin` (binary neutral).

**Length Unit**

Simulation automatically sets the length unit in the part or assembly to meters, which is the unit used internally by Parasolid to dimension solid parts. No adjustment of length unit is necessary or possible.

**Faceting Limitation**

Generalized (non-manifold) bodies from Parasolid will not have facets with smoothly matching edges. The model will appear to have gaps; however, this is a limitation only in the faceting capabilities from Parasolid and does not affect meshing or accuracy.

**Pro/ENGINEER**

Simulation supports Pro/ENGINEER Wildfire 1 and Wildfire 2. See the release notes for updated compatibility information.

**Installation Notes**

Before installing Simulation, please make sure that you have installed Pro/ENGINEER and have run the program at least once under the user login that you will use to install Simulation.

**Notes**

If an active Pro/ENGINEER file does not appear under Active CAD Files, either Pro/ENGINEER is not running or the Simulation Plug-in for Pro/ENGINEER is not loaded. For this last condition, you must re-install the Pro/Engineer Plug-in component using the Simulation CD. For more information on attach error conditions, see CAD Related Troubleshooting.

If a part, a component, an assembly, or a sub-assembly has one or more local coordinate systems, those coordinate systems will get transferred into Simulation upon attaching. Once they are in Simulation, they can be modified by updating.

Surface bodies imported into Simulation include numerical references to the parent part or assembly and Pro/ENGINEER quilt ID. For example, a part named H103 with three Pro/ENGINEER quilts 1, 2, and 3 will be identified as H103[1], H103[2] and H103[3].

**Starting Simulation and Attaching CAD Geometry**

If you switch between the Master and simplified representations of your geometry in Pro/ENGINEER, you must use the `Erase Not Displayed` option in Pro/ENGINEER to remove the geometry not shown in Pro/ENGINEER’s window (but resident in memory) before attaching or refreshing in Simulation.
For material data to be transferred into workbench with the correct values the model and the material must be reflecting the same unit system. This unit system must be one of the 6 standard unit systems used by Pro/ENGINEER. If the unit system of the model is not supported, a warning will be displayed in Pro/ENGINEER.

If you attach surface model database files from DesignSpace 7.0, you must re-attach loads after updating.

*Note* — Due to a reported defect in the Pro/ENGINEER API, active models do not correctly reflect their UNC path. To import parts into ANSYS Workbench, you must open the parts in Pro/ENGINEER from a local or mapped drive.

### Parts and Assemblies

Simulation supports Pro/ENGINEER part (.prt) or assembly (.asm) files. When you open or attach geometry, Simulation assumes that the current active part or assembly in Pro/ENGINEER is desired.

If you open multiple parts in Pro/ENGINEER, select the window of the part that you want to work with before switching to Simulation and attaching.

When using an assembly’s offset as a parameter, a negative value will cause the direction of the offset to flip and the value will be returned with a positive sign.

### Updating Instances

If you wish to update a particular instance of a model, it is necessary that the active model in Pro/ENGINEER be the desired instance, otherwise a generic version of the instance will be used for the update.

### File Versions

Multiple versions of Pro/ENGINEER files are designated with a .# extension that is appended to the .prt or .asm extension (for example, wrench.prt.1, wrench.prt.2 are names of two Pro/ENGINEER file versions). You can access a specific version of a Pro/ENGINEER file through the Workbench Start Page.

You are strongly advised to avoid stripping the version numbers from Pro/ENGINEER files for the following reasons:

- If you open a stripped version of the file in Pro/ENGINEER and import the file via the plug-in, it will indicate the wrong version if there is any other version of that part file in the same directory.
- If you attempt to load a stripped version of the file by using the reader, the highest file version of that model will be loaded.

Regarding the updating of Pro/ENGINEER file versions, updating will be version specific if you use the reader or if you do not open a copy of that model with the same name in a Pro/ENGINEER interactive session. However, if you open one version of a model in Pro/ENGINEER and you request the same model, but a different version for attach or update, the currently active version will be assumed to be the one that you want. This assumption is necessary for the following reasons:

- Pro/ENGINEER does not allow two different versions of the same part to be active at one time, using the same name.
- If you save a model in a Pro/ENGINEER session, its version is incremented (for example, if you attach via the plug-in with version 3, then save the model in Pro/ENGINEER, the version of the active model would be version 4).
**Length Unit**

Simulation automatically sets the length unit in the part or assembly to match the unit saved in the Pro/ENGINEER part file. No adjustment of length unit is necessary or possible. Assemblies and their component parts should all be constructed using the same length unit.

**Solid Edge**

Simulation supports Solid Edge v16.0 and v17.0 as both a reader and a plug-in. See the release notes for updated compatibility information.

**Supported Documents**

The Solid Edge interface supports Solid Edge part, assembly, sheet metal, and weldment documents. If more than one document is open in Solid Edge, the top-most document, which is the active document, will be processed by the interface.

Solid Edge recommends that each part document contain only one body, otherwise a duplicate set of parameters and variables may be imported.

**Notes**

After opening a document in Solid Edge, if the ANSYS 10.0 menu is not displayed in the Solid Edge menu bar, check if ANSYS 10.0 is listed in the Available Add-Ins list box of the Add-in Manager dialog box (Tools> Add Ins> Add-In Manager...). If it is listed but not checked, check the box in front of it and click OK. If it is not listed, try to register the plug-in DLL (DSPluginSEU.dll) manually. The DLL is located in the ANSYS Workbench installation folder under the CAD Integration\Solid Edge folder. If it fails to register, re-install the Solid Edge plug-in component.

A closed surface body will be imported into Simulation as a solid body since Solid Edge considers this body as a solid.

For a part that has a simplified model, if you have this model displayed in Solid Edge, you will need to have the Simplify menu displayed in order to get the simplified model in Simulation.

**Naming Components in Solid Edge Assemblies**

When importing a Solid Edge assembly, make sure that no two components have the same name. This will result in the second component being displayed on top of the other.

**Motion Loads Import**

To import motion loads from Solid Edge models to Simulation, you will need to use the motion load files generated from the same version of Solid Edge that you are running. If the load files were generated from a different version of Solid Edge, the loads will not get imported properly.

**Length Unit**

The Part length unit within Simulation is meters independent of the unit system displayed in Solid Edge. The Length Unit displayed under “Details of Geometry” in Simulation cannot be changed.
**Parts and Assemblies**

All multi-solid-body components created in Solid Edge will be transferred to Simulation as a single part containing multiple bodies.

**SolidWorks**

Simulation supports SolidWorks 2004 and 2005 as both a reader and a plug-in. See the release notes for updated compatibility information.

**Supported Documents**

The SolidWorks interface supports SolidWorks part and assembly documents. If more than one document is open in SolidWorks, the top-most document, which is the active document, will be processed by the interface.

**Notes**

After opening a document in SolidWorks, if the ANSYS 10.0 menu is not displayed in the SolidWorks menu bar, check if ANSYS 10.0 is listed in the **Available Add-Ins** list box of the **Add-in Manager** dialog box (**Tools> Add Ins...**). If it is listed but not checked, check the box in front of it and click **OK**. If it is not listed, try to register the plug-in DLL (**DSPlugInSWU.dll**) manually. The DLL is located in the ANSYS Workbench installation folder under the **CAD Integration>SolidWorks** folder. If it fails to register, re-install the SolidWorks plug-in component.

Lightweight components (marked with a feather icon in the feature tree) of a SolidWorks assembly must be set to resolved prior to attaching into Simulation.

A SolidWorks surface model attached in Simulation may lose its associativity due to a problem in a SolidWorks API for binding back the entities. Also there is a limitation imposed by SolidWorks in relation to geometry and the API processing. If a sketch is revolved 180 degrees, the faces generated on either portion of the revolution are identified as the same. However if the revolution angle is changed, they now become different faces; one retains the original identification and the second a new one. This creates an associativity break if the angle of revolution is modified to or from 180 degrees. If this situation arises you will need to reapply loads and/or boundary conditions.

If a part, a component, an assembly, or a sub-assembly has one or more local coordinate systems, those coordinate systems will get transferred into Simulation upon attaching. Once they are in Simulation, they can be modified by updating.

Motion loads can be imported by transferring CAD attributes. See Geometry Preferences for details on setting this preference.

**Length Unit**

Simulation automatically locks the length unit in the part or assembly to meters, which is the unit used internally by SolidWorks. No adjustment of length unit is necessary or possible. The Simulation user can change the unit system for display of Simulation data.

**STEP**

Simulation supports STEP as a reader up to and including version AP203 and AP214. See the release notes for updated compatibility information.
Part and Assemblies Files

STEP files containing parts or assemblies are supported by Simulation. STEP files can use the extensions .step or .stp.

Closed surfaces and hollow solids from an STEP file are transferred as full solids in Simulation.

Length Unit

Simulation automatically sets the length unit in the part or assembly to meters. No adjustment of length unit is necessary or possible.

Unigraphics

Simulation supports Unigraphics (UG) NX2.0 and NX3.0 as both a reader and a plug-in. See the release notes for updated compatibility information.

If You Need to Re-register the Plug-In

If the ANSYS 10.0 menu is not displayed in Unigraphics menu bar:

- Check the existence of the menu file UgToDSpace.men in the ...\CAD Integration\Unigraphics\startup folder of the ANSYS Workbench product installation directory.
- Check if the UGII_CUSTOM_DIRECTORY_FILE environment variable is set and the file (default ds_custom_dirs.dat) exists. The environment variable points to this file.
- Make sure the path to the ...\CAD Integration\Unigraphics folder of the ANSYS Workbench product installation directory is listed in that file.

If any of the ANSYS 10.0 menu items do not function properly, you will need to reregister the plug-in DLL using the provided bat file, regNX.bat or regNX1.bat and regNX2.bat, which resides in the ...\CAD Integration\Unigraphics\startup directory. Replace the /s %1 with the full path of the startup folder and put this full path and the DLL name in a pair of double quotes, for example: regsvr32 “C:\Program Files\Ansys Inc\v100\AISOL\CAD Integration\Unigraphics\startup\DSPlugInUGNX2U.dll” or DSPlugInUGNX1U.dll.

Maintaining Associativity of Persistent IDs

The following is of particular importance if you update/refresh a geometry with applied loads and supports. The Unigraphics interface uses Unigraphics User Defined Objects (UDO) to store persistent IDs. To maintain the associativity of the geometry between Unigraphics and Simulation, you need to save the part file at the end of a UG session (plug-in), or save the part file from within Simulation (reader). Saving the part file from within Simulation at attach time requires that you first check the Reader mode saves updated CAD file task under the Advanced Geometry Usage Defaults group on the Project page. At update/refresh time, you will need to set the Reader Save Part File to Yes in the Preferences list of Geometry tree item in the Details View within Simulation. The part file will be saved at the end of an attach process using the same file name in the same directory. The current part file will be backed up by changing the extension of the file to bak before saving the part. Make sure that the file is not set to read-only.

If you don’t save the parts files upon update, the loads and supports could disappear or be applied to the wrong entities.
Multiple Versions of Unigraphics Installed

If you have multiple versions of Unigraphics installed, you must make sure the following environment variables are properly set when running Simulation in reader mode:

- UGI_BASE_DIR
- UGI_ROOT_DIR

The reader will use the version of Unigraphics set by these variables when processing the attach or updates. Parts files are saved in the format designated by the above two variables. For more information concerning these variables, consult your Unigraphics documentation.

Using the Teamcenter Engineering Database

When running Unigraphics in plug-in mode on a Windows platform, you can make use of the Teamcenter Engineering database repository as follows:

1. Ensure you are running “UG NX V2.0 and TcEng V9.0” or “UG NX V3.0 and TcEng V9.1.2” Base (server) and Portal (client) installed on one machine or two different machines [client-server setting] in a two-tier configuration.
2. Double-click on the part file in the TcEng Portal. This will open the part file in Unigraphics.
3. Attach the model into Simulation using ANSYS 10.0> Simulation or ANSYS 10.0> Workbench and optionally perform one or more analyses.
4. Save the .dsdb file into the TcEng database using File> Save to TcEng.

You must be aware of the following limitations when using the Teamcenter Engineering database:

- Only .dsdb files can be saved in the Teamcenter Engineering database. Other ANSYS Workbench database files like .agdb, .wbdb, and .dxdb are not supported.
- When saving the .dsdb file to the Teamcenter Engineering database, the file name cannot be more than 32 characters long including the extensions.
- The .dsdb file gets saved under a Unigraphics file data set, which implies that the .dsdb file gets saved as the Unigraphics file name.
- The .dsdb file gets saved under the dataset of the Unigraphics file sourced in the first branch of the .dsdb file. This may lead to a situation where, for example, a .dsdb file having 4 Unigraphics files in 4 branches can be potentially saved under the first sourced Unigraphics file dataset in the Teamcenter Engineering database. To make the best use of the Save to TcEng menu option, have one model per .dsdb file and do multiple analyses on that model before saving it to the Teamcenter Engineering database.

Notes

Closed surface models from Unigraphics can only be imported to ANSYS Workbench Products through UG NX 1.0.1.2 and up.

If your Unigraphics surface model has a thickness defined and it does not get transferred to Simulation, this could mean that you do not have a Unigraphics Scenario (Structural) license.

When you transfer Unigraphics expressions/parameters into Simulation, make sure that all feature parameter names are unique within a part and all non-feature parameter names are unique within an assembly. The non-feature parameters could be from one or more components of the assembly.
The non-feature parameters of a part or a component of an assembly are displayed under the **Geometry** branch in Simulation version 10.0 and in DesignSpace version 7.0. When you resume a `.dsdb` file from a version prior to 7.0, you will need to click **Update** first, from the **Update** menu upon resuming before performing any updates with one or more parameter changes from Simulation.

### Material Properties

The Unigraphics interface will not process any temperature dependent or varying material properties. Yield and ultimate tensile strength values will not get transferred since there are no APIs available for obtaining this data.

### Length Unit

Simulation automatically sets the length unit in the part or assembly to match the unit saved in the Unigraphics file. No adjustment of length unit is necessary or possible.
Problem Situations

A Load Transfer Error Has Occurred.
Although the Solution Failed to Solve Completely at all Time Points.
An Error Occurred Inside the SOLVER Module: Invalid Material Properties
An Error Occurred While Starting the ANSYS Solver Module
An Internal Solution Magnitude Limit Was Exceeded.
An Iterative Solver Was Used for this Analysis
Assemblies Missing Parts
CATIA V5 and IGES Surface Bodies
Illogical Reaction Results
Large Deformation Effects are Active
One or More Contact Regions May Not Be In Initial Contact
One or more contact regions using MPC formulation may have conflicts
One or More Parts May Be Underconstrained
Problems Unique to Asynchronous Solutions
Problems Using Solution
Running Norton AntiVirusTM Causes Simulation to Crash
The Correctly Licensed Product Will Not Run
The Deformation is Large Compared to the Model Bounding Box
The Initial Time Increment May Be Too Large for This Problem
The License Manager Server Is Down
The Solution Combination Folder
The Solver Engine was Unable to Converge
The Solver Fills My Disk With Temporary Files
Unable to Find Requested Modes

A Load Transfer Error Has Occurred.

... A load could not be applied to small or defeatured entity. Please see the Troubleshooting section of the Help System for more information.

At least one load is not able to be applied. This may be due to mesh-based defeaturing of the geometry. Set the variable allow zero nodes to 1 in order to allow the solution to proceed with an ANSYS warning which can be used to identify the offending load(s). Then, apply the load on other entities or create a finer mesh in this area.

Although the Solution Failed to Solve Completely at all Time Points.

... partial results at some points have been able to be solved. Refer to Troubleshooting in the Help System for more details.

This message displays if for some reason the simulation does not run to completion, but the solution does produce at least some results. This can occur for the following simulation types:
In a sequenced simulation where the solution was able to solve for at least one of the sequence steps but was unable to solve all the defined steps due to reasons such as non-convergence or the user choosing the **Stop** button.

In a thermal transient simulation where the model was able to solve at least one time point and write results to the result file.

If such a condition occurs, any applicable results in the tree that you request will be calculated (that is, they are defined at a sequence number or time that has been solved). These results will be assigned a green check state (up to date) but the solution itself will still be in an obsolete state because it is not fully complete. Use the **Evaluate Results** right mouse button option on a **Solution** object or a result object in order to additionally postprocess the partial solution.

See Section : Recovering Unconverged Results for further details.

**An Error Occurred Inside the SOLVER Module: Invalid Material Properties**

... Please see the Troubleshooting section of the Help system for possible causes.

Check the following:

**Material Definition**

Check the Details View for each part to see that you selected the correct material for each part. Go to the Engineering Data to edit and check your material files and data and to verify the material definitions (including numbers and units). Note that, depending on the type of result, you will have a minimum of properties to be set.

**Structural, Vibration, Harmonic, and Shape Results:**

- Need to define the Modulus of Elasticity
- If you don’t define the Poisson’s Ratio it will default to 0.0. Also note that the Solver engine will not accept values of Poisson’s Ratio smaller than 0.1 or larger than 0.4 for Shape Results.
- For Vibration and Harmonic results, include the Mass Density of your material.
- For Thermal-stress results, you will need the Coefficient of Thermal expansion.

**Thermal Results:**

Thermal conductivity is required. Can be constant or temperature-dependent.

Specific Heat is required in a thermal transient analysis. Can be constant or temperature-dependent.

**Check Thermal Data**

For thermal analysis, go to the Engineering Data to edit and check thermal conductivity in the material files and to check thermal convection in the convection files. Verify the 'smoothness' of the temperature-dependent conductivity data and convection data. Non-smooth curves will lead to Solve failures.

**Electromagnetic Materials - Minimum Requirements**

For a **Conductor** scoped to a body, the associated material must have either **Resistivity** or **Orthotropic Resistivity** specified in order for the simulation to continue on to a solve.
For all materials in an electromagnetic simulation, one of the following four conditions must be met. These conditions are mutually exclusive of each other so only one condition can exist at a time for a material.

- **Linear “Soft” Magnetic Material** properties specified: Either **Relative Permeability** or **Linear Orthotropic Permeability** are set.
- **Linear “Hard” Magnetic Material** properties specified. Only **Linear “Hard” Magnetic Material** property is set.
- **Nonlinear “Soft” Magnetic Material** properties specified: Either only **BH Curve** or **BH Curve** and **Nonlinear Orthotropic Permeability** are set.
- **Nonlinear “Hard” Magnetic Material** properties specified: Only **Demagnetization BH Curve** is set.

### An Error Occurred While Starting the ANSYS Solver Module

There are two reasons that the ANSYS solver may fail.

#### Insufficient Memory

You may not have enough virtual memory assigned to your system. To increase the allocation of virtual memory (total paging file size), go to **Settings> Control Panel> System** (on your Windows Start Menu). Click the **Advanced** tab and then click **Performance Options**. Increase the size of your virtual memory.

#### Insufficient Disk Space

You may not have enough disk space to support the increase in virtual memory and the temporary files that are created in the analysis. Be sure you have enough disk space or move to an area where you have enough.

### An Internal Solution Magnitude Limit Was Exceeded.

... Please check your Environment for inappropriate load values or insufficient supports. Also check that your mesh has more than 1 element in at least 2 directions if solid brick elements are present. Please see the Troubleshooting section of the Help System for more information.

In most cases this message will occur if your model is improperly constrained or extremely large load magnitudes are applied relative to the model size. First check that the applied boundary conditions are correct. In some cases, loads that are self-equilibrating with no support may be desired. To help in these cases, if this message occurs, consider adjusting the weak spring stiffness or turning on inertia relief.

Another scenario that includes the following conditions can also prompt this message:

- Structural solid models
- Brick meshes that have only 1 element in less than 2 directions.
- Reduced element integration (This can happen by default if **Element Control** in the **Geometry** object is set to **Program Controlled**.)

If the above conditions are met and you receive this message, do one of the following:

- Modify the mesh to have more than 1 element in at least 2 directions.
- Use **Full** integration on the offending bodies.
An Iterative Solver Was Used for this Analysis

...However, a direct solver may enhance performance. Consider specifying the use of a direct solver.

An iterative solver was used to obtain the solution; however, a large number of iterations were needed in order to get a converged answer.

By default, the program will either choose a direct or iterative solver based on analysis type and geometric properties. (In general, thin models perform better with a direct solver while bulky models perform better with an iterative solver.) However, sometimes the iterative solver is chosen when the direct solver would have performed better. In such cases, you may want to force the use of the direct solver. You may specify the solver type in the Details View of the Solution folder.

Assemblies Missing Parts

When reading assemblies from CATIA V5, all part files that are referenced by assemblies must be accessible in order for the importing to occur.
CATIA V5 and IGES Surface Bodies

CATIA V5 and IGES surface bodies consisting of closed surfaces are transferred as solid bodies.

Illogical Reaction Results

Cause

Loads, supports, or contact items are applied to the same or shared topology.

Reason

It is unclear or ambiguous as to which reaction should be attributed to which support, load, or contact item. Refer to this Note for details.

Large Deformation Effects are Active

... Which may have invalidated some of your applied supports such as frictionless, cylindrical, or compression only supports. Refer to Troubleshooting in the Help System for more details.

In a large deformation analysis, the program updates the nodal coordinates as the solution progresses towards the final configuration. As a result, supports that fix only some of the degrees of freedom of a node but not all (for example fix only UX=0), may become invalid as the model’s nodal coordinates and thus nodal rotation angles are updated. A classic example is a simple torsion of a rod. Initially the nodes at zero degrees have a circumferential direction of UY but after a twist of 90 degrees, have a circumferential direction of UX.

The user is responsible for determining if any nodal rotation at the support is significant enough to cause undesired results.

The following is a list of supports which only fix the movement of a node partially and thus are susceptible to large deformation effects:

- Frictionless Support
- Displacement
- Cylindrical support

In addition a Compression Only Support may be susceptible to large deformation effects because if large sliding occurs, the surface can literally "slide off" the compression only support.

One or More Contact Regions May Not Be In Initial Contact

... Check results carefully. Refer to Troubleshooting in the Help System for more details.

During the solution it was found that one or more of the contact pairs was not initially in contact. You may check the solution output located in the Worksheet tab of a Solution Information object to determine exactly which contact pairs are initially open, and take the appropriate action.

- This message is expected if a contact pair is meant to be initially open and may become closed after the load application.
• If initial contact was desired and the contact pair has a significant geometric gap, setting the Pinball Radius manually to a sufficiently large value may be required.

• If shell edge contact is involved and the Search Direction is set to Target Normal, setting the direction to Inside Pinball may be required depending on the geometry configuration.

• If symmetric contact is active, it is possible that one pair may be initially open and its symmetric pair be initially in contact. Check the solution output to confirm this.

One or more contact regions using MPC formulation may have conflicts

... With applied boundary conditions or other contact regions. Refer to Troubleshooting in the Help System for more details.

During solution it was found that one or more contact pairs using MPC (multi point constraint) contact formulation overlaps with another contact region or boundary condition. Due to the fact that MPC formulation can cause over constraint if applied to the same nodes more than once, the program may have not been able to completely bond the desired entities together. You may check the solution output located in the Worksheet tab of a Solution Information object to determine which pairs and nodes are affected by this condition. Specifically this can happen when:

• A contact pair entity (either an edge or surface) also has a Dirichlet (prescribed displacement/temperature) boundary condition applied to it. In this case the MPC constraints will not be created at nodes that have prescribed conditions thus possibly causing parts to lose contact. Sometimes this warning may be disregarded in cases such as a large surface with a fixed support at one edge and a contact pair on another. If it is determined that overlap does indeed exist, consider relocating the applied support or using a formulation other than MPC.

• Two MPC contact pairs share topology (such as a surface or an edge). Again it is possible for one or both of these pairs to lose contact. This message may especially occur when edge/face contact is automatically generated by the program because often 2 complementary contact pairs (that is, edge part 1/face part 2 and edge part 2/face part 1) are created. Often in this case the message can be ignored after verifying result correctness and if necessary, deleting/suppressing one of the inverse pairs. This condition may also occur when 1 part (typically a shell), is being contacted by 2 or more parts in the same spatial region. In this case it is possible for one or more of the parts to lose contact. Consider reducing the Pinball Radius to avoid overlap or changing one or more of the regions in question to use a contact formulation other than MPC.

One or More Parts May Be Underconstrained

...and experiencing rigid body motion.

This message may occur for one of several reasons: If the program detects that the model may be underconstrained, weak springs will be added to the finite element model to help obtain a solution. In addition, the program will automatically add weak springs if unstable contact (frictionless, no separation, rough) or compression only supports are active in order to make the problem more numerically stable. Since the weak springs have a low stiffness relative to the model stiffness, they will not have an effect on a properly constrained model. If you are confident that weak springs are not needed for a solution and the program adds them anyway, you may disable them by setting the Weak Springs option to Off in the Details View of the Solution object.

Problems Unique to Asynchronous Solutions

Consider the following hints when troubleshooting asynchronous solution problems:
• It may sometimes be necessary for you to enter the full path to the ANSYS executable file in the **Solve Command** field of the **Solution** object.

• It may sometimes be necessary for you to enter the full path to the UNIX working directory in the UNIX **Working Directory** field of the **Solution** object (under **Process Settings**). Common shortcuts like ~/ may not work on some systems.

• The LSF administrator should configure the Workbench job server to disallow multiple, simultaneous jobs. Two solves running on the same server will interfere with each other, preventing successful completion of each.

• To help in debugging ANSYS startup problems on the remote machine, it is sometimes useful for you to insert a **Solution Information** object under the **Solution** object in the Simulation tree. The **Solution Information** object will show the contents of the **solve.out** file that the remote ANSYS produced, if the executable was able to start.

• When using the **Stop Solution** option to stop a solve running on a UNIX machine, it is possible that the ANSYS executable file will continue to run on that machine even though the Simulation session thinks it has stopped. If this happens and you don’t want the solve job to continue on the UNIX machine it will be necessary for you to kill the process manually. The ability to solve to two different UNIX machines simultaneously is not allowed.

• The solve command may have failed to execute on the remote UNIX server. Verify the command’s spelling and/or path. Solve commands are issued to the remote server using the **rexec** interface. Failures may occur if the resulting path (**$path**) is insufficient. **$path** can be verified by issuing **rexec** on the command prompt on the local machine. For example:

**rexec machinename -l username echo $path > diagnosticsfile**

(where “l” is the letter “el”)

The **machinename** and **username** match the entries in the **Process Settings** for the **Solution** folder, and **diagnosticsfile** corresponds to the recipient on the local machine for the command output.

**Note** — After issuing **rexec**, if you receive the following message, **rexec** isn’t enabled on the remote UNIX server. This feature must be enabled on the remote UNIX server in order for the solution to proceed.

> **rexec:connect:Connection refused**

**rexec: can’t establish connection**

If the path to the solve command is unavailable on the remote server, it can be added to user or system-wide files that initialize the startup shell (for example, **.cshrc** or **/etc/csh.login** on C-shells). Consult the UNIX server’s **rexec** interface and appropriate shell manual pages for details.

• If you cannot make ASCII transfers to a UNIX server, changes need to be made on the server. Asynchronous solutions on a remote UNIX server use file transfer protocol (ftp). Therefore, the system administrator must install ftp and enable it. Ftp uses ASCII transfer mode to convert PC text to UNIX text. If ASCII mode is disabled, it is not obvious because error messages do not imply this. On some ftp servers (vsftpd, for example), by default, the server will pretend to allow ASCII mode, but in fact, will ignore the request. You will need to ensure that the ASCII upload and download options are enabled to have the server actually do ASCII mangling on files when in ASCII mode. To enable these options, the system administrator should consult the operating system documentation. The following **vsftp.conf** modification procedure is Linux platform specific and is provided as an example only.

1. In **/etc/vsftpd/vsftpd.conf**, uncomment the following lines (that is, remove the # at the beginning of these lines):
Problems Using Solution

If Solution fails to complete, try the following suggestions.

Verify the Environment

Verify that the loads and supports in the Environment meet the requirements for Stress, Thermal, Thermal-Stress, Shape or Vibration.

You can verify the environment quickly by looking at the icons adjacent to each environment item in the Tree Outline. A green check ✔ indicates that the requirements are met. A 🚫 indicates that the requirements were not met.

Check System Requirements

Verify that your system meets the minimum requirements at the time you start Solution. Disk space and memory may fluctuate depending on how the system is used. See also General Solver Error.

For Thin-Walled or Finely Detailed Parts

If your parts contain features whose size or thickness is extremely small in comparison to the principal dimensions of the assembly, try adjusting the variables used in modeling geometry.

- Set the variable DSMESH DEFEATUREPERCENT to 1e-5. To set variables, click Tools> Variable Manager.
- If that fails, change the setting to 1e-6.

Invalid or Poorly Defined Models

At the end of the Solution procedure, the region of a part that caused the problem is usually labeled.

If the geometry that is notated looks valid, but is small compared to the rest of the model, adjusting the Sizing Control may correct the problem.
Running Norton AntiVirus™ Causes Simulation to Crash

If the Norton AntiVirus™ product is running and you choose Allow the entire script once to resolve a script error, Simulation crashes. Choose Authorize this script to allow Simulation to function normally.

The Correctly Licensed Product Will Not Run

If you have installed a license file for a valid DesignSpace product, but DesignSpace continues to run in read-only mode or, in the case of an upgrade to a higher product, continues to run the lower product, make sure you have specified the correct product in the launcher.

This situation can occur if you install DesignSpace before creating your license file. In this case, DesignSpace will run only in read-only mode. When you create your license file later, you must choose a license under ANSYS Product Launcher in the Start menu. Once there, select the product that you have licensed to reset the default to the correct product. Otherwise, DesignSpace will continue to run in read-only mode.

This situation can also occur if you upgrade your license to a higher DesignSpace product. Again, you must choose a license under ANSYS Product Launcher in the Start menu. Then reset to the appropriate product. Otherwise, DesignSpace will continue to run as the lower, previously-licensed product.

The Deformation is Large Compared to the Model Bounding Box

... Verify boundary conditions or consider turning large deflection on.

This message will be displayed any time the software detects nodal deformations exceeding 10% of the model diagonal. Exceeding 10% of this length suggests model mechanics that depart from linearity in response to the applied boundary conditions. Load magnitudes, shell thicknesses, and contact options, if applicable, should be verified. If these are intended, a nonlinear analysis is advised. To request a nonlinear analysis, set Large Deflection to On in the Details View of the Solution folder.

The Initial Time Increment May Be Too Large for This Problem

... Check results carefully. Refer to Troubleshooting in the Help System for more details.

This message will appear if the program determines that the initial time increment used in the thermal transient analysis may be too large based on the "Fourier modulus" (Fo). This dimensionless quantity can be used as a guideline to define a conservative time step based on thermal material properties and element sizes. It is defined as:

\[ Fo = \frac{k (\Delta t)}{\rho c \text{ (length}_{e}^{2})} \]

where:

- \( \text{length}_{e} \) = Average element length
- \( \Delta t \) = Time step
- \( k \) = Thermal Conductivity
- \( c \) = Specific Heat
- \( \rho \) = Density
Specifically this warning will be issued if the program finds that the Fourier modulus is greater than 100, that is, \( F_0 > 100 \). Stated in terms of the initial time step (ITS), this warning appears when the ITS is 100 times greater than the time step suggested by the Fourier modulus in the form expressed below:

\[
\Delta t = \text{length}_e^2 / (k / (c \rho))
\]

This check is done on a per body basis and the results are echoed in the ANSYS output listing. For example:

```
********* Initial Time Increment Check And Fourier Modulus *********
  Specified Initial Time Increment: .75
  Estimated Increment Needed, le*le/alpha, Body 1: 0.255118
  Estimated Increment Needed, le*le/alpha, Body 2: 1.30416
  Estimated Increment Needed, le*le/alpha, Body 3: 0.158196
  Estimated Increment Needed, le*le/alpha, Body 4: 0.364406
```

If this warning is issued make sure that the specified time step sizes are sufficiently fine to accurately capture the transient phenomenon. The proper use of this guideline depends on the type of problem being solved and on accuracy expectations.

### The License Manager Server Is Down

**Unless a connection is reestablished, DesignSpace will exit in \( nn \) minutes.**

**Cause**

This message occurs in a one-server license environment if your license manager has quit running. In a three-license server environment, the ANSYS license manager must be running on at least two of the three license server machines at all times. If two of the license server machines go down, or two of the machines are not running the license manager, this error message will appear in the program output or in a message box. The program will continue to run for \( nn \) minutes to allow the license manager to be restarted or to be started on a second machine if using redundant servers. When the message first displays, \( nn = 60 \). The message then reappears every five minutes with \( nn \) displaying the elapsed time at each 5 minute increment (55, 50, 45, etc.) until the connection is established.

**Resolution**

When this error message appears, start the license manager on the other machines designated as license servers. If you get this message and determine that the license manager is still running, and you are running in a one-server environment, then the IP address of the license server machine was changed while the application (DesignSpace) was running (this is usually caused by connecting to or disconnecting from an Internet Service Provider (ISP) that dynamically allocates IP addresses). To correct this situation, you must return the IP address to the same address that the license server had when DesignSpace was started. If the IP address changes after you start DesignSpace (either because you connected to or disconnected from your ISP), you can correct the error by restarting DesignSpace. You should not need to restart the license manager.

You can avoid this problem by remaining connected to or disconnected from the ISP the entire time you are running the application.

### The Solution Combination Folder

**...is underdefined due to invalid input environments.**

When the Solution Combination Folder is underdefined, verify that:

- At least one environment is checked in the Solution Combination Worksheet
• The selected environments are pure structural analyses
• The selected environments do not contain convergence

For more information, see Section: Solution Combinations.

The Solver Engine was Unable to Converge

Cause

The solver engine was unable to converge on a solution of a nonlinear problem.

Recommendations

• When Advanced Contact is NOT Present in the Model ...

  Check for sufficient supports to prevent rigid body motion (structural) or check for thermal material curves or convection curves which rise and/or fall sharply over the temperature range (thermal).

• When Advanced Contact IS Present in the Model ...

  1. Check for sufficient supports to prevent rigid body motion or that contact with other parts will prevent rigid motion.
  2. Check that the loading is of a reasonable nature. Unlike linear problems whose results will scale linearly with the loading, advanced contact is nonlinear and convergence problems may arise if the loading is too big or small in a real world setting.
  3. If the contact type is frictionless, try setting the type to rough. This may help some problems to converge if any possible sliding is not constrained.
  4. Check that the mesh is sufficiently fine on surfaces that may be in contact. Too coarse a mesh may cause inaccurate answers and convergence difficulties.
  5. Consider softening the normal contact stiffness KN to a value of .1. The default value is 1 and may be changed by setting the Normal Stiffness. Smaller KN multipliers will allow more contact penetration which may cause inaccuracies but may allow problems to converge that would not otherwise.
  6. If symmetric contact is being used (by default the contact is symmetric), consider using asymmetric contact pairs. This may help problems that experience oscillating convergence patterns due to contact chattering. The program can be directed to automatically use asymmetric contact in the Details view of the Contact Folder.

The Solver Fills My Disk With Temporary Files

During a solution, large temporary files may be created by the solver. By default, these files are written to the system temporary directory. You may override the directory where the solver files are stored through via the Solution category in the Options dialog box where you choose the browse... option and specify any location for these files. Or you can set the location to Project Directory.

Unable to Find Requested Modes

If the analysis is a frequency analysis and this message is shown, most likely a frequency search range was specified but no natural frequencies were found in the specified range. Either increase search range or specify that the first N frequencies be found.
If this message occurs in a buckling analysis, verify that the loading is in the correct direction (that is, compressive) and that the structure is well constrained so that no rigid body motion can occur. If the applied boundary conditions appear to be correct, it is likely that a buckling failure will not occur.

**CAD Related Troubleshooting**

General Errors
ACIS
Autodesk Inventor
CATIA
Mechanical Desktop
Pro/ENGINEER
Parasolid
Solid Edge
SolidWorks
Unigraphics

**General Errors**

The following is a list of the more common CAD errors and their cause. Other errors may occur. If the meaning of any error is unclear, please respond through TECS.

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>The required license is unavailable.</td>
<td>Plug-in license was not able to be checked out.</td>
</tr>
<tr>
<td>Assemblies not licensed.</td>
<td>User attempting to attach an assembly model, but did not purchase or properly configure assembly licensing.</td>
</tr>
<tr>
<td>Cannot open part file.</td>
<td>If call to CAD to open model file fails this message is displayed.</td>
</tr>
<tr>
<td>Unable to retrieve part.</td>
<td>Part model is wireframe model in UG.</td>
</tr>
<tr>
<td>No model is currently active.</td>
<td>The CAD system has no model open.</td>
</tr>
<tr>
<td>Unable to acquire part data.</td>
<td>Query of CAD part data returned failure message.</td>
</tr>
<tr>
<td>Assembly has no parts.</td>
<td>An assembly model has no parts or all have been suppressed.</td>
</tr>
<tr>
<td>Unknown entity.</td>
<td>CAD identifies model element as a type unknown to plug-in.</td>
</tr>
<tr>
<td>Registration access error.</td>
<td>Attempt to read information for system registry returned error.</td>
</tr>
<tr>
<td>Plug-In not found.</td>
<td>An attempt to use a plug-in that does not exist.</td>
</tr>
<tr>
<td>Failed to load String Table.</td>
<td>Localized string table was not able to be loaded, may not exist. Error is not fatal, will cause messages to appear as somewhat cryptic.</td>
</tr>
<tr>
<td>Unable to activate document.</td>
<td>Unable to make identified model the active model.</td>
</tr>
<tr>
<td>There are no active parts in the model.</td>
<td>A part model has had the part suppressed.</td>
</tr>
<tr>
<td>Regeneration failure.</td>
<td>During an update, when changing a parameter value if the CAD is unable to update with the value set passed it this message will be displayed. When possible, the model is changed back to its previous state.</td>
</tr>
<tr>
<td>Attach failed.</td>
<td>General failure that indicates the attach was unable to be completed.</td>
</tr>
<tr>
<td>Refresh failed.</td>
<td>General failure that indicates the attach was unable to be updated.</td>
</tr>
<tr>
<td>No active document.</td>
<td>CAD system running with no model opened.</td>
</tr>
</tbody>
</table>
### CAD Related Troubleshooting

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to access the selected file.</td>
<td>The file is either protected against reading or does not exist in the specified location. Note that Pro/ENGINEER users may not use models specified with a UNC path.</td>
</tr>
<tr>
<td>A Fatal Exception was caught.</td>
<td>An unexpected error occurred within the plugin. Please report issue to TECS.</td>
</tr>
</tbody>
</table>

**ACIS**

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to initialize (ACIS or Parasolid) libraries.</td>
<td>Current file structure has missing or erroneous elements.</td>
</tr>
<tr>
<td>File does not exist.</td>
<td>Entered file does not exist.</td>
</tr>
<tr>
<td>Failed to read the (ACIS or Parasolid) file.</td>
<td>File is corrupt.</td>
</tr>
<tr>
<td>No valid bodies found in the file.</td>
<td>Only wires or independent faces.</td>
</tr>
</tbody>
</table>

**Autodesk Inventor**

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed to get reference key.</td>
<td>Unable to get reference data from Autodesk Inventor. Not a fatal error. The attach process continues, but an associative relation during update cannot be guaranteed.</td>
</tr>
<tr>
<td>Attach failed.</td>
<td>Attach aborted.</td>
</tr>
</tbody>
</table>

**CATIA**

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Error</td>
<td>Current file structure has missing or erroneous elements.</td>
</tr>
<tr>
<td>File is not a CATIA export file</td>
<td>Simulation can import only CATIA export type files, the entered file is not of that type.</td>
</tr>
</tbody>
</table>

**Mechanical Desktop**

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mechanical Desktop must be set in Model Mode.</td>
<td>Plug-in is operable only when Mechanical Desktop is in model mode.</td>
</tr>
<tr>
<td>An error occurred accessing the Mechanical Desktop database.</td>
<td>Query of Mechanical Desktop returned error message.</td>
</tr>
<tr>
<td>An error occurred getting the DWG file name.</td>
<td>Query of Mechanical Desktop for the name of the drawing returned error.</td>
</tr>
<tr>
<td>Look for later releases to handle sheets.</td>
<td>User attempted to attach a sheet model from Mechanical Desktop (not supported).</td>
</tr>
<tr>
<td>Unable to add database attribute to Mechanical Desktop.</td>
<td>Plug-in was unsuccessful in adding associative attribute to Mechanical Desktop database.</td>
</tr>
<tr>
<td>Subentity error: part may need to be converted to solid.</td>
<td>Likely an imported model that needs to be converted to a solid model. To see how, see the ANSYS Workbench Mechanical Desktop plug-in documentation.</td>
</tr>
</tbody>
</table>
## Pro/ENGINEER

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot activate different model with same name as model in session.</td>
<td>User is attempting to activate a model of same name and different path for Simulation attach.</td>
</tr>
<tr>
<td>Unable to add required information to <strong>config.pro</strong> file.</td>
<td>During installation, if unable to write data to <strong>config.pro</strong> file. This will indicate that the plug-in will not be operational after install is over. The ANSYS 10.0 Menu will not appear in Pro/ENGINEER if the <strong>config.pro</strong> file does not contain the required information. When installing the Pro/ENGINEER Plugin, a line is added to the <strong>config.pro</strong> file which points to the path of <strong>Pro2001PlugIn.dat</strong>. The <strong>config.pro</strong> file typically exists under the text directory of the Pro/ENGINEER installation directory. The workbench installation also creates this file in the ANSYS Workbench Installation Directory. A typical install would create this file in: `C:\Program Files\ANSYS Inc\v100\AISOL\CAD Integration\PROE\text`. If the <strong>config.pro</strong> file was not updated during the installation, the user must then copy the line from this file and add it to the default config.pro that is being used by Pro/ENGINEER. The following is an example of a line added to <strong>config.pro</strong>: PROTKDAT C:\Program Files\ANSYS Inc\v100\AISOL\CAD Integration\ProE\intel\text\Pro2001PlugIn.dat</td>
</tr>
<tr>
<td>Entered non-integer value for XXX Truncating value.</td>
<td>When changing the value of a parameter in Simulation, if the originally defined parameter is of integer type and the user enters a non-integer value this message will be displayed as a reminder for future updates.</td>
</tr>
<tr>
<td>Warning: Pro/E Asm does not use consistent unit system.</td>
<td>A component part does not have the same unit system as the assembly. This is a requirement as indicated in the documentation. The component name is visible in the progress window at the time this error occurs. You are advised to terminate the attach (by clicking <strong>Cancel</strong> in the progress window) and returning to Pro/ENGINEER to bring all components of the model to the same unit system. If you wish, you may allow the attach to continue to its completion making note of all components that generate this warning, then return to Pro/ENGINEER to make changes. In some instances only the assembly needs to be modified instead of the parts. If allowed to import entirely, the model is likely to have graphics and selection problems. These will be remedied when the model is imported after changes are made to the Pro/ENGINEER model.</td>
</tr>
</tbody>
</table>

## Parasolid

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schema access error.</td>
<td>Probably saved model in later version of Parasolid or schema directory is missing.</td>
</tr>
</tbody>
</table>
### Solid Edge

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workbench Plug-In disabled.</td>
<td>Plug-in has been disabled and unable to be used for attach process.</td>
</tr>
</tbody>
</table>

### SolidWorks

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rebuild of Part Failed.</td>
<td>Regeneration failed on update with parameter changes.</td>
</tr>
</tbody>
</table>

### Unigraphics

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Could not lock Unigraphics.</td>
<td>Unigraphics is already locked by some other process</td>
</tr>
<tr>
<td>Could not unlock Unigraphics.</td>
<td>If the Simulation process did not successfully lock Unigraphics, this unlock error is also likely to be displayed as it does not have the right to unlock Unigraphics.</td>
</tr>
</tbody>
</table>
Part I. Appendices
## Appendix A. Glossary of General Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Callout</strong></td>
<td>A message that appears as a result of an action initiated within the wizard. Callouts usually point to a toolbar button, a row in the Section : Details View, or object in the Section : Tree Outline. The message contains descriptive and instructive text.</td>
</tr>
<tr>
<td><strong>Context Menu</strong></td>
<td>Provides a short list of options applicable to a specific object or window. To view a context menu, click the right mouse button on an object or in a window.</td>
</tr>
<tr>
<td><strong>Context Toolbar</strong></td>
<td>A toolbar containing options appropriate for the current level in the Section : Tree Outline.</td>
</tr>
<tr>
<td><strong>Details View</strong></td>
<td>Provides information on the highlighted object in the Section : Tree Outline.</td>
</tr>
<tr>
<td><strong>Displacement</strong></td>
<td>A vector quantity used to measure the movement of a point from one location to another. The basic unit for displacement is (Length).</td>
</tr>
<tr>
<td><strong>Drag</strong></td>
<td>Moving an on-screen object in the Section : Tree Outline from one location to another using the mouse cursor while holding down the left button. The drag is interpreted as “move” if the object is dragged from the outline and “copy” if the object is dragged from the outline while holding down the Ctrl key</td>
</tr>
<tr>
<td><strong>Edge</strong></td>
<td>A selectable entity on a part that occurs at the intersection of two surfaces. In a surface model, an edge can also exist on the edge of one surface.</td>
</tr>
<tr>
<td><strong>Elastic Strain</strong></td>
<td>Normal elastic strain is a measure of the elongation or contraction of a hypothetical line segment inside a body per unit length. Normal elastic strain is dimensionless, however in practice it is common to assign normal elastic strain the basic unit of (Length / Length). Shear elastic strain is a measure of the change in angle that occurs between two initially perpendicular hypothetical line segment inside a body. The basic unit for shear elastic strain is radians.</td>
</tr>
<tr>
<td><strong>Factor of Safety</strong></td>
<td>Factor of safety is defined as the ratio of the limit strength of a material to the maximum stress predicted for the design. This definition of factor of safety assumes that the applied load is linearly related to stress (an assumption implicit in all calculations performed in the application). A factor of safety of less than one generally predicts failure of the design; in practice a factor of safety of one or greater is required to help avoid the potential for failure.</td>
</tr>
<tr>
<td><strong>FEA</strong></td>
<td>Finite Element Analysis. A robust and mature technique for approximating the physical behavior of a complex system by representing the system as a large number of simple interrelated building blocks called elements.</td>
</tr>
<tr>
<td><strong>Fundamental Frequencies</strong></td>
<td>The fundamental frequencies are the frequencies at which a structure under free vibration will vibrate into its fundamental mode shapes. The fundamental frequencies are measured in Hertz (cycles per second).</td>
</tr>
<tr>
<td><strong>Heat Flux</strong></td>
<td>A measure of heat flow per unit area. The basic unit for heat flux is (Heat / Length*Length).</td>
</tr>
<tr>
<td><strong>Margin of Safety</strong></td>
<td>Margin of safety is always equal to the factor of safety minus one.</td>
</tr>
<tr>
<td><strong>Multiple Select</strong></td>
<td>Select more than one surface, edge or vertex by holding the Ctrl key.</td>
</tr>
</tbody>
</table>
### Object
A set of information displayed visually as an icon (usually in the Section: Tree Outline).

### Reference Temperature
The reference temperature defines the temperature at which strain in the design does not result from thermal expansion or contraction. For many situations, reference temperature is adequately defined as room temperature. Define reference temperature in the properties of an environment or as a property of a material. A material reference temperature overrides an environment reference temperature.

### Right-Hand Rule
The right-hand rule is a convenient method for determining the sense of a rotation defined by a vector: close your right hand and extend your thumb in the direction of the vector defining the rotation. Your fingers will indicate the sense or direction of the rotation. The direction in which your fingers curl is the positive direction.

### Rigid Body Motion
Might occur when the part is free to translate or rotate in one or more directions. For example, a body floating in space is free to move in the X-, Y-, and Z-directions and to rotate about the X-, Y-, and Z-directions.

### Stress
A measure of the internal forces inside a body. The basic unit for stress is (Force / Length*Length).

### Surface
A selectable area on a part bordered on all sides by edges. Periodic, non-boundary edged surfaces (like spheres) may occasionally appear.

### Temperature
A scalar quantity used to measure the relative hotness or coldness of a point from one location to another. The basic units for temperature are degrees Fahrenheit or Celsius.

### Vertex
A selectable entity on a part that occurs at the intersection of two or more edges.

### World Coordinate System
The fixed global Cartesian (X, Y, Z) coordinate system defined for a part by the CAD system.
Appendix B. ANSYS Workbench and ANSYS Meshing Differences

The ANSYS Workbench, in its present form, meshes solid geometry parts using a number of 3-D elements for thermal and structural analysis. These elements include:

- 10-node tetrahedrals
- 20-node hexahedrals
- 13-node pyramids
- 15-node wedge elements
- 4-node quadrilateral shells
- 3-node triangle shells

While the corresponding meshing algorithms originated from the meshing capabilities present in the ANSYS family of products, over time these algorithms have diverged from those in ANSYS Prep7. The divergence was due to the different focus of the Simulation product, which was previously concerned with linear elastic materials, linear modal, linear buckling, and steady-state heat transfer analyses. The ANSYS Workbench and its mesher are now being transitioned to support the full ANSYS general-purpose, finite element code that supports all levels of the multiphysics disciplines. The Shape Checking option found in the Advanced meshing control allows the user to set the level of shape checking the ANSYS Workbench will perform in generating the mesh. This does not mean that elements generated by the default value of the Shape Checking control's Standard setting cannot be used to solve other idealizations. However, it does mean the default setting of the Shape Checking control will produce meshes for the ANSYS Workbench that easily pass the requirements necessary to fulfill the early DesignSpace product mission.

The default shape checking acceptance criterion that is used by the ANSYS Workbench was produced by an extensive and thorough study that correlated different element shape metrics to the quality of the solution achieved with a distorted mesh. The ANSYS Workbench shape parameters included many that the ANSYS Prep7 program uses in the shape-checking (SHPP command) portion of the meshing code. The study concluded that the ANSYS program, which supports many different types element formulations (such as p-elements), must enforce stricter shape parameter values than the ANSYS Workbench, which only needed to support the solid and shell elements for the aforementioned analyses. One particular shape metric predicted whether the quality of the element would affect the numerical solution time and again. This metric was the calculation of the Jacobian ratio at the integration points of the element. At a certain level of the Jacobian ratio, we determined that the element solution would degrade and give results that would produce an unacceptable result. While many other shape metrics are used for the generation of the mesh in the ANSYS Workbench, the Jacobian ratio is the primary metric used to determine the acceptability of the mesh.

When elements are imported into the ANSYS environment, the shape checking command is turned off. This is done for two reasons:

1. The elements have already undergone extensive shape checking in the Workbench product
2. As stated previously, the ANSYS environment requires different and much more conservative criteria for a few element shapes and a few idealizations. However, in the vast majority of cases the metrics used in the ANSYS Workbench are valid.
The major difference is that ANSYS requires that the Jacobian ratio be valid at the corner nodes of the elements (this is to support the p-element technology). The **Aggressive** setting of the **Shape Checking** control will check the Jacobian ratios at the nodes.

The ANSYS Workbench’s quality acceptance plan includes solving hundreds of problems where the numerical solution is known. The solution produced by the ANSYS Workbench is compared to the analytical or test solution of the model. Besides these engineering tests, the meshing process is tested against over a thousand user models. These models are set up to seek out errors related to element distortion.

We feel that the current ANSYS Workbench shape metric will produce results that are minimally affected by errors due to element distortions for linear static, modal, and transient analysis. It is suggested that the **Shape Checking** control’s **Aggressive** setting be used if the mesh is intended for large deformation or material nonlinear analysis inside the ANSYS environment.
Engineering Data Help
Engineering Data Help
# Table of Contents

**Overview** .......................................................................................................................... 1–1

* Access Engineering Data ......................................................................................................... 1–1
* Engineering Data User Interface .............................................................................................. 1–2
  * Menu Bar .............................................................................................................................. 1–3
  * Toolbar ................................................................................................................................. 1–3
  * Engineering Data Project Tree ............................................................................................ 1–4
  * Data Overview Window ......................................................................................................... 1–5
* Import Engineering Data ........................................................................................................... 1–7
* Export Engineering Data ........................................................................................................... 1–8
* Delete or Duplicate Engineering Data ....................................................................................... 1–9
* Change the Unit System ............................................................................................................ 1–10
* Assign Defaults and Favorites .................................................................................................. 1–10
* Save Engineering Data Database ............................................................................................ 1–11

**Material Data** .................................................................................................................... 2–1

* Create New Materials ............................................................................................................. 2–1
* Add or Remove Properties ........................................................................................................ 2–1
* Modify and Parameterize Material Properties .......................................................................... 2–3
* Suppress/Unsuppress Properties ............................................................................................ 2–3
* ANSYS Supplied Sample Material Library .............................................................................. 2–4
* Supported Material Properties ................................................................................................ 2–5
  * Structural Material Properties .............................................................................................. 2–6
  * More About Hyperelastic Materials ...................................................................................... 2–10
  * Thermal Material Properties ............................................................................................... 2–15
  * Electromagnetic Material Properties ................................................................................... 2–15
  * Material Curve Fitting .......................................................................................................... 2–17
  * Prepare the Test Data ............................................................................................................ 2–17
  * Input Test Data as Material Properties ................................................................................ 2–18
  * Select a Material Model Option ............................................................................................ 2–18
  * Perform a Curve Fit ............................................................................................................... 2–19
  * Save Results to a Library ........................................................................................................ 2–22

**Load Data** ............................................................................................................................ 3–1

* Convections ............................................................................................................................ 3–1
  * Create New Convections ........................................................................................................ 3–1
  * ANSYS Supplied Convection Sample Library ...................................................................... 3–1
* Load History ........................................................................................................................... 3–2
  * Create New Load Histories ................................................................................................... 3–2
  * Supported Load History Properties ...................................................................................... 3–3
Overview

This section presents the purpose and common features of Engineering Data. Later sections cover the specific operations associated with:

- Material Data
- Load Data

Introduction

Engineering Data provides access and storage for most of the information or data that is independent of your model's geometry. This data falls into two general classes:

- **Material properties** will include Young's Modulus, Poisson's Ratio, and other material-specific data. You use the Engineering Data feature to create, modify, and maintain external libraries of this information. You can access these libraries during your analysis, or during other ANSYS Workbench analyses.

- **Load data** includes thermal load histories (load versus time) and convection data (convection coefficient versus temperature).

Like other ANSYS Workbench applications, Engineering Data is accessed via a tab along the top of the user interface and displays independently as a separate control panel, and provides navigation tools and specifications areas to input and store your data. All material and load history information associated with a project resides in and can be accessed from the Engineering Data tab.

Engineering Data has two primary modes of operation:

- **Creating and Maintaining Engineering Data Libraries** - You can use this application to create a library made up of the material properties and load data that you use most often.

- **Assigning Engineering Data During Analysis** - You can select and assign stored material and load data to your model during an analysis. You can also review and modify the data used in a project.

Engineering data is automatically saved when a project is saved.

Using Engineering Data Help

To access the ANSYS Workbench Help, see Section : Using Help.

Access Engineering Data

Engineering Data is accessed using the Data button on the toolbar of the Project Page, in Simulation, and in FE Modeler. In addition, based upon the type of analysis you are performing, Engineering Data is accessed from the Details View of Simulation. See the following sections for more information about how to interact with Engineering Data from Simulation:

- Assign Materials in Simulation
- Apply Convections in Simulation
- Apply Load Histories in Simulation
Engineering Data User Interface

This section examines the functional elements of the Engineering Data user interface. A screen capture of the Engineering Data tab follows:

The functional elements of the interface include the following.

<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Bar</td>
<td>Provides selectable menu options.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Provides selectable options that allow you to modify the engineering data associated with your model.</td>
</tr>
<tr>
<td>Project Tree</td>
<td>Displays the location(s) of the material and loading data (the engineering data) associated with your project. This information is provided in an easily navigated tree, with specific materials and loading data residing in separate folders.</td>
</tr>
<tr>
<td>Data View</td>
<td>Displays the data for the selected item in the Project Tree Outline. The data may be displayed as an overall summary or tabular data with its corresponding graph. For example, the material Structural Steel, as shown above shows the summary of constant data and thumbnails of the tabular data. The individual data specifications are displayed, and can be modified or edited in this area.</td>
</tr>
</tbody>
</table>
Menu Bar

The Engineering Data menu bar provides the following functions.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection(s)</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Close Engineering Data</td>
<td>Closes the Engineering Data tab and returns you to the project Page.</td>
</tr>
<tr>
<td></td>
<td>Exit Workbench</td>
<td>Closes Workbench.</td>
</tr>
<tr>
<td>View</td>
<td>Restore Original Window Layout</td>
<td>Restores the window layout that was displayed when Engineering Data was opened.</td>
</tr>
<tr>
<td>Units</td>
<td>Metric (m, kg, °C, s, V, A)</td>
<td>Changes the unit system.</td>
</tr>
<tr>
<td></td>
<td>Metric (cm, g, dyne, °C, s, V, A)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Metric (mm, kg, dyne, °C, s, mV, mA)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>U.S. Customary (ft, lbm, lbf, °F, s, V, A)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>U.S. Customary (in, lbm, lbf, °F, s, V, A)</td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td>Engineering Data Help</td>
<td>Opens the Engineering Data Help file in a new browser window.</td>
</tr>
<tr>
<td></td>
<td>Installation and Licensing Help</td>
<td>Opens the Installation and Licensing Help file in a new browser window.</td>
</tr>
</tbody>
</table>

Toolbar

The Engineering Data toolbar provides the following operational features.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>A drop-down menu that allows you to create a new Material, Convection, or Load History into the Project Tree. You must then enter the engineering data for the new Material, Convection, or Load History.</td>
</tr>
<tr>
<td>Import</td>
<td>A drop-down menu that allows you to import Materials, Convections, or Load Histories from the Engineering Data source.</td>
</tr>
<tr>
<td>Export</td>
<td>Drop-down menu that allows you to select materials, convections, or load histories and “write them out” to an external library file in an .xml format. It does not change the current project or library and is typically used to create libraries from existing project data. If an existing library file is opened and modified, selected items can either be appended to the library or the library file can be overwritten and replaced.</td>
</tr>
<tr>
<td>Close Curve</td>
<td>Closes the tabular data and graph for a material property and returns to the material summary Data View. Only available for material properties that have tabular data.</td>
</tr>
</tbody>
</table>

Note — Engineering Data database files and Workbench projects are linked. Engineering data saves automatically to a file based on the project’s name (<Project Name>.eddb) when the Workbench project (wbdb) is saved. Opening a project automatically retrieves engineering data information from the corresponding .eddb file.
Engineering Data Project Tree

The project tree lists the materials and loading scenarios that are associated with the project. You navigate to the folder-level on the tree and perform actions, such as importing data from a library, exporting data to library, creating new materials, new convections, or new loads, defining a project’s default material, assigning materials and convections as favorites, deleting, duplicating, renaming, and updating the source of a material or load.

Selecting any folder in the project tree (Project, Materials, Convections, or Load Histories) displays the materials and/or load data associated with the project and the location of their source files.

A state icon is displayed next to the name of the materials, convections and load histories that indicates the state of the engineering data. There are three possible states indicated:

- Valid data which is indicated by a plain icon (see above).
- Invalid data is indicated by a question mark on the foreground of the icon. The value for Invalid data is also highlighted in yellow in the Data Overview window (see below).
- Undefined data is also indicated by a question mark on the foreground of the icon. The property field for undefined data in the Data Overview window displays blank and is also highlighted in yellow.

Example of Invalid Data
Materials, Convections and Load Histories in the project tree may display a link icon next to the state icon. This link indicates that the data is saved on hard disk space. If engineering data is not synchronized the link icon appears as broken, as illustrated above. This state indicates that the data in use does not match the data on the source disk space. You may reload the original data by using the context menu (right-click) option Update From Source.

Data Overview Window

The Data Overview window allows you view engineering data information two different ways. As shown below, it displays either a list of properties associated with a material or tabular data associated with a convection or load history that you can review and/or modify, such as Alternating Stress. When a material property has an adjacent thumbnail graph icon, then the property has associated tabular data, such as temperature dependent properties, stress-strain curves, and fatigue S-N curves is associated with the material. The individual data specifications are displayed, and can be modified or edited in this area.

The Add/Remove Properties option displays a dialog box that allows you to add and/or remove material properties.

The Close Curve button closes the tabular display and returns you to the property display.

Properties for Structural Steel
Tabular Data for Alternating Stress (Structural Steel)
Import Engineering Data

You may import engineering data from an existing data source by using the Import feature from the toolbar or the context menu. To import engineering data from a source into a project:

1. Access the Engineering Data tab.
2. Display the Import drop-down list from the toolbar and select Materials, Convections, or Load Histories. An import dialog box that is based on your selection displays, such as the Import Material Data dialog box shown below.

   *Note* — You can also highlight the Materials folder, the Convections folder, or the Load Histories folder in the Project Tree, right-click the mouse, and then select the Import option on the menu to display the associated import dialog box.
3. Select the appropriate Material or Convection data or Load History library to import from the Data Source field. A list of materials, convections or load histories available in the selected library file displays in the bottom half of the dialog box. You can Add or Remove source files from the list as desired.

Note — Three types of sources are supported: Library files, ANSYS CDB files, and folders containing .xml files developed prior to ANSYS 9.0.

4. Select the appropriate Material or Convection data, or Load History library to import from the dialog box.

5. Click OK. A list of materials, convections, or load histories available in the selected library file is displayed in the bottom half of the import dialog.

6. Choose the engineering data that you want to use in the project. Clicking OK adds the newly selected engineering data to the project tree.

Export Engineering Data

If you have a collection of materials, convections, and/or load histories that you frequently use, you can create a new library file using the Export feature. You can export engineering data using the following methods.

Using the Export Button

<table>
<thead>
<tr>
<th>Task</th>
<th>Actions</th>
</tr>
</thead>
</table>
| Export all Engineering Data | 1. Display the Export drop-down list and select All Engineering Data to a Library.  
                              | 2. A Save As dialog box displays. Select a folder location for the library and name the new file.  
                              | 3. Click OK. The materials or convections are saved to a new library .xml file. |
## Append all engineering data to an existing library

1. Display the Export drop-down list and select **All Engineering Data to an Existing Library** to append all Project Tree data.
2. An Open dialog box displays. Select a folder location for the library and name the new file.
3. Click OK. The materials, convections and load histories are appended to the existing library file.

## Export selected engineering data

1. Select any combination of individual data items or folders such as the Materials folder and the convection *Stagnate Air*. Use the Shift or Ctrl keys to highlight multiple folders and/or individual data items. Display the Export drop-down list and choose **Selected Engineering Data to a Library**.
2. A Save As dialog box displays. Select a folder location for the library and name the new file.
3. Click OK. The materials, convections, or load histories are saved to a new library .xml file.

## Append selected engineering data

1. Highlight the individual materials, convections, or load histories of interest. Use the Shift or Ctrl keys to highlight multiple folders and/or individual data items
2. Display the Export drop-down list and choose **Selected Engg Data to an Existing Library**.
3. An Open dialog box displays. Select a folder location for the library and select an existing library file.
4. Click OK. The materials, convections and load histories are appended to the existing library file.

### Using the Context (Right-Click) Menu

In addition to the toolbar option, you may also use the right mouse button to export engineering data.

## Export engineering data

1. Select any combination of individual data items or folders in the project tree, such as the Materials folder and the convection *Stagnate Air*.
2. Right-click the mouse, and select Export.
3. A Save As dialog box displays. Select a folder location for the library and name the new file.
4. Click OK. The materials or convections are saved to a new library .xml file.

### Delete or Duplicate Engineering Data

To delete or duplicate materials, convections, or load histories from Engineering Data:

1. Highlight the material, convection, or load history item and right-click.
2. Select **Delete** or **Duplicate**.
Change the Unit System

Unit systems can be changed in Engineering Data so that properties can be reviewed and modified based on the unit system you select. The unit system settings are synchronized between Simulation and Engineering Data to preserve consistency between the two applications.

To change the Unit System, make a new selection in the **Units** menu on the menu bar.

Assign Defaults and Favorites

Workbench assigns **Structural Steel** as the default material for all parts and **Stagnate Air - Simplified Case** as the default convection. These are available in the **Workbench Samples** library.

To change the default material or convection for new projects:

1. In the **Project Tree**, highlight the material or convection that you want to make the default for new projects.
2. Right-click the mouse and choose **Default for New Projects** from the menu.

   *Note* — Only one material and one convection may be set as the default.

You can also mark a set of materials or convections or load histories as favorites. Engineering data items marked as favorites are the first data source in the **Import** dialog box, enabling quick selection of often used data. To mark items as favorites:

1. Display the project folder and highlight the material(s), convection(s), and/or load histories that you want to be available in all projects.
2. Right-click the mouse and choose **Include as Favorite**.

An example of materials marked as **Favorites** is shown below.
Note — These changes affect all subsequent projects opened in the Workbench.

Save Engineering Data Database

All material, convection, and load history information of a project is saved to an Engineering Data database file based on the project's name (<Project Name>.eddb). This file is saved automatically whenever the Workbench project database (wbdb) is saved. The Workbench project database file contains project definitions and the links to the .eddb file and automatically updates, saves, and synchronizes the data of this file. As a result, you are not prompted separately to save Engineering Data after changes to a project are performed.

The .eddb file allows you to save project materials, convections, load history, and other pertinent project information. It provides a means to archive the engineering data used in a project. Because Simulation and DesignXplorer databases utilize engineering data, material and load information is also stored in the Simulation database file (.dsdb).

Engineering data parameters are also saved in the .eddb file. You can retrieve these parameters by first saving, then resuming the .wbdb file. Simulation creates material parameters only in legacy .dsdb files (version 8.1 and earlier).

Note — You can export engineering data to a library file for future use.

Caution: Because this file is updated automatically, you do not access the .eddb file directly.
Material Data

This section examines the function and use of Project Materials and Material Properties within Engineering Data. Please select one of the following links to learn more about that topic or click Next to advance through each topic.

- Create New Materials
- Add or Remove Properties
- Modify and Parameterize Material Properties
- Suppress/Unsuppress Properties
- ANSYS Supplied Sample Material Library
- Supported Material Properties

Create New Materials

To insert a new material into a project:

1. Access the Engineering Data application.
2. Highlight the Materials folder in the Project Tree and:
   a. Right-click and select Insert New Material.
   b. Click the New button and then select Material.
3. A New Material entry displays in the Project Tree. Rename the new material.
4. A list of common properties with zero values is shown in the property view. You will need to enter values for the displayed properties. You can also add and/or remove properties from the default list. In addition, you can select further classifications for material properties using the Add/Remove Properties option. See Section: Supported Material Properties for more information about material properties.

Assign Materials in Simulation

The properties of materials can only be changed using Engineering Data, however, materials are assigned to parts in Simulation. Please see the Materials topic in the How to Attach Geometry section of the Simulation Help.

Add or Remove Properties

Use the Add/Remove Properties option to add or remove properties from a material. The following window displays when you select the Add/Remove Properties option. This example displays the properties for Structural Steel.
All current properties have a check mark beside the property name.

Each property is preceded by a check box that you can select or unselect to add or remove properties from a list of supported properties. When you are finished making selections, click the OK button to add or remove the properties from the summary view. Click Cancel if you did not add or delete properties.

**View Options**

In addition, there are two ways to view the material properties.

1. Select the **Organizational Structure** radio button (as shown above) to view material properties in a tree structure of three main material categories: **Structural**, **Thermal**, and **Electromagnetics**. This also provides further classification of the properties within the individual categories.

2. Select the **Alphabetic List** radio button to display a list of all available material properties in alphabetical order.

A **Filter** is also available on the **Add or Remove Properties** dialog box. This field allows you to filter all of the available properties by the spelling of the property names.
Modify and Parameterize Material Properties

Constant Properties

You can edit the constant properties of a material in the Data Overview section by placing the cursor in the column beside the property and entering a new value.

You can also parameterize properties for later use in DesignXplorer from the summary view by selecting the box to the left of the property name. Parameterization is indicated with a P as shown here:

![Parameterized Property Example]

Temperature Dependent and Nonlinear Properties

You can also edit and parameterize the temperature-dependent and nonlinear properties of a material.

Properties with an associated graph icon contain tabular data. Properties with the graph icon also have a corresponding graph thumbnail in the right portion of the view. Clicking the icon or the thumbnail graph replaces the content of the view with an enlarged graph and a table that you may use to edit the tabular values of the property. To return to the summary view, click the Close Curve button.

Like constant properties, you can parameterize temperature-dependent and nonlinear properties by selecting the box to the left of the property name. In DesignXplorer, you will see two parameters, a scale factor and an offset value for each property. You can parameterize one or both of these values. The scale value varies the curve by multiplying the y-axis value of each point on the curve. The offset adds or subtracts to/from a y-axis value for each point on the curve. Thus, the equation for varying the property value is:

\[ \text{Property} = \text{Scale} \times \text{Nominal Value} \pm \text{Offset} \]

If an invalid property value exists, the corresponding property field is highlighted in yellow, such as a negative Young's Modulus, and the validation icon beside the material in the Project Tree also changes.

Parameterization Notes:

- DX-VT supports only Young's Modulus, density, and Poisson's Ratio for parameterization.
- DS parameter manager supports all constant properties for parameterization.
- DX-DOE supports the parameterization of all properties including tabular and nonlinear properties.
- If a Multilinear Isotropic Hardening (MISO) stress-strain curve is used for a material, then Young's Modulus cannot be parameterized.

Suppress/Unsuppress Properties

Items in the property list can be suppressed. Suppression allows you to define a property but not include it in a simulation. Suppressed property names are shown with a "strikethrough" through the property name, as shown here.

![Suppressed Property Example]

Only defined, unsuppressed properties are sent to simulation for use during analysis.

How to Suppress/Unsuppress Properties

To suppress a property, place your cursor over the property, right-click, and select Suppress.
Perform the same steps and select **Unsuppress** to reverse the action.

**Mutually Exclusive Properties**

Any property of a material can be suppressed. However, some properties are mutually exclusive and the selection of one of these properties automatically suppresses the other, mutually exclusive, property. For example, defining bilinear isotropic hardening plasticity and multilinear isotropic hardening plasticity for the same material represents redundant plasticity behavior. Only one behavior can be active for the material. When such conflict occurs, the last defined property is used and the previously defined, conflicting properties are automatically suppressed. The properties that are mutually exclusive include the following:

- Bilinear isotropic hardening plasticity/multilinear isotropic hardening plasticity/hyperelasticity
- Relative permeability/linear orthotropic permeability
- Relative permeability/b-h curve/demagnetization curve/linear hard magnetic material
- Resistivity/orthotropic resistivity
- Young’s Modulus and Poisson’s Ratio/Orthotropic Elasticity/Hyperelasticity
- Conductivity/Orthotropic conductivity

**ANSYS Supplied Sample Material Library**

The Engineering Data Library provided by ANSYS includes the following:

**Materials:**

- Air
- Aluminum Alloy
- Concrete
- Copper Alloy
- Gray Cast Iron
- Magnesium Alloy
- Polyethylene
- Stainless Steel
- Structural Steel
- Titanium Alloy
- Neoprene Rubber

**B-H Curves for Soft Materials:**

- Cold Rolled low carbon strip steel
- Silicon Core Iron
- Co25ni45
- 1018 Steel 90.5 HRB
- Powdered Iron Sintered plus annealed
- Ferro Cobalt: 34.5% co
- Gray Cast Iron
Section: Supported Material Properties

- hymu49
- Ingot iron, annealed
- M14 Steel
- M19 Steel
- M2 Steel
- M22 Steel
- M27 Steel
- M3 Steel
- M4 Steel
- M43 Steel
- M47 Steel
- M50 Steel
- M54 Steel
- M6 Steel
- Moly permalloy
- Monel Annealed
- Mu metal
- Nodular Cast Iron
- Pure Iron Annealed
- Pure Nickel Annealed
- SA1008
- SA1010
- SA1020
- Sintered material 80HP
- SS416
- Supermendure

**Supported Material Properties**

Engineering Data allows you to model various material properties. Each of the material properties is addressed below according to the following main material categories:

- **Structural Material Properties**
- **Thermal Material Properties**
- **Electromagnetics Material Properties**

In addition, you can derive coefficients from supplied test data for your materials so that you can select the most closely matched material model for a solution using the Material Curve Fitting feature.
Structural Material Properties

Introduction

In general, structural properties are isotropic, meaning that you only need to define one value for a property. The same property value is used in all directions. Orthotropic properties have an associated X, Y, or Z direction. These directions refer to the element coordinate system. Specifically:

- *If the material is isotropic*: You must enter Young's modulus and Poisson's ratio. There are no default values for either property. Poisson's ratio should not be equal to or greater than 0.5.
- *If the material is orthotropic*: Nine property values (Young's Modulus in the X, Y, and Z directions, three major Poisson's ratios and three shear moduli) must be defined. There are no defaults. For 2D, the X and Y related components must be entered.

Temperature Dependence

Temperature-dependent properties are input in a tabular form (value vs. temperature). Once defined, these tabular properties are available to the elements during solution. Structural material properties are evaluated at the integration points. If the temperature of a integration point falls below or rises above the defined temperature range of tabular data, the solver assumes the defined extreme minimum or maximum value, respectively, for the material property outside the defined range.

Supported Structural Material Properties

The following structural material properties are supported in Engineering Data:

- **Linear Elastic**
  - Young's Modulus - Temperature Dependent
  - Poisson's Ratio - Temperature Dependent
  - Orthotropic Elasticity

- **Density** - Temperature Dependent

- **Thermal Expansion** - Temperature Dependent

- **Life Data**

- **Alternating Stress**: You can define a Mean Value for each stress-life (SN) curve. This is important if you want to have multiple SN curves defined to account for any mean stresses that may exist. You must also define the Interpolation method (Log-Log, Semi-Log, or Linear) and the Mean Curve Type.

  If experimental SN data was collected at constant mean stress for individual SN curves, select the Mean Stress option for Mean Curve Type. However, if multiple SN curves were collected at a constant r-ratio, then select R-Ratio. R-ratio is defined as the ratio of the second loading to the first: \( r = L_2 / L_1 \). Typical experimental r-ratios are -1 (fully reversed), 0 (zero-based), and .1 (to ensure that a tensile stress always exists in the part). The values of mean stress/r-ratio are only important if multiple curves are done and the SN-Mean Stress Curves correction using experimental data option is chosen in the Fatigue Tool.

- **Strain-Life Parameters**

- **Stress Limits**

- **Tensile Yield Strength**
• Compressive Yield Strength
• Tensile Ultimate Strength
• Compressive Ultimate Strength

• Nonlinear Material Properties
  – Plasticity
    → **Bilinear Isotropic Hardening**: This material model is often used in large strain analyses. A Bilinear Stress-Strain (BISO) curve requires that you input the **Yield Strength** and **Tangent Modulus**. The slope of the first segment in a BISO curve is equivalent to the Young’s modulus of the material while the slope of the second segment is the tangent modulus.
    
    → **Multilinear Isotropic Hardening**: This material model is often used in large strain analyses. Do not use this model for cyclic or highly nonproportional load histories in small-strain analyses.

Data must be supplied in the form of Plastic Strain vs. Stress. The first point specified must have zero (0) plastic strain and the yield.

The slopes of all segments must be less than or equal to the Young’s Modulus. No segment can have a slope of less than zero. Workbench performs checks to ensure that these criteria are met.

– **Hyperelastic Material Models**

Hyperelasticity can be used to analyze rubber-like materials (elastomers) that undergo large strains and displacements, as shown below, with small volume changes (nearly incompressible materials). Large strain theory is required [NLGEOM,ON].

*The following is an animated GIF. Please view online if you are reading the PDF version of the help.*
The material response in ANSYS hyperelastic models is always assumed to be isotropic and isothermal. The hyperelastic materials are also assumed to be nearly or purely incompressible. Material thermal expansion is also assumed to be isotropic.

The following hyperelastic material models are supported. Data can be input in the form of test data and the coefficients calculated via a Material Curve Fit or the coefficients can be directly input.

→ **Mooney-Rivlin**
- Mooney-Rivlin 2 Parameter
- Mooney-Rivlin 3 Parameter
- Mooney-Rivlin 5 Parameter
- Mooney-Rivlin 9 Parameter

→ Neo-Hookean
→ Polynomial 1st order
→ Polynomial 2nd order
→ Polynomial 3rd order
→ Yeoh 1st order
→ Yeoh 2nd order
→ Yeoh 3rd order
→ Ogden 1st Order
→ Ogden 2nd Order
→ Ogden 3rd Order

Please see the next section for additional information about Hyperelastic Material Models.

Hyperelastic behavior is typically characterized by the following tests:

- Uniaxial test
- Biaxial test
- Shear test
- Volumetric test

Engineering Data allows you to directly input the engineering stress/engineering strain data as properties of the material.

Once the test data is input, the **Fit to Test Data** button is used to perform a curve fit of the test data and compute the coefficients for the chosen material model. The resultant graph shows the test data points.
superimposed on the fitted curves to show the degree of accuracy of the curve fit. If you know the coefficient values then you may input them directly in the corresponding material model. Make sure that you set Engineering Data’s Unit System to the units in which the constants were derived.

More About Hyperelastic Materials

This section defines the expressions of the supported Hyperelastic Material models in Engineering Data.

Mooney-Rivlin

- **Mooney-Rivlin 2 Parameter**

  Input values for **Material Constant C10**, **Material Constant C01**, and **Incompressibility Parameter D1** as defined by the following form of the strain energy potential, $W$:

  $$ W = c_{10}(T_1 - 3) + c_{01}(T_2 - 3) + \frac{1}{d}(J - 1)^2 $$

  where:

  - $T_1$ = first deviatoric strain invariant
  - $T_2$ = second deviatoric strain invariant
  - $J$ = determinant of the elastic deformation gradient $F$
  - $c_{10}$, $c_{01}$ = material constants characterizing the deviatoric deformation of the material.
  - $d$ = material incompressibility parameter.

  The initial shear modulus is defined as:
\[ \mu = 2(c_{10} + c_{01}) \]

and the initial bulk modulus is defined as:

\[ K = \frac{2}{d} \]

where:

\[ d = \frac{(1-2\nu)}{(c_{10} + c_{01})} \]

- **Mooney-Rivlin 3 Parameter**

  Input values for Material Constant \( C_{10} \), Material Constant \( C_{01} \), Material Constant \( C_{11} \), and Incompressibility Parameter \( D_{1} \) as defined by the following form of the strain energy potential, \( W \):

\[ W = c_{10}(\tilde{T}_1 - 3) + c_{01}(\tilde{T}_2 - 3) + c_{11}(\tilde{T}_1 - 3)(\tilde{T}_2 - 3) + \frac{1}{d}(J - 1)^2 \]

where:

\[ c_{10}, c_{01}, c_{11} = \text{material constants characterizing the deviatoric deformation of the material.} \]

\[ d = \text{material incompressibility parameter.} \]

See **Mooney-Rivlin 2 Parameter** for definitions of remaining terms.

- **Mooney-Rivlin 5 Parameter**

  Input values for Material Constant \( C_{10} \), Material Constant \( C_{01} \), Material Constant \( C_{20} \), Material Constant \( C_{11} \), Material Constant \( C_{02} \), and Incompressibility Parameter \( D_{1} \) as defined by the following form of the strain energy potential, \( W \):

\[ W = c_{10}(\tilde{T}_1 - 3) + c_{01}(\tilde{T}_2 - 3) + c_{20}(\tilde{T}_1 - 3)^2 \]

\[ + c_{11}(\tilde{T}_1 - 3)(\tilde{T}_2 - 3) + c_{02}(\tilde{T}_1 - 3)^2 + \frac{1}{d}(J - 1)^2 \]

where:

\[ c_{10}, c_{01}, c_{20}, c_{11}, c_{02} = \text{material constants characterizing the deviatoric deformation of the material.} \]

\[ d = \text{material incompressibility parameter.} \]

See **Mooney-Rivlin 2 Parameter** for definitions of remaining terms.

- **Mooney-Rivlin 9 Parameter**

  Input values for Material Constant \( C_{10} \), Material Constant \( C_{01} \), Material Constant \( C_{20} \), Material Constant \( C_{11} \), Material Constant \( C_{02} \), Material Constant \( C_{30} \), Material Constant \( C_{21} \), Material Constant \( C_{12} \), Material Constant \( C_{03} \), and Incompressibility Parameter \( D_{1} \) as defined by the following form of the strain energy potential, \( W \):

\[ W = c_{10}(\tilde{T}_1 - 3) + c_{01}(\tilde{T}_2 - 3) + c_{20}(\tilde{T}_1 - 3)^2 \]

\[ + c_{11}(\tilde{T}_1 - 3)(\tilde{T}_2 - 3) + c_{02}(\tilde{T}_2 - 3)^2 + c_{30}(\tilde{T}_2 - 3)^3 \]

\[ + c_{21}(\tilde{T}_1 - 3)^2(\tilde{T}_2 - 3) + c_{12}(\tilde{T}_1 - 3)(\tilde{T}_2 - 3)^2 + c_{03}(\tilde{T}_2 - 3)^3 + \frac{1}{d}(J - 1)^2 \]
where:

\[ c_{10}, c_{20}, c_{11}, c_{02}, c_{30}, c_{21}, c_{12}, c_{03} = \text{material constants characterizing the deviatoric deformation of the material.} \]
\[ d = \text{material incompressibility parameter.} \]

See Mooney-Rivlin 2 Parameter for definitions of remaining terms.

**Neo-Hookean**

Neo-Hookean: Input values for Initial Shear Modulus \( \mu \) and Incompressibility Parameter \( D_1 \) as defined by the following form of the strain energy potential per unit reference volume, \( W \):

\[ W = \frac{\mu}{2} (T_1 - 3) + \frac{1}{d} (J - 1)^2 \]

where:

\( \mu = \text{initial shear modulus of the material.} \)

See Mooney-Rivlin 2 Parameter for definitions of remaining terms.

**Polynomial**

- **Polynomial 1st order**

Input values for Material Constant \( C_{10} \), Material Constant \( C_{01} \), and Incompressibility Parameter \( D_1 \) as defined by the following form of the strain energy potential, \( W \):

\[ W = \sum_{i+j=1}^{N} c_{ij} (T_1 - 3)^i (T_2 - 3)^j + \sum_{k=1}^{N} \frac{1}{d_k} (J - 1)^{2k} \]

where \( N = 1 \). This is equivalent to Mooney-Rivlin 2 Parameter. If \( N = 1 \) and \( c_{01} = 0 \), it is equivalent to Neo-Hookean.

- **Polynomial 2nd order**

Input values for Material Constant \( C_{10} \), Material Constant \( C_{01} \), Material Constant \( C_{20} \), Material Constant \( C_{11} \), Material Constant \( C_{02} \), Incompressibility Parameter \( D_1 \), and Incompressibility Parameter \( D_2 \) as defined by the following form of the strain energy potential, \( W \):

\[ W = \sum_{i+j=1}^{N} c_{ij} (T_1 - 3)^i (T_2 - 3)^j + \sum_{k=1}^{N} \frac{1}{d_k} (J - 1)^{2k} \]

where \( N = 2 \). This is equivalent to Mooney-Rivlin 5 Parameter.

- **Polynomial 3rd order**

Input values for Material Constant \( C_{10} \), Material Constant \( C_{01} \), Material Constant \( C_{20} \), Material Constant \( C_{11} \), Material Constant \( C_{02} \), Material Constant \( C_{30} \), Material Constant \( C_{21} \), Material Constant \( C_{12} \), Material Constant \( C_{03} \), Incompressibility Parameter \( D_1 \), Incompressibility Parameter \( D_2 \), and Incompressibility Parameter \( D_3 \) as defined by the following form of the strain energy potential, \( W \):

\[ W = \sum_{i+j=1}^{N} c_{ij} (T_1 - 3)^i (T_2 - 3)^j + \sum_{k=1}^{N} \frac{1}{d_k} (J - 1)^{2k} \]
where \( N = 3 \). This is equivalent to Mooney-Rivlin 9 Parameter.

**Yeoh**

- **Yeoh 1st order**: Input values for Material Constant \( C_{10} \) and Incompressibility Parameter \( D_1 \) as defined by the following form of the strain energy potential, \( W \):

\[
W = \sum_{i=1}^{N} c_{i0} \left( T_1 - 3 \right)^i + \sum_{k=1}^{N} \frac{1}{d_k} (J - 1)^{2k}
\]

where:

\[
N = 1.
\]

\( T_1 = \) first deviatoric strain invariant

\( J = \) determinant of the elastic deformation gradient \( F \).

\( c_{10}, d_1 = \) material constants.

The initial shear modulus is defined as:

\[
\mu = 2c_{10}
\]

and the initial bulk modulus is defined as:

\[
K = 2/d_1
\]

- **Yeoh 2nd order**

  : Input values for Material Constant \( C_{10} \), Material Constant \( C_{20} \), Incompressibility Parameter \( D_1 \), and Incompressibility Parameter \( D_2 \) as defined by the following form of the strain energy potential, \( W \):

\[
W = \sum_{i=1}^{N} c_{i0} \left( T_1 - 3 \right)^i + \sum_{k=1}^{N} \frac{1}{d_k} (J - 1)^{2k}
\]

where:

\[
N = 2.
\]

\( c_{10}, c_{20}, d_1, d_2 = \) material constants.

See Yeoh 1st order for definition of the remaining terms.

- **Yeoh 3rd order**

  : Input values for Material Constant \( C_{10} \), Material Constant \( C_{20} \), Material Constant \( C_{30} \), Incompressibility Parameter \( D_1 \), Incompressibility Parameter \( D_2 \), and Incompressibility Parameter \( D_3 \) as defined by the following form of the strain energy potential, \( W \):

\[
W = \sum_{i=1}^{N} c_{i0} \left( T_1 - 3 \right)^i + \sum_{k=1}^{N} \frac{1}{d_k} (J - 1)^{2k}
\]

where:

\[
N = 3.
\]

\( c_{10}, c_{20}, c_{30}, d_1, d_2, d_3 = \) material constants.
See Yeoh 1st order for definition of the remaining terms.

Ogden

• Ogden 1st Order

Input values for Material Constant Mu1 PA, Material Constant A1, and Incompressibility Parameter D1 as defined by the following form of the strain energy potential, \( W \):

\[
W = \sum_{i=1}^{N} \frac{\mu_i}{\alpha_i} \left( \lambda_{i1}^{\alpha_i} + \lambda_{i2}^{\alpha_i} + \lambda_{i3}^{\alpha_i} - 3 \right) + \sum_{k=1}^{N} \frac{1}{d_k} (J - 1)^{2k}
\]

where:

\[
\lambda_p (p = 1,2,3) = \text{deviatoric principal stretches, defined as } \lambda_p = J^\frac{1}{3} \lambda_p
\]

\( \lambda_p = \text{principal stretches of the left Cauchy-Green tensor} \)

\( J = \text{determinant of the elastic deformation gradient} \)

\( N, \mu_p, \alpha_p \), and \( d_p = \text{material constants} \)

The initial shear modulus, \( \mu \), is given as:

\[
\mu = \frac{1}{2} \sum_{i=1}^{N} \alpha_i \mu_i
\]

The initial bulk modulus is:

\[
K = \frac{2}{d_1}
\]

where:

\( N = 1 \)

\( \mu_1, \alpha_1, d_1 \)

• Ogden 2nd Order

Input values for Material Constant Mu1 PA, Material Constant Mu2 PA, Material Constant A1, Material Constant A2, Incompressibility Parameter D1, and Incompressibility Parameter D2 as defined by the following form of the strain energy potential, \( W \):

\[
W = \sum_{i=1}^{N} \frac{\mu_i}{\alpha_i} \left( \tilde{\lambda}_{i1}^{\alpha_i} + \tilde{\lambda}_{i2}^{\alpha_i} + \tilde{\lambda}_{i3}^{\alpha_i} - 3 \right) + \sum_{k=1}^{N} \frac{1}{d_k} (J - 1)^{2k}
\]

where:

\( N = 2 \)

\( \mu_1, \mu_2, \alpha_1, \alpha_2, d_1, d_2 \)

• Ogden 3rd Order
: Input values for Material Constant Mu1 PA, Material Constant Mu2 PA, Material Constant Mu3 PA, Material Constant A1, Material Constant A2, Material Constant A3, Incompressibility Parameter D1, Incompressibility Parameter D2, and Incompressibility Parameter D3 as defined by the following form of the strain energy potential, \( W \):

\[
W = \sum_{i=1}^{N} \frac{\mu_1}{\alpha_i} (\lambda_{1i}^{\alpha_i} + \lambda_{2i}^{\alpha_i} + \lambda_{3i}^{\alpha_i} - 3) + \sum_{k=1}^{N} \frac{1}{d_k} (J - 1)^{2k}
\]

where:

\( N = 3 \)

\( \mu_1, \alpha_1, \mu_2, \alpha_2, \mu_3, \alpha_3, d_1, d_2, d_3 \)

**Thermal Material Properties**

In general, thermal properties are **isotropic**, meaning that you need to define only one value for a property. The same property value is used in all directions. **Orthotropic** properties have an associated X, Y, or Z direction. These directions refer to the element coordinate system.

**Temperature Dependence**

Temperature-dependent properties are input in a tabular form (value vs. temperature). Once defined, these tabular properties are available during solution. If the temperature at a node falls below or rises above the defined temperature range of tabular data, the solver assumes the defined extreme minimum or maximum value, respectively, for the material property outside the defined range.

The following properties are supported for Thermal Analysis:

- **Thermal Conductivity** - can be temperature dependent
- **Orthotropic Thermal Conductivity**
- **Density** – can be temperature dependent
- **Specific Heat** – can be temperature dependent

If the analysis is:

- **Steady state**: You must enter a Thermal Conductivity value (either constant or temperature dependent).
- **Transient**: You must enter Thermal Conductivity, Density and Specific Heat properties. Each of these can either be constant or temperature dependent.

**Electromagnetic Material Properties**

- **Linear “Soft” Magnetic Material**: This classification characterizes magnetic material assuming a constant permeability, that is, no saturation effects. Permeability is simply defined as the ratio of B to H: \( \mu = B/H \). Permeability is more easily expressed in terms of relative and free-space values: \( \mu = \mu_r \mu_0 \). Free-space permeability, \( \mu_0 \), is equal to \( 4\pi \times 10^{-7} \) H/m. Relative permeability, \( \mu_r \), is a multiplier of free-space permeability. Free-space permeability is defined internally within the program. You are required to supply a relative permeability value. This classification is applicable to nonmagnetic material such as air, copper, aluminum. It can also be used as an approximation to magnetic materials when a B-H curve is not available. If the material exhibits constant properties in all directions (isotropic behavior) then select **Relative Permeability** and enter the appropriate value. If the material exhibits different permeability in different orthogonal
directions (orthotropic), then select **Linear Orthotropic Permeability** and enter values for three orthogonal directions (X, Y, Z). When the material is applied to a part in Simulation, you must apply a coordinate system to the part. The material orthogonal properties will align with the coordinate system assigned to the part. For orthogonal properties, the Y and Z values will default to the X value if not specified. An X direction value is required.

**Linear “Hard” Magnetic Material:** This classification characterizes hard magnetic materials such as permanent magnets. The demagnetization curve of the permanent magnet is assumed to have a constant slope. The demagnetization curve intersects the H axis at a value corresponding to the coercive force, \( H_c \). The curve also intersects the B-axis at a value corresponding to the residual induction, \( B_r \). You must enter the **Coercive Force** and **Residual Induction** values. (Use a positive value for the **Coercive Force**). A permanent magnet is polarized along an axis of the part. In Simulation, you must apply a coordinate system to the part. Align the X-axis of the coordinate system in the direction of the North pole of the magnet. The coordinate system may be Cartesian or cylindrical. A cylindrical system may be used for radially oriented permanent magnets.

**Nonlinear “Soft” Magnetic Material:** This classification characterizes soft materials that exhibit nonlinear behavior between B and H. Select **BH Curve** to enter nonlinear B-H data. The nonlinear behavior is described by a single B-H curve. You may create a curve by entering B and H data points in the Engineering Data, or you may choose from a library of B-H curves for typical properties. For material exhibiting orthotropic behavior, you may also select **Nonlinear Orthotropic Permeability**. You may elect to apply the B-H curve in any one or all three orthotropic directions, and specify a constant relative permeability in the other directions. If you use the orthotropic option, you must apply a coordinate system to the part in Simulation. When creating B-H curves, please observe the following guidelines:

a. The curve should be smooth and continuous.
b. Extend the curve well beyond the operating location to accurately capture local high saturation levels. The slope of the curve should asymptotically approach that of free-space permeability. The program will extrapolate beyond the end of the curve at a slope equal to free-space permeability if required during the simulation.
c. Group data points around the knee of the curve for better curve-fitting.
d. For best convergence of the simulation, the curve should approach the (0,0) point asymptotically. A new point in the curve near the curve origin may cause convergence problems.

**Nonlinear “Hard” Magnetic Material:** This classification characterizes hard magnetic materials such as permanent magnets. The demagnetization curve of the permanent magnet is described by a series of B-H data points located in the second quadrant. Select **Demagnetization B-H Curve** to enter this data. The first data entry point should be at \( B = 0, H = -H_c \). A permanent magnet is polarized along an axis of the part. In Simulation, you must apply a coordinate system to the part. Align the X-axis of the coordinate system in the direction of the North pole of the magnet. The coordinate system may be Cartesian, cylindrical. A cylindrical system may be used for radially oriented permanent magnets. When creating B-H curves, please observe the following guidelines:

a. The curve should be smooth and continuous.
b. The curve may extend into the first quadrant.
c. Group data points around the knee of the curve for better curve-fitting.

d. **Electric:** This classification defines electrical properties of materials, specifically electrical resistivity. If the material exhibits constant properties in all directions (isotropic behavior), then select **Resistivity** and enter the appropriate value. If the material exhibits different resistivity in different orthogonal directions (orthotropic), then select **Orthotropic Resistivity** and enter values for three orthogonal directions (X, Y,
Z). When the material is applied to a part in Simulation, you must apply a coordinate system to the part. The material orthogonal properties will align with the coordinate system assigned to the part. For orthogonal properties, the Y and Z values will default to the X value if not specified. An X-direction value is required.

**Material Curve Fitting**

Material curve fitting allows you to estimate coefficients from supplied test data for your material. Curve fitting compares your test data to certain nonlinear material models that are built into ANSYS Workbench. With this feature, you compare test data versus ANSYS-calculated data for different nonlinear models. Based on the comparisons, you decide which material model to use during solution.

To perform curve fitting, you define the type(s) of test data supported for hyperelastic curve fitting, choose a model from one of several supplied hyperelastic models, perform regression analysis, and then graphically view and compare the curve fitting results to the experimental data. The fitted coefficients may then be used for subsequent finite element analyses.

For hyperelastic material models, stress-strain curves can be converted to any of the following hyperelastic models:

- Mooney-Rivlin
- Ogden
- Neo-Hookean
- Polynomial
- Yeoh

**Using Curve Fitting to Determine Your Hyperelastic Material Behavior**

To perform hyperelastic curve fitting in Engineering Data, you will:

1. Prepare the Test Data
2. Input Test Data as Material Properties
3. Select a Material Model Option
4. Perform a Curve Fit
5. Save Results to a Library

**Prepare the Test Data**

You will select from the following four types of test data supported for hyperelastic curve fitting:

- Uniaxial Test (Engineering Strain vs. Engineering Stress)
- Biaxial Test (Engineering Strain vs. Engineering Stress)
- Shear Test (Engineering Strain vs. Engineering Stress)
- Volumetric Test (Volumetric Strain vs. True Stress)

Note — Volumetric Strain equals the ratio of the current volume to that of the original volume and all Solution data displayed for postprocessing are true stresses and logarithmic strains.
Input Test Data as Material Properties

Use the Add/Remove Properties option to add the test data. As shown below, you can quickly isolate the test data using the Filter feature.

Once the data is input the material can be saved to a library and reused.

Select a Material Model Option

Use the Add/Remove Properties option to add any of the constitutive models listed below. When volumetric data is supplied, a compressible or nearly incompressible model is implied. When no volumetric data is supplied, the model is understood to be incompressible. Supplying zero as a coefficient for the volumetric data field also denotes an incompressible model.

- Mooney-Rivlin 2, 3, 5, and 9 parameter models
- Polynomial 1st, 2nd, and 3rd order models
- Yeoh 1st, 2nd, and 3rd order models
- Neo-Hookean model
- Ogden 1st, 2nd, and 3rd order models
Note — For Ogden properties, Workbench will supply initial seed values for the Material Constants in an effort to determine the curve fit and the calculated coefficients. You may also choose your own seed values by entering initial values for the coefficients. It is suggested that you attempt to use seed values based on experience if possible. An Ogden curve fit will most often converge to a local error norm minimum. It may take several attempts, trial seed values, to achieve the desired fit.

**HINT**

Use the values from a lower-order curve fit as seed values for a higher order fit. Use Ogden 1st order curve fit values to seed an Ogden 2nd order curve fit, and Ogden 2nd order values for Ogden 3rd order fit.

**Perform a Curve Fit**

When you add a material model that you wish to curve-fit, the test data points are plotted in the graph, as shown below in an example of a **Polynomial 3rd order** model.

Note — The table enables you to cut or copy and paste data from spreadsheets, such as Excel.

Click the **Fit to Test Data** button to perform the curve fit. Your error norms can be either Normalized or Absolute. Normalized error norms (the default regression option) generally provide better results than absolute error norms, since normalized error norms give equal weight to all of your data points.
Once the curve-fit is complete, the graph overlays the fitted curves derived using the computed coefficients on the test data points. This provides a visual indication of how close the fit is over the strain range of interest. You can perform curve fit on several hyperelastic models and choose the one that best meets your needs, such as the examples shown below.

**Example of Polynomial 2nd Order Fit**
Example of Polynomial 3rd Order Fit
Save Results to a Library

Once you have the material model(s) curve successfully fitted, use the Export feature of Engineering Data to save the material to a library. The material may be further defined or modified in Engineering Data and is available for use in Simulation.
Load Data

This section examines the role of Engineering Data when you apply loads to a simulation. Please select one of the following links to learn more about that topic.

- Convections
- Load History

Convections

Convection information resides and is defined in Engineering Data. You use this information to create, modify, and maintain libraries of convection data. As needed, Workbench applications retrieve convection information from the libraries for use during simulation analyses. This section examines the following convection topics:

- Create New Convections
- ANSYS Supplied Convection Sample Library

Create New Convections

To insert a new convection into a project:

1. Access the Engineering Data application.
2. Highlight the Convection folder in the Project Tree and:
   a. Right-click and select Insert New Convection.
   Or...
   b. Click the New button and then select Convection.
3. A New Convection entry displays in the Project Tree. Rename the new convection.
4. The right pane on the window displays property and tabular data fields. Define the Coefficient Type, Temperature, and Convection Coefficients data.
5. Return to your simulation or create new convections, materials, or load histories.

Modify Convection Data

To modify a convection load in Engineering Data, simply select the appropriate folder in the Project Tree and modify its tabular data.

Note — Convection loads are assigned in Simulation. However, the tabular data associated with the convection is always modified in Engineering Data.

Apply Convections in Simulation

Convections are applied in Simulation for temperature-dependent load simulations. Please see the Thermal Transient Simulations section of the Simulation Help for more information.

ANSYS Supplied Convection Sample Library

The Engineering Data Library provided by ANSYS includes the following convections:

- Stagnant_Air_Horizontal_Cylinder_Turbulent.xml
Load Data

- Stagnant_Air_Simplified_Case.xml
- Stagnant_Air_Vertical_Planes_Laminar_1.xml
- Stagnant_Air_Vertical_Planes_Laminar_2.xml
- Stagnant_Air_Vertical_Planes_Turbulent.xml
- Stagnant_Water_Simplified_Case.xml

Load History

Load history data refers to variation of load with respect to time. This data is defined in a tabular form as TIME versus a load parameter. Like other material and load data, Engineering Data provides an area where this data can be input, stored, modified and used again in a modified or completely different analysis. This section examines the following load history topics:
  - Create New Load Histories
  - Supported Load History Properties

Create New Load Histories

To create a new load history into a project:

1. Access the Engineering Data application.
2. Highlight the Load History folder in the Project Tree and:
   a. Right-click and select Insert New Load History.
   
   Or...

   b. Click the New button and then select Load History.

3. Select the desired load history dependent type.
4. A new load history entry displays. Rename the new load history.
5. The right pane on the window displays property and tabular data fields. Enter tabular data for the new entry.
6. Return to your simulation or create new load histories, materials, or convections.

Note — You can also insert a specific type of load history, such as Temperature, Heat Flux, etc., into a project by selecting the desired load history folder in the Project Tree and performing the above steps.

Modify Load History Data

To modify a load history data in Engineering Data, simply select the appropriate folder in the Project Tree and modify its tabular data.

Note — Load histories are assigned in Simulation. However, the data is always modified in Engineering Data.

Apply Load Histories in Simulation

Load History data are used to apply loads in Thermal Transient Simulations. Please see the Thermal Transient Simulations section of the Simulation Help for more information.
Supported Load History Properties

The following types of loads are currently supported as a function of time.

- Specified temperature
- Heat flux
- Heat generation rate
- Heat flow (on a surface in 3D; on an edge in 2D)
- Film Coefficient for convection
- Ambient temperature for convection or radiation load

Load history data is applicable only for thermal transient simulations.
FE Modeler Help
FE Modeler Help
# Table of Contents

## The Role of FE Modeler in ANSYS Workbench

**Basic Workflow** .................................................................................................................. 1–1
**Interface Tools** .................................................................................................................... 2–1
**Mesh Metrics Tool** ............................................................................................................... 3–1
**Modal Simulation Tool** ....................................................................................................... 4–1
**Navigating the FE Model** ................................................................................................... 5–1

### Navigating the FE Model

- Entities View ...................................................................................................................... 6–1
- Element Types View ........................................................................................................... 6–2
- Bodies View ........................................................................................................................ 6–2
- Contacts View ..................................................................................................................... 6–3
- Materials View .................................................................................................................... 6–3
- Thicknesses View ............................................................................................................... 6–4
- Composites View ............................................................................................................... 6–5
- Bar Properties View .......................................................................................................... 6–5
- Beam Properties View ....................................................................................................... 6–5
- Mass Properties View ....................................................................................................... 6–6
- Components View ............................................................................................................. 6–6

## FE Modeler Options

........................................................................................................................................ 7–1

## Import Specifications

**Unit Systems** .......................................................................................................................... 8–1
**NASTRAN Bulk Data Processing Specifications** .................................................................. 8–1
- Supported General Cards ................................................................................................... 8–1
- Supported Coordinate System Cards .................................................................................. 8–2
- Supported Element Cards .................................................................................................. 8–2
- Supported Loads/Boundary Conditions Cards .................................................................. 8–3
- Supported Material Cards .................................................................................................. 8–3
- Supported Property Cards .................................................................................................. 8–3
- Supported Specialty Elements ............................................................................................ 8–4

### ABAQUS Keyword Specifications

- Supported General Keywords ............................................................................................ 8–4
- Supported Node Keywords ................................................................................................ 8–6
- Supported Element Keywords ............................................................................................ 8–6
- Supported Materials Keywords .......................................................................................... 8–6
- Supported Properties Keywords ........................................................................................ 8–7
- Supported Loads/Boundary Conditions Keywords .......................................................... 8–8
- Supported Contact Keywords ............................................................................................. 8–9

### ABAQUS Element Types Supported by FE Modeler

- Simulation Data Processing Specifications ........................................................................... 8–10

## Export Specifications

- ANSYS as the Target System .............................................................................................. 9–1
- ABAQUS as the Target System ........................................................................................... 9–2
- NASTRAN as the Target System ......................................................................................... 9–3
- Template as the Target System ............................................................................................ 9–4
The Role of FE Modeler in ANSYS Workbench

FE Modeler works with the standard finite element representation used inside ANSYS Workbench. FE Modeler supports robust data transfer from NASTRAN, ABAQUS, or Simulation to ANSYS.

Use FE Modeler to:

- Import an FE model from a NASTRAN bulk data file or ABAQUS Input file.
- Import FE information from Simulation.
- Navigate and visualize the data contained in the model.
- Create named components based on element selections.
- Generate an ANSYS, NASTRAN, or ABAQUS input deck for downstream analysis.

Using FE Modeler Help

To access the ANSYS Workbench Help, see Section : Using Help.

FE Modeler Licensing

FE Modeler capabilities are available for users with an ANSYS Professional license or above. FE Modeler capabilities are also available at any license level if a CAE Templates Add-on license is purchased.
Basic Workflow

The following steps summarize the typical workflow when using FE Modeler. Subsequent sections describe additional tasks for exploring the data and for adding named components to the FE model.

1. To open an existing FE Modeler database or to import NASTRAN or ABAQUS data, perform one of the following:
   
a. From the Start Page, click the **Finite Element Model** icon.
   
b. Open an FE Modeler database, file extension `.fedb`, a NASTRAN bulk data file or an ABAQUS input file.
   
c. Select an appropriate **Unit System** and click **OK**.

   **OR**
   
a. Open an Empty Project.
   
b. Select **Link to a NASTRAN bulk data file**... or **Link to a ABAQUS input**... from the **Project Task** field and then choose the appropriate file.
   
c. If necessary, select a unit system from the **Unit Selection** list.
   
d. Choose **New FE Model**.

   _Note_ — An existing FE Modeler database file can also be opened by double-clicking a file from its directory location.

To import Simulation data:

a. Create or open a Simulation database (.dsdb).

b. Access the Project Page and select a Simulation model from the list of Project items.

c. Under **New FE Model**, choose one **Environment**. Note that FE Modeler transforms the nodes associated with the loads and boundary conditions from that Environment into named components.

2. Review the **Import Summary** report.

During import, FE Modeler dynamically builds a report summarizing the information obtained from NASTRAN, ABAQUS, or Simulation. The report also includes a list of issues raised during the import process. Carefully review these issues to determine their effect on the FE model.

Use the toolbar to print the report or export the document as an HTML file.

3. Define the export specifications using the **Target System** drop-down list on the toolbar and select one of the following templates:

   · **ANSYS** - Default
   
   · **ABAQUS**
   
   · **NASTRAN**
   
   · **Template** - Customizable option for one of the above output selections.
4. Choose **Generated Data** from the **Reports** field to preview the input deck for the targeted system constructed from the current data in the FE model. The preview prohibits text editing to maintain fidelity between the FE model and the generated data.

5. Use the toolbar to print the preview or export the data in the form of the target system’s commands to an `.inp` file.

*Note* — Because it is not unusual to encounter large gaps in node and element numbering in finite element models, **Generated Data**, by default, compresses any such gaps when exporting to ANSYS. You can disable the option that changes the ID’s of all of nodes and elements that are sent to the target system from FE Modeler through the **Tools** > **Options** feature. However, sending large entity numbers such as node or element ID’s may not be memory efficient in ANSYS.
Interface Tools

This section includes information about the interface tools you’ll use in FE Modeler.

Element Selection

Use the following tools to interactively select elements in the Graphics Window:

- **Single Select** mode (Click) - selects the element under the cursor. Hold the Ctrl key to add or remove elements from the selection set.
- **Drag** - "paint selects" a group of elements by pointing, clicking and dragging the cursor over a region adjacent elements. Note that moving the cursor quickly may cause sporadic selection due to system processing limitations.
- **Box Select** mode - selects a group of elements by clicking and dragging the cursor over a region of elements. **Box Select** mode filters out interior and back-facing elements.
- **Box Volume Select, for Elements** mode - similar to **Box Select** mode except that all (interior and back-facing) elements captured by the box are selected throughout the model. When defining the box, the direction from which you drag the mouse, either left or right, from the starting point determines what elements are selected.
- **Select Nodes** mode - selects one node to display its properties (Entities View only - please see the Note shown below). Multiple nodes may be selected by holding the Ctrl key and then clicking multiple nodes.
- **Select Element Faces** mode - selects one element face to display its properties. Multiple element faces may be selected by holding the Ctrl key and then clicking multiple element faces. In addition, similar to Drag select, you may "paint select” a group of elements.
- **Select Elements** mode - selects one element to display its properties. Multiple elements may be selected by holding the Ctrl key and then clicking multiple elements.

*Note* — Element properties are displayed only when one element is selected and in **Entities View** only.

The toolbar contains the following selection tools: Rotate, Pan, Zoom, Box Zoom, Zoom to Fit, Fit, Magnifier Window, Previous View, Next View, and ISO (Set) view.

The status bar at the bottom of the model display window displays a count of the selected elements and nodes.

Context Menu Viewing Options

In addition to toolbar options, you may also use the right mouse button to quickly display selection and view options. Place your cursor over the model and click the right mouse button. A menu displays **Cursor Mode** and **Fit**. Selecting **Cursor Mode** provides the following:

<table>
<thead>
<tr>
<th>Element Selection Tools</th>
<th>View Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Nodes</td>
<td>Rotate</td>
</tr>
<tr>
<td>Select Element Faces</td>
<td>Pan</td>
</tr>
<tr>
<td>Select Elements</td>
<td>Zoom</td>
</tr>
<tr>
<td></td>
<td>Box Zoom</td>
</tr>
</tbody>
</table>

These options are also available when using the Magnifier Window feature.
Printing and Image Capture

The following toolbar buttons allow you to print, or capture and save a displayed image.

- **Resolution** - Allows you to define the quality of the image's resolution as: Normal Image Resolution, Enhanced Image Resolution, or High Resolution.
  
  *Note* — The High Resolution choice requires significant memory capacity.

- **Print** - Allows you to print the image as displayed in the Print Preview display when you are viewing a model (entities, elements types, etc.). The Print button is active only after you have chosen the Print Preview button.

  *Note* — When you are viewing the content of the Import Summary or Generated Data sections, choosing the Print button allows you to print this text content.

- **Print Preview** - Displays how the model will appear in print. Once you select the Print Preview button, the Print button becomes active. To exit the Print Preview display, make a selection from the Views menu.

- **Image Capture** - Saves the image to a file (.png, .jpg, .tif, .bmp, .eps).

The Print Preview and Image Capture buttons are only available when you are viewing a model (entities, elements types, etc.). If elements, faces, or nodes are selected on the model, these selection designations do not appear in either the print preview or on the captured image.

Filtering

Filtering displays excluded elements as translucent or invisible. Interactive selection applies only to opaque elements.

Adding Components

Sometimes it is convenient to group portions of the model to form components, and give the components recognizable names, such as FLANGE, WHEEL2, FIN7.

When one or more elements have been selected, click the Component button in the toolbar. A dialog box displays that provides a text field in which you may name a component to the FE model. The generated ANSYS input deck includes all defined components for use in working with the data in subsequent analyses. The animation shown below illustrates the steps to create a Component. Please take a moment to watch the entire process.

*The following is an animated GIF. Please view online if you are reading the PDF version of the help.*
Graphically select one element to view its properties.
Select multiple elements to create a named component.
Mesh Metrics Tool

The FE Modeler Mesh Metrics tool allows you to evaluate the mesh quality of a model to avoid inaccurate or incomplete solutions.

Element quality is measured in different ways. For example, measurements can be based on an element’s aspect ratio or upon the interior angles. A quality factor is then computed for each element of a model (excluding line and point elements). FE Modeler’s Mesh Metrics feature provides a composite quality metric that ranges between 0 and 1. This metric is based on the ratio of the volume to the edge length for a given element. A value of 1 indicates a perfect cube or square while a value of 0 indicates that the element has a zero or negative volume. The results are displayed in a bar chart that enables you to graphically evaluate the mesh.

The Mesh Metrics feature allows users to confidently import and analyze NASTRAN, ABAQUS, and Simulation models. Once a NASTRAN, ABAQUS, or Simulation model is imported, simply select the Mesh Metrics option under Tools. This action displays a bar chart, as illustrated in the example below, labeled with color-coded bars for each element shape represented in the model’s mesh.

![Element Quality Chart](image)

The X-axis defines composite quality and the Y-axis is the percentage of the volume of the model represented by each bar. The graph can be filtered based on bodies (from Simulation) and element shapes.

The Y-axis represents the elements’ volumes that have a particular quality factor as a percentage of total volume. For example, a model could have a large number of poorly shaped elements that are confined to a small local area. The total volume of these elements might not be significant compared to the volume of the entire model. As a result, the bar corresponding to this low quality factor may not be significant.
Note — For shell Mesh Metrics, the Y-axis displays a percentage of surface area instead of a volume percentage.

The bar chart is based on element shape rather than element type. In addition, 3D solids and shells are included within the bar chart.
Modal Simulation Tool

Overview

The Modal Simulation tool allows you to define a modal analysis (that is, solve for Eigenvalues) based upon modal solution options and constraint sets specified by a NASTRAN bulk data deck, ABAQUS input file, or a Simulation model. You may also modify the following settings when requesting an ANSYS command input file.

- Constraints
- Number of modes (to find)
- Frequency range
- Solver technique

Imported File Requirements

**Simulation**: the Environment input into FE Modeler must have a Frequency Finder object in order to display the modal options.

**NASTRAN**: require models to have SOL equal to 103 in the executive control to display the modal options.

**ABAQUS**: the *FREQUENCY keyword should be defined in the input deck in order to display the modal options.

Steps to Perform a Modal Analysis

Use the following procedure to perform a Modal analysis on a NASTRAN bulk data deck or a Simulation model.

1. Import a NASTRAN bulk data deck, an ABAQUS input file, or a Simulation model into FE Modeler. FE Modeler displays the Import Summary.

2. Select Modal Simulation under the Tools section located in the lower-left portion of the screen and select Enable. Any modal analysis specifications associated with the imported file (ABAQUS, NASTRAN or Simulation) are displayed.
3. Verify the contents of the following fields. If necessary, modify the values.

- **Number of Modes**
- **Frequency Range**
- **Mode Extraction Method**

4. Select a **Constraint Set** for the modal analysis. By default, a **Free-Free** configuration is defined and no constraints are written to the ANSYS input file.

   - **Note** — The following conditions apply:
   
   - Only one constraint set can be used to generate the ANSYS input.
   - For Simulation models, only one constraint set (other than **Free-Free**) is available.
   - For ABAQUS and NASTRAN files, all constraint sets from the bulk data input are displayed in the **Constraint Sets** field.

5. Select **Generated Data** contained in the **Reports** section of the screen. Modal analysis specifications are now included.

### Verify Node Location

To verify the location of nodes contained in a constraint set or to verify the specific degrees of freedom that are constrained, use the **Constraints View**. This view displays the settings for each constraint set available. For example, if a Constraint Set from a NASTRAN model has a Set ID of nine (9), the **Constraints View** may display the following components:

```
SPC <SET: 9, DOFS: 1,2,3,4,5,6, VALUE: 0>
SPC <SET: 9, DOFS: 1,2,3,4,5,6, VALUE: 0>
SPC <SET: 9, DOFS: 1 , VALUE : 0>
SPC <SET: 9, DOFS: 2, 3, VALUE:0>
```

By selecting each of these components you can visualize the nodes that are constrained in all directions, as well as those constrained in direction 1 (UX), 2 (UY) and 3 (UZ) only. All of these values compose Constraint Set 9.
Navigating the FE Model

Explore available views of the data by selecting links under the View section of the screen. Each view focuses on working with a specific aspect of the finite element representation.

Most views include a list of items that manage the data available in the view. Selecting a subset of items in the list filters subsequent data, graphic displays and selectable entities.

- Add or remove selections from the list by using the Ctrl key. Should you have the need to clear all selections from a list, you must use the Ctrl key.
- Use the Shift key to select ranges within the list.

Initially, highlighted items in the list correspond to data applicable to the existing element selection. For example, if no element selection exists the view highlights all items automatically.

The following view types are available in FE Modeler.

- Entities View
- Element Types View
- Bodies View
- Contacts View
- Materials View
- Thicknesses View
- Composites View
- Bar Properties View
- Beam Properties View
- Mass Properties View
- Components View

**Entities View**

Purpose:

- Arbitrary element selection.
- Display of attribute values for a single selected element.

Colors in the graphics display differentiate type classification as follows:

- Low order quad/tri elements
- Low order shell elements
- High order quad/tri elements
- High order shell elements
- Low order 'Solid' Elements (hex/wedge/pyramid)
- High order 'Solid' Elements (hex/wedge/pyramid)
- Mass elements
- Low order lines/beams/rods
- High order lines/beams/rods
- General (RBE1/2/3)
Element Types View

Purpose:

- Listing of element types present in the model, along with corresponding element counts.
- Visualization of element type usage in the model.
- Element selection filtered by one or more element types.

The following is an animated GIF. Please view online if you are reading the PDF version of the help.

Colors in the graphics display differentiate bodies.

Bodies View

Notes:

- For models based on Simulation data, each Part corresponds to one body.
- For models based on NASTRAN and ABAQUS data, one and only one body exists.

Purpose:

- Listing and visualization of bodies defined in the FE model.
- Listing of element types present in a given set of bodies, along with corresponding element counts.
- Element selection filtered by one or more bodies.
- Element selection filtered by one or more element types within a set of bodies.

Colors in the graphics display differentiate bodies.
Contacts View

Note —

- Contacts correspond to Contact objects in Simulation.
- Contacts view is not applicable for models based on NASTRAN data.
- Contacts correspond to *CONTACT PAIR and *SURFACE INTERACTION combinations based on ABAQUS data.

Purpose:

- Listing and visualization of contact regions defined in the FE model.
- Listing of contact element types present in a given set of contact regions, along with corresponding element counts.
- Element selection filtered by one or more contact regions.
- Element selection filtered by one or more contact element types within a set of contact regions.

Colors in the graphics display differentiate contact regions.

Materials View

The purpose of the Materials View is to provide a:

- Listing of all material names present in the model.
- Grouping of materials with identical properties.
- Visualization of material usage in the model. The materials of the model display in different colors.
- Filter for element selection by one or more materials.
- Display of material properties. Modification of material properties is performed in the Engineering Data application.

Material Property Display

The material properties associated with models in FE Modeler can be viewed and edited in Workbench's Engineering Data. Engineering Data provides a centralized storage area for material data that can be shared across other Workbench applications. The Data button on the FE Modeler toolbar provides access to Engineering Data.

When you import ABAQUS and/or NASTRAN data, you must select the same unit system as the original model because the unit system is used to interpret material property values in Engineering Data. For example, if you choose the MKS system, Engineering Data interprets the imported material properties in the MKS system.
**Note** —

- **Generated Data** always uses the same unit system as the imported data. Therefore, if you use FE Modeler as a translator, the property values are the same as those of the imported file. For example, if a source file contains a Young’s Modulus of \(10^7\) then the **Generated Data** always creates a Young’s Modulus of \(10^7\) regardless of the unit system chosen.

- The material properties of imported models are assumed to have a consistent unit system. However, in some unit systems this may cause the values displayed in Engineering Data to be different than the one in the imported file. For example if a density value of 0.00073 in British Inch units is read in from an ABAQUS input file, this value gets multiplied by 386.4 and a value of 0.282072 \(\text{lbm/in}^3\) is displayed in Engineering Data.

- FE Modeler supports Reference Temperature as a *material property* but unlike Simulation, does not support a global reference temperature.

### Custom Unit System for Materials

An option for a custom unit system is available if the unit system of imported NASTRAN or ABAQUS data files does not match the five standard unit systems available in Workbench. If you customize the unit system, you must supply any scale factors that relate length, mass, and time units custom unit system to meters, kilograms, and seconds respectively. Custom units are created on the Project Page once a model has been imported into Workbench. Once imported, you can view imported data in Engineering Data using the ANSYS Workbench standard unit systems, however custom unit systems are not available or displayed from Engineering Data.

**Note** —

- For models based on NASTRAN data, the materials retain their original ID number but are given a default name with the prefix **Unnamed**. These materials can be renamed in Engineering Data.
- For models based on ABAQUS data, materials display their original name from the ABAQUS input.

### Thicknesses View

**Note** —

- Thicknesses correspond to the **Thickness** property of Parts in Simulation.
- For models based on NASTRAN data, thicknesses retain their original ID number.
- For models based on ABAQUS data, thicknesses ID numbers are assigned by FE Modeler.

**Purpose:**

- Listing of all thickness definitions and values present in the model.
- Grouping of thicknesses with identical values.
- Visualization of elements with thickness attributes.
- Element selection filtered by one or more thicknesses.

Colors in the graphics display differentiate thicknesses.
Composites View

Note —

- Displayed only if composite properties are present in the model.
- Displays composite properties from PCOMP card of NASTRAN, if present.
- Displays composite properties from COMPOSITE parameter on the *SHELL SECTION keyword of ABAQUS, if present.

Note — Composite properties retain their original number in NASTRAN data.

Purpose:

- Provides a listing of all composite properties (e.g., offset, non-structural mass, thickness, orientation angle, and material ID) for each layer.
- Displays grouping of composites with identical properties.
- Provides a visualization of composite elements in a model.
- Filters element selection for composite elements only.
- Differentiates elements with different composite properties by color.

Bar Properties View

Note —

- Displayed only if bar elements are present in the model.
- Displays bar properties from PBAR card of NASTRAN, if present.
- Displays bar properties from the *BEAM SECTION, *BEAM GENERAL SECTION, and *FRAME SECTION keywords of ABAQUS, if present.

Note — Bar properties retain the original ID numbering from NASTRAN data.

Purpose:

- Provides a listing of bar properties (e.g., area of cross-section, Inertia terms, Torsion constant and non-structural mass).
- Provides a grouping of bars with identical properties.
- Provides a visualization of bar elements within a model.
- Filters element selection for specified set of bar elements only.
- Differentiates bar elements with different properties by color.

Beam Properties View

Note —

- Displayed only if beam elements are present in the model.
- Displays beam properties from simulation or PBEAM card of NASTRAN.

Note — Beam properties retain the original ID numbering from NASTRAN data.
Navigating the FE Model

Purpose:

- Provides a listing of beam properties (e.g., number of beam sections, Location along the beam, Area of cross-section, Inertia terms, Torsion constant and non-structural mass for each beam section).
- Provides a grouping of beams with identical properties.
- Provides a visualization of beam elements within a model.
- Filters element selection for a specified set of beam elements only.
- Differentiates beam elements with different properties by color.

Mass Properties View

Note —

- Displays Mass properties from CONM2 element type of NASTRAN. Mass properties are assigned an arbitrarily large ID number.
- Displays mass properties from the *MASS and *ROTARY INERTIA keywords of ABAQUS. ID numbers are automatically assigned by FE Modeler.

Purpose:

- Displays a listing of mass properties (e.g., mass value, Coordinate system ID used for offset and inertia terms, \([x, y, z]\) offsets, 6 terms of the inertia tensor).
- Provides a grouping of mass elements with identical properties.
- Filters element selection for specified set of mass elements only.
- Differentiates elements with different properties by color.

Components View

Note —

- Models based on Simulation contain components corresponding to Named Selections and for loads and supports.
- Models based on ABAQUS contain node and element sets. Components are also created by FE Modeler for loads and boundary conditions not defined by a set.

Models based on ABAQUS contain node and element sets for loads and boundary conditions.

- Models based on NASTRAN may contain components that automatically group features of interest (such as rotated nodes), or features that are only partially supported (such as elements with variable thickness, non-zero material orientation angles, etc.). Loads and boundary conditions also define components.
- Component names in FE Modeler and in ANSYS are the same as the entity names in Simulation and ABAQUS sets. NASTRAN components are named by FE Modeler.
- For Generated Data or when transferring the model to ANSYS, any characters that ANSYS component names do not allow are replaced with an underscore. If the name starts with a space or a number, a prefix FEM is added automatically.

Purpose:
• Listing and visualization of components defined in the FE model.
• Naming components.
• Listing of element types present in one or more components, along with corresponding element counts.
• Element selection filtered by one or more components.
• Element selection filtered by one or more element types within a set of components.
You can control the behavior of certain functions in FE Modeler through the Options dialog box. To access FE Modeler options:

1. From the main menu, choose Tools> Options. The Options dialog box shown below appears.
2. Select the plus (+) symbol beside FE Modeler to expand the option.
3. Highlight Miscellaneous to display the available FE Modeler options.
4. Change any of the option settings by clicking directly in the option field on the right.
5. Click OK.

The following FE Modeler options appear in the Options dialog box:

- Miscellaneous
- Templates

Miscellaneous Option

You can disable the option that changes the ID's of all of nodes and elements that are sent to the target system from FE Modeler by selecting Tools> Options> FE Modeler> Miscellaneous and changing Compress Numbers Sent To ANSYS from Yes to No. See the Export Specifications section for more information.

Note — It is highly recommended that you maintain the default setting to avoid sending large numbers to ANSYS.
Templates Option

You can change a target system template by selecting Tools > Options > FE Modeler > Templates and modifying the directory path of the target template file.
Import Specifications

This section includes specifications associated with importing files into FE Modeler and presents the requirements for using the given data.

Unit Systems

NASTRAN Bulk Data Processing Specifications
ABAQUS Keyword Specifications
Simulation Data Processing Specifications

Unit Systems

When you transfer models from Simulation to FE Modeler, the:

- Unit system from the Simulation model is used to create the FE Modeler Generated Data.
- FE Modeler displayed data is always in the MKS System. However, the generated data is in the Simulation Unit System. For example, a node selected in FE Modeler displays its coordinates in the MKS system even though the Generated Data may appear in inches.

When you transfer models from ABAQUS/NASTRAN to FE Modeler, the:

- Generated Data in FE Modeler always uses the unit system of the imported file. For example, if the source file contains a Young's Modulus of $1e7$, in British inch units, then the Generated Data always creates a Young's Modulus of $1e7$.
- Imported unit system information is only used to transfer the given material information to Engineering Data. It can then be used by Simulation.
- Material data from NASTRAN/ABAQUS is interpreted in a consistent unit system. As a result, the values displayed in Engineering Data can be different.
- Material data imported into FE Modeler from ABAQUS/NASTRAN is the only data for which the unit system can be recognized.

NASTRAN Bulk Data Processing Specifications

This section presents FE Modeler support for the following NASTRAN items:

Supported General Cards
Supported Coordinate System Cards
Supported Element Cards
Supported Loads/Boundary Conditions Cards
Supported Material Cards
Supported Property Cards
Supported Specialty Elements

Supported General Cards

- EIGR - The number of modes to extract and the minimum/maximum frequency range is processed.
- EIGRL - The number of modes to extract and the minimum/maximum frequency range is processed.
- GRDSET
- GRID - Rotated nodes are grouped into a component during import.
- INCLUDE - 1 level only, no nesting.
Import Specifications

- MPC
- PARAM - The only parameter name supported is “WTMASS”. The value of this parameter is multiplied by all items associated with the mass (such as material density).

**Supported Coordinate System Cards**

- CORD1C
- CORD1R
- CORD1S
- CORD2C
- CORD2R
- CORD2S

**Supported Element Cards**

- CBAR - No pin releases and offsets. All affected elements are grouped in a component during import.
- CBEAM - No pin releases and offsets. All affected elements are grouped in a component during import.
- CBUSH - 2 grid option only supported. Element number, property id, and 2 grid points only processed.
- CELAS1 - C1 = C2 is assumed.
- CELAS2 - C1 = C2 is assumed. Stress coefficient is ignored.
- CHEXA
- CONM1 - Connectivity information only is transferred to ANSYS.
- CONM2 - All properties are displayed in the GUI. However, only the mass and diagonal terms of the inertia tensor are transferred to ANSYS. No coordinate system, mass offset from node location, or off-diagonal terms of the inertia tensor are transferred to ANSYS.
- CPENTA
- CQUAD - No center node.
- CQUAD4 - No offset. All affected elements are grouped in a component during import.
- CQUAD8 - No offset. All affected elements are grouped in a component during import.
- CQUADR
- CQUADX - No center node. All affected elements are grouped in a component during import.
- CROD
- CSHEAR
- CTETRA
- CTRIA3 - No offset. All affected elements are grouped in a component during import.
- CTRIA6 - No offset. All affected elements are grouped in a component during import.
- CTRIAR
- CTRIAX
- CTRIAX6
Note — If Tri- and Quad-shell elements are missing one or more mid-side nodes, FE Modeler will ignore (not process) all mid-side nodes.

**Supported Loads/Boundary Conditions Cards**

- FORCE
- FORCE1
- FORCE2
- MOMENT
- MOMENT1
- MOMENT2
- PLOAD
- PLOAD2
- PLOAD4
  - A non-normal orientation is displayed in the GUI as a force, but is sent to ANSYS as a pressure. A non-normal orientation is supported only on a 3D solid element face.
  - Variable pressure distribution is not supported.
- SPC
- SPC1

**Supported Material Cards**

- MAT1
- MAT2 - No data is supported. The material id only is maintained.
- MAT3 - No data is supported. The material id only is maintained.
- MAT4 - Thermal conductivity and Specific Heat.
- MAT8
- MAT9 - No data is supported. The material id only is maintained.
- MAT10 - No data is supported. The material id only is maintained.

**Supported Property Cards**

- PBAR - No stress recovery coefficients and area factors for shear.
- PBARL - The following cross-section shapes are supported: ROD, TUBE, I, CHAN, BOX, BAR, I1, CHAN1, Z, T2, BOX1, HAT
- PBEAM - No stress data recovery data, shear stiffness factors, warping coefficients, coordinates of center of gravity for nonstructural mass, and coordinates of the neutral axis.
- PBEAML - The following cross-section shapes are supported: ROD, TUBE, L, I, CHAN, BOX, BAR, I1, CHAN1, Z, T2, BOX1, HAT.
- PCOMP - No failure theory, reference temperature and damping coefficient.
- PELAS - No stress coefficient.
• PROD
• PSHEAR - No effectiveness factors for extensional stiffness.
• PSHELL - Only MID1 and T are read.
• PSOLID - No material coordinate system, integration network, integration scheme or stress data is read.

Note — Rod/Bar/Beam properties are displayed in the GUI and used when exporting to ANSYS. If the NASTRAN model contains PBEAM tapered beams, when exporting to ANSYS the tapered properties are defined as a constant cross-section with the properties being "averaged" from the first and last cross-section to represent the taper. Also, for both PBEAM and PBEAML tapered beams, the intermediate cross-sections properties are ignored.

Supported Specialty Elements

• RBE1
• RBE2
• RBE3
• RBAR - Processed as a RBE2 card always using the component numbers 123456.
• RROD - Processed as a RBE2 card always using the component numbers 123.

AB AQUS Keyword Specifications

This section presents FE Modeler support for the following ABAQUS items:

Supported General Keywords

Supported Node Keywords

Supported Element Keywords

Supported Materials Keywords

Supported Properties Keywords

Supported Loads/Boundary Conditions Keywords

Supported Contact Keywords

AB AQUS Element Types Supported by FE Modeler

Supported General Keywords

• *ASSEMBLY
  – Only the first instance defined in a model is read in. All other instances and data are ignored. Element and node sets, as well as materials, associated with this instance are also processed.

• *INCLUDE supported
  – Only 1 level deep supported.

• *INSTANCE
  – Only the first instance of a part will be processed

• *END ASSEMBLY
• *END PART
**END INSTANCE**

- **PARAMETER** supported - Independent parameters only (constants).

  *Note* — These parameters are not stored and used in ANSYS, the values are substituted “on the fly.”

- **PART**
  - Only the first instance of a part is processed.

- **TRANSFORM** supported

- **SYSTEM**

- **SURFACE**
  - NAME parameter supported.
  - TYPE parameter supported.
    - TYPE = ELEMENT only supported.
  - Element id/set and surface id only supported.

- **SURFACE DEFINITION**
  - NAME parameter supported.
  - Element id and surface id only supported.

- **NSET**
  - NSET parameter supported.
  - GENERATE parameter supported.
  - INSTANCE parameter supported - If the name matches the processed instance, the set will be processed.
  - List of node sets supported.

- **ELSET**
  - ELSET parameter supported.
  - GENERATE parameter supported.
  - INSTANCE parameter supported - If the name matches the processed instance, the set will be processed.
  - List of element sets supported.

- **FREQUENCY** supported
  - A modal simulation will be defined.
  - EIGENSOLVER parameter supported.
  - NORMALIZATION parameter supported.
  - For Lanczos solver:
Number of eigenvalues to extract read.
Minimum and maximum frequencies read.

For Subspace solver:
Number of eigenvalues to extract read.
Maximum frequency read.

- *EQUATION supported
  - Using a component (set) name not supported.

- *MPC supported
  - Only BEAM and TIE types are supported

### Supported Node Keywords

- *NODE
  - SYSTEM parameter supported.
  - INPUT parameter supported.

### Supported Element Keywords

- *ELEMENT
  - INPUT parameter supported.
  - ELSET parameter supported.
  - TYPE parameter supported.
  - ALL NODES parameter NOT supported.

  Note — Please see the ABAQUS Element Types Supported by FE Modeler section for the specific ABAQUS Elements that are supported by FE Modeler.

- *ORIENTATION - Used to define element coordinate systems.
  - NAME parameter supported.
  - DEFINITION parameter supported for COORDINATES and NODES options.
  - SYSTEM parameter supported for RECTANGULAR and CYLINDRICAL options.

### Supported Materials Keywords

- *MATERIAL
NAME parameter supported.

- **ELASTIC**
  - For TYPE = ISOTROPIC, ENGINEERING CONSTANTS, and LAMINA.
  - If no Poisson's Ratio is specified, 0.3 is used.
  - For TYPE = ISOTROPIC, Young's Modulus and Poisson's Ratio are supported.
  - For TYPE = ISOTROPIC and TYPE = LAMINA, Young's moduli, Poisson's ratios, and the Shear Moduli in the principal directions are supported.
  - Temperature dependency not supported.

- **DENSITY**
- **EXPANSION**
- **PLASTIC**
  - HARDENING = ISOTROPIC only.

- **CONDUCTIVITY**
- **SPECIFIC HEAT**

### Supported Properties Keywords

- **NODAL THICKNESS**
  - Any thicknesses defined by this keyword supersedes the constant thickness value defined by the *SHELL SECTION keyword. The constant shell thickness is still defined, but is not used by any of the elements.

- **SOLID SECTION**
  - ELSET parameter supported.
  - ORIENTATION parameter supported.
  - Material supported.

- **SHELL SECTION**
  - COMPOSITE parameter supported.
    → Orientation angle is only supported (fourth item on the data line).
  - NODAL THICKNESS parameter supported.
    → A constant thickness definition will exist but is not used by the elements. The definition from the *NODAL THICKNESS keyword is used instead.
  - ELSET parameter supported.
  - ORIENTATION parameter supported.
OFFSET parameter supported. Restrictions when exporting to ANSYS:

- High order shells ignore offsets.
- Variable thickness values are averaged.

- Material supported.
- Thickness supported.

• Beam Properties (*BEAM SECTION, *FRAME SECTION, *BEAM GENERAL SECTION)
  - Not supporting arbitrary, hex, or elbow sections.
  - ELSET parameter supported.
  - Material properties supported for General Beam and Frame.

• *MASS and *ROTARY INERTIA support
• *SHELL GENERAL SECTION
• *SPRING support
  - Linear only.
  - SPRINGA NOT supported.
  - The degree of freedom (DOF) associated with the first node will be stored with the definition. The DOF for the second node (used with SPRING2 elements) is ignored.

Supported Loads/Boundary Conditions Keywords

• *BOUNDARY supported
  - Parameter TYPE = DISPLACEMENT is only supported.
  - The following boundary condition types are supported:
    → ENCASTRE
    → PINNED
    → XSYMM
    → YSYMM
    → ZSYMM
    → XASYMM
    → YASYMM
    → ZASYMM

• *CLOAD
  - Defined component only.
  - Forces and moments.
• No parameter label supported.

• *DLOAD - Pressure loading only as signified by Pn, where n is the face ID.

**Supported Contact Keywords**

• *CLEARANCE
  – Only the parameters SLAVE, MASTER, and VALUE are supported

• *CONTACT PAIR
  – EXTENSION ZONE parameter supported
  – TIED parameter supported
  – ADJUST parameter supported
  – Contact and target elements are defined using minimal settings.

  **Note:** Contact definition is composed of three parts:

  1. The first is the contact interaction name for that contact pair (specified on the *CONTACT PAIR command and used in the *SURFACE INTERACTION card).
  2. The second part is the “Slave” set name.
  3. The third is the “Master” set name.

  Each part of the contact name is separated by an underscore. For example, the ABAQUS command sequence would appear as follows:

  *SURFACE, NAME=Surf1
  *SURFACE, NAME=Surf2
  *CONTACT PAIR, INTERACTION=Inter1, Surf1, Surf2
  *SURFACE INTERACTION, NAME=Inter1

  The contact object in FE Modeler will have the name **Inter1_Surf1_Surf2**.

• *CONTACT INTERFERENCE
  – Only parameter “TYPE = CONTACT PAIR” is supported.
  – SHRINK parameter supported.
  – The Reference Allowable Interference is supported.
  – The Shift Direction Vector is NOT supported.

• *FRICTION support
  – Only used in conjunction with the *SURFACE INTERACTION keyword (contact only).
  – Friction coefficient is supported and only read from data lines.
  – The following parameters are supported:
ROUGH
EXPONENTIAL DECAY
TAUMAX
SLIP TOLERANCE
LAGRANGE

*SURFACE BEHAVIOR
- NO SEPARATION parameter supported.
- The following items are supported for the parameter PRESSURE-OVERCLOSURE:
  - HARD
  - Linear
- AUGMENTED LAGRANGE parameter supported.

*SURFACE INTERACTION
- UNSYMM parameter supported

ABAQUS Element Types Supported by FE Modeler

This section defines the ABAQUS Element Types that are supported by FE Modeler. The supported ABAQUS Element types can be categorized as shown below and each ABAQUS element type defines a new FE Modeler element type. The ANSYS element type corresponding to each category is also summarized below.

Each unique ABAQUS element type is defined by an FE Modeler element type and each FE Modeler element type is processed in ANSYS as a unique ANSYS element type. ABAQUS elements can be further defined into the specified categories. For example, Point Mass has four ABAQUS element types that define a mass element. If ABAQUS MASS and ROTARY1 elements, as shown below, are defined, the result is two distinct FE Modeler element types and both are processed in ANSYS as MASS21, however ANSYS defines two separate MASS21 element types for the given ABAQUS element types.

<table>
<thead>
<tr>
<th>ABAQUS Element Type Category</th>
<th>ABAQUS Element Type</th>
<th>Exported ANSYS Element Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point Mass</td>
<td>MASS, HEATCAP, ROTARY1, ASI1</td>
<td>MASS21</td>
</tr>
<tr>
<td>Point Spring</td>
<td>SPRING1, DASHPOT1</td>
<td>COMBIN14</td>
</tr>
<tr>
<td>2D Linear Line</td>
<td>ASI2, B21, B21H, B23, B23H, PIPE21, PIPE21H, F2D2, FRAME2D, R2D2³, RB2D2³, T2D2, T2D2H, T2D2T, T2D2E, CONN2D2, JOINT2D</td>
<td>BEAM3</td>
</tr>
<tr>
<td>2D Line Gasket</td>
<td>GK2D2², GK2D2N¹</td>
<td>BEAM3</td>
</tr>
<tr>
<td>Axisymmetric Linear Line</td>
<td>DCCAX2, DCCAX2D, ASI2A, SAX1, DSAX1, FAX2, MAX1, MGAX1, RAX2³, SFMAX1, SFMGAX1, SAXA1N</td>
<td>SHELL208</td>
</tr>
<tr>
<td>Axisymmetric Line Gasket</td>
<td>GKAX2², GKAX2N¹</td>
<td>SHELL208</td>
</tr>
<tr>
<td>ABAQUS Element Type Category</td>
<td>ABAQUS Element Type</td>
<td>Exported ANSYS Element Type</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>3D Linear Line</td>
<td>DC1D2, DCC1D2, DCC1D2D, DC1D2E, AC1D2, B31, B31H, B33, B33H, PIPE31, PIPE31H, B31OS, B31OSH, DASHPOTA, DASHPOT2, GAPUNI, GAPCYL, GAPSPHER, GAPUNIT, DGAP, ELBOW31, ELBOW31B, ELBOW31C, FLINK, FRAME3D, RB3D2, SPRINGA, SPRING2, T3D2, T3D2H, T3D2T, T3D2E, CONN3D2, JOINT3D, JOINTC</td>
<td>BEAM188</td>
</tr>
<tr>
<td>3D Line Gasket</td>
<td>GK3D2, GK3D2N</td>
<td>BEAM188</td>
</tr>
<tr>
<td>2D Quadratic Line</td>
<td>ASI3, B22, B22H, PIPE22, PIPE22H, T2D3, T2D3H, T2D3T, T2D3E</td>
<td>BEAM3</td>
</tr>
<tr>
<td>Axisymmetric Quadratic Line</td>
<td>ASI3A, SAX2, DSAX2, SAX2T, MAX2, MGAX2, SFMAX2, SFMGAX2, SAXA2N</td>
<td>SHELL208</td>
</tr>
<tr>
<td>3D Quadratic Line</td>
<td>DC1D3, DC1D3E, AC1D3, B32, B32H, PIPE32, PIPE32H, B32OS, B32OSH, ELBOW32, T3D3, T3D3H, T3D3T, T3D3E</td>
<td>BEAM188</td>
</tr>
<tr>
<td>2D Linear Triangle</td>
<td>CPE3, CPE3H, CPS3, CPE3G, CPE3H, CPE3T, CPS3T, CPE3GHT, DC2D3, DC2D3E, AC2D3, CPE3E, CPS3E, WARP2D3</td>
<td>PLANE182</td>
</tr>
<tr>
<td>Axisymmetric Linear Triangle</td>
<td>CAX3, CAX3H, CGAX3, CGAX3H, DCA2D3, DCA2D3E, CAX3T, CGAX3T, CGAX3HT, CAX3X, CAX3E</td>
<td>PLAN182, KEYOPT(3)=1</td>
</tr>
<tr>
<td>3D Linear Triangle</td>
<td>STRI3, S3, S3R, S3RS, DS3, F3D3, M3D3, R3D3, SFM3D3</td>
<td>SHELL181</td>
</tr>
<tr>
<td>2D Quadratic Triangle</td>
<td>CPE6, CPE6H, CPE6M, CPE6MH, CPS6, CPS6M, CPE6G, CPE6GH, CPE6GM, CPE6GHM, CPE6GMP, DC2D6, DC2D6E, CPE6GMPH, AC2D6, CPE6E, CPS6E</td>
<td>PLAN183</td>
</tr>
<tr>
<td>Axisymmetric Quadratic Triangle</td>
<td>CAX6, CAX6H, CAX6M, CAX6MH, CGAX6, CGAX6H, CGAX6M, CGAX6MH, DCAX6, DCA6X, CAX6E, CAX6HT, CAX6MT, CAX6MHT, CAX6MP, CAX6XMP, ACAX6, CAX6E</td>
<td>PLAN183, KEYOPT(3)=1</td>
</tr>
<tr>
<td>3D Quadratic Triangle</td>
<td>STRI65, DS6, M3D6, SFM3D6</td>
<td>SHELL93</td>
</tr>
<tr>
<td>2D Quadratic Gasket</td>
<td>GKPS4, GKPE4, GKPS4N, GKPS6, GKPS6N, GKPE6</td>
<td>INTER192</td>
</tr>
<tr>
<td>ABAQUS Element Type Category</td>
<td>ABAQUS Element Type</td>
<td>Exported ANSYS Element Type</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Axisymmetric Quadratic Gasket</td>
<td>GKAX4, GKAX4N, GKAX6, GKAX6N</td>
<td>INTER192, KEYOPT(3)=1</td>
</tr>
<tr>
<td>3D Linear Quadrilateral</td>
<td>ASI4, S4, S4R, S4RS, S4RSW, S4R5, DS4, M3D4, M3D4R, MCL6, R3D4, SFM3D4, SFM3D4R, SFMCL6, F3D4</td>
<td>SHELL181</td>
</tr>
<tr>
<td>2D Quadratic Quadrilateral</td>
<td>CPE8, CPE8H, CPE8R, CPE8RH, CPS8, CPS8R, CPS8H, CPS8R, CPE8RH, CPE8T, CPE8HT, CPE8RT, CPE8RHT, CPS8T, CPS8RT, CPS8HT, CPE8HT, CPE8RT, DC2D8, DC2D8E, CPE8P, CPE8PH, CPE8RP, CPE8RH, AC2D8, CPE8E, CPE8RE, CPS8E, CPS8RE</td>
<td>PLANE183</td>
</tr>
<tr>
<td>Axisymmetric Quadratic Quadrilateral</td>
<td>CAX8, CAX8H, CAX8R, CAX8NH, CAX8RH, CGAX8, CGAX8H, CGAX8R, CGAX8RH, DCAX8, DCAX8E, CAX8T, CAX8HT, CAX8RT, CAX8RHT, PAX8, CAX8PH, CAX8RP, CAX8RP, ACA8, CAX8E, CAX8RE, CAX8N, CAX8HN, CAX8RN, CAX8RHN, CAX8PN, CAX8RPN</td>
<td>PLANE183, KEYOPT(3)=1</td>
</tr>
<tr>
<td>3D Quadratic Quadrilateral</td>
<td>ASI8, S8R, S8R5, S8R5, S8R5, S8R, S8RT, M3D8, M3D8R, M3D9, M3D9R, MCL9, SFM3D8, SFM3D8R, SFMCL9</td>
<td>SHELL93</td>
</tr>
<tr>
<td>Linear Tetrahedral</td>
<td>C3D4, C3D4H, C3D4T, DC3D4, DC3D4E, AC3D4, C3D4E</td>
<td>SOLID185</td>
</tr>
<tr>
<td>Linear Wedge</td>
<td>C3D6, C3D6H, C3D6T, DC3D6, DC3D6E, AC3D6, C3D6E, SC6R</td>
<td>SOLID185</td>
</tr>
<tr>
<td>Wedge Gasket</td>
<td>GK3D6, GK3D6N, GK3D12M, GK3D12MN</td>
<td>SOLID185</td>
</tr>
<tr>
<td>Linear Hexahedral</td>
<td>C3D8, C3D8H, C3D8I, C3D8IH, C3D8R, C3D8RH, C3D8HT, C3D8RT, C3D8RHT, DC3D8, DCC3D8, DCC3D8D, DC3D8E, C3D8P, C3D8PH, C3D8P, C3D8RP, AC3D8, AC3D8R, C3D8E, SC8R</td>
<td>SOLID185</td>
</tr>
<tr>
<td>Hexahedral Gasket</td>
<td>GK3D8, GK3D8N, GK3D12N, GK3D12MN</td>
<td>INTER195</td>
</tr>
<tr>
<td>Quadratic Tetrahedral</td>
<td>C3D10, C3D10H, C3D10M, C3D10MH, C3D10MT, C3D10MHT, C3D10, DC3D10E, C3D10MP, C3D10MPH, AC3D10, C3D10E</td>
<td>SOLID187</td>
</tr>
</tbody>
</table>
## Simulation Data Processing Specifications

### Supported Elements - 2D Models

<table>
<thead>
<tr>
<th>Simulation/ANSYS Elements</th>
<th>FE Modeler Generic Representation</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-Node Triangular Structural (PLANE182)</td>
<td>3-Node Triangular Planar</td>
</tr>
<tr>
<td>4-Node Quadrilateral Structural (PLANE182)</td>
<td>4-Node Quadrilateral Planar</td>
</tr>
<tr>
<td>8-Node Triangular Structural (PLANE183)</td>
<td>6-Node Triangular Planar</td>
</tr>
<tr>
<td>8-Node Quadrilateral Structural (PLANE183)</td>
<td>8-Node Quadrilateral Planar</td>
</tr>
<tr>
<td>4-Node Triangular Thermal (PLANE55)</td>
<td>3-Node Triangular Planar</td>
</tr>
<tr>
<td>4-Node Quadrilateral Thermal (PLANE55)</td>
<td>4-Node Quadrilateral Planar</td>
</tr>
<tr>
<td>8-Node Triangular Thermal (PLANE77)</td>
<td>6-Node Triangular Planar</td>
</tr>
<tr>
<td>8-Node Quadrilateral Thermal (PLANE77)</td>
<td>8-Node Quadrilateral Planar</td>
</tr>
</tbody>
</table>

### Supported Elements - 3D Models

<table>
<thead>
<tr>
<th>Simulation/ANSYS Elements</th>
<th>FE Modeler Generic Representation</th>
</tr>
</thead>
<tbody>
<tr>
<td>8-Node Hexahedral Structural Solid (Solid45)</td>
<td>8-Node Hexahedron</td>
</tr>
<tr>
<td>8-Node Pentahedral Structural Solid (Solid45)</td>
<td>8-Node Wedge</td>
</tr>
<tr>
<td>8-Node Pyramidal Structural Solid (Solid45)</td>
<td>8-Node Pyramid</td>
</tr>
<tr>
<td>10-Node Tetrahedral Structural Solid (Solid92)</td>
<td>10-Node Tetrahedron</td>
</tr>
<tr>
<td>10-Node Tetrahedral Structural Solid (SOLID187)</td>
<td>10-Node Tetrahedron</td>
</tr>
<tr>
<td>20-Node Hexahedral Structural Solid (SOLID95)</td>
<td>20-Node Hexahedron</td>
</tr>
<tr>
<td>20-Node Pentahedral Structural Solid (SOLID95)</td>
<td>20-Node Wedge</td>
</tr>
<tr>
<td>20-Node Pyramidal Structural Solid (SOLID95)</td>
<td>20-Node Pyramid</td>
</tr>
<tr>
<td>20-Node Hexahedral Structural Solid (SOLID186)</td>
<td>20-Node Hexahedron</td>
</tr>
<tr>
<td>20-Node Pentahedral Structural Solid (SOLID186)</td>
<td>20-Node Wedge</td>
</tr>
<tr>
<td>20-Node Pyramidal Structural Solid (SOLID186)</td>
<td>20-Node Pyramid</td>
</tr>
<tr>
<td>4-Node Quadrilateral Structural (SHELL181)</td>
<td>4-Node Quadrilateral Shell</td>
</tr>
</tbody>
</table>
## Import Specifications

### Simulation/ANSYS Elements vs. FE Modeler Generic Representation

<table>
<thead>
<tr>
<th>Simulation/ANSYS Elements</th>
<th>FE Modeler Generic Representation</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-Node Triangular Structural Shell (SHELL181)</td>
<td>4-Node Triangular Shell</td>
</tr>
<tr>
<td>8-Node Hexahedral Thermal Solid (Solid70)</td>
<td>8-Node Hexahedron</td>
</tr>
<tr>
<td>8-Node Pentahedral Thermal Solid (Solid70)</td>
<td>8-Node Wedge</td>
</tr>
<tr>
<td>8-Node Pyramidal Thermal Solid (SOLID70)</td>
<td>8-Node Pyramid</td>
</tr>
<tr>
<td>10-Node Tetrahedral Thermal Solid (SOLID87)</td>
<td>10-Node Tetrahedron</td>
</tr>
<tr>
<td>20-Node Hexahedral Thermal Solid (SOLID90)</td>
<td>20-Node Hexahedron</td>
</tr>
<tr>
<td>20-Node Pentahedral Thermal Solid (SOLID90)</td>
<td>20-Node Wedge</td>
</tr>
<tr>
<td>20-Node Pyramidal Thermal Solid (SOLID90)</td>
<td>20-Node Pyramid</td>
</tr>
<tr>
<td>4-Node Quadrilateral Thermal Shell (SHELL57)</td>
<td>4-Node Quadrilateral Shell</td>
</tr>
<tr>
<td>4-Node Triangular Thermal Shell (SHELL57)</td>
<td>4-Node Triangular Shell</td>
</tr>
<tr>
<td>3-Node Structural Beam (BEAM188)</td>
<td>3-Node Beam</td>
</tr>
<tr>
<td>2-Node Conducting Bar (Link33)</td>
<td>2-Node Beam</td>
</tr>
<tr>
<td>Contact Region (CONTA174)</td>
<td>8-Node Quadratic Quadralateral Contact or 6-Node Quadratic Triangular Contact</td>
</tr>
<tr>
<td>Target Region (TARGE170)</td>
<td>3-D Contact Target Segment</td>
</tr>
<tr>
<td>Contact Region2 (CONTA174)</td>
<td>8-Node Quadratic Quadralateral Contact or 6-Node Quadratic Triangular Contact</td>
</tr>
<tr>
<td>Target Region2 (TARGE170)</td>
<td>8-Node Quadratic Quadralateral Target or 6-Node Quadratic Triangular Target</td>
</tr>
<tr>
<td>Username (CONTA174)</td>
<td>8-Node Quadratic Quadralateral Contact or 6-Node Quadratic Triangular Contact</td>
</tr>
<tr>
<td>Username (TARGE170)</td>
<td>8-Node Quadratic Quadralateral Target or 6-Node Quadratic Triangular Target</td>
</tr>
</tbody>
</table>

**Note** — MESH200 is also supported and used when importing only a mesh to FE Modeler, or whenever the analysis type, as reported by Simulation, is **Unknown**. MESH200 is also used whenever there is not enough information in the Simulation branch to deduce the analysis type.

### Supported Simulation Loads

Listed below are the specific types of Simulation loads that are supported by FE Modeler.

<table>
<thead>
<tr>
<th>Simulation Load Type</th>
<th>Loads Supported in FE Modeler</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIXED SUPPORTS</td>
<td>• Fixed Surface</td>
</tr>
<tr>
<td></td>
<td>• Fixed Edge</td>
</tr>
<tr>
<td></td>
<td>• Fixed Vertex</td>
</tr>
<tr>
<td></td>
<td>• Simply Supported Edge</td>
</tr>
<tr>
<td></td>
<td>• Simply Supported Vertex</td>
</tr>
<tr>
<td>FORCE</td>
<td>• On Vertex</td>
</tr>
<tr>
<td></td>
<td>• On Surface</td>
</tr>
<tr>
<td>PRESSURE</td>
<td>• On Surface</td>
</tr>
<tr>
<td></td>
<td>• On Edge</td>
</tr>
<tr>
<td>Simulation Load Type</td>
<td>Loads Supported in FE Modeler</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------</td>
</tr>
</tbody>
</table>
| SPECIFIED DISPLACEMENTS | - On Surface  
|                      | - On Edge  
|                      | - On Vertex |
Export Specifications

The **Target System** feature, located on the toolbar, allows you to export or "write out," FE Modeler data through the use of templates. Templates are required to export data from FE Modeler. They provide a way for you to generate a customized ANSYS, ABAQUS, or NASTRAN input deck. The following options (formats) are available from the **Target System** drop-down list:

- ANSYS
- ABAQUS
- NASTRAN
- Template

See the FE Modeler Options section for information on how to change the path to a target system template.

**ANSYS as the Target System**

When ANSYS is used as the target system the following entities, if present, are written out as ANSYS commands from FE Modeler.

*Note* — Only structural element types are supported.

<table>
<thead>
<tr>
<th>FE Modeler Generic Representation</th>
<th>Exported ANSYS Element Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Node Mass</td>
<td>MASS21</td>
</tr>
<tr>
<td>3-Node Triangular Planar</td>
<td>PLANE182</td>
</tr>
<tr>
<td>4-Node Quadrilateral Planar</td>
<td>PLANE182</td>
</tr>
<tr>
<td>6-Node Triangular Planar</td>
<td>PLANE183</td>
</tr>
<tr>
<td>8-Node Quadrilateral Planar</td>
<td>PLANE183</td>
</tr>
<tr>
<td>8-Node Hexahedron</td>
<td>SOLID185</td>
</tr>
<tr>
<td>8-Node Wedge</td>
<td>SOLID185</td>
</tr>
<tr>
<td>8-Node Pyramid</td>
<td>SOLID185</td>
</tr>
<tr>
<td>10-Node Tetrahedron</td>
<td>SOLID187</td>
</tr>
<tr>
<td>20-Node Hexahedron</td>
<td>SOLID186</td>
</tr>
<tr>
<td>20-Node Wedge</td>
<td>SOLID186</td>
</tr>
<tr>
<td>20-Node Pyramid</td>
<td>SOLID186</td>
</tr>
<tr>
<td>4-Node Quadrilateral Shell</td>
<td>SHELL181</td>
</tr>
<tr>
<td>4-Node Triangular Shell</td>
<td>SHELL181</td>
</tr>
<tr>
<td>3-Node Beam</td>
<td>BEAM188</td>
</tr>
<tr>
<td>8-Node Quadratic Quadrilateral Contact or 6-Node Quadratic Triangular Contact</td>
<td>CONTA174</td>
</tr>
<tr>
<td>3-D Contact Target Segment</td>
<td>TARGE170</td>
</tr>
<tr>
<td>8-Node Quadratic Quadrilateral Contact or 6-Node Quadratic Triangular Contact</td>
<td>CONTA174</td>
</tr>
<tr>
<td>8-Node Quadratic Quadrilateral Target or 6-Node Quadratic Triangular Target</td>
<td>TARGE170</td>
</tr>
</tbody>
</table>
### Export Specifications

<table>
<thead>
<tr>
<th>FE Modeler Generic Representation</th>
<th>Exported ANSYS Element Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>8-Node Quadratic Quadrilateral Target or 6-Node Quadratic Triangular shell</td>
<td>SHELL93</td>
</tr>
</tbody>
</table>

Exported ANSYS FE Entity Types have the following specifications.

<table>
<thead>
<tr>
<th>FE Entity Type</th>
<th>Exported Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nodes</td>
<td>Nodal coordinates and rotation angles.</td>
</tr>
<tr>
<td>Elements</td>
<td>Element definition includes element connectivity, element type ID, material ID, real constant ID, and element coordinate system ID.</td>
</tr>
<tr>
<td>Material Properties</td>
<td>Isotropic and orthotropic elastic properties, Plastic strain based MISO plasticity, isotropic thermal coefficient of expansion, density, thermal conductivity and specific heat.</td>
</tr>
<tr>
<td>Physical Properties</td>
<td>Real constants and/or section data.</td>
</tr>
<tr>
<td>Interfaces</td>
<td>Includes surface-to-surface contact pair definitions, contact properties, constraint equations and couples.</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>Any available local coordinate systems.</td>
</tr>
<tr>
<td>Components</td>
<td>Node and Element components. Face components in FE Modeler are converted to node components and sent over to ANSYS.</td>
</tr>
<tr>
<td>Boundary Conditions</td>
<td>Constraints for structural degrees of freedom only.</td>
</tr>
<tr>
<td>Loads</td>
<td>Concentrated forces and Element pressures only.</td>
</tr>
</tbody>
</table>

### ABAQUS as the Target System

When ABAQUS is used as the target system the following entities, if present, are written out as ABAQUS commands from FE Modeler.

*Note* — Only structural element types are supported.

<table>
<thead>
<tr>
<th>FE Modeler Generic Representation</th>
<th>Exported ABAQUS Element Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D</td>
<td></td>
</tr>
<tr>
<td>3-Node Triangular Planar</td>
<td>S3</td>
</tr>
<tr>
<td>4-Node Quadrilateral Planar</td>
<td>S4</td>
</tr>
<tr>
<td>6-Node Triangular Planar</td>
<td>STRI65</td>
</tr>
<tr>
<td>8-Node Quadrilateral Planar</td>
<td>S8R</td>
</tr>
<tr>
<td>3D</td>
<td></td>
</tr>
<tr>
<td>1-Node Mass</td>
<td>MASS</td>
</tr>
<tr>
<td>2-Node Bar</td>
<td>B31</td>
</tr>
<tr>
<td>4-Node</td>
<td>C3D4</td>
</tr>
<tr>
<td>6-Node</td>
<td>C3D6</td>
</tr>
<tr>
<td>8-Node</td>
<td>C3D8</td>
</tr>
<tr>
<td>10-Node</td>
<td>C3D10</td>
</tr>
<tr>
<td>15-Node</td>
<td>C3D15</td>
</tr>
<tr>
<td>20-Node</td>
<td>C3D20</td>
</tr>
</tbody>
</table>
Exported ABAQUS FE Entity Types have the following specifications.

<table>
<thead>
<tr>
<th>FE Entity Type</th>
<th>Exported Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nodes</td>
<td>Nodal coordinates and rotation angles.</td>
</tr>
<tr>
<td>Elements</td>
<td>Element definition includes element connectivity.</td>
</tr>
<tr>
<td>Material Properties</td>
<td>Isotropic and orthotropic elastic properties, Plastic strain based MISO plasticity, isotropic thermal coefficient of expansion, density, thermal conductivity and specific heat.</td>
</tr>
</tbody>
</table>

**NASTRAN as the Target System**

When NASTRAN is used as the target system, the following entities, if present, are written out as NASTRAN commands from FE Modeler.

*Note* — Only structural element types are supported.

Exported NASTRAN FE Entity Types have the following specifications.
Export Specifications

<table>
<thead>
<tr>
<th>FE Entity Type</th>
<th>Exported Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nodes</td>
<td>Nodal coordinates and rotation angles.</td>
</tr>
<tr>
<td>Elements</td>
<td>Element definition includes element connectivity.</td>
</tr>
<tr>
<td>Material Properties</td>
<td>Isotropic and orthotropic elastic properties, Plastic strain based MISO plasticity, isotropic thermal coefficient of expansion, density, thermal conductivity and specific heat.</td>
</tr>
</tbody>
</table>

Template as the Target System

When **Template** is used as the target system, you are prompted to open a customized template that you have created. A customized template allows you to control the order in which FE data is written out. In addition you can also intersperse commands with a template that are not supported by FE Modeler to perform advanced modeling or provide analysis controls.

Shown below are the commands contained in the Workbench provided default template for each of the supported target systems that you will use as the basis for a customize template. In addition, samples of the template are provided.

<table>
<thead>
<tr>
<th>Commands to Include in Template</th>
<th>Supported Targets</th>
<th>Supported Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>@ElementType@</td>
<td>ANSYS</td>
<td>Element type definitions.</td>
</tr>
<tr>
<td>@MeshNodes @</td>
<td>ANSYS, ABAQUS, NASTRAN</td>
<td>Node definitions including rotations.</td>
</tr>
<tr>
<td>@MeshElements@</td>
<td>ANSYS, ABAQUS, NASTRAN</td>
<td>Element definitions (element type, material ID, property ID, element connectivity).</td>
</tr>
<tr>
<td>@MaterialProperties@</td>
<td>ANSYS, ABAQUS, NASTRAN</td>
<td>Material property definitions.</td>
</tr>
<tr>
<td>@Components@</td>
<td>ANSYS</td>
<td>Element, Node and Face component definitions.</td>
</tr>
<tr>
<td>@InterfaceRegions@</td>
<td>ANSYS</td>
<td>Definition of contact regions and contact properties.</td>
</tr>
<tr>
<td>@Loads@</td>
<td>ANSYS</td>
<td>Nodal forces and surface pressures.</td>
</tr>
<tr>
<td>@BoundaryConditions@</td>
<td>ANSYS</td>
<td>Specified displacement boundary conditions.</td>
</tr>
<tr>
<td>@PhysicalProperties@</td>
<td>ANSYS</td>
<td>Real constant and Section definitions.</td>
</tr>
</tbody>
</table>

**Note** — Not all entities imported into FE Modeler can be exported to all of the available systems.

Sample Templates

**ANSYS** as the target system

```
<wbtemplate>
!HEADING
! File created at @timestamp@
!
! This template extracts the FEmodeler mesh in a format
! compatible with ANSYS input
!
@MeshNodes@
!
@MeshElements@
!
@ElementType@
!
@MaterialProperties@
```

FE Modeler Help. © SAS IP, Inc.
NASTRAN as the target system.

```xml
<NASTRAN>
  <WBTEMPLATE TARGET=NASTRAN>
    $...
    $ File created at @TimeStamp@
    $...
    $ This template extracts the FEModeler mesh in a format compatible with NASTRAN input.
    $...
    BEGIN BULK
    $...
    *MATERIAL PROPERTIES
    $...
    @MaterialProperties@
    $...
    *MESH NODES
    $...
    @MeshNodes@
    $...
    *MESH ELEMENTS
    $...
    @MeshElements@
    $...
    ENDDATA
  </WBTEMPLATE>
</NASTRAN>
```

ABAQUS as the target system.

```xml
<ABAQUS>
  <WBTEMPLATE TARGET=ABAQUS>
    *HEADING
    ** File created at @TimeStamp@
    **...
    ** This template extracts the FEModeler mesh in a format compatible with ABAQUS input
    **...
    @MeshNodes@
    **
    @MeshElements@
    **
    @MaterialProperties@
    **
  </WBTEMPLATE>
</ABAQUS>
```

Sample templates are provided to perform a large deflection analysis using ANSYS, NASTRAN or ABAQUS.
DesignXplorer Help
DesignXplorer Help
# Table of Contents

## Overview
- Systems Support .......................................................................................................................... 1–1
- What is DesignXplorer? .................................................................................................................. 1–1
- The User Interface .......................................................................................................................... 1–2
- Parameters ....................................................................................................................................... 1–4
- Design Points ................................................................................................................................. 1–5
- Work Flow ....................................................................................................................................... 1–5
- DesignXplorer Options .................................................................................................................. 1–6

## Using DesignXplorer
- Starting DesignXplorer ................................................................................................................ 2–1
- Working with Parameters .............................................................................................................. 2–2
- Input Parameters ............................................................................................................................. 2–2
- Declare Design Variables ............................................................................................................. 2–3
- Declare Uncertainty Variables ...................................................................................................... 2–3
- Response Parameters .................................................................................................................... 2–5
- Creating Derived Parameters ....................................................................................................... 2–5
- Creating Robust Design Parameters ............................................................................................ 2–7
- Status of the Parameter .................................................................................................................. 2–7

## Creating a DesignXplorer Solution ............................................................................................ 2–7

## Automatic Design Points .......................................................................................................... 2–8

## Responses ..................................................................................................................................... 2–13
- Controlling the Graph with the Navigational Control ................................................................. 2–14
- Snapshots ....................................................................................................................................... 2–15
- Imprinting ........................................................................................................................................ 2–15
- Generating Custom Design Points From Response Charts .......................................................... 2–17
- Response Charts ............................................................................................................................. 2–17
- Goodness of Fit ............................................................................................................................... 2–19
- Making an X-Y Graph ..................................................................................................................... 2–19
- Making a 2-D Contour Graph ......................................................................................................... 2–19
- Making a 3-D Contour Graph ......................................................................................................... 2–20
- Spider Charts .................................................................................................................................... 2–22
- Single Parameter Sensitivities ...................................................................................................... 2–24

## Custom Design Points ................................................................................................................. 2–25
- Viewing Geometry .......................................................................................................................... 2–26
- Updating Simulation Results and Parameters ............................................................................... 2–26

## Sample Generation ..................................................................................................................... 2–26
- Min/Max Search ............................................................................................................................... 2–28

## Using Goal Driven Optimization ............................................................................................... 2–29
- Defining Design Goals .................................................................................................................... 2–29
- Creating New Design Points From Goals ..................................................................................... 2–30
- Sensitivities ....................................................................................................................................... 2–31
- TradeOff Study ................................................................................................................................. 2–32

## Using Six Sigma Analysis ........................................................................................................... 2–33
- Performing a Six Sigma Analysis ................................................................................................... 2–33
- Using Statistical Postprocessing ................................................................................................... 2–33
- Tables ............................................................................................................................................. 2–33
- Charts ............................................................................................................................................. 2–34
- Sensitivities ....................................................................................................................................... 2–35
- Statistical Measures ....................................................................................................................... 2–36
- Parameterizing Six Sigma Analysis Results .................................................................................. 2–37
List of Figures

1. Histograms for the Snow Height H1 and H2 ................................................................. 2–4
2. 6,000 Sample Points Generated by Screening Method .................................................. 4–2
3. Final Sample Set After 5,100 Evaluations by Advanced Method ............................... 4–2
4. Pareto Optimal Front Showing Two Non-dominated Solutions ................................. 4–3
5. Case Where the Advanced Option Cannot be Activated .............................................. 4–4
6. Case Where GDO Solves a Constraint Satisfaction Problem ...................................... 4–5
7. Typical MOO Case .......................................................................................................... 4–6
8. Primary Postprocessing Options for GDO ................................................................. 4–7
9. Typical TradeOff Study of Sample Showing First Pareto Front ................................. 4–8
10. Selection of a Subset of the First Pareto Front ............................................................. 4–9
11. User-Selected Sample Set From the First Pareto Front ............................................... 4–10
12. Decision Support as Performed on User-Selected Sample Set ................................... 4–11
13. Two-dimensional TradeOff Plot Showing Feasible and Infeasible Points .................. 4–12
14. Three-dimensional TradeOff Plot Showing Feasible and Infeasible Points ............... 4–12
1. Illustration of cumulative distribution function ............................................................ 5–12
2. Probability Tables ........................................................................................................... 5–13

List of Tables

1. Number of Automatic Design Points as a Function of the Number of Input Parameters ................................................. 2–11
2. Goals and Their Meanings for Continuous Input Parameters ........................................ 2–29
3. Goals and Their Meanings for Discrete Input Parameters ............................................. 2–29
4. Goals and Their Meanings for Response and Derived Parameters (Y = Output Parameters) ........................................ 2–30
1. Different Types of Kurtosis .............................................................................................. 5–16
Overview

The following links provide quick access to information concerning DesignXplorer and its use:

- Using DesignXplorer Help
- Section : Systems Support
- Section : What is DesignXplorer?
- Section : The User Interface
- Section : Parameters
- Section : Design Points
- Section : Work Flow
- Section : DesignXplorer Options
- Using DesignXplorer

Using DesignXplorer Help

To access the ANSYS Workbench Help, see Section : Using Help.

Systems Support

DesignXplorer and DesignXplorer VT are only supported on the Windows platform. A complete listing of operating system requirements is listed in the ANSYS Workbench Products Installation and Configuration Guide for Windows.

Limitations

DesignXplorer, DesignXplorer VT and the DesignXplorer Parameter Manager are not localized.

What is DesignXplorer?

DesignXplorer is a powerful tool for designing and understanding the analysis response of parts and assemblies. DesignXplorer is based on Design of Experiment (DOE) and various optimization methods, and uses parameters as its basic language. These parameters can come from Simulation, DesignModeler, and various supported CAD systems. (For a complete list of supported CAD systems, see CAD Systems.) Structural and thermal responses can be studied, quantified, and graphed. Using a goal-driven optimization method, DesignXplorer can obtain a multiplicity of robust design points. You can also explore the calculated response surface and generate design sets directly from there.

Design of Experiment

DOE is a technique used to determine the location of sampling points. There are several versions of design of experiment available in engineering literature. These techniques all have one common characteristic: they try to locate the sampling points such that the space of random input parameters is explored in the most efficient way, or obtain the required information with a minimum of sampling points. Sample points in efficient locations will not only reduce the required number of sampling points, but also increase the accuracy of the response surface that is derived from the results of the sampling points. DesignXplorer uses a central composite design, which combines one center point, points along the axis of the input parameters, and the points determined by a fractional factorial design.
**Variational Technology**

The results of a finite element analysis depend on several input variables, such as material properties, CAD parameters, and shell thickness properties. In a design optimization based on DOE, each change of the value of any input variable requires a new finite element analysis. A response surface is generated which is an explicit approximation function of the finite element results expressed as a function of all selected input variables. The DOE method generates a response surface using curve- and surface-fitting algorithms to “fit” output data as a function of input data. This requires a group of design points where each point is generated via a finite element solve.

DesignXplorer VT provides a much more efficient approach by providing a response surface that is based on a single finite element solve combined with the use of mesh morphing and the Taylor series expansion approximation. Because the derivatives are also calculated, this “extended” finite element analysis may take longer than a regular solve. However, this one “extended” finite element analysis takes considerably less time compared to the many solution runs that are required for a regular DOE solve.

**Six Sigma Analysis**

Six Sigma Analysis is an analysis technique for assessing the effect of certain input parameters and assumptions on your model.

A Six Sigma Analysis allows you to determine the extent to which uncertainties in the model affect the results of an analysis. An “uncertainty” (or random quantity) is a parameter whose value is impossible to determine at a given point in time (if it is time-dependent) or at a given location (if it is location-dependent). An example is ambient temperature: you cannot know precisely what the temperature will be one week from now in a given city.

In a Six Sigma Analysis, statistical distribution functions (such as the Gaussian or normal distribution, the uniform distribution, etc.) describe uncertain parameters.

**Robust Design**

Robust Design studies combine Goal Driven Optimization and Six Sigma Analysis to optimize Six Sigma Analysis results to minimize the probability of failure.

**The User Interface**

Views available in the DesignXplorer application window are shown below.

**Views**

The available views expose all of the important objects of DesignXplorer. Several of the views are pictured below as they appear in the Views pane.
Parameters: When you select Parameters in the Views pane, the parameters you set in Simulation are visible in View Details, sorted by input and output. When a parameter is selected, information about the parameter appears in the right pane.

Automatic Design Points: When you select Automatic Design Points in the Views pane, Summary and Geometry appear in View Sub-options while a list of designs appears in View Details. Information about, if you have Summary selected, or a picture of, if you have Geometry selected, the selected design appears in the right pane.

Responses: When you select Responses in the Views pane, three options appear in View Sub-options: Response Charts, Single Parameter Sensitivities, and Spider Charts. Selecting Response Charts displays a response chart, showing the effect varying input parameters has on an output parameter, in the right pane. Selecting Single Parameter Sensitivities displays charts in the right pane which show which input parameter(s) have the greatest effect on a selected output parameter. Selecting Spider Charts displays a spider chart in the right pane, allowing you to visualize the impact that changing the input parameter(s) has on all of the output parameters simultaneously.

Custom Design Points: When you click on Custom Design Points in the Views pane, design points that you have generated from response charts or stated design goals are displayed.

Goal Driven Optimization: When you select Goal Driven Optimization in the Views pane, three options appear in View Sub-options: Goals & Candidates, Sensitivities, and TradeOff Study. Details of the sample set appear in View Details. Before you are able to select any of these options, you must have generated a sample set. Selecting Goals & Candidates allows you to set the importance of and goals for each parameter before generating designs. Selecting Sensitivities displays the sensitivity charts in the right pane. Selecting TradeOff study allows you to perform a tradeoff study.

Six Sigma Analysis: When you run a solve in DesignXplorer with one or more input parameters set as uncertainty variables, you will see Six Sigma Analysis in the Views pane. There will be three options in View Sub-options: Tables, Charts, and Sensitivities. Before selecting one, you must generate a sample set. Once that is done, selecting Tables or Charts will display statistical charts for the set in the right pane. Selecting Sensitivities will display statistical sensitivity charts.

Robust Design: When you select Robust Design in the Views pane, three options appear in View Sub-options: Goals & Candidates, Sensitivities, and TradeOff Study. Details of the sample set appear in View Details. Before you are able to select any of these options, you must have generated a sample set. Selecting Goals & Candidates allows you to set the importance of and goals for each parameter before generating designs. Selecting Sensitivities displays the sensitivity charts in the right pane. Selecting TradeOff study allows you to perform a tradeoff study.

Snapshots: When Snapshots is selected in the Views pane, three options appear in View Sub-options: Responses, Sensitivities, and TradeOff Study. Choosing one of these options displays all snapshots.
from the selected category. The **Snapshots** view can be used to quickly access related graphs and delete or rename snapshots.

- **Solution Messages**: When **Solution Messages** is selected in the Views pane, errors that occurred while DesignXplorer was solving are displayed. General Errors are not selectable.
- **Report**: When you select **Report** in the Views pane, DesignXplorer will automatically generate a report for you. The report will display in the right pane.

### Parameters

The following types of parameters are used in DesignXplorer:

- Input Parameters
- Response Parameters
- Derived Parameters
- Parameters associated with ANSYS Parametric Design Language (APDL)

#### Input Parameters

Input parameters are those parameters that define the geometry or inputs to the analysis for the structure under investigation. Input parameters have predefined ranges that may be changed. These include (and are not limited to) CAD parameters, Simulation parameters, and DesignModeler parameters. CAD and DesignModeler input parameters might include length, radius, etc.; Simulation input parameters might include pressure, material properties, materials, sheet thickness, etc.

Input parameters can be discrete or continuous, and each of these have specific forms. Discrete parameters are those that are not continuous in nature (for example, the number of holes in a part, or the material the part is made of). Continuous parameters can be any value defined by the range you set.

<table>
<thead>
<tr>
<th>Parameter Type</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discrete Parameters</td>
<td>Valid only at integer values</td>
<td>Number of holes, number of weld points</td>
</tr>
<tr>
<td>Scenario Discrete Parameters</td>
<td>Set conditions independent of other scenario discrete parameters</td>
<td>Material type</td>
</tr>
<tr>
<td>Continuous Parameters</td>
<td>Continuous non-interrupted range of values</td>
<td>Thickness, force, temperature</td>
</tr>
<tr>
<td>Continuous Parameters with Usability Constraints</td>
<td>The theoretical values are continuous, but manufacturing or real-world constraints limit actual values</td>
<td>Drill bit sizes, readily available bolts, screws</td>
</tr>
</tbody>
</table>

Because the parameter manager will not delete existing usability values from the values set when you generate a run, the reset ranges are interpreted as new usability levels. Output values that are evaluated with usability input parameters outside of the reset ranges are not guaranteed to have +/- 2% accuracy in a DesignXplorer VT design study.

#### Response Parameters

Response parameters are those parameters that result from the geometry or are the response outputs from the analysis. These include (and are not limited to) volume, mass, frequency, stress, heat flux, and so forth.
Derived Parameters

Derived parameters are an analytical combination of response or input parameters. As the definition suggests, derived parameters are calculated from other parameters by using equations that you provide. Basing derived parameters upon other derived parameters is not supported.

Design Points

A Design Point is defined by a snapshot of parameter values. These include input parameters, response parameters, and derived parameters. A complete definition of a design point also includes its name, a description, and its identification as either an automatic or custom design point.

Automatic Design Points

An Automatic Design Point is a design point which has parameter values that were calculated directly in Simulation, a CAD system, or DesignModeler. There is a Workflow associated with the creation of an automatic design point.

Custom Design Points

A Custom Design Point is a design point which has parameter values that were calculated in DesignXplorer. As such, the parameter values are approximate and calculated from response charts. The most promising custom designs should be verified by a solve in Simulation using the same parameter values.

Work Flow

The following procedures provide overviews of work flow:

- from a modeling system (either DesignModeler or other CAD software), through Simulation, and then into DesignXplorer for design optimization.
- through DesignXplorer, creating candidate designs that meet the stated design goals.
- verifying the validity of custom/candidate design points in Simulation, with the final design ultimately reflected in the modeling system.

To load a scenario into DesignXplorer:

1. Create parts and assemblies in either the DesignModeler solid modeler or any of the supported CAD systems. Features in the geometry that will be important to the analysis should be set as parameters. Such parameters can be passed to DesignXplorer.
2. Click the Project tab, and on the Project Page, highlight the row representing the DesignModeler or CAD file, and click the link for transferring the model into Simulation.
3. Specify additional input parameters and output parameters in Simulation.
4. Click the Project tab, and on the Project Page, highlight the row representing the Simulation model, and click the link for transferring the model into DesignXplorer.

To create candidate designs:

1. Set up design parameters.
2. Run the DesignXplorer solution. Automatic design points are solved.
3. Generate candidate design points.
1. Set design goals and generate candidate design points based on the current goals (from the Goals & Candidates view).

and/or

2. Generate new custom design points from the various response views.

The goals method provides a way of optimizing your design based on goals that you set. Generating design points from the response data graphs allows you to explore the response surface and choose designs based on the values in the graphs.

4. Create snapshots of the response charts. You can include the snapshots in your reports, as well as reload them on demand.

5. Create reports based on the response data for candidate designs.

To verify the best candidate designs:

1. Create reference design points by running analyses on candidate designs in Simulation.
2. Insert a view of the CAD/DesignModeler part or assembly.
3. Update the geometry in DesignModeler or the CAD system based on the best automatic design point(s).

DesignXplorer Options

You can control the behavior of functions in DesignXplorer through the Options dialog box. To access DesignXplorer options:

1. From the main menu, choose Tools>Options. An Options dialog box appears and the DesignXplorer options are displayed on the left.
2. Click on a specific option.
3. Change any of the option settings by clicking directly in the option field on the right. You will first see a visual indication for the kind of interaction required in the field (examples are drop-down menus, secondary dialog boxes, and direct text entries).
4. Click OK.

The following DesignXplorer options appear in the Options dialog box:

- Automatic Design Points
- Graph
- Random Number Generation
- Solution
- Sensitivity
- Optimization
- Parameter Options

Other help information is available that describes the Options dialog box:

- Common Settings
- DesignModeler
- CFX-Mesh
- Simulation
Automatic Design Points

The **Central Composite Design** category includes:

- **Design Type**: Specifies a Central Composite Design (CCD) type to help improve the response surface fit for DOE studies. For each CCD type, the alpha value is defined as the location of the sampling point that accounts for all quadratic main effects. The following choices are available:
  - **Face-Centered**: A three-level design with no rotatability. The alpha value equals 1.0. The Enhanced Template option automatically appears when Face-Centered is selected from the drop-down menu. Select Yes to enable the enhanced template.
  - **Rotatable**: A five-level design that includes rotatability. The alpha value is calculated based on the number of input variables and a fraction of the factorial part. A design with rotatability has the same variance of the fitted value regardless of the direction from the center point. The Enhanced Template option automatically appears when Rotatable is selected from the drop-down menu. Select Yes to enable the enhanced template.
  - **VIF-Optimality**: A five-level design in which the alpha value is calculated by minimizing a measure of non-orthogonality known as the Variance Inflation Factor (VIF). The more highly correlated the input variable with one or more terms in a regression model, the higher the Variance Inflation Factor.
  - **G-Optimality**: Minimizes a measure of the expected error in a prediction and minimizes the largest expected variance of prediction over the region of interest.
  - **Auto Defined** (default): The DesignXplorer program automatically selects the Design Type based on the number of input variables. Use of this option is recommended for most cases as which it automatically switches between the G-Optimal (if the number of variables is 5) or VIF-optimal otherwise.

However, the rotational design may be used if the default option does not provide good values for the goodness of fits from the response surface plots. Also, the Enhanced Template may be used if the default standard template does not fit the response surfaces too well.

The **Enhanced Template** option may be used for Face-Centered and Rotable if the default standard template does not fit the response surfaces. The default is No.

---

**Note** — To view the current Central Composite Design type, click on the **Automatic Design Points** view. The CCD type is displayed above the summary of automatic design points.

Changing the CCD type in the **Options** dialog box will generate new automatic design points provided the study has not yet been solved.

---

**Graph**

The **Axis** category includes:

- **Number of Gridlines**: Changes the number of points used by the continuous input parameter axes in the 2-D/3-D response surface charts. This enhances the viewing of these charts. The range is from 2 to 100. The default is 10.

The **Tradeoff** category includes:
• **Color Usage**: Controls the number of colors used by 2-D and 3-D tradeoff charts. Choosing more colors provides a better color quality display at the expense of slower chart rendering. Choosing less colors provides faster chart rendering at the expense of lower color quality. The following choices are available:
  - Use 8 Colors
  - Use 16 Colors
  - Use 32 Colors (default)
  - Use 64 Colors
  - Use Maximum Colors possible (Graph display will be slow)

**Random Number Generation**

The **Seed Option** category includes:

• **Repeatability**: Seeds the random number generator to the same value each time you generate uncertainty analysis samples. With repeatability set to **No**, the random number generator is seeded with the system time every time you generate samples. This applies to all methods in DesignXplorer where random numbers are needed, as in Six Sigma Analysis or optimization using Goal Driven Optimization. The default is **No**.

**Solution**

The **Variational Technology Method** category includes:

• **Mesh Morphing Type**: To use mesh morphing, DesignXplorer VT must include the initial geometry with an initial mesh, as well as several updated geometries. The values of the CAD parameters must be different from the initial geometry values.
  - **Classic Method** (default): DesignXplorer VT minimizes the number of configurations to minimize the time required for mesh morphing. Only one parameter is varied in each configuration.
  - **CCD Matrix Method**: DesignXplorer VT chooses the parameter configurations using the CCD (Central Composite Design) matrix to calculate the value of each parameter for each configuration. For some cases, especially when CAD parameters are coupled, this method is more precise, because more configurations are used.

• **Approximation Type**
  - **Auto** (default): DesignXplorer will automatically pick Taylor series approximation or Pade approximation type.
  - **Reduced Order Model Sweep (ROMS)**: This method is the most accurate.

• **Solver Type for Approximation Type ROMS**: This is only taken into account with ROMS. With Taylor and Pade, the solver type is always **DIRECT** (SPARSE solver) and this option is ignored.
  - **Inherited from Simulation** (default): Means the Solver Type picked in Tools>Options>Simulation>Solution>Solver Type is used.
  - **Direct**: The Sparse Direct (SPARSE) Solver will be used.
  - **Iterative**: The Preconditioned Conjugate Gradient (PCG) Solver will be used.
**Solution Type**

- **Full** (default): When selected, the solution evaluates the derivatives for the Series Expansion method, including mixed-derivatives, addressing the interactions between the input variables. When set to **Independent**, the solver will evaluate the derivatives assuming that the input variables are independent, so mixed derivatives will be neglected.
- **Independent**: Mixed input variable interaction will not be calculated.

The **Variational Technology Settings** category includes:

- **Accuracy**: Increasing the accuracy will increase the time of the solution run in DesignXplorer.
  - **Aggressively Accurate**: Calculate the solution to within ±0.5% accuracy.
  - **Very Accurate**: Calculate the solution to within ±1% accuracy.
  - **Accurate** (default): Calculate the solution to within ±2% accuracy.
  - **Moderately Accurate**: Calculate the solution to within ±5% accuracy.

- **Maximum Mesh Distortion**: Controls the overall mesh quality in DesignXplorer VT to prevent the deformation of your mesh. This will limit the relative variation of the volume of a solid (3-D) element or of the surface of a shell (2-D) element. The default is 90. The range is from 1 to 150.

  *Note* — If, during the morphing of the mesh, the mesh quality is worse than the maximum mesh distortion setting, the parameter causing this distortion will be suppressed. However, in some situations, a few elements in the mesh can be of poor quality without affecting the overall quality of the solution. If you increase the distortion setting, the solution proceeds while including the bad elements.

- **Out-of-core Post-processing**: The default is No. Allows you to choose if the Variational Technology evaluations are done in memory (out-of-core = no) or directly using the results file on the disk (out-of-core = yes). The goal is not to increase performances, but to allow the evaluation of larger models and/or on machines having a small amount of memory and swapping very quickly. You must close and reopen your DesignXplorer project to see the effect of this option.

**Sensitivity**

The **Global Sensitivity** category includes:

- **Significance Level**: Controls the relative importance or significance of input variables. The allowable range is from 0.0, meaning all input variables are to be significant, to 1.0, meaning all input variables are to be insignificant. The default is 0.025.

- **Correlation Coefficient Calculation Type**: Specifies the calculation method for determining sensitivity correlation coefficients. The following choices are available:
  - **Rank Order (Spearman)** (default): Correlation coefficients are evaluated based on the rank of samples.
  - **Linear (Pearson)**: Correlation coefficients are evaluated based on the samples.
Optimization

The Optimization category includes:

- **Constraint Handling (GDS)**

  This option can be used for any optimization or robust design application and is best thought of as a "constraint satisfaction" filter either on samples generated from the "Screening" or the "Advanced" runs. This is especially useful for "Screening" samples to detect the edges of solution feasibility for highly constrained nonlinear optimization problems.

  - **As goals** (default): Implies that the upper, lower and equality constrained goals of the candidate designs shown in the “Goals and Candidates” page are treated as goals (or objective functions), thus any violation of the goals is still considered feasible.

  - **As hard constraints**: When chosen, the upper, lower and equality constrained goals are treated as hard constraints, that is, if any of them are violated then the candidate is no longer displayed. So, in some cases no candidate designs may be displayed depending on the extent of Constraint violation.

Parameter Options

The Parameter Settings category includes:

- **Parameter Naming Convention**: Sets the naming style of parameters within DesignXplorer.

  - **Taguchi Style**: Names the parameters as Continuous Variables and Noise Variables.

  - **Uncertainty Management Style** (default): Names the parameters as Design Variables and Uncertainty Variables.

  - **Reliability Based Optimization Style**: Names the parameters as Design Variables and Random Variables.
Using DesignXplorer

The topics in this section cover the basics of using DesignXplorer. Details on the use of DesignXplorer VT can be found in the Variational Technology section.

Note — DesignXplorer is not available in any language other than English.

Starting DesignXplorer

There are two ways to start DesignXplorer:

1. Start DesignXplorer from the Start Page by clicking the link for opening an existing DesignXplorer database file.
2. From within Simulation, click the Project tab, highlight the row representing the Simulation file on the Project Page, and click New DesignXplorer Study.

When started from Simulation, defined Parameters are automatically made available for use in DesignXplorer.

Note — Your screen should be set to a minimum resolution of 1152 x 864 pixels when using DesignXplorer.

Working with Parameters

General Information

There is a separate Parameter View for each input, derived, or response parameter. Click the parameter in the Views pane to view more detailed information about the parameter and to change the parameter properties.

All parameters shown under the Geometry node in the CAD Parameters section of the Details View in Simulation will become input parameters in DesignXplorer. These include those parameters that you specify in Simulation using a check box, as well as parameters that you choose to filter from a CAD system. From an active CAD file or DesignModeler file, you can access the Default Geometry Usage Options section of the Project Page to select filtering for Simulation and DesignXplorer.

Note — After creating a DesignXplorer VT design study, you cannot return to Simulation to adjust a DesignXplorer Design Study.

Certain parameters (e.g., sheet thickness) defined in Simulation affect how the mesh is displayed in Simulation, but will have no effect on the actual geometry. You must select such parameters via the check boxes in the Details View for them to transfer to DesignXplorer.
Parameters as Design Variables for Optimization

Upon creation of a DesignXplorer or DesignXplorer VT design study, each input parameter’s range will default to +/- 10% of the parameter’s initial value. These default values may not be valid in certain situations, so be sure to verify that the ranges are valid with respect to the input geometry and Simulation scenario.

Input Parameters

Click a parameter you wish to edit. Editing functions include:
Renaming a Parameter: All DesignXplorer parameters can be renamed.

Filtering a Parameter: Parameters may be selected or unselected in a project.

Deciding if you want to use an input parameter as a design variable (Goal Driven Optimization) or an uncertainty variable (Six Sigma Analysis): In either case, you need to specify further attributes for the input parameter, such as a range (upper and lower bounds) of values for a continuous input parameter or values for a discrete input parameter.

Creating a Derived Parameter: A derived parameter is a function of input parameters or response parameters. See Creating Derived Parameters.

Caution: Using the DOE Method, the number of design points is directly related to the number of selected input parameters. The design and analysis Workflow shows that specifying many input parameters will make heavy demands on computer time and resources, including Simulation analysis, DesignModeler geometry generation, and/or CAD system generation. Also, large input parameter ranges may lead to inaccurate results.

Note — Remote displacement is not recognized as a parameter.

Declare Design Variables

A range (upper and lower bounds) of values is required for all continuous input parameters, and values are required for discrete input parameters.

Declare Uncertainty Variables

The next step is to declare uncertainty variables, that is, to specify which parameters are uncertainty variables. To declare uncertainty variables, select Parameters in the Views pane, then set the parameter type to Uncertainty Variable from the drop-down menu.

Simulation Parameter Type:

Uncertainty Variable

Parameter Type:

Length

Distribution Type:

Gaussian

For uncertainty variables, you must specify the type of statistical distribution function used to describe its randomness as well as the parameters of the distribution function. For the distribution type, you can select one of the following:

- Uniform
• Triangular
• Gaussian
• Truncated Gaussian
• Log Normal
• Exponential
• Beta
• Weibull

For more information on the distribution types, see Section: Distribution Functions.

In the example below of a beam supporting a roof with a snow load, you could measure the snow height on both ends of the beam 30 different times. Suppose the histograms from these measurements look like the figures given below.

**Figure 1 Histograms for the Snow Height H1 and H2**
From these histograms, you can conclude that an exponential distribution is suitable to describe the scatter of the snow height data for H1 and H2. Suppose from the measured data we can evaluate that the average snow height of H1 is 100 mm and the average snow height of H2 is 200 mm. The parameter $\lambda$ can be directly derived by 1.0 divided by the mean value, which leads to $\lambda_1 = 1/100 = 0.01$ for H1, and $\lambda_1 = 1/200 = 0.005$ for H2.

**Response Parameters**

Click a response parameter you wish to edit. Just like input parameters, response parameters may be renamed and you can use them to create derived parameters.

As the name suggests, each response parameter corresponds to a response surface and they are expressed as functions of the input parameters. All output parameters in Simulation which were marked by a “P” are automatically imported into DesignXplorer. Some typical response parameters are: Equivalent Stress, Displacement, Maximum Shear Stress, etc.

Shape optimization parameters from Simulation cannot be imported into DesignXplorer because DesignXplorer has its own Goal Driven Optimization system which can optimize those parameters.

*Note* — Contact tool reaction force component table parameters and contact tool reaction moment component table parameters are not transferred from Simulation. Remote displacement is not recognized as a parameter.

**Creating Derived Parameters**

Creating new derived parameters allows you to optionally treat the upper, lower, and equality constrained goals as hard constraints in the “Goals and Candidates” page. To set the Constraint Handling (GDS) as hard constraints, select the Optimization option in the DesignXplorer Options control panel.

As the name implies, derived parameters are values created through expressions that reference existing input and/or response parameters. They cannot reference other derived parameters. Insert the derived parameter as described in the current DesignXplorer Help and illustrated below. Input the derived equation string into the text box, or click the grey buttons.
This option can be used for any optimization or robust design application. This actually works like a "constraint satisfaction" filter either on samples generated from the "Screening" or the "Advanced" runs. This is especially useful for "Screening" samples to detect the edges of solution feasibility for highly constrained nonlinear optimization problems.

The following math functions are supported:

- **cos(x)**: Computes the Cosine of x where x is a value in Radians.
- **sin(x)**: Computes the Sine of x where x is a value in Radians.
- **tan(x)**: Computes the Tangent of x where x is a value in Radians.
- **acos(x)**: Computes the ArcCosine of x, where the result will be in Radians.
- **asin(x)**: Computes the ArcSin of x, where the result will be in Radians.
- **atan(x)**: Computes the ArcTangent of x, where the result will be in Radians.
- **sinh(x)**: Computes the Hyperbolic Sine of x, where x is a value in Radians.
- **cosh(x)**: Computes the Hyperbolic Cosine of x, where x is a value in Radians.
- **tanh(x)**: Computes the Hyperbolic Tangent of x, where x is a value in Radians.
- **exp(x)**: Computes the exponential value of x, e^x.
- **log(x)**: Computes the natural logarithm of x.
- **log10(x)**: Computes the base 10 logarithm of x.
- **sqrt(x)**: Computes the square root of x.
- **fabs(x)**: Computes the absolute value of x.

Valid operators are:

- **+**: Addition
- **-**: Subtraction
- *****: Multiplication
The precedence of operations is in the following order: ^, *, /, +, -. You can use parentheses to ensure that operations are grouped properly.

Parameters are referenced by their names. You must use the parameter ID when specifying a derived parameter: “P1 + P2” is acceptable, “length + width” is not.

There is no enforced dimensional consistency and the inclusion or exclusion of the derived parameters does not affect response surface generation strategies, like Variational Technology (used in DesignXplorer VT) and DOE (used in DesignXplorer), in any way. Also, if a particular parameter, for example, P1, has a 0 value anywhere and the derived parameter involves a term 1/P1, then this will give erroneous values in the response charts.

The following restrictions are placed on derived parameters in order to maintain consistency between derived parameters and samples:

- A new derived parameter can be inserted at any time.
- If a sample set is created, derived parameters existing at the time of sample generation will be frozen. They cannot be deleted or modified unless you delete the generated sample set.
- Derived parameters will only be reflected in Robust Design if they were in the system when the Six Sigma Analysis sample set used to create Robust Design parameters was created.

### Creating Robust Design Parameters

The following applies to the creation of Robust Design parameters:

- Robust Design parameters can only be created for a single Six Sigma Analysis sample set.
- Once you have generated a Robust Design sample set, you will not be able to create any new Robust Design parameters, unless you delete all Robust Design sample sets.
- The Six Sigma Analysis samples are always based on the current values of the design variables in the system. To change the values of the design variables, change the input parameter sliders in the Chart Navigator.
- Six Sigma Analysis sample sets that are used to create Robust Design parameters cannot be deleted if a Robust Design sample set has been generated.

### Status of the Parameter

Before solving, check the Status column at the far right of the Parameter Definitions page for improper parameter states. A white check mark encircled in green means the parameter is all right and the simulation should proceed without error. A change in the range may change the status, and although you will not be prohibited from solving, your results may be inaccurate.

For more details about the values showing as the range of the parameter, see Section: Automatic Design Points.

### Creating a DesignXplorer Solution

As part of the execution phase, response surfaces are generated for each response parameter based on the data in the Automatic Samples. If the parameters, as defined in the Parameters page, are incomplete (for example, ranges not defined for all input parameters), the Run> Solve Automatic Design Points button is not available.

You can stop execution with the Stop button in the toolbar and you can restart at a later time.
During execution a small progress Execution Status bar appears in the DesignXplorer status bar. This continuously reports the status of the execution. If solution errors exist, the **Solution Error** view will be available. Click this view to examine solution error information.

In order to obtain a solution for each Design Set, DesignXplorer must transfer parameters to Simulation and any geometry package used by Simulation. One consequence of this is that if the Simulation database or the geometry file is saved after a DesignXplorer run, the parameter values in Simulation or the geometry file will reflect the parameter values of the last solved Design Set in DesignXplorer.

You can run DesignXplorer Design of Experiment (DOE) solutions on a single machine or distributed across several machines by changing the appropriate settings in Simulation. These settings are located under **Run Process on** in the Details View of a **Solution** tree object. All DesignXplorer DOE solutions will assume these settings. You can monitor the status of a solution in progress using the **Solution Status** monitor, which is accessible from the Windows system tray.

To clear a DesignXplorer database, click the button in the toolbar.

*Note* — If you want to change unit systems, start a new DesignXplorer study. Clearing the database does not take into account an update of units. If the parameters are not correct, the study will still run. However, the results may not be correct.

### Automatic Design Points

Clicking the **Run** button in the toolbar fills in the response and derived parameter values for the automatic design points. The generation of these points follows the Workflow that includes parameterized CAD Geometry, parameterized Simulation results, and parameterized DesignModeler results. The Automatic Design Points are different for the DesignXplorer VT and the DesignXplorer DOE methods.

*Note* — If material properties from Simulation are used as parameters in a DesignXplorer analysis, at the end of each DesignXplorer run, the material properties are reset to their original values. This may cause the last run of solution items in Simulation (run using the last set of parameters from DesignXplorer) to be marked as needing to be solved because the property value used in the solution is different from the original property value.

- For DesignXplorer VT there is only one Automatic Design Point, located at the initial design configuration (the values of all input parameters are equal to their initial values). Also, in DesignXplorer VT the **Run** button includes three steps. You should execute all of these steps.
  - Verify geometry parameters.
  - Process initial mesh and geometry configurations.
  - Solve in ANSYS.

- For the DesignXplorer DOE method, the locations of the automatic design points are determined according to a design-of-experiment method that is called a central composite design with a fractional factorial design. The number of generated automatic design points is calculated using the number of input parameters selected in the parameters view. DesignXplorer automatically generates the response surfaces as part of the execution process and displays them as shown below.
Design Criteria Considered in DOE

In Central Composite Design (CCD), a Rotatable (spherical) design is preferred since the prediction variance is the same for any two locations that are the same distance from the design center. However, there is other criteria to consider for an optimal design setup. Among these criteria, there are two commonly considered in setting up an optimal design using the design matrix.

1. The degree of non-orthogonality of regression terms can inflate the variance of model coefficients.
2. The position of sample points in the design can be influential based on its position with respect to others of the input variables in a subset of the entire set of observations.

An optimal CCD design should minimize both the degree of non-orthogonality of term coefficients and the opportunity of sample points having abnormal influence. In minimizing the degree of non-orthogonality, the Variation Inflation Factor (VIF) of regression terms is used. For a VIF-Optimality design, the maximum VIF of the regression terms is to be minimized, and the minimum value is 1.0. In minimizing the opportunity of influential sample points, the leverage value of each sample points is used. Leverages are the diagonal elements of the Hat matrix.
matrix, which is a function of the design matrix. For a **G-Optimality** design, the maximum leverage value of sample points is to be minimized.

For a **VIF-Optimality** design, the alpha value/level is selected such that the maximum VIF is minimum. Likewise, for a **G-Optimality** design, the alpha value/level is selected such that the maximum leverage is minimum. The rotatable design is found to be a poor design in terms of VIF- and G-Efficiencies.

For an optimal CCD, the alpha value/level is selected such that both the maximum VIF and the maximum leverage are minimum possible. For the **Auto-Defined** design, the alpha value is selected from either VIF- or G-Optimality design that meets the criteria. Since it is a multi-objective optimization problem, in many cases, there is no unique alpha value such that; both criteria reach their minimum. However, the alpha value is evaluated such that one criterion reaches minimum while another approaches minimum.

For the current **Auto-Defined** setup (except for a problem with five variables that uses G-Optimality design) all other multi-variable problems use VIF-Optimality. In some cases, despite the fact that **Auto-Defined** provides an optimal alpha meeting the criteria, an **Auto-Defined** design might not give as good of a response surface as anticipated due to the nature of physical data used for fitting in the regression process. In that case, you should try other design types that might give a better response surface approximation.

*Note* — CCD Types can be selected via the Automatic Design Points section of the Options control panel in the Tools menu.

It is a good practice to always verify some selected points on the response surface with an actual simulation evaluation to determine its validity of use for further analyses in Design for Six Sigma and/or Robust Design. In some cases, a good response surface does not mean a good representation of an underlying physics problem since the response surface is generated according to the predetermined sampling points in the design space, which sometimes misses capturing an unexpected change in some regions of the design space. In that case, you should try Extended DOE. In Extended DOE, a mini CCD is appended to a standard CCD design, where a second alpha value is added, and is set to half the alpha value of the Standard CCD. The mini CCD is set up in a way that the essences of CCD design (rotatability and symmetry) are still maintained. The appended mini CCD serves two purposes:

1. to capture a drastic change within the design space, if any.
2. to provide a better response surface fit.

The two purposes seem to be conflicting in some cases where the response surface might not be as good as that of the Standard DOE due to the limitation of a quadratic response surface in capturing a drastic change within the design space.

**Solving in DesignXplorer**

Simulation solution process settings are carried through to DesignXplorer. For more information, see Section : Solving Overview.

**Upper and Lower Locations of DOE Points**

The upper or lower levels of the DOE points depend on whether the input variable is a design variable (optimization or robust design) or an uncertainty variable (Six Sigma Analysis). Generally, a response surface will be more accurate when closer to the DOE points. Therefore, the points should be close to the areas of the input space that are critical to the effects being examined.

For example, for goal driven optimization, the DOE points should be located close to where the optimum design is determined to be. For a Six Sigma Analysis, the DOE points should be close to the area where failure is most
likely to occur. In both cases, the location of the DOE points depends upon the outcome of the analysis. Not having that knowledge at the start of the analysis, you can determine the location of the points as follows:

- For a design variable, the upper and lower levels of the DOE range coincide with the bounds specified for the input parameter.

  It often happens in optimization that the optimum point is at one end of the range specified for one or more input parameters.

- For an uncertainty variable, the upper and lower levels of the DOE range are the quantile values corresponding to a probability of 0.1% and 99.9%, respectively.

This is the standard procedure whether the input parameter follows a bounded (e.g., uniform) or unbounded (e.g., Gaussian) distribution. Because the probability that the input variable value will exactly coincide with the upper or lower bound (for a bounded distribution) is exactly zero. That is, failure can never occur when the value of the input variable is equal to the upper or lower bound. Failure typically occurs in the tails of a distribution, so the DOE points should be located there, but not at the very end of the distribution.

**DOE Theory**

For the DesignXplorer DOE method, response surfaces for all response parameters are generated in two steps:

- Solving the response parameters for all automatic design points as defined by a design-of-experiment.
- Fitting the response parameters as a function of the input parameters using regression analysis techniques.

**DOE Using a Central Composite Design**

The location of the automatic design points for the DesignXplorer DOE method is based on a central composite design. If \( N \) is the number of input parameters, then a central composite design consists of:

- One center point.
- \( 2^N \) axis point located at the \(-\alpha\) and \(+\alpha\) position on each axis of the selected input parameters.
- \( 2^{(N-1)} \) factorial points located at the -1 and +1 positions along the diagonals of the input parameter space.

The fraction \( \epsilon \) of the factorial design and the resulting number of automatic design points are given in the following table:

**Table 1 Number of Automatic Design Points as a Function of the Number of Input Parameters**

<table>
<thead>
<tr>
<th>Number of input parameters</th>
<th>Factorial number ( \epsilon )</th>
<th>Number of automatic design points</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>9</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>15</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>25</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>27</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>45</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>79</td>
</tr>
<tr>
<td>8</td>
<td>2</td>
<td>81</td>
</tr>
</tbody>
</table>
Regression Analysis to Generate Response Surfaces

Regression analysis is a statistical methodology that utilizes the relationship between two or more quantitative variables so that one dependent variable can be estimated from the other or others.

A regression analysis assumes that there are a total of $n$ sampling points and for each sampling point the corresponding values of the response parameters are known. Then the regression analysis determines the relationship between the input parameters and the response parameter based on these sample points. This relationship also depends on the chosen regression model. Typically for the regression model, a second-order polynomial is preferred. In general, this regression model is an approximation of the true input-to-output relationship and only in special cases does it yield a true and exact relationship. Once this relationship is determined, the resulting approximation of the output parameter as a function of the input variables is called the response surface.

1. **General Definitions**

The error sum of squares $SSE$ is:

$$SSE = \sum_{i=1}^{n} (y_i - \hat{y}_i)^2 = (y - \hat{y})^T (y - \hat{y})$$

(1)

where:

- $y_i =$ value of the output parameter at the $i$th sampling point
- $\hat{y}_i =$ value of the regression model at the $i$th sampling point

The regression sum of squares $SSR$ is:

$$SSR = \sum_{i=1}^{n} (\hat{y}_i - \bar{y})^2$$

(2)

where:

$$\bar{y} = \frac{1}{n} \sum_{i=1}^{n} y_i$$
The total sum of squares SST is:

\[ \text{SST} = \sum_{i=1}^{n} (y_i - \bar{y})^2 \]  

(3)

For linear regression analysis the relationship between these sums of squares is:

\[ \text{SST} = \text{SSR} + \text{SSE} \]  

(4)

2. **Linear Regression Analysis**

For a linear regression analysis, the regression model at any sampled location \( \{x\}_i \) with \( i = 1, \ldots, n \) in the \( m \)-dimensional space of the input variables can be written as:

\[ y_i = \begin{bmatrix} t_i \end{bmatrix} \{c\} + \varepsilon \]  

(5)

where:

- \( \begin{bmatrix} t_i \end{bmatrix} \) = row vector of regression terms of the response surface model at the \( i \)th sampled location
- \( \{c\} = [c_1 \ c_2 \ldots c_p]^T \) = vector of the regression parameters of the regression model
- \( p \) = total number of regression parameters. For linear regression analysis, the number of regression parameters is identical to the number of regression terms.

The regression coefficients \( \{c\} \) can be calculated from:

\[ \{c\} = ([d]^T[d])^{-1}[d]^T\{y\} \]  

(6)

3. **Forward-Stepwise-Regression**

In the forward-stepwise-regression, the individual regression terms are iteratively added to the regression model if they are found to cause a significant improvement of the regression results. In DesignXplorer, a partial F test is used to determine the significance of the individual regression terms.

4. **Improving the regression model with transformation functions**

Only in special cases can response parameters of a finite element analysis, such as displacements or stresses, be exactly described by a second-order polynomial as a function of the input parameters. Usually a second order polynomial provides only an approximation. The quality of the approximation can be significantly improved by applying a transformation function input parameter as well as the response parameters. In DesignXplorer, the Yeo-Johnson transformation is used. The parameter \( \lambda \) of the Yeo-Johnson transformation for the individual input parameters and response parameters is determined using a nonlinear optimization algorithm.

**Responses**

There is one Response Surface or Curve for every response parameter and derived parameter. Response parameters are represented in terms of the input parameters, which are treated as independent variables.

**Procedure**

These graph types are supported:
Using DesignXplorer

- Response Charts
  - X-Y Graphs
  - 2-D Contour Graphs
  - 3-D Contour Graphs
- Spider Charts
- Sensitivity Charts

Each of these means of viewing your results are explained below.

Graphs can be generated and inserted in the Design View as snapshots. These snapshots are static and become part of the Design Report. However, they also serve as links back to the response graph from which they were generated.

**Controlling the Graph with the Navigational Control**

The bottom right of the graphing window contains a navigational control. You can use this control to zoom and pan the graph. You can use the double-sided arrow at any corner of the control to zoom in or out. When you place the mouse in the center of the navigational control, you can drag the four-sided arrow to move the chart points within the chart.

The following shows the navigational control in use.

*The following is an animated GIF. Please view online if you are reading the PDF version of the help.*
Snapshots

You can snapshot the current state of any response chart, sensitivity chart, spider chart, FEA result, or tradeoff chart. Taking a snapshot will enter it into the list of snapshots available through the Snapshots view.

Snapshots are presented in reports and also provide a way of quickly accessing their related response graphs again (simply double-click the snapshot). To create a snapshot, click on the Snapshots button in the toolbar ( ). The snapshot will appear in the corresponding section of the Snapshots view, where snapshots are sorted by type: Responses, Sensitivities, and TradeOff Study. Single parameter sensitivities are included under Responses.

Snapshots Summary

Snapshots can be renamed in the Snapshots view. To rename a snapshot, you must first click the snapshot to select it and then click the title to place the insertion point in the text. Note that this is a click, pause, click action. Double-clicking will cause the snapshot to load the related response graph, as will selecting the snapshot and clicking Activate Selected Chart.

To delete a snapshot, select it and then click Delete Selected Chart.

Note — Geometry views cannot be captured as snapshots.

Input and output distribution charts cannot be captured as snapshots. They are automatically included in the report.

Imprinting

For X-Y graphs only, you can imprint multiple curves and annotations on the graph.
To create an imprint:

1. Using the input parameters check box in the chart navigator, select the curve that you wish to imprint.

![Input Parameters]

2. Type the desired annotation into the XY Curve Imprints input box.

3. Click **Imprint the current curve and notation**.

![XY Curve Imprints]

You can repeat the above procedure to add as many curves as are necessary. The result will look something like this:
Generating Custom Design Points From Response Charts

The response charts and the chart navigator can be used to explore the space of design and analysis. All response parameters and derived parameters can be examined simultaneously. Once a desirable design is located, it can be marked in the Design View by simply clicking the Insert Custom Design Point button in the toolbar. The custom design point is added to the list of custom design points.

Response Charts

The various response charts allow you to graphically view impact that parameters have on one another. There are currently three forms of charts available: response charts, spider charts, and sensitivity charts. These charts share several features:
• Access to parameters via the chart navigator.
• XY Curve Imprints — use this feature to add labels to your charts. Enter the text you want to use, then click Imprint the current curve and notation to add the label. To remove all labels, click Clear all imprints. Imprints are useful when you need to label charts to take snapshots for reports.

The various response charts allow you to see the impact that changing each input parameter has on the response parameter. Spider charts are available from the sub-options in the Responses view. Spider charts are useful for visualizing all output parameter values simultaneously.

Maximum Principal Stress Maximum

You can change the parameter values to explore other designs by moving the slider bars, or entering specific values in the accessible value boxes.

The navigational control at the bottom right in the chart window allows you to zoom in on or isolate any part of the chart. The mini-window lets you see what part of the total picture you are currently viewing.

The Section : Goodness of Fit information is also available in the DOE Method.
Goodness of Fit

- **Coefficient of Determination**: The percent of the variation of the output parameter that can be explained by the response surface regression equation. That is, coefficient of determination is the ratio of the explained variation to the total variation.

  The automatic design points used to create the response surface are likely to contain variation for each output parameter (unless all the output values are the same, which will result in a flat response surface). This variation is explained by the response surface that DesignXplorer generates. If the response surface were to pass directly through each automatic design point, the coefficient of determination would be 1 or 100%, meaning that all variation is explained.

- **Maximum Relative Residual**: The maximum distance (relatively speaking) out of all of the automatic design points from the calculated response surface to each automatic design point.

Making an X-Y Graph

In the description of making graphs below, Z is a response parameter (weight, stress, frequency, heat flux, etc.) or a derived parameter, and X1, X2, X3, etc., are input parameters (radius, pressure, length, etc.).

In the chart navigator, select one Input Parameter (for example, X2). The graph of Z versus X2 will be shown for the current values of X1, X3, etc. Adjusting the values of X1, X3, and so on, will change the shape and position of the Z-X2 graph. The chart navigator allows imprinting of curves with notations, so that very simple or elaborate sets of response curves can be created.

Also indicated in the chart navigator are the values of the remaining response and derived parameters. Thus, instantaneous design and analysis is possible, leading to the generation of additional design points.

Making a 2-D Contour Graph

A 2-D contour graph is a flat 3-D response chart. To access this feature, select the **Flat/3-D Charts** option in the **Tools** menu.

An example of a 2-D response chart is shown below (discrete input parameters).
Making a 3-D Contour Graph

In the chart navigator, select two input parameters (say, X2 and X3). A smooth 3-D contour of Z versus X2 and X3 is presented. In the Design View, the 3-D contour can be rotated by clicking and dragging the mouse. Moving the cursor in the Design View shows the values of Z, X2, X3, etc., and the other response parameters. The values of X1, X4, etc. can also be adjusted in the chart navigator, showing different contours of Z. Thus, instantaneous design and analysis is possible, leading to the generation of additional design points.

The actual appearance of the graph will vary depending on the input parameter pair you select — discrete vs. discrete, continuous vs. continuous, or discrete vs. continuous. Two examples of this are shown below.
Equivalent Stress Maximum

Response Charts
- Single Parameter Sensitivities
- Spider Charts

Input Parameters:
- DS_NumHoles@CirPattern1@Puller
- DS_Depth@Sketch1@Puller
- DS_SmallRadius@Sketch2@Puller
- DS_HoleDiaFmCir@Sketch2@Puller

Response and Derived Parameters:
- Equivalent Stress Maximum
Spider Charts

Spider charts allow you to visualize the impact that changing the input parameter(s) has on all of the output parameters simultaneously. Spider charts are available from the Responses sub-options.
You can use the slider bars to adjust the value for the input parameter(s) to visualize different designs. The parameter box at the top right in the chart window allows you to select the parameter that is in the primary (top) position.

You can change the parameter values to explore other designs by moving the slider bars, or entering specific values in the value boxes.

To set the target values, use Goal Driven Optimization (shown below); the targets are shown on the spider chart as black boxes on each parameter spoke. When a parameter hits the target, the parameter number is given a green background; if the parameter is close to the target (without exceeding it), the parameter number gets a yellow background. If the parameter exceeds or is too far short of the target value, the parameter number gets a red background.
Single Parameter Sensitivities

Sensitivity charts allow you to see the impact of the input parameters on the response and derived parameters. You access these charts from the Responses sub-options. At this level, the sensitivity charts are “Single Parameter Sensitivities.” This means that DesignXplorer calculates the change of the output based on the change of each input independently at the current value of each input parameter. The larger the change of the output, the more significant is the input parameter that was varied. As such, single parameter sensitivities are local sensitivities. Changing the input parameter values will update the sensitivities.
For discrete parameters, you can change the parameter values to explore other designs by moving the slider bars, or entering specific values in the value boxes.

**Sensitivity Chart Limitations**

- Sensitivity charts are not available for DOE design studies if ALL input parameters are discrete.
- Sensitivities are calculated for continuous parameters only.
- Changes in sensitivities due to different discrete parameter combinations are supported.

**Custom Design Points**

**Custom Design Points** are generated either from response charts or stated Design Goals. If you choose to update Simulation with CAD system or DesignModeler parameters and run an analysis in Simulation, then **Custom Design Points** also contains the designs that you generated.

If you **Generate a hard reference...** design from a custom design, the resulting design will be accessible through the **Custom Designs View**.
Viewing Geometry

To display a geometry view for any design point, select the design point in the pertinent design list, then click the Geometry sub-option.

Updating Simulation Results and Parameters

The response parameter and derived parameter values of a custom design point are only approximate if the custom design point was generated from a response view or a goal driven optimization. A reference design point will be added to the custom design list if you click the Generate a hard reference design based on the input parameter values. A custom design point can be converted into an automatic design point if the input parameters and the output parameters are calculated in Simulation, DesignModeler, and the appropriate CAD system.

The conversion takes place at the pertinent custom design point object in the Custom Design Points option in the Selection View. Click Generate a hard reference... in the Design View.

Note — DesignXplorer cannot be used if you created virtual topology automatically in Simulation and set Generate on Update to Yes. Setting this option to Yes deletes all Virtual Cell objects that were automatically generated.

Sample Generation

To generate samples for a Goal Driven Optimization ( ), Six Sigma Analysis ( ), or Robust Design ( ) study, click the button for the desired sample set type from the toolbar or select the desired type from the Insert menu. The sample generation interface opens. Use it to set the number of samples for optimization from the minimum (equal to the number of Input Parameters) to a maximum 1e6. For Goal Driven Optimization and Robust Design sample sets, you will be presented with two options, Screening and Advanced, as shown below.
For GDO or Robust Design problems containing only continuous input parameters, the Advanced option (shown above) can be used to generate samples.

The Initial Samples drop-down menu allows you to either start a completely new sample generation (Generate Initial Samples) or from an existing Screening sample.

If you wish to start from a new set, first set the Number of Initial Samples. This number should be at least 10 times the number of continuous input parameters, but not more than 300. If you want to use an existing Screening sample set, you cannot edit the Number of Initial Samples field.

Before clicking Generate, you must also set Number of Samples Per Iteration, Maximum Number of Iterations, and Maximum Allowable Pareto Percentage.

The Number of Samples Per Iteration setting must be less than or equal to the number of initial samples. This is the number of samples that are iterated and updated at every iteration.
**Maximum Number of Iterations** determines the maximum possible number of iterations the algorithm executes. If convergence happens before this number is reached, the iterations will cease. This also provides an idea of the maximum possible number of function evaluations that are needed for the full cycle, as well as the maximum possible time it may take to run the optimization. For example, the absolute maximum number of evaluations is given by: Number of Initial Samples + Number of Samples Per Iteration * (Maximum Number of Iterations - 1).

**Maximum Allowable Pareto Percentage** indicates the approximate maximum percentage of first Pareto front points (computed with respect to the **Number of Samples Per Iteration**) that you wish to compute. For example, if the **Maximum Allowable Pareto Percentage** is set to 70 and the **Number of Samples Per Iteration** is set to 200, then you can expect to have, at most, approximately 140 first Pareto front points. If the **Maximum Allowable Pareto Percentage** is too low (below 30), then there is a chance that the iterations will converge slowly. If the value is too high (above 80), then the problem may converge prematurely. The value of the **Maximum Allowable Pareto Percentage** depends on the number of output and input parameters of the problem, in addition to the nature of the design space itself. Using a value between 55 and 75 works best for most problems.

For generating Six Sigma Analysis sample sets, you only need to select the sample size and click **Generate**.

**Min/Max Search**

Performing a Min/Max search will examine the entire output parameter space to approximate the minimum and maximum of each output parameter. You can perform this search at any time.

To run a Min/Max search, click **Perform Min/Max Search** in the toolbar or **Insert** menu. The Min/Max values are automatically generated and displayed in a table in the Design View. **Min/Max Search** will appear in the Views pane.

This item will also be automatically inserted in the Views pane if you generate samples for either a Goal Driven Optimization or Six Sigma Analysis. In this case, an actual search will not be performed, but the sample set will be examined for the maximum and minimum values for each parameter. To indicate this lack, there will be an asterisk (*) next to **Min/Max Search** in the Views pane. There will also be a message at the bottom of the Min/Max search page in the Design View stating that the results are approximated.

If you insert a derived parameter, you must perform a new Min/Max search, because you cannot assume that the existing values in the search are sufficient to generate accurate values for the derived parameter’s minimum and maximum. When a derived parameter is inserted, a message will be displayed at the bottom of the Min/Max search page in the Design View stating that the search results may not be accurate for the new parameter values.

If you click the blue “Search” in either of the above warning messages, a Min/Max search will be performed.
Min/Max search values are always approximated for Six Sigma Analysis output variables. These variables are inserted from the Six Sigma Analysis view. When an output variable is inserted, a message will be displayed at the bottom of the Min/Max search page in the Design View stating that the search results may not be valid for Six Sigma Analysis output parameters and that Robust Design samples must be generated to approximate Min/Max values. If you click the blue “here” in this warning message, you will be taken to the Robust Design page. For more information on Six Sigma Analysis output variables, see Section : Parameterizing Six Sigma Analysis Results.

Using Goal Driven Optimization

This section contains information about running a Goal Driven Optimization analysis. For more information, see Goal Driven Optimization.

- Section : Defining Design Goals
- Section : Creating New Design Points From Goals
- Section : Sensitivities
- Section : TradeOff Study

Defining Design Goals

By selecting Goal Driven Optimization in the Views pane and its page in the Design View, you can state a series of design goals, which will be used to generate optimized designs.

The optimization approach used in the DesignXplorer departs in many ways from traditional optimization techniques. Many goals are allowed and can be assigned to each Response Parameter and each Derived Parameter. Goals may be weighed in terms of importance.

This departure from traditional optimization also accounts for preferences for the input parameters, which are independent variables, allowing flexibility in obtaining the desired design configuration.

The following tables show the goals that may be applied to input parameters, and to response parameters and derived parameters. For purposes of space, response parameters and derived parameters are collectively called output parameters.

### Table 2 Goals and Their Meanings for Continuous Input Parameters

<table>
<thead>
<tr>
<th>Goal</th>
<th>Meaning</th>
<th>Mathematical Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Preference</td>
<td>Keep the input parameter within its upper and lower bounds</td>
<td>$X_{\text{Lower}} &lt;= X &lt;= X_{\text{Upper}}$</td>
</tr>
<tr>
<td>Near Lower Bound</td>
<td>Minimize the input parameter within its range</td>
<td>$X \rightarrow X_{\text{Lower}}$</td>
</tr>
<tr>
<td>Near Midpoint</td>
<td>Attain the average value of the input parameter within its range</td>
<td>$X \rightarrow \frac{1}{2} (X_{\text{Lower}} + X_{\text{Upper}})$</td>
</tr>
<tr>
<td>Near Upper Bound</td>
<td>Maximize the input parameter within its range</td>
<td>$X \rightarrow X_{\text{Upper}}$</td>
</tr>
</tbody>
</table>

(X = an input parameter, $X_{\text{Lower}}$ = lower limit, $X_{\text{Upper}}$ = Upper Limit)

### Table 3 Goals and Their Meanings for Discrete Input Parameters

<table>
<thead>
<tr>
<th>Goal</th>
<th>Meaning</th>
<th>Mathematical Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Preference</td>
<td>Uses the full discrete range allowed for the parameter</td>
<td>$X_{\text{Lower}} &lt;= X &lt;= X_{\text{Upper}}$</td>
</tr>
<tr>
<td>Goal</td>
<td>Meaning</td>
<td>Mathematical Meaning</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Near Target</td>
<td>Set the goal to in-range values close to the target value</td>
<td>( X \rightarrow X_{\text{Target}} )</td>
</tr>
<tr>
<td>Less Than Target</td>
<td>Set the goal to in-range values below the target value</td>
<td>( X \leq X_{\text{Target}} )</td>
</tr>
<tr>
<td>Greater Than Target</td>
<td>Set the goal to in-range values above the target value</td>
<td>( X \geq X_{\text{Target}} )</td>
</tr>
</tbody>
</table>

\( (X = \text{an input parameter}, X_{\text{Lower}} = \text{lower limit}, X_{\text{Upper}} = \text{Upper Limit}, X_{\text{Target}} = \text{Target Value}) \)

**Table 4 Goals and Their Meanings for Response and Derived Parameters (Y = Output Parameters)**

<table>
<thead>
<tr>
<th>Goal</th>
<th>Meaning</th>
<th>Mathematical Meaning</th>
<th>GDO Treatment</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Preference</td>
<td>No goals are specified</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Minimum Possible</td>
<td>Achieve the lowest possible value for the output parameter</td>
<td>Minimize Y</td>
<td>Goal (TradeOff always on)</td>
</tr>
<tr>
<td>Maximum Possible</td>
<td>Achieve the highest possible value for the output parameter</td>
<td>Maximize Y</td>
<td>Goal (TradeOff always on)</td>
</tr>
<tr>
<td>Less than Target</td>
<td>If a Target Value is specified, then achieve an output parameter value that is less than the Target Value</td>
<td>( Y \leq Y_{\text{Target}} )</td>
<td>Inequality constraint (TradeOff always off)</td>
</tr>
<tr>
<td>Greater than Target</td>
<td>If a Target Value is specified, then achieve an output parameter value that is greater than the Target Value</td>
<td>( Y \geq Y_{\text{Target}} )</td>
<td>Inequality constraint (TradeOff always off)</td>
</tr>
<tr>
<td>Near Target</td>
<td>If a Target Value is specified, then achieve an output parameter value that is close to the Target Value</td>
<td>( Y \rightarrow Y_{\text{Target}} )</td>
<td>Goal (TradeOff on) or equality constraint (Tradeoff off)</td>
</tr>
</tbody>
</table>

\( (Y = \text{output parameter}, Y_{\text{Target}} = \text{Target Value}) \)

**Creating New Design Points From Goals**

Goals are specified at the **Goal Driven Optimization** node in the Views pane. Once the goals are stated (**Input Parameter Goals**) and generated (**Candidate Designs**), several candidate designs are listed and may be selected and added to the Outline as an automatic design set.

Specifying more **Sample Designs** directly increases the time required to generate optimized designs but also produces more accurate **Candidate Designs**.
Sensitivities

To perform a global sensitivity study, select Goal Driven Optimization from the Views pane, then select Sensitivities from the View Sub-options. Global sensitivities quantify the concurrent influence of all the input parameters on an input parameter.

Next, generate samples.

By checking the box next to a parameter in Response and Derived Parameters, you can see the global sensitivities of the parameter with respect to the input parameters. The sensitivities are displayed in both bar chart and pie chart representations.
TradeOff Study

To perform a tradeoff study, select Goal Driven Optimization from the Views pane, then generate samples as done in Section: Sensitivities. After the samples have been created, the Goals & Candidates page will display in the right pane.

On this page, you can change the Target and Desired Value settings for response parameters. You can also change the Target and Importance settings for input parameters, as these values do not affect the tradeoff study. Definitions for response parameter goals are given in the table below.

For the meaning of each goal, see Section: Defining Design Goals.

For further information on results, see Section: Postprocessing.

You can insert a custom design point from the TradeOff charts. Select a point by clicking on it, then click in the toolbar. The custom design point will be inserted in the Summary section of Custom Design Points.

You can also insert a custom sample set. Select more than one point in the graph, then click . You can select points by clicking on them or by adjusting the slider to display fewer Pareto front points. If you use the slider method, the points will not be highlighted. The new sample set will be inserted in the list of sample sets.
In order to perform a TradeOff Study, at least one output parameter should have a Desired Value of anything other than No Preference. Importance settings do not affect TradeOff studies. Input parameter settings do not affect the studies, either.

**Using Six Sigma Analysis**

This section contains information about running a Six Sigma Analysis. For more information, see Six Sigma Analysis.

- Section : Performing a Six Sigma Analysis
- Section : Using Statistical Postprocessing
- Section : Statistical Measures
- Section : Parameterizing Six Sigma Analysis Results

**Performing a Six Sigma Analysis**

After you have specified the input parameters as uncertainty variables, assigned distribution functions to them as described in Section : Declare Uncertainty Variables, and specified the distribution attributes, then the procedure for a Six Sigma Analysis is:

- Run the automatic design by clicking the Run — Solve Automatic Design Points button in the toolbar. After the automatic design points are finished solving, the Views pane will include Six Sigma Analysis.
- Click Six Sigma Analysis in the Views pane.
- Generate samples.
- If you have created multiple sample sets this way, you will need to select the one you want to use for postprocessing.

**Using Statistical Postprocessing**

In the Six Sigma Analysis view you can choose to review results Section : Tables, Section : Charts, or Section : Sensitivities.

**Tables**

If you select the Tables sub-option, you are able to view the probability and inverse probability tables of each variable, both of which you can modify by adding or deleting values. To add a value to the table, type the desired value into the text box below the table and click on Insert New Parameter Value. A row with the value you entered will be added to the table. To add a new value to the inverse probability table, type the desired value into the text box below the table and click on the appropriate choice, Insert New Probability Value or Insert New Sigma Level. To delete a row from either table, select the check box next to the row and click on Delete Selected Row(s). The row will be deleted from the table.

*Note — You cannot add a value to a probability table that falls outside the range of the table. Values you add must be greater than the minimum and less than the maximum values specified for a variable.*
For information on parameterizing statistics in the Parameter Statistics table, see Section: Parameterizing Six Sigma Analysis Results.

**Charts**

If you select the **Charts** sub-option, you can review the statistical results of the analysis. In the right pane you can select a variable from a drop-down menu. The results of a Six Sigma Analysis are visualized using histogram plots and cumulative distribution function plots. For information on parameterizing statistics in the Parameter Statistics table, see Section: Parameterizing Six Sigma Analysis Results.

A drop-down menu lets you choose which way the probability axis will be displayed. If the sampling data includes only positive values, the choices in the drop-down will be Empirical Distribution Function, Normal Probability Plot, Log-Normal Probability Plot, Exponential Probability Plot, and Weibull Probability Plot. If the sampling data includes negative values, then the choices will be limited to Empirical Distribution Function, Normal Probability Plot, and Exponential Probability Plot.

**CDF Plot Type**

**Cumulative Distribution Function**

These plot types differ in how they plot the sample data on the x-axis and the probability data on the y-axis. The table below explains the plot types, with the following assumptions: If the sample data is sorted in ascending order, $x_i$ denotes the $i$th sample value, $F_i$ is the corresponding probability value (as calculated by Equation 15), and $\Phi^{-1}(F_i)$ is the inverse cumulative distribution function of the standard normal distribution.
### Interpretation of the Plot

<table>
<thead>
<tr>
<th>Plot Type</th>
<th>Plotted on X-Axis</th>
<th>Plotted on Y-Axis</th>
<th>Interpretation of the Plot</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empirical Distribution</td>
<td>$x_i$</td>
<td>$F_i$</td>
<td>If the resulting graph resembles a straight line, then it can be concluded that the underlying data probably follows a uniform distribution.</td>
</tr>
<tr>
<td>Normal Probability</td>
<td>$x_i$</td>
<td>$\Phi^{-1}(F_i)$</td>
<td>If the resulting graph resembles a straight line, then it can be concluded that the underlying data probably follows a normal distribution.</td>
</tr>
<tr>
<td>Log-Normal Probability</td>
<td>$\ln(x_i)$</td>
<td>$\Phi^{-1}(F_i)$</td>
<td>If the resulting graph resembles a straight line, then it can be concluded that the underlying data probably follows a log-normal distribution.</td>
</tr>
<tr>
<td>Exponential Probability</td>
<td>$x_i$</td>
<td>$\ln\left(\frac{1}{1-F_i}\right)$</td>
<td>If the resulting graph resembles a straight line, then it can be concluded that the underlying data probably follows an exponential distribution.</td>
</tr>
<tr>
<td>Weibull Probability</td>
<td>$\ln(x_i)$</td>
<td>$\ln\left(\ln\left(\frac{1}{1-F_i}\right)\right)$</td>
<td>If the resulting graph resembles a straight line, then it can be concluded that the underlying data probably follows a Weibull distribution.</td>
</tr>
</tbody>
</table>

### Sensitivities

If you select the **Sensitivities** sub-option, you can review the sensitivities derived from the samples generated for the Six Sigma Analysis. The Six Sigma Analysis sensitivities are global, not Section : Single Parameter Sensitivities. In the left pane, you can choose the response or derived parameter for which you want to review sensitivities.

The sensitivity charts appear in the right pane. The global sensitivities displayed there distinguish between significant and insignificant input parameters. If all input parameters are significant, all parameters will be displayed. If not, the sensitivity plot will show only the significant parameters and the insignificant parameters will be listed below the sensitivity plot. For details on how the distinction between significant and insignificant is made, see Section : Theory.
Statistical Measures

You can parameterize Shannon’s entropy and Taguchi’s signal-to-noise ratios for a robust design study. To do so, perform a Section : Using Six Sigma Analysis analysis, then select Six Sigma Analysis from the Views pane and Charts from the View Sub-options. From there you can select one of the following features to be parameterized/optimized.
• Mean
• Standard Deviation
• Skewness
• Kurtosis
• Shannon Entropy (Complexity)
• Signal-Noise Ratio (Smaller is Better)
• Signal-Noise Ratio (Nominal is Best)
• Signal-Noise Ratio (Larger is Better)
• Minimum
• Maximum

Note — The three signal-to-noise ratios are mutually exclusive. Therefore, for a given parameter, only one of them can be parameterized.

Caution: The three signal-to-noise ratios inherently tie the goal of variation reduction together with the overall optimization problem, which makes them insufficient and inflexible for use in robust design.

Parameterizing Six Sigma Analysis Results

You can parameterize variable statistics in Charts and Tables. To do so, click the box next to the statistic you want to parameterize. A P will appear in the box (as shown below) and Robust Design will appear below Six Sigma Analysis in the Views pane. If you parameterize a statistical result on the Tables page, it will display as a parameter on the Charts page, and vice versa.

Parameter Statistics

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mean</td>
<td>10.0551</td>
</tr>
<tr>
<td>Standard Deviation</td>
<td>8.468</td>
</tr>
<tr>
<td>Skewness</td>
<td>3.2398e-02</td>
</tr>
<tr>
<td>Kurtosis</td>
<td>3.0571e-03</td>
</tr>
<tr>
<td>Shannon Entropy (Complexity)</td>
<td>5.3482</td>
</tr>
<tr>
<td>Signal-Noise Ratio (Smaller is Better)</td>
<td>-60.011</td>
</tr>
<tr>
<td>Signal-Noise Ratio (Nominal is Best)</td>
<td>25.937</td>
</tr>
<tr>
<td>Signal-Noise Ratio (Larger is Better)</td>
<td>69.967</td>
</tr>
<tr>
<td>Minimum</td>
<td>874.81</td>
</tr>
<tr>
<td>Maximum</td>
<td>1140.3</td>
</tr>
</tbody>
</table>

Note — You may only parameterize Six Sigma Analysis results in one sample set. Otherwise there might be contradictions, if you happened to select the mean value of a parameter from one sample set and tried to maximize that under Robust Design while minimizing the mean value of the very same parameter from another sample set.

On the Tables page, you can also parameterize values from the probability tables (as shown below).
Using DesignXplorer

**Probability Table**

<table>
<thead>
<tr>
<th>X</th>
<th>v</th>
<th>Probability</th>
<th>Sigma-Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>874.81</td>
<td>6.9075e-003</td>
<td>-2.462</td>
<td></td>
</tr>
<tr>
<td>891.4</td>
<td>2.1052e-002</td>
<td>-2.0325</td>
<td></td>
</tr>
<tr>
<td>908.0</td>
<td>3.633e-002</td>
<td>-1.7698</td>
<td></td>
</tr>
<tr>
<td>924.59</td>
<td>6.8358e-002</td>
<td>-1.4881</td>
<td></td>
</tr>
<tr>
<td>941.18</td>
<td>0.12135</td>
<td>-1.1683</td>
<td></td>
</tr>
<tr>
<td>957.76</td>
<td>0.2002</td>
<td>-0.84092</td>
<td></td>
</tr>
<tr>
<td>974.37</td>
<td>0.30304</td>
<td>-0.51669</td>
<td></td>
</tr>
<tr>
<td>990.96</td>
<td>0.42428</td>
<td>-0.19097</td>
<td></td>
</tr>
<tr>
<td>1007.6</td>
<td>0.56459</td>
<td>0.16261</td>
<td></td>
</tr>
<tr>
<td>1024.2</td>
<td>0.68407</td>
<td>0.47911</td>
<td></td>
</tr>
<tr>
<td>1040.7</td>
<td>0.79178</td>
<td>0.81262</td>
<td></td>
</tr>
<tr>
<td>1057.3</td>
<td>0.87129</td>
<td>1.1325</td>
<td></td>
</tr>
<tr>
<td>1073.9</td>
<td>0.92417</td>
<td>1.4337</td>
<td></td>
</tr>
<tr>
<td>1090.5</td>
<td>0.96374</td>
<td>1.7969</td>
<td></td>
</tr>
<tr>
<td>1107.1</td>
<td>0.98129</td>
<td>2.0812</td>
<td></td>
</tr>
<tr>
<td>1123.7</td>
<td>0.98785</td>
<td>2.2524</td>
<td></td>
</tr>
<tr>
<td>1140.3</td>
<td>0.99309</td>
<td>2.462</td>
<td></td>
</tr>
</tbody>
</table>

*Note* — You may only parameterize either the probability or sigma-level value, not both, for each row in the probability tables.

**Using Robust Design**

This section contains information about running a Robust Design analysis. For more information, see Robust Design.

- Section: Defining Design Goals
- Section: Creating New Design Points From Goals

**Defining Design Goals**

A Robust Design analysis is somewhat similar to Section: Using Goal Driven Optimization. When selected, you are presented with the same options except that only the Six Sigma Analysis parameters are listed as output parameters.

To run a Robust Design analysis, you must have parameterized one or more of the statistical results of a Six Sigma Analysis. Until you do so, the Robust Design node will not appear in the Views pane.

For information on specifying goals and candidates, see Section: Defining Design Goals.
Goals and Candidate Designs

- A Goals Driven Study uses a calculated set of sample design points. Click the "Generate Sample Designs" button to generate these points.

Input Parameter Goals
Click rows in this table to assign design goals to input parameters.

<table>
<thead>
<tr>
<th>Name</th>
<th>Lower Bound</th>
<th>Upper Bound</th>
<th>Target</th>
<th>Desired Value</th>
<th>Importance</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>4.5</td>
<td>5.5</td>
<td>No Preference</td>
<td>Default</td>
<td></td>
</tr>
<tr>
<td>l</td>
<td>90.</td>
<td>110.</td>
<td>No Preference</td>
<td>Default</td>
<td></td>
</tr>
<tr>
<td>p</td>
<td>900.</td>
<td>1100.</td>
<td>No Preference</td>
<td>Default</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>1.8e+005</td>
<td>2.2e+005</td>
<td>No Preference</td>
<td>Default</td>
<td></td>
</tr>
</tbody>
</table>

Response Parameter Goals
Click rows in this table to assign design goals to response parameters. Defining a target value is optional.

<table>
<thead>
<tr>
<th>Name</th>
<th>Target</th>
<th>Desired Value</th>
<th>Importance</th>
<th>TradeOff</th>
</tr>
</thead>
<tbody>
<tr>
<td>v Mean (Sample Set 1)</td>
<td>-</td>
<td>No Preference</td>
<td>Default</td>
<td>-</td>
</tr>
</tbody>
</table>

Candidate Designs

- Generate or update candidate designs based on the current goals.

About Parameter Ratings

Creating New Design Points From Goals
You can create new design points using the Goals & Candidates page. For more information, see Section: Defining Design Goals.

Errors

Topology Errors
Topology Errors show the topology changes that have caused DesignXplorer VT to cut parameter ranges or fail to generate a solution.

General Errors
General errors are not selectable.

Connectivity
Connectivity denotes a connection between two entities. If connectivity has been removed, the entities are no longer touching.
Report

To generate a design report, click **Report** in the Views pane. The Design Report shows summaries of all Parameters, Design Sets, and Response Charts saved as snapshots. You can then use **Publish Report** to write the report as an HTML file in a designated directory.

**APDL Input files in DesignXplorer**

DesignXplorer supports the parameters associated with ANSYS Parametric Design Language (APDL). This means that ANSYS APDL input files may take full advantage of the DesignXplorer capability, including the creating of design and analysis graphs, sensitivities, and optimization. The process for this using DesignXplorer with APDL file is as follows:

1. Open the ANSYS Workbench and **Create a new project** and then open the Project Page. Generally the APDL input file will be in the project folder on your hard drive.
2. On the Project Page, click the **Link to an ANSYS APDL input file**.
3. In the **Open** dialog box, open the appropriate APDL input file (filename.inp).
4. On the Project Page click **Edit mapping of APDL parameters** under **ANSYS APDL Tasks**.

This action will open an APDL filtering page for your project.
5. Identify the appropriate Input Parameters and Response Parameters from the APDL Parameters list and add them to the respective DesignXplorer lists (you can use standard Windows functionality for multiple selecting using the [Shift] and [Ctrl] keys). Also define the initial values of the Input Parameters.

6. Return to the Project Page. DesignXplorer automatically creates an XML file containing the input and response parameters you chose. The file is saved in the project directory. Click Create a new DesignXplorer study under ANSYS APDL Tasks. At this point, you will enter the DesignXplorer application.

Please note that for steps 4 and 5, DesignXplorer will parse your APDL input file and search for APDL parameter names. The parsing process does not include APDL macros that are called from your input file. This means that APDL parameters defined in those APDL macros will not be included in the APDL filtering page. However, you can manually add APDL parameters that are not automatically detected by filling in the name and value of the parameters in the Input Parameter or Response Parameter table of the APDL list.

The parser collects APDL Parameters from the following commands:

- ABC = 10
- *SET,ABC(1,2,3), 12.3,10.3, 1
- *GET,MAX_STRESS,NODE,STR_POINT,S,EQV
- *VGET,MAX_STRESS(1,2,3),NODE,1,S,X

There are some cases where an APDL parameter will not show up in your APDL Parameters list. These are:

- The case where APDL Parameters are used as part of the parameter assignment. For example: ABC(I,J)=10.345.
- If the APDL parameter is a character value or a character array. For example: ABC='ANSYS'.

The parser will also attempt to determine an Initial Value for the Input Parameters list. The parsing process cannot determine the initial value if a parameter is defined by an APDL function and/or by using another parameter on the right hand side of the equal sign. The parsing process can only determine the initial value if the
Input Parameter is directly defined by “Name=value.” If the parsing process was able to determine the initial value, then this value will be used in the Input Parameters list. If the parsing process was not able to determine the initial value, then a value of 1.0 will be used.

If you change the input file and then click the APDL Parameters tab, then the values in the APDL Parameters list do not update until you click the Refresh button.

The following error message appears if you change either the XML file (created at step 6 above) or the APDL input file:

**Input file has been changed since you last exposed the input and response parameters to DesignXplorer. Do you want to populate the old input and response parameters?**

- Click Yes if you want to use the old XML file to populate the Input Parameters and Response Parameters lists.
- Click No to remove the selections that you previously had in the Input Parameters and Response Parameters lists and reparse the file.

### Third Party Plug-Ins and Generic Process Sequencing

![Diagram of process sequence](image)

*Note* — For more information on Extensible Markup Language (XML), please read Understanding XML.

A mechanism is in place which allows DesignXplorer to interact with executables and codes that are not native to the WorkBench environment. This is referred to as the DesignXplorer 3rd Party Plug-In. Any executable that supports a command line that can specify a text based input file and output file can be used by DesignXplorer in a DOE optimization. Alternatively, any scriptable (ActiveX) objects can be accessed by wrapping a simple script file around the object. Both of these methods of interaction are detailed below.

In order to accomplish generic interaction between process level components, an XML instruction language for DesignXplorer has been developed. Using this language, it is possible to chain a sequence of actions (each may occur in a separate executable or code component) together to define a full process. This process will be used to define a single DOE point which will be treated just as a standard Simulation design point in a traditional DesignXplorer DOE study. As a result of this, all optimization (Six Sigma Analysis, Robust Design, Goal Driven Optimization, GA, NLPQL, and Monte-Carlo sampling) in DesignXplorer is compatible with a user defined process.
XML Instructions

All XML instructions have an outer layer which must be defined for any process. This outer layer includes a working directory (the location is assumed to be central for all project files) as well as information that is stored internally in DesignXplorer for future reference.

Note — All text is case sensitive in XML instructions.

Global Instruction Node

```
<Instructions Process="[Process Name]" Type="[Method Type]"
WorkingDirectory="[Directory Name]">
</Instructions>
```

1. **[Process Name]** — Will be used internally by DesignXplorer. This can be any string which contains any character in the Unicode character set.

2. **[Method Type]** — The method type can be the following value.

   - **DX_DOE** — Will perform the traditional DOE looping with the defined process and fit response surfaces based on the results of the analysis.

3. **[Directory Name]** — The path of the working directory, with or without the trailing slash.

Inside the global `<Instructions>` XML node, the actual process sequence will be defined.

Stage Node

The first part of the process sequence is a stage definition, which will simply specify the text that is displayed in the DesignXplorer toolbar. The stage definition has some advanced functionality which can be used to set up a multi-stage analysis, however, for process sequencing it is only necessary to have a single item as a child of the main stage node.

```
<Instruction Type="Global" Category="Stages">
<Stage Flags="[Value]" Property="" PlugIn=""[PlugIn]">[User Text]</Stage>
</Instruction>
```

1. **[User Text]** — The text which will be displayed in the DesignXplorer Run menu.

2. **[Value]** — Any numerical value greater than 20,000. Values 0 through 20,000 are reserved for DesignXplorer. This is a simple ID that will be used internally by DesignXplorer, or in Conditional Instructions (explained below.)

Initialization Instructions

Following the stage node will be a list of initialization instructions that tell DesignXplorer which plug-ins will be used for the analysis. For third party integration, the “Generic” plug-in will be used.

```
<Instruction Type="Init" PlugIn="Generic">
<Name>[Plug-In Name]</Name>
<ExePath>[Executable Path]</ExePath>
</Instruction>
```

DesignXplorer Help . © SAS IP, Inc.
1. **[Plug-In Name]** — The user defined name of the generic Plug-In. This name must be unique throughout the instruction file. Basically, this just defines a way for DesignXplorer to identify this instance of the Generic Plug-In, because it is possible to have several instances (several third party applications or codes) of the third party Plug-In in the process sequence.

2. **[Executable Path]** — The location of the executable file that the 3rd party Plug-In will interact with. This can be either the full path, or the relative path of the executable with respect to the Working Directory for the instruction file.

3. **[Node Name]** — A name given to the XML node that defines the parsing information for a single parameter. This name does not have to be unique, but must only adhere to the naming rules for XML nodes (no spaces, special characters, etc.)

4. **[Parameter Name]** — A unique name that represents a single parameter in DesignXplorer. This is the name that will be used to identify the parameter throughout the UI.

5. **[Type]** — The general type of the parameter. Must be one of two possible values.
   a. "Input": Signifies that the parameter will be treated as an input parameter, exactly as input parameters are handled in DesignXplorer.
   b. "Output": Signifies that the parameter will be treated as an output or response parameter in DesignXplorer. Note: When chaining generic Plug-Ins together, each instance of the generic Plug-In can contain input and output parameters.

6. **[Rule Name]** — A name given to the XML node that represents a single parsing rule for the parameter defined by the rule's parent node. This name must not be unique, but only adhere to the naming rules for XML nodes (no spaces, special characters, etc.) Multiple rules can (and in most cases must) be defined for each parameter. The only restriction is that only one rule of each type (detailed below) can exist for each parameter.

7. **[Rule Type]** — The type of the rule defined. This can be one of the following values.
   a. "File": The 'file' rule defines the text file that contains the parameter value. This file can be the full path to the file, or the relative path to the file with respect to the Working Directory. Concerning "Input" type parameters, the file MUST exist before initializing DesignXplorer.
   b. "StartLine": The line number in the text file that DesignXplorer will begin parsing. For instance, if the first 500 lines of a file contain only comments, begin parsing the file at line 501 to avoid wasting system resources.
   c. "PreString": The text that immediately precedes the actual parameter value in the file. For instance, if the file defines a parameter as "Cf = 12.555" the "PreString" for the parameter would be "Cf =". This text does not need to include any white space immediately preceding the parameter value.
   d. "DataType": Describes the type of data that represents the parameter. Must be one of the following values.
      i. **float**: The value of the parameter is a floating point (decimal) number. This is used for continuous variables.
      ii. **long**: The value of the parameter is an integer. This is used for discrete variables (number of holes, number of ribs, etc.) DesignXplorer will physically interpret these as Discrete Parameters.
e. **“Precision”**: The number of significant digits that will be respected when reading from or writing to the text file.

f. **“SkipOccurrences”**: The number of occurrences of “PreString” to skip before parsing begins.

8. **[Value]** — The value of the rule. No quotes are needed to delimit this value, as per the XML parsing rules. For instance, a “Precision” node would look like

   `<Rule Type="Precision">8</Rule>`

   where “8” is the [Value] for the rule, signifying that parameters should be read and written from the input/output text files with 8 significant digits.

**Processing Instructions**

After each Plug-In has been initialized, DesignXplorer can begin a processing phase with each Plug-In. The processing phase defines the instructions necessary to fully run one complete design from start to finish. This means, that for a DesignXplorer DOE run, the processing instructions will be executed several times by DesignXplorer.

Since XML is processed sequentially, DesignXplorer will process each instruction sequentially. This does not mean that a simple linear chain of Plug-Ins is the only type of process chain that is supported. For instance, all of the following are acceptable chains:

![Diagram of processing instructions]

In any case, the instructions for multiple Plug-Ins will not be processed in parallel. For instance, in the second example, the instructions for 'Exe 1' will be processed, then the instructions for 'Exe 2' will be processed, and then 'Exe 3' will use the output of both 'Exe 1' and 'Exe 2' as inputs for its processing phase.

The processing instruction XML is as follows:
1. **[Plug-In Name]** — The user defined name of the generic Plug-In, which was defined in an existing 'Initialization' instruction. The processing instruction will fail if the Plug-In is not already initialized.

2. **[Argument Node Name]** — A name given to the XML node that defines a command line argument for the executable specified in a Plug-In initialization node. This node must not be unique, but only adhere to the rules for XML node naming (no space, special characters, etc.) There will probably be multiple rules defining multiple arguments, or a single rule defining all command line arguments.

3. **[Argument Value]** — A string representing the argument value. Any file paths in these argument lists must be a full path to the file. The working directory will not be respected in the argument list. For instance if you have a simple executable which handles a qualifier, an input file, and a location for an output file you could specify the instructions in either of the following ways.

```
<Instruction Type="Processing" PlugIn="Generic">
  <Name>[Plug-In Name]</Name>
  <Argument>-i</Argument>
  <Argument>C:\Temp\myFile.input</Argument>
  <Argument>-o</Argument>
  <Argument>C:\Temp\myFile.output</Argument>
</Instruction>
```

OR

```
<Instruction Type="Processing" PlugIn="Generic">
  <Name>[Plug-In Name]</Name>
  <Argument>-i C:\Temp\myFile.input -o C:\Temp\myFile.output</Argument>
</Instruction>
```

### Conditional Instructions

Conditional instructions can be defined to execute processing instructions when a criterion is satisfied. From an XML standpoint, a conditional instruction is an XML node whose children will not be processed unless the criterion is satisfied. These instructions can have either a global or a process specific context.

```
<IF Property="[Property Name]" Location="[File Name]" [Comparison]="[Value]">
  [Instructions]
</IF>
```

1. **[Property Name]** — The name of the property that will determine the criterion for the conditional instruction. The method must return only a single value.

2. **[File Name]** — Optional. If this does not exist, the instruction will be processed as a global instruction. Currently only one property is supported at the global level, "ProcessingFlags", which determines the current stage of execution. Otherwise, this value is the full path of the JavaScript file that contains the property. This must be a path to a valid JavaScript file. If [File Name] has a value of "localscript" the property must either be physically appended to the existing DesignXplorer scripts or added to the config.xml file for DesignXplorer as a JavaScript file. Using "localscript" will require a Workbench customization license. In either case, the script file will automatically contain a global variable ‘WB’ which is the current instance of Workbench. This will allow the script to interact with Workbench just as a traditional Workbench macro can.

3. **[Comparison]** — The comparison type. This property is optional. If it does not exist the property is processed as a Boolean true/false property. Other values for this parameter are as follows.

   a. **EQUALTO**: Conditional Instruction processes the child instructions if [Property Name] evaluates to [Value].
b. **NOTEQUALTO**: Conditional Instruction processes the child instructions if \([\text{Property Name}]\) does not evaluate to \([\text{Value}]\).

c. **LESSTHAN**: Conditional Instruction processes the child instructions if \([\text{Property Name}]\) evaluates to a value less than \([\text{Value}]\).

d. **GREATERTHAN**: Conditional Instruction processes the child instructions if \([\text{Property Name}]\) evaluates to a value greater than \([\text{Value}]\).

e. **LESSTHANEQUALTO**: Conditional Instruction processes the child instructions if \([\text{Property Name}]\) evaluates to a value less than or equal to \([\text{Value}]\).

f. **GREATERTHANEQUALTO**: Conditional Instruction processes the child instructions if \([\text{Property Name}]\) evaluates to a value greater than or equal to \([\text{Value}]\).

4. **[Value]**: The value that will be used in the specified comparison.

5. **[Instructions]**: The processing instructions that will be processed if the property or comparison evaluates to “true”.

**Stop Instructions**

If a Stop Instruction is processed, all processing will immediately stop and control of the DesignXplorer User Interface will return to the user. This is useful for trapping errors or processing multiple phases of execution.

```xml
<Instruction Type="Global" Category="Stop">
</Instruction>
```

**Advanced Stage Instructions**

As mentioned in the short section above, stage instructions have some advanced functionality which can be used to separate a run into several phases. DesignXplorer VT for instance, has three separate execution phases. This is accomplished via property callbacks and Stop Instructions.

```xml
<Instruction Type="Global" Category="Stages">
<Stage Flags="[Value]" Property="[Property Name]" Location="[Location]">[User Text]
</Stage>
</Instruction>
```

1. **[Property Name]** — The property that signifies whether or not the phase of processing has been completed. If this property evaluates to ‘true’ then the item in the DesignXplorer run menu will be disabled. Multiple stages are supported. Usually, a property validated stage instruction will be accompanied by a conditional instruction and a stop instruction. For instance, if two phases are needed this can be accomplished with the following XML. Here, the first stage is given Flags of 1001. The item in the DesignXplorer toolbar will be finished when the Stage1Done function in C:\File.js evaluates to true. Additionally, after some processing, DesignXplorer checks to see what phase is currently running (which item the user clicked in the DesignXplorer run menu.) DesignXplorer will stop execution if the ProcessingFlags (from the Stage node) are equal to “1001”.

```xml
<Instruction Type="Global" Category="Stages">
<Stage Flags="1001" Property="Stage1Done" Location="C:\File.js">Stage 1<Stage>
<Stage Flags="1002" Property="Stage2Done" Location="C:\File.js">Stage 2<Stage>
</Instruction>
```

```xml
[Initialization Instructions]

[Processing Instructions]

<IF Property="ProcessingFlags" EQUALTO="1001">
<Instruction Type="Global" Category="Stop">
</Instruction>
</IF> [Processing Instructions]
```
2. **[Location]** — The location of the script file, just as in conditional instructions. This can also use the value of “localscript”.

3. **[Value]** and **[User Text]** — Described in the previous section “Stage Node”.

### Running DesignXplorer with Custom XML Instructions

After creating the custom XML file open an empty project from the Workbench start page.

![DesignXplorer interface](image)

Then, click "Link to a Process Instruction File..." in the task pane.
Next, click “Run Optimization in DesignXplorer…”
Variational Technology

The results of a finite-element analysis depend on several input variables, such as:

- Material properties
- Physical parameters (for example, the thickness of a plate)
- Geometry
- Loads

In a design optimization based on DOE (used in DesignXplorer), each change of the value of any input variable requires a new finite element analysis. To perform a "what-if study" where several input variables are varied in a certain range, a considerable number of finite element analyses may be required to satisfactorily evaluate the finite element results over the space of the input variables. A response surface is generated that is an explicit approximation function of the finite element results expressed as a function of all selected input variables. The DOE method generates a response surface using curve and surface fitting algorithms to “fit” output data as a function of input data. This requires a group of design points where each point is generated via a finite element solve.

Variational Technology (used in DesignXplorer VT) provides a much more efficient approach by providing a response surface that is based on a single finite element solve. For shape modifications, combined with the use of mesh morphing and the Taylor series expansion approximation, Variational Technology can handle up to 10 input variables, and can be used with multiple input variables or shape parameters. For non-shape parameters, Variational Technology can handle 50 to 100 parameters.

The Taylor series expansion technique depends on the order of the approximation function. Naturally, the higher the order of the approximation, the more accurate the approximation will be. Variational Technology as implemented in ANSYS Workbench automatically determines the necessary order of the approximation based on the requested accuracy of the expected results.

To determine the response surfaces, it is necessary to evaluate higher-order derivatives of the finite element results with respect to the selected input variables, where the order of the derivatives corresponds to the order of the approximation function. It is a unique key feature of Variational Technology implemented in ANSYS Workbench that all necessary derivatives of any order are calculated automatically within one single finite element analysis. Because the derivatives are also calculated, this “extended” finite element analysis may take longer than a regular solve. However, this one finite element analysis will take a considerably shorter time than the many solution runs that are required for the “what-if study” mentioned above. Depending on the analysis problem, typical speed-up factors may be on the order of ten or even up to several thousand.

DesignXplorer VT uses Variational Technology, and is available for structural applications, providing a response surface of finite element results for linear, elastic, and static analysis types and eigenfrequency analyses.

DesignXplorer VT

- Section : What is DesignXplorer VT?
- Section : Good Practices
- Section : General Procedure for Using DesignXplorer VT
- Section : Results Viewing in DesignXplorer VT
- Section : Modifying DesignXplorer VT Input Variables
- Section : Viewing .rsx Files
What is DesignXplorer VT?

DesignXplorer VT is an option available in ANSYS Workbench that provides a wide range of accurate, rapid, derived results for structural static and modal analyses with linear elastic and isotropic materials. DesignXplorer VT supports varying the following design parameters:

- Material properties for a static structural analysis, including elastic modulus, material density, and minor Poisson's ratio
- Shell thickness
- Mass
- CAD Parameters
- Acceleration and Rotation Velocity Parameters
- Discrete Parameters

Postprocessing in DesignXplorer VT provides the following tools for design evaluation and optimization:

- Design Curves
- Response Surfaces
- Contour Plots
- Spider Charts
- Sensitivity Charts

Good Practices

Run a Simulation Solution Before a DesignXplorer VT analysis: Running a single Simulation run first helps "weed out" any problems that might cause the analysis to fail. For example, this will help locate such problems as poorly applied loads, distorted elements, or coincident nodes not merged. You should eliminate any such problems before performing a DesignXplorer VT analysis.

Review Parameters: Before performing a DesignXplorer VT analysis, you should inspect the parameters listed on the Parameters Page to ensure that they are defined as intended. Variations can exist in how different CAD packages display the parameters. Edit any parameters, as needed, before proceeding to the analysis. For example, CAD parameters listed as "Unknown CAD" must be changed to the specific type of parameter (angle, coordinate system, length, radius, thickness, etc.).

Effect of Additional Parameters: After doing a DesignXplorer VT study with a certain set of parameters, if you wish to see the effect of additional parameters in DesignXplorer VT, you need to create a new DesignXplorer VT study. Additional parameters cannot be added to existing DesignXplorer study.

Generating Automatic Reference Design: As in DesignXplorer, if you Generate an automatic reference... design from a custom design, the resulting design will be in the Reference Designs folder. Because in DesignXplorer VT generating an automatic reference design involves re-meshing and performing an ANSYS solve, the mesh-morphed custom design values may be more than +/- 2% away from the automatic design.
Using Virtual Topology: DesignXplorer VT will not block models containing virtual topology. However, you should not use virtual topology to circumvent topological changes in the model. Models containing virtual edges will produce invalid results or cause mesh morphing to fail.

Guidelines for Using Geometry Parameters

- Parameter Ranges: As a default, the range of each input parameter is simply +/-10% of the central value. This default is meaningless most of the time. It is really necessary to carefully think of the best min and max values and to select realistic values. In general, CAD geometry parameters that cause only local changes in a part's configuration (e.g., a fillet radius) can be assigned ranges that vary widely. Conversely, changes in parameters that cause gross distortion (e.g., the length of the entire part) will require more thought and, most likely, a smaller range of variation. In the example below, it is likely that the radius (R) can be varied as much as +/- 50%, while the length (L) of the part will most likely be restricted to a smaller variation, perhaps less than +/- 10%.

![Example Image]

- Number of Parameters: DesignXplorer VT should efficiently support up to 4 geometry input parameters. Attempting upwards of 8 Input Parameters is also supported and possible, but should be tried with care and much planning. The effects of each variable on the CAD geometry should be well understood (see below). For the 8-parameter study, for example, it might be better to perform two studies with 4 parameters each.

- CAD geometry: For DesignXplorer VT to be used successfully, the CAD geometry should be “clean”; that is, topologically correct (e.g., no missing pieces, slivers) and geometrically well behaved (for example, avoid surfaces of high complexity). It should refresh easily over a significant range of its parameter. In addition, it should mesh easily in ANSYS Workbench with little or no user intervention.

- CAD Parameter Selection: To take full advantage of DesignXplorer VT, a firm understanding of CAD parameters and how they interact and affect the CAD geometry is essential. If changing a CAD parameter causes an unsuccessful CAD update or a change in the CAD geometry topology, then DesignXplorer VT simply will not work. The example below shows how changing a part’s radius too much will cause a topological change. In this example, the change in the radius that defines the centerline of a hole yields an undesirable topological change.
Example 1 Undesirable Topological Change

- **Topological Placement**: Avoid creating topology where an outer loop and an inner loop share a common definition point, as pictured below.
• **Meshing:** In general, ANSYS Workbench finite element meshes that show highly distorted elements tend to not work well in DesignXplorer VT studies. However, this situation is problem-dependent. If parameter changes do not cause changes in the distorted elements, then there will not be a problem with using DesignXplorer VT. Also, free tetrahedron meshes tend to work better than hexahedron meshes. Once again, however, this may not be true in all cases. In a DesignXplorer VT study, the mesh is based on the original CAD geometry to perform mesh morphing.

• **Recommendation Summary for Initial treatment of a New CAD Geometry**
  - Use independent parameter variation to determine the sensitivity of the input parameters independently before attempting a full run. The parameters that have very low sensitivity with respect to the output parameters can be eliminated from the full analysis to save computing time and reduce solution complexity.
  - Keep the geometry parameter ranges small.
  - Make sure that the ANSYS Workbench mesh is not overly distorted and the Simulation results are logical and correct.
  - Use the Simulation Parameter Manager to test that CAD refreshes and simulation results make sense over the parameter ranges of interest.
  - Use the standard DesignXplorer methodology, which is based on Design of Experiment (DOE), to quantify the problem setup and the selection of CAD parameters and their ranges.

**General Procedure for Using DesignXplorer VT**

**Use the following as a general guideline.**

1. Obtain a Simulation solution. While in Simulation, specify items as parameters that you wish to become DesignXplorer VT input and output parameters.
2. Choose the **New DesignXplorer VT Study** option from the project page.
3. Solve the DesignXplorer VT analysis. All solutions are performed on the local desktop, and are synchronous, meaning that they begin and end in a particular Workbench session.
Note — If the vector magnitude is modified for acceleration and rotational velocity input parameters, after solving, the upper and lower bounds will display as scaled values (e.g., 0.9 and 1.1 instead of 9 and 11).

4. Review DesignXplorer VT results.

Results Viewing in DesignXplorer VT

The results-viewing capability for DesignXplorer VT includes the same capabilities available for viewing DesignXplorer results, plus the ability to view contour plots.

To view contour plots, click Responses in the Views pane, then select FEA Result from the View Sub-options. The contour plot that displays represents the result item checked in View Details. Check the box of a different result item to change the contour display to the new result item. Viewing contour plots can assist you in displaying the instantaneous effects of varying your input parameters. By dragging the slider to change an input parameter, you will see the output parameters change accordingly in the View Details, and the contour plot will reflect the change as well. After dragging the input parameter slider, the output parameter value will change, and changes in the contour plot will occur instantly when you upclick.

When you click FEA Result in the View Sub-options of Responses to view contour plots, you activate a viewing toolbar, a legend next to the contour plot, and a triad in the lower right corner. Most of these items are standard viewing tools available in other modules within the ANSYS Workbench. Their arrangement in the toolbar may differ across the modules, but their individual functions are the same. Presented below are links to sections of the Simulation help where descriptions of these tools are included.

Toolbars

![Toolbars](image)

- Scaling Deformed Shape
- Geometry
- Contour Options
- Wireframe and Elements

Graphics Toolbar: Rotate, Pan, Zoom, Box Zoom, Zoom to Fit, Magnifier Window

![Graphics Toolbar](image)

- Draw Slice Plane
- Edit Planes

Animation

Also, the last two animation buttons are unique to DesignXplorer VT. They involve “animation sets” that allow you to define an animation over a specific range of an input parameter. You define an animation set by dragging
the slider of the input parameter to the beginning of your intended range, and clicking the button. This adds a “keyframe” to the animation set. Drag the input parameter slider to the end of your intended range and click again. The animation will only include this range when you click . Click the clear animation button on the toolbar ( ) to clear the animation set.

**Legend**

When viewing DesignXplorer VT result contours, an additional feature of the legend is its ability to readjust its colors and numerical divisions to the current maximum and minimum of the selected output parameter. To activate this feature, click **Reset legend MIN/MAX** after you adjust an input parameter slider. The min/max on the Legend will update only when the minimum or maximum has been exceeded in the model. To reset the min/max to that of the model, click **Reset Min/Max** in View Details.

**Triad and View Control**

**Modifying DesignXplorer VT Input Variables**

You can modify DesignXplorer VT input variables using the **Parameter Definitions** page.

**Viewing .rsx Files**

To view .rsx files in DesignXplorer VT, start with an empty project. Click **Link to a DesignXplorer VT Results file...** under **Project Tasks**. Browse to an .rsx file and click **Open**.

Next, click **View Results in DesignXplorer VT** under **DesignXplorer VT Results File Tasks**. This opens DesignXplorer VT. Notice that there are no output parameters listed in the **Parameters** view. This is because the .rsx file contains general solution information and you must select exactly which outputs you want to see.

To view a result, click **Insert Output Parameter** ( ) in the toolbar or **Insert** menu. After clicking, you'll see a default output parameter in the parameter list. DesignXplorer VT inserts the most general quantity possible. Therefore, if you have stress or displacement results, you'll see a total displacement parameter. If you have frequency results, DesignXplorer VT will insert the first mode shape. You can then specify the exact output quantities by adjusting the fields on the output parameter page, as shown below.

After a parameter is inserted, DesignXplorer VT functions as usual.

**Note** — If the .rsx file was created from an ANSYS run and not a DesignXplorer VT run, there may be certain element types that are not supported by DesignXplorer VT.

DesignXplorer VT cannot use .rsx files that do not contain solution information (i.e., ANSYS ParaMesh .van files cannot be imported).
Depending on the type of output, more options may be available than are shown above.

- **Output Type:** The type of output. For example, Stress, Displacement, Normal Stress, Shear Stress, etc.
- **Output Scoping:** The nodes that the output is scoped to. Any components defined in the input file will be available here, but it does not make sense for certain outputs to be scoped to all components.
- **Output Orientation:** The orientation of the output. For a deformation, the possibilities are \(X\), \(Y\), \(Z\), or Total. For shear stress, the possibilities are \(XY\), \(XZ\), or \(YZ\). Essentially, this is the directional component of the output.
- **Nodal Search Value:** Sets whether to search for the minimum or maximum of the output for response surfaces and single output quantities.
- **Frequency Mode:** Sets the frequency mode to be viewed.

**Optimization Using Discrete Parameters**

You can use DesignXplorer VT to obtain a solution using one or more discrete input variables. This allows you to optimize combinations of discrete variables in order to get an optimal solution that will reduce weight or minimize failure in a design.
This feature can be used for FEA problems containing spot welds, support beams, spars, ribs, etc., and multibody parts with “holes” represented by fill areas.

To perform an optimization using discrete input parameters, parameterize the “suppressed” property of the spot weld, part, or body in the Simulation Details View. Create a new DesignXplorer VT study from the Project page and the discrete parameters will be imported into DesignXplorer VT.

*Note* — You cannot use discrete and shape parameters simultaneously.

You cannot apply of loads and boundary conditions on parts used as discrete parameters.

**Discrete Parameter Charts**

When you click **Responses** in the Views pane and select **Scatter Chart** from the View Sub-options, the discrete parameter charts are displayed as a scatter plot. The scatter chart view is shown for each selected output parameter. Parameters can be selected by clicking the checkboxes to the left of the parameter name. As more (discrete) input parameters are selected, more points are added to the scatter chart, representing the solution points corresponding to all the parameter combinations of the selected parameters. Unchecked parameters are held at either **Active** or **Inactive**, as selected in the drop-down menu under each checkbox. By placing your cursor over the points in the scatter chart, you can see the relevant parameter combinations as bars in the slider bars next to the parameters.

If \( n \) parameters are selected, the total number of points displayed on the scatter chart is \( 2^n \). Therefore, to allow for a reasonable solution time, the maximum number of parameters that can be checked at the same time is 10.
Sample Generation

This section explains the use of the Advanced option (shown below) of sample generation for problems with discrete (boolean) parameters.
As with other sampling methods, this technique features both Screening and Advanced options. The Screening option generates all possible combinations of the parameters (i.e., for \( n \) Boolean parameters, the total number of combinations is \( 2^n \)). However, for problems with 32 or more parameters, the Screening option is disabled, as the exhaustive sampling is extremely time-consuming.

The Advanced option is a multi-objective Boolean optimizer based on Bayesian sampling updates. For information on how to set Initial Samples, Number of Samples Per Iteration, and Maximum Number of Iterations, see Section: Sample Generation. You must also specify Training Set Percentage, which controls the convergence rate of the algorithm. The value of the percentage depends on the number of TradeOff output parameters. For problems with only one or two output parameters, the value should be set within 5%. With each additional TradeOff output parameter, the percentage should be increased 2%. With this value set low, the convergence is quicker, as the method is more exploitative. As the value increases, the study becomes more explorative. You must choose the balance between explorative and exploitative. One option is to perform several exploitative runs with different sample sizes and, depending on the differences between the solutions, run an explorative search.

You can choose whether to set Target Number of Parameters and the corresponding Desired Value depending on how many of the Boolean parameters you wish to see in the final design. This is a way to control the geometry configurations in the final design.

You may also choose whether to set Maximum Cache Size. This is a mechanism by which duplicate configurations generated during optimization are not reevaluated, but are copied from a cached set of solutions. The larger the cache size, the faster the optimization gets as the iterations progress. However, a large cache involves a large use of memory, and vice versa. You should keep this in mind when choosing a cache size.

Click Generate to start the iterations. If you wish to stop the iterations before they converge, click the Stop button.

**Theory**

This section describes the algorithm developed to perform multiobjective constrained optimization of discrete problems in DesignXplorer VT.
In DesignXplorer VT, discrete parameters are essentially Boolean in nature. That is, they can assume only two values: “active” or “inactive,” represented by the values 1 and 0, respectively. For a problem which has \( n \) discrete parameters, an exhaustive evaluation search space involves \( 2^n \) evaluations of the DesignXplorer VT response surface. This optimizer is intended to report the optimal solution (a Pareto front in the case of multiobjective optimization) by using fewer evaluations.

The optimizer accepts only discrete (Boolean) variables as input, and the outputs can be any DesignXplorer output. You can use an additional constraint with this optimizer to force the optimal results to suppress a user-defined number of discrete parameters.

The following describes the optimizer’s methodology.

1. An initial probability value of 0.5 is defined for each discrete parameter.
2. The probabilities are used in a Bernoulli distribution to generate a sample of discrete input parameters. Each row of the sample represents a specific configuration.
3. Each row is evaluated from the DesignXplorer VT response surface.
4. The solved sample matrix is classified into Pareto fronts by the Pareto ranking method.
5. The samples in the first Pareto front or \( n\% \) of the best samples are selected, whichever is larger, and a training sample is formed. You set the value of \( n \) in the GUI.

   *Note* — For a Pareto-ranked sample, the “best” solutions are found by partial rank ordering using crowding distances.

6. Each column of the training sample is used to update the probability of the corresponding variable. The probability of a column is calculated as the sum of the boolean values in a column divided by the training sample size.
7. Check for convergence. If the solution has not converged, return to step 2.

The results of the optimization are shown as Pareto charts and sensitivities.

**Limitations**

Presented below are DesignXplorer VT limitations.

**Check the ANSYS Workbench 10.0 Errata for the possibility of additional limitations.**

DesignXplorer VT has the following analysis limitations:

- Static stress and modal analyses are supported (thermal analyses are not supported).
- Pre-stress normal mode analyses are not supported. This includes using applied loads such as nonzero displacements, forces, pressures, etc.
- All types of nonlinearity in the model (i.e., nonlinear geometry, etc.) are not supported.
- Multiple environments leading to multiple solves (for example, one structural analysis and one modal analysis together) are not supported. These analyses must be performed separately.
- Mass and volume are not available in normal modes (frequency).
- Only bonded MPC contact is supported.

DesignXplorer VT has the following results limitations:
• Only structural and modal results are supported.
• DesignXplorer VT does not support all stresses supported by Simulation, namely, the stress tools (e.g., factor of safety) cannot be selected as result quantities.
• Structural and thermal strains are not supported.
• The result parameter MASS is not supported for normal modal analysis.
• Eigenfrequencies below 1.1 Hertz are not supported for normal modal analysis.
• Part, Body, Assembly, Edge, and Vertex scoped results will cause a problem in DesignXplorer VT. Inserting a result with no pre-selections in Simulation will automatically scope the result to the entire model. Do not select the entire model, and then insert a result. To scope a result to a surface in Simulation, first select the desired surfaces, and then insert the result. To change the scope of a result, delete the result and reinsert a new result item.

DesignXplorer VT has the following **geometry** limitations:

• Autodesk Mechanical Desktop is not supported.
• For surfaces, only a single surface or multiple spot weld surfaces are supported.
• Sheets attached with spot welds created in Simulation are not supported.
• Pro/ENGINEER geometries containing disjoined areas represented as a single area will cause DesignXplorer VT geometry transfer or mesh morphing to fail. This is a very abnormal representation, specific only to Pro/ENGINEER.

DesignXplorer VT has the following **meshing** limitations:

• In Simulation, if you use a Method mesh control tool set to Uniform Quad/Tri, some models will not mesh morph correctly because of the patch-independent nature of the Uniform Quad/Tri setting. The node is limited to being morphed only on it's first topology.

DesignXplorer VT has the following **loads and boundary conditions** limitations:

• Pinned cylinders are not supported.
• Coordinate System is not supported.

DesignXplorer VT has the following **parameters** limitations:

• Discrete parameters and shape parameters are not supported simultaneously.
• Boundary conditions are not supported as input parameters.
• The maximum number of parameters is 20 when geometry parameters are present. If only non-geometry parameters (e.g., edges, Young's Modulus, thickness, etc.) are present then the maximum number of parameters should not exceed 100.

**Modal Analysis Limitations**

• **Repeated Roots** - If the part analyzed has symmetries, its eigenfrequencies might come by pairs or more. You should not select only some of the repeated frequencies as output variables. For example, consider a part with the following eigenfrequencies:

  1003 Hz.

  1003 Hz.
1546 Hz.

2412 Hz.

2412 Hz.

For this part, you should not make a parameter of the 1st 2412 Hz. frequency without selecting the 2nd 2412 Hz. frequency.

**Accuracy**

DesignXplorer VT results and response surfaces are highly accurate over a wide range of input parameters. That range is normally characterized as a “radius” of convergence. Once the input parameters fall outside of the convergence radius, the results become more approximate. In a problem with $n$ input parameters, there are $2^n$ “corners.” For example, consider a problem with 2 input parameters, $X$ and $Y$, as indicated in the response surface below. Clearly, $n = 2$ and there are $2^2 = 4$ corners. Inside the radius of convergence ($r$), the response surface results are very accurate, while in the area of the corners (that is, outside the radius) the results are approximate. Of course, this is more difficult to visualize in a general, $n$-dimensional space of input parameters, but the effect on accuracy is similar. Therefore, if all input parameters are simultaneously pushed to their extremes, the results will be less accurate. It follows that if the results are desired in a corner, the design center should be shifted by modifying the ranges of the input parameters.

The radius of accuracy for DesignXplorer results can be visualized in the View Details by the shaded portions of the Input Parameters slider bars. All displacement values within the radius are expected to be +/- 2% accurate.
Goal Driven Optimization

Goal Driven Optimization (GDO) is a constrained, multi-objective optimization (MOO) technique in which the “best” possible designs are obtained from a sample set given the goals you set for parameters. The sample set is generated either by the Screening or Advanced option in the sample generation menu. Advanced sample generation can only be performed when all of the input parameters are continuous or uncertain.

The GDO process allows you to determine the effect on input parameters with certain preferences applied for the output parameters. For example, in a structural engineering design problem, you may want to determine which set of designs (in terms of geometric problem dimensions and material types) best satisfy minimum mass, maximum natural frequency, maximum buckling and shear strengths, and minimum cost, with maximum value constraints on the von Mises stress and maximum displacement.

This section describes the GDO tool and its use in performing MOO.

Principles

GDO can be used for design optimization in two ways: the Screening approach or the Advanced approach. The Screening approach is a non-iterative direct sampling method by a quasi-random number generator based on the Hammersley algorithm. The Advanced approach is an iterative Multi-objective Genetic Algorithm (MOGA), which can optimize problems with continuous input parameters. Problems with mixed parameter types (i.e., usability, discrete, or scenario parameters with continuous parameters) or discrete problems cannot currently be handled by the Advanced technique and in these cases you will only be able to use the Screening technique.

The GDO framework also allows you to use a Decision Support Process (DSP) based on satisfying criteria as applied to the parameter attributes using a weighted aggregate method. In effect, the DSP can be viewed as a post-processing action on the Pareto fronts as generated by the Advanced or Screening process.

Usually the Screening approach is used for preliminary design, which may lead you to apply the Advanced approach for more refined optimization results. In either approach, the TradeOff Study option, as applied to the resulting sample set, shows the Pareto-dominant solutions. However, in the Advanced approach, the Pareto fronts are better articulated and most of the solutions lie on the first front, as opposed to the usual results of the Screening approach, where the solutions are distributed across all the Pareto fronts. This is illustrated in Figure 1: “6,000 Sample Points Generated by Screening Method” and Figure 2: “Final Sample Set After 5,100 Evaluations by Advanced Method”. Figure 1: “6,000 Sample Points Generated by Screening Method” shows the sample as generated by the Screening method, and Figure 2: “Final Sample Set After 5,100 Evaluations by Advanced Method” shows a sample set generated by the Advanced method for the same problem.
Figure 1  6,000 Sample Points Generated by Screening Method

Figure 2  Final Sample Set After 5,100 Evaluations by Advanced Method

Figure 3: “Pareto Optimal Front Showing Two Non-dominated Solutions” shows the necessity of generating Pareto fronts. The two axes represent two output parameters that are conflicting by nature. Two optimal solutions, marked “1” and “2,” are shown. Both of these solutions are “non-dominated.” That is, they are equally good in terms of Pareto optimality. Point 1 corresponds to a better solution in terms of the output marked “v.” Point 2 corresponds to a better solution in terms of the output marked “buck.”
Guidelines and Best Practices

At least one of the output parameters should have a **Desired Value** of **Maximum Possible**, **Minimum Possible**, or a **Target** specification with **Near Target** with the **TradeOff** option turned on in order to do optimization with the **Advanced** option.

If this is not done, then the optimization problem is either undefined (**Desired Value** for each parameter set to **No Preference**) or is merely a constraint satisfaction problem (**Desired Value** set to **Above Target** or **Below Target** or **Near Target** with **TradeOff** set to off). When the problem is not defined, as in Figure 4: “Case Where the Advanced Option Cannot be Activated”, the **Advanced** option cannot be activated for sample generation. If the problem defined is only one of constraint satisfaction, as in Figure 5: “Case Where GDO Solves a Constraint Satisfaction Problem”, the Pareto fronts displayed (from the **TradeOff** option) may not be very clearly articulated, as there are no objectives to be traded off. However, this is a good way to demonstrate the feasibility boundaries of the problem in the output space (i.e., to determine the boundaries of the design envelope that reflects your preferences).

As shown in Figure 4: “Case Where the Advanced Option Cannot be Activated”, if the entire **Desired Value** column is set to “No Preference,” the optimization process will not be activated, as no outputs have goals specified which could drive the algorithm.
Goals and Candidate Designs

- A Goals Driven Study uses a calculated set of sample design points. Click the "Generate Sample Designs" button to generate these points.

### Input Parameter Goals
Click rows in this table to assign design goals to input parameters.

<table>
<thead>
<tr>
<th>Name</th>
<th>Lower Bound</th>
<th>Upper Bound</th>
<th>Target</th>
<th>Desired Value</th>
<th>Importance</th>
</tr>
</thead>
<tbody>
<tr>
<td>b</td>
<td>1.8</td>
<td>2.2</td>
<td></td>
<td>No Preference</td>
<td>Default</td>
</tr>
<tr>
<td>d</td>
<td>4.5</td>
<td>5.5</td>
<td></td>
<td>No Preference</td>
<td>Default</td>
</tr>
<tr>
<td>l</td>
<td>90.</td>
<td>110.</td>
<td></td>
<td>No Preference</td>
<td>Default</td>
</tr>
<tr>
<td>p</td>
<td>900.</td>
<td>1100.</td>
<td></td>
<td>No Preference</td>
<td>Default</td>
</tr>
<tr>
<td>E</td>
<td>1.8e+005</td>
<td>2.2e+005</td>
<td></td>
<td>No Preference</td>
<td>Default</td>
</tr>
</tbody>
</table>

### Response Parameter Goals
Click rows in this table to assign design goals to response parameters. Defining a target value is optional.

<table>
<thead>
<tr>
<th>Name</th>
<th>Target</th>
<th>Desired Value</th>
<th>Importance</th>
<th>TradeOff</th>
</tr>
</thead>
<tbody>
<tr>
<td>v</td>
<td>-</td>
<td>No Preference</td>
<td>Default</td>
<td>-</td>
</tr>
<tr>
<td>sig</td>
<td>-</td>
<td>No Preference</td>
<td>Default</td>
<td>-</td>
</tr>
<tr>
<td>dis</td>
<td>-</td>
<td>No Preference</td>
<td>Default</td>
<td>-</td>
</tr>
<tr>
<td>buck</td>
<td>-</td>
<td>No Preference</td>
<td>Default</td>
<td>-</td>
</tr>
</tbody>
</table>

### Candidate Designs
Generate or update candidate designs based on the current goals

### About Parameter Ratings

As shown in Figure 5: “Case Where GDO Solves a Constraint Satisfaction Problem”, some combinations of **Desired Value** and **Target** settings specify that the problem is one of constraint satisfaction. The results obtained from these settings indicate only the boundaries of the feasible region in the design space. Currently the **Advanced** option cannot be used to solve a pure constraint satisfaction problem.
Figure 5  Case Where GDO Solves a Constraint Satisfaction Problem

Goals and Candidate Designs

- A Goals Driven Study uses a calculated set of sample design points. Click the “Generate Sample Designs” button to generate these points.

### Input Parameter Goals

Click rows in this table to assign design goals to input parameters.

<table>
<thead>
<tr>
<th>Name</th>
<th>Lower Bound</th>
<th>Upper Bound</th>
<th>Target</th>
<th>Desired Value</th>
<th>Importance</th>
</tr>
</thead>
<tbody>
<tr>
<td>b</td>
<td>1.8</td>
<td>2.2</td>
<td>No Preference</td>
<td>Default</td>
<td></td>
</tr>
<tr>
<td>d</td>
<td>4.5</td>
<td>5.5</td>
<td>No Preference</td>
<td>Default</td>
<td></td>
</tr>
<tr>
<td>l</td>
<td>90.</td>
<td>110.</td>
<td>No Preference</td>
<td>Default</td>
<td></td>
</tr>
<tr>
<td>p</td>
<td>900.</td>
<td>1100.</td>
<td>No Preference</td>
<td>Default</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>1.8e+005</td>
<td>2.2e+005</td>
<td>No Preference</td>
<td>Default</td>
<td></td>
</tr>
</tbody>
</table>

### Response Parameter Goals

Click rows in this table to assign design goals to response parameters. Defining a target value is optional.

<table>
<thead>
<tr>
<th>Name</th>
<th>Target</th>
<th>Desired Value</th>
<th>Importance</th>
<th>TradeOff</th>
</tr>
</thead>
<tbody>
<tr>
<td>v</td>
<td>730.03</td>
<td>Less Than Target</td>
<td>Default</td>
<td>-</td>
</tr>
<tr>
<td>sig</td>
<td>7295.7</td>
<td>Greater Than Target</td>
<td>Default</td>
<td>-</td>
</tr>
<tr>
<td>dis</td>
<td>33.217</td>
<td>Less Than Target</td>
<td>Default</td>
<td>-</td>
</tr>
<tr>
<td>buck</td>
<td>-</td>
<td>No Preference</td>
<td>Default</td>
<td>-</td>
</tr>
</tbody>
</table>

### Candidate Designs

Generate or update candidate designs based on the current goals.

As shown in Figure 6: “Typical MOO Case”, some selections allow either Screening or Advanced options to be used for optimization. Typically, the “Near Target” option can be used either as a goal-based objective with TradeOff turned on, or as an equality constraint with TradeOff turned off. The Screening process does not make a distinction between the two scenarios. However, this setting does affect the Advanced method of GDO because of the way the method handles objective functions and constraints.
Figure 6  Typical MOO Case

Goals and Candidate Designs

- A Goals Driven Study uses a calculated set of sample design points. Click the “Generate Sample Designs” button to generate these points.

Input Parameter Goals
Click rows in this table to assign design goals to input parameters.

<table>
<thead>
<tr>
<th>Name</th>
<th>Lower Bound</th>
<th>Upper Bound</th>
<th>Target</th>
<th>Desired Value</th>
<th>Importance</th>
</tr>
</thead>
<tbody>
<tr>
<td>b</td>
<td>1.8</td>
<td>2.2</td>
<td></td>
<td>No Preference</td>
<td>Default</td>
</tr>
<tr>
<td>d</td>
<td>4.5</td>
<td>5.5</td>
<td></td>
<td>No Preference</td>
<td>Default</td>
</tr>
<tr>
<td>l</td>
<td>90.0</td>
<td>110.0</td>
<td></td>
<td>No Preference</td>
<td>Default</td>
</tr>
<tr>
<td>p</td>
<td>900.0</td>
<td>1100.0</td>
<td></td>
<td>No Preference</td>
<td>Default</td>
</tr>
<tr>
<td>E</td>
<td>1.8e+005</td>
<td>2.2e+005</td>
<td></td>
<td>No Preference</td>
<td>Default</td>
</tr>
</tbody>
</table>

Response Parameter Goals
Click rows in this table to assign design goals to response parameters. Defining a target value is optional.

<table>
<thead>
<tr>
<th>Name</th>
<th>Target</th>
<th>Desired Value</th>
<th>Importance</th>
<th>TradeOff</th>
</tr>
</thead>
<tbody>
<tr>
<td>v</td>
<td></td>
<td>Minimum Possible</td>
<td>Default</td>
<td>On</td>
</tr>
<tr>
<td>sig</td>
<td></td>
<td>Maximum Possible</td>
<td>Default</td>
<td>On</td>
</tr>
<tr>
<td>dis</td>
<td>33.217</td>
<td>Near Target</td>
<td>Default</td>
<td>On</td>
</tr>
<tr>
<td>buck</td>
<td></td>
<td>No Preference</td>
<td>Default</td>
<td></td>
</tr>
</tbody>
</table>

Candidate Designs

Generate or update candidate designs based on the current goals

About Parameter Ratings

The Target and Desired Value settings of the input parameters do not affect the sample generation part of the Advanced method. However, these settings will affect the ranking of the samples which generate the three candidate designs, if the Generate or update candidate designs based on the current goals button is clicked on the Goals & Candidates page.

Sample generation using the Screening method is not affected by any parameter setting. However, the parameter settings do still affect the generation of candidate designs.

The TradeOff option indicates which output parameter is to be treated as an objective function for the optimization. Setting the Desired Value to Maximum Possible or Minimum Possible automatically sets the TradeOff option to on. If Desired Value is set to Near Target, then you can either treat it as an objective function (TradeOff turned on), which will treat the output as a goal, or treat the output as an equality constraint (TradeOff turned off). Output parameters for which the Desired Value has been set to Above Target or Below Target are automatically assigned as constraints and the TradeOff option is turned off.

The tradeoff study option is affected by the Desired Value set for the output parameters. It is also affected by whether the TradeOff option is set on or off. If the Desired Value for each output parameter is set to “No Preference,” then a tradeoff study cannot be performed. If the sample generation performed prior to the study used the Screening method, you can freely change the attributes of the output parameters. However, if the study is preceded by an Advanced sample generation, the output parameters are locked and cannot be changed.
Typically, the **Screening** method is best suited for conducting a preliminary design study, because it is a low-resolution, fast, and exhaustive study that can be useful in locating approximate solutions quickly. The solutions may then be used as a starting sample for the **Advanced method**. Ideally, as the **Screening** method does not depend on any parameter settings, several such settings may be used successively in **Screening** runs to perform preliminary design studies.

For example, you may run the **Screening** process for 3,000 samples, then use a tradeoff Study to generate and view the Pareto fronts. The solutions slider can be used on the **TradeOff** page to display only the prominent points you may be interested in (usually the first few fronts) and these can be saved as a new sample set by selecting **Insert Custom Sample Set**. This new sample can then be selected in the **Initial Samples** drop-down menu and the **Advanced** method of sample generation can proceed from there. In this case, the final Pareto fronts generated will be very well articulated.

Because the GDO algorithm works off of response surfaces, you should validate the best obtained optimization results by generating the corresponding hard designs and comparing the results.

**Postprocessing**

Postprocessing of GDO optimization results is explained below. The postprocessing phase follows the generation of samples. If the **Screening** method of sample generation is used, the samples can be generated before goals are selected. However, if the **Advanced** method is used, the goals must be set before the samples are generated. For more information, see Section : Sample Generation.

Postprocessing comprises the following:

- Generate non-dominated Pareto fronts by the tradeoff study or use the Decision Support Process (DSP) to generate three candidate designs.
- Manually select specific points or automatic selection of point set from the tradeoff chart and save them as **Advanced** or **Screening** sample sets, depending on how they were generated. (The full sample set may also be saved this way.)
- Generate the best solutions from your specified preferences using the DSP with weighted goals on the filtered tradeoff study samples.
- Save the best solutions from the DSP and generate hard designs from them for validation.

Figure 7: “Primary Postprocessing Options for GDO” shows the options offered for primary postprocessing of the sampling results. These can be conducted on either **Screening** or **Advanced** sample generation results.

**Figure 7 Primary Postprocessing Options for GDO**

If **TradeOff Study** is selected after sample generation, the samples are ranked by non-dominated Pareto fronts and the tradeoffs which concern you may be viewed. To make sense of the true nature of the tradeoffs, the plots must be viewed with the output parameters as the axes. This shows which output goals can be achieved and whether this entails sacrificing the goal attainment of other outputs. Typically, a tradeoff study gives you a choice of possible, conflicting solutions from which to choose.
If you wish to bypass the tradeoff study process and only want to view and archive the three best solutions from the generated sample set, you can click **Generate or update candidate designs based on current goals**. This performs a weighted aggregate ranking of the solutions based on your specified preferences and reports the three best solutions available. However, these results are not truly representative of the solution set, as this approach obtains results by ranking the solution by an aggregated, weighted method. Schematically, this represents only a section of the available Pareto fronts. Changing the weights (i.e., **Importance**) will display different such sections. This postprocessing step helps in selecting solutions if you are sure of your preferences for each parameter.

Figure 8: “Typical TradeOff Study of Sample Showing First Pareto Front” shows the results of the tradeoff study performed on an **Advanced** sample set. The first Pareto front (non-dominated solutions) are shown as blue boxes in the output-axis plot as the default output. The slider can be moved to the right to add more fronts, effectively adding more points to the tradeoff chart. The additional points added this way are inferior to the points in the first Pareto front in terms of the goals you specified, but in some cases, where there are not enough first Pareto front points, these may be necessary to obtain the final design.

**Figure 8 Typical TradeOff Study of Sample Showing First Pareto Front**

At this point it is possible to save a sub-sample, i.e., the displayed points in the tradeoff chart, by clicking the **Insert a Custom Sample Set** button. You can also select any group of points from the chart and use this option to save a sub-sample. Alternatively, if only one point is needed from the chart, select it and click the **Insert a Custom Design Point** button to save it.

In Figure 9: “Selection of a Subset of the First Pareto Front”, some points (yellow) have been selected from the first Pareto front to be saved as a custom sample that can optionally be used in the DSP. Once a custom sample is selected, fresh tradeoff studies can no longer be performed on it, because the sample set has already been optimized in the Pareto sense and any further Pareto-based operations would not yield better results. Any further tradeoff study operations on this sample set would only resume the previously-ranked points from the database.
As shown in Figure 10: “User-Selected Sample Set From the First Pareto Front”, only the points that are selected from the first Pareto front of an existing sample set and saved (by using Insert Custom Sample Set) are saved as a new sample set. The visible point set can now be used for the DSP, which will select the three best solutions from this set according to your specified preferences. In order to do this, select Goals & Candidates.

In the decision support process, the settings for Desired Value and Target for output parameters cannot be modified because the sample set obtained by the Advanced process has already narrowed down the sample space to reflect your specified preferences. However, the Importance settings of the input and output parameters and the Desired Value and Target settings for the input parameters can be changed. Only the Desired Value and Target settings for the outputs affect the Advanced search.
In Figure 11: “Decision Support as Performed on User-Selected Sample Set”, you set the Importance value for each output. You can also set values for Importance, Desired Value, and Target for the input parameters now.
Next, click **Generate or update candidate designs of the current goals** to generate three candidate designs. Of the three designs generated, you may save whichever you want by selecting it and clicking **Insert selected candidate as a soft design**.

It is also important to discuss the representation of feasible and infeasible points. The **Advanced** algorithm always ensures that feasible points are shown as being of better quality than the infeasible points, and different markers are used to indicate them in the chart. In the 3-D tradeoff chart, cubes denote feasible points and pyramids denote infeasible ones. In the 2-D tradeoff chart, square markers denote the feasible points and triangular markers denote the infeasible points.

Also, in both types of charts, the best Pareto front is blue and the fronts gradually transition to red (worst Pareto front). Additionally, in the 3-D charts, the best Pareto front is opaque and the opacity reduces as progressively worse fronts are identified.

Figure 12: “Two-dimensional TradeOff Plot Showing Feasible and Infeasible Points” is a typical 2-D tradeoff chart with feasible and infeasible points.
Figure 12  Two-dimensional TradeOff Plot Showing Feasible and Infeasible Points

Figure 13: “Three-dimensional TradeOff Plot Showing Feasible and Infeasible Points” is a typical 3-D tradeoff plot with feasible and infeasible points. Once the specific tradeoff points are selected, automatically or manually, they can be saved as a custom sample, as discussed earlier.

Figure 13  Three-dimensional TradeOff Plot Showing Feasible and Infeasible Points

Theory

In this section, theoretical aspects of goal driven optimization are briefly discussed.
Shifted Hammersley Sampling Method

The shifted Hammersley method is the sampling strategy used for the Screening process. The conventional Hammersley sampling algorithm is a quasi-random number generator which has very low discrepancy and is used for quasi-Monte Carlo simulations. A low-discrepancy sequence is defined as a sequence of points that approximate the equidistribution in a multi-dimensional cube in an optimal way. In other words, the design space is populated almost uniformly by these sequences and, due to the inherent properties of Monte Carlo sampling, dimensionality is not a problem (i.e., the number of points does not increase exponentially with an increase in the number of input parameters). The conventional Hammersley algorithm is constructed by using the radical inverse function. Any integer \( n \) can be represented as a sequence of digits \( n_0, n_1, n_2, ..., n_m \) by the following equation:

\[
n = n_0 n_1 n_2 \cdots n_m
\]

(1)

For example, consider the integer 687459, which can be represented this way as \( n_0 = 6, n_1 = 8, \) and so on. Because this integer is represented with radix 10, we can write it as \( 687459 = 9 \times 10 + 5 \times 100 \) and so on. In general, for a radix \( R \) representation, the equation is:

\[
n = n_m + n_{m-1} R + \cdots + n_0
\]

(2)

The inverse radical function is defined as the function which generates a fraction in \((0, 1)\) by reversing the order of the digits in Equation 2 about the decimal point, as shown below.

\[
\Phi_R(n) = n_m n_{m-1} n_{m-2} \cdots n_0 = n_m R^{-1} + n_{m-1} R^{-2} + \cdots + n_0 R^{-(m-1)}
\]

(3)

Thus, for a \( k \)-dimensional search space, the Hammersley points are given by the following expression:

\[
H_k(i) = \left[ i/N, \Phi_R(i), \Phi_{R^2}(i), \cdots, \Phi_{R^{k-1}}(i) \right]
\]

(4)

where \( i = 0, ..., N \) indicates the sample points. Now, from the plot of these points, it is seen that the first row (corresponding to the first sample point) of the Hammersley matrix is zero and the last row is not 1. This implies that, for the \( k \)-dimensional hypercube, the Hammersley sampler generates a block of points that are skewed more toward the origin of the cube and away from the far edges and faces. To compensate for this bias, a point-shifting process is proposed that shifts all Hammersley points by the amount below:

\[
\Delta = \frac{1}{2} N
\]

(5)

This moves the point set more toward the center of the search space and avoids unnecessary bias. Thus, the initial population always provides unbiased, low-discrepancy coverage of the search space.
Pareto Dominance in Multi-objective Optimization

The concept of Pareto dominance is of extreme importance in multi-objective optimization, especially where some or all of the objectives are mutually conflicting. In such a case, there is no single point that yields the “best” value for all objectives (i.e., the Utopia Point). Instead, the best solutions, often called a Pareto or non-dominated set, are a group of solutions such that selecting any one of them in place of another will always sacrifice quality for at least one objective, while improving at least one other. Formally, the description of such Pareto optimality for generic optimization problems can be formulated as in the following equations.

Taking a closer, more formal look at the multi-objective optimization problem, let the following denote the set of all feasible (i.e., do not violate constraints) solutions:

\[ X := \{ x \in \mathbb{R}^n : g(x) \geq 0, h(x) = 0, x_i \leq x \leq x_u \} \]

(6)

The problem can then be simplified to:

\[ \min_{x \in X} f(x) \]

(7)

If there exists \( x^* \in X \) such that for all objective functions \( x^* \) is optimal. This, for \( i = 1, ..., k \), is expressed:

\[ f_i(x^*) \leq f_i(x) \forall x \in X, \forall \]

(8)

This indicates that \( x^* \) is certainly a desirable solution. Unfortunately, this is a utopian situation that rarely exists, as it is unlikely that all \( f_i(x) \) will have minimum values for \( X \) at a common point \( (x^*) \). The question is left: What solution should be used? That is, how should an “optimal” solution be defined? First, consider the so-called ideal (utopian) solution. In order to define this solution, separately attainable minima must be found for all objective functions. Assuming there is one, let \( x^{(1)} \) be the solution of the scalar optimization problem:

\[ \min_{x \in X} f_i(x) = f_i^* \]

(9)

Here \( f_i^* \) is called the individual minimum for the scalar problem \( i \); the vector \( f^* = (f_1^*, \ldots, f_k^*) \) is called ideal for a multi-objective optimization problem; and the points in \( X \) which determined this vector is the ideal solution.

It is usually not true that Equation 10 holds, although it would be useful, as the multi-objective problem would have been solved by considering a sequence for scalar problems. It is necessary to define a new form of optimality, which leads to the concept of Pareto Optimality. Introduced by V. Pareto in 1896, it is still the most important part of multi-objective optimization.

\[ f^* = (f_1^*, \ldots, f_k^*) \]

(10)

A point \( x^* \in X \) is said to be Pareto Optimal for the problem if there is no other vector \( x \in X \) such that for all \( i = 1, ..., k \),

\[ f_i(x) \leq f_i(x^*) \]

(11)

and, for at least one \( i \in \{1, ..., k\} \):

\[ f_i(x) < f_i(x^*) \]

(12)
This definition is based on the intuitive conviction that the point \( x^* \in X \) is chosen as the optimal if no criterion can be improved without worsening at least one other criterion. Unfortunately, the Pareto optimum almost always gives not a single solution, but a set of solutions. Usually Pareto optimality is spoken of as being global or local depending on the neighborhood of the solutions \( X \), and in this case, almost all traditional algorithms can at best guarantee a local Pareto optimality. However, this MOGA-based system, which incorporates global Pareto filters, yields the global Pareto front.

**MOGA (Multi-objective Genetic Algorithm)**

The MOGA used in GDO is a hybrid variant of the popular NSGA-II (Non-dominated Sorted Genetic Algorithm-II) based on controlled elitism concepts. Currently, only continuous problems can be solved. The Pareto ranking scheme is done by a fast, non-dominated sorting method that is an order of magnitude faster than traditional Pareto ranking methods. The constraint handling uses the same non-dominance principle as the objectives, thus penalty functions and Lagrange multipliers are not needed. This also ensures that the feasible solutions are always ranked higher than the infeasible solutions.

The first Pareto front solutions are archived in a separate sample set internally and are distinct from the evolving sample set. This ensures minimal disruption of Pareto front patterns already available from earlier iterations. You can control the selection pressure (and, consequently, the elitism of the process) to avoid premature convergence by altering the parameter Percent Pareto.

**Decision Support Process**

The decision support process is a goal-based, weighted, aggregation-based design ranking technique and can be accessed in the **Goals & Candidates** page of DesignXplorer.

Given \( n \) input parameters, \( m \) output parameters, and their individual targets, the collection of objectives is combined into a single, weighted objective function, \( \Phi \), which is sampled by means of a direct Monte Carlo method using uniform distribution. The candidate designs are subsequently ranked by ascending magnitudes of the values of \( \Phi \). The proposed function for \( \Phi \) (where all continuous input parameters have usable values of type “continuous”) is given by the following:

\[
\Phi \equiv \sum_{i=1}^{n} w_i N_i + \sum_{j=1}^{m} w_j M_j
\]  

(13)

where:

- \( w_i \) and \( w_j \) = weights defined in Equation 16
- \( N_i \) and \( M_i \) = normalized objectives for input and output parameters, respectively

The output parameters include response and derived parameters. The normalized objectives (metrics) are:

\[
N_i = \left( \frac{x_t - x_i}{x_u - x_i} \right)_j
\]  

(14)

\[
M_j = \left( \frac{y_t - y_j}{y_{\text{max}} - y_{\text{min}}} \right)_j
\]  

(15)

where:
The fuzziness of the combined objective function derives from the weights \( w \), which are simply defined as follows:

\[
\begin{align*}
    w_i &= w_j = \begin{cases} 
        1.000, & \text{if the Importance is } \text{"Higher"} \\
        0.666, & \text{if the Importance is } \text{"Default"} \\
        0.333, & \text{if the Importance is } \text{"Lower"} 
    \end{cases}
\end{align*}
\]

The labels used are defined in Section: TradeOff Study.

The targets represent the desired values of the parameters, and are defined for the continuous input parameters as follows:

\[
x_t = \begin{cases} 
    x_i, & \text{if Desired Value is } \text{"No Preference"} \\
    x_f, & \text{if Desired Value is } \text{"Near Lower Bound"} \\
    \frac{1}{2}(x_l + x_u), & \text{if Desired Value is } \text{"Near Midpoint"} \\
    x_u, & \text{if Desired Value is } \text{"Near Upper Bound"} 
\end{cases}
\]

and, for the output parameters we have the following desired values:

\[
y_t = \begin{cases} 
    y, & \text{if Desired Value is } \text{"No Preference"} \\
    y_f, & \text{if Desired Value is } \text{"Minimum Possible"} \text{ and a } \text{"Target"} \text{ value is not defined} \\
    y_t, & \text{if Desired Value is } \text{"Less Than Target"} \text{ and } \text{"Target"} \text{ is defined and } y \geq y_t^* \\
    y, & \text{if Desired Value is } \text{"Less Than Target"} \text{ and } \text{"Target"} \text{ is defined and } y < y_t^* \\
    y_t^*, & \text{if Desired Value is } \text{"Near Target"} \\
    y, & \text{if Desired Value is } \text{"Greater Than Target"} \text{ and } \text{"Target"} \text{ is defined and } y > y_t^* \\
    y_t^{*}, & \text{if Desired Value is } \text{"Greater Than Target"} \text{ and } \text{"Target"} \text{ is defined and } y \leq y_t^{*} \\
    y_u, & \text{if Desired Value is } \text{"Maximum Possible"} \text{ and a } \text{"Target"} \text{ value is not defined} 
\end{cases}
\]

where:

\[ y_t^* = \text{user-specified target value} \]

Thus, Equation 16 and Equation 17 constitute the input parameter goals for the continuous input parameters and Equation 16 and Equation 18 constitute the response parameter goals.

The following section considers the case where the continuous input parameters have discrete Usable Values (menu item “List of Discrete Values”) and there may be discrete input parameters of type “Discrete.” Let us consider the case where the Usable Values of the continuous input parameter are defined as the following:

\[
X = \{X_0, X_1, \ldots, X_{i-1}\}
\]

where:

\[ X_i = \text{discrete Usable Values} \]
with 1 usable values, the following metric is defined:

\[ P_k = \frac{|x_t - x|}{|x_{\text{MAX}} - x_{\text{MIN}}|} \]  

(20)

where, as before,

- \( x_{\text{MAX}} \) = upper bound of the usable values
- \( x_{\text{MIN}} \) = lower bound of the usable values

The target value \( x_t \) is given by the following:

\[
x_t = \begin{cases} 
  x_t^*, & \text{if Desired Value is "No Preference"} \\
  x_t^*, & \text{if Desired Value is "Less Than Target" and "Target" is defined and } x \geq x_t^* \\
  x_t, & \text{if Desired Value is "Less Than Target" and "Target" is defined and } x < x_t^* \\
  x_t^*, & \text{if Desired Value is "Near Target"} \\
  x_t, & \text{if Desired Value is "Greater Than Target" and "Target" is defined and } x > x_t^* \\
  x_t^*, & \text{if Desired Value is "Greater Than Target" and "Target" is defined and } x \leq x_t^* 
\end{cases}
\]  

(21)

Thus, the GDO objective equation becomes the following (for parameters with discrete Usable Values).

\[ \Phi \equiv \sum_{i=1}^{n} w_i N_i + \sum_{j=1}^{m} w_j M_j + \sum_{l=1}^{p} w_l P_l \]  

(22)

Therefore, Equation 15, Equation 16, and Equation 20 constitute the input parameter goals for parameters which may be continuous or possess discrete usable values.

The norms and goals as in equations Equation 20 and Equation 20 are also adopted to define the input goals for the discrete input parameters of the type "Discrete"; i.e., those discrete parameters whose Usable Alternatives indicate a whole number of some particular design feature (number of holes in a plate, number of stiffeners, etc.). Discrete input parameters of type “Scenario,” where the Usable Alternatives may indicate some discrete configuration or type (like material name) and for which, consequently, no specific whole value can be attached, are treated differently. The following metric is defined for “Scenario” parameters, where \( N_q \) is the total number of “Scenario” parameter Usable Alternatives.

\[
Q_k = \begin{cases} 
  0 & \text{if Desired Value = “Near Target” and current Usable Alternative = Target} \\
  0 & \text{if Desired Value = “No Preference”} \\
  1/N_q & \text{if Desired Value = “Near Target” and current Usable Alternative \neq Target} 
\end{cases}
\]  

(23)

Thus, equations Equation 15, Equation 16, and Equation 20 constitute the input parameter goals for “Discrete” parameters and equations Equation 15, Equation 16, and Equation 22 constitute the input parameter goals for “Scenario” parameters.

Therefore, the GDO objective function equation for the most general case (where there are continuous and discrete parameters) can be written as the following:
\[ \Phi \equiv \sum_{i=1}^{n} w_i N_i + \sum_{j=1}^{m} w_j M_j + \sum_{l=1}^{l} w_l P_l + \sum_{k=1}^{s} w_k Q_k \]  
(24)

where:

- \( n \) = number of Continuous Input parameters
- \( m \) = number of Continuous Output parameters
- \( l \) = number of Continuous Input parameters with Usability Levels and “Discrete” parameters
- \( s \) = number of “Scenario” parameters

From the normed values it is obvious that the lower the value of \( \Phi \), the better the design with respect to the desired values and importances. Thus, a quasi-random uniform sampling of design points is done by a Hammersley algorithm and the samples are sorted in ascending order of \( \Phi \). The desired number of designs are then drawn from the top of the sorted list. A crowding technique is employed to ensure that any two sampled design points are not very close to each other. The crowding is done for all parameter studies except for the case where preferences are activated only on “Scenario” parameters.
Six Sigma Analysis

A Six Sigma Analysis allows you to determine the extent to which uncertainties in the model affect the results of an analysis. An uncertainty (or random quantity) is a parameter whose value is impossible to determine at a given point in time (if it is time-dependent) or at a given location (if it is location-dependent). An example is ambient temperature; you cannot know precisely what the temperature will be one week from now in a given city.

A Six Sigma Analysis uses statistical distribution functions (such as the Gaussian, or normal, distribution, the uniform distribution, etc.) to describe uncertain parameters.

Six Sigma Analysis allows you to determine whether your product satisfies Six Sigma quality criteria. A product has Six Sigma quality if only 3.4 parts out of every 1 million manufactured fail. This quality definition is based on the assumption that a response parameter relevant to the quality and performance assessment follows a Gaussian distribution, as shown below.

A response parameter that characterizes product performance is typically used to determine whether a product’s performance is satisfactory. The parameter must fall within the interval bounded by the lower specification limit (LSL) and the upper specification limit (USL). Sometimes only one of these limits exists.

An example of this is a case when the maximum von Mises stress in a component must not exceed the yield strength. The relevant response parameter is, of course, the maximum von Mises stress and the USL is the yield strength. The lower specification limit is not relevant. The area below the probability density function falling outside the specification interval is a direct measure of the probability that the product does not conform to the quality criteria, as shown above. If the response parameter does follow a Gaussian distribution, then the product satisfies a Six Sigma quality criterion, if both specification limits are at least six standard deviations away from the mean value.
Six Sigma Analysis

In reality, a response parameter rarely exactly follows a Gaussian distribution. However, the definition of Six Sigma quality is inherently probabilistic -- it represents an admissible probability that parts do not conform to the quality criteria defined by the specified limits. DesignXplorer can calculate the non-conformance probability no matter which distribution the response parameter actually follows. For distributions other than Gaussian, the Six Sigma level is not really six standard deviations away from the mean value, but it does represent a probability of 3.4 parts per million, which is consistent with the definition of Six Sigma quality.

This section describes the Six Sigma Analysis tool and how to use it to perform a Six Sigma Analysis.

Understanding Six Sigma Analysis

Computer models are described with specific numerical and deterministic values: material properties are entered using certain values, the geometry of the component is assigned a certain length or width, etc. An analysis based on a given set of specific numbers and values is called a deterministic analysis. The accuracy of a deterministic analysis depends upon the assumptions and input values used for the analysis.

While scatter and uncertainty naturally occur in every aspect of an analysis, deterministic analyses do not take them into account. To deal with uncertainties and scatter, use Six Sigma Analysis, which you can use to answer the following questions:

- If the input variables of a finite element model are subject to scatter, how large is the scatter of the output parameters? How robust are the output parameters? Here, output parameters can be any parameter that ANSYS Workbench can calculate. Examples are the temperature, stress, strain, or deflection at a node, the maximum temperature, stress, strain, or deflection of the model, etc.
- If the output is subject to scatter due to the variation of the input variables, then what is the probability that a design criterion given for the output parameters is no longer met? How large is the probability that an unexpected and unwanted event takes place (i.e., what is the failure probability)?
- Which input variables contribute the most to the scatter of an output parameter and to the failure probability? What are the sensitivities of the output parameter with respect to the input variables?

Six Sigma Analysis can be used to determine the effect of one or more variables on the outcome of the analysis. In addition to the Six Sigma Analysis techniques available, ANSYS Workbench offers a set of strategic tools to enhance the efficiency of the Six Sigma Analysis process. For example, you can graph the effects of one input variable versus an output parameter, and you can easily add more samples and additional analysis loops to refine your analysis.

In traditional deterministic analyses, uncertainties are either ignored or accounted for by applying conservative assumptions. You would typically ignore uncertainties if you know for certain that the input parameter has no effect on the behavior of the component under investigation. In this case, only the mean values or some nominal values are used in the analysis. However, in some situations, the influences of uncertainties exist but is still neglected, as for the thermal expansion coefficient, for which the scatter is usually ignored.

Example 1 Accounting for Uncertainties

If you are performing a thermal analysis and want to evaluate the thermal stresses, the equation is:

\[ \sigma_{\text{therm}} = E \alpha \Delta T \]

because the thermal stresses are directly proportional to the Young's modulus as well as to the thermal expansion coefficient of the material.

The table below shows the probability that the thermal stresses will be higher than expected, taking uncertainty variables into account.
Reliability, Quality, and Safety Issues

Use Six Sigma Analysis when issues of reliability, quality, and safety are paramount.

Reliability is typically a concern when product or component failures have significant financial consequences (costs of repair, replacement, warranty, or penalties) or worse, can result in injury or loss of life.

If you use a conservative assumption, the difference in thermal stresses shown above tells you that uncertainty or randomness is involved. Conservative assumptions are usually expressed in terms of safety factors. Sometimes regulatory bodies demand safety factors in certain procedural codes. If you are not faced with such restrictions or demands, then using conservative assumptions and safety factors can lead to inefficient and costly over-design. By using Six Sigma Analysis methods, you can avoid over-design while still ensuring the safety of the component.

Six Sigma Analysis methods even enable you to quantify the safety of the component by providing a probability that the component will survive operating conditions. Quantifying a goal is the necessary first step toward achieving it.

Guidelines for Selecting Six Sigma Analysis Variables

This section presents useful guidelines for defining your Six Sigma Analysis variables.

Choosing and Defining Uncertainty Variables

First, you should:

- Specify a reasonable range of values for each uncertainty variable.
- Set reasonable limits on the variability for each uncertainty variable.

Uncertainty Variables for Response Surface Analyses

The number of simulation loops that are required for a Response Surface analysis depends on the number of uncertainty variables. Therefore, you want to select the most important input variable(s), the ones you know have a significant impact on the result parameters. If you are unsure which uncertainty variables are important, include all of the random variables you can think of and then perform a Monte Carlo Simulation. After you learn which uncertainty variables are important and should be included in your Response Surface Analysis, you can eliminate those that are unnecessary.
Choosing a Distribution for a Random Variable

The type and source of the data you have determines which distribution functions can be used or are best suited to your needs.

Measured Data

If you have measured data, then you must first know how reliable that data is. Data scatter is not just an inherent physical effect, but also includes inaccuracy in the measurement itself. You must consider that the person taking the measurement might have applied a “tuning” to the data. For example, if the data measured represents a load, the person measuring the load may have rounded the measurement values; this means that the data you receive are not truly the measured values. The amount of this tuning could provide a deterministic bias in the data that you need to address separately. If possible, you should discuss any bias that might have been built into the data with the person who provided that data to you.

If you are confident about the quality of the data, then how you proceed depends on how much data you have. In a single production field, the amount of data is typically sparse. If you have only a small amount of data, use it only to evaluate a rough figure for the mean value and the standard deviation. In these cases, you could model the uncertainty variable as a Gaussian distribution if the physical effect you model has no lower and upper limit, or use the data and estimate the minimum and maximum limit for a uniform distribution.

In a mass production field, you probably have a lot of data. In these cases you could use a commercial statistical package that will allow you to actually fit a statistical distribution function that best describes the scatter of the data.

Mean Values, Standard Deviation, Exceedance Values

The mean value and the standard deviation are most commonly used to describe the scatter of data. Frequently, information about a physical quantity is given as a value such as “100±5.5.” Often, this form means that the value “100” is the mean value and “5.5” is the standard deviation. Data in this form implies a Gaussian distribution, but you must verify this (a mean value and standard deviation can be provided for any collection of data regardless of the true distribution type). If you have more information, for example, you know that the data is lognormal distributed, then Six Sigma Analysis allows you to use the mean value and standard deviation for a lognormal distribution.

Sometimes the scatter of data is also specified by a mean value and an exceedance confidence limit. The yield strength of a material is sometimes given in this way; for example, a 99% exceedance limit based on a 95% confidence level is provided. This means that, from the measured data, we can be sure by 95% that in 99% of all cases the property values will exceed the specified limit and only in 1% of all cases will they drop below the specified limit. The supplier of this information is using the mean value, the standard deviation, and the number of samples of the measured data to derive this kind of information. If the scatter of the data is provided in this way, the best way to pursue this further is to ask for more details from the data supplier. Because the given exceedance limit is based on the measured data and its statistical assessment, the supplier might be able to provide you with the details that were used.

If the data supplier does not give you any further information, then you could consider assuming that the number of measured samples was large. If the given exceedance limit is denoted with \( x_{1 - \alpha/2} \) and the given mean value is denoted with \( \mu \), then the standard deviation can be derived from the equation:

\[
\sigma = \frac{x_{1 - \alpha/2} - \mu}{C}
\]
where the values for the coefficient $C$ are:

<table>
<thead>
<tr>
<th>Exceedance Probability</th>
<th>$C$</th>
</tr>
</thead>
<tbody>
<tr>
<td>99.5%</td>
<td>2.5758</td>
</tr>
<tr>
<td>99.0%</td>
<td>2.3263</td>
</tr>
<tr>
<td>97.5%</td>
<td>1.9600</td>
</tr>
<tr>
<td>95.0%</td>
<td>1.6449</td>
</tr>
<tr>
<td>90.0%</td>
<td>1.2816</td>
</tr>
</tbody>
</table>

No Data

In situations where no information is available, there is never just one right answer. Below are hints about which physical quantities are usually described in terms of which distribution functions. This information might help you with the particular physical quantity you have in mind. Also below is a list of which distribution functions are usually used for which kind of phenomena. Keep in mind that you might need to choose from multiple options.

Geometric Tolerances

- If you are designing a prototype, you could assume that the actual dimensions of the manufactured parts would be somewhere within the manufacturing tolerances. In this case it is reasonable to use a uniform distribution, where the tolerance bounds provide the lower and upper limits of the distribution function.
- If the manufacturing process generates a part that is outside the tolerance band, one of two things may happen: the part must either be fixed (reworked) or scrapped. These two cases are usually on opposite ends of the tolerance band. An example of this is drilling a hole. If the hole is outside the tolerance band, but it is too small, the hole can just be drilled larger (reworked). If, however, the hole is larger than the tolerance band, then the problem is either expensive or impossible to fix. In such a situation, the parameters of the manufacturing process are typically tuned to hit the tolerance band closer to the rework side, steering clear of the side where parts need to be scrapped. In this case, a Beta distribution is more appropriate.
- Often a Gaussian distribution is used. The fact that the normal distribution has no bounds (it spans minus infinity to infinity), is theoretically a severe violation of the fact that geometrical extensions are described by finite positive numbers only. However, in practice, this lack of bounds is irrelevant if the standard deviation is very small compared to the value of the geometric extension, as is typically true for geometric tolerances.

Material Data

- Very often the scatter of material data is described by a Gaussian distribution.
- In some cases the material strength of a part is governed by the “weakest-link theory.” The “weakest-link theory” assumes that the entire part will fail whenever its weakest spot fails. For material properties where the “weakest-link” assumptions are valid, the Weibull distribution might be applicable.
- For some cases, it is acceptable to use the scatter information from a similar material type. For example, if you know that a material type very similar to the one you are using has a certain material property with a Gaussian distribution and a standard deviation of ±5% around the measured mean value, then you can assume that for the material type you are using, you only know its mean value. In this case, you could consider using a Gaussian distribution with a standard deviation of ±5% around the given mean value.
Load Data

For loads, you usually only have a nominal or average value. You could ask the person who provided the nominal value the following questions: Out of 1000 components operated under real life conditions, what is the lowest load value any one of the components sees? What is the most likely load value? That is, what is the value that most of these 1000 components are subject to? What is the highest load value any one component would be subject to? To be safe you should ask these questions not only of the person who provided the nominal value, but also to one or more experts who are familiar with how your products are operated under real-life conditions. From all the answers you get, you can then consolidate what the minimum, the most likely, and the maximum value probably is. As verification, compare this picture with the nominal value that you would use for a deterministic analysis. The nominal value should be close to the most likely value unless using a conservative assumption. If the nominal value includes a conservative assumption (is biased), then its value is probably close to the maximum value. Finally, you can use a triangular distribution using the minimum, most likely, and maximum values obtained.

You also have to distinguish if the load values are random fields or single random variables. If the load is different from node to node (element to element), then it is most appropriate to include the program calculating the load in the analysis file. If the load is described by one or very few constant values, then you can also consider performing a Six Sigma Analysis with the program calculating these load values. Again, you need to provide an interface to transfer input data to this program and get output data (the loads) back to ANSYS. If there is more than just one single load value generated by the program, then you should also check for potential correlations.

Distribution Functions

Beta Distribution

You provide the shape parameters \( r \) and \( t \) and the lower and the upper limit \( x_{\text{min}} \) and \( x_{\max} \) of the random variable \( x \).

The Beta distribution is very useful for random variables that are bounded at both sides. If linear operations are applied to random variables that are all subjected to a uniform distribution, then the results can usually be described by a Beta distribution. For example, if you are dealing with tolerances and assemblies where the components are assembled and the individual tolerances of the components follow a uniform distribution (a special case of the Beta distribution), the overall tolerances of the assembly are a function of adding or subtracting the geometrical extension of the individual components (a linear operation). Hence, the overall tolerances of the assembly can be described by a Beta distribution. Also, as previously mentioned, the Beta distribution can be useful for describing the scatter of individual geometrical extensions of components as well.
Exponential Distribution

You provide the decay parameter $\lambda$ and the shift (or lower limit) $x_{\text{min}}$ of the random variable $x$.

The exponential distribution is useful in cases where there is a physical reason that the probability density function is strictly decreasing as the uncertainty variable value increases. The distribution is mostly used to describe time-related effects; for example, it describes the time between independent events occurring at a constant rate. It is therefore very popular in the area of systems reliability and lifetime-related systems reliability, and it can be used for the life distribution of non-redundant systems. Typically, it is used if the lifetime is not subjected to wear-out and the failure rate is constant with time. Wear-out is usually a dominant life-limiting factor for mechanical components that would preclude the use of the exponential distribution for mechanical parts. However, where preventive maintenance exchanges parts before wear-out can occur, then the exponential distribution is still useful to describe the distribution of the time until exchanging the part is necessary.

Gaussian (Normal) Distribution

You provide values for the mean value $\mu$ and the standard deviation $\sigma$ of the random variable $x$.

The Gaussian, or normal, distribution is a fundamental and commonly-used distribution for statistical matters. It is typically used to describe the scatter of the measurement data of many physical phenomena. Strictly speaking, every random variable follows a normal distribution if it is generated by a linear combination of a very large number of other random effects, regardless which distribution these random effects originally follow. The Gaussian distribution is also valid if the random variable is a linear combination of two or more other effects if those effects also follow a Gaussian distribution.
Lognormal Distribution

You provide values for the logarithmic mean value $\xi$ and the logarithmic deviation $\delta$. The parameters $\xi$ and $\delta$ are the mean value and standard deviation of $\ln(x)$:

$$f(x, \xi, \delta) = \frac{1}{\sqrt{2\pi} \cdot \sigma} \cdot \exp \left( -\frac{1}{2} \left( \frac{\ln(x) - \xi}{\delta} \right)^2 \right)$$

The lognormal distribution is another basic and commonly-used distribution, typically used to describe the scatter of the measurement data of physical phenomena, where the logarithm of the data would follow a normal distribution. The lognormal distribution is suitable for phenomena that arise from the multiplication of a large number of error effects. It is also used for random variables that are the result of multiplying two or more random effects (if the effects that get multiplied are also lognormally distributed). It is often used for lifetime distributions such as the scatter of the strain amplitude of a cyclic loading that a material can endure until low-cycle-fatigue occurs.

Uniform Distribution

You provide the lower and the upper limit $x_{\text{min}}$ and $x_{\text{max}}$ of the random variable $x$.

The uniform distribution is a fundamental distribution for cases where the only information available is a lower and an upper limit. It is also useful to describe geometric tolerances. It can also be used in cases where any value of the random variable is as likely as any other within a certain interval. In this sense, it can be used for cases where “lack of engineering knowledge” plays a role.
Triangular Distribution

You provide the minimum value $x_{\text{min}}$, the most likely value limit $x_{\text{mlv}}$ and the maximum value $x_{\text{max}}$.

The triangular distribution is most helpful to model a random variable when actual data is not available. It is very often used to capture expert opinions, as in cases where the only data you have are the well-founded opinions of experts. However, regardless of the physical nature of the random variable you want to model, you can always ask experts questions like “Out of 1000 components, what are the lowest and highest load values for this random variable?” and other similar questions. You should also include an estimate for the random variable value derived from a computer program, as described above. For more details, see Section : Choosing a Distribution for a Random Variable.

Truncated Gaussian Distribution

You provide the mean value $\mu$ and the standard deviation $\sigma$ of the non-truncated Gaussian distribution and the truncation limits $x_{\text{min}}$ and $x_{\text{max}}$.

The truncated Gaussian distribution typically appears where the physical phenomenon follows a Gaussian distribution, but the extreme ends are cut off or are eliminated from the sample population by quality control measures. As such, it is useful to describe the material properties or geometric tolerances.
Weibull Distribution

You provide the Weibull characteristic value \(x_{chr}\), the Weibull exponent \(m\) and the minimum value \(x_{min}\). Special cases: For \(x_{min} = 0\) the distribution coincides with a two-parameter Weibull distribution. The Rayleigh distribution is a special case of the Weibull distribution with \(\alpha = x_{chr} - x_{min}\) and \(m = 2\).

In engineering, the Weibull distribution is most often used for strength or strength-related lifetime parameters, and is the standard distribution for material strength and lifetime parameters for very brittle materials (for these very brittle material the “weakest-link theory” is applicable). For more details, see Section: Choosing a Distribution for a Random Variable.

Sample Generation

For Six Sigma Analysis, the sample generation is based on the Latin Hypercube Sampling (LHS) technique. The LHS technique is a more advanced and efficient form of Monte Carlo Simulation methods. The only difference between LHS and the Direct Monte Carlo Sampling technique is that LHS has a sample “memory,” meaning it avoids repeating samples that have been evaluated before (it avoids clustering samples). It also forces the tails of a distribution to participate in the sampling process. Generally, the LHS technique requires 20% to 40% fewer simulations loops than the Direct Monte Carlo Simulation technique to deliver the same results with the same accuracy. However, that number is largely problem-dependent.

Postprocessing Six Sigma Analysis Results

- Section: Histogram
- Section: Cumulative Distribution Function
- Section: Probability and Inverse Probability Tables
- Section: Sensitivities
- Section: Theory

Histogram

A histogram plot is most commonly used to visualize the scatter of a Six Sigma Analysis variable. A histogram is derived by dividing the range between the minimum value and the maximum value into intervals of equal size. Then Six Sigma Analysis determines how many samples fall within each interval, that is, how many “hits” landed in each interval.

Six Sigma Analysis also allows you to plot histograms of your uncertainty variables so you can double-check that the sampling process generated the samples according to the distribution function you specified. For uncertainty variables, Six Sigma Analysis not only plots the histogram bars, but also a curve for values derived from the dis-
tribution function you specified. Visualizing histograms of the uncertainty variables is another way to verify that enough simulation loops have been performed. If the number of simulation loops is sufficient, the histogram bars will:

- Be close to the curve that is derived from the distribution function
- Be “smooth” (without large “steps”)
- Not have major gaps (no hits in an interval where neighboring intervals have many hits)

However, if the probability density function is flattening out at the far ends of a distribution (for example, the exponential distribution flattens out for large values of the uncertainty variable) then there might logically be gaps. Hits are counted only as positive integer numbers and as these numbers gradually get smaller, a zero hit can happen in an interval.

**Cumulative Distribution Function**

The cumulative distribution function is a primary review tool if you want to assess the reliability or the failure probability of your component or product. Reliability is defined as the probability that no failure occurs. Hence, in a mathematical sense, reliability and failure probability are different ways of examining the same problem and numerically they complement each other (they sum to 1.0). The cumulative distribution function value at any given point expresses the probability that the respective parameter value will remain below that point.

The value of the cumulative distribution function at the location \( x_0 \) is the probability that the values of \( X \) stay below \( x_0 \). Whether this probability represents the failure probability or the reliability of your component depends on how you define failure; for example, if you design a component such that a certain deflection should not exceed a certain admissible limit, then a failure event occurs if the critical deflection exceeds this limit. Thus, for this example, the cumulative distribution function is interpreted as the reliability curve of the component. On the other hand, if you design a component such that the eigenfrequencies are beyond a certain admissible limit, then a failure event occurs if an eigenfrequency drops below this limit. So for this example, the cumulative distribution function is interpreted as the failure probability curve of the component.

The cumulative distribution function also lets you visualize what the reliability or failure probability would be if you chose to change the admissible limits of your design.

A cumulative distribution function plot is an important tool to quantify the probability that the design of your product does or does not satisfy quality and reliability requirements. The value of a cumulative distribution function of a particular response parameter represents the probability that the response parameter will remain below a certain level as indicated by the values on the x-axis of the plot.

**Example 2**

As shown in Figure 1: “Illustration of cumulative distribution function”, the probability that the Shear Stress Maximum will remain less than a limit value of 1.71E+5 is about 93%, which also means that there is a 7% probability that the Shear Stress Maximum will exceed the limit value of 1.71E+5.
**Figure 1 Illustration of cumulative distribution function**

For more information, see Section : Theory.

**Probability and Inverse Probability Tables**

Instead of reading data from the cumulative distribution chart, DesignXplorer also allows you to obtain important information about the cumulative distribution function in tabular form. DesignXplorer provides a **Probability Table** that is designed to provide probability values for an even spread of levels of the parameter. The Probability to Parameter table lets you find out the parameter levels corresponding to probability levels that are typically used for the design of reliable products. If you want to see the probability of a value that is not listed, you can add it to the table. Likewise, you can add a probability or sigma-level and see the corresponding values. You can also delete values from the table. For more information, see Section : Using Statistical Postprocessing.
Figure 2 Probability Tables

Note — Both tables will have more rows, i.e., include more data, if the number of samples is increased. If you are designing for high product reliability, i.e., a low probability that it does not conform to quality or performance requirements, then the sample size must be adequately large to address those low probabilities. Typically, if your product does not conform to the requirements denoted with “Preq,” then the minimum number of samples should be determined by: Nsamp = 10.0 / Preq.

For example, if your product has a probability of Preq=1.0 e-4 that it does not conform to the requirements, then the minimum number of samples should be Nsamp = 10.0 / 1.0e-4 = 10e+5.

Sensitivities

The sensitivity plots available in DesignXplorer allow you to efficiently improve your design toward a more reliable and better quality design, or to save money in the manufacturing process while maintaining the reliability and quality of your product. You can request a sensitivity plot for any response or derived parameter in your model.

The sensitivities available under the Six Sigma Analysis and the Goal Driven Optimization views are statistical sensitivities. Statistical sensitivities are global sensitivities, whereas the single parameter sensitivities available under the Responses view are local sensitivities. The global, statistical sensitivities are based on a correlation analysis using the generated sample points, which are located throughout the entire space of input parameters. The local single parameter sensitivities are based on the difference between the minimum and maximum value obtained by varying one input parameter while holding all other input parameters constant. As such, the values obtained for single parameter sensitivities depends on the values of the input parameters that are held constant.
Global, statistical sensitivities do not depend on the settings for the input parameters, because all possible values for the input parameters are already taken into account when determining the sensitivities.

To display statistical sensitivities, DesignXplorer groups the input parameters into two groups: significant and insignificant. DesignXplorer displays sensitivities as both a bar chart and pie chart. Sensitivities are ranked such that the most important input parameters appear first.

In the bar charts, the most important uncertainty variable (with the highest sensitivity) appears at the top and the others follow below in the order of their importance. The charts describe the sensitivities in an absolute fashion (taking the signs into account); a positive sensitivity indicates that increasing the value of the uncertainty variable increases the value of the result parameter for which the sensitivities are plotted. Conversely, a negative sensitivity indicates that increasing the uncertainty variable value reduces the result parameter value.

In the pie charts, sensitivities are relative to each other. The most important uncertainty variable (with the highest sensitivity) will appear first after the 12 o’clock position, and the others follow in clockwise direction in the order of their importance.

Using a sensitivity plot, you can answer the following important questions.

**How can I make the component more reliable or improve its quality?**

If the results for the reliability or failure probability of the component do not reach the expected levels, or if the scatter of an output parameter is too wide and therefore not robust enough for a quality product, then you should make changes to the important input variables first. Modifying an input variable that is insignificant would be waste of time.

Of course, you are not in control of all uncertainty parameters. A typical example where you have very limited means of control are material properties. For example, if it turns out that the environmental temperature (outdoor) is the most important input parameter, then there is probably nothing you can do. However, even if you find out that the reliability or quality of your product is driven by parameters that you cannot control, this data has importance -- it is likely that you have a fundamental flaw in your product design! You should watch for influential parameters like these.

If the input variable you want to tackle is a geometry-related parameter or a geometric tolerance, then improving the reliability and quality of your product means that it might be necessary to change to a more accurate manufacturing process or use a more accurate manufacturing machine. If it is a material property, then there might be nothing you can do about it. However, if you only had a few measurements for a material property and consequently used only a rough guess about its scatter, and the material property turns out to be an important driver of product reliability and quality, then it makes sense to collect more raw data.

**How can I save money without sacrificing the reliability or the quality of the product?**

If the results for the reliability or failure probability of the component are acceptable or if the scatter of an output parameter is small and therefore robust enough for a quality product, then there is usually the question of how to save money without reducing the reliability or quality. In this case, you should first make changes to the input variables that turned out to be insignificant, because they do not effect the reliability or quality of your product. If it is the geometrical properties or tolerances that are insignificant, you can consider applying a less expensive manufacturing process. If a material property turns out to be insignificant, then this is not typically a good way to save money, because you are usually not in control of individual material properties. However, the loads or boundary conditions can be a potential for saving money, but in which sense this can be exploited is highly problem-dependent.
Theory

The purpose of a Six Sigma Analysis is to gain an understanding of the impact of uncertainties associated with the input parameter of your design. This goal is achieved using a variety of statistical measures and postprocessing tools.

Statistical Postprocessing

Convention: Set of data $x_i$.

1. **Mean Value**

   Mean is a measure of average for a set of observations. The mean of a set of $n$ observations is defined as follows:
   \[
   \hat{\mu} = \frac{1}{n} \sum_{i=1}^{n} y_i
   \]  
   \[ (1) \]

2. **Standard Deviation**

   Standard deviation is a measure of dispersion from the mean for a set of observations. The standard deviation of a set of $n$ observations is defined as follows:
   \[
   \hat{\sigma} = \sqrt{\frac{1}{n-1} \sum_{i=1}^{n} (y_i - \hat{\mu})^2}
   \]  
   \[ (2) \]

3. **Skewness**

   Skewness is a measure of degree of asymmetry around the mean for a set of observations. The observations are symmetric if distribution of the observations looks the same to the left and right of the mean. Negative skewness indicates the distribution of the observations being left-skewed. Positive skewness indicates the distribution of the observations being right-skewed. The skewness of a set of $n$ observations is defined as follows:
   \[
   \hat{\gamma} = \frac{n}{(n-1)(n-2)} \sum_{i=1}^{n} \left( \frac{y_i - \hat{\mu}}{\hat{\sigma}} \right)^3
   \]  
   \[ (3) \]

4. **Kurtosis**

   Kurtosis is a measure of relative peakedness/flatness of distribution for a set of observations. It is generally a relative comparison with the normal distribution. Negative kurtosis indicates a relatively flat distribution of the observations compared to the normal distribution, while positive kurtosis indicates a relatively peaked distribution of the observations. As such, the kurtosis of a set of $n$ observations is defined with calibration to the normal distribution as follows:
   \[
   \hat{\kappa} = \left[ \frac{n(n+1)}{(n-1)(n-2)(n-3)} \sum_{i=1}^{n} \left( \frac{y_i - \hat{\mu}}{\hat{\sigma}} \right)^4 \right] - \frac{3(n-1)^2}{(n-2)(n-3)}
   \]  
   \[ (4) \]
where \( \mu \) and \( \sigma \) represent mean and standard deviation, respectively.

**Table 1** Different Types of Kurtosis

<table>
<thead>
<tr>
<th>( \kappa )</th>
<th>Distribution Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \kappa &lt; 0 )</td>
<td>Flat distribution</td>
</tr>
<tr>
<td>( \kappa = 0 )</td>
<td>Normal distribution</td>
</tr>
<tr>
<td>( \kappa &gt; 0 )</td>
<td>Peaked distribution</td>
</tr>
</tbody>
</table>

5. **Shannon Entropy**

Entropy is a concept first introduced in classical thermodynamics. It is a measure of disorder in a system. The concept of entropy was later extended and recognized by Claude Shannon in the domain of information/communication as a measure of uncertainty over the true content of a message. In statistics, the entropy is further reformulated as a function of mass density, as follows:

\[
H = -\sum P_i \ln P_i
\]  

(5)

where \( P_i \) represents mass density of a parameter. In the context of statistics/probability, entropy becomes a measure of complexity and predictability of a parameter. A more complex, and less predictable, parameter carries higher entropy, and vice versa. For example, a parameter characterized with uniform distribution has higher entropy than that with truncated triangular distribution (within the same bounds). Hence, the parameter characterized with uniform distribution is less predictable compared to the triangular distribution. In the context of robust design, a response parameter is more robust if the Shannon entropy is minimized.

\[
P_i = \frac{N_i}{N \cdot \Delta w}
\]  

(6)

DesignXplorer uses the probability mass in a normalized fashion, such that not only the shape, but the range of variability, or the distribution is accounted for. This is shown in Equation 6, where \( N_i/N \) is the relative frequency of the parameter falling into a certain interval, and \( \Delta w \) is the width of the interval. As a result, Shannon entropy can have a negative value. Below are some comparisons of the Shannon entropy, where \( S_2 \) is smaller than \( S_1 \).
6. **Taguchi Signal-to-Noise Ratios**

Signal-to-noise ratios were introduced by Genichi Taguchi as a quality control measure for robust design. In robust design, the relationship between design parameters and product performance is explored to perform correctly and predictably in the presence of controllable design parameters and uncontrollable noise factors. In essence, robust design is seeking to design a product or a process which is insensitive, or robust, to the causes of quality problems by maximizing performance and minimizing variation. The signal-to-noise ratio has the following three forms:

- **Larger is Better.** A measure used for characterizing response parameters such as material yield. Robust design seeks to maximize the measure, which is defined as follows:
  \[ \eta = -10 \log \left( \frac{1}{n} \sum_{i=1}^{n} \frac{1}{y_i^2} \right) \]  
  \[ (7) \]

- **Smaller is Better.** A measure used for characterizing response parameters such as model deformation. Robust design seeks to maximize the measure, which is defined as follows:
  \[ \eta = -10 \log \left( \frac{1}{n} \sum_{i=1}^{n} y_i^2 \right) \]  
  \[ (8) \]

- **Nominal is Best.** A measure used for characterizing design parameters such as model dimension in a tolerance design, in which a specific dimension is required, with an acceptable standard deviation. Robust design seeks to maximize this measure. However, it is noted that the maximization can happen to either the standard deviation, the mean value, or both. Therefore, achieving the goal of maximization may not necessarily mean having an optimum design because the targeted/specified value may be off. The measure is defined as follows:
  \[ \eta = 20 \log \frac{\hat{\mu}}{\hat{\sigma}} \]  
  \[ (9) \]

where \( \hat{\mu} \) and \( \hat{\sigma} \) represent mean and standard deviation, respectively.

The three signal-to-noise ratios are mutually exclusive. Therefore, for a given parameter, only one of them can be parameterized.

**Caution:** The three signal-to-noise ratios inherently tie the goal of variation reduction together with the overall optimization problem, which makes them insufficient and inflexible for use in robust design.
Minimum and Maximum Values

The minimum and maximum values of a set of \( n \) observations are:

\[
x_{\min} = \min(x_1, x_2, \ldots, x_n)
\]

\[
x_{\max} = \max(x_1, x_2, \ldots, x_n)
\]

Note — The minimum and maximum values strongly depend on the number of samples. If you generate a new sample set with more samples, then chances are that the minimum value will be lower in the larger sample set. Likewise, the maximum value of the larger sample set will most likely be higher than for the original sample set. Hence, the minimum and maximum values should not be interpreted as absolute physical bounds.

Statistical Sensitivity Measures

The sensitivity charts displayed under the Six Sigma Analysis view are global sensitivities based on statistical measures (see Single Parameter Sensitivities). Generally, the impact of an input parameter on a response parameter is driven by:

- The amount by which the output parameter varies across the variation range of an input parameter.
- The variation range of an input parameter. Typically, the wider the variation range is, the larger the impact of the input parameter will be.

The statistical sensitivities used under Six Sigma Analysis are based on the Spearman-Rank Order Correlation coefficients that take both those aspects into account at the same time.

Basing sensitivities on correlation coefficients follows the concept that the more strongly a response parameter is correlated with a particular input parameter, the more sensitive it is with respect to changes of that input parameter.

Spearman Rank-Order Correlation Coefficient

The Spearman rank-order correlation coefficient is:

\[
r_s = \frac{\sum_{i=1}^{n} (R_i - \bar{R})(S_i - \bar{S})}{\sqrt{\sum_{i=1}^{n} (R_i - \bar{R})^2} \sqrt{\sum_{i=1}^{n} (S_i - \bar{S})^2}}
\]

where:

\[
R_i = \text{rank of } x_i \text{ within the set of observations } [x_1 x_2 \ldots x_n]^T
\]

\[
S_i = \text{rank of } y_i \text{ within the set of observations } [y_1 y_2 \ldots y_n]^T
\]

\[
\bar{R}, \bar{S} = \text{average ranks of } R_i \text{ and } S_i \text{ respectively}
\]
Since the sample size \( n \) is finite, the correlation coefficient \( r_p \) is a random variable itself. Hence, the correlation coefficient between two random variables \( X \) and \( Y \) usually yields a small, but nonzero value, even if \( X \) and \( Y \) are not correlated at all in reality. In this case, the correlation coefficient would be insignificant. Therefore, we need to find out if a correlation coefficient is significant or not. To determine the significance of the correlation coefficient, we assume the hypothesis that the correlation between \( X \) and \( Y \) is not significant at all, i.e., they are not correlated and \( r_p = 0 \) (null hypothesis). In this case the variable:

\[
t = r_p \sqrt{\frac{n-2}{1-r_p^2}}
\]  

(13)

is approximately distributed like the student's t-distribution with \( \nu = n - 2 \) degrees of freedom. The cumulative distribution function student's t-distribution is:

\[
A(t|\nu) = \frac{1}{\sqrt{\nu} \, B\left(\frac{1}{2}, \frac{\nu}{2}\right)} \int_{-t}^{t} \left(1 + \frac{x^2}{\nu}\right)^{-\frac{\nu+1}{2}} dx
\]

(14)

where:

\[ B(\ldots) = \text{complete Beta function} \]

There is no closed-form solution available for Equation 14. See Abramowitz and Stegun (Pocketbook of Mathematical Functions, abridged version of the Handbook of Mathematical Functions, Harry Deutsch, 1984) for more details.

The larger the correlation coefficient \( r_p \), the less likely it is that the null hypothesis is true. Also, the larger the correlation coefficient \( r_p \), the larger is the value of \( t \) from Equation 13 and consequently also the probability \( A(t|\nu) \) is increased. Therefore, the probability that the null hypothesis is true is given by \( 1-A(t|\nu) \). If \( 1-A(t|\nu) \) exceeds a certain significance level, for example 2.5%, then we can assume that the null hypothesis is true. However, if \( 1-A(t|\nu) \) is below the significance level, then it can be assumed that the null hypotheses is not true and that consequently the correlation coefficient \( r_p \) is significant. This limit can be changed in Section : DesignXplorer Options.

11. Cumulative Distribution Function

The cumulative distribution function of sampled data is also called the empirical distribution function. To determine the cumulative distribution function of sampled data, you need to order the sample values in ascending order. Let \( x_i \) be the sampled value of the random variable \( X \) having a rank of \( i \), i.e., being the \( i \th \) smallest out of all \( n \) sampled values. The cumulative distribution function \( F_i \) that corresponds to \( x_i \) is the probability that the random variable \( X \) has values below or equal to \( x_i \). Since we have only a limited amount of samples, the estimate for this probability is itself a random variable. According to Kecicioglu (Reliability Engineering Handbook, Vol. 1, 1991, Prentice-Hall, Inc.), the cumulative distribution function \( F_i \) associated with \( x_i \) is:

\[
\sum_{k=i}^{n} \frac{n!}{(n-k)!k!} F_i^k (1-F_i)^{n-k} = 50\%
\]

(15)

Equation 15 must be solved numerically.

12. Probability and Inverse Probability
The cumulative distribution function of sampled data can only be given at the individual sampled values \( x_1, x_2, \ldots, x_n \) using Equation 15. Hence, the evaluation of the probability that the random variable is less than or equal to an arbitrary value \( x \) requires an interpolation between the available data points.

If \( x \) is, for example, between \( x_i \) and \( x_{i+1} \), then the probability that the random variable \( X \) is less or equal to \( x \) is:

\[
P(X \leq x) = F_i + (F_{i+1} - F_i) \frac{x - x_i}{x_{i+1} - x_i}
\]

The cumulative distribution function of sampled data can only be given at the individual sampled values \( x_1, x_2, \ldots, x_n \) using Equation 15. Hence, the evaluation of the inverse cumulative distribution function for any arbitrary probability value requires an interpolation between the available data points.

The evaluation of the inverse of the empirical distribution function is most important in the tails of the distribution, where the slope of the empirical distribution function is flat. In this case, a direct interpolation between the points of the empirical distribution function similar to Equation 16 can lead to inaccurate results. Therefore, the inverse standard normal distribution function \( \Phi^{-1} \) is applied for all probabilities involved in the interpolation. If \( p \) is the requested probability for which we are looking for the inverse cumulative distribution function value, and \( p \) is between \( F_i \) and \( F_{i+1} \), then the inverse cumulative distribution function value can be calculated using:

\[
x = x_i + (x_{i+1} - x_i) \frac{\Phi^{-1}(p) - \Phi^{-1}(F_i)}{\Phi^{-1}(F_{i+1} + 1) - \Phi^{-1}(F_i)}
\]
Robust Design

- Section: What is Robust Design?
- Section: Guidelines and Best Practices
- Section: Theory

What is Robust Design?

Robust Design is a technique by which you can optimize a product so that its behavior is not only improved, but more predictable. In DesignXplorer, the product behavior is expressed using the response parameters you choose. For example, in a finite model, you might use the maximum stress or maximum deflection to decide whether the product behavior is acceptable.

Robust Design is based on assumptions regarding scatter, or uncontrollable uncertainties. Scatter in the input parameters that affect the response parameters will cause the response parameters to also be uncertain and therefore less predictable. Robust Design is based on the result parameters of a Six Sigma Analysis. Therefore, before you run a Robust Design analysis, you must first parameterize the results of a Six Sigma Analysis. To understand which Six Sigma Analysis parameters should be parameterized, look at how robustness can be defined and measured.

- Reduction of Variability: If the input parameters that affect response parameters are subjected to uncertainty and scatter, the response parameters are also uncertain; i.e., they will show variability to some degree. Used to reduce the variability of product behavior, you can use the following Six Sigma Analysis result parameters:
  - Standard Deviation: The standard deviation is a measure of how wide the scatter, or how large the variability, of the response parameter is. Minimizing the standard deviation will lead to a smaller range of variability; i.e., the chance that the response parameters will differ largely from the mean value decreases. Therefore, the goal of a Robust Design analysis is to minimize the standard deviation of a response parameter, as shown below.
Kurtosis: Kurtosis is a measure of how peaked a distribution is. When kurtosis increases, the distribution is more peaked, and fewer samples will be located further away from the mean value. Therefore, the goal of a Robust Design analysis is to maximize the kurtosis of a response parameter, as shown below. You should read Section: Guidelines and Best Practices before using kurtosis.
Signal-to-Noise Ratios: The goal of minimizing the standard deviation (or noise) of a response parameter is inherently coupled with the goal of shifting the mean value (or signal). Different ratios are appropriate for different shifts of the mean (e.g., for maximizing the mean, minimizing the mean, etc.). The goal of a Robust Design analysis is to minimize the noise, which means the signal-to-noise ratio of a response parameter must be maximized. You should read Section: Guidelines and Best Practices before using signal-to-noise ratios.

Shannon Entropy: Shannon entropy is a measure of the complexity or predictability of the distribution of a response parameter. Entropy is a measure of the irreversible loss a real engineering system experiences as compared to a perfectly efficient, lossless system. For the distribution of a response parameter, entropy is a measure of the loss of information for a result subjected to uncertainty as compared to a completely predictable result. For example, if you knew that a response parameter always has a value of 5.0, regardless of the input parameter values, the response parameter would be completely predictable and very easy to describe, because a single scalar value sufficiently characterizes its behavior as a function of the input parameters. When the response parameter is affected by randomness, the predictability is lost and its behavior as a function of the input parameters is no longer characterized by a single value, but is more complex. The wider the scatter of the response parameter, the more predictability is lost and the more complex its behavior characterization. Therefore, the goal of a Robust Design analysis is to minimize the Shannon entropy of a response parameter.

Six Sigma Analysis: Robust Design that is interpreted from a Six Sigma Analysis leads to an optimization problem that tries to achieve or enforce a design that satisfies Six Sigma Analysis quality goals, as outlined in Six Sigma Analysis. In this case, sigma levels (in probability and inverse probability tables) are used as Robust Design parameters. Depending on whether your focus is on the lower or upper specification limit, a Robust Design analysis will try to minimize the sigma level to below -6 or above +6, or both, as shown below. If +/- 6 is too strict (or not strict enough) for your study, you can adjust the value.

Reliability-based Optimization: In a more general probabilistic sense, a product can be considered robust if it is reliable. If interpreted this way, Robust Design becomes an optimization tool to improve product reliability. Here, reliability is the probability that the product functions as expected; i.e., conforms to the specification criteria. This is very similar to Six Sigma Analysis, except that here you deal directly with the probabilities as parameters (in probability and inverse probability tables) in one of two ways:
Robust Design

- Insert the value of the lower or upper specification limit in the probability table. You will then obtain the probability of the response parameter dropping below that limit, which can be parameterized. Depending on whether it is the lower or upper limit, the analysis will try to either minimize or maximize the probability. See Section: Guidelines and Best Practices for more details.

- Insert the targeted non-conformance probability into the inverse probability table. You will get a value for the response parameter corresponding to that non-conformance probability, which you can then parameterize. For a design that is not robust enough, the value will be outside the specified interval. Depending on whether it is the lower or upper limit, the analysis will try to either minimize or maximize the probability. See Section: Guidelines and Best Practices for more details.

Guidelines and Best Practices

Don’t Go to Extremes

Performing a Robust Design analysis does not always mean that the parameters must be strictly minimized or maximized. Here, minimization and maximization mean that the optimization tries to go to the extremes; e.g., if the probability of non-conformance is minimized, then Robust Design tries to achieve a design for which this probability is as low as possible. However, going to the extremes has a price. Making products more reliable or robust than they need to be can also make them more expensive.

For example, to ensure that the maximum stress does not exceed an admissible limit, you might make the component thicker in some places, which makes it heavier and more expensive. So, if your Robust Design analysis tries to reduce the standard deviation, increase a sigma level, or reduce the non-conformance probability, do not just minimize or maximize the quantities. Instead, if you have a target value for those quantities, use the analysis to find a design that is just on the correct side of the target; i.e., less or greater than the target value.

Use the Lower Tail of a Distribution

If you are working with probabilities that are close to 1.0, your results may be inaccurate because of rounding. A computer can easily distinguish between a value of 1e-12 and a value of 1e-15, but a computer with a 32-bit operating system cannot distinguish between

\[ 1.0 - 1e-12 = 0.999999999999 \]

and

\[ 1.0 - 1e-15 = 0.999999999999999. \]

Because a 32-bit computer can usually represent 8 or 9 significant digits. Since both numbers have more than 8 or 9 significant digits, they would both be rounded to 1.0. Therefore, if you work with the probabilities in the probability tables, you should use derived parameters to avoid this problem.

If you are working with a lower specification limit, then a Robust Design analysis might try to reduce the probability of dropping below that limit. In this case, you are working with the lower tail of the distribution of the response parameter, thus avoiding a rounding problem.

If you are working with the upper specification limit, you can avoid the rounding problem by using a derived parameter with the following equation.

\[ Y_{\text{Derived}} = Y_{\text{USL}} - Y \]
Here, \( Y_{\text{Derived}} \) is the name of the derived parameter, \( Y_{\text{USL}} \) is the value of the upper specification limit for the response parameter, and \( Y \) is the name of the response parameter itself. If the value of the response parameter exceeds the upper specification limit, the derived parameter becomes negative. The more the value of the response parameter exceeds the upper specification limit, the smaller the value of the derived parameter. Parameterizing the probability that the derived parameter is less than zero and then reducing that probability will not cause a rounding problem because you will be working with the lower tail of the distribution.

If you have a response parameter that is supposed to be bounded by both lower and upper specification limits, you should define a derived parameter with the following equation.

\[
Y_{\text{Derived}} = (Y_{\text{USL}} - Y) * (Y - Y_{\text{LSL}})
\]

This derived parameter will become negative whether the value of the response parameter drops below the lower limit or exceeds the upper limit. As above, you avoid the rounding problem.

If you are working with probabilities that are only moderately close to 1.0, such as 0.999 or 0.9999, you will not typically have a rounding problem, but you may still want to use a derived parameter.

You can also avoid the rounding problem by using sigma levels instead of probabilities. For example, a sigma level of 10.0 is approximately equivalent to a probability of 1.0 - 7.6e-24, which is a number so close to 1.0 that it would be rounded to 1.0. However, using the 10.0 sigma level can be represented without the rounding problem.

**Beware of Physically Conflicting Robust Design Goals**

DesignXplorer provides some safeguards to avoid conflicts in the definition of Robust Design problems, but cannot automatically detect and eliminate all possible ill-defined problems. For example, DesignXplorer does not allow you to parameterize Six Sigma Analysis results from different sample sets. For example, minimizing the mean value of a response parameter in one sample set while trying to maximize the mean value of the same parameter in another sample set is not allowed because it is a contradiction. Also, parameterizing the probability and sigma level from an inverse probability table for the same value of a response parameter is not possible, because they are directly related. Examples that might lead to similar conflicts but which cannot be automatically detected include:

- Parameterizing the mean value and either a probability, sigma level, or inverse probability value of the same response parameter at the same time.

Sometimes it makes sense to try to increase a mean value while at the same time reduce the probability of exceeding an upper limit time, as shown below. However, trying to increase a mean value and decrease the value of a response parameter at a probability of 50% is a conflict, because those two values are usually not far from each other. In fact, for symmetric distributions, the mean value and the 50% value are always identical.
• Parameterizing two probabilities, sigma levels, or inverse probability values for the same parameter at the same time.

If you are trying to achieve a design that is bounded by both lower and upper specification limits and you want a small probability of non-conformance on both sides, then you can insert both the lower and the upper specification limits in a probability table, parameterize both resulting probabilities, and run a Robust Design analysis that tries to push both probabilities to the desired levels. However, you may encounter the rounding problem mentioned above. Additionally, if you use probabilities that are too close to each other and try to push them apart in a Robust Design analysis. You may encounter convergence problems. You could encounter similar difficulties if you parameterize two sigma levels or inverse probability values.

Do Not Use Coupled Measures of Robustness

Signal-to-noise ratios inherently couple the goal of variance (noise) reduction to the goal of increasing or decreasing the overall location of the distribution of a response parameter (optimizing the signal). D.C. Montgomery (Design and Analysis of Experiments, 1991, John Wiley & Sons) and J.M. Parks (“On stochastic optimization: Taguchi methods™ demystified; its limitations and fallacy clarified,” Probabilistic Engineering Mechanics 16, 1, 2001, pg. 87-101) point out that coupling these goals makes signal-to-noise ratios inefficient and inflexible. Instead, parameterize the mean value or the 50% probability value as a measure for the location of a distribution and to use, for example, the standard deviation or Shannon entropy as a measure of variability, and then use Robust Design to independently move them toward your goals.

Do Not Use Statistically Unstable Measures of Robustness

Kurtosis is a fourth-order moment of the distribution of a response parameter. As such, it can be numerically unstable in an optimization that tries to increase it, which could lead to convergence problems for the optimization algorithm. The same holds true for minimum and maximum sample values from a sample set.

Theory

Robust Design is a combination of Goal Driven Optimization and Six Sigma Analysis. For theory information, refer to Goal Driven Optimization theory and Six Sigma Analysis theory.
Parameter Manager

The topics in this section cover the basics of using the DesignXplorer Parameter Manager accessible via the Simulation Tasks section of the Project Page. Accessible from the location are DesignXplorer Design of Experiments and DesignXplorer VT study, both of which are explained in the Overview section the Help.

What-if Parameter Studies

You can examine how the input parameters affect the output parameters by creating designs in a tabular view. To examine, highlight the Simulation link in the Project Page hierarchy.

Then click New DesignXplorer Parameter Manager in the Tasks pane.

Modify the parameter values and click Insert a new “What-If” design point under the table.

Continue to insert design points.
When done inserting design points, click Run in the toolbar. This will run an analysis of the design points that you captured. When the analysis is finished, click What-If Charts in the Views task pane to explore the results. The charts are designed to support plotting any input or output versus any other input or output.
What-If will also run with Simulation in Distributed/Asynch mode.
Walkthroughs

- Section: Design of Experiment Walkthrough
- Section: DesignXplorer VT Walkthrough
- Section: Discrete Optimization Walkthrough
- Section: APDL and Goal Driven Optimization Walkthrough
- Section: APDL and Six Sigma Analysis Walkthrough
- Section: APDL and Robust Design Walkthrough

Design of Experiment Walkthrough

The following example builds the model shown below with a moment and a fixed support.

A standard Simulation is performed after importing the model from its CAD system, followed by a DesignXplorer analysis. The following steps begin before a Simulation solution is obtained.
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. While in Simulation, specify the following as parameters:</td>
<td>Check the boxes to the left of the items in the <strong>Details View</strong>. See Section : Specifying Parameters for details.</td>
</tr>
<tr>
<td>- Number of small holes</td>
<td></td>
</tr>
<tr>
<td>- Large hole radius</td>
<td></td>
</tr>
<tr>
<td>- Depth</td>
<td></td>
</tr>
<tr>
<td>- Small hole radius</td>
<td></td>
</tr>
<tr>
<td>- Distance of holes from center</td>
<td></td>
</tr>
<tr>
<td>- Equivalent stress, Maximum</td>
<td></td>
</tr>
<tr>
<td>- Maximum principal stress, Maximum</td>
<td></td>
</tr>
<tr>
<td>- Middle principal stress, Maximum</td>
<td></td>
</tr>
<tr>
<td>- Minimum principal stress, Maximum</td>
<td></td>
</tr>
<tr>
<td>- Total deformation, Maximum</td>
<td></td>
</tr>
<tr>
<td>- Stress intensity, Maximum</td>
<td></td>
</tr>
<tr>
<td>- Normal stress, Maximum</td>
<td></td>
</tr>
<tr>
<td>- Shear stress, Maximum</td>
<td></td>
</tr>
<tr>
<td>2. Obtain a Simulation solution.</td>
<td>Click the <strong>Solve</strong> button. See Section : Solving for details.</td>
</tr>
<tr>
<td>3. Start DesignXplorer.</td>
<td>Click the [<strong>Project</strong>] tab, then click <strong>Create a new DesignXplorer study</strong>.</td>
</tr>
<tr>
<td>4. Modify parameters as follows:</td>
<td>Click <strong>Parameters</strong> in the Views pane and modify the parameters.</td>
</tr>
<tr>
<td>- Number of small holes (Discrete)</td>
<td></td>
</tr>
<tr>
<td>- Values: 9, 10, 3, 4, 5, 6, 7, 8</td>
<td></td>
</tr>
<tr>
<td>- Large hole radius (Continuous)</td>
<td></td>
</tr>
<tr>
<td>- Lower bound = 67</td>
<td></td>
</tr>
<tr>
<td>- Upper bound = 83</td>
<td></td>
</tr>
<tr>
<td>- Depth (Continuous)</td>
<td></td>
</tr>
<tr>
<td>- Lower bound = 45</td>
<td></td>
</tr>
<tr>
<td>- Upper bound = 55</td>
<td></td>
</tr>
<tr>
<td>- Small hole radius (Usability)</td>
<td></td>
</tr>
<tr>
<td>- Lower bound = 10.8</td>
<td></td>
</tr>
<tr>
<td>- Upper bound = 13.2</td>
<td></td>
</tr>
<tr>
<td>- Distance of holes from center (Continuous)</td>
<td></td>
</tr>
<tr>
<td>- Lower bound = 27</td>
<td></td>
</tr>
<tr>
<td>- Upper bound = 33</td>
<td></td>
</tr>
</tbody>
</table>
**DesignXplorer VT Walkthrough**

The following example builds the model shown with a pressure load and a fixed support.

A standard Simulation is then performed, followed by a DesignXplorer VT analysis. The following steps begin before a Simulation solution is obtained.

One of the most useful features of DesignXplorer VT is its ability to recalculate nodal results “on the fly” without the need for repeated solutions. This feature is illustrated in steps 6 and 7 below, where you can view the results of varying input parameters in real time.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>5. Solve the DesignXplorer analysis.</td>
<td>Click Run in the toolbar, then click:</td>
</tr>
<tr>
<td></td>
<td>· Solve Automatic Design Points.</td>
</tr>
<tr>
<td>6. View a response surface of the DesignXplorer results.</td>
<td>· Click Responses in the Views pane.</td>
</tr>
<tr>
<td></td>
<td>· Click Response Charts in the Responses sub-options menu.</td>
</tr>
<tr>
<td></td>
<td>· Move the cursor as shown in DesignXplorer VT.</td>
</tr>
</tbody>
</table>

1. While in Simulation, specify the following as parameters:  
   · Hole radius  
   · Back height  
   · Front height  
   · Equivalent stress, Maximum  
   · Maximum principal stress, Maximum  
   · Middle principal stress, Maximum  
   · Minimal principal stress, Maximum  
   · Total deformation, Maximum  
   Check the boxes to the left of the items in the Details View. See Section : Specifying Parameters for details.

2. Obtain a Simulation solution.  
   Click the Solve button. See Section : Solving for more details.

3. Start DesignXplorer VT.  
   Click the [Project] tab, then click Create a new DesignXplorer VT study.
4. Modify parameters as follows:
   - Hole radius
     - Lower bound = 7.107
     - Upper bound = 8.686
   - Back height
     - Lower bound = 5.67
     - Upper bound = 6.571
   - Front height
     - Lower bound = 2.67
     - Upper bound = 3.263

5. Solve the DesignXplorer VT analysis.


To solve a DesignXplorer VT analysis, click the Run button on the toolbar, and then click:

- **Verify Geometry Parameters**: Checks to assure that parameter ranges are valid and do not cause any topological changes in the model. If you see errors after performing this stage of the execution, adjust the parameter ranges and try again.

- **Mesh Morph**: Performs the mesh morphing. Errors in this phase indicate that the input parameter ranges deform the elements too much. Ranges will be automatically adjusted.

  *Note* — Clicking this choice automatically performs the previous choice.

- **Solve in ANSYS**: Performs the ANSYS solve.

  *Note* — Clicking this choice automatically performs the previous two choices.
Response Surface

The following is an animated GIF. Please view online if you are reading the PDF version of the help.

Moving the cursor allows you to pan or zoom to various portions of the chart. Shown here is zooming.

Animation

The following is an animated GIF. Please view online if you are reading the PDF version of the help.
The animation shows another instantaneous rendering of how varying the input parameters changes the output parameter.

**Discrete Optimization Walkthrough**

This example details the steps of a discrete optimization using the model shown below. The problem is defined in DesignXplorer VT with discrete (binary) variables. The output parameter is maximum displacement and the input parameters are the columns.
### APDL and Goal Driven Optimization Walkthrough

The following DesignXplorer example uses an existing APDL file containing the calculation of simple expressions to illustrate the application of APDL and Goal Driven Optimization capabilities.

This example uses a typical APDL problem illustrating a Bernoulli-Euler beam under a concentrated load, as shown below. The volume of the beam, natural frequency, buckling strength, and tip deflection are used as output parameters. The input parameters are shown below.
The APDL file contains the following commands:

\[
\begin{align*}
   b &= 2 \\
   d &= 5 \\
   l &= 100 \\
   p &= 1000 \\
   E &= 200000 \\
   v &= b\cdot d \cdot l \\
   \sigma &= (6\cdot p \cdot l)/(b\cdot d \cdot d) \\
   \text{dis} &= (4\cdot p \cdot l \cdot l)/(d \cdot d \cdot b \cdot E) \\
   \text{buck} &= (9.87755 \cdot E \cdot b \cdot d \cdot d)/(48 \cdot l \cdot l)
\end{align*}
\]

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Start ANSYS Workbench and link to the existing APDL file.</td>
<td>Start an empty project, then click on <strong>Link to ANSYS APDL</strong> Input... in the [Project] tab.</td>
</tr>
</tbody>
</table>
### Task | Action
---|---
2. Define input and response parameters included in the APDL file. | Click on **Edit mapping of APDL parameters...** in the [Project] tab. This will add a new [APDL Parameter] tab to the view. In this tab you can select input and output parameters.  
   - Select \( b, d, l, p, \) and \( E \) and click the **Add** button under **Input Parameters** to define them as input parameters.  
   - Select \( v, \sigma, d, \text{ and } \sigma_{\text{buck}} \) and click the **Add** button under **Response Parameters** to define them as response parameters.

3. Start DesignXplorer. | Click the [Project] tab, then click **Create a new DesignXplorer study**.

4. Set all parameters to have be continuous with 10% variation. | Click **Parameters** in the Views pane and modify the parameters.

5. Solve. | Click **Run** in the toolbar.

6. Generate a sample set. | Click **Goal Driven Optimization** in the Views pane and **Goals & Candidates** in the View Sub-options. Select the **Screening** option with 6000 samples, then click **Generate**.

7. View the three best candidate designs. | Click **Generate or update candidate designs based on the current goals**.

8. View the non-dominated Pareto fronts. | Click **TradeOff Study** in the View Sub-options.

9. Generate an Advanced sample set. | Click in the toolbar, then generate an Advanced sample set with 200 samples and 30 iterations.

10. View the Pareto fronts for the Advanced sample set. | Select the new sample set.  
   - Click **TradeOff Study** in the View Sub-options.  
   - Select the output axes marked **TradeOff On**.

11. Save a new sample set. | Move the slider to the far left to see only the first Pareto front.  
   - Click in the toolbar to save this front as a separate sample set.

12. Update candidate designs. | Select the sample set you've just created.  
   - Click **Goals & Candidates**, then **Generate or update candidate designs based on the current goals**. This will display the three best candidate designs for the first Pareto front based on the preferences you set.

13. Create a new Advanced sample set. | Click and generate a new Advanced sample set with 200 samples and 30 iterations, using the initial sample set (Initial Samples = first sample set) as a starting sample.
### APDL and Six Sigma Analysis Walkthrough

The following DesignXplorer example uses the same problem described in Section : APDL and Goal Driven Optimization Walkthrough.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Start ANSYS Workbench and link to the existing APDL file.</td>
<td>Start an empty project, then click on <strong>Link to ANSYS APDL Input</strong>... in the [Project] tab.</td>
</tr>
<tr>
<td>2. Define input and response parameters included in the APDL file.</td>
<td>Click on <strong>Edit mapping of APDL parameters</strong>... in the [Project] tab. This will add a new [APDL Parameter] tab to the view. In this tab you can select input and output parameters.</td>
</tr>
<tr>
<td>3. Start DesignXplorer.</td>
<td>Click the [Project] tab, then click <strong>Create a new DesignXplorer study</strong>.</td>
</tr>
<tr>
<td>4. Modify parameters as follows:</td>
<td>Click <strong>Parameters</strong> in the Views pane and modify the parameters.</td>
</tr>
<tr>
<td>· Set the parameters to be <strong>Uncertainty</strong> variables.</td>
<td></td>
</tr>
<tr>
<td>· Change associated distributions with the <strong>Distribution Type</strong> drop-down menu.</td>
<td></td>
</tr>
<tr>
<td>· Parameters of a distribution can be edited in the <strong>Parameter Properties</strong> table. Resulting statistics are displayed in the <strong>Distribution Attributes</strong> table.</td>
<td></td>
</tr>
<tr>
<td>5. Solve the analysis.</td>
<td>Click <strong>Run</strong> in the toolbar.</td>
</tr>
<tr>
<td>Task</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| 6. Generate a sample set. | - Click **Six Sigma Analysis** in the Views pane.  
- Set the number of samples to 10000.  
- Click **Generate**. |
| 7. Review the Six Sigma Analysis results. | - Select **Charts** from the View Sub-options to display distribution charts for input and output parameters, as well as the histogram and cumulative distribution function plots, shown below.  
- Select **Tables** from the View Sub-options to display probability tables. |
| 8. Add a value to the **Probability Table**. | Type a new parameter value in the field above **Insert New Parameter Value** and click the button. Review the new table information. |

**APDL and Robust Design Walkthrough**

The following DesignXplorer example uses the same problem described in Section : APDL and Goal Driven Optimization Walkthrough.
### Task | Action
--- | ---
1. Start ANSYS Workbench and link to the existing APDL file. | Start an empty project, then click on **Link to ANSYS APDL Input...** in the **[Project]** tab. ![Link to ANSYS APDL Input](image)

2. Define input and response parameters included in the APDL file. | Click on **Edit mapping of APDL parameters...** in the **[Project]** tab. This will add a new **[APDL Parameter]** tab to the view. In this tab you can select input and output parameters.

   * Select $b$, $d$, $l$, $p$, and $E$ and click the **Add** button under **Input Parameters** to define them as input parameters.

   * Select $v$, $sig$, $dis$, and $buck$ and click the **Add** button under **Response Parameters** to define them as response parameters.

3. Start DesignXplorer. | Click the **[Project]** tab, then click **Create a new DesignXplorer study**.

4. Modify parameters as follows: | Click **Parameters** in the Views pane and modify the parameters.

   * Set the parameters to be **Uncertainty** variables, except for one, which must be a **Design** variable.

   * Change associated distributions with the **Distribution Type** drop-down menu.

   * Parameters of a distribution can be edited in the **Parameter Properties** table. Resulting statistics are displayed in the **Distribution Attributes** table.

5. Solve the analysis. | Click **Run** in the toolbar.

6. Generate a sample set. | Click **Six Sigma Analysis** in the Views pane.

   * Set the number of samples to 10000.

   * Click **Generate**.

7. Review and parameterize the Six Sigma Analysis results. | Select **Charts** from the View Sub-options to display distribution charts for input and output parameters, as well as the histogram and cumulative distribution function plots, shown below. Specific rows in the output distributions can be parameterized by clicking the box next to them.

   * Select **Tables** from the View Sub-options to display probability tables. Values in the tables can be parameterized by clicking the box next to them.


   * Generate a **Screening** sample set with 6000 samples.
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>9. View the three best candidate designs.</td>
<td>Click <strong>Goals &amp; Candidates</strong> in the View Sub-options to set goals and update candidate designs.</td>
</tr>
<tr>
<td>10. View the Pareto fronts.</td>
<td>Click <strong>TradeOff Study</strong> in the View Sub-options.</td>
</tr>
</tbody>
</table>
| 11. Create an *Advanced* sample set. | | · Click ![icon](image) in the toolbar.  
| | · Click **Generate**. |
| 12. View the Pareto fronts. | | · Click **TradeOff Study** in the View Sub-options.  
| | · Select the output axes marked **TradeOff On**. |
| 13. View the Pareto fronts for the new *Advanced* sample set. | | · Click **TradeOff Study**.  
| | · Move the slider all the way to the left to display only the first Pareto front.  
| | · Click ![icon](image) to save the front as a new sample set. |
| 14. Update the candidate designs. | | · Select the sample set you’ve just created.  
| | · Click **Goals & Candidates**, then **Generate or update candidate designs based on the current goals**. This will display the three best candidate designs for the first Pareto front based on the preferences you set. |
| 15. Create a new *Advanced* sample set. | Click ![icon](image) and generate a new *Advanced* sample set with 200 samples and 30 iterations, using the initial sample set (Initial Samples = first sample set) as a starting sample. |
| 16. View the Pareto fronts for the new *Advanced* sample set. | | · Click **TradeOff Study**.  
| | · Move the slider all the way to the left to display only the first Pareto front.  
| | · Click ![icon](image) to save the front as a new sample set. |
| 17. Update the candidate designs. | | · Select the sample set you’ve just created.  
| | · Click **Goals & Candidates**, then **Generate or update candidate designs based on the current goals**. This will display the three best candidate designs for the first Pareto front based on the preferences you set. |
Troubleshooting

Resumed DesignXplorer database will not solve custom design points or finish execution of a previously unfinished DOE run.

Exit and reopen the Workbench project file. Refresh the geometry in Simulation, then open the DesignXplorer database.

*Note* — Make sure the personal parameter key in the control panel is consistent with your geometry parameters.

DesignXplorer won’t run load geometry from Pro/ENGINEER.
Make sure that you either have Pro/ENGINEER currently running or you have set the Pro/ENGINEER environment variable to allow the application to run in silent mode.

DesignXplorer stops execution and provides an error message.
Check your input parameters. They may contain values wildly out of range or not within real-world bounds.
In many cases the CAD system won’t regenerate due to conflicts with Input Parameters.

After reopening a DesignXplorer database, new Design Sets that you create have Response and Derived Parameter values that don’t make sense.
You’ve changed the units for the input parameters in Simulation. Change the units back to their original settings.

The parameters reported in DesignXplorer do not match those that you added in Simulation.
You started a solve in DesignXplorer but received an error message that forced you to return to Simulation to make changes. You did not save the changes before leaving Simulation, so DesignXplorer retains the parameters you used before you made the changes. Choose *File > Save* before leaving Simulation to have DesignXplorer reflect the latest parameters.

If you encounter problems running the DesignXplorer VT:
Make sure that the `CADOE_LIBDIR100` environment variable has been set. It should point to the `\Program Files\Ansys Inc\V100\CommonFiles\Language\en-us` directory in Windows and the `/ansys_inc/v100/CommonFiles/Language/en-us` directory in UNIX.

If DesignXplorer VT fails in the mesh morphing step or in the solver step (i.e., after you get all CAD model updates successfully):
Return to Simulation to set the “aggressive shape checking option,” remesh, resolve, and save the model in Simulation and then try the DesignXplorer VT run again. It may be beneficial to increase the mesh relevance, or add sizing controls to the mesh in Simulation, to ensure that all elements are relatively the same size.

The modal analysis of a part that has a rigid body modes will result in 1 to 6 eigenfrequencies close to 0 Hz. DesignXplorer VT does not take into account these eigenfrequencies as output variables. For frequencies that you have defined in the frequency finder, only those frequencies above 1.1 HZ. will be parameterized. This may lead to a mismatch in results between Simulation and DesignXplorer VT. For example, if a part has no boundary conditions, the first 6 eigenfrequencies will be 0 Hz. For a request of 8 modes in Simulation, the first output frequency in DesignXplorer VT will correspond to the 7th frequency in Simulation.
**Appendices**

- Section: Glossary of General Terms
- Using DesignXplorer Help

**Glossary of General Terms**

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatic Design Point</strong></td>
<td>A design point in which Parameter values were calculated directly in Simulation, a CAD system, or DesignModeler.</td>
</tr>
<tr>
<td><strong>Custom Design Point</strong></td>
<td>A design point which has parameter values calculated in DesignXplorer. As such, the parameter values are approximate and calculated from response charts.</td>
</tr>
<tr>
<td><strong>Design of Experiments (DOE)</strong></td>
<td>Optimization method (used in DesignXplorer) where each change of the value of any input variable requires a new finite element analysis. To perform a “what-if study” where several input variables are varied in a certain range, a considerable number of finite-element analyses may be required to satisfactorily evaluate the finite-element results over the space of the input variables. The DOE method generates a response surface using curve and surface fitting algorithms to “fit” output data as a function of input data. This requires a group of design points where each point is generated via a finite element solve.</td>
</tr>
<tr>
<td><strong>Input Parameters</strong></td>
<td>Those parameters that define the geometry (e.g., length, width, thickness) to the analysis for the structure under investigation.</td>
</tr>
<tr>
<td><strong>Loop or Simulation Loop</strong></td>
<td>A single pass through an analysis file.</td>
</tr>
<tr>
<td></td>
<td>In each loop, the Six Sigma Analysis tool uses the values of the uncertainty variables from one sample and executes the user-specified analysis. The Six Sigma Analysis tool collects the values for the uncertainty variables following each loop.</td>
</tr>
<tr>
<td><strong>Mean Value</strong></td>
<td>A measure of location often used to describe the general location of the bulk of the scattering data of a random output parameter or of a statistical distribution function.</td>
</tr>
<tr>
<td></td>
<td>Mathematically, the mean value is the arithmetic average of the data. The mean value also represents the center of gravity of the data points. Another name for the mean value is the <em>expected value</em>.</td>
</tr>
<tr>
<td><strong>Median Value</strong></td>
<td>The statistical point where 50% of the data is below the value and 50% is above.</td>
</tr>
<tr>
<td></td>
<td>For symmetrical distribution functions (Gaussian, uniform, etc.) the median value and the mean value are identical, but for nonsymmetrical distributions, they are different.</td>
</tr>
<tr>
<td><strong>Output Parameters</strong></td>
<td>Parameters that define the response outputs (e.g., volume) from the analysis.</td>
</tr>
<tr>
<td><strong>Pareto Set</strong></td>
<td>A concept used in multi-objective optimization, especially where some or all of the objectives are mutually conflicting. In such a case, there is no single point which simultaneously yields the “best” value of all the objectives. Instead, the best solutions, called a Pareto or non-dominated set, are a group of solutions.</td>
</tr>
</tbody>
</table>
such that selecting any one of them in place of another will always sacrifice the quality of at least one objective while improving at least one other.

**Response Surface**
The empirical relationship between a variable of interest, y, and a set of independent variables, x1, x2, x3, ... Usually the function y = F(x1, x2, x3, ...) is a polynomial or some other well-defined relationship, which forms the response surface model of y. When applied to design and analysis in the realm of CAD and CAE, a response surface is the representation of the physical behavior of a structure in terms of its independent variables. For example, a response surface can be devised for the fundamental frequency (F) of a structure as a function of CAD geometry parameters (R, L) and the modulus of elasticity (E); that is, F = G(R,L,E).

**Result Parameters**
The results of a finite element analysis.

The result parameters are typically a function of the uncertainty variables; that is, changing the values of the uncertainty variables should change the value of the result parameters.

**Sample**
A unique set of parameter values that represents a particular model configuration.

A sample is characterized by uncertainty variable values. Think of a sample as one virtual prototype. Every component manufactured represents one sample, because you can measure its particular properties (material, geometry, etc.) and obtain specific values for each.

In statistics, however, *sample* also has a wider and more general use. For example, any single measured value of any physical property is considered to be one sample. Because a Six Sigma Analysis is based on a statistical evaluation of the result parameters, the values of the result parameters are also called samples.

**Standard Deviation**
A measure of variability (i.e., dispersion or spread) about the arithmetic mean value, often used to describe the width of the scatter of a random output parameter or of a statistical distribution function.

The larger the standard deviation, the wider the scatter, and the more likely it is that there are data values further apart from the mean value.

**Uncertainty Variables**
Quantities that influence the result of an analysis.

In a Six Sigma Analysis, uncertainty variables are often called "drivers" because they drive the result of an analysis. You must specify the type of statistical distribution the uncertainty variables follow and the parameter values of their distribution functions.

**Variational Technology**
Optimization method (used in DesignXplorer VT) that is based on a single finite-element solve, combined with the use of mesh morphing and the Taylor series expansion approximation. The Taylor series expansion handles up to 10 input variables, and can be used with multiple input variables or shape parameters. See Variational Technology for further details.

**View Details**
Bottom frame of left pane. Offers detailed choices when an item is selected from the Views pane and/or View Sub-options.

**Views Pane**
Top of left pane. The Views pane is used to choose sections of DesignXplorer to view.
| **View Sub-options** | Middle of left pane. When an option is chosen in the Views pane, sub-options, if available, will be displayed. |
ANSYS Workbench
Verification Manual
# Table of Contents

**Introduction** ........................................................................................................................................... 1-1

I. Verification Test Case Descriptions

<table>
<thead>
<tr>
<th>I. Simulation Descriptions</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSVM1</td>
<td>1-5</td>
</tr>
<tr>
<td>DSVM2</td>
<td>1-6</td>
</tr>
<tr>
<td>DSVM3</td>
<td>1-8</td>
</tr>
<tr>
<td>DSVM4</td>
<td>1-10</td>
</tr>
<tr>
<td>DSVM5</td>
<td>1-12</td>
</tr>
<tr>
<td>DSVM6</td>
<td>1-14</td>
</tr>
<tr>
<td>DSVM7</td>
<td>1-15</td>
</tr>
<tr>
<td>DSVM8</td>
<td>1-17</td>
</tr>
<tr>
<td>DSVM9</td>
<td>1-20</td>
</tr>
<tr>
<td>DSVM10</td>
<td>1-22</td>
</tr>
<tr>
<td>DSVM11</td>
<td>1-24</td>
</tr>
<tr>
<td>DSVM12</td>
<td>1-26</td>
</tr>
<tr>
<td>DSVM13</td>
<td>1-27</td>
</tr>
<tr>
<td>DSVM14</td>
<td>1-28</td>
</tr>
<tr>
<td>DSVM15</td>
<td>1-30</td>
</tr>
<tr>
<td>DSVM16</td>
<td>1-32</td>
</tr>
<tr>
<td>DSVM17</td>
<td>1-35</td>
</tr>
<tr>
<td>DSVM18</td>
<td>1-36</td>
</tr>
<tr>
<td>DSVM19</td>
<td>1-38</td>
</tr>
<tr>
<td>DSVM20</td>
<td>1-40</td>
</tr>
<tr>
<td>DSVM21</td>
<td>1-42</td>
</tr>
<tr>
<td>DSVM22</td>
<td>1-43</td>
</tr>
<tr>
<td>DSVM23</td>
<td>1-45</td>
</tr>
<tr>
<td>DSVM24</td>
<td>1-47</td>
</tr>
<tr>
<td>DSVM25</td>
<td>1-49</td>
</tr>
<tr>
<td>DSVM26</td>
<td>1-51</td>
</tr>
<tr>
<td>DSVM27</td>
<td>1-53</td>
</tr>
<tr>
<td>DSVM28</td>
<td>1-55</td>
</tr>
<tr>
<td>DSVM29</td>
<td>1-56</td>
</tr>
<tr>
<td>DSVM30</td>
<td>1-58</td>
</tr>
<tr>
<td>DSVM31</td>
<td>1-60</td>
</tr>
<tr>
<td>DSVM32</td>
<td>1-62</td>
</tr>
<tr>
<td>DSVM33</td>
<td>1-64</td>
</tr>
</tbody>
</table>

II. DesignXplorer Descriptions .................................................................................................................. 1-69

| DXVM1                      | 1-70 |
| DXVM2                      | 1-72 |
| DXVM3                      | 1-74 |
| DXVM4                      | 1-76 |
| DXVM5                      | 1-78 |
Introduction

Overview

This manual presents a collection of test cases that demonstrate a number of the capabilities of the Workbench analysis environment. The available tests are engineering problems that provide independent verification, usually a closed form equation. Many of them are classical engineering problems.

The solutions for the test cases have been verified, however, certain differences may exist with regard to the references. These differences have been examined and are considered acceptable. The workbench analyses employ a balance between accuracy and solution time. Improved results can be obtained in some cases by employing a more refined finite element mesh but requires longer solution times. For the tests, an error rate of 3% or less has been the goal.

These tests were run on an Intel Xeon processor using Microsoft Windows XP Professional. These results are reported in the test documentation. Slightly different results may be obtained when different processor types or operating systems are used.

The tests contained in this manual are a partial subset of the full set of tests that are run by ANSYS developers to ensure a high degree of quality for the Workbench product. The verification of the Workbench product is conducted in accordance with the written procedures that form a part of an overall Quality Assurance program at ANSYS, Inc.

You are encouraged to use these tests as starting points when exploring new Workbench features. Geometries, material properties, loads, and output results can easily be changed and the solution repeated. As a result, the tests offer a quick introduction to new features with which you may be unfamiliar.

Some test cases will require different licenses, such as DesignModeler, Emag, or DesignXplorer. If you do not have the available licenses, you may not be able to reproduce the results. The Educational version of Workbench should be able to solve most of these tests. License limitations are not applicable to Workbench Education version but problem size may restrict the solution of some of the tests.

The working directories for each of the Verification Manual tests are available on the installation media at

<drive>:\ansys_inc\v100\aisol\Samples\AWEVM

These databases provide all of the necessary elements for running a test, including geometry parts, material files and workbench databases. To open a test case in workbench, locate the working directory and double-click the Workbench database (.wbdb).

You can use these tests to verify that your hardware is executing the ANSYS Workbench tests correctly. The results in the databases can be cleared and the tests solved multiple times. The test results should be checked against the verified results in the documentation for each test.

ANSYS Inc. offers the Workbench Verification and Validation package for users that must perform system validation. This package automates the process of test execution and report generation. If you are interested Readers interested in contracting for such services may contact the ANSYS, Inc. Quality Assurance Group.
Simulation Descriptions
**DSVM1: Statically Indeterminate Reaction Force Analysis**

**Overview**

| Analysis Type(s): | Linear Static Structural Analysis |
| Element Type(s): | Solid |

**Test Case**

An assembly of three prismatic bars is supported at both end faces and is axially loaded with forces $F_1$ and $F_2$. Force $F_1$ is applied on the face between Parts 2 and 3 and $F_2$ is applied on the face between Parts 1 and 2. Apply advanced mesh control with element size of 0.5”.

Find reaction forces in the y direction at the fixed supports.

---

**Figure 1.1 Schematic**

---

**Material Properties**

- $E = 2.9008 \times 10^7$ psi
- $\nu = 0.3$
- $\rho = 0.28383$ lbm/in$^3$

**Geometric Properties**

- Cross section of all parts = 1” x 1”
- Length of Part 1 = 4”
- Length of Part 2 = 3”
- Length of Part 3 = 3”

**Loading**

- Force $F_1 = -1000$ (y direction)
- Force $F_2 = -500$ (y direction)
## Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y Reaction Force at Top Fixed Support (lbf)</td>
<td>900</td>
<td>901.14</td>
<td>0.127</td>
</tr>
<tr>
<td>Y Reaction Force at Bottom Fixed Support (lbf)</td>
<td>600</td>
<td>598.86</td>
<td>-0.190</td>
</tr>
</tbody>
</table>
DSVM2: Rectangular Plate with Circular Hole Subjected to Tensile Loading

Overview


Analysis Type(s): Linear Static Structural Analysis

Element Type(s): Solid

Test Case

A rectangular plate with a circular hole is fixed along one of the end faces and a tensile pressure load is applied on the opposite face. A convergence with an allowable change of 10% is applied to account for the stress concentration near the hole. The Maximum Refinement Loops is set to 2 and the Refinement mesh control is added on the cylindrical surfaces of the hole with Refinement = 1.

Find the Maximum Normal Stress in the x direction on the cylindrical surfaces of the hole.

Figure 2.1 Schematic

<table>
<thead>
<tr>
<th>Material Properties</th>
<th>Geometric Properties</th>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>E = 1000 Pa</td>
<td>Length = 15 m</td>
<td>Pressure = -100 Pa</td>
</tr>
<tr>
<td>ν = 0</td>
<td>Width = 5 m</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Thickness = 1 m</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hole radius = 0.5 m</td>
<td></td>
</tr>
</tbody>
</table>
# Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Normal X Stress (Pa)</td>
<td>312.5</td>
<td>313.85</td>
<td>0.432</td>
</tr>
</tbody>
</table>
DSVM3: Modal Analysis of Annular Plate

Overview


Analysis Type(s): Free Vibration Analysis

Element Type(s): Solid

Test Case

An assembly of three annular plates has cylindrical support (fixed in the radial, tangential, and axial directions) applied on the cylindrical surface of the hole. Sizing control with element size of 0.5” is applied to the cylindrical surface of the hole.

Find the first six modes of natural frequencies.

Figure 3.1 Schematic

<table>
<thead>
<tr>
<th>Material Properties</th>
<th>Geometric Properties</th>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>$E = 2.9008 \times 10^7$ psi</td>
<td>Inner diameter of inner plate = 20”</td>
<td>Cylindrical Support: 0, 0, 0 in</td>
</tr>
<tr>
<td>$\nu = 0.3$</td>
<td>Inner diameter of middle plate = 28”</td>
<td></td>
</tr>
<tr>
<td>$\rho = 0.28383$ lbf/in$^3$</td>
<td>Inner diameter of outer plate = 34”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Outer diameter of outer plate = 40”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Thickness of all plates = 1”</td>
<td></td>
</tr>
</tbody>
</table>
Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st Frequency Mode (Hz)</td>
<td>310.911</td>
<td>311.03</td>
<td>0.038</td>
</tr>
<tr>
<td>2nd Frequency Mode (Hz)</td>
<td>318.086</td>
<td>316.34</td>
<td>-0.549</td>
</tr>
<tr>
<td>3rd Frequency Mode (Hz)</td>
<td>318.086</td>
<td>316.81</td>
<td>-0.401</td>
</tr>
<tr>
<td>4th Frequency Mode (Hz)</td>
<td>351.569</td>
<td>347.77</td>
<td>-1.081</td>
</tr>
<tr>
<td>5th Frequency Mode (Hz)</td>
<td>351.569</td>
<td>348.26</td>
<td>-0.941</td>
</tr>
<tr>
<td>6th Frequency Mode (Hz)</td>
<td>442.451</td>
<td>437.97</td>
<td>-1.013</td>
</tr>
</tbody>
</table>
DSVM4: Shape Optimization of a Quarter of a Plate With Hole

Overview

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Shape Optimization</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>Solid</td>
</tr>
</tbody>
</table>

Test Case

A rectangular plate (1300 x 1300 mm) with a hole is modeled with one-quarter symmetry. It has frictionless support applied on the two flat faces along the thickness near the hole. Pressure loads are applied on the remaining two flat faces along the thickness as shown below. Apply advanced mesh control with element size of 29 mm to get accurate results.

Find the Optimized Mass for target reduction of 20%.

Figure 4.1 Schematic

<table>
<thead>
<tr>
<th>Material Properties</th>
<th>Geometric Properties</th>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>$E = 2.1 \times 10^5$ MPa</td>
<td>Quadrant Length = 650 mm</td>
<td>Pressure = -0.15385 MPa</td>
</tr>
<tr>
<td>$\nu = 0.3$</td>
<td>Quadrant Width = 650 mm</td>
<td>Pressure 2 = -0.076925 MPa</td>
</tr>
<tr>
<td>$\rho = 8 \times 10^{-6}$ kg/mm$^3$</td>
<td>Thickness = 10 mm</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Radius = 250 mm</td>
<td></td>
</tr>
</tbody>
</table>

Frictionless Support 2

Frictionless Support
## Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimized Mass (kg)</td>
<td>23.8984</td>
<td>24.115</td>
<td>0.906</td>
</tr>
</tbody>
</table>
DSVM5: Heat Transfer in a Composite Wall

Overview

Reference: Kreith, Principles of Heat Transfer, Third Edition, Figure 2-5, pg. 37
Analysis Type(s): Linear Static Thermal Analysis
Element Type(s): Solid

Test Case

A furnace wall consists of two layers: fire brick and insulating brick. The temperature inside the furnace is 3000°F ($T_f$) and the inner surface convection coefficient is $3.333 \times 10^{-3}$ BTU/s ft$^2$°F ($h_f$). The ambient temperature is 80°F ($T_a$) and the outer surface convection coefficient is $5.556 \times 10^{-4}$ BTU/s ft$^2$°F ($h_a$).

Find the Temperature Distribution.

Figure 5.1 Schematic

![Schematic diagram of the furnace wall with convection and geometric properties](image)

Material Properties
- Fire brick wall: $k = 2.222 \times 10^{-4}$ BTU/s ft °F
- Insulating wall: $k = 2.778 \times 10^{-5}$ BTU/s ft °F

Geometric Properties
- Cross-section = 1" x 1"
- Fire brick wall thickness = 9"
- Insulating wall thickness = 5"

Loading

Results Comparison

<table>
<thead>
<tr>
<th></th>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Temperature (°F)</td>
<td>336</td>
<td>336.69</td>
<td>0.205</td>
<td></td>
</tr>
<tr>
<td>Maximum Temperature (°F)</td>
<td>2957</td>
<td>2957.2</td>
<td>0.007</td>
<td></td>
</tr>
</tbody>
</table>
DSVM6: Heater with Nonlinear Conductivity

Overview

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Nonlinear Static Thermal Analysis</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>Solid</td>
</tr>
</tbody>
</table>

Test Case

A liquid is boiled using the front face of a flat electric heater plate. The boiling temperature of the liquid is 212°F. The rear face of the heater is insulated. The internal energy generated electrically may be assumed to be uniform and is applied as internal heat generation.

Find the maximum temperature and maximum total heat flux.

Figure 6.1 Schematic

![Schematic](image)

<table>
<thead>
<tr>
<th>Material Properties</th>
<th>Geometric Properties</th>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>$k = [0.01375 \times (1 + 0.001 T)]$ BTU/s in°F</td>
<td>Radius = 3.937&quot;</td>
<td>Front face temperature = 212°F</td>
</tr>
<tr>
<td>Temperature (°F)</td>
<td>Conductivity (BTU/s in°F)</td>
<td>Thickness = 1&quot;</td>
</tr>
<tr>
<td>32</td>
<td>1.419e-002</td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>2.75e-002</td>
<td></td>
</tr>
</tbody>
</table>
## Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Temperature (°F)</td>
<td>476</td>
<td>480.57</td>
<td>0.960</td>
</tr>
<tr>
<td>Maximum Total Heat Flux (BTU/s in³)</td>
<td>10</td>
<td>9.9998</td>
<td>-0.002</td>
</tr>
</tbody>
</table>
DSVM7: Thermal Stress in a Bar with Temperature Dependent Conductivity

Overview

<table>
<thead>
<tr>
<th>Reference:</th>
<th>Any basic Heat Transfer book</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Nonlinear Thermal Stress Analysis</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>Solid</td>
</tr>
</tbody>
</table>

Test Case

A long bar has thermal conductivity that varies with temperature. The bar is constrained at both ends by frictionless surfaces. A temperature of $T$°C is applied at one end of the bar (End A). The reference temperature is 5°C. At the other end, a constant convection of $h$ W/m²°C is applied. The ambient temperature is 5°C. Advanced mesh control with element size of 2 m is applied.

Find the following:

- Minimum temperature
- Maximum thermal strain in z direction (on the two end faces)
- Maximum deformation in z direction
- Maximum heat flux in z direction at $z = 20$ m

Figure 7.1 Schematic

<table>
<thead>
<tr>
<th>Material Properties</th>
<th>Geometric Properties</th>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>$E = 2e11 \text{ Pa}$</td>
<td>$\text{Length} = 20\text{ m}$</td>
<td>Rear face temperature $T = 100°C$</td>
</tr>
<tr>
<td>$\nu = 0$</td>
<td>$\text{Width} = 2\text{ m}$</td>
<td>Film Coefficient $h = 0.005$</td>
</tr>
<tr>
<td>$\alpha = 1.5e-05 \text{/ °C}$</td>
<td>$\text{Breadth} = 2\text{ m}$</td>
<td>W/m²°C</td>
</tr>
<tr>
<td>$k = 0.038*(1 + 0.00582*T) W/\text{m °C}$</td>
<td></td>
<td>Ambient temperature = 5°C</td>
</tr>
<tr>
<td>$\text{Temperature (°F)}$</td>
<td>$\text{Conductivity (W/m °C)}$</td>
<td>Reference temperature = 5°C</td>
</tr>
<tr>
<td>5</td>
<td>3.91e-002</td>
<td></td>
</tr>
<tr>
<td>800</td>
<td>0.215</td>
<td></td>
</tr>
</tbody>
</table>
Analysis

Temperature at a distance “z” from rear face is given by:
\[ T_z = -171.82 + \sqrt{73886.82 - 1492.13x(z)} \]

Thermal strain in the z direction in the bar is given by:
\[ \varepsilon_{zT} = 1.5 \times 10^{-5} \times (T_z - 5) \]

Deformation in the z direction is given by:
\[ u_z = \int (1.425 \times 10^{-5} \times (T_z - 5)) \, dz \]

Heat flux in the z direction is given by:
\[ q = 0.005 \times (T_z - 5) \]

Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Temperature (°C)</td>
<td>38.02</td>
<td>38.014</td>
<td>-0.016</td>
</tr>
<tr>
<td>Maximum Thermal strain (z = 20) (m/m)</td>
<td>0.000495</td>
<td>0.00049521</td>
<td>0.042</td>
</tr>
<tr>
<td>Maximum Thermal strain (z = 0) (m/m)</td>
<td>0.001425</td>
<td>0.001425</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum Z Deformation (m)</td>
<td>0.00232</td>
<td>0.002341</td>
<td>0.905</td>
</tr>
<tr>
<td>Maximum Z Heat Flux (z = 20) (W/m²)</td>
<td>0.165</td>
<td>0.16507</td>
<td>0.042</td>
</tr>
</tbody>
</table>
DSVM8: Heat Transfer from a Cooling Spine

Overview

| Analysis Type(s): | Linear Static Thermal Analysis |
| Element Type(s): | Solid |

Test Case

A steel cooling spine of cross-sectional area $A$ and length $L$ extend from a wall maintained at temperature $T_w$. The surface convection coefficient between the spine and the surrounding air is $h$, the air temper is $T_a$, and the tip of the spine is insulated. Apply advanced mesh control with element size of 0.025".

Find the heat conducted by the spine and the temperature of the tip.

**Figure 8.1 Schematic**

![Schematic Diagram]

**Material Properties**

- $E = 4.177\times10^9$ psf
- $\nu = 0.3$
- Thermal conductivity $k = 9.71\times10^{-3}$ BTU/s ft °F

**Geometric Properties**

- Cross section = 1.2" x 1.2"
- $L = 8"$

**Loading**

- $T_w = 100°F$
- $T_a = 0°F$
- $h = 2.778\times10^{-4}$ BTU/s ft² °F

**Results Comparison**

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature of the Tip (°F)</td>
<td>79.0344</td>
<td>79.078</td>
<td>0.055</td>
</tr>
<tr>
<td>Heat Conducted by the Spine (Heat Reaction) (BTU/s)</td>
<td>6.364e-3</td>
<td>6.3614e-3</td>
<td>-0.041</td>
</tr>
</tbody>
</table>
DSVM9: Stress Tool for Long Bar with Compressive Load

Overview

| Reference: | Any basic Strength of Materials book |
| Analysis Type(s): | Linear Static Structural Analysis |
| Element Type(s): | Solid |

Test Case

A multibody of four bars connected end to end has one of the end faces fixed and a pressure is applied to the opposite face as given below. The multibody is used to nullify the numerical noise near the contact regions.

Find the maximum equivalent stress for the whole multibody and the safety factor for each part using the maximum equivalent stress theory with tensile yield limit.

Figure 9.1 Schematic

<table>
<thead>
<tr>
<th>Material Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material</td>
</tr>
<tr>
<td>Part 1</td>
</tr>
<tr>
<td>Part 2</td>
</tr>
<tr>
<td>Part 3</td>
</tr>
<tr>
<td>Part 4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Geometric Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part 1: 2 m x 2 m x 3 m</td>
</tr>
<tr>
<td>Part 2: 2 m x 2 m x 10 m</td>
</tr>
<tr>
<td>Part 3: 2 m x 2 m x 5 m</td>
</tr>
<tr>
<td>Part 4: 2 m x 2 m x 2 m</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pressure = 2.5e8 Pa</td>
</tr>
</tbody>
</table>
## Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Equivalent Stress (Pa)</td>
<td>2.5e8</td>
<td>2.5e8</td>
<td>0.000</td>
</tr>
<tr>
<td>Safety Factor for Part 1</td>
<td>0.828</td>
<td>0.828</td>
<td>0.000</td>
</tr>
<tr>
<td>Safety Factor for Part 2</td>
<td>1.12</td>
<td>1.12</td>
<td>0.000</td>
</tr>
<tr>
<td>Safety Factor for Part 3</td>
<td>1</td>
<td>1</td>
<td>0.000</td>
</tr>
<tr>
<td>Safety Factor for Part 4</td>
<td>1.12</td>
<td>1.12</td>
<td>0.000</td>
</tr>
</tbody>
</table>
DSVM10: Modal Analysis of a Rectangular Plate

Overview


Analysis Type(s): Free Vibration Analysis

Element Type(s): Shell

Test Case

A rectangular plate is simply supported on both the smaller edges and fixed on one of the longer edges as shown below. Sizing mesh control with element size of 6.5 mm is applied on all the edges to get accurate results.

Find the first five modes of natural frequency.

Figure 10.1 Schematic

![Schematic Diagram](image)

Material Properties

| E = 2e11 Pa | \( \nu = 0.3 \) | \( \rho = 7850 \text{ kg/m}^3 \) |

Geometric Properties

| Length = 0.25 m | Width = 0.1 m | Thickness = 0.005 m |

Loading

Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st Frequency Mode (Hz)</td>
<td>595.7</td>
<td>590.17</td>
<td>-0.928</td>
</tr>
<tr>
<td>2nd Frequency Mode (Hz)</td>
<td>1129.55</td>
<td>1119.8</td>
<td>-0.863</td>
</tr>
<tr>
<td>3rd Frequency Mode (Hz)</td>
<td>2051.79</td>
<td>2042.8</td>
<td>-0.438</td>
</tr>
<tr>
<td>Results</td>
<td>Target</td>
<td>DS</td>
<td>Error (%)</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------</td>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td>4th Frequency Mode (Hz)</td>
<td>2906.73</td>
<td>2931.2</td>
<td>0.842</td>
</tr>
<tr>
<td>5th Frequency Mode (Hz)</td>
<td>3366.48</td>
<td>3358.1</td>
<td>-0.249</td>
</tr>
</tbody>
</table>
DSVM11: Large Deflection of a Circular Plate with Uniform Pressure

Overview


Analysis Type(s): Nonlinear Structural Analysis (Large Deformation On)

Element Type(s): Shell

Test Case

A circular plate is subjected to a uniform pressure on its flat surface. The circular edge of the plate is fixed. To get accurate results, apply sizing control with element size of 5 mm on the circular edge.

Find the total deformation at the center of the plate.

Figure 11.1 Schematic

<table>
<thead>
<tr>
<th>Material Properties</th>
<th>Geometric Properties</th>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>$E = 2e11$ Pa</td>
<td>Radius = 0.25 m</td>
<td>Pressure = 6585.18 Pa</td>
</tr>
<tr>
<td>$\nu = 0.3$</td>
<td>Thickness = 0.0025 m</td>
<td></td>
</tr>
</tbody>
</table>
## Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total deformation (m)</td>
<td>0.00125</td>
<td>0.0012365</td>
<td>-1.080</td>
</tr>
</tbody>
</table>
DSVM12: Buckling of a Stepped Rod

Overview


Analysis Type(s): Buckling Analysis

Element Type(s): Solid

Test Case

A stepped rod is fixed at one end face. It is axially loaded by two forces: a tensile load at the free end and a compressive load on the flat step face at the junction of the two cross sections. To get accurate results, apply sizing control with element size of 6.5 mm.

Find the Load Multiplier for the First Buckling Mode.

Figure 12.1 Schematic

<table>
<thead>
<tr>
<th>Material Properties</th>
<th>Geometric Properties</th>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>$E = 2 \times 10^{11}$ Pa</td>
<td>Larger diameter = 0.011982 m</td>
<td>Force at free end = 1000 N</td>
</tr>
<tr>
<td>$\nu = 0.3$</td>
<td>Smaller diameter = 0.010 m</td>
<td>Force at the flat step face = -2000 N</td>
</tr>
<tr>
<td></td>
<td>Length of larger diameter = 0.2 m</td>
<td>Both forces are in the z direction</td>
</tr>
<tr>
<td></td>
<td>Length of smaller diameter = 0.1 m</td>
<td></td>
</tr>
</tbody>
</table>

Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Multiplier</td>
<td>22.5</td>
<td>22.958</td>
<td>2.036</td>
</tr>
</tbody>
</table>
DSVM13: Buckling of a Circular Arch

Overview

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Buckling Analysis</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>Shell</td>
</tr>
</tbody>
</table>

Test Case

A circular arch of a rectangular cross section (details given below) is subjected to a pressure load as shown below. Both the straight edges of the arch are fixed.

Find the Load Multiplier for the first buckling mode.

Figure 13.1 Schematic

Fixed Support

Pressure: 1 MPa

Fixed Support 2

Material Properties

E = 2e5 MPa
ν = 0

Geometric Properties

Arch cross-section = 5 mm x 50 mm
Mean radius of arch = 50 mm
Included angle = 90°

Loading

Pressure = 1 MPa

Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Multiplier</td>
<td>544</td>
<td>548.05</td>
<td>0.744</td>
</tr>
</tbody>
</table>
DSVM14: Harmonic Response of a Single Degree of Freedom System

Overview

<table>
<thead>
<tr>
<th>Reference:</th>
<th>Any basic Vibration Analysis book</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Harmonic Analysis</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>Solid</td>
</tr>
</tbody>
</table>

Test Case

An assembly where four cylinders represent massless springs in series and a point mass simulates a spring mass system. The flat end face of the cylinder (Shaft 1) is fixed. Harmonic force is applied on the end face of another cylinder (Shaft 4) as shown below.

Find the z directional Deformation Frequency Response of the system on the face to which force is applied for the frequency range of 0 to 500 Hz for the following scenarios using Mode Superposition. Solution intervals = 20.

- Scenario 1: Damping ratio = 0
- Scenario 2: Damping ratio = 0.05

Figure 14.1 Schematic

Material Properties

<table>
<thead>
<tr>
<th>Material</th>
<th>E (Pa)</th>
<th>ν</th>
<th>ρ (kg/m³)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shaft 1</td>
<td>1.1e11</td>
<td>0.34</td>
<td>1e-8</td>
</tr>
<tr>
<td>Shaft 2</td>
<td>1.1e11</td>
<td>0.34</td>
<td>1e-8</td>
</tr>
<tr>
<td>Shaft 3</td>
<td>4.5e10</td>
<td>0.35</td>
<td>1e-8</td>
</tr>
<tr>
<td>Shaft 4</td>
<td>4.5e10</td>
<td>0.35</td>
<td>1e-8</td>
</tr>
</tbody>
</table>

Geometric Properties

Each cylinder:
- Diameter = 20 mm
- Length = 50 mm

Loading
- Force = -1e7 N (Z-direction)
- Point Mass = 3.1044 Kg
## Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Amplitude without damping (m)</td>
<td>0.1404</td>
<td>0.1412</td>
<td>0.570</td>
</tr>
<tr>
<td>Phase angle without damping (degrees)</td>
<td>0</td>
<td>0</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum Amplitude with damping (m)</td>
<td>0.14</td>
<td>0.14078</td>
<td>0.557</td>
</tr>
<tr>
<td>Phase angle with damping (degrees)</td>
<td>175.6</td>
<td>175.58</td>
<td>0.000</td>
</tr>
</tbody>
</table>
DSVM15: Harmonic Response of Two Storied Building under Transverse Loading

Overview


Analysis Type(s): Harmonic Analysis
Element Type(s): Solid

Test Case

A two-story building has two columns (2K and K) constituting stiffness elements and two slabs (2M and M) constituting mass elements. The material of the columns is assigned negligible density so as to make them as massless springs. The slabs are allowed to move only in the y direction by applying frictionless supports on all the faces of the slabs in the y direction. The end face of the column (2K) is fixed and a harmonic force is applied on the face of the slab (M) as shown in the figure below.

Find the y directional Deformation Frequency Response of the system at 70 Hz on each of the vertices as shown below for the frequency range of 0 to 500 Hz using Mode Superposition. Use Solution intervals = 50.

Figure 15.1 Schematic

<table>
<thead>
<tr>
<th>Material</th>
<th>E (Pa)</th>
<th>ν</th>
<th>ρ (kg/m³)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block 2</td>
<td>2e18</td>
<td>0.3</td>
<td>7850</td>
</tr>
<tr>
<td>Shaft 2</td>
<td>4.5e10</td>
<td>0.35</td>
<td>1e-8</td>
</tr>
<tr>
<td>Block 1</td>
<td>2e18</td>
<td>0.3</td>
<td>15700</td>
</tr>
<tr>
<td>Shaft 1</td>
<td>9e10</td>
<td>0.35</td>
<td>1e-8</td>
</tr>
</tbody>
</table>
**Geometric Properties**

- **Block 1 and 2:** 40 mm x 40 mm x 40 mm
- **Shaft 1 and 2:** 20 mm x 20 mm x 200 mm

**Loading**

Force = -1e5 N (y direction)

---

### Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Amplitude for vertex A (m)</td>
<td>0.20853</td>
<td>0.21002</td>
<td>0.715</td>
</tr>
<tr>
<td>Maximum Amplitude for vertex B (m)</td>
<td>0.074902</td>
<td>0.074902</td>
<td>0.684</td>
</tr>
</tbody>
</table>
DSVM16: Fatigue Tool with Non-Proportional Loading for Normal Stress

Overview

<table>
<thead>
<tr>
<th>Reference:</th>
<th>Any basic Machine Design book</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Fatigue Analysis</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>Solid</td>
</tr>
</tbody>
</table>

Test Case

A bar of rectangular cross section has the following loading scenarios.

- Scenario 1: One of the end faces is fixed and a force is applied on the opposite face as shown below in Figure 16.1: “Scenario 1”.
- Scenario 2: Frictionless support is applied to all the faces of the three standard planes (faces not seen in Figure 16.2: “Scenario 2”) and a pressure load is applied on the opposite faces in positive y- and z-directions.

Find the life, damage, and safety factor for the normal stresses in the x, y, and z directions for non-proportional fatigue using the Soderberg theory. Use a design life of 1e6 cycles, a fatigue strength factor or 1, a scale factor of 1, and 1 for coefficients of both the environments under Solution Combination.

Figure 16.1 Scenario 1
Figure 16.2 Scenario 2

Material Properties

\[ E = 2 \times 10^{11} \text{ Pa} \]
\[ \nu = 0.3 \]

Ultimate Tensile Strength = 4.68 \times 10^8 \text{ Pa}
Yield Tensile Strength = 3.58 \times 10^8 \text{ Pa}
Endurance Strength = 2.2998 \times 10^6 \text{ Pa}

<table>
<thead>
<tr>
<th>Number of Cycles</th>
<th>Alternating Stress (Pa)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>4.68</td>
</tr>
<tr>
<td>1e6</td>
<td>2.2998e6</td>
</tr>
</tbody>
</table>

Geometric Properties

Bar: 20 m x 1 m x 1m

Loading

Scenario 1: Force = 2e6 N (y-direction)
Scenario 2: Pressure = -1e8 Pa

Analysis

Non-proportional fatigue uses the corresponding results from the two scenarios as the maximum and minimum stresses for fatigue calculations. The fatigue calculations use standard formulae for the Soderberg theory.

Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stress Component - Component X</td>
<td>Life</td>
<td>3335.1049</td>
<td>3329.9</td>
</tr>
<tr>
<td></td>
<td>Damage</td>
<td>299.8406</td>
<td>300.31</td>
</tr>
<tr>
<td></td>
<td>Safety Factor</td>
<td>0.019</td>
<td>0.019025</td>
</tr>
<tr>
<td>Stress Component - Component Y</td>
<td>Life</td>
<td>14765.7874</td>
<td>14653</td>
</tr>
<tr>
<td></td>
<td>Damage</td>
<td>67.724</td>
<td>68.247</td>
</tr>
<tr>
<td></td>
<td>Safety Factor</td>
<td>0.04569</td>
<td>0.045378</td>
</tr>
<tr>
<td>Stress Component - Component Z</td>
<td>Life</td>
<td>14765.7874</td>
<td>14766</td>
</tr>
<tr>
<td></td>
<td>Damage</td>
<td>67.724</td>
<td>67.725</td>
</tr>
<tr>
<td>Safety Factor</td>
<td>0.04569</td>
<td>0.045696</td>
<td>0.013</td>
</tr>
</tbody>
</table>
DSVM17: Thermal Stress Analysis with Remote Force and Thermal Loading

Overview

| Reference: | Any basic Strength of Materials book |
| Analysis Type(s): | Linear Thermal Stress Analysis |
| Element Type(s): | Solid |

Test Case

A cylindrical rod assembly of four cylinders connected end to end has frictionless support applied on all the cylindrical surfaces and both the flat end faces are fixed. Other thermal and structural loads are as shown below.

Find the Deformation in the x direction of the contact surface on which the remote force is applied. To get accurate results apply a global element size of 1.5 m.

Figure 17.1 Schematic

![Schematic diagram of the test case](image)

Material Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>$E$</td>
<td>$2 \times 10^{11}$ Pa</td>
</tr>
<tr>
<td>$\nu$</td>
<td>0</td>
</tr>
<tr>
<td>$\alpha$</td>
<td>$1.2 \times 10^{-5}$/°C</td>
</tr>
</tbody>
</table>

Geometric Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diameter</td>
<td>2 m</td>
</tr>
<tr>
<td>Lengths of cylinders in order from End A:</td>
<td>2 m, 5 m, 10 m, and 3 m.</td>
</tr>
</tbody>
</table>

Loading

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Given temperature (End A)</td>
<td>1000°C</td>
</tr>
<tr>
<td>Given temperature (End B)</td>
<td>0°C</td>
</tr>
<tr>
<td>Remote force</td>
<td>$1 \times 10^{10}$ N applied on the contact surface at a distance 7 m from end A. Location of remote force</td>
</tr>
</tbody>
</table>

Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum X Deformation (m)</td>
<td>0.101815</td>
<td>0.10018</td>
<td>-1.606</td>
</tr>
</tbody>
</table>
DSVM18: A Bar Subjected to Tensile Load with Inertia Relief

Overview

<table>
<thead>
<tr>
<th>Reference:</th>
<th>Any basic Strength of Materials book</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Linear Static Structural Analysis (Inertia Relief On)</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>Solid</td>
</tr>
</tbody>
</table>

Test Case

A long bar assembly is fixed at one end and subjected to a tensile force at the other end as shown below. Turn on Inertia Relief.

Find the deformation in the z direction

Figure 18.1 Schematic

Material Properties

| E = 2e11 Pa |
| v = 0.3     |
| ρ = 7850 kg/m³ |

Geometric Properties

Cross-Section = 2 m x 2 m

Lengths of bars in order from End A: 2 m, 5 m, 10 m, and 3 m.

Loading

Force P = 2e5 N (positive z direction)

Analysis

\[ \delta_z = \frac{PL}{AE} - \frac{PL^2\rho}{2mE} \]

where:

L = total length of bar
A = cross-section
m = mass
# Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Z Deformation (m)</td>
<td>2.5e-6</td>
<td>2.5038e-6</td>
<td>0.152</td>
</tr>
</tbody>
</table>
DSVM19: Mixed Model Subjected to Bending Loads with Solution Combination

Overview

| Reference: | Any basic Strength of Materials book |
| Analysis Type(s): | Linear Static Structural Analysis |
| Element Type(s): | Beam and Shell |

Test Case

A mixed model (shell and beam) has one shell edge fixed as shown below. Bending loads are applied on the free vertex of the beam as given below. Apply a global element size of 80 mm to get accurate results.

- Scenario 1: Only a force load.
- Scenario 2: Only a moment load.

Find the deformation in the y direction under Solution Combination with the coefficients for both the environments set to 1.

**Figure 19.1 Scenario 1**
Figure 19.2 Scenario 2

**Material Properties**
E = 2e5 Pa  
ν = 0

**Geometric Properties**
Shell = 160 mm x 500 mm x 10 mm  
Beam rectangular cross section = 10 mm x 10 mm  
Beam length = 500 mm

**Loading**
Force F = -10 N (y direction)  
Moment M = -4035 Nmm @ z-axis

**Analysis**

\[ \delta_y = \frac{23}{384} \frac{Fl^3}{EI} + \frac{19}{128} \frac{Ml^2}{EI} \]

where:

\( l = \) total bending length of the mixed model  
\( l = \) moment of inertia of the beam cross-section

**Results Comparison**

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Y-Deformation (mm)</td>
<td>-7.18742</td>
<td>-7.2542</td>
<td>0.929</td>
</tr>
</tbody>
</table>
DSVM20: Modal Analysis for Beams

Overview

<table>
<thead>
<tr>
<th>Reference:</th>
<th>Any basic Vibration Analysis book</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Modal Analysis</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>Beam</td>
</tr>
</tbody>
</table>

Test Case

Two collinear beams form a spring mass system. The density of the longer beam is kept very low so that it acts as a massless spring and the smaller beam acts as a mass. The end vertex of the longer beam (acting as a spring) is fixed. The cross section details are as shown below.

Find the natural frequency of the axial mode.

Figure 20.1 Cross Section Details for Both Beams
**Material Properties**

<table>
<thead>
<tr>
<th>Material</th>
<th>$E$ (Pa)</th>
<th>$\nu$</th>
<th>$\rho$ (kg/m$^3$)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spring</td>
<td>1.1e11</td>
<td>0.34</td>
<td>1e-8</td>
</tr>
<tr>
<td>Mass</td>
<td>2e11</td>
<td>0</td>
<td>7.85e5</td>
</tr>
</tbody>
</table>

**Geometric Properties**

Spring beam length = 500 mm  
Mass beam length = 5 mm

**Results Comparison**

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Natural Frequency of Axial Mode (Hz)</td>
<td>1188.6</td>
<td>1190.5</td>
<td>0.160</td>
</tr>
</tbody>
</table>
DSVM21: Buckling Analysis of Beams

Overview

| Reference: | Young, Warren C., Roark’s Formulas for Stress and Strains, McGraw Hill, 6th Edition, Table 34, Case 3a, pg. 675 |
| Analysis Type(s): | Buckling Analysis |
| Element Type(s): | Beam |

Test Case

A beam fixed at one end and is subjected to two compressive forces. One of the forces is applied on a portion of the beam of length 50 mm ($L_1$) from the fixed end and the other is applied on the free vertex, as shown below.

Find the load multiplier for the first buckling mode.

Figure 21.1 Schematic

![Figure 21.1 Schematic](image)

Material Properties

- $E = 2e11$ Pa
- $\nu = 0.3$

Geometric Properties

- $L_1 = 50$ mm
- Total length = 200 mm
- Rectangular cross section = 10 mm x 10 mm

Loading

- Force on $L_1 = -1000$ N (x direction)
- Force on free vertex = -1000 N (x direction)

Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Multiplier</td>
<td>10.2397</td>
<td>10.198</td>
<td>-0.407</td>
</tr>
</tbody>
</table>
DSVM22: Structural Analysis with Advanced Contact Options

Overview

Reference: Any basic Strength of Material book
Analysis Type(s): Nonlinear Static Structural Analysis
Element Type(s): Solid

Test Case

An assembly of two parts with a gap has a Frictionless Contact defined between the two parts. The end faces of both the parts are fixed and a given displacement is applied on the contact surface of Part 1 as shown below.

Find the Normal stress and Directional deformation - both in the z direction for each part for the following scenarios:

- Scenario 1: Interface treatment - adjust to touch.
- Scenario 2: Interface treatment - add offset. Offset = 0 m.
- Scenario 3: Interface treatment - add offset. Offset = 0.001 m.
- Scenario 4: Interface treatment - add offset. Offset = -0.001 m.

Validate all of the above scenarios for Augmented Lagrange and Pure Penalty formulations.

Figure 22.1 Schematic

<table>
<thead>
<tr>
<th>Material Properties</th>
<th>Geometric Properties</th>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>E = 2e11 Pa</td>
<td>Gap = 0.0005 m</td>
<td>Given displacement = (0, 0, 0.0006) m</td>
</tr>
<tr>
<td>ν = 0</td>
<td>Dimensions for each part: 0.1 m x 0.1 m x 0.5m</td>
<td></td>
</tr>
</tbody>
</table>

Results Comparison

The same results are obtained for both Augmented Lagrange and Pure Penalty formulations.
<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust To Touch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum directional z deformation Part 1 (m)</td>
<td>6e-4</td>
<td>6e-4</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum directional z deformation Part 2 (m)</td>
<td>6e-4</td>
<td>5.9786e-4</td>
<td>-0.357</td>
</tr>
<tr>
<td>Maximum normal z stress Part 1 (Pa)</td>
<td>2.4e8</td>
<td>2.4e8</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum normal x stress Part 2 (Pa)</td>
<td>-2.4e8</td>
<td>-2.3915e8</td>
<td>-0.357</td>
</tr>
<tr>
<td>Add Offset. Offset = 0 m</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum directional z deformation Part 1 (m)</td>
<td>6e-4</td>
<td>6e-4</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum directional z deformation Part 2 (m)</td>
<td>1e-4</td>
<td>0.99644e-4</td>
<td>-0.356</td>
</tr>
<tr>
<td>Maximum normal z stress Part 1 (Pa)</td>
<td>2.4e8</td>
<td>2.4e8</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum normal x stress Part 2 (Pa)</td>
<td>-4e7</td>
<td>-3.9858e7</td>
<td>-0.356</td>
</tr>
<tr>
<td>Add Offset. Offset = 0.001 m</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum directional z deformation Part 1 (m)</td>
<td>6e-4</td>
<td>6e-4</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum directional z deformation Part 2 (m)</td>
<td>1.1e-3</td>
<td>1.0961e-3</td>
<td>-0.355</td>
</tr>
<tr>
<td>Maximum normal z stress Part 1 (Pa)</td>
<td>2.4e8</td>
<td>2.4e8</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum normal x stress Part 2 (Pa)</td>
<td>-4.4e8</td>
<td>-4.3843e8</td>
<td>-0.355</td>
</tr>
<tr>
<td>Add Offset. Offset = -0.0001 m</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum directional z deformation Part 1 (m)</td>
<td>6e-4</td>
<td>6e-4</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum directional z deformation Part 2 (m)</td>
<td>0</td>
<td>0</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum normal z stress Part 1 (Pa)</td>
<td>2.4e8</td>
<td>2.4e8</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum normal x stress Part 2 (Pa)</td>
<td>0</td>
<td>0.003752</td>
<td>0.004</td>
</tr>
</tbody>
</table>
DSVM23: Curved Beam Assembly with Multiple Loads

Overview

<table>
<thead>
<tr>
<th>Reference:</th>
<th>Any basic Strength of Materials book</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Linear Static Structural Analysis</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>Beam</td>
</tr>
</tbody>
</table>

Test Case

An assembly of two curved beams, each having an included angle of 45°, has a square cross-section. It is fixed at one end and at the free end a Force F and a Moment M are applied. Also, a UDL of \( w \) N/mm is applied on both the beams. Use a global element size of 30 mm to get accurate results. See the figure below for details.

Find the deformation of the free end in the y direction.

Figure 23.1 Schematic

Equivalent Loading:
Material Properties
Beam 1:
- $E_1 = 1.1 \times 10^5$ MPa
- $\nu_1 = 0$
- $\rho_1 = 8.3 \times 10^{-6}$ kg/mm$^3$
Beam 2:
- $E_2 = 2 \times 10^5$ MPa
- $\nu_2 = 0$
- $\rho_2 = 7.85 \times 10^{-6}$ kg/mm$^3$

Geometric Properties
For each beam:
- Cross-section = 10 mm x 10 mm
- Radius $r = 105$ mm
- Included angle = 45°

Loading
- Force $F = 1000$ N (y direction)
- Moment $M = -10000$ Nmm (about z-axis)
- UDL $w = -5$ N/mm (y direction) on both beams

This UDL is applied as an edge force on each beam with magnitude $= 5 \times (2 \times 3.14 \times 10^5) / 8 = 412.334$ N

Analysis
The deflection in the y direction is in the direction of the applied force $F$ and is given by:
\[
\delta = \frac{1}{2E_1I} \left\{ \frac{F^3}{33} (0.142699) + Mr^2 (0.29289) + r^4 \omega (0.039232) \right\} + \frac{1}{E_2I} \left\{ \frac{F^3}{33} (0.642699) + Mr^2 (0.707) + r^4 \omega (0.293564247) \right\}
\]
where:
- $\delta$ = deflection at free end in the y direction
- $I$ = moment of inertia of the cross-section of both beams

Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Y Deformation (mm)</td>
<td>-8.416664</td>
<td>-8.4688</td>
<td>0.619</td>
</tr>
</tbody>
</table>

---

DSVM23
DSVM24: Harmonic Response of a Single Degree of Freedom System for Beams

Overview

| Reference:   | Any basic Vibration Analysis book |
| Analysis Type(s): | Harmonic Analysis |
| Element Type(s): | Beam |

Test Case

Two collinear beams form a spring-mass system. The density of the longer beam is kept very low so that it acts as a massless spring and the smaller beam acts as a mass. The end vertex of the longer beam (acting as a spring) is fixed. A Harmonic force $F$ is applied on the free vertex of the shorter beam in $z$ direction. Both beams have hollow circular cross-sections, as indicated below.

- Scenario 1: Damping ratio = 0
- Scenario 2: Damping ratio = 0.05

Find the $z$ directional deformation of the vertex where force is applied at frequency $F = 500$ Hz for the above scenarios with solution intervals = 25 and a frequency range of 0 to 2000 Hz. Use both Mode Superposition and Full Method.

Figure 24.1 Schematic

<table>
<thead>
<tr>
<th>Material Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material</td>
</tr>
<tr>
<td>Spring</td>
</tr>
<tr>
<td>Mass</td>
</tr>
</tbody>
</table>
### Geometric Properties
Cross-section of each beam:
- Outer radius = 10 mm
- Inner radius = 5 mm
- Length of longer beam = 100 mm
- Length of shorter beam = 5 mm

### Loading
Harmonic force $F = 1 \times 10^6$ N (z-direction)

### Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mode Superposition</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum $z$ directional deformation (m)</td>
<td>4.11332e-3</td>
<td>4.0654e-3</td>
<td>-1.165</td>
</tr>
<tr>
<td>Maximum $z$ directional deformation (m) with damping</td>
<td>4.11252e-3</td>
<td>4.064e-3</td>
<td>-1.180</td>
</tr>
<tr>
<td><strong>Full Method</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum $z$ directional deformation (m) without damping</td>
<td>4.11332e-3</td>
<td>4.1132e-3</td>
<td>-0.003</td>
</tr>
<tr>
<td>Maximum $z$ directional deformation (m) with damping</td>
<td>4.11252e-3</td>
<td>4.0695e-3</td>
<td>-1.046</td>
</tr>
</tbody>
</table>
### DSVM25: Stresses Due to Shrink Fit Between Two Cylinders

#### Overview

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Linear Static Structural Analysis</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>Solid</td>
</tr>
</tbody>
</table>

#### Test Case

One hollow cylinder is shrink fitted inside another. Both cylinders have length \( L \) and both the flat faces of each cylinder are constrained in the axial direction. They are free to move in radial and tangential directions. An internal pressure of \( P \) is applied on the inner surface of the inner cylinder. To get accurate results, apply a global element size of 0.8 inches.

Find the maximum tangential stresses in both cylinders.

*Note —* Tangential stresses can be obtained in Simulation using a cylindrical coordinate system.

To simulate interference, set Contact Type to Rough with interface treatment set to add offset with Offset \( = 0 \).

#### Figure 25.1 Schematic

![Schematic Diagram](image)

#### Material Properties

<table>
<thead>
<tr>
<th>Both cylinders are made of the same material</th>
</tr>
</thead>
<tbody>
<tr>
<td>( E = 3e7 \text{ psi} )</td>
</tr>
<tr>
<td>( \nu = 0 )</td>
</tr>
<tr>
<td>( \rho = 0.28383 \text{ lbm/in}^3 )</td>
</tr>
</tbody>
</table>

#### Geometric Properties

<table>
<thead>
<tr>
<th>Inner Cylinder:</th>
</tr>
</thead>
<tbody>
<tr>
<td>( r_i = 4&quot; )</td>
</tr>
<tr>
<td>( r_o = 6.005&quot; )</td>
</tr>
<tr>
<td>( R_i = 6&quot; )</td>
</tr>
<tr>
<td>( R_o = 8&quot; )</td>
</tr>
<tr>
<td>Length of both cylinders = 5&quot;</td>
</tr>
</tbody>
</table>

#### Loading

| \( P = 30000 \text{ psi} \) |
## Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum normal y stress, inner cylinder (psi)</td>
<td>35396.67</td>
<td>35849</td>
<td>1.278</td>
</tr>
<tr>
<td>Maximum normal y stress, outer cylinder (psi)</td>
<td>42281.09</td>
<td>42295</td>
<td>0.033</td>
</tr>
</tbody>
</table>

*Note — Here y corresponds to θ direction of a cylindrical coordinate system.*
DSVM26: Fatigue Analysis of a Rectangular Plate Subjected to Edge Moment

Overview

Analysis Type(s): Fatigue Analysis
Element Type(s): Shell

Test Case

A plate of length L, width W, and thickness T is fixed along the width on one edge and a moment M is applied on the opposite edge about the z-axis.

Find the maximum Bending Stress sx and maximum Total Deformation d of the plate. Also find the part life and the factor of safety using Goodman, Soderberg, & Gerber criteria. Use the x-stress component. Consider load type as fully reversed and a Design Life of 1e6 cycles, Fatigue Strength factor of 1, and Scale factor of 1.

Figure 26.1 Schematic

Material Properties

\[ E = 2e11 \text{ Pa} \]
\[ \nu = 0.0 \]
Ultimate tensile strength = 2.5e8 Pa
Endurance strength = 1.38e8 Pa

<table>
<thead>
<tr>
<th>No. of Cycles</th>
<th>Alternating Stresses (Pa)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>1.08e9</td>
</tr>
<tr>
<td>1e6</td>
<td>1.38e8</td>
</tr>
</tbody>
</table>

Geometric Properties

Length \( L = 12e-3 \text{ m} \)
Width \( W = 1e-3 \text{ m} \)
Thickness \( T = 1e-3 \text{ m} \)

Loading

Moment \( M = 0.15 \text{ Nm} \) (counterclockwise @ z-axis)
## Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum normal x-stress (Pa)</td>
<td>9e8</td>
<td>9e8</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum total deformation</td>
<td>6.48e-4</td>
<td>6.49e-4</td>
<td>0.279</td>
</tr>
<tr>
<td>SN-Goodman Safety factor</td>
<td>0.1533</td>
<td>0.15333</td>
<td>0.020</td>
</tr>
<tr>
<td>Safety factor</td>
<td>Life</td>
<td>1844.3</td>
<td>1844.4</td>
</tr>
<tr>
<td>SN-Soderberg Safety factor</td>
<td>0.1533</td>
<td>0.15333</td>
<td>0.020</td>
</tr>
<tr>
<td>Safety factor</td>
<td>Life</td>
<td>1844.3</td>
<td>1844.4</td>
</tr>
<tr>
<td>SN-Gerber Safety factor</td>
<td>0.1533</td>
<td>0.15333</td>
<td>0.020</td>
</tr>
<tr>
<td>Safety factor</td>
<td>Life</td>
<td>1844.3</td>
<td>1844.4</td>
</tr>
</tbody>
</table>
DSVM27: Thermal Analysis for Shells with Heat Flow and Given Temperature

Overview

<table>
<thead>
<tr>
<th>Reference:</th>
<th>Any standard Thermal Analysis book</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Thermal Stress Analysis</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>Shell</td>
</tr>
</tbody>
</table>

Test Case

A plate of length (L), width (W), and thickness (T) is fixed along the width on one edge and heat flow (Q) is applied on the same edge. The opposite edge is subjected to a temperature of 20 °C. Ambient temperature is 20 °C. To get accurate results, apply a sizing control with element size = 2.5e-2 m.

Find the maximum temperature, maximum total heat flux, maximum total deformation, and heat reaction at the given temperature.

Figure 27.1 Schematic

<table>
<thead>
<tr>
<th>Material Properties</th>
<th>Geometric Properties</th>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>E = 2e11 Pa</td>
<td>Length L = 0.2 m</td>
<td>Heat flow Q = 5 W</td>
</tr>
<tr>
<td>ν = 0.0</td>
<td>Width W = 0.05 m</td>
<td></td>
</tr>
<tr>
<td>Thermal expansion α = 1.25e-5/°C</td>
<td>Thickness T = 0.005 m</td>
<td></td>
</tr>
<tr>
<td>Thermal conductivity k = 60.5 W/m°C</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Analysis

Heat Reaction = -(Total heat generated)

Heat flow due to conduction is given by:

\[ Q = kA \frac{(T_h - T_l)}{l} \]
Total heat flux is:

\[ q = \frac{Q}{A} \]

Temperature at a variable distance \( z \) from the fixed support is given by:

\[ T_z = T_h - \left( \frac{(T_h - T_\alpha) \times z}{l} \right) \]

Thermal deformation in the z-direction is given by:

\[ \delta_z = \int_0^l \alpha(T_z - T_\alpha) \, dz \]

**Results Comparison**

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Temperature (°C)</td>
<td>86.116</td>
<td>86.1157</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum Total Heat Flux (W/m²)</td>
<td>2e4</td>
<td>2e4</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum Total Deformation</td>
<td>7.93386e-5</td>
<td>7.9963e-5</td>
<td>0.787</td>
</tr>
<tr>
<td>Heat Reaction (W)</td>
<td>-5</td>
<td>-5</td>
<td>0.000</td>
</tr>
</tbody>
</table>
DSVM28: Pretension Bolt Load Applied on a Semi-Cylindrical Face

Overview

Reference: Any standard Strength of Materials book
Analysis Type(s): Static Structural Analysis
Element Type(s): Solid

Test Case

A half-cylinder 1 m long having a diameter of 0.05 m is fixed at both the end faces. The longitudinal faces have frictionless support. A pretension bolt load is applied on the semi-cylindrical face. To get accurate results, apply sizing control with element size = 0.01 m.

Find the z-directional deformation and the adjustment reaction due to the pretension bolt load.

Figure 28.1 Schematic

Material Properties
\[ E = 2e11 \text{ Pa} \quad \nu = 0.0 \]

Geometric Properties
Length \( L = 1 \text{ m} \)
Diameter \( D = 0.05 \text{ m} \)

Loading
Pretension as preload = 19.635 N (equal to adjustment of 1e-7 m)

Analysis

The pretension bolt load applied as a preload is distributed equally to both halves of the bar. Therefore the z-directional deformation due to pretension is given by:

\[ \delta_{\text{Pretension}} = \frac{\text{Pretension Load} \times L}{2AE} \]

Adjustment = \( \delta_{\text{Pretension}} \times 2 \)

Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum z-directional deformation (m)</td>
<td>-0.5e-7</td>
<td>-0.50002e-7</td>
<td>0.004</td>
</tr>
<tr>
<td>Adjustment Reaction (m)</td>
<td>1e-7</td>
<td>1e-7</td>
<td>0.000</td>
</tr>
</tbody>
</table>
DSVM29: Elasto-Plastic Analysis of a Rectangular Beam

Overview

| Analysis Type(s): | Static Plastic Analysis |
| Element Type(s): | Solid |

Test Case

A rectangular beam is loaded in pure bending fashion. For an elastic, perfectly plastic stress-strain behavior, show that the beam remains elastic at $M = M_{yp} = \frac{\sigma_{yp} bh^2}{6}$ and becomes completely plastic at $M = M_{ult} = 1.5 M_{yp}$. To get accurate results, set the advanced mesh control element size to 0.5 inches.

Figure 29.1 Schematic
Figure 29.2 Schematic

Material Properties

- $E = 3 \times 10^7$ Pa
- $\nu = 0.0$
- $\sigma_{yp} = 36000$ psi

Geometric Properties

- Length $L = 10''$
- Width $b = 1''$
- Height $h = 2''$

Loading

- $M = 1.0 \sigma_{yp}$ to $1.5 \sigma_{yp}$
  - $(\sigma_{yp} = 24000$ lbf-in$)$

Analysis

The load is applied in three increments: $M_1 = 24000$ lbf-in, $M_2 = 30000$ lbf-in, and $M_3 = 36000$ lbf-in.

Results Comparison

<table>
<thead>
<tr>
<th>$M/\sigma_{yp}$</th>
<th>Target State</th>
<th>Equivalent Stress (psi)</th>
<th>DS State</th>
<th>Equivalent Stress (psi)</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>fully elastic</td>
<td>36000</td>
<td>fully elastic</td>
<td>36059</td>
<td>0.164</td>
</tr>
<tr>
<td>1.25</td>
<td>fully elastic</td>
<td>36000</td>
<td>elastic-plastic</td>
<td>36288</td>
<td>0.800</td>
</tr>
<tr>
<td>1.5</td>
<td>plastic</td>
<td>solution not converged</td>
<td>plastic</td>
<td>solution not converged</td>
<td>-</td>
</tr>
</tbody>
</table>
DSVM30: Bending of Long Plate Subjected to Moment - Plane Strain Model

Overview

<table>
<thead>
<tr>
<th>Reference:</th>
<th>Any standard Strength of Materials book</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Plane Strain Analysis</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>2D Structural Solid</td>
</tr>
</tbody>
</table>

Test Case

A long, rectangular plate is fixed along the longitudinal face and the opposite face is subjected to a moment of 5000 lbf-in about the z-axis. To get accurate results, set the advanced mesh control element size to 0.5 inches.

Find x-normal stress 0.5 inches from the fixed support. Also find total deformation and reaction moment.

Figure 30.1 Schematic

Analysis

Since the loading is uniform and in one plane (the x-y plane), the above problem can be analyzed as a plane strain problem. Therefore, the moment applied will be per unit length (5000/1000 = 5 lbf-in). Analysis takes into account the unit length in the z-direction.

Material Properties

\[ E = 2.9e7 \text{ Pa} \]

\[ \nu = 0.0 \]

Geometric Properties

\[ \text{Length } L = 1000^\circ \]

\[ \text{Width } W = 40^\circ \]

\[ \text{Thickness } T = 1^\circ \]

Loading

\[ \text{Moment } M = 5000 \text{ lbf-in} \]
Figure 30.2 Plane Strain Model (analyzing any cross section (40” x 1”) along the length)

Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Normal Stress in the X-Direction (psi)</td>
<td>30</td>
<td>30</td>
<td>0.000</td>
</tr>
<tr>
<td>Maximum Total Deformation (in)</td>
<td>0.1655e-2</td>
<td>0.1655e-2</td>
<td>0.018</td>
</tr>
<tr>
<td>Reaction Moment (lbf-in)</td>
<td>-5</td>
<td>-5</td>
<td>0.000</td>
</tr>
</tbody>
</table>
DSVM31: Long Bar with Uniform Force and Stress Tool - Plane Stress Model

Overview

Reference: Any standard Strength of Materials book  
Analysis Type(s): Plane Stress Analysis  
Element Type(s): 2D Structural Solid

Test Case

A long, rectangular bar assembly is fixed at one of the faces and the opposite face is subjected to a force of 1e9 N in the negative x-direction. To get accurate results, set the advanced mesh control element size to 1 m.

Find the maximum equivalent stress for the whole assembly and safety factor, safety margin, and safety ratio for the first and last part using the maximum equivalent stress theory with Tensile Yield Limit.

Figure 31.1 Schematic

<table>
<thead>
<tr>
<th>Material Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material</td>
</tr>
<tr>
<td>Part 1</td>
</tr>
<tr>
<td>Part 2</td>
</tr>
<tr>
<td>Part 3</td>
</tr>
<tr>
<td>Part 4</td>
</tr>
</tbody>
</table>
### Geometric Properties

<table>
<thead>
<tr>
<th>Part</th>
<th>Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part 1</td>
<td>2 m x 2 m x 3 m</td>
</tr>
<tr>
<td>Part 2</td>
<td>2 m x 2 m x 10 m</td>
</tr>
<tr>
<td>Part 3</td>
<td>2 m x 2 m x 5 m</td>
</tr>
<tr>
<td>Part 4</td>
<td>2 m x 2 m x 2 m</td>
</tr>
</tbody>
</table>

### Loading

- Force = $1 \times 10^9$ N in the negative z-direction

### Analysis

Since the loading is uniform and in one plane, the above problem can be analyzed as a plane stress problem. Analysis takes into account the thickness of 2 m along the z-direction.

### Figure 31.2 Plane Stress Model (Analyzing any cross section along Z)

#### Fixed Support

- Force: $1 \times 10^9$ N

### Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Equivalent Stress (Pa)</td>
<td>2.5e8</td>
<td>2.5e8</td>
<td>0.000</td>
</tr>
<tr>
<td>Part 1 Safety Factor</td>
<td>0.828</td>
<td>0.828</td>
<td>0.000</td>
</tr>
<tr>
<td>Part 1 Safety Margin</td>
<td>-0.172</td>
<td>-0.172</td>
<td>0.000</td>
</tr>
<tr>
<td>Part 1 Safety Ratio</td>
<td>1.207</td>
<td>1.2077</td>
<td>0.058</td>
</tr>
<tr>
<td>Part 4 Safety Factor</td>
<td>1.12</td>
<td>1.12</td>
<td>0.000</td>
</tr>
<tr>
<td>Part 4 Safety Margin</td>
<td>0.12</td>
<td>0.12</td>
<td>0.000</td>
</tr>
<tr>
<td>Part 4 Safety Ratio</td>
<td>0.892</td>
<td>0.89286</td>
<td>0.096</td>
</tr>
</tbody>
</table>
DSVM32: Radial Flow due to Internal Heat Generation in a Copper Disk - Axisymmetric Model

Overview

Reference: Any standard Thermal Analysis book
Analysis Type(s): Axisymmetric Analysis
Element Type(s): 2D Structural Solid

Test Case

A copper disk with thickness $t$ and radii $R_i$ and $R_o$ is insulated on the flat faces. It has a heat-generating copper coaxial cable (of radius $R_i$) passing through its center. The cable delivers a total heat flow of $Q$ to the disk. The surrounding air is at a temperature of $T_o$ with convective film coefficient $h$. To get accurate results, set the advanced mesh control element size to 0.002 m.

Find the disk temperature and heat flux at inner and outer radii.

Figure 32.1 Schematic

![Diagram showing a copper disk with a coaxial cable passing through its center. The disk has radii $R_i = 10$ mm and $R_o = 60$ mm, and thickness $t = 8$ mm. The cable delivers a heat flow $Q = 100$ W to the disk, and the surrounding air is at a temperature $T_o$.]

<table>
<thead>
<tr>
<th>Material Properties</th>
<th>Geometric Properties</th>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>$E = 1.1e11$ Pa</td>
<td>$R_i = 10$ mm</td>
<td>$Q = 100$ W (equal to 39788735.77 W/m³)</td>
</tr>
<tr>
<td>$\nu = 0.34$</td>
<td>$R_o = 60$ mm</td>
<td>Film coefficient $h = 1105$ W/m²·°C</td>
</tr>
<tr>
<td>Thermal conductivity $k = 401.0$ W/m·°C</td>
<td>$t = 8$ mm</td>
<td>Surrounding temperature $T_o = 0^\circ$C</td>
</tr>
</tbody>
</table>

Analysis

Because the geometry and loading are symmetric about the y-axis, the above problem can be analyzed as an axisymmetric problem.
Figure 32.2 Plane Stress Model (Analyzing any cross section along Z)

Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Temperature (°C)</td>
<td>38.9</td>
<td>38.896</td>
<td>-0.010</td>
</tr>
<tr>
<td>Minimum Temperature (°C)</td>
<td>30</td>
<td>30.007</td>
<td>0.023</td>
</tr>
<tr>
<td>Maximum Heat Flux (W/m$^2$)</td>
<td>1.98943e5</td>
<td>1.9808e5</td>
<td>-0.434</td>
</tr>
<tr>
<td>Minimum Heat Flux (W/m$^2$)</td>
<td>33157</td>
<td>33148</td>
<td>-0.027</td>
</tr>
</tbody>
</table>
DSVM33: Electromagnetic Analysis of a C-Shaped Magnet

Overview

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Electromagnetic Analysis</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>Solid</td>
</tr>
</tbody>
</table>

Test Case

A C-shaped magnet has a coil with 400 turns and a cross section of the core with area 4 cm$^2$. A current of 0.1 A flows through the coil. The air gap is 0.2 cm and the coil details are given in Figure 33.2: “Coil Details in cm”. Flux parallel is applied on the nine outer faces as shown in Figure 33.4: “Flux Parallel Applied on 9 Outer Faces”. To get accurate results, set the advanced mesh control element size to 0.003 m.

Find the total flux density and total field intensity.

Figure 33.1 Schematic
Figure 33.2 Coil Details in cm

Figure 33.3 Current and Voltage
Figure 33.4 Flux Parallel Applied on 9 Outer Faces

Material Properties

<table>
<thead>
<tr>
<th>Material</th>
<th>Young's Modulus (Pa)</th>
<th>Poisson's Ratio</th>
<th>Density (kg/m³)</th>
<th>Relative Permeability</th>
<th>Electric Resistivity (ohm-m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air Body</td>
<td>1e7</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Coil</td>
<td>1.1e11</td>
<td>0.34</td>
<td>8300</td>
<td>1</td>
<td>2e-7</td>
</tr>
<tr>
<td>Core</td>
<td>2e11</td>
<td>0.3</td>
<td>7850</td>
<td>500</td>
<td>0</td>
</tr>
</tbody>
</table>

Geometric Properties

Given in Figure 33.2: "Coil Details in cm"

Loading

Voltage = 0 V
Current = 0.1 A

Analysis

Using the analogy of Ohm's law of Magnetism, we have the following equation:

Magnetic flux is: \( \phi = \frac{NI}{\left( \frac{L_c}{\mu_c A_c} + \frac{L_a}{\mu_a A_a} \right)} \)

where:

- \( N \) = number of turns
- \( I \) = current
- \( L_c \) = mean core length
- \( L_a \) = air gap
- \( A_c \) = cross-sectional area of core
- \( A_a \) = apparent area of air gap
- \( \mu_c \) = permeability of core
- \( \mu_a \) = permeability of air

The air-gap average flux density is given by:
\[ B_a = \frac{\phi}{A_a} \]

The air-gap average field intensity is given by:
\[ H_a = \frac{B_a}{\mu_a} \]

**Results Comparison**

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DS</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Flux Density (T)</td>
<td>4.061e-2</td>
<td>4.0556e-2</td>
<td>-0.133</td>
</tr>
<tr>
<td>Total Field Intensity (A/m)</td>
<td>32320.0585</td>
<td>32273</td>
<td>-0.146</td>
</tr>
</tbody>
</table>
DesignXplorer Descriptions
DXVM1: Optimization of L-shaped cantilever beam for deflection, volume, and stress under axial load

Overview

<table>
<thead>
<tr>
<th>Reference:</th>
<th>From the Basic Principle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Goal Driven Optimization</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>3-D Solid</td>
</tr>
</tbody>
</table>

Test Case

An L-shaped beam with dimensions 30 x 25 mm with 4 mm as the rib thickness and 300 mm in length has the surface fixed at one end. A force of 10,000 N is then applied to the opposite end of the beam.

**Input Parameters:**  Width, Height, and Length (CAD Geometry)

**Response Parameters:** Volume, Stress, and Deflection

**Figure 1.1 Schematic**

<table>
<thead>
<tr>
<th>Material Properties</th>
<th>Geometric Properties</th>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>$E = 2e11$ Pa</td>
<td>Width = 25 mm</td>
<td></td>
</tr>
<tr>
<td>$\nu = 0$</td>
<td>Height = 30 mm</td>
<td></td>
</tr>
<tr>
<td>$\rho = 7850$ kg/m$^3$</td>
<td>Rib Thickness = 4 mm</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Length = 300 mm</td>
<td></td>
</tr>
</tbody>
</table>

| Fixed Support |
| Force $F = 10000$ N (Z direction) |

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Limits</th>
<th>Desired Value</th>
<th>Importance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>Input</td>
<td>$20 \text{ mm} \leq W \leq 30 \text{ mm}$</td>
<td>No Preference</td>
<td>High</td>
</tr>
<tr>
<td>Height</td>
<td>Input</td>
<td>$25 \text{ mm} \leq H \leq 35 \text{ mm}$</td>
<td>No Preference</td>
<td>High</td>
</tr>
</tbody>
</table>
### Parameter Table

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Limits</th>
<th>Desired Value</th>
<th>Importance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Input</td>
<td>$250 \text{ mm} \leq L \leq 350 \text{ mm}$</td>
<td>No Preference</td>
<td>High</td>
</tr>
<tr>
<td>Volume</td>
<td>Output</td>
<td>n/a</td>
<td>Minimum Possible</td>
<td>Low</td>
</tr>
<tr>
<td>Stress</td>
<td>Output</td>
<td>n/a</td>
<td>Minimum Possible</td>
<td>High</td>
</tr>
<tr>
<td>Deflection</td>
<td>Output</td>
<td>n/a</td>
<td>Minimum Possible</td>
<td>High</td>
</tr>
</tbody>
</table>

### Analysis

Beam volume:

$$V = L(4W + 4H + 16)$$

Maximum axial deformation under load $F$:

$$D = \frac{FL}{AE} = 5.0 \times 10^{-2} \times \frac{L}{(4W + 4H + 16)}$$

Normal stress along Z-direction:

$$\sigma = \frac{F}{A} = \frac{10,000}{(4W + 4H + 16)}$$

Combined objective function becomes:

$$\Phi = 2.8008 \times 10^{-5}L(W + H + 4) + \frac{0.2842L}{(W + H + 4)} + \frac{169.0503}{(W + H + 4)} - 3.8227$$

Minimizing $\phi$ we get dimensions as:

- $L = \text{Length} = 0.250 \text{ m}$
- $W = \text{Width} = 0.030 \text{ m}$
- $H = \text{Height} = 0.035 \text{ m}$

### Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DX</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume (V)</td>
<td>$6.9 \times 10^{-5} \text{ m}^3$</td>
<td>$6.9643 \times 10^{-5}$</td>
<td>0.932</td>
</tr>
<tr>
<td>Deformation (D)</td>
<td>$4.5290 \times 10^{-5} \text{ m}$</td>
<td>$4.6029 \times 10^{-5}$</td>
<td>1.632</td>
</tr>
<tr>
<td>Stress ($\sigma$)</td>
<td>$3.62319 \times 10^7 \text{ Pa}$</td>
<td>$3.6338 \times 10^7$</td>
<td>0.296</td>
</tr>
</tbody>
</table>
DXVM2: Optimization of bar with temperature-dependent conductivity for temperature and thermal strain

Overview

<table>
<thead>
<tr>
<th>Reference:</th>
<th>From the Basic Principle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type(s):</td>
<td>Goal Driven Optimization</td>
</tr>
<tr>
<td>Element Type(s):</td>
<td>3-D Solid</td>
</tr>
</tbody>
</table>

Test Case

A long bar 2 X 2 X 20 m is made up of material having thermal conductivity linearly varying with the temperature

\[ K = k_0(1 + a \cdot T) \text{ W/m}^{-\circ}C, \]

where \( k_0 = 0.038, a = 0.00582 \). The bar is constrained on all faces by frictionless support. A temperature of 100°C is applied at one end of the bar. The reference temperature is 5°C. At the other end, a constant convection coefficient of 0.005 W/m²°C is applied. The ambient temperature is 5°C. (Esize of 1 m)

Input Parameters: Convection coefficient and coefficient of thermal expansion length (CAD Geometry)

Response Parameters: Temperature (scoped on end face), thermal strain

Find reaction forces in the y direction at the fixed supports.

Figure 2.1 Schematic

<table>
<thead>
<tr>
<th>Material Properties</th>
<th>Geometric Properties</th>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>( E = 2 \times 10^{11} \text{ Pa} )</td>
<td>Breadth ( B = 2 \text{ m} )</td>
<td>Frictionless Support (on all faces)</td>
</tr>
<tr>
<td>( \nu = 0 )</td>
<td>Width ( W = 2 \text{ m} )</td>
<td>Reference temperature = 5°C</td>
</tr>
<tr>
<td>( \alpha = 1.5 \times 10^{-5}/^\circ C )</td>
<td>Length ( L = 2 \text{ mm} )</td>
<td>Temperature on end face ( T = 100^\circ C )</td>
</tr>
<tr>
<td>( K = k_0(1 + a \cdot T) \text{ W/m}^{-\circ}C )</td>
<td>( k_0 = 0.038 )</td>
<td>Convection on other end face</td>
</tr>
<tr>
<td>( a = 0.00582 )</td>
<td>( a = 0.00582 )</td>
<td>Convection coefficient ( h = 5 \times 10^{-3} \text{ W/m}^{2}^\circ C )</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ambient temperature ( Ta = 5^\circ C )</td>
</tr>
</tbody>
</table>
### Analysis

#### Temperature:

\[
T_s = \frac{-4521.613h_\alpha l - 171.8213 + \sqrt{2.0445 \times 10^7 h_\alpha^2 l^2 + 1.6 \times 10^6 h_\alpha l + 73887.8}}{25}
\]

#### Thermal strain:

\[
\varepsilon = \alpha(T_s - T_a) = \alpha(T_s - 5)
\]

Combined objective function becomes,

\[
\Phi = (0.048365 + 2630.75\alpha) \left( -4521.613h_\alpha l - 171.8213 + \sqrt{2.0445 \times 10^7 h_\alpha^2 l^2 + 1.6 \times 10^6 h_\alpha l + 73887.8} \right) - 13153.74\alpha - 2.34215
\]

Minimizing \( \Phi \) we get input parameters as:

- \( l = \) beam length = 25 m
- \( h = \) convection coefficient = 0.006 W/m\(^2\)\(^\circ\)C
- \( \alpha = \) coefficient of thermal expansion = 1.4e-5/\(^\circ\)C

### Results Comparison

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Target</th>
<th>DX</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length (l)</td>
<td>25 m</td>
<td>24.938 m</td>
<td>-0.248</td>
</tr>
<tr>
<td>Convection coefficient (h)</td>
<td>0.006 W/m(^2)(^\circ)C</td>
<td>0.0059711 W/m(^2)(^\circ)C</td>
<td>-0.482</td>
</tr>
<tr>
<td>Coefficient of thermal expansion ((\alpha))</td>
<td>1.4e-5/(^\circ)C</td>
<td>1.4062e-5/(^\circ)C</td>
<td>0.443</td>
</tr>
<tr>
<td>Temperature (T)</td>
<td>29.6528(^\circ)C</td>
<td>29.694(^\circ)C</td>
<td>0.148</td>
</tr>
<tr>
<td>Thermal strain ((\varepsilon))</td>
<td>3.4514e-4 m/m</td>
<td>3.4724e-4 m/m</td>
<td>0.608</td>
</tr>
</tbody>
</table>
Overview


Analysis Type(s): Goal Driven Optimization with APDL
Element Type(s): 3-D Solid

Test Case

A uniform column of rectangular cross section b and d m is to be constructed for supporting a water tank of mass M. It is required to:

1. minimize the mass of the column for economy
2. maximize the natural frequency of transverse vibration of the system for avoiding possible resonance due to wind.

Design the column to avoid failure due to direct compression (should be less than maximum permissible compressive stress) and buckling (should be greater than direct compressive stress). Assume the maximum permissible compressive stress as $\sigma_{max}$. The design vector is defined as:

$\{X\} = \{X_1, X_2\}^T = [b, d]^T$

where:

$b = \text{width of cross-section of column}$
$d = \text{depth of cross-section of column}$

Input Parameters:

- Mass of water tank $M = 1000000$ kg
- Side of Square C/S, Length of Cantilever Bar and Young's Modulus
  - Young's modulus of concrete material $E = 3 \times 10^{10}$ Pa
  - Length of column $l = 20$ m
- Density of concrete material $\rho = 2300$ kg/m$^3$
- Maximum permissible compressive stress $\sigma_{max} = 4.1 \times 10^7$ Pa
- Acceleration due to gravity $g = 9.81$ m/sec$^2$

Response Parameters: Mass, Natural Frequency, Direct Stress, Buckling Stress

Sample Size: 10000

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Limits</th>
<th>Desired Value</th>
<th>Importance</th>
<th>Trade-off</th>
<th>Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width b</td>
<td>Input</td>
<td>$0.36 \text{ m} &lt; b &lt; 0.4 \text{ m}$</td>
<td>No preference</td>
<td>Default</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Depth d</td>
<td>Input</td>
<td>$1.08 \text{ m} &lt; d &lt; 1.32 \text{ m}$</td>
<td>No preference</td>
<td>Default</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Mass of column M</td>
<td>Output</td>
<td>N/a</td>
<td>Maximum possible</td>
<td>High</td>
<td>On</td>
<td>-</td>
</tr>
</tbody>
</table>
### Analysis

Minimize:
Mass of the column \( M = \rho b d l \)

Maximize:

Natural frequency of transverse vibrations of the water tank \( w = \left[ \frac{E b d^3}{4 l^3 \left( M + \frac{33}{140} \rho l b d \right)} \right]^{1/2} \)

Subject to constraints:

\[ \text{Direct Stress} = \sigma_{\text{max}} = \frac{Mg}{b d} \geq 0 \]

and \( \text{Buckling Stress} = \left( \frac{\pi^2 E d^2}{48 l^2} \right) - \left( \frac{Mg}{b d} \right) \geq 0 \)

Required objective is obtained by having:

\( b = 0.36102 \text{ m} \)
\( d = 1.3181 \text{ m} \)
\( M = \text{(minimum)} = 21890 \text{ kg} \)
\( W = \text{(maximum)} = 0.87834 \text{ rad/sec} \)
\( \text{Direct stress} = 2.0386e7 \text{ Pa} \)
\( \text{Buckling stress} = 6.1526e6 \text{ Pa} \)

### Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DX</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width b</td>
<td>0.36102 m</td>
<td>0.36102 m</td>
<td>0.000</td>
</tr>
<tr>
<td>Depth d</td>
<td>1.3181 m</td>
<td>1.3181 m</td>
<td>0.000</td>
</tr>
<tr>
<td>Mass of column M</td>
<td>21890 kg</td>
<td>21890 kg</td>
<td>0.000</td>
</tr>
<tr>
<td>Natural frequency w</td>
<td>0.87834 rad/sec</td>
<td>0.87834 rad/sec</td>
<td>-0.020</td>
</tr>
<tr>
<td>Direct stress</td>
<td>2.0386e7 Pa</td>
<td>2.0383e7 Pa</td>
<td>-0.015</td>
</tr>
<tr>
<td>Buckling stress</td>
<td>6.1526e6 Pa</td>
<td>6.15260e6 Pa</td>
<td>-0.015</td>
</tr>
</tbody>
</table>
DXVM4: Optimize frequency of plate with simply supported at all its vertices

Overview


Analysis Type(s): Goal Driven Optimization

Element Type(s): 3-D Shell

Test Case

A square plate with following dimensions is subjected to boundary conditions as given below:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>a = 250 mm</td>
</tr>
<tr>
<td>Width</td>
<td>b = 250 mm</td>
</tr>
<tr>
<td>Thickness</td>
<td>h = 5 mm</td>
</tr>
</tbody>
</table>

**Input Parameters:** Young’s modulus, Poisson’s ratio and density

**Response Parameters:** First natural frequency

Figure 4.1 Schematic

<table>
<thead>
<tr>
<th>Material Properties</th>
<th>Geometric Properties</th>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>E = 2e5 MPa</td>
<td>Length a = 250 mm</td>
<td>All vertices are simply supported</td>
</tr>
<tr>
<td>ν = 0.3</td>
<td>Width b = 250 mm</td>
<td></td>
</tr>
<tr>
<td>ρ = 7.850 e-6 kg/mm³</td>
<td>Rib Thickness h = 5 mm</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Type</td>
<td>Constraints</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Young’s Modulus $E$</td>
<td>Input</td>
<td>$1.8 \times 10^{11} \text{ Pa} \leq E \leq 2.2 \times 10^{11} \text{ Pa}$</td>
</tr>
<tr>
<td>Poisson’s Ratio $\mu$</td>
<td>Input</td>
<td>$0.27 \leq \mu \leq 350 \text{ mm}$</td>
</tr>
<tr>
<td>Density $\rho$</td>
<td>Input</td>
<td>$7065 \text{ kg/m}^3 &lt; \rho &lt; 8635 \text{ kg/m}^3$</td>
</tr>
<tr>
<td>First Natural Frequency $w$</td>
<td>Output</td>
<td>N/a</td>
</tr>
</tbody>
</table>

**Analysis**

First Natural Frequency:

$$w = \frac{7.12^2}{2\pi \alpha^2} \left[ \frac{Eh^3}{12p(1-\nu^2)} \right]^{1/2}$$

Objective function becomes:

$$\phi = 1.29e-4 \left[ \frac{2.083x E}{\rho(1-\nu^2)} \right]^{1/2}$$

Minimizing $\phi$ we get dimensions as:

- Young’s Modulus $E = 1.8\times10^{11} \text{ Pa}$
- Poisson’s Ratio $\mu = 0.27$
- Density $\rho = 8635 \text{ kg/m}^3$
- First Natural Frequency $w = 124.0913 \text{ rad/s}$

**Results Comparison**

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DX</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Young's Modulus $E$</td>
<td>$1.8\times10^{11} \text{ Pa}$</td>
<td>$1.8254\times10^{11} \text{ Pa}$</td>
<td>1.411</td>
</tr>
<tr>
<td>Poisson’s Ratio $\mu$</td>
<td>0.27</td>
<td>0.27373</td>
<td>1.381</td>
</tr>
<tr>
<td>Density $\rho$</td>
<td>$8635 \text{ kg/m}^3$</td>
<td>$8611.3 \text{ kg/m}^3$</td>
<td>-0.274</td>
</tr>
<tr>
<td>First Natural Frequency $w$</td>
<td>124.0913 rad/s</td>
<td>124.63 rad/s</td>
<td>0.434</td>
</tr>
</tbody>
</table>
DXVM5: Optimization of buckling load multiplier with CAD parameters and Young's modulus

Overview

| Analysis Type(s): | Goal Driven Optimization |
| Element Type(s): | 3-D Solid |

Test Case

The cantilever bar of length 25 feet is loaded by uniformly distributed axial force \( p = 11 \) lbf on one of the vertical face of the bar in negative Z-direction. The bar has a cross-sectional area \( A = 0.0625 \) ft\(^2\).

**Input Parameters:** Side of Square C/S, Length of Cantilever Bar and Young's Modulus

**Response Parameters:** Load Multiplier of the First Buckling Mode

**Optimization Method:** Genetic Algorithm

**Sample Size:** 200

**Figure 5.1 Schematic**

<table>
<thead>
<tr>
<th>Material Properties</th>
<th>Geometric Properties</th>
<th>Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>( E = 4.1771 \times 10^9 ) psf</td>
<td>Cross-section of square = 0.25 ft. x 0.25 ft.</td>
<td>Fixed support on one face force = 11 lbf (Negative Z-direction) on top face</td>
</tr>
<tr>
<td>( \nu = 0.3 )</td>
<td>Length of bar = 25 ft.</td>
<td></td>
</tr>
<tr>
<td>( \rho = 490.45 ) lbm/ft(^3)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Parameter** | **Type** | **Constraints** | **Desired Value** | **Importance**
---|---|---|---|---|
Cross-section side | Input | \( 0.225 \) ft. \( \leq a \leq 0.275 \) ft. | No Preference | N/A
### Analysis

Assuming that under the action of uniform axial load a slight lateral bucking occurs.

The expression for deflection is:

\[ y = \delta (1 - \cos \frac{\pi x}{2l}) \]

The critical load is given by,

\[ P_{cr} = (q)_{cr} = \frac{7.89 (EI)}{l^2} = \frac{\pi^2 E I}{(1.122l)^2} \]

where:

\[ q = \text{force per unit length} \]

The first critical buckling load is:

\[ P_{cr} = \frac{\pi^2 E I}{(1.122l)^2} = \frac{\pi^2 E I}{(1.122)^2 (l)^2} = 0.6533 \times \frac{E \alpha^4}{l^2} \]

The load multiplier is given by the ratio of critical load to applied load \( P_{cr} \).

The first buckling multiplier is:

\[ 0.6533 \times \frac{E \alpha^4}{l^2} \times \frac{1}{11} = 0.0594 \times \frac{E \alpha^4}{l^2} \]

Combined objective function becomes:

\[ \Phi = 2.8008 \times 10^{-5} L(2\alpha + 4) + \frac{0.2842L}{(2\alpha + 4)} + 169.0503 \frac{1}{(2\alpha + 4)} - 3.8227 \]

Minimizing \( \phi \) we get dimensions as:

- Cross-section side \( a = 0.275 \text{ ft.} \)
- Length \( l = 22.5 \text{ ft.} \)
- Young's Modulus \( E = 4.5948e9 \text{ psf} \)
- Buckling load multiplier = 3083.32
# Results Comparison

<table>
<thead>
<tr>
<th>Results</th>
<th>Target</th>
<th>DX</th>
<th>Error (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>First buckling mode load multiplier</td>
<td>3083.32</td>
<td>3002.9</td>
<td>-2.608</td>
</tr>
</tbody>
</table>